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About this guide

The EFM User Guide provides instructions about how to use the EFM application.

Intended audience

This guide is designed for:
• Anyone responsible for planning and setting up systems.
• Anyone responsible for system administration and maintenance.
• Anyone using the product.

Documentation feedback

We strive to produce the highest-quality documentation products and welcome your 
feedback. If you have comments or suggestions about our guides or help, you can email us. 
With your feedback, include the following information:

       Document name and revision number or title of help topic and product version

       Your suggestion for correcting or improving the documentation

Send your messages to userguides@verint.com.
The email address is only for documentation feedback. If you have a technical question, 
contact Technical Support.

Technical support

Our goal at Verint Systems is to provide you with the best products backed by a high-quality 
support network with various resource options. Verint Systems Technical Support services 
include email and telephone support. 
To learn more about the support options that best suit your needs, visit us at Customer 
Engagement Support. 

mailto:userguides@verint.com?subject=Documentation feedback
https://www.verint.com/engagement/support/customer-engagement/index.html
https://www.verint.com/engagement/support/customer-engagement/index.html
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Verint University

In addition to documentation, help, and support services, Verint Systems also offers both classroom-
based and online learning alternatives to suit your specific needs. 
To learn more about available training options from Verint Systems, visit us at verint.com/training. 

Document revision history

Revision Description of changes

1.00 Added all changes included in the EFM Release Notes.

1.01 Added details of Schedule Case Exports and Randomize and Rotate survey 
questions in a page.

https://verint.com/training
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Getting Started overview
 
To start your survey process, click Survey designer overview, page 226. 
 
To learn more about the product, visit the following topics:
• Question Types, page 1
• My Surveys grid, page 169
• Video Library, page 1
• Documentation Library, page 1

What's New
What's new in EFM 15.3 FP2, page 1
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Verint Resources

Contact us
• For company contact information

http://www.verint.com/about/contact
• For technical support

Support Portal: https://community.verint.com/
• For help with training

Learn more at Verint University
Contact us at Training.Request@verint.com

Verint links
• Follow Us on Twitter
• Bookmark Our Blog

http://www.verint.com/about/contact
https://community.verint.com/
http://www.verint.com/training
mailto: Training.Request@verint.com
http://twitter.com/verint
https://community.verint.com/b/customer-engagement
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System Requirements

Designing surveys
EFM is a web-based application that requires the following to design surveys:
• Internet Explorer 11+
• Microsoft Edge
• Safari (most recent version)
• Chrome (most recent version)
• Firefox Quantum (most recent version)

Taking surveys 
These are based on what is currently verified (other browsers are likely to work as well).
For Windows:
• Internet Explorer 8+
• Microsoft Edge
• Chrome (Current – 1 version)
• Firefox Quantum (Current – 1 version)
• Opera (Current – 1 version)
For Mac:
• Safari (Current – 1 version)
• Chrome (Current – 1 version)
• Firefox Quantum (Current – 1 version)
For iOS:
• Safari (Current – 1 version)
For Android:
• Chrome (Current – 1 version)
Current – 1 version denotes that we support the current stable version of the browser and the version 
that preceded it. For example, if the current version of a browser is 24.x, we support the 24.x and 23.x 
versions.

Other requirements
• A minimum screen resolution of 1024 x 768 is required
• Administrative rights required to install ActiveX component on first use
• A minimum screen width of 1280 is required to access all functionality
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Login page
To log in to the EFM application, type your user name or email address in the box, then click Next. Type 
your password in the box then click Login.

 You should use a unique email address to log in to the EFM application. If the email address is 
assigned to two or more accounts, then you need to enter your user name or contact a System 
Administrator.

If you forget your password, click Forgot Password. For more information, see Reset password, page 54.
If you type incorrect user name, email address, or password, an error message appears notifying you how 
many attempts are left before you are locked out. You have 25 incorrect login attempts. If your account 
has been locked out, contact your system administrator to unlock it. After unlocking, your password 
remains the same.

 If you try to access the EFM application by using an unsupported browser or without enabling 
cookies in your browser settings, you are redirected to the Unsupported Browsers page. For 
more information about supported browsers, see System Requirements, page 51.
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Reset password
You can reset your password.

Procedure 
1 In the Customer Login dialog box, click the Forgot Password link.
2 In the Forgot Password window, type your user name or email address in the User Name or Email 

box, and then click Send Password.
The email message with password recovery link is sent to your email address.

3 In the received email message, click the link.
4 In the Password Reset dialog box, type your new password in the Password and the Confirm 

Password boxes.
5 Click Login.
Your password is now reset and you are automatically logged into the EFM.
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Update password
If your password does not meet the latest security requirements or is set to expire in a certain number of 
days by the administrator, the Update Password page opens right after you type your user name and 
password. In this case, you will be asked to create a new password that meets the defined criteria—the 
password must be at least 8 characters long and include at least one lowercase letter, one uppercase letter, 
one digit, no spaces, and no user name.

Procedure 
1 On the Update Password page, type your old password in the Password box.
2 In the New Password and Confirm Password boxes, type your new password that meets the 

defined criteria.
3 Click Continue.

 If your password does not meet the security requirements, you cannot log in to the EFM 
application until you update the password.
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Interstitial page
An interstitial page, if set by the administrator, appears right after you log in to the EFM application and if 
the language or time zone is not specified.
The interstitial page often includes:
• List of all the newly added features and bug fixes
• Notification about the scheduled maintenance tasks
• An alert from Account Management that it is time to renew your account.
If you want to hide the interstitial page, in the upper-right corner of the page, click the Don’t show this 
message again link.

 If the language or time zone is not specified, the Preferences page is displayed after you close 
the interstitial page.

If you want to proceed to the application, click Continue on to the application.
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Preferences page
Navigation

Log in to the EFM application > click Continue on to the application  (if the interstitial page appears).

The Preferences page appears right after you log in to the EFM application or after clicking the Continue 
on to the application link on the interstitial page if this page appears.
On the Preferences page, you can select the language and time zone for your account.

 The Preferences page appears if the administrator did not select the language or the time zone 
for your account.

If you want to select the language, on the Display the application in this language menu, select the 
needed language.
If you want to select the time zone, on the Preferred Time Zone menu, select the needed time zone.   
If you want to proceed to the EFM application, click Continue.
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Dashboard Home Page
Navigation

Dashboards tab .

You can create dashboards, add elements to your dashboards, and view the data that you are interested 
in. You can also duplicate, share,  and delete the dashboards and change the dashboard theme.

The Dashboard View

The following options are available on the dashboard home page:
• Duplicate – Click the link to duplicate the current dashboard. Click the link to edit dashboard 

name and to select dashboard theme.
• Share – Click the link to share your dashboard with other users.
• Change theme - Click to change the theme of the dashboard.
• Edit Filters (available for advanced dashboards) - Click to create your own user filters based on 

specific survey questions and hierarchical filters.
• Delete - Click to delete the dashboard.
• Filter by date – Click the drop-down arrow to filter the dashboard to view the information for a 

specific time period.
• Add Report Element – Click the button to select an element from any report you have access to 

and to add it to the dashboard to view the data.
• Add Application Metric – Click the button to add and view a variety of metrics that cover the 

entire workgroup and all surveys.
• Add External Element – Click the button to select an element from the external source and to 

add it to the dashboard to view the data.
• Create New Dashboard – Click the button to add a new dashboard.
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• Advanced Dashboard - Click the arrow next to the Create New Dashboard button, and then 
click Advanced Dashboard to add a new advanced dashboard. For more information, see Create 
advanced dashboard, page 66.

 You can add and manage dashboards that can be shared and customized for unique data needs.

You can minimize the What can I add to my dashboard section if your dashboard contains no 
elements. If there are elements added, the bottom section is minimized automatically when you access 
the dashboard next time. Click the Expand link to show the What can I add to my dashboard section 
again.
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Display dashboard home page after login
Navigation

Account menu  > My Account page.

You can make the dashboard home page displayed right after you log in to the EFM application. If your 
dashboard home page contains several dashboards, the last viewed dashboard is displayed.

Procedure 
1 In the upper-left corner of the page, click the My Account link.
2 On the Settings tab, in the Define Log-on Experience section, select the Display dashboard after 

login check box, and then click Save.
3 In the upper-left corner, click the Return to Main Tab link.
The dashboard home page is displayed.

 When both the Display dashboard after login and the Remember the last selected 
survey project on login check boxes are selected, the dashboard home page is displayed after 
login.
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Grant access to dashboard home page
Navigation

Administration tab >  Roles tab.

Group administrator can control the workgroup access to creating dashboards and viewing them based on 
the user role.
By default, access to the dashboard home page is granted to the user roles that have access to view and 
edit reports. You can grant access to the dashboard home page for other roles when creating or editing 
these roles.

Procedure 
1 On the Roles page, click the needed role.
2 On the Edit Role page, in the Experience section, select the View Dashboards check box, and then 

click Save.
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Create dashboard
 

Navigation

Dashboards tab  >  Create New Dashboard button.

You can create dashboards with report elements and workgroup metrics to track your data.
   

Procedure 
1 At the bottom of the page, click Create New Dashboard button.
2 In the Name Your Dashboard dialog box, type the name of the dashboard in the Dashboard 

Name box, and then click OK.

 You can change the order of your dashboards by dragging the dashboard tabs to the appropriate 
locations.
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Create advanced dashboard
Navigation

Dashboards tab > Dashboard View tab > Create New Dashboard list > Advanced Dashboard 
option.

With Advanced Dashboard, you can add custom filters to your dashboard and use the collected data 
more effectively. For more information, see Add user filters, page 67.
Report elements and application metrics added to Advanced Dashboard reflect only the data related to 
the Unified Data Set projects, surveys, comments, profiles, file imports, Speech Analytics project, and data 
sets which are selected when creating the dashboard.

 Panel Health Score is not available for the Advanced Dashboard.

Procedure 
1 At the bottom of the board View page, click the arrow next to the Create New Dashboard button, 

and then click Advanced Dashboard.

The Advanced Dashboard option
  

2 In the Select Project for the Dashboard dialog box, in the Dashboard Name box, type the name 
for your advanced dashboard.

3 In the projects list, click the project that you want to add, or search for it by typing its name in the 
search box.

4 Click OK.
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Add user filters
Navigation

Dashboards tab >  icon > Edit Filters option.

With Advanced Dashboard, you can create your own user filters based on data sets, comment cards, file 
imports, specific survey questions, and hierarchical filters based on Organization/Employee External ID 
questions to filter your dashboard data. For example, you can set up a filter to view which terms are used 
by the promoters of your product (based on your Net Promotion Score question).

 User filters do not apply to external elements, such as Text Analytics, Feedback Intelligence, or 
External Content application metric. 

You can create filters for the following questions: Organization External ID, Employee External ID, 
Choose One-based (Choose One, Choose One with Image, Matrix Choose One, Rank Order, Drag 
and Drop Rank Order, Scale Slider, and Scrolling Matrix), Choose Many, Matrix Choose Many, 
Short Answer, Matrix Short Answer, and Fill in the Blank.
Custom filters are available only for the questions from the survey that is selected when creating the 
Advanced Dashboard.
You can also create filters based on data points.

 You cannot add filters based on the survey or data set that is still in the design mode.

Procedure 

1 On the  menu, click Edit Filters.
2 In the filter editing area, click Add User Filters.
3 In the Add User Filters dialog box, on the Source menu, select source data for your filter.

You can choose data from the Current Survey, Columns (Participant Information, Respondent 
System Information, or Respondent Location), or Profiles (Basic Information).

 For comments project type, on the Source menu, you can choose data from Comment Cards 
(Default Questions, Custom Questions, Custom Variables) or Columns (Participant 
Information or Respondent System Information).

4 In the Question (Field) list for surveys or Data Point list for data sets, select the question, field, or 
data point that you want to use for filtering.

 For comments project type, on the Question (Field) menu, you can select the question or field 
for filtering that depends on the source data selection.

5 In the Display Label box, type the name for your filter that will be displayed on the dashboard.
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 If you selected Organization External ID or Employee External ID question, go to step 6. 
You cannot specify filter options for this type of filtering.

6 Specify the filter options:
• For Choose One and Choose Many-based questions only, from Filter Options, select the 

choices to be used as filter options. By default, all choices are selected.
• To add more filter options (for Short Answer, Matrix Short Answer, Fill in the Blank, Choose 

One-, and Choose Many-based questions):
a. Click the Add Option link.
b. In the Add Filter dialog box, type the name for your filter option in the Name box.
c. Click the Add Another Criteria link, and then define the criterion to be used as the filter option. 

To combine multiple criteria, use the criteria builder advanced options. The criteria are defined 
only for the question or side selected in step 6. You can create as many additional options as 
needed.

 If you want to edit the added filter option, just click its link and make the needed edits in the 
criteria builder.

7 Click Add Filter.
The filter is now added as a drop-down menu next to the date filter; selected choices and defined 
criteria are displayed as filter options in the drop-down menu. To filter the dashboard data, select the 
needed filter option.

 With the filter based on the Organization External ID question, you can filter by the 
available organizations. With the filter based on the Employee External ID question, you 
can filter by the available organizations and users.

8 To edit or delete the filter, click the Edit Filter link, and then click the gear icon or delete icon 
correspondingly next to the needed filter.

 If you share the Advanced Dashboard with other users, they can view and use the filters you 
created. The items available in the hierarchical filter depend on the user’s position in the 
hierarchy.
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Delete a dashboard
Navigation

Dashboards tab  >  Dashboard View tab.
 

You can delete any dashboard that you do not need anymore.

Procedure 

1 In the Dashboard View menu, click  for the dashboard which you want to delete.
2 In the confirmation message, click Delete.

 If there is only one dashboard, you cannot delete it, but you can delete its elements by clicking 
Delete in the element list.
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Managing Dashboard items
Navigation

Dashboards tab  >  Dashboard View tab.

You can change the item size, edit the item title, delete the dashboard items, and access their source by 
using the dashboard item drop-down menu.
You can use the following options in the dashboard item drop-down menu:
• Edit Title – Edit the title of the dashboard item to change the survey question or describe what 

the corresponding dashboard item represents.
• Resize – Change the size of a dashboard item to optimize the displayed content within the 

dashboard.
• Go to Report – Access the full report from which the dashboard item is inserted. This 

functionality is available for the report elements only.
• Edit – Change the dashboard element settings, such as source, data, or date filter. This 

functionality is available for the external elements only.
• Delete – Remove unnecessary items from the dashboard.

 For the steps on how to delete the dashboard items, see the Deleting dashboard Items, page 73.

Change the Width of a Dashboard Item

Procedure 

 If the dashboard item does not support the specific size, the "Resize" option is unavailable.

1 Click the arrow  in the upper-right corner of the needed dashboard item.
2 In the drop-down menu, point to Resize > Width, and then select the percentage you want. The 

available options are 33%, 50%, 66%, and 100%. The default size depends on the type of the element. 
The dashboard item is updated immediately.

Change the Height of a Dashboard Item

Procedure 
1 Click the arrow  in the upper-right corner of the needed dashboard item.
2 In the drop-down menu, point to Resize > Height, and then select the size you want. The available 

options are 1x, 2x, and 3x. The default size depends on the type of the element. The dashboard item 
is updated immediately
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Rename a Dashboard Item

Procedure 
1 Click the black down arrow in the upper-right corner of the needed dashboard item.
2 In the drop-down menu, select the "Edit Title" option. The Enter new title dialog box opens.
3 Edit the name of the dashboard item.
4 Click OK to save the changes.

Access the Source Report from the Dashboard Item

Procedure 

 The "Go to Report" link is only available for the dashboard elements that are added from the 
reports.

1 Click the black down arrow  in the upper-right corner of the needed dashboard item.
2 In the drop-down menu, select the "Go to Report" option. The related report opens on the page 

where the report element source is located. If you have the Edit access to the report, the report opens 
in Preview mode of the report designer. If you have the View access, the report opens in a new 
window for preview.

Edit a Dashboard Item

Procedure 

 The "Edit" link is only available for the external dashboard elements.

1 Click the arrow in the upper-right corner of the needed dashboard item.
2 In the drop-down menu, select the "Edit" option. The Edit Report Element dialog box opens.
3 Edit the external element settings.
4 Click OK to save the selected changes. The dashboard item is updated immediately.
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Dragging dashboards
Navigation

Dashboards tab  >  Dashboard View tab.

You can change the order of dashboards on the toolbar by using the drag-and-drop functionality. The 
location changes of dashboards are saved across the sessions.

Procedure 
1 On the home page, hover over the dashboard tab that you want to drag.
2 When the pointer becomes a four-headed arrow, drag the pointer to move the dashboard tab to the 

appropriate location.
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Deleting dashboard Items
Navigation

Dashboards tab  >  Dashboard View tab.

You can delete any item from the dashboard. If you delete the dashboard item from the report, it will no 
longer show on the dashboard.
  

Delete an Item from the dashboard

Procedure 
1 Hover over the  arrow in the upper-right corner of the needed dashboard item.
2 On the drop-down menu, select the Delete option. The confirmation dialog box opens. See images 

below.
  

3 Click Delete. The dashboard item is deleted from dashboard.
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Sharing a dashboard
Navigation

Dashboards page > click the needed dashboard >  menu.

You can share your dashboards for viewing with other users, organizations, and groups as well as they 
can share theirs with you.

 This functionality is available only if you have the Share Dashboards permission enabled.

You can restrict sharing all dashboards by clearing the Share Dashboards check box on the 
Administration page > Roles tab. 
If you clear the View Dashboards check box, the Share Dashboards check box is cleared by default. If 
you select the Share Dashboards check box, the View Dashboards check box is selected by default.
All dashboards shared before the permissions were disabled are still available to the users with whom 
they were shared.
You can share one dashboard at a time. When you share a dashboard with another user, organization, or 
group, the Shared by You icon appears next to the dashboard name. Hover over the icon to see a 
tooltip displaying the sharing notification.
When a dashboard is shared with you by another user, you can be informed about it by email. Also, a 
notification appears with a link to the shared dashboard. 
If multiple dashboards are shared with you since your last session, the corresponding notification 
appears at the top of the Dashboard tab.
The dashboard viewer can change only the date filter on the shared dashboard to view the information 
for a specific time period.
The list of users and organizations in the left box of the Select Other Users dialog box contains 
maximum 200 user names. To search for specific user or organization, use the search box at the top of 
the list.

Share dashboard

Procedure 

1 Go to the Dashboards tab, click the needed dashboard, and then click the Share icon .
2 In the Select Other Users dialog box, in the Dashboard Name text box, edit the name of the 

dashboard that you want to share. By default, the text box contains the current dashboard’s name. 
3 Select one of the following:

• Share by Organization Structure – Share with specific organizations and users. This option is 
selected by default.

• Share by Group – Share with specific groups configured for Feedback Intelligence. If the 
dashboard is already shared, the new sharing overwrites the existing one.
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The Select Other Users dialog box

 To select the Share by Group option, verify that a System Administrator configured Feedback 
Intelligence under Feedback Intelligence > Business Objects > Enable FI User Security 
Automation Features to activate the Groups view.

4 In the left column, select a check box next to the needed user, organization, or group, and then click 
the right double arrows button to move them to the View Access box. 
To move them back, click the left arrows button.

 All users assigned to the selected organization and its child organizations are moved to the right 
box as well.

5 If needed, clear the following check boxes (they are selected by default):
• Overwrite Existing Dashboard – Share one dashboard several times as different dashboards.
• Notify Users by Email – Send an email notification to the users allowed to view the dashboard.
• Allow drill-down to response list for text elements – Allow respondents to click the text 

analytics elements on a dashboard and view responses that represent them.
6 Click OK. 
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7 If the Notify Users by Email check box is selected, the Notify User dialog box opens, where you 
can edit your email notification.

8 Click OK.

Stop the dashboard sharing

Procedure 

1 Go to the Dashboards tab, click the needed dashboard, and then click the Share icon .
2 In the Select Other Users dialog box, in the View Access text box, select the user or organization 

that you want to stop sharing the dashboard with. 
3 Click the left double arrows button to move the selected user to the Users text box.
4 Click OK.

The dashboard is no longer available for viewing by the user or organization.
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Duplicate a dashboard
Navigation

Dashboards tab  >  Dashboard View tab >  menu.

Use the Duplicate option to copy the current dashboard.
 

Only dashboard owner can duplicate the dashboard. If the dashboard is shared with you, the Duplicate 
option is not available and you cannot duplicate the dashboard. By default, the duplicated dashboard is 
not shared with other users. The filters and theme of the selected dashboard are also applied to the 
duplicated dashboard.

Duplicate a dashboard

Procedure 

1 Click the  menu, and then click the Duplicate option. 
2 In the Duplicate Dashboard dialog box, edit the dashboard name, and then click OK.
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Managing multiple dashboards
Navigation

Dashboards tab  >  Dashboard View tab.

You can add multiple dashboards for different purposes to your home page and switch between them. A 
new dashboard is added to the right of the currently selected dashboard within the tab structure.
You can add as many dashboards as you want to the home page. Switch between the tabs to view 
different dashboards. When the home page contains more dashboards than your current window can fit, 

the scroll arrows    appear on the toolbar. You can navigate through the dashboards using the 
scroll arrows. Next to the last dashboard in the row, the scroll arrow is inactive and appears in gray. 

The multiple dashboards toolbar with scroll arrows

Add a new dashboard

 This option is only available for the home page containing multiple dashboards.

Procedure 

1 Click the black plus icon   on the toolbar of the home page. The Name Your Dashboard dialog 
box opens. 

2 Edit the name of the dashboard in the Dashboard Name field.
3 Click OK. The initial entry message appears. 

 The initial entry message appears only for the newly created and empty dashboards.

4 Click Close.

Switch between the dashboards

 This option is only available for the home page containing multiple dashboards.
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Procedure 

1 Click the black down arrow   on the toolbar of the home page. The drop-down list of all existing 
dashboards appears. The current dashboard is outlined in an orange rectangle and marked with a 
green check mark.

The dashboards list

2 Select the dashboard from the drop-down list to open it.
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Dashboard date filter
Navigation

Dashboards tab  >  Dashboard View tab >  upper-right corner of the dashboard.

You can filter the dashboard to view the information for a specific time period using the date filter  menu.

The date filter menu on a dashboard

When you use a filter like Last Week, Last Month, Last Quarter, etc., the filter is a rolling filter. It means 
that the filter will continue to update relative to the current date and not the date when it is created.
You can find the following functionality in the dashboard date filter drop-down menu:
• Date Range – From the drop-down list, define a date range to filter the information within the 

dashboard. You can filter only completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you create by yourself. Enter the 

start date and end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date.
• Year to Date – Shows the completed data for the period starting January 1st of the current year 

up until the current date.
• Last Month – Shows the completed data for the past month.
• Last Quarter – Shows the completed data for the past three months.
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• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
• Last 180 Days – Shows the completed data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon.
• End Date – Enter the end date in the text box manually or by using the calendar icon.
• Apply – Save the selected changes.
• Cancel – Remove the changes.
The selected dashboard date filter is applied to all the dashboard items and is saved across the browser 
sessions. When you re-open the dashboard, the previously saved date filter is selected. The filters are 
supported separately for each dashboard.
The dashboard date filter does not override the filters previously applied to the dashboard item at the 
report or report element level. In this case, the dashboard date filter restricts the previously applied filter. 
It is applied in addition to any other filter. For example, the element date filter is set to the range from 
1/1/2011 to 12/31/2011. The dashboard date filter is set to the range from 10/1/2011 to 12/31/2011. 
The combined filter only shows the data between the date range 1 and date range 2. Thus, the data for 
the 10/1/2011-12/31/2011 period displays.

Apply a custom Date filter to the dashboard

Procedure 
1 Click the date filter  menu in the upper-right corner on the dashboard.
2 Select Custom from the Date Range  list.
3 Select the date range using the Start Date and End Date text boxes.

 These fields are filled in automatically for all the other date filters.

4 Click Apply to save the selected changes. The date filter displays in the upper-right corner on the 
dashboard. The dashboard items are updated to show the data according to the defined filter.
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Customize dashboard
Navigation

Dashboards tab .
 

You can customize the dashboard by editing its name and selecting a theme to make the dashboard 
elements from different sources look similar.

To edit the dashboard name, hover over the dashboard name, click , and then edit the name.
By default, no theme is applied to the dashboard. The dashboard elements are added to the dashboard 
with their source theme. When you apply a dashboard theme to the elements, it overrides the elements 
source theme. If you apply the None theme, the dashboard elements original theme is not restored.

Procedure 

1 Click the   menu, and then click Change Theme.
2 In the Change Theme box, select the dashboard theme from the Theme list, and then click Save.

 Themes are not supported for the Feedback Intelligence dashboard elements.

 



Dashboards Managing a public dashboard

EFM User Guide 83

Confidential and Proprietary Information of Verint Systems Inc.

Managing a public dashboard
Navigation

Dashboards page > click the needed dashboard > menu > Make Dashboard Public option.

If you want to share your dashboards with other users who do not have access to EFM, you can generate 
the dashboard public link. In addition, you can secure the public dashboard by password.

Generate a dashboard public link

Procedure 
1 Go to the Dashboards tab, and then click the needed dashboard.

2 On the   menu, click the Make Dashboard Public option.
3 In the Make Dashboard Public dialog box, select the Allow the dashboard to be accessed 

publicly check box.
4 To set the password for accessing your public dashboard, select the Require a password for the 

public dashboard check box, and then type the password in the box.
5 To generate the link to your public dashboard, click Apply Changes.

The generated link for public dashboard

6 Click Close.

 To stop dashboard public sharing, clear the Allow the dashboard to be accessed publicly 
check box. The dashboard is no longer available for viewing by a dashboard public link.
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View a password protected public dashboard

Procedure 
1 Open the email that contains the dashboard public link and password.
2 Click the generated dashboard public link.
3 On the dashboard access page, in the Password box, type the password for a public dashboard.

The password protected public dashboard

4 Click Access Dashboard.

When a dashboard is shared publicly, you can view the Public icon   next to the dashboard 
name.

Enable a public dashboard for a workgroup

Procedure 
1 Go to the Configuration tab > General tab.
2 On the General Setup page, select the Enable Public Dashboard check box.
3 Click Save Setup.

 For the steps on how to enable public dashboards based on the user role, see the Public 
dashboard–Role-based access, page 86 topic.

You can select a different source when you add a report element to your dashboard. To make a publicly 
shared dashboard with report elements accessible for users, you have to add report elements from the 
projects of which you are the owner. For example, when you are the owner of the survey and add two 
report elements to a dashboard, one using data from the owned survey and another one on data from 
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the non-owned survey, and then share this dashboard publicly, only one report element is available for 
the users.

 External elements are not supported in the publicly shared dashboards. 
If you add an external element to a publicly shared dashboard, you stop sharing this dashboard.
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Public dashboard–Role-based access
Navigation

Administration tab > Roles tab.

As administrator you can enable public dashboards for a user by creating a new role or editing the 
existing ones. You can control the workgroup members' access to public dashboards creation and sharing 
based on the user role set of permissions.

 For details on making a dashboard public, see the Managing a public dashboard, page 83.

Activate public dashboard for a user role

Procedure 
1 Go to the Administration tab > Roles tab.
2 To grant a user role permission to share dashboards publicly, click the Create Role button or the 

name of already existing role that you want to edit. 
3 On the Edit Role page, in the Experience section, select the Public Dashboard check box.
4 Click Save.

 By selecting the Public Dashboard permission, the View Dashboards check box is selected 
automatically. 
If the View Dashboards check box is not selected, the Public Dashboard check box is cleared 
automatically. 
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By default, the following user roles have the Public Dashboard permission:
• Group Administrator
• Survey Administrator
• Survey Author
• Lite Survey Author
• Report Author

 For details on the user roles, see Roles, page 1378 and Create a new role, page 1380.
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Dashboard Add Report Element
Navigation

Dashboards page.

You can add all available report elements to the dashboard. You can select report elements from any 
existing report you are granted access to. Use the Add Report Element button in the bottom section for 
adding report elements to the dashboard.
When you click the Add Report Element button, the element selection dialog box opens showing the 
last modified report on the last viewed survey. You can preview the reports in the dialog box to find the 
elements that you want to add to the dashboard. 
The following options show in the element selection dialog box:
• Source – Click this button to select the source of the element that you want to add to the 

dashboard. Surveys, reports, profiles, data sets, application statistics, file imports, Speech 
Analytics projects, and comments are all items which contain usable information. The selected 
source shows to the right of the Source button.

• Report – Click this drop-down list to view all existing reports available in the selected source. 
Select the report containing the report element that you want to add to the dashboard.

• Page – Click this drop-down list to select the report page containing the report element that you 
want to add to the dashboard.

• Select Element – Click this button to select the report element you want to add to the 
dashboard.

 For the Advanced Dashboard, only the survey that was selected when creating the dashboard 
is shown.

Add a Report Element to the Dashboard

Procedure 
1 Click Add Report Element at the bottom of the dashboard. In the Add a Report Element dialog 

box, click Source to open the element source selection dialog box, which shows the folders with the 
existing surveys, comments, profiles, data sets, file imports, Speech Analytics projects, application 
metrics, and reports that you have access to.

2 Click the black right arrow   next to the folder that you need to expand, and then select the 
element source.

3 Click Select.
4 In the Report list, click the report name, and then click the report page containing the report element 

that you want to add.
5 Click Select Element next to the report element that you want to add to the dashboard. You can 

select multiple elements to add to the dashboard at a time. Navigate through the report pages using 
the navigation arrows to find all report elements that you need. The numeric counter on the Add 
button shows the number of the selected elements.

6 Click Add. The selected report elements show on the dashboard.
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Adding report elements to dashboard
Navigation

Dashboards tab.

You can add all available report elements to the dashboard, including the report elements from profiles 
and data sets. You can select report elements from any existing report you are granted access to. Use the 
Add Report Element button in the bottom section for adding report elements to the dashboard.
When you click the Add Report Element button, the element selection dialog box opens showing the 
last modified report on the last viewed survey or data set. You can preview the reports in the dialog box 
to find the elements that you want to add to the dashboard.
In the element selection dialog box, the following options are available:
• Source – Click this button to select the source of the element that you want to add to the 

dashboard.  Surveys, reports, profiles, data sets, application statistics, file imports, Speech 
Analytics projects, Unified Data Set projects, ForeSee projects, and comments are all items which 
contain usable information. The selected source shows on the right side of the Source button.

• Report – Click the list to view all existing reports available in the selected source. Select the report 
containing the report element that you want to add to the dashboard.

• Page – Click the list to select the report page containing the report element that you want to add 
to the dashboard.

• Select Element – Click this button to select the report element you want to add to the 
dashboard.

Add a report element to the dashboard
1 Click Add Report Element at the bottom of the dashboard. In the Add a report element dialog 

box, click Source to open the element source selection dialog box, which shows the folders with the 
existing surveys, comments, profiles, data sets, file imports, Speech Analytics projects,  ForeSee 
projects, comments, application metrics, and reports that you have access to.

 For the Advanced Dashboard, only the survey that was selected when creating the dashboard 
is shown.

2 Click the black right arrow  next to the folder you need to expand, and then select the element 
source.

3 Click Select.
4 In the Report list, click the report name, and then click the report page containing the report element 

that you want to add.
5 Click Select Element next to the report element that you want to add to the dashboard. You can 

select multiple elements to add to the dashboard at a time. Navigate through the report pages using 
the navigation arrows to find all report elements that you need. The numeric counter on the Add 
button shows the number of the selected elements.

6 Click Add. 
The selected report elements are shown on the dashboard.



Dashboards Adding Elements to Dashboard from Report

EFM User Guide 90

Confidential and Proprietary Information of Verint Systems Inc.

Adding Elements to Dashboard from Report
Navigation

Dashboards tab.

You can add report elements to the dashboard from the report designer using the Add to Dashboard 

icon  in the right pane. The report element is added to the bottom section of the selected dashboard. 
You can select whether to add a report element to an existing dashboard or to create a new dashboard 
and add the element to it. After adding the element, you stay on the current report and can add more 
elements. The newly created dashboard becomes available in the list of existing dashboards.

Add a Report Element to a new dashboard

Procedure 
1 In the report designer, hover over the report element that you want to add to a dashboard. The Add 

to Dashboard icon appears in the right pane.
2 Click the Add to Dashboard icon. 

The Add report element to dashboard dialog box opens.
3 Select Create New Dashboard in the Select Dashboard list. 

The Dashboard Name text box appears.
4 Enter the name for the new dashboard in the Dashboard Name field.
5 Click OK. 

The new dashboard with the report element is added to the right of the last viewed dashboard on the 
home page.

Add a Report Element to an existing dashboard

Procedure 
1 In the report designer, hover over the report element that you want to add to a dashboard. The Add 

to Dashboard icon appears in the right pane.
2 Click the Add to Dashboard icon. 

The Add report element to dashboard dialog box opens.
3 Select the dashboard for adding the report element from the Select Dashboard list.
4 Click OK. 

The report element is added to the bottom section of the selected dashboard.

 To delete the report element from the dashboard, go to the dashboard.
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Dashboard Styling of Report Elements
Navigation

Dashboards tab.

You can add all report element types to the dashboard to provide a real-time view of critical information 
from your report within a dashboard. A dashboard item created from a report item is a snapshot (copy) 
of its settings and view. The data within the report element displays according to the dashboard date 
filter.
The report elements on the dashboard can have different appearance depending on the type. The 
question caption appears in the tooltip. The question title appears in the dashboard element title bar. The 
dashboard theme is applied to the element automatically.

 For the steps on how to add report elements to the dashboard, see Adding Elements to 
Dashboard from Report, page 90.

Chart Elements
When you add a report element to the dashboard, the text on the chart, for example, question text, 
resizes appropriately for better appearance. The default width of the "Frequency Chart," "Trend Chart," 
and "Sentiment Chart" report elements is set to 33%. When you resize the browser window, the charts fit 
the current window size automatically.
For better appearance, the number of categories for the "Sentiment Chart" report element on the 
dashboard is limited to 5 per page. By default, all categories are horizontal. The settings applied to the 
"Sentiment Chart" report element in the report designer will be overridden.

Table Elements
If the table-based element contains a large amount of data, the scroll bars appear within the element on 
the dashboard. The default width of the table-based elements is the following:
• Statistics – 33%
• Sentiment Table and Sentiment Trend Table – 50%
• Frequency Table, Correlation, Gap, and Response List – 66%
• Top Box, Top Box Cross-tab, Trend Table, Summary Table, and Summary of Means – 100% and is 

not resizable.
• Cross-tab, Bar Chart Organization Cross-tab, Top Box Organization Cross-tab, and Organization 

Cross-tab Table – 100%.

Text-Based Elements
The default width of the "Sentiment Summary," "Word Cloud," and "Heat Map" text analytics report 
elements is set to 50%. When you resize the browser window, the elements fit the current window size 
automatically.
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 For the text analytics report elements, you can click the element and view responses that 
represent it.
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Displaying Report Filters on the Dashboard
Navigation

Dashboards tab.

You can see the notification on the dashboard element that the filter is applied to its source. In such case, 

the Filtered icon  appears in the upper-left corner of the dashboard element. Hover over the Filtered 

icon   to view the applied filter in a tooltip.
The filter on the dashboard element does not change even if you change its source filter in the report.
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Add Workgroup Metrics to Dashboard
Navigation

Dashboards tab.

You can add application metrics to the dashboard to display the important information, such as 
workgroup, panel, survey, and user statistics directly within the dashboard. You can also define the scope 
of the presented data and view the data from the specific survey, report, or application statistics. Use the 
Add Application Metric button in the bottom section for adding application metrics to the dashboard.
When you click the Add Application Metric button, the element selection dialog box opens. You can 
preview the metrics in the dialog box to find the items that you want to add to the dashboard. 
The following options are available in the element selection dialog box:
• Source – Click this button to select the source of the element that you want to add to the 

dashboard. Surveys, reports, profiles, data sets, application statistics, file imports, Speech 
Analytics projects,  Unified Data Set projects,  ForeSee projects, and comments are all items which 
contain usable information. The selected source is displayed on the right side of the Source 
button.

 For the Advanced Dashboard, only the questions from the survey that was selected when 
creating the dashboard are shown.

• Select Element – Click this button to select the element you want to add to the dashboard.

Add an Application Metric to the Dashboard

Procedure 
1 Click the Add Application Metric button on the home page. The element selection dialog box opens.
2 Click the Source button. The element source selection dialog box opens showing the folders with the 

existing surveys, comments, profiles, data sets, file imports, Speech Analytics projects,  Unified Data 
Set projects,  ForeSee projects, application metrics, and reports that you have access to.

3 Click the black right arrow   next to the folder you need to expand and select the element source.
4 Click Select.
5 Click the Select Element button next to the metric that you want to add to the dashboard. You can 

select multiple metrics to add to the dashboard at a time. The numeric counter on the Add button 
shows the number of the selected metrics.

6 Click Add. The selected metrics appear on the dashboard.

Filter the Workgroup Statistics Metric Data

Procedure 
After adding the metric to the dashboard, you can select all surveys or one specific survey, for which to 
display the metric. By default, all surveys are included in the calculation. If the user does not have the 



Dashboards Add Workgroup Metrics to Dashboard

EFM User Guide 95

Confidential and Proprietary Information of Verint Systems Inc.

View All Surveys permission, only surveys that the user has access to are included in the calculation, 
and the most recently accessed survey is the default filter.
1 Click the link next to the Showing data for option to select the metric source. The metric source 

selection dialog box opens.

2 Click the black right arrow   next to the folder you need to expand and select the metric source.
3 Click Select. The metric source is selected. The current filter shows on the right side of the Showing 

data for option on the dashboard.
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Adding application metrics to dashboard
Navigation

Dashboards tab > Add Application Metric button.

You can add application metrics to the dashboard to display the important information, such as 
workgroup, panel, survey, data set, and user statistics directly within the dashboard. You can also define 
the scope of the presented data and view the data from the specific survey, report, data set, or 
application statistics. Use the Add Application Metric button in the bottom section for adding 
application metrics to the dashboard.

The Add Application Metric button

When you click the Add Application Metric button, the element selection dialog box opens. You can 
preview the metrics in the dialog box to find the items that you want to add to the dashboard.
The following options are available in the element selection dialog box:
• Source – Click this button to select the source of the element that you want to add to the 

dashboard. Surveys, reports, profiles, data sets, application statistics, file imports, Speech 
Analytics projects,  Unified Data Set projects,  ForeSee projects, and comments are all items which 
contain usable information. The selected source is displayed on the right side of the Source 
button.

 For the Advanced Dashboard, only the questions from the survey that was selected when 
creating the dashboard are shown.

• Select Element – Click this button to select the element you want to add to the dashboard.

Add an application metric to the dashboard

Procedure 
1 Click the Add Application Metric button on the home page. The element selection dialog box opens.
2 Click the Source button. The element source selection dialog box opens showing the folders with the 

existing surveys, comments, profiles, data sets, file imports, Speech Analytics projects,  Unified Data 
Set projects,  ForeSee projects, application metrics, and reports that you have access to.

3 Click the black right arrow   next to the folder you need to expand and select the element source.



Dashboards Adding application metrics to dashboard

EFM User Guide 97

Confidential and Proprietary Information of Verint Systems Inc.

4 Click Select.
5 Click the Select Element button next to the metric that you want to add to the dashboard. You can 

select multiple metrics to add to the dashboard at a time. The numeric counter on the Add button 
shows the number of the selected metrics.

6 Click Add. The selected metrics appear on the dashboard.

Filter the workgroup statistics metric data
After adding the metric to the dashboard, you can select all surveys or one specific survey, for which to 
display the metric. By default, all surveys are included in the calculation. If the user does not have the 
View All Surveys permission, only surveys that the user has access to are included in the calculation, and 
the most recently accessed survey is the default filter.

Procedure 
1 Click the link next to the Showing data for option to select the metric source. The metric source 

selection dialog box opens.

2 Click the black right arrow  next to the folder you need to expand and select the metric source.
3 Click Select. The metric source is selected. The current filter shows on the right side of the Showing 

data for option on the dashboard.
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Adding Workgroup Statistics to the Dashboard
Navigation

Dashboards tab > Add Application Metric button.

You can add workgroup statistics such as workgroup campaign status, current response count and rate, 
and current health score of the panel directly to the dashboard. Additionally, you can add items from 
other application or Web page to the dashboard by using the embedded code or URL. Use the Add 
Application Metric button in the bottom section to add workgroup metrics to the dashboard.
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Response Activity
Navigation

Dashboards tab > Add Application Metric button > Response Activity metric.

You can add the Response Activity metric to the dashboard to view the number of people invited 
versus started a survey. This functionality is available for the email-based surveys only. The Generate 
Link surveys are not included.
The following charts are displayed in the Response Activity metric:
• Invitations – Shows the count of invitations sent to participants to take the survey.
• Responses – Shows the count of respondents who replied to the survey.
Click the label on the legend to show or hide the corresponding displayed value.

The legend on the response rate chat

The data displayed in the Response Activity is calculated depending on the current dashboard date 
filter. The Response Activity is calculated only for the surveys that have the Open and Closed status.
You can define the scope of the presented data and view the data from the specific survey. The current 
filter shows to the right of the Showing data for option. By default, all surveys are included in the 
calculation. If the user does not have the View All Surveys permission, only surveys that the user has 
access to are included in the calculation, and the most recently accessed survey is the default filter.
The default size of the Response Activity metric is set to 33%.

 For details on how to add response metrics to the dashboard, see Add Workgroup Metrics to 
Dashboard, page 94.



Dashboards Respondents by Invitation

EFM User Guide 100

Confidential and Proprietary Information of Verint Systems Inc.

Respondents by Invitation
Navigation

Dashboards tab > Add Application Metric button > Respondents of Invitation metric.

You can add the Respondents by Invitation metric to the dashboard to view the current workgroup 
response rate. This functionality is available for all the email-based surveys only. The Generate Link 
surveys are not included.
The Respondents by Invitation metric appears as trend chart and displays the response rate within the 
specific date range. The response rate is the percentage of invitations sent versus the percentage of 
responses given. The response rate is calculated in the following way:
Responses / Invitations * 100% = X, that appears when you hover over the chart.

The legend on the respondents by invitation chart

The data displayed in the Respondents by Invitation chart is calculated depending on the current 
dashboard date filter. The response rate is calculated only for the surveys that have the Open and 
Closed status.
You can define the scope of the presented data and view the data from the specific survey. The current 
filter shows to the right of the Showing data for option. By default, all surveys are included in the 
calculation. If the user does not have the View All Surveys permission, only surveys that the user has 
access to are included in the calculation, and the most recently accessed survey is the default filter.
The default size of the Respondents by Invitation metric is set to 33%.

 For details on how to add the Respondents by Invitation metric to the dashboard, seeAdd 
Workgroup Metrics to Dashboard, page 94.
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Workgroup Campaign Status
Navigation

Dashboards tab > add the campaign status chart to the dashboard.

You can add a chart of your workgroup campaign status for all surveys to the dashboard. The workgroup 
campaign status displays as a pie chart on the dashboard. Hover over the survey status on the chart to 
view the count and percentage of participants that represent it.
The campaign status is calculated only for the surveys that are in the Open or Closed status. The 
workgroup campaign status chart is displayed in the same manner as the overall campaign chart on the 
Collect tab and shows the following participant statuses:
• Sent (or In Queue)
• Confirmed Received
• Started
• Undeliverable
• Completed
• Bounced Back
• Unsubscribed
• Branched Out
• Over Quota 
For definitions of the statuses, see Participant status, page 584.
The workgroup campaign status is calculated depending on the current dashboard date filter. You can 
define the scope of the presented data and view the data from the specific survey. The current filter 
shows to the right of the Showing data for option. By default, all surveys are included in the calculation. 
If the user does not have the View All Surveys permission, only surveys that the user has access to are 
included in the calculation, and the most recently accessed survey is the default filter.
The default size of the campaign status metric is set to 33%.

 For details on how to add campaign status to the dashboard, see Add Workgroup Metrics to 
Dashboard, page 94.
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Panel Health Score Gauge
Navigation

Dashboards tab > add  the current panel health score to the dashboard.

You can add the workgroup panel health score indicating the current health of the panel to the 
dashboard. The workgroup panel health score is presented as a gauge, showing the average panel health 
score in the same manner as on the Panel tab.

 Panel Health Score is not available for the Advanced Dashboard.

 

 Only users who have access to view the panelists have permissions to view the panel health score 
on the dashboard.

The health score is a weighted value on a 0% to 100% scale showing the average activity rate of the 
panelists. The gauge presents the health score for the panelists of the workgroup in the following way:
• Blue – healthy, 75% and above
• Red – unhealthy, 25% and below
• Grey – all other percentages.

 For details on the panel health score, see Panel Health Score, page 1241.

The dashboard date filter does not affect the panel health score. The width of the health score element is 
set to 33% and is not resizable.

How to add the Panel Health Score to a dashboard

Procedure 
1 Click the Add Application Metric button on the home page. The element selection dialog box opens.
2 Click the Select Element button next to the current panel health score element.
3 Click Add. The panel health score gauge appears on the dashboard.
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External Content Dashboard Item
Navigation

Dashboards tab > Add Application Metric button > Workgroup Statistics source > External 
Content item > Add button > External Content item.
You can add items from other application or web page to the dashboard using the embed code or URL.
Use the Add Application Metric button to add the external content to the dashboard. The default 
width of the external content dashboard item is set to 33%, but you can resize it to optimize the 
displayed content within the dashboard. For the videos, you can use the iFrame to ensure that the video 
fits correctly. 
<iframe width="560" height="315" src="http://www.examplevideolink" frameborder="0" 
allowfullscreen></iframe>
You can access the basic web page functionality directly within the dashboard item. You can also change 
the content using the dashboard item  menu.

Add External Content to the Dashboard

Procedure 
1 Copy the embed code or URL of the web page that you want to add to the dashboard.
2 Click the Add Application Metric button on the Dashboards page. The element selection dialog box 

opens.
3 Into the text box, enter the copied embed code or URL of the web page that should appear on the 

dashboard.
4 Click the Select Element button above the text box.
5 Click Add. The external content item appears on the dashboard.

Edit an External Content Dashboard Item

Procedure 

1 Click the black down arrow   in the upper-right corner of the external content dashboard item that 
you want to edit.

2 In the drop-down menu, select the Edit option. The external content editing dialog box opens. See 
images below.

3 Into the text box, enter the copied embed code or URL of the Web page that should appear on the 
dashboard.

4 Click OK. The external content dashboard item updates immediately.
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Add case metrics to the dashboard
Navigation

Dashboards tab > Add Application Metric button > Case Metrics source.
You can add case metrics to the dashboard to monitor the case statistics directly within the dashboard. 
The following elements are available to view the case trending properties: Cases Opened vs. Cases 
Closed, Average Time Open (Days), Average Resolution Time (Days), Trending Properties Heat 
Map, Trending Properties Cloud, or Case Summary Pareto Chart element.

 The case metrics are available only if you have a license for the Case Management feature.
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The Cases Opened vs. Cases Closed Metric
Navigation

Dashboards tab > Add Application Metric button > Case Metrics source > Cases Opened vs. Cases 
Closed metric > Add button.
You can add the Cases Opened vs. Cases Closed metric to the dashboard by using the Add 
Application Metric button. Thus you can view the number of opened versus closed cases within the 
dashboard.
The following charts are displayed for the Cases Opened vs. Cases Closed metric:
• Opened – The number of opened cases in a column chart.
• Closed – The number of closed cases in a line chart.
You can click the label on the legend to show or hide the corresponding displayed value. The data 
displayed in the Cases Opened vs. Cases Closed metric is calculated depending on the current 
dashboard date filter. You can filter the presented case data to include only specific users into the 
calculation by using the Edit Report Element dialog box. By default, all users are included in the 
calculation.
When the Cases Opened vs. Cases Closed metric is added to the dashboard, its default size is 33% 
width and 1x height. You can change the dashboard item size according to your needs. For details on how 
to add case metrics to the dashboard, see Add case metrics to the dashboard, page 104.

Procedure 
1 Add a Cases Opened vs. Cases Closed metric to the dashboard.

2 Click the arrow  in the upper-right corner of the case metric.
3 In the drop-down menu, click Edit.
4 In the Edit Report Element dialog box, in the Data Filter section, define the scope of the data 

presented in the chart by selecting the corresponding radio button. The following options are 
available:

• Show Only Me - Only cases managed by you will be displayed in the chart.
• Show Logged in User - Only cases opened by a logged in user will be displayed in the chart. 

When you share a dashboard with other users, they can see data for their own cases only.
• Show All Users - Cases managed by all case users will be displayed in the chart. This is the default 

option.
• Choose Specific Users to Display - Only data of the cases managed by specific users will be 

displayed in the chart. You can define the users below in the dialog.

In the Find User text box, type the name of the user, whose case data you want to view in the chart. The 
search results are displayed in the Available Users box.

 If the View All Cases permission is inactive for the user role, the Show Only Me is the only 
available option.

5 In the Find User text box, type the name of the user, whose case data you want to view in the chart. 
The search results are displayed in the Available Users box.
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 The Find User, Available Users, and Selected Users boxes are active only when the Choose 
Specific Users to Display option is selected in the Data Filter section.

6 In the Available Users box, select the user. Only users who have any case assigned to them appear 
in the box. When there are more than 50 users, the Available Users box appears as an 
autocompleting text box.

 To select more than one user at a time, press and hold CTRL on the keyboard while clicking the 
user names.

7 Click the right double arrows button  to move the selected user to the Selected Users box.
8 In the Date Filter section, define a date range to filter the information within the case metric. You can 

apply the following date filters:
• Date Range – From the drop-down list, define a date range to filter the information within the 

Cases Opened vs. Cases Closed metric. The following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.

9 Click OK. The current filter appears on the case metric's title bar. The case metric filter overrides the 

whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.
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 When no data is available for the selected filter, the No Chart Data notification appears for the 
case metric.



Dashboards The Average Time Open Metric

EFM User Guide 108

Confidential and Proprietary Information of Verint Systems Inc.

The Average Time Open Metric
Navigation

Dashboards tab > Add Application Metric button > Case Metrics source > Average Time Open 
metric > Add button.
You can add the Average Time Open metric to the dashboard by using the Add Application Metric 
button. Thus you can view the average open time of cases opened within a workgroup.
The following charts are displayed for the Average Time Open metric:
• Average Time Open for Users – The average open time for the cases created by a single user. 

The individual column appears for each user.
• Average Time Open for Workgroup – The average open time of cases opened within a 

workgroup. This metric appears as a straight horizontal line and is displayed only when the Show 
Average Time Open for Workgroup check box is selected in the Edit Dashboard Element 
dialog box.

 The Average Time Open calculation includes cases with the Open and On Hold current status.

The data displayed in the Average Time Open metric is calculated depending on the current dashboard 
date filter. You can filter the presented case data to include only specific users into the calculation by 
using the Edit Dashboard Element dialog box. By default, all case users are included in the calculation.
When the Average Time Open metric is added to the dashboard, its default size is 33% width and 1x 
height. You can change the dashboard item size according to your needs.

 For details on how to add case metrics to the dashboard, see Add Workgroup Metrics to 
Dashboard, page 94.

Procedure 
1 Add an Average Time Open metric to the dashboard.

2 Click the arrow  in the upper-right corner of the case metric.
3 In the drop-down menu, click Edit. 
4 In the Edit Dashboard Element dialog box, in the Data Filter section, define the scope of the data 

presented on the chart by selecting the corresponding radio button. The following options are 
available:
• Show Only Me – Only cases opened by you will be displayed in the chart.
• Show Logged in User – Only cases opened by a logged in user will be displayed in the chart. 

When you share a dashboard with other users, they can see data for their own cases only.
• Show All Users – Cases opened by all case users will be displayed in the chart. This is the default 

option.
• Choose Specific Users to Display – Only data of the cases opened by specific users will be 

displayed in the chart. You can also select the Unassigned option to easily manage the 
unassigned cases. You can define the users below in the dialog box.
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 If the View All Cases permission is inactive for the user role, the Show Only Me is the only 
available option.

5 In the Find User text box, type the name of the user whose case data you want to view in the chart. 
The search results are displayed in the Available Users box.

 The Find User, Available Users, and Selected Users boxes are active only when the Choose 
Specific Users to Display option is selected in the Data Filter section.

6 In the Available Users box, select the user. Only users who have any case assigned to them appear 
in the box. When there are more than 50 users, the Available Users box appears as an 
autocompleting text box.

 To select more than one user at a time, press and hold CTRL on the keyboard while clicking the 
user names.

7 Click the right double arrows button  to move the selected user to the Selected Users box.
8 In the Data section, select the Show Average Time Open for Workgroup check box to display the 

average open time calculation for the whole workgroup within the chart. This option is active by 
default.

9 In the Date Filter section, define a date range to filter the information within the case metric. You can 
apply the following date filters:
• Date Range – From the drop-down list, define a date range to filter the information within the 

Average Time Open metric. The following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .
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• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.

10 Cancel – Remove the changes.Click OK. The current filter appears on the case metric's title bar. The 

case metric filter overrides the whole dashboard filter. Hover over the Filtered icon to view the 
applied date filter in a tooltip.

 When no data is available for the selected filter, the No Chart Data notification appears for the 
case metric.
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The Average Resolution Time (Days) Metric
Navigation

Dashboards tab > Add Application Metric button > Case Metrics source > Average Resolution 
Time (Days) metric > Add button.
You can add the Average Resolution Time (Days) metric to the dashboard by using the Add 
Application Metric button. Thus you can view the average open time of the currently closed cases 
within a workgroup.
The following charts are displayed for the Average Resolution Time (Days) metric:
• Average Resolution Time for Users – The average open time in a column chart for the cases 

created by a single user and currently closed. The individual column appears for each user.
• Average Resolution Time for Workgroup – The average open time in a line chart for the 

currently closed cases within a workgroup. This metric appears as a straight horizontal line and is 
displayed only when the Show Average Resolution Time for Workgroup check box is selected 
in the Edit Dashboard Element dialog box.

The data displayed in the Average Resolution Time (Days) metric is calculated depending on the 
current dashboard date filter. You can filter the presented case data to include only specific users into the 
calculation by using the Edit Dashboard Element dialog box. By default, all case users are included in 
the calculation.
When the Average Resolution Time (Days) metric is added to the dashboard, its default size is 50% 
width and 1x height. You can change the dashboard item size according to your needs. For details on how 
to add case metrics to the dashboard, see Add Workgroup Metrics to Dashboard, page 94.

Procedure 
1 Add an Average Resolution Time (Days) metric to the dashboard.

2 Click the arrow  in the upper-right corner of the case metric.
3 In the drop-down menu, click Edit.
4 In the Edit Dashboard Element dialog box, in the Data Filter section, define the scope of the data 

presented on the chart by selecting the corresponding radio button. The following options are 
available:
• Show Only Me – Only cases resolved by you will be displayed in the chart.
• Show Logged in User – Only cases opened by a logged in user will be displayed in the chart. 

When you share a dashboard with other users, they can see data for their own cases only.
• Show All Users – Cases resolved by all case users will be displayed in the chart. This is the default 

option.
• Choose Specific Users to Display – Only data of the cases opened by specific users will be 

displayed in the chart. You can also select the Unassigned option to easily manage the 
unassigned cases. You can define the users below in the dialog box.

 If the View All Cases permission is inactive for the user role, the Show Only Me is the only 
available option.

5 In the Find User text box, type the name of the user whose case data you want to view in the chart. 
The search results are displayed in the Available Users box.
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 The Find User, Available Users, and Selected Users boxes are active only when the Choose 
Specific Users to Display option is selected in the Data Filter section.

6 In the Available Users box, select the user. Only users who have any case assigned to them appear 
in the box. When there are more than 50 users in a workgroup, the Available Users box appears as 
an autocompleting text box.

 To select more than one user at a time, press and hold CTRL on the keyboard while clicking the 
user names.

7 Click the right double arrows button to move the selected user to the Selected Users box.
8 In the Data section, select the Show Average Resolution Time for Workgroup check box to 

display the average resolution time calculation for the whole workgroup within the chart. This option 
is active by default.

9 In the Date Filter section, define a date range to filter the information within the case metric. You can 
apply the following date filters:
• Date Range – From the drop-down list, define a date range to filter the information within the 

Average Time Open metric. The following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself.  Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.
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10 Click OK. The current filter appears on the case metric's title bar. The case metric filter overrides the 

whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.

 When no data is available for the selected filter, the No Chart Data notification appears for the 
case metric.
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The Trending Properties Heat Map Metric
Navigation

Dashboards tab > Add Application Metric button > Case Metrics source > Trending Properties 
Heat Map metric > Add button.
You can add the Trending Properties Heat Map metric to the dashboard by using the Add Application 
Metric button. Thus you can view a graphical representation of case data that appears in different size 
and color within the dashboard. The size of each heat map segment indicates the number of cases, to 
which the corresponding property is applied. The color indicates the average priority, highlighting low 
priorities in green and high priorities in red.

Item Description

1 The custom property applied to the case.

2 The selected custom property choice.

3 Only custom properties that are currently applied 
to the cases are displayed in a heat map.

 Only custom properties that are currently applied to the cases are displayed in a heat map.

When you hover over the segment, a tooltip appears displaying the following details of the case property:
• Property > Choice – The names of the case property and property choice applied to the case.
• Number of Cases – The number of cases, to which the corresponding property is applied.
• Average Priority – The average priority of the cases, to which the corresponding property is 

applied.
The data displayed in the Trending Properties Heat Map metric is calculated depending on the current 
dashboard date filter. You can filter the presented case data to include only specific users into the 
calculation by using the Edit Report Element dialog box. By default, all case users are included in the 
calculation.
When the Trending Properties Heat Map metric is added to the dashboard, its default size is 50% 
width and 1x height. You can change the dashboard item size according to your needs. For details on how 
to add case metrics to the dashboard, see Add Workgroup Metrics to Dashboard, page 94.

Trending Properties Heat Map Custom Filtering
You can apply the data filters to the trending properties heat map to view the data that represents a 
certain value in the heat map. When you click the value in the Trending Properties Heat Map metric, 
the Cases page opens displaying the results according to the applied custom filter. The custom filter 
criteria is based on the selected value. A notification describing the current filter appears above the Cases 
grid.

Procedure 
1 Add a Trending Properties Heat Map metric to the dashboard.
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2 Click the arrow  in the upper-right corner of the case metric.
3 In the drop-down menu, click Edit.
4 In the Edit Report Element dialog box,in the Data Filter section, define the scope of the data 

presented in the heat map by selecting the corresponding radio button. The following options are 
available:
• Show Only Me – Only cases opened by you will be displayed in the heat map.
• Show Logged in User – Only cases opened by a logged in user will be displayed in the chart. 

When you share a dashboard with other users, they can see data for their own cases only.
• Show All Users – Cases opened by all case users will be displayed in the heat map. This is the 

default option.
• Choose Specific Users to Display – Only data of the cases opened by specific users will be 

displayed in the heat map. You can define the users below in the dialog box.

 If the View All Cases permission is inactive for the user role, the Show Only Me is the only 
available option.

5 In the Find User text box, type the name of the user whose case data you want to view in the heat 
map. The search results are displayed in the Available Users box.

 The Find User, Available Users, and Selected Users boxes are active only when the Choose 
Specific Users to Display option is selected in the Data Filter section.

6 In the Available Users box, select the user. Only users who have any case assigned to them appear 
in the box. When there are more than 50 users, the Available Users box appears as an 
autocompleting text box.

 To select more than one user at a time, press and hold CTRL on the keyboard while clicking the 
user names.

7 Click the right double arrows button  to move the selected user to the Selected Users box.
8 In the Date Filter section, define a date range to filter the information within the case metric. You can 

apply the following date filters:
• Date Range – From the drop-down list, define a date range to filter the information within the 

Trending Properties Heat Map metric. The following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself.  Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
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• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon 

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.

9 Click OK. The current filter appears on the case metric's title bar. The case metric filter overrides the 

whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.

 When no data is available for the selected filter, the No Chart Data notification appears for the 
case metric.
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The Trending Properties Cloud Metric
Navigation

Dashboards tab > Add Application Metric button > Case Metrics source > Trending Properties 
Cloud metric > Add button.
You can add the Trending Properties Cloud metric to the dashboard by using the Add Application 
Metric button. Thus you can view a case properties data that appears in a word cloud on the dashboard. 
Each word in a cloud indicates a custom property choice applied to one or more cases. The size of the 
word depends on the number of cases, to which the corresponding property is applied. The color 
indicates the average priority, highlighting low priorities in green and high priorities in red.

 Only custom properties that are currently applied to the cases are displayed in a word cloud.

When you hover over the word, a tooltip appears displaying the following details of the case property:
• Number of Cases – The number of cases, to which the corresponding property is applied.
• Average Priority – The average priority of the cases, to which the corresponding property is 

applied.
The data displayed in the Trending Properties Cloud metric is calculated depending on the current 
dashboard date filter. You can filter the presented case data to include only specific users into the 
calculation by using the Edit Report Element dialog box. By default, all case users are included in the 
calculation.
When the Trending Properties Cloud metric is added to the dashboard, its default size is 33% width 
and 1x height. You can change the dashboard item size according to your needs.

 For details on how to add case metrics to the dashboard, see Add Workgroup Metrics to 
Dashboard, page 94.

Trending Properties Cloud Custom Filtering
You can apply the data filters to the trending properties cloud to view the data that represents a certain 
value in the word cloud. When you click the value in the Trending Properties Cloud metric, the Cases 
page opens displaying the results according to the applied custom filter. The custom filter criteria is based 
on the selected value. A notification describing the current filter appears above the Cases grid.

Procedure 
1 Add a Trending Properties Cloud metric to the dashboard.

2 Click the arrow  in the upper-right corner of the case metric.
3 In the drop-down menu, click Edit.
4 In the Edit Report Element dialog box, in the Data Filter section, define the scope of the data 

presented in the word cloud by selecting the corresponding radio button. The following options are 
available:
• Show Only Me – Only cases opened by you will be displayed in the word cloud.
• Show Logged in User – Only cases opened by a logged in user will be displayed in the chart. 

When you share a dashboard with other users, they can see data for their own cases only.



Dashboards The Trending Properties Cloud Metric

EFM User Guide 118

Confidential and Proprietary Information of Verint Systems Inc.

• Show All Users – Cases opened by all case users will be displayed in the word cloud. This is the 
default option.

• Choose Specific Users to Display – Only data of the cases opened by specific users will be 
displayed in the chart. You can also select the Unassigned option to easily manage the 
unassigned cases. You can define the users below in the dialog box.

 If the View All Cases permission is inactive for the user role, the Show Only Me is the only 
available option.

5 In the Find User text box, type the name of the user whose case data you want to view in the word 
cloud. The search results are displayed in the Available Users box.

 The Find User, Available Users, and Selected Users boxes are active only when the Choose 
Specific Users to Display option is selected in the Data Filter section.

6 In the Available Users box, select the user. Only users who have any case assigned to them appear 
in the box. When there are more than 50 users, the Available Users box appears as an 
autocompleting text box.

 To select more than one user at a time, press and hold CTRL on the keyboard while clicking the 
user names.

7 Click the right double arrows button  to move the selected user to the Selected Users box.
8 In the Date Filter section, define a date range to filter the information within the case metric. You can 

apply the following date filters:
• Date Range – From the drop-down list, define a date range to filter the information within the 

Trending Properties Cloud metric. The following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.
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• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.

9 Click OK. The current filter appears on the case metric's title bar. The case metric filter overrides the 

whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.

 When no data is available for the selected filter, the No Chart Data notification appears for the 
case metric.
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The Case Summary Pareto Chart Metric
Navigation

Dashboards tab > Add Application Metric button > Case Metrics source > Case Summary Pareto 
Chart metric > Add button.
You can add the Case Summary Pareto Chart metric to the dashboard by using the Add Application 
Metric button. Thus you can view the case counts by core or custom properties on the dashboard.
The following charts are displayed for the Case Summary Pareto Chart metric:
• Total Cases – The number of cases according to the option selected from the Segmented by  list 

above the chart against the total number of cases. The individual column appears for each option. 
The Contact's Business is the default option. The columns are arranged in a descending order 
from left to right. The chart may include up to 12 columns.

• Cumulative Percentage – The cumulative percentage of cases according to the option selected 
from the Segmented by  list above the chart against the total percentage of valid cases. The 
cumulative percentage shows when you hover over the chart.

 For details on the Case Summary Pareto Chart calculation, see Case Summary Pareto Chart, 
page 1146.

The data displayed in the Case Summary Pareto Chart metric is calculated depending on the current 
dashboard date filter. You can filter the presented case data to include only specific users into the 
calculation by using the Edit Dashboard Element dialog box. By default, all case users are included in 
the calculation.
When the Case Summary Pareto Chart metric is added to the dashboard, its default size is 33% width 
and 1x height. You can change the dashboard item size according to your needs.

 For details on how to add case metrics to the dashboard, see Add Workgroup Metrics to 
Dashboard, page 94

Trending Properties Cloud Custom Filtering
You can apply the data filters to the trending properties cloud to view the data that represents a certain 
value in the word cloud. When you click the value in the Case Summary Pareto Chart metric, the Cases 
page opens displaying the results according to the applied custom filter. The custom filter criteria is based 
on the selected value. A notification describing the current filter appears above the Cases grid.

Filter the Case Summary Pareto Chart Metric Data
1 Add a Case Summary Pareto Chart metric to the dashboard.

2 Click the arrow  in the upper-right corner of the case metric.
3 In the drop-down menu, click Edit. The Edit Dashboard Element dialog box opens.
4 In the Data Filter section, define the scope of the data presented on the chart by selecting the 

corresponding radio button. The following options are available:
• Show Only Me – Only cases opened by you will be displayed in the chart.
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• Show Logged in User - Only cases opened by a logged in user will be displayed on the chart. 
When you share a dashboard with other users, they can see data for their own cases only.

• Show All Users – Cases opened by all case users will be displayed in the chart. This is the default 
option.

• Choose Specific Users to Display – Only data of the cases opened by specific users will be 
displayed in the chart. You can also select the Unassigned option to easily manage the 
unassigned cases. You can define the users below in the dialog box.

 If the View All Cases permission is inactive for the user role, the Show Only Me is the only 
available option.

5 In the Find User text box, type the name of the user whose case data you want to view in the chart. 
The search results are displayed in the Available Users box.

 The Find User, Available Users, and Selected Users text boxes are active only when the 
Choose Specific Users to Display option is selected in the Data Filter section.

6 In the Available Users box, select the user name. Only users who have any case assigned to them 
appear in the box. When there are more than 50 users, the Available Users box appears as an 
autocompleting text box.

 To select more than one user at a time, press and hold CTRL on the keyboard while clicking the 
user names.

7 Click the right double arrows button  to move the selected user to the Selected Users box.
8 In the Data section, select the Show Average Time Open for Workgroup check box to display the 

average open time calculation for the whole workgroup within the chart. This option is active by 
default.

9 In the Date Filter section, define a date range to filter the information within the case metric. You can 
apply the following date filters:
• Date Range – From the drop-down list, define a date range to filter the information within the 

Case Summary Pareto Chart metric. The following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Week – Shows the data for the current week, no matter the current date.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
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• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar  icon.

• End Date – Enter the end date in the text box manually or by using the calendar  icon.
• Apply – Save the selected changes.
• Cancel – Remove the changes.

10 Click OK. The current filter appears on the case metric's title bar. The case metric filter overrides the 

whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.

 When no data is available for the selected filter, the No Chart Data notification appears for the 
case metric.
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Displaying Updates in the Dashboard Items
Navigation

Dashboards tab.
A dashboard item created from a report item is a snapshot (copy) of its settings, view, and filter. When 
you make changes to the report or report element that the dashboard item is sourced from, the 
dashboard item does not change. Thus, you can add one report element to the dashboard several times 
as different dashboard items to view and compare the data throughout the report updating process.
However, the dashboard item refers to the live survey data. If you make any changes to the survey, the 
dashboard item updates immediately. If you delete the source report or the source report element, it will 
no longer appear on the dashboard.



Dashboards Adding external elements to the dashboard

EFM User Guide 124

Confidential and Proprietary Information of Verint Systems Inc.

Adding external elements to the dashboard
Navigation

Dashboards tab > Add External Element button.

Add the Impact 360 Text Analytics, Feedback Intelligence, or Tableau elements to the dashboard to 
monitor the external source metrics directly within the dashboard.

The Add External Element button

 The External Source feature is available only if you have a license for it and the external sources 
are activated for your workgroup.

 External elements are not supported in the publicly shared dashboards. 
If you add an external element to a publicly shared dashboard, you will stop sharing this 
dashboard.
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Adding Feedback Intelligence documents to the 
dashboard

Navigation

Dashboards tab > Add External Element button.
You can add your documents from Feedback Intelligence to the dashboard to view all the relevant metrics 
on a common dashboard. The documents are directly connected to your Feedback Intelligence instance.

 The Feedback Intelligence documents are available if you have a license for the Feedback 
Intelligence feature.

Also the system administrator needs to configure Feedback Intelligence, and then activate the Feedback 
Intelligence connection for your workgroup under FI Connections > Dashboard Usage.
The Feedback Intelligence metrics appear on the dashboard as an open document in an IFrame. The 
Feedback Intelligence document supports single sign on so once you have connected to Feedback 
Intelligence and added the document to the dashboard, you do not have to log into Business Objects 
again. The Feedback Intelligence document is updated on the dashboard every time you log into the 
application or refresh the page and is saved automatically when you log out.
There is no date filter for the Feedback Intelligence external elements, and they are not affected by the 
dashboard date filter.
Use the Add External Element button in the bottom section to add external elements to the 
dashboard. When you add the Feedback Intelligence document to the dashboard, it appears in 
Configure mode. You can edit the element that you have added to the dashboard by using the 
Configure Source link.
When you click the Configure Source link, the Edit Report Element dialog box opens, where you can 
define the Feedback Intelligence document settings.

 Add and configure a Feedback Intelligence external dashboard item

Procedure 
1 In the Add External Element dialog box,click the Source button. 

The Add a Report Element dialog box shows the folders with the existing external sources, 
application metrics, surveys, and reports that you have access to.

2 Click the arrow next to the External Sources folder, and then select the Feedback Intelligence 
source. 
The source name is the display name of the Feedback Intelligence connection.

3 Click Select. 
4 Click the Select Element button next to the Feedback Intelligence Document external element.
5 Click the Add button. 

The Feedback Intelligence Document external element appears on the dashboard with the 
Configure Source link.

6 Click the Configure Source link for the Feedback Intelligence external element. 
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7 In the Edit Dashboard Element dialog box,from the External Source  list, select the source for the 
Feedback Intelligence document. 
The list contains all the available connections to Feedback Intelligence that you have added on the 
Reports tab.

8 From the Document  list, select the document that you want to add to the dashboard. 
The list contains all the available Feedback Intelligence documents. The name of the selected 
document automatically becomes the name of the corresponding dashboard item.

9 In the Filter Parameter text box, type the query string filter. 
For details on how to build filters, see Advanced filtering for external Text Analytics dashboard items, 
page 140. Put the ampersand character (&) in the beginning of the filter parameter text.

10 To limit the user access to the data, select the Use Dashboard Viewer Authentication check box. 
The data is what the user has access to only.

11 To save the selected settings, click OK. 
The dashboard item is updated immediately.

When the Feedback Intelligence external element is added to the dashboard, its default size is 100% 
width and 3x height. You can change the dashboard item size according to your needs.
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Advanced filtering for external Feedback Intelligence 
dashboard items

Navigation

Dashboards tab > Add External Element button.
You can create user-specific dashboard items with the Feedback Intelligence elements to provide users 
with the information that is relevant to them only.
Advanced filtering syntax of Feedback Intelligence reports is defined by the capabilities of Business 
Objects (BO) OpenDocument reports. Since the Feedback Intelligence external dashboard item just 
shows a BO OpenDocument report in an iFrame, you can use the filtering parameters you put on the URL 
to control the report rendering as the filtering parameters for configuring the external dashboard item.
You can define the filter parameters while configuring an external dashboard element. The query string 
filter supports parameters that allow replacements based on the user meta data. When the report 
element is rendered, it replaces these parameters with the values from the currently logged in user.
Here is the information on how to pass the Feedback Intelligence report parameters from a Feedback 
Intelligence dashboard item.

I. Defining a prompted report parameter in a BO WebIntelligence Document
1 Within the WebIntelligence query builder, add a new query filter.
2 Set the value type to Prompt.
3 Provide a name identifier for the prompt. COUNTRY is selected in the example below.
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Defining a prompted report parameter

II. Single and multi-valued prompt syntax in BO OpenDocument URL
The OpenDocument URL parameter parser uses the prefixes "lsS" and "lsM" to identify URL string 
parameters for prompts. When the URL parameter name attached to one of these prefixes matches the 
name of a prompt in the document, the associated value is passed into the query filter. Multiple prompt 
items can be passed in a single URL as single or multiple value parameters.
• Single value prompt parameter – lsS[NAME]

• Example: &lsSCOUNTRY=France
• Multi-value prompt parameter – lsM[NAME]

• Example: &lsMCOUNTRY=France;Germany;Italy;Spain
You can use the EFM users extended information in combination with the filters. This allows you to create 
one dashboard item, share it with many users, and have the dynamic filter based on the users extended 
information. For example, if you want to create a dynamic filter that filters by the users country, you can 
use the following parameter:
&lsSCOUNTRY=%user.country%
 
The supported parameters are:
%user.id%
%user.username%
%user.displayname%
%user.email%
%user.organization%
%user.department%
%user.jobtitle%
%user.country%
%user.state%
%user.province%
%user.telephone%
%user.fax%
%user.interests%
%user.employeecount%
%user.referredby%
%user.industry%
%user.registrationdate%
%user.registrationportal%

 Registration date is a string. There is no guarantee that its content will follow any date format.
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Adding Sentiment Summary External Element to 
Dashboard

Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button.
You can add a Sentiment Summary element to the dashboard directly from the Impact 360 Text 
Analytics external source. Thus you can track your external Text Analytics data within the dashboard. 
When you add the Sentiment Summary external element to the dashboard, it appears in the Configure 
mode. You can select the settings for your Sentiment Summary element by using the Edit Dashboard 
Element dialog box that you can access via the Configure Source link.

 You can drill down into the sentiment summary chart to view responses.

Add and configure a Sentiment Summary external dashboard item

Procedure 
1 Click the Add External Element button at the bottom of the Dashboards page.
2 In the Add External Element dialog box, click the Source button. 

The Add a Report Element dialog box shows the folders with the existing external sources, 
application metrics, surveys, and reports that you have access to.

3 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

4 Click Select. 
5 Click the Select Element button next to the Sentiment Summary external element.
6 Click the Add button. 

The Sentiment Summary external element appears on the dashboard with the Configure Source 
link.

7 Click the Configure Source link for the sentiment summary chart. 
The Edit Dashboard Element dialog box opens.

8 From the External Source list, select the source for the sentiment summary chart. 
The list contains all available connections to Text Analytics that you have added on the My Account 
page.

9 From the Project Name list, select the project for your sentiment summary. 
The list contains all available projects for the selected source.

10 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

11 From the Verbatim list, select the question, which data will be analyzed in the sentiment summary 
chart. 
You can select the All option to include all questions.
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12 From the Sort Order list, select the option for the bar order in the chart. 
You can select the Descending (Positive to Negative) or Ascending (Negative to Positive) 
option. By default, Descending (Positive to Negative) option is selected.

13 From the Report by list, select the data parameters upon which the chart is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics for each type of summary.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics for each type of summary. This option is selected 
by default.

14 In the Filter Parameter text box, type the Lucene filter string. 
For details on how to build filters, see Advanced filtering for external Text Analytics dashboard items, 
page 140. From the Date Range list, define a date range to filter the sentiment summary data. You 
can filter only completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you specify. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date. This filter is selected by default.
• Year to Date – Shows the completed data for the period starting January 1st of the current year 

up until the current date.
• Last Week – Shows the completed data for the past week.
• Last Month – Shows the completed data for the past month.
• Last Quarter – Shows the completed data for the past three months.
• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
• Last 180 Days – Shows the completed data for the past 180 days.

15 In the Start Date text box, enter the start date manually or by clicking the calendar icon  .

16 In the End Date text box, enter the end date manually or by clicking the calendar icon  .
17 To save the selected settings, click OK. 

The dashboard item is updated immediately.
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The Sentiment Summary element on the dashboard

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, the 
No data available notification appears for the sentiment summary chart.

The current filter appears on the dashboard element's title bar. The dashboard element filter overrides 

the whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.
When the Sentiment Summary external element is added to the dashboard, its default size is 33% 
width and 1x height. You can change the dashboard item size according to your needs.
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Adding Sentiment Chart to Dashboard
Navigation

Dashboards tab > Add External Element button > Sentiment Chart element > Add button.
You can add a Sentiment Chart element to the dashboard directly from the Impact 360 Text 
Analytics external source. Thus you can track your external text analytics data within the dashboard. 
When you add the Sentiment Chart external element to the dashboard, it appears in the Configure 
mode. You can select the settings for your sentiment chart by using the Edit Dashboard Element dialog 
box that you can access via the Configure Source link.

 You can drill down into the sentiment chart to view responses.

 Add and configure a Sentiment Chart external dashboard item

Procedure 
1 Click the Add External Element button at the bottom of the Home page.
2 In the Add External Element dialog box, click the Source button. 

The Add a Report Element dialog box shows the folders with the existing external sources, 
application metrics, surveys, and reports that you have access to.

3 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

4 Click Select. 
5 Click the Select Element button next to the Sentiment Chart external element.
6 Click the Add button. 

The Sentiment Chart external element appears on the dashboard with the Configure Source link.
7 Click the Configure Source link for the sentiment chart. 

The Edit Dashboard Element dialog box opens.
8 From the External Source list, select the source for the sentiment chart. 

The list contains all available connections to Text Analytics that you have added on the My Account 
page.

9 From the Project Name list, select the project for your sentiment chart. The list contains all available 
projects for the selected source.

10 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

11 From the Verbatim list, select the question, which data will be analyzed in the sentiment chart. 
You can select the All option to include all questions.

12 From the Content list, select the type of content you want to display in the sentiment chart. 
The following options are available:
• Top Level Categories
• Category Leaves
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• Relationships
• Terms
• Structured Data

13 From the Sort Order list, select the option for the stacked bars order in the chart. 
You can select the Descending or Ascending option. By default, Descending option is selected.

14 From the Report by list, select the data parameters upon which the chart is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics. This option is selected by default.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics.
• Sentiment Score – The dashboard item displays the rolled-up sentiment score for each content 

type as returned from Text Analytics. If you select this option, the sentiment chart is displayed as 
a Sentiment Gap chart type.

• Sentiment Distribution – The dashboard item displays the sentiment chart (stacked Positive, 
Neutral, and Negative statements) where stacked bars are arranged by volume either in ascending 
or descending order according to the Sort Order option selected.

15 From the Structured Attribute list, select the attribute for the structured data content. This option 
is only available when you select Structured Data from the Content list. 
The following options are available:
• Source ID
• Verbatim Type
• Auto-Detected Language
• Processed Language
• Document Date

16 In the Filter Parameter text box, type the Lucene filter string. For details on how to build filters, see 
Advanced filtering for external Text Analytics dashboard items, page 140.

17 From the Date Range list, define a date range to filter the sentiment chart data. You can filter only 
completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you specify. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date. This filter is selected by default.
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• Year to Date – Shows the completed data for the period starting January 1st of the current year 
up until the current date.

• Last Week – Shows the completed data for the past week.
• Last Month – Shows the completed data for the past month.
• Last Quarter – Shows the completed data for the past three months.
• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
• Last 180 Days – Shows the completed data for the past 180 days.

18 In the Start Date text box, enter the start date manually or by clicking the calendar icon  .

19 In the End Date text box, enter the end date manually or by clicking the calendar icon  .
20 To save the selected settings, click OK. The dashboard item is updated immediately.

The Sentiment Chart element on the dashboard

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the sentiment chart.

The current filter appears on the dashboard element's title bar. The dashboard element filter overrides 

the whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.
By default, the Sentiment Chart external element displays ten bars per page. Use the navigation arrows 

in the lower-right corner of the chart to navigate to the previous , next  , first , or last page of the 
sentiment chart.
When the Sentiment Chart external element is added to the dashboard, its default size is 50% width 
and 1x height. You can change the dashboard item size according to your needs.
• When the height is set to 1x, the chart displays 5 elements per page.
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• When the height is set to 2x, the chart displays 10 elements per page.
• When the height is set to 3x, the chart displays 15 elements per page.
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The Sentiment Trend Chart on the Dashboard
Navigation

Dashboards tab > Add External Element button > Sentiment Trend Chart element > Add button.
You can add a Sentiment Trend Chart element to the dashboard when Impact 360 Text Analytics is 
selected as an external source. Thus you can track the top ten data type items over the selected date 
range using the trend lines. When you add the text analytics element to the dashboard, it appears in the 
Configure mode. You can select the settings for your Sentiment Trend Chart element by using the 
Edit Dashboard Element dialog box that you can access via the Configure Source link.

 You can drill down into the sentiment trend chart to view responses.

Add and configure a Sentiment Trend Chart external dashboard item

Procedure 
1 Click the Add External Element button at the bottom of the Dashboards page.
2 In the Add External Element dialog, lick the Source button. 

The Add a Report Element dialog box shows the folders with the existing external sources, 
application metrics, surveys, and reports that you have access to.

3 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

4 Click Select. 
5 Click the Select Element button next to the Sentiment Trend Chart external element.
6 Click the Add button. 

The Sentiment Trend Chart external element appears on the dashboard with the Configure 
Source link.

7 Click the Configure Source link for the sentiment trend chart. 
The Edit Dashboard Element dialog box opens.

8 From the External Source list, select the source for the sentiment trend chart. 
The list contains all available connections to Text Analytics that you have added on the My Account 
page.

9 From the Project Name list, select the project for your sentiment trend chart. 
The list contains all available projects for the selected source.

10 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

11 From the Verbatim list, select the question, which data will be analyzed in the sentiment trend chart. 
You can select the All option to include all questions.

12 From the Content list, select the type of content you want to display in the sentiment trend chart. 
The following options are available:
• Top Level Categories
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• Category Leaves
• Relationships
• Terms
• Structured Data

13 From the Report by list, select the data parameters upon which the chart is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics. This option is selected by default.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics.
• Sentiment Score – The dashboard item displays the rolled-up sentiment score for each content 

type as returned from Text Analytics.
14 From the Structured Attribute list, select the attribute for the structured data content. This option 

is only available when you select Structured Data from the Content list. 
The following options are available:
• Source ID
• Verbatim Type
• Auto-Detected Language
• Processed Language
• Document Date

15 In the Filter Parameter text box, type the Lucene filter string. For details on how to build filters, see 
Advanced filtering for external Text Analytics dashboard items, page 140.

16 From the Date Range list, define a date range to filter the sentiment trend chart data. You can filter 
only completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you specify. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date. This filter is selected by default.
• Year to Date – Shows the completed data for the period starting January 1st of the current year 

up until the current date.
• Last Week – Shows the completed data for the past week.
• Last Month – Shows the completed data for the past month.
• Last Quarter – Shows the completed data for the past three months.
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• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
• Last 180 Days – Shows the completed data for the past 180 days.

17 In the Start Date text box, enter the start date manually or by clicking the calendar icon .

18 In the End Date text box, enter the end date manually or by clicking the calendar icon .
19 To save the selected settings, click OK. 

The dashboard item is updated immediately.

The Sentiment Trend Chart element on the dashboard

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the sentiment trend chart.

The current filter appears on the dashboard element's title bar. Hover over the Filtered icon   to view 
the applied date filter in a tooltip. The Sentiment Trend Chart external element added to the 
dashboard does not support the dashboard date filter.
When the Sentiment Trend Chart external element is added to the dashboard, its default size is 50% 
width and 1x height. You can change the dashboard item size according to your needs.
• When the height is set to 1x, the chart displays 5 elements per page.
• When the height is set to 2x, the chart displays 10 elements per page.
• When the height is set to 3x, the chart displays 15 elements per page.
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Adding Text Analytics elements to the dashboard
Navigation

Dashboards tab > Add External Element button.

You can add Text Analytics elements to the dashboard to track your Impact 360 Text Analytics external 
source metrics within the dashboard. 
You can add the following text analytics elements:
• Adding Sentiment Summary External Element to Dashboard, page 129
• Adding Sentiment Chart to Dashboard, page 132
• The Sentiment Trend Chart on the Dashboard, page 136
• Sentiment Table external dashboard item, page 145
• Sentiment Trend Table external dashboard item, page 148
• Add Word Cloud External Dashboard Item, page 151
• Heat Map external item filtering, page 164
When you add the Text Analytics element to the dashboard, it appears in Configure mode. You can edit 
the element that you have added to the dashboard by using the Configure Source link.
When you click the Configure Source link, the Edit Dashboard Element dialog box opens, where you 
can define the Text Analytics element settings. If you do not set all the required parameters, the Edit 
Dashboard Element dialog box closes, and the report element stays in the Configure mode.
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Advanced filtering for external Text Analytics 
dashboard items

Navigation

Dashboards tab > Add External Element button.

You can create user-specific dashboard items with the Text Analytics elements to provide users with the 
information that is relevant to them only.
The EFM application supports the native Lucene report filtering that Text Analytics provides. You can 
define the filter parameters while configuring an external dashboard element. The Lucene filter string 
supports parameters that allow replacements based on the user meta data. When the report element is 
rendered, it replaces these parameters with the values from the currently logged in user.
Here is the information on how to use some of the native Lucene filtering on verbatims and attributes in 
Text Analytics.

Verbatims
Equals
(_verbatimtype:Q1 +_words:\"tech support\")
 
Does not Equal
-(_verbatimtype:Q1 _words:\"tech support\")
 
Contains Phrase
(_verbatimtype:Q1 +_words:\"tech support\")
 
Does Not Contain Phrase
-(_verbatimtype:Q1 _words:\"tech support\")
 
Contains Word
(_verbatimtype:Q1 +_words:tech*)
 
 
Does Not Contain Word
-(_verbatimtype:Q1 _words:tech*)

Attributes
Equals
(Q1:\"10\")
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Does Not Equal
(Q1:(NOT \"10\"))
 
Contains Phrase
(Q1:\"tech support\")
 
Contains Word
(Q1:(tech*))
 
You can use the EFM users extended information in combination with the filters. This allows you to create 
one dashboard item, share it with many users, and have the dynamic filter based on the users extended 
information. For example, if you want to create a dynamic filter that filters by the users department, you 
can use the following parameter:
(Q1:\"%user.department%\")
 
The supported parameters are:
%user.id%
%user.username%
%user.displayname%
%user.email%
%user.organization%
%user.department%
%user.jobtitle%
%user.country%
%user.state%
%user.province%
%user.telephone%
%user.fax%
%user.interests%
%user.employeecount%
%user.referredby%
%user.industry%
%user.registrationdate%
%user.registrationportal%
 
Dates are tested as a range in YYYYMMDD format.

 Registration date is a string. There is no guarantee that its content will follow any date format.
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Sentiment Trend Chart external dashboard item
Navigation

Dashboards tab > Add External Element button > Sentiment Trend Chart element > Add button.
You can add a Sentiment Trend Chart element to the dashboard when the Impact 360 Text 
Analytics is selected as an external source. Thus you can track the top ten data type items over the 
selected date range using the trend lines. 
When you add the text analytics element to the dashboard, it appears in the Configure mode. You can 
select the settings for your Sentiment Trend Chart element by using the Edit Dashboard Element 
dialog box that you can access via the Configure Source link.

 You can drill down into the sentiment table to view responses.

Add and configure a Sentiment Trend Chart external dashboard item

Procedure 
1 In the Add External Element dialog box, click the Source button. 

The Add a Report Element dialog box shows the folder with the existing external sources, 
application metrics, surveys, and reports that you have access to.

2 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

3 Click Select. 
4 Click the Select Element button next to the Sentiment Trend Chart external element.
5 Click the Add button. 

The Sentiment Trend Chart external element appears on the dashboard with the Configure 
Source link.

6 Click the Configure Source link for the sentiment trend chart. 
The Edit Dashboard Element dialog box opens.

7 From the External Source list, select the source for the sentiment trend chart. 
The list contains all available connections to Text Analytics that you have added on the My Account 
page.

8 From the Project Name list, select the project for your sentiment trend chart. 
The  list contains all available projects for the selected source.

9 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

10 From the Verbatim list, select the question, which data will be analyzed in the sentiment  trend chart. 
You can select the All option to include all questions.

11 From the Content  list, select the type of content you want to display in the sentiment trend chart.
The following options are available:
• Top Level Categories
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• Category Leaves
• Relationships
• Terms
• Structured Data

12 From the Report by list, select the data parameters upon which the chart is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics for each type of summary. This option is selected by default.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics.
• Sentiment Score – The dashboard item displays the rolled-up sentiment score for each content 

type as returned from Text Analytics. 
13 From the Structured Attribute list, select the attribute for the structured data content. This option 

is only available when you select Structured Data from the Content list.
The following options are available:
• Source ID
• Verbatim Type
• Auto-Detected Language
• Processed Language
• Document Date

14 In the Filter Parameter text box, type the Lucene filter string. For details on how to build filters, see 
Advanced filtering for external Text Analytics dashboard items, page 140.

15 From the Date Range  list, define a date range to filter the sentiment trend chart data. You can filter 
only completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you specify. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date. This filter is selected by default.
• Year to Date – Shows the completed data for the period starting January 1st of the current year 

up until the current date.
• Last Week – Shows the completed data for the past week.
• Last Month – Shows the completed data for the past month.
• Last Quarter – Shows the completed data for the past three months.
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• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
• Last 180 Days – Shows the completed data for the past 180 days.

16 In the Start Date text box, enter the start date manually or by clicking the calendar icon  .

17 In the End Date text box, enter the end date manually or by clicking the calendar icon  .
18 To save the selected settings, click OK. 

The dashboard item is updated immediately.

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the sentiment table.

The current filter appears on the dashboard element's title bar. Hover over the Filtered icon  to view 
the applied date filter in a tooltip. The Sentiment Trend Chart external element added to the 
dashboard does not support the dashboard date filter.
When the Sentiment Trend Chart external element is added to the dashboard, its default size is 50% 
width and 1x height. You can change the dashboard item size according to your needs.
• When the height is set to 1x, the table displays 5 elements per page.
• When the height is set to 2x, the table displays 15 elements per page.
• When the height is set to 3x, the table displays 25 elements per page.
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Sentiment Table external dashboard item
Navigation

Dashboards tab > Add External Element button > Sentiment Table element > Add button.
You can add a Sentiment Table element to the dashboard when Impact 360 Text Analytics is 
selected as an external source. You can use a Sentiment Table report element to view your text analysis 
results in a table. The color indicates the Positive, Neutral, and Negative sentiments. Using the 
Sentiment Table external element, you can view data for the terms, top level categories, category 
leaves, relationships, and structured data created within the responses to the question.
When you add the text analytics element to the dashboard, it appears in the Configure mode. You can 
select the settings for your Sentiment Table element by using the Edit Dashboard Element dialog box 
that you can access via the Configure Source link.

 You can drill down into the sentiment table to view responses.

Add and configure a Sentiment Table external dashboard item

Procedure 
1 In the Add External Element dialog box, click the Source button. 

The Add a Report Element dialog box shows the folder with the existing external sources, 
application metrics, surveys, and reports that you have access to.

2 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

3 Click Select. 
4 Click the Select Element button next to the Sentiment Table external element.
5 Click the Add button. 

The Sentiment Table external element appears on the dashboard with the Configure Source link.
6 Click the Configure Source link for the sentiment table. 

The Edit Dashboard Element dialog box opens.
7 From the External Source list, select the source for the sentiment table. 

The list contains all available connections to Text Analytics that you have added on the My Account 
page.

8 From the Project Name list, select the project for your sentiment table. 
The  list contains all available projects for the selected source.

9 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

10 From the Verbatim list, select the question, which data will be analyzed in the sentiment table. 
You can select the All option to include all questions.

11 From the Content list, select the type of content you want to display in the sentiment table. 
The following options are available:
• Top Level Categories
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• Category Leaves
• Relationships
• Terms (default option)
• Structured Data

12 From the Sort Order list, select the option for the value order in the sentiment table. You can select 
the Descending or Ascending option.

13 From the Report by list, select the data parameters upon which the table is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics. This option is selected by default.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics.
• Sentiment Score – The dashboard item displays the rolled-up sentiment score for each content 

type as returned from Text Analytics.
14 From the Structured Attribute list, select the attribute for the structured data content. This option 

is only available when you select Structured Data from the Content list. 
The following options are available:
• Source ID
• Verbatim Type
• Auto-detected Language
• Processed Language
• Document Date

15 In the Filter Parameter text box, type the Lucene filter string. For details on how to build filters, see 
Advanced filtering for external Text Analytics dashboard items, page 140.

16 From the Date Range  list, define a date range to filter the sentiment table data. You can filter only 
completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you specify. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date. This filter is selected by default.
• Year to Date – Shows the completed data for the period starting January 1st of the current year 

up until the current date.
• Last Week – Shows the completed data for the past week.
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• Last Month – Shows the completed data for the past month.
• Last Quarter – Shows the completed data for the past three months.
• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
• Last 180 Days – Shows the completed data for the past 180 days.

17 In the Start Date text box, enter the start date manually or by clicking the calendar icon  .

18 In the End Date text box, enter the end date manually or by clicking the calendar icon  .
19 To save the selected settings, click OK. 

The dashboard item is updated immediately.

The Sentiment Table element on the dashboard

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the sentiment table.

You can click the column header in the table to sort the results based on the selected column. A sort icon 
indicates which column is used for sorting.
The current filter appears on the dashboard element's title bar. The dashboard element filter overrides 

the whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.
When the Sentiment Table external element is added to the dashboard, its default size is 50% width 
and 1x height. You can change the dashboard item size according to your needs.
• When the height is set to 1x, the table displays 5 elements per page.
• When the height is set to 2x, the table displays 15 elements per page.
• When the height is set to 3x, the table displays 25 elements per page.
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Sentiment Trend Table external dashboard item
Navigation

Dashboards tab > Add External Element button > Sentiment Trend Table element > Add button.
You can add a Sentiment Trend Table element to the dashboard when Impact 360 Text Analytics is 
selected as an external source. You can use the Sentiment Trend Table external element to view your 
text analysis results over the selected date range in a table. The color indicates the Positive, Neutral, and 
Negative sentiments. Using the Sentiment Trend Table external element, you can view data for the 
terms, top level categories, category leaves, relationships, and structured data created within the 
responses to the question.
When you add the text analytics element to the dashboard, it appears in the Configure mode. You can 
select the settings for your Sentiment Trend Table element by using the Edit Dashboard Element 
dialog box that you can access via the Configure Source link.

 You can drill down into the sentiment trend table to view responses.

Add and configure a Trend Table external dashboard item

Procedure 
1 In the Add External Element dialog box, click the Source button. 

The Add a Report Element dialog box shows the folder with the existing external sources, 
application metrics, surveys, and reports that you have access to.

2 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

3 Click Select. 
4 Click the Select Element button next to the Sentiment Trend Table external element.
5 Click the Add button. 

The Sentiment Trend Table external element appears on the dashboard with the Configure 
Source link.

6 Click the Configure Source link for the sentiment trend table. 
The Edit Dashboard Element dialog box opens.

7 From the External Source list, select the source for the sentiment trend table. 
The list contains all available connections to Text Analytics that you have added on the My Account 
page.

8 From the Project Name  list, select the project for your sentiment trend table. 
The list contains all available projects for the selected source.

9 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

10 From the Verbatim list, select the question, which data will be analyzed in the sentiment trend table. 
You can select the All option to include all questions.
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11 From the Content list, select the type of content you want to display in the sentiment trend table. 
The following options are available:
• Top Level Categories
• Category Leaves
• Relationships
• Terms (default option)
• Structured Data

12 From the Sort Order list, select the option for the value order in the sentiment trend table. You can 
select the Descending or Ascending option.

13 From the Report by list, select the data parameters upon which the sentiment trend table is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics. This option is selected by default.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics.
• Sentiment Score – The dashboard item displays the rolled-up sentiment score for each content 

type as returned from Text Analytics.
• % Change in Volume – The dashboard item displays the percent change in the total number of 

distinct verbatims returned from Text Analytics over the selected date range.
• % Change in Sentiment Score – The dashboard item displays the percent change in the rolled-

up sentiment score for each content type as returned from Text Analytics over the selected date 
range.

14 From the Structured Attribute list, select the attribute for the structured data content. This option 
is only available when you select Structured Data from the Content list. 
The following options are available:
• Source ID
• Verbatim Type
• Auto-detected Language
• Processed Language
• Document Date

15 From the Trend Over list, define the period over which you want to track the data. 
The following options are available:
• Day over Day – Shows the results on a daily basis.
• Week over Week – Shows the results on a weekly basis.
• Month over Month – Shows the results on a monthly basis.
• Quarter over Quarter – Shows the results on a quarterly (three months) basis.
• Year over Year – Shows the results on a yearly basis.

 You can view the date range in the Start Date and End Date text boxes. The sentiment trend 
table has no local date filter and is not affected by the dashboard date filter.

16 In the Filter Parameter text box, type the Lucene filter string. For details on how to build filters, see 
Advanced filtering for external Text Analytics dashboard items, page 140.
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17 To save the selected settings, click OK. 
The dashboard item is updated immediately.

The Sentiment Trend Table element on the dashboard

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the sentiment trend table.

You can click the column header in the table to sort the results based on the selected column. A sort icon 
indicates which column is used for sorting.
When the Sentiment Trend Table external element is added to the dashboard, its default size is 50% 
width and 1x height. You can change the dashboard item size according to your needs.
• When the height is set to 1x, the table displays 5 elements per page.
• When the height is set to 2x, the table displays 15 elements per page.
• When the height is set to 3x, the table displays 25 elements per page.
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Add Word Cloud External Dashboard Item
Navigation

Dashboards tab > Add External Element button > Word Cloud element > Add button.
You can add a Word Cloud element to the dashboard when Impact 360 Text Analytics is selected as an 
external source. 
Word cloud is a set of words represented as a cloud that appears in different size and color. The cloud 
gives greater prominence to words that occur more frequently in the source text. The color indicates the 
Positive, Neutral, and Negative sentiments. Using the Word Cloud external element, you can view data 
for the terms, top level categories, category leaves, relationships, and structured data created within the 
responses to the question.
When you add the text analytics element to the dashboard, it appears in the Configure mode. You can 
select the settings for your Word Cloud element by using the Edit Dashboard Element dialog box that 
you can access via the Configure Source link.

 You can drill down into the word cloud to view responses.

Add and configure a Word Cloud external dashboard item

Procedure 
1 Click the Add External Element button at the bottom of the Home page.
2 In the Add External Element dialog box, click the Source button. 

The Add a Report Element dialog box shows the folders with the existing external sources, 
application metrics, surveys, and reports that you have access to.

3 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

4 Click Select. 
5 Click the Select Element button next to the Word Cloud external element.
6 Click the Add button. 

The Word Cloud external element appears on the dashboard with the Configure Source link.
7 Click the Configure Source link for the word cloud. 

The Edit Dashboard Element dialog box opens.
8 From the External Source list, select the source for the word cloud.

The list contains all available connections to Text Analytics that you have added on the My Account 
page.

9 From the Project Name list, select the project for your word cloud. The list contains all available 
projects for the selected source.

10 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all the models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

11 From the Verbatim list, select the question, which data will be analyzed in the word cloud. 
You can select the All option to include all the questions.
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12 From the Content list, select the type of content you want to display in the word cloud. 
The following options are available:
• Top Level Categories
• Category Leaves
• Relationships
• Terms (default option)
• Structured Data

13 From the Report by list, select the data parameters upon which the word cloud is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics. This option is selected by default.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics.
14 From the Structured Attribute list, select the attribute for the structured data content. This option 

is only available when you select Structured Data from the Content list. 
The following options are available:
• Source ID
• Verbatim Type
• Auto-detected Language
• Processed Language
• Document Date

15 In the Filter Parameter text box, type the Lucene filter string. For details on how to build filters, see 
Advanced filtering for external Text Analytics dashboard items, page 140.

16 From the Date Range list, define a date range to filter the word cloud data. You can filter only 
completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you specify. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date. This filter is selected by default.
• Year to Date – Shows the completed data for the period starting January 1st of the current year 

up until the current date.
• Last Week – Shows the completed data for the past week.
• Last Month – Shows the completed data for the past month.
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• Last Quarter – Shows the completed data for the past three months.
• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
• Last 180 Days – Shows the completed data for the past 180 days.

17 In the Start Date text box, enter the start date manually or by using the calendar icon  .

18 In the End Date text box, enter the end date manually or by using the calendar icon  .
19 To save the selected settings, click OK. 

The dashboard item is updated immediately.

The Word Cloud element on the dashboard

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the word cloud.

The current filter appears on the dashboard element's title bar. The dashboard element filter overrides 

the whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.
When the Word Cloud external element is added to the dashboard, its default size is 33% width and 1x 
height. You can change the dashboard item size according to your needs.
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Add Heat Map External Dashboard Item
Navigation

Dashboards tab > Add External Element button > Heat Map element > Add button.
You can add a Heat Map element to the dashboard when Impact 360 Text Analytics is selected as an 
external source. 
Heat map is a graphical representation of data that appears in different size and color. The size indicates 
volume of words that occur more frequently in the source text. The color indicates the Positive, Neutral, 
and Negative sentiments. Using the Heat Map external element, you can view data for top level 
categories and category leaves created within the responses to the question.
When you add the text analytics element to the dashboard, it appears in the Configure mode. You can 
select the settings for your Heat Map element by using the Edit Dashboard Element dialog box that 
you can access via the Configure Source link.

 You can drill down into the heat map to view responses.

Add and configure a Heat Map external dashboard item

Procedure 
1 Click the Add External Element button at the bottom of the Dashboards page.
2 In the Add External Element dialog box, click the Source button. 

The Add a Report Element dialog box shows the folder with the existing external sources, 
application metrics, surveys, and reports that you have access to.

3 Click the arrow next to the External Sources folder, and then select the Impact 360 Text Analytics 
source.

4 Click Select. 
5 Click the Select Element button next to the Heat Map external element.
6 Click the Add button. 

The Heat Map external element appears on the dashboard with the Configure Source link.
7 Click the Configure Source link for the heat map. 

The Edit Dashboard Element dialog box opens.
8 From the External Source list, select the source for the heat map.

The drop-down list contains all available connections to Text Analytics that you have added on the My 
Account page.

9 From the Project Name list, select the project for your heat map. 
The list contains all available projects for the selected source.

10 From the Model Name list, select the model created in Text Analytics for data analysis. 
The following options are available:
• All Models – The data based on all models is analyzed.
• Theme Detection Model – The data based on the theme detection default model is analyzed.

11 From the Verbatim list, select the question, which data will be analyzed in the heat map. 
You can select the All option to include all questions.
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12 From the Content list, select the type of content you want to display in the heat map. 
The following options are available:
• Top Level Categories (default option) – The top level category appears as the parent category at 

the top of the square. The individual category leaves appear as child categories under the 
corresponding top level category.

• Category Leaves
13 From the Sort Order list, select the option for the value order in the heat map. You can select the 

Descending or Ascending option. By default, the Descending option is selected. 
With the Descending option selected, the heat map presents the top ten largest values. With the 
Ascending option selected, the heat map presents the top ten lowest values.

14 From the Report by list, select the data parameters upon which the heat map is based. 
The following options are available:
• Volume – The dashboard item displays the data based on the total number of distinct verbatims 

returned from Text Analytics. This option is selected by default.
• % of Total Volume – The dashboard item displays the data based on the percent of total 

verbatim volume returned from Text Analytics.
• Sentiment Score – The dashboard item displays the rolled-up sentiment score for each content 

type as returned from Text Analytics.
15 In the Filter Parameter text box, type the Lucene filter string. For details on how to build filters, see 

Advanced filtering for external Text Analytics dashboard items, page 140.
16 From the Date Range list, define a date range to filter the word cloud data. You can filter only 

completed data.

 The dashboard date filter does not work for external elements unless you add them from the 
report designer.

The following options are available:
• None – Applies no date filter.
• Custom – Shows the completed data for the date range that you specify. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the completed data for today.
• Current Month – Shows the completed data for the current month, no matter the current date.
• Current Quarter – Shows the completed data for the current three months, no matter the 

current date.
• Current Year – Shows the completed data for the current calendar year, no matter the current 

date. This filter is selected by default.
• Year to Date – Shows the completed data for the period starting January 1st of the current year 

up until the current date.
• Last Week – Shows the completed data for the past week.
• Last Month – Shows the completed data for the past month.
• Last Quarter – Shows the completed data for the past three months.
• Last Year – Shows the completed data for the past year.
• Last 30 Days – Shows the completed data for the past 30 days.
• Last 90 Days – Shows the completed data for the past 90 days.
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• Last 180 Days – Shows the completed data for the past 180 days.

17 In the Start Date text box, enter the start date manually or by clicking the calendar icon  .

18 In the End Date text box, enter the end date manually or by clicking the calendar icon  .
19 To save the selected settings, click OK . 

The dashboard item is updated immediately.

The Heat Map element on the dashboard

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the heat map.

The current filter appears on the dashboard element's title bar. The dashboard element filter overrides 

the whole dashboard filter. Hover over the Filtered icon  to view the applied date filter in a tooltip.
When the Heat Map external element is added to the dashboard, its default size is 50% width and 2x 
height. You can change the dashboard item size according to your needs.
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Sentiment Summary external item filtering
Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button > 
Configure Source link > click the sentiment bar within the chart > View Responses dialog box.
You can add a Sentiment Summary external element to the dashboard to display the overall sentiment 
for the open-ended questions in a bar chart. The overall sentiment is broken down by positive, negative, 
and neutral responses. 
On the Sentiment Summary chart, you can click a sentiment bar and view the text that represents a 
portion of the chart. You can switch between the different sentiments and data types and view the full 
respondents' answers.

 You can drill down into the Sentiment Summary chart to view responses.

Filter responses by Sentiment

Procedure 
1 Add a Sentiment Summary external element to the dashboard.
2 Click the Configure Source link in the Sentiment Summary element.
3 Configure your Sentiment Summary chart.

The hover over percentage on the sentiment summary chart

4 Click the sentiment bar within the chart to filter responses by sentiment. 
The View Responses dialog box opens with all sentences that contributed to that sentiment 
regardless of the data type.

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all responses for the selected category, including positive, negative, and 
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neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
When you hover over the responses text, the Show More Text link appears. To see the full response 
text, click the Show More Text link.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages by clicking the scroll arrows at the bottom of the 
dialog box.
Under Top Level Categories, all categories for the selected question are listed. You can scroll among the 
categories by clicking the up and down arrows. When you select a different category, the response list on 
the right is updated to show the responses that represent that category.

 You can drill down into the Sentiment Summary chart to view responses.
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Sentiment Chart external item filtering
Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button > 
Configure Source link > click the sentiment bar within the chart > View Responses dialog box.
You can add a Sentiment Chart element to the dashboard to display your Text Analytics report in a 
sentiment chart. Thus you can track the sentiment breakdown by content type. On a sentiment chart, 
you can click a top level category name or the bar within the chart and view the text that represents a 
portion of the chart. You can switch between the different sentiments and top level categories and view 
the full respondents' answers.

 You can drill down into the sentiment chart to view responses.

Filter responses by Top Level Categories and Sentiment

Procedure 
1 Add a Sentiment Chart external element to the dashboard.
2 Click the Configure Source link in the Sentiment Chart element.
3 Configure your sentiment chart, and then select Top Level Categories as a content type and 

Sentiment Distribution as a Report by option.
4 Click the sentiment bar next to the top level category within the chart to filter responses. 

The View Responses dialog box opens with all sentences that contributed to that top level category 
and sentiment.

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all responses for the selected category, including positive, negative, and 
neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
When you hover over the responses text, the Show More Text link appears. To see the full response 
text, click the Show More Text link.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages by clicking the scroll arrows at the bottom of the 
dialog box.
Under Top Level Categories, all categories for the selected question are listed. The categories appear in 
the same order as on the chart. Thus, categories with the most number of responses appear at the top of 
the list. You can scroll between the categories by clicking the up and down arrows. When you select a 
different category, the response list on the right is updated to show the responses that represent that 
category.

 You can select only one category and one sentiment at a time. For long category names, hover 
over the name to view the full text.
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Sentiment Trend Chart external item filtering
Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button > 
Configure Source link > click the sentiment bar within the chart > View Responses dialog box.
You can add a Sentiment Trend Chart element to the dashboard to display your text analytics report in 
a sentiment trend chart. Thus you can track  Top Level Categories over the selected date range by clicking 
the trend lines. 
On a sentiment trend chart, you can click a top level category and view the text that represents a portion 
of the chart. You can switch between the different sentiments and top level categories and view the full 
respondents' answers.

 You can drill down into the sentiment trend chart to view responses.

Filter responses by Top Level Categories

Procedure 
1 Add a Sentiment Trend Chart external element to the dashboard.
2 Click the Configure Source link in the Sentiment Trend Chart element.
3 Configure your sentiment trend chart, and then select Top Level Categories as a content type.
4 Click the trend line within the chart to view responses. 

You can hover over a top level category to view its name. The View Responses dialog box opens with 
all sentences that represent that top level category based on the specified trend period regardless of 
the sentiment. 

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option is a default option and shows all responses for the selected category, including 
positive, negative, and neutral. When you select a different sentiment, the response list on the right is 
updated to show the responses that represent that sentiment segment.
When you hover over the responses text, the Show More Text link appears. To see the full response 
text, click the Show More Text link. 
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages by clicking the scroll arrows at the bottom of the 
dialog box.
Under Top Level Categories, all categories for the selected question are listed. You can scroll between 
the categories by clicking the up and down arrows. When you select a different category, the response list 
on the right is updated to show the responses that represent that category.

 You can select only one category and one sentiment at a time. For long category names, hover 
over the name to view the full text.
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Sentiment Table external item filtering
Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button > 
Configure Source link > click the sentiment bar within the chart > View Responses dialog box.
You can add a Sentiment Table element to the dashboard to view your text analysis results in a table. 
The color indicates the Positive, Neutral, and Negative sentiments. 
On a sentiment table, you can click a top level category name and view the text that represents a portion 
of the table. You can switch between the different top level categories and view the full respondents' 
answers.

 You can drill down into the sentiment table to view responses.

Filter responses by Top Level Categories

Procedure 
1 Add a Sentiment Table external element to the dashboard.
2 Click the Configure Source link in the Sentiment Table element.
3 Configure your sentiment table, and then select Top Level Categories as a content type.
4 Click the top level category name within the table to filter responses. 

The View Responses dialog box opens with all sentences that contributed to that top level category 
regardless of the sentiment. See images below.

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option is a default option and shows all responses for the selected category, including 
positive, negative, and neutral. When you select a different sentiment, the response list on the right is 
updated to show the responses that represent that sentiment segment.
When you hover over the responses text, the Show More Text link appears. To see the full response 
text, click the Show More Text link.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages by clicking the scroll arrows at the bottom of the 
dialog box.
Under Top Level Categories, all categories for the selected question are listed. You can scroll between 
the categories by clicking the up and down arrows. When you select a different category, the response list 
on the right is updated to show the responses that represent that category.

 You can select only one category and one sentiment at a time. For long category names, hover 
over the name to view the full text.
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Sentiment Trend Table external item filtering
Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button > 
Configure Source link > click the sentiment bar within the chart > View Responses dialog box.
You can add a Sentiment Trend Table element to the dashboard to view your text analysis results over 
the specified period in a table. On a sentiment trend table, you can click a top level category name and 
view the text that represents a portion of the trend table. You can switch between the different top level 
categories and view the full respondents' answers.

 When no data is returned from the Impact 360 Text Analytics for the selected set of options, 
the No data available notification appears for the sentiment trend table.

Filter responses by Top Level Categories

Procedure 
1 Add a Sentiment Trend Table external element to the dashboard.
2 Click the Configure Source link in the Sentiment Trend Table element.
3 Configure your sentiment trend table, and then select Top Level Categories as a content type.
4 Click the top level category within the trend table to filter responses. 

The View Responses dialog box opens with all sentences that contributed to that top level category 
based on the specified trend period regardless of the sentiment. See images below.

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option is a default option and shows all responses for the selected category, including 
positive, negative, and neutral. When you select a different sentiment, the response list on the right is 
updated to show the responses that represent that sentiment segment.
When you hover over the responses text, the Show More Text link appears. To see the full response 
text, click the Show More Text link.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages by clicking the scroll arrows at the bottom of the 
dialog box.
Under Top Level Categories, all categories for the selected question are listed. You can scroll between 
the categories by clicking the up and down arrows. When you select a different category, the response list 
on the right is updated to show the responses that represent that category.

 You can select only one category and one sentiment at a time. For long category names, hover 
over the name to view the full text.
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Word Cloud external item filtering
Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button > 
Configure Source link > click the sentiment bar within the chart > View Responses dialog box.
You can add a Word Cloud element to the dashboard when Impact 360 Text Analytics is selected as 
an external source. Thus you can track the sentiment breakdown by content type. 
On a word cloud, you can click a top level category name and view the text that represents a portion of 
the word cloud. You can switch between the different sentiments and top level categories and view the 
full respondents' answers.

 You can drill down into the word cloud to view responses.

Procedure 
1 Add a Word Cloud external element to the dashboard.
2 Click the Configure Source link in the Word Cloud element.
3 Configure all settings for your word cloud, and then select Top Level Categories as a content type.
4 Click the top level category name within the word cloud to filter responses. 

The View Responses dialog box opens with all sentences that contributed to that top level category 
regardless of the sentiment.

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all responses for the selected category, including positive, negative, and 
neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
When you hover over the responses text, the Show More Text link appears. To see the full response 
text, click the Show More Text link.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages by clicking the scroll arrows at the bottom of the 
dialog box.
Under Top Level Categories, all categories for the selected question are listed. You can scroll between 
the categories by clicking the up and down arrows. When you select a different category, the response list 
on the right is updated to show the responses that represent that category.

 You can select only one category and one sentiment at a time. For long category names, hover 
over the name to view the full text.
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Heat Map external item filtering
Navigation

Dashboards tab > Add External Element button > Sentiment Summary element > Add button > 
Configure Source link > click the sentiment bar within the chart > View Responses dialog box.
You can add a Heat Map element to the dashboard when Impact 360 Text Analytics is selected as an 
external source. Thus you can track the breakdown by  Top Level Categories by using the heat map. On 
a heat map, you can click a top level category name and view the text that represents a portion of the 
heat map. You can switch between the different sentiments and top level categories and view the full 
respondents' answers.

 You can drill down into the heat map to view responses.

Filter responses by Top Level Categories

Procedure 
1 Add a Heat Map external element.
2 Click the Configure Source link in the Heat Map element to your dashboard.
3 Configure all settings for your heat map, and then select Top Level Categories as a content type.
4 Hover over a segment to view the text that represents a portion of the heat map.
5 Click the top level category name within the heat map to filter responses by top level category. 

The View Responses dialog box opens with all sentences that contributed to that top level category 
regardless of the sentiment.

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all responses for the selected category, including positive, negative, and 
neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
When you hover over the responses text, the Show More Text link appears. To see the full response 
text, click the Show More Text link.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages by clicking the scroll arrows at the bottom of the 
dialog box.
Under Top Level Categories, all categories for the selected question are listed. You can scroll between 
the categories by clicking the up and down arrows. When you select a different category, the response list 
on the right is updated to show the responses that represent that category.

 You can select only one category and one sentiment at a time. For long category names, hover 
over the name to view the full text.
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Add Tableau elements to the dashboard
Navigation

 tab > Add External Element button.

You can add views created in Tableau to the EFM dashboard to monitor and analyze your report data in 
the EFM application.

Before you begin 

• Ensure that the Tableau Server feature and the  tab are configured for your workgroup.
• Ensure that the External Sources permission is enabled for your workgroup.

Procedure 
1 On the Dashboards page, click the Add External Element button.
2 In the Add External Element dialog box, click Source.
3 In the Add a Report Element dialog box, click Tableau, and then click Select.
4 In the Add External Element dialog box, click Select Element, and then click Add.

The Tableau report element is added to the dashboard.
5 In the Tableau Report Element, click the Configure Source link.
6 In the Source dialog box, in the Select Tableau View list, click one of the Tableau views, and then 

click OK.
The Tableau view is applied to the dashboard element and is as interactive as in the Tableau 
application.

 All users who have access to the workbook in Tableau, can see the Tableau elements on the EFM 
dashboard.

7 To edit the Tableau element, click the Edit in Tableau button (available only for the Publisher of the 
Tableau workbook).

 You can interact with Tableau elements on the EFM dashboard according to your site role in the 
Tableau application. If you have the Viewer permissions, you can only view the Tableau elements 
on the EFM dashboard. If you have the Publisher permissions for the Tableau workbook, you can 
edit the Tableau elements by using the Edit in Tableau button.

8 To repeat or discard your changes, click the Undo, Redo, or Revert button correspondingly.
9 To share the Tableau elements with other users, on the EFM dashboard, click Share.

 The Tableau elements are shared and displayed to the users who have permissions to see them in 
the Tableau application.
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Tableau view
If you have a dashboard with the Tableau element, or if you delete all the elements from your dashboard 
except the Tableau element, the Tableau view is automatically applied to your dashboard.
The Tableau view is different from the standard dashboard view. If you have the Tableau view, the 
following advantages are available:
• Full-page view of dashboard element
• Menu with Duplicate, Share, Edit, and Delete options
• Editable dashboard title

 You can change the Tableau view to the standard dashboard view by adding a new report 
element.
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My Surveys grid
Navigation

Design & Collect tab > Surveys tab > My Surveys page.

You can open, design, collect, analyze, view, organize, customize, copy, and delete your surveys. You can 
also customize the appearance and number of surveys displayed in the grid.
On the Viewing menu, you can select the following folders:
• My Surveys – View a list of the created surveys.
• For Review – View a list of surveys that are being reviewed.
• Shared Surveys – View a list of surveys shared with you by other users.
• Other Users’ Surveys – View a list of surveys created by other users.
• Recycle Bin – View a list of surveys that you deleted from your folders.
• Workgroup – The workgroup hierarchy is available if you have the View All Surveys 

permissions. The root workgroup is your scoped workgroup. When you select a workgroup on the 
Viewing, all surveys for all users in the selected workgroup and its child workgroups appear in the 
grid.

The My Surveys folder
The following options are available on the Actions menu:
• Duplicate – Duplicate the selected survey. In the Duplicate a Survey dialog box, you can 

include all campaigns, participants, and reports associated with this survey by selecting 
corresponding check boxes or just duplicate a survey without them. For more information, see 
Duplicate a survey, page 190.

• Rename – Change the name of the selected survey.
• Delete – Move one or more selected surveys to the recycle bin. You can also select the check box 

in the column header to select all surveys. If a survey is used as a source in a data set, you cannot 
delete the survey.

• Share – Provide users the Full Access to view and edit the selected survey or the View Access 
to view the selected survey.

• Change Owner – Select a user to be a new survey owner.
• New Folder – Create a new folder or subfolder.
• Move – Move the selected survey to a different folder. On the Actions menu, point to Move, 

and then click the necessary folder.
• Preview – Preview the selected survey in a new window. You can preview all surveys with the 

Open, Closed, or Design status.
• Review History – View the history of all changes made to the survey.

The Recycle Bin folder
The following options are available on the Actions menu:
• Restore – Move the selected survey from the recycle bin to its original folder location.
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• Delete Permanently – Delete the selected survey permanently from the recycle bin. This action 
removes the survey from the application with all the associated participants lists, invitations, and 
reports.

 The option is available if you have the Allow users to permanently delete surveys from the 
Recycle Bin check box selected, the Manage Data Policies permission to view the Data 
Policies page, and the Permanently Delete Surveys permission.To disable the Delete 
Permanently option, clear the check box.

 You can schedule the automatic survey deletion for all your closed surveys on the Configuration 
tab > Data Policies tab > Surveys tab > Data Retention section. 

• Preview – Preview the selected survey in a new window. You can preview all surveys with the 
Open, Closed, or Design status to ensure that you want to delete the selected survey before 
deleting it permanently.

Search for a survey
To search for a survey in the My Surveys grid, enter the survey name, tag, or author in the Search box 
on the toolbar, and then click Search. The results of the search appear in the grid with the corresponding 
notification. To delete the search results, click the Clear link.

Links
In the My Surveys grid, the following links are available for each survey:
• Design – Click to create, edit, and review your survey.
• Collect – Choose how to collect the results from your survey
• Analyze – Export response data from your survey into .xlsx, .csv, and .tsv files.
• Survey Link – Click to view a live version of the selected survey.

The Survey link

With the following links, you can:
• Design – Create, edit, and review questions and properties.
• Collect – Choose how to collect your survey.
• Analyze – Export response data from your survey into .xlsx, .csv, and .tsv formats.
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 The Survey Link is only available for the opened surveys.

Organize the My Surveys grid
To sort your surveys by survey titles, status, or the last modified date, click the corresponding column 
heading. By default, your surveys are sorted by the last modified date.

 You can also change column widths by dragging the edge of column headers.

By default, the My Surveys grid shows the first 10 surveys. To view more items per page, use the View 
per Page option at the bottom of the My Surveys grid. Click 25, 50, or 100 to display more surveys.
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Folder structure
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Viewing menu.

 If you have no saved surveys, the Welcome Page is displayed and the Folder Structure feature 
is not applied until you save a survey.

With the Folder Structure feature, you can  add folders and subfolders to your My Surveys folder. Use 
this feature to organize your surveys. Once you create a folder or subfolder, you can rename, move, or 
delete it. 
If you are a survey administrator, you can select another user to see their My Surveys folder. This folder 
is selected by default. However, if you select other users’ folder, you can view the contents of their My 
Surveys folder.

 If you are not a survey administrator, you can only view your own folder structure.

In addition, when you create a new survey, it is saved in the folder or subfolder you have selected in the 
folder structure of your My Surveys page. For example, if you open a folder titled My Business 
Surveys, and then create a new survey, the new survey is saved to the My Business Surveys folder.
You can also view the surveys of other users and organizations within your workgroup.

Add a new folder

Procedure 
1 Go to the My Surveys grid > Actions menu, click New Folder. 

A dialog box opens.
2 In the text box, enter a name for the new folder, and then click OK.
3 On the Viewing menu, your new folder appears.

Add a new subfolder

Procedure 
1 On the Viewing menu, select the folder you want to add your subfolder to.
2 On the Actions menu, click New Folder. A dialog box opens.
3 In the text box, enter a name for the new folder. Click OK.
4 On the Viewing menu, your new folder displays.



Design and Collect My Survey folder enhancements

EFM User Guide 173

Confidential and Proprietary Information of Verint Systems Inc.

My Survey folder enhancements
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Viewing menu.

The new enhancements to the survey folders include:
• Side and bottom scrolling bars to easily access all of your folders and surveys.
• Easily move folders and subfolders – You can drag-and-drop folders/subfolders to a new location 

in the left pane. 
OR
To manage folders/subfolders, go to the My Surveys grid  > Actions menu > click Move.

• New Other Surveys folder – If you have the proper permission, you can see other user's survey 
folders at this location.

• Administrative users have the ability to move user folders through the Other Surveys folder 
structure. Moving folders produces warning alerts for your safety.
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Search for a survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Advanced Search.

With the search functionality, you can search and locate a particular survey per a workgroup.

Procedure 
1 On My Surveys page, next to Quick Filters, click the Advanced Search link. 
2 On the Search page, click the drop-down arrow in the search box (next to Survey name contains), 

and then select your option criteria. 
There are the following options:
• Survey name contains – Use this option if you know the survey name or a keyword from the 

name.
• Author name contains – Add the name as a criteria, if you know the survey author.
• Tag name contains – Search for a survey by its tags.
• URL of survey – Search by survey URL if you have access to the URL (possibly through an 

invitation or reminder that was sent).
• Project ID equals – Search by survey ID number.
• Created before – Use this option that is used in conjunction with a specified date.
• Created after – Use this option that is used in conjunction with a specified date.
• Opened before – Use this option that is used in conjunction with a specified date.
• Opened after – Use this option that is used in conjunction with a specified date.

3 In the adjacent text box, add your search text.
4 Click the Search button, and then your results appear.

Additional options
You can add multiple search criteria by clicking the Add Criteria link. Add your criteria, and then click the 
Search button. 
To remove one criteria, click the Remove link.
To remove all criteria, click the Reset Criteria button.
There are two options available in the Match section:
• All Criteria – Conducts the search based on each criteria you specify and returns only the surveys 

that meet all criteria.
• At Least One – Returns surveys that match at least one of the criteria specified.

Search results
If the user search for any keyword with the Survey name contains search option, the search results 
show the following information (if available):
• Survey Name
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• Survey Description
• Survey Author Name and Email Address
• Workgroup Name
• Survey Created Date
• Survey Opened Date (if a survey is published)
• Link to Survey
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Hiding the Surveys start page
Navigation

Log in to the EFM application >  Surveys start page.

You can skip the Surveys start page if you do not want to create new surveys.

 If you do not have permissions to create surveys, you skip the Surveys start page automatically.

Hide the Surveys start page

Procedure 
1 Log in to the EFM application.
2 The Surveys start page opens, if you do not have any saved surveys.
3 To hide the Surveys start page and quickly access the other functionality, click the Don't show this 

page again link. 
If you hide the Surveys start page, you go directly to the My Surveys page.

Restore the Surveys start Page

Procedure 
1 Go to My Account option > My Account  tab.
2 Above the Define Log-on Experience section, click the Reset Hidden Help Messages button. 

The Surveys start page is restored, and notification appears at the bottom of the My Account side 
tab saying that the help messages are reset.

 Keep in mind that clicking the Reset Hidden Help Messages button restores all hidden help 
messages, including the banner on the My Surveys page and confirmation dialog boxes.
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My Surveys hide banner
Navigation

Surveys tab > Hide This button.

You can hide the banner on the My Surveys page to view a larger list of surveys and reduce the amount 
of scrolling through the page. 
To hide the banner, on the My Surveys page, click the Hide This button.

The Hide This button

To restore all help messages including the hidden banner  on the My Surveys page and confirmation 
dialog boxes for deleting your survey pages and questions, go to the My Account tab and click the 
Reset Hidden Help Messages button. 
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Snapshots
Navigation

Design & Collect tab > Surveys tab > My Surveys page > click the arrow next to the survey for which 
you want to view a snapshot.

The snapshot provides different information depending on the current survey status (Design, Open, or 
Closed). You can view only one survey snapshot at a time. For multiple-campaign surveys, the last added 
campaign is displayed in the snapshot.
To view a snapshot of your survey, click the black arrow next to the survey name. 
When the survey is in the Design mode, a snapshot shows up to three survey pages with five questions 
across all pages. You can use the available links and options to design, download, test your survey, and 
select the method to collect your survey results.

Snapshot of survey in Design mode

 To close an open snapshot, click the arrow next to the survey title. The current snapshot is also 
closed when you open a new snapshot.

When the survey is in the Open mode, a snapshot shows a summary of the Overview dashboard. You 
can use the available options to view and export the survey responses and create reports on the current 
survey results.
When the survey is in the Closed mode, a snapshot shows the final survey results. You can use the 
available links and options to analyze results of your survey as well as open your survey again or edit your 
survey schedule, etc.
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Feedback Intelligence Snapshots
Navigation

Design & Collect tab > Surveys tab > My Surveys page > click the arrow next to the survey for which 
you want to view a snapshot.

If a survey is added to Feedback Intelligence by your system administrator, the Feedback Intelligence 
statistics is displayed in the survey expansion under the survey list.
The Feedback Intelligence statistics contain the universe name, universe statistics, and data statistics:
• Created – Date the universe was created.
• Modified – Last time when the universe was changed. The date is changed only in connection 

with the Push to Feedback Intelligence updates.
• Status – Current universe status in Feedback Intelligence.
• Last Load – Last time when the responses were processed by Feedback Intelligence.
• FI Records – Number of records that are added to the Feedback Intelligence database response 

table.
• Pending – Number of records waiting to be added to Feedback Intelligence. This number includes 

all records that were not added to Feedback Intelligence previously.

Feedback Intelligence statistics



Design and Collect Survey status definitions

EFM User Guide 180

Confidential and Proprietary Information of Verint Systems Inc.

Survey status definitions
There are three survey status options: Design, Open, and Closed. For details about each of the statuses, 
see Survey Status, page 549.
You can view the status of your survey in the following places in the application: 
• My Surveys page > Status column
• Design view > Action toolbar
• Collect view > Overview dashboard or Campaigns dashboard (for multiple-campaign surveys)

Status in Design view

Design Mode
A survey is in the design mode when it is first created and remains in the design mode until the survey is 
opened for the first time. The Design mode is where you add your questions and apply appearance 
options. In addition, you can copy, move, or delete your questions in this mode. To create a survey, select 
the Design from Scratch option on the Welcome page or My Surveys page. For details, see Survey 
designer overview, page 226.

 Once a survey is changed to the Open mode, it can never return to the design mode. Changes 
can be made in the Open mode and applied, but the status remains as the Open. The 
modification of the previously published questions might impact the collected results.

Open Mode

Procedure 
1 Log in to the EFM application.
2 In the My Surveys grid, click the needed survey.
3 In the Collect view, and then select one of the distribution methods.

If you select the Generate Link distribution method, the Open Survey dialog box opens straight 
away.  

4 In the Open Survey dialog box, click the Open Survey Now button.
You are then provided with a URL for your survey that you can distribute to your participants.

 If you make changes to your survey while in the Open status, a note appears notifying you to 
apply your changes.
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Closed Mode
Your survey is moved to the Closed mode when you close the survey. 
To close a survey that is in the Open mode, in the Collect view, click Close Survey Now. 

 Testing a survey has no implication on the status of a survey in any mode. A survey can be tested 
and re-tested as often as needed and the status will not change.
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Navigation based on the survey status
Navigation

Design & Collect tab > Surveys tab > My Surveys page.

On the My Surveys page, click the survey, and that triggers the following:
• For surveys with the Design status, the Design view opens.
• For surveys with the Open status, the Collect view opens.
• For surveys with the Closed status, the Analyze view opens.
If you have no access the Analyze view, for example, nothing will happen when you click the survey 
name in the My Surveys grid.
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Exporting a survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Actions menu > click Export > select the required option for the survey export. 

You can now export your survey to the .docx, .pdf, or .que format. In addition, you receive an e-mail 
report if the task takes longer than two minutes.
• .doc and .pdf – These options enable you to save the survey to a file that can be printed or 

forwarded to others.
• .que – This option enables you to save the survey to a file that is an .xml document and contains 

all the important design information applied in the Design view. You can send this file to another 
EFM user to create a new survey.

You can also export translated surveys to the .doc and .pdf formats. It is possible to export all survey 
translations to one document. Each translation then begins from the new page in the document 
indicating the language of the translation in the caption.

Procedure 
1 In the Design viewI, on the Actions menu on the toolbar, click Export, and then select the 

corresponding file format. 
The available options are .docx, .pdf, and .que.

2 When exporting to MS Word, select the Content Review survey type if you want to include all the 
survey logic into the export file.

3 When exporting to MS Word or PDF, select the translated surveys from the  Survey Language(s) 
menu.

4 Click Export. 
The export file is generated in the selected format.

5 Click the link with the file name to save or open the file.
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Survey export preview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Actions menu > Preview option.
You can preview all of your survey on one page and print it out to edit, store, or share. The Preview 
window shows all questions, except for the hidden questions, and does not include menus and buttons. 
The Preview mode is available for all existing surveys in the Design, Open, or Closed status. You can 
also preview your survey in the Recycle Bin folder to ensure that you want to permanently delete your 
survey.

How to print a survey
1 On the My Surveys page, select a check box next to the survey that you want to print.
2 Click the Preview button on the toolbar. 

The print preview version of your survey appears in a new browser window.
3 On the File menu, click Print.
4 Set up your print options, and then click Print.



Design and Collect MS Word and PDF export options

EFM User Guide 185

Confidential and Proprietary Information of Verint Systems Inc.

MS Word and PDF export options
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Actions menu > Export > Microsoft Word or PDF option > Export Survey dialog.

When you export a survey to the Microsoft Word or Adobe PDF format, you can choose between the 
following two types of the survey to export:
• Content Review – Include all survey branching and conditional visibility. This option is selected 

by default.
• Paper Survey – Include only survey questions and text.

Content Review
Include survey branching and conditional visibility into the export file. The following logic is exported:
• Advanced branching
• Question destinations
• Choice destinations
• Notifications about the conditional visibility of pages, questions, choices, and rows
The question headings are exported automatically regardless of the survey settings.

 If the survey contains one or more branches, in the export file, they appear at the end of the 
pages they are evaluated on. The branch set to be evaluated at the end of the randomized or 
rotated block, in the export file, appears at the end of each page in the block.

Paper Survey
Include only survey questions and text into the export file. The question headings are exported according 
to your survey settings. The question destinations are exported if they are defined in the survey.

You can view the details about the Export Survey event on the Administration tab > System Tasks  
tab.

 If the survey export takes more time than the specified timing on the My Account page for the 
task to be completed, you can close the Export Survey dialog box and task will continue running 
in the background. When task is completed, the email message with a link to the survey export 
will be sent to you.
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Push a survey to Feedback Intelligence
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey > Actions menu > 
Push to Feedback Intelligence option.

You can update and filter your surveys in Feedback Intelligence with the Push to Feedback Intelligence 
option. This option is available if your survey is published by you and added to Feedback Intelligence by a 
System Administrator of your workgroup. The System Administrator can also turn the Push to Feedback 
Intelligence option on or off for a certain survey. You can push to FI a survey with one or multiple 
campaigns.

 When you update the existing survey in Feedback Intelligence, changes that you made to the 
survey may affect the previously generated Feedback Intelligence universe, which may change or 
damage the existing reports. If you have reports based on this survey, it is recommended that 
you discuss your survey changes with a support manager before submitting this update.

When a survey is added to Feedback Intelligence, you can access and filter responses from all campaigns.
You can view and use the following columns for creating report elements in Business Objects and 
Tableau: Current Survey, Respondent Fields, Panelists, Profiles, Surveys, Respondent System 
Information, Respondent Location, Campaign ID, Campaign Name, Campaign Type, and 
Campaign Status.

 If you added a survey to Feedback Intelligence when the possibility to send only the first 
campaign was supported, to make all campaigns available in Feedback Intelligence for reporting, 
push the survey to Feedback Intelligence again.

All survey campaigns that have the Active status are exported to Feedback Intelligence.

 

Procedure 
1 On the Surveys tab, select the survey that you want to update in Feedback Intelligence.
2 On the Actions menu, click Push to Feedback Intelligence. 
3 In the confirmation dialog box, click OK. 

Your survey is marked to be updated in Feedback Intelligence.

The Push to Feedback Intelligence option
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Export a survey to EFM Offline Mobile (PC edition)
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Actions menu >  Export option.

You can export a survey to the .que format, and then import it into the EFM Offline Mobile (PC edition) 
product to conduct it offline.

 You cannot import SMS surveys and Require a Passcode surveys to EFM Offline Mobile (PC 
edition).

Some functionality that is available in EFM is not available for use with the EFM Offline Mobile. This 
includes:
• Hierarchical questions
• Image Upload questions
• Quota Management
• Event triggers while taking the survey
• End Page Redirects/URLs if not online
• Web Services Event Handler

Before you begin 
• Open a survey.
• Add the Offline Device campaign to your survey on the Collect tab (Adding multiple campaigns to 

survey, page 586).

Procedure 
1 Go to the Design view of the survey designer.
2 On the Actions menu on the toolbar, click Export, and then click EFM Offline Mobile.

The export file is generated in the .que format.

 You can also export your survey to EFM Offline Mobile directly from the Offline Devices widget 
on the Collect tab (see Adding multiple campaigns to survey, page 586).

3 To save or open the file, in the Export to EFM Offline Mobile dialog box, click the link with the file 
name.

4 Click Close.

 For details about importing the exported survey into the EFM Offline Mobile (PC edition) product, 
refer to the EFM Offline Mobile Quick Start Guide.
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Share a survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Actions menu.
You can share your survey to allow other users or organizations to access your survey. You can share any 
existing survey from the My Surveys page or from the Properties tab in the left pane of the survey 
designer. The following sharing options are available:
• View Access – The user can only view the survey shared with that specific user.
• Full Access – The user can view and edit the survey shared with that specific user.
You can also share multiple surveys with several people at a time. When multiple surveys are selected, 
you can only add Authors or Viewers. Open an individual survey to view who has access and remove 
Authors or Viewers as needed.

 You can share surveys only when the survey sharing permission is activated for your user role.

In the Share Access dialog box, the list of users and organizations  contains maximum 200 user names. 
To search for specific user or organization, use the search box at the top of the list.
You can share a survey with only some users from an organization if you do not want to share your 
survey with the whole organization.

Procedure 
1 On the My Surveys page, select the check box next to the survey that you want to share.
2 On the Actions menu, click Share. 
3 In the Share Access dialog box, you can view a list of users and organizations.
4 Select a check box next to the user or an organization from this box, and then click the right arrow to 

move them to the Full Access or View Access box.

 All users assigned to the selected organization as well as all child organizations will be moved to 
the selected right box too. You can move back the users or organizations you do not want to 
share the survey with, by selecting the corresponding check boxes and clicking the left arrows 
button.

5 To send the email notification to the users allowed to view or edit the survey, select the Notify Users 
by Email check box. 
The check box is selected by default.

 All users assigned to the selected organization will receive the email notification of the survey 
being shared with them. The email will include a link to the shared survey.

6 Click OK.
7 In the Notify Users dialog box, edit your email notification, and then click OK.

 The Notify Users dialog box opens only when the Notify Users by Email check box is selected.
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Stop the survey sharing
Select a single survey to view the list of users who have access to it and stop the survey sharing.

Procedure 
1 On the My Surveys page, select the check box next to the previously shared survey.
2 On the Actions menu, click Share. 

The Share Access dialog box opens.
3 In the Full Access or View Access text box, select the check boxes next to the users or organizations 

that you want to stop the survey sharing with.
4 Click the left double arrows button  to move the selected user to the left text box.
5 Click OK. 

The survey is no longer available for the users and organizations.
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Duplicate a survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Actions menu > Duplicate option.

You can copy your survey instead of creating and designing a new one from scratch. The survey duplicate 
is an unpublished survey without any of the responses received in the original survey.

 The copied survey is in the Modern survey rendering by default, even if the original survey is in 
the Classic survey rendering.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

To avoid duplicating a survey that contains the insecure code, on the General Setup page, select the 
Automatically remove insecure code from survey designer check box. For more information, see 
General Setup, page 1406.

Procedure 
1 In the My Surveys grid, select a survey that you want to duplicate.
2 On the Actions menu, click Duplicate.
3 In the Duplicate a Survey dialog box, in the Survey Name box, change the duplicate survey name 

if needed.
4 To include all campaigns associated with this survey, select the corresponding check box. The 

invitations and reminders for each campaign, as well as the survey logic based on Campaign Name 
are also copied to the duplicate survey.

 This option is unavailable for an SMS surveys.

5 To include all reports associated with this survey, select the corresponding check box. 

 If your survey report has a set filter based on Campaign Name,  when including both campaigns 
and reports, the filter will be duplicated as well. When including only one of the options, the filter 
data will be lost.

This option is unavailable if there are no reports for the survey.
6 To include all participants associated with this survey, select the corresponding check box. This option 

is unavailable if the Include all campaigns associated with this survey option is not selected.

 All the participants are copied into the duplicate survey with the Not Sent status.

7 Click OK.
The duplicate of your survey is displayed in the My Surveys grid.

 If a survey has weighting defined, the survey duplicate preserves this weighting.
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Delete a survey permanently
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey > Delete button > 
Viewing menu > Recycle Bin option > Actions menu > Delete Permanently option.

The Delete Permanently feature is used to remove a survey from your system and all associated 
invitations, reports, and participant lists. 

 To permanently delete surveys, you must have the Manage Data Policies permission to view 
the Data Policies page, the  Permanently Delete Surveys permission, and the Allow users 
to permanently delete surveys from the Recycle Bin check box selected. Go to 
Administration > Roles, and then click the name of the role you want to edit.

 To test Delete Permanently feature,  make a copy of any survey, and then follow the procedure.

Procedure 
1 On the My Surveys page, delete a survey.

The deleted survey is moved to the Recycle Bin folder.
2 Go to the  Viewing > Recycle Bin folder, select the check box next to the survey that you want to 

delete permanently.
3 On the Actions menu, click Delete Permanently. 
4 In the warning dialog box, type the word DELETE (all caps), and then click the Delete button.

Tips
1 There are safeguards to ensure surveys are not permanently deleted accidentally (Delete 

Permanently warning dialog box). If you ignore all of the warnings and permanently delete your 
survey, there are no options to restore it.

2 If you get to the point of receiving the warning dialog box, and decide you do not want to delete the 
survey, simply click Cancel.

3 You will be able to view a report or survey that had piped in responses from the deleted survey.
4 Permanently deleting a survey does not impact the panelist health score.
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Automatic survey permanent deletion
Navigation

Configuration tab > General tab.

A Group Administrator can activate the automatic survey permanent deletion to permanently delete 
surveys from the recycle bin to stay compliant with contractual obligations involving customer data.
To activate this option, on the General tab, on the Configuration tab, select the Enable automatic 
survey permanent deletion check box.

 The automatic survey permanent deletion is disabled by default.

You can define the time duration a survey is stored in the recycle bin before it is permanently deleted by 
the system. Enter the number of days in the Survey Hard Deletion Days text box in the Delete 
permanently setup section.

 You can enter only whole numbers in the Survey Hard Deletion Days text box.

By default, the duration of survey storage in the recycle bin before automatic permanent deletion is set 
to 45 calendar days. To disable automatic survey permanent deletion, set it to 0 days.

 The Survey Hard Deletion Days text box is only active when the Enable automatic survey 
permanent deletion check box is selected.

The permanent deletion date shows in the warning message when you move the survey from the My 
Surveys page to the recycle bin. Keep in mind that you will lose all survey data including links and 
responses without any chance to restore it after permanent deletion.

The Enable automatic survey permanent deletion check box is available for group administrators 
only. For example, when you log in as a survey administrator, you have a limited view of the General 
Setup page functionality. In such case, you can disable the automatic survey permanent deletion by 
selecting the Disable Permanent Survey Deletion for Survey Authors check box.

When the automatic survey permanent deletion is activated, the Permanent Deletion Date column 
displays in the My Surveys grid in the Recycle Bin folder, showing the date of survey permanent 
deletion.

Activate the Automatic Survey Permanent Deletion

Procedure 
1 Go to the Configuration tab > General tab.
2 On the General Setup page, select the Enable automatic survey permanent deletion check 

box.
3 In the Survey Hard Deletion Days text box, enter the number of days a survey is stored in the 

recycle bin.
4 Click Save Setup.
5 In the warning message, click Continue.
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Create a survey from Scratch
Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option.
 

You can create a survey from scratch in two ways:
• By using the New menu on the My Surveys page.
• By using the corresponding button on the survey welcome page.

Procedure 
1 On the My Surveys page, in the New menu, click Design from Scratch.
2 In the Name Your Survey dialog box, type the name for your survey, and click OK.

The new survey opens in survey designer.
3 In Survey Designer, add and edit your survey questions, configure survey logic and design options, 

export, and test your survey.
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Create from Word
 

Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Import Survey option.

You can create a survey by importing it from a Microsoft Word (.doc and .docx) or EFM survey (.que) file 
using the Import Survey option. 
Importing from Microsoft Word is recommended for experienced users of the application who can build 
the survey using special formatting in the document. In the Import Survey dialog box, you can download 
a Microsoft Word survey example for your reference.
You can access the Import Survey option in the following ways:
• By using the New menu on the My Surveys page.
• By using the corresponding button on the survey welcome page.
 

When you import a file into the survey, the Design tab opens with the first question selected. You can 
edit your survey, save changes to it, and then publish it.

 The imported survey is defaulted to Modern survey rendering, even if the original survey is in 
Classic survey rendering. 
Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

 To avoid importing a survey that contains the insecure code, on the General Setup page, select 
the Automatically remove insecure code from survey designer check box. For more 
information, see General Setup, page 1406.

Procedure 
1 On the My Surveys page, from the New menu, select Import Survey.
2 In the Import Survey dialog box, click Browse to navigate to the file that you want to upload. 

The available file formats are Microsoft Word (.doc and .docx) and EFM survey (.que).
3 Select the file, and then click Open.

 The Create Survey button is available when you upload a file.

4 Click the Create Survey button. 
The survey created from the selected file is opened in survey designer.
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Create from template
 

Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Use a Template option.

You can create a survey from a wide variety of predefined templates that are available within the EFM 
library. The template already contains the questions, which makes creating a survey quicker and more 
efficient.
You can access the Use a Template option in the following ways:
• By using the New menu on the My Surveys page.
• By using the corresponding button on the survey welcome page (if you have no saved surveys 

yet).
 

When you create a survey using the template, the Design tab opens with the first question selected. You 
can edit your survey, save changes to it, and then publish it.

Procedure 
1 On the My Surveys page, from the New menu, select Use a Template. 
2 From the Use a Template dialog box, select a template from the list.

 To preview a template in the right pane, click the needed template.

3 Click the Create Survey button.
The survey with the selected template opens in Survey Designer.
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Distribution Events calendar
Navigation

Design & Collect tab > Events tab > Distribution Events page.

With the Distribution Events calendar, can view all survey distribution events that have been scheduled 
by using the EFM application. 
Distribution events for all your surveys appear on the calendar. The group administrators can also view 
the survey distribution events for the workgroup. On the Distribution Events page, a calendar appears 
in the left pane showing the survey distribution events scheduled for the current month. You can 
navigate through the calendar by using navigation arrows at the top.
In the Distribution events to display section, select check boxes next to the following events to be 
displayed on the calendar: 
• Opening date
• Closing date
• Invitation date
• Reminder date
• Thank You message date
You can hover over an icon to view the event information in a tooltip. When multiple events are 
scheduled for a single day, the Plus   icon appears next to the event icon on the calendar.
The detailed 24-hour view of the current week is displayed to the right. To open the Overview 
dashboard for the corresponding survey, click the event icon.
If the survey is scheduled for transaction events, a corresponding notification is displayed below the 
calendar. 
To open the Overview dashboard for the survey, in the notification, click the survey name link.
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Distribution Events quick filtering
Navigation

Design & Collect tab > Events tab > Distribution Events page > Quick Filters option.

You can filter survey events. Quick filters are predefined filters you can use to quickly get to the survey 
events that you need.
The following options are available:
• Owned by Me – View all events of the surveys owned by you.
• Shared with Me – View all events of the surveys shared to you or your organization.
When you apply a quick filter to the surveys, a notification describing the current filter appears on the 
Distribution Events page. 
To cancel the filtering, click the Clear link.
 

You can view the owner of the survey event you do not own by hovering over the event icon in the 
calendar.
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Polls page
Navigation

Design & Collect tab > Polls tab > Polls page.

You can create polls to collect answers to a single question quickly and easily without designing a full 
survey. Use polls to gain feedback from your respondents on a hot topic or current event and view the 
results immediately.
The Polls page provides you information on each poll you created. You can sort polls by clicking the 
column heading. To change the width of a column, drag its edge. In addition, you can display more or 
fewer polls on the Polls page. At the bottom of the page, a toolbar enables you to adjust the number of 
polls that displays on one page. The default number of polls per page is 10; however, you can select up to 
100 polls to display on the Polls page.
To manage all polls, select the check box in the upper-left corner of the Polls page.
The following columns are available on the Polls page.
• Poll Title – Name of a poll, which is your poll question.
• Last Modified – Last time when you made changes to the poll.
• Total Responses – Total number of poll answers collected from respondents.
• Preview Poll – View how your poll will actually appear to participants on your Web page.
• View Code Snippets – View the HTML code of a poll to copy this code to your Web page.
• View Results – View the current poll statistics, which includes the total number of poll responses 

and their breakdown.
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Create a new poll
Navigation

Design & Collect tab > Polls tab > Polls page.

You can create polls to collect answers to a single question quickly and easily without designing a full 
survey. Use polls to gain feedback from your respondents on a hot topic or current event and view the 
results immediately.

Procedure 
1 On the Polls tab, click the New button on the Polls toolbar to create a new poll. The following dialog 

box opens where you can specify your main poll information, such as your poll question and its type, 
up to ten response options, predefined count values, text of the poll buttons, and your poll closing 
date.
• Poll Question – Type your own poll question, for which you want to collect answers from 

respondents.
• Option – Type response options of your poll question.
• Count – Type numbers to predefine answers for your poll participants. This option is useful if you 

want your poll to initially show data rather than zeros.

 The numbers you enter into the "Count" fields are included in your poll results. Deduct these 
numbers from your final statistics to get your actual poll results.

• Vote Button Text – Edit text of the Vote button in your poll if needed.
• View Results Button Text – Edit text of the View Results link in your poll if needed.

 If you include the View Results link into your poll, poll participants can click this link to skip 
directly to the poll results without casting a vote.

• Style of Poll – Specify the type of your poll question. The following options are available:
- Choose One – Enable your poll participants to choose only one answer to your poll question.
- Choose Many – Enable your poll participants to choose more than one answer to your poll 

question.
- Star Rating – Enable your poll participants to rank variables by using the star rating. The 

number of stars matches the number of question choices, for example, if there are 5 choices 
in the question, you can rate each choice from 1 to 5 stars. When you hover over the star, the 
current star and all preceding stars appear in yellow, and the current choice text is displayed in 
a tooltip. Respondents can answer the question by clicking the star under the selected 
position.

• Close poll to voting and display the results after – Specify the date when you want your poll 
to close and stop accepting responses.

2 After completing your main poll information, click the Next button. The following dialog box opens 
where you can control the appearance of your poll and its results by customizing the font, color, 
borders, and so on. 

3 To save your poll and close the dialog box, click Finish.
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• Select a Style – Select the poll style from the drop-down list. The available options are gray, 
green, purple, red, and white. If you change any of the predefined settings, you create your own 
"custom" style, which appears automatically in the "Select a Style" drop-down list.

 You can view any changes you make to your poll and its results appearance in the right dialog box 
pane under the Polls and Results example immediately.

• Font – Select the font type of your poll and its results from the drop-down list.
• Size – Select the font size of your poll and its results from the drop-down list.
• Font Color – Select the font color of your poll and its results from the drop-down list. You can 

select from a range of colors in the Web Palette, RGB (Red, Green, and Blue) Sliders, HSB (Hue, 
Saturation, and Brightness), and HSV (Hue, Saturation, and Value). If you know the hexadecimal 
value of a color, you can type it in the provided field.

• Background Color – Select the background color of your poll and its results from the drop-down 
list.

• Result Bar Color – Select the result bar color of your poll results from the drop-down list.
• Border Color – Select the border color of your poll and its results from the drop-down list.
• Border Style – Select the border style of your poll and its results, such as solid, dotted, dashed, 

and double.
• Width – Select the width of borders in pixels.
• Poll/Results Width – Select the width of your poll and its results in pixels. The default value of 

your poll size is 150 pixels.
• Display Results as – Select an appropriate option to show the poll results as percentages, count, 

or both.
• Include total response count in chart – Select this check box to show total number of votes 

at the bottom of the poll results table.
• Include option to jump directly to results – Select this check box to include the View Results 

link into your poll, which allows poll participants to jump directly to the poll results without casting 
a vote.
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Preview a poll
Navigation

Design & Collect tab > Polls tab > Polls page.

Use polls to gain feedback from your respondents on a hot topic or current event and view the results 
immediately. After designing your poll, you can preview it before distributing the code. You can interact 
with the question to observe the presentation of the question and results.

Procedure 
1 In the Polls list, click the Preview link next to the poll you want to preview.
 
You can edit the poll to correct the text and presentation characteristics by clicking the poll question in 
the Polls list to open the question in the editor.
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Add a poll to your website
Navigation

Design & Collect tab > Polls tab > Polls page.

After creating your poll, you need to add it to your website so that poll participants can vote. 

Procedure 
1 On the Polls tab, click the View Code Snippets link for a specific poll. The dialog box opens where 

you can view the HTML code of your poll.
2 Select all content within the text box and copy it.
3 Switch to the HTML editor of your website and insert this code into the location where you want your 

poll to display. After you  added the copied HTML code to your website, your poll appears on it and is 
active and ready to collect votes.

 If you do not copy the entire HTML code snippet or edit it, your poll may perform incorrectly.

 

 It is strongly recommended that you do not edit the HTML snippet for a poll, though you may 
need to adjust the formatting. Keep in mind that if you edit the HTML snippet for a poll, each 
poll's script tag (<script>) must have an associated anchor tag (<a>) with an ID attribute matching 
the poll's ID.

Tips on Adding a Poll to Your Web Page

• You must have rights to edit the Web page where you want to add the poll.
• JavaScript must be enabled in the browser's settings. JavaScript is used to handle the poll vote 

submission and poll and results display.
• Cookies must be enabled in the browser's settings. Cookies are used to track voting and control 

what you see once you have taken the poll. If you answer a specific poll, the results appear, 
otherwise the poll appears.

• Multiple polls can be placed on the same Web page and will act independently of each other. Each 
poll has its own cookie value. By default, one vote per respondent per poll is allowed.
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Track your poll results
Navigation

Design & Collect tab > Polls tab > Polls page.

After adding your poll to a Web page, you begin to collect responses and can track the poll results. 

Procedure 
1 On the Polls tab, click the View Results icon  for a specific poll. 

The dialog box opens where you can view the current poll statistics, which includes the total number 
of poll responses and their breakdown.
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Delete a poll
Navigation

Design & Collect tab > Polls tab > Polls page.

You can remove a poll if you no longer need it anymore.

Procedure 
1 On the Polls tab, select the check box next to the poll you want to delete, and then click Delete on 

the Polls toolbar. 
2 Click Delete in the confirmation dialog box.

 When you delete a poll, remove the HTML snippet for your poll from any web page where you 
have inserted the poll. If you do not remove the HTML snippet, users will see the error message.



Intercepts
Topics 
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Map single survey intercepts
Navigation

Design & Collect tab > Intercepts tab > My Intercepts page > create a new intercept or open an 
existing intercept > click the intercept name to open the intercept designer > Message tab in the left pane.

An intercept lets you automatically invite your website visitors to participate in online surveys. When a 
website visitor is intercepted, an invitation message is displayed to the visitor directly on your website. 
The Web site visitor can either accept or decline the invitation.

 The Web Intercepts functionality is available if you have a license for the Web Intercepts 
feature.

On the Intercepts tab, you can create, copy, rename, and delete intercepts. The intercept is a container 
for your survey. You can add one survey to the intercept, and then delete it and add another survey to it. 
In such case, you do not need to update the intercept code snippet. All intercepts need to be published 
only once and their content can be changed. So, you can reuse your intercept multiple times.
Currently, you can add only one survey to the intercept. The survey must be open and have the 
Generate Link distribution type. If a survey is closed or deleted, it does not appear in the intercept. If 
there is no survey in the intercept, the intercept does not appear.
The My Intercepts page provides you information on each intercept you created. You can sort 
intercepts by clicking the column heading. To change the width of a column, drag its edge. At the bottom 
of the My Intercepts page, you can adjust the number of intercepts that displays on one page. The 
default number of intercepts per page is 10; however, you can select up to 100 intercepts to display on 
the My Intercepts page.
To manage all intercepts, select the check box in the upper-left corner of the My Intercepts page.
The following columns are available on the My Intercepts page.
• Intercept Title – Name of an intercept. Click the intercept name to edit the intercept.
• Last Modified – Last time when you made changes to the intercept.
• Open Surveys – Name of the survey assigned to the intercept. The survey name link directs you 

to the survey designer. The edit link directs you to the Surveys tab of the intercept designer.
• Design – Click the icon to go to the Message tab of the intercept designer.
• View Code Snippets – Click the icon to go to the Code Snippet tab of the intercept designer.

Create a new intercept

Procedure 
1 On the My Intercepts page, click the New button. The Name Your Intercept dialog box opens.
2 Enter the name of the intercept in the Intercept Name text box.
3 Click OK.



Chapter 5 - Map single survey intercepts

EFM User Guide 207

Confidential and Proprietary Information of Verint Systems Inc.

Edit an intercept

Procedure 
1 On the My Intercepts page, click the intercept name you want to edit. The intercept designer opens.
2 Make the required changes. Your edits are saved automatically.

Duplicate an intercept

Procedure 
1 On the My Intercepts page, select a check box next to the survey you want to copy.
2 On the toolbar, click the Duplicate button. The Duplicate an Intercept dialog box opens.

 Edit the intercept name if required.

3 Click OK.

Rename an intercept

Procedure 
1 On the My Intercepts page, select a check box next to the survey you want to rename.
2 On the toolbar, click the Rename button. The Rename dialog box opens.
3 Edit the name of the intercept.
4 Click OK.

Delete an intercept

Procedure 
1 On the My Intercepts page, select a check box next to the survey you want to remove.
2 On the toolbar, click the Delete button. The confirmation dialog box opens.
3 Click Delete.
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Creating an invitation for the intercept
Navigation

Design & Collect tab > Intercepts tab > My Intercepts page > create a new intercept or open an 
existing intercept > click the intercept name to open the intercept designer > Message side tab in the left 
pane.

You can create and format an invitation message asking your website visitors to take a survey. The 
invitation appears directly on your Web site. The Web site visitors can either accept the invitation and 
take a survey or decline the invitation. If invitation is accepted, a survey opens in a new browser window.
In the left pane, you can view the language of your invitation under Base Language. In the right pane, 
you can preview your current invitation appearance under Intercept.
The sections below include information on how to compose your invitation:
• Title, page 208
• Message, page 208
• Confirm Button, page 209
• Cancel Button, page 209
• Preview, page 209

Title
Add text to your invitation title in the "Title" field. The default title is blank. You can format text by using 
the editing toolbar. The following options are available:
• Font name
• Font size
• Bold
• Italic
• Underline
• Alignment
The invitation title is shown by default. You can hide the title by selecting the "Hide Title Bar" check box.

Message
Add text to your invitation message in the "Message" text box. The default message is "Please take a few 
moments to answer a brief survey." You can format text by using the editing toolbar. The following 
options are available:
• Font name
• Font size
• Bold
• Italic
• Underline
• Foreground color
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• Background color
• Alignment

Confirm Button
Add text to the confirm button in the "Confirm Button" field. By clicking this button, users accept the 
invitation to take your survey. The default button text is "Take survey!"

 You can format text by using the editing toolbar.

Cancel Button
Add text to the cancel button in the "Cancel Button" field. By clicking this button, users decline the 
invitation to take your survey. The default button text is "No Thanks."

 You can format text by using the editing toolbar.

Preview
In the right pane, you can preview the changes you made to the invitation at once.
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Formatting the intercept
Navigation

Design & Collect tab > Intercepts tab > My Intercepts page > create a new intercept or open an 
existing intercept > click the intercept name to open the intercept designer > Formatting tab in the left 
pane.

You can customize your intercept theme so that the style and brand match your website and survey. You 
can format the title area, content area, confirm button, and cancel button. The intercept preview is 
updated immediately after any changes.
The sections below include information on how to change the appearance of your intercept:
• Title Area, page 210
• Content Area, page 210
• Confirm and Cancel Buttons, page 211

Title Area
In the Title Area section, you can change the color in the title area of the intercept, create a gradient, and 
select the close icon for the title.
• Text Color – Select the color of the title text from the drop-down list. You can select from a range 

of colors in the Web Palette, RGB (Red, Green, and Blue) Sliders, HSB (Hue, Saturation, and 
Brightness), and HSV (Hue, Saturation, and Value). If you know the hexadecimal value of a color, 
you can enter it in the provided field.

• Background Color1 – Select the top background color of the title area from the drop-down list.

 You can create a gradient in the title area using the "Background Color1" option together with the 
"Background Color2" option.

• Background Color2 – Select the bottom background color of the title area from the drop-down 
list. The "Background Color2" option has additional button to clear the color selection. If a color is 
selected, the title area is a gradient. If the "Transparent color" button  is selected, the title area is a 
solid color defined in the "Background Color1" field.

• Border Color – Select the border color of the title area from the drop-down list.
• Close Icon – Select the close icon that appears on the intercept title from the drop-down list. You 

can select from five different close icons. The default icon is the second icon in the list.

Content Area
In the Content Area section, you can change the color in the content area of the intercept and insert the 
background image. You can add an image by uploading it or providing a link to its location.
• Background Color – Select the background color of the content area from the drop-down list.
• Border Color – Select the border color of the content area from the drop-down list.
• Background Image – Click the Upload Image link to select an image for the content 

background. If you want to enter a URL to the image location, click the Provide URL link.
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Confirm and Cancel Buttons
In the Confirm Button and Cancel Button sections, you can change the buttons color of the intercept.
• Text Color – Select the color of the button text from the drop-down list.
• Background Color – Select the background color of the button from the drop-down list.
• Border Color – Select the border color of the button from the drop-down list.

Upload the background image

Procedure 
1 Open the Formatting tab in the intercept designer.
2 Click the Upload Image link next to the "Background Image" field. The Picture dialog box opens.
3 Select the image you want to add.

 If no images are available in the Picture dialog box, click the Upload  button to upload one or 
multiple images.

4 Click Insert. The image appears on the intercept background.

How to provide URL to image

Procedure 
1 Open the Formatting tab in the intercept designer.
2 Click the Provide URL link next to the "Background Image" field. An empty field appears for you to 

add a URL.
3 In the field, enter a URL to the image you want to add.
4 Click the Save link.

 Hover over an abbreviated URL to view the full URL in a tooltip.

How to delete the background image

Procedure 
1 Open the Formatting tab in the intercept designer.
2 Click the Remove link next to the "Background Image" field. The background image is deleted.
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Map a single survey
Navigation

Design & Collect tab > Intercepts tab > My Intercepts page > create a new intercept or open an 
existing intercept > click the intercept name to open the intercept designer > Survey tab in the left pane.

You can select a survey for your intercept. Currently, you can add only one survey to the intercept. The 
survey must be in the Open status and have the Generate Link distribution type. You can add and 
remove the surveys in your intercept and do not need to republish the intercept in such case. The 
intercept code snippet does not need to be updated.
Additionally, you can preview the survey selected for the intercept on the Survey tab. Preview helps you 
to ensure that you selected the correct survey for your intercept. All survey pages are listed at one page 
for your convenience.

 A web administrator does not have access to the Survey tab in the intercept designer. If a user 
does not have access to any surveys, the Survey tab is hidden.

When you are ready to publish your intercept, you can click the code snippet link at the top of the page to 
go to the Code Snippet tab.
If you close this message, it is hidden on all tabs. You can restore all hidden messages on the My 
Account  tab. Click the Reset Hidden Help Messages link to restore all hidden messages.

Add a survey to the intercept

Procedure 
1 Open the Survey tab in the intercept designer.
2 Click the Add Survey button. The Add Survey dialog box opens. 
3 In the left pane, select the folder, which contains the survey you want to add. The list with all open 

surveys in this folder appears.
4 In the right pane, select the survey you want to add.

 You can add only one survey to the intercept. The survey must be open.

5 Click Add.

Delete a survey from the intercept

Procedure 
1 Open the Survey tab in the intercept designer.
2 Select the survey added to the intercept.
3 Click the Remove button. The confirmation dialog box opens.
4 Click Remove.
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Rename an intercept

Procedure 
1 Open the Survey tab in the intercept designer.
2 Click the Edit link next to the intercept name.
3 Enter a new name for your intercept.
4 Click Save.



Chapter 5 - Properties tab

EFM User Guide 214

Confidential and Proprietary Information of Verint Systems Inc.

Properties tab
Navigation

Design & Collect tab > Intercepts tab > My Intercepts page > create a new intercept or open an 
existing intercept > click the intercept name to open the intercept designer > Properties tab in the left 
pane.

You can control how often the intercept is shown to the website visitors and select what event triggers 
the intercept. The same Web site visitor is invited only once by an intercept. The browser's cookies are 
used to ensure that a visitor has already been intercepted. The intercept appears again in a 30-day 
period.
The "Frequency" property of an intercept is a probability that the Web site visitor is intercepted. You can 
specify the frequency in percentage of times (0-100%) the intercept appears. For example, a frequency of 
40% means that a Web site visitor has a 40% chance of being intercepted when viewing a Web page on 
your site.
You can select from the following events to trigger the intercept:
• User visits page, page 214
• Customized Trigger (Advanced), page 214

 The intercept appears in three seconds after it is triggered.

User visits page
Activate the "User visits page" option to ask your website visitors for feedback immediately when they 
first view a Web page. The invitation appears asking a visitor to take a survey. The Web site visitor can 
either accept or decline the invitation. If the invitation is accepted, the survey appears at once in a new 
browser window over the main window.

Customized Trigger (Advanced)
Activate the "Customized Trigger (Advanced)" option to ask your Web site visitors for feedback 
immediately when they click somewhere on the Web page so that you can best control where surveys are 
deployed. The list of actions includes clicking a link, button, or image. The invitation appears asking a 
visitor to take a survey. The website visitor can either accept or decline the invitation. If the invitation is 
accepted, the survey appears at once in a new browser window over the main window.

 For more information on how to configure the customized trigger, see Code Snippet tab, 
page 215.



Chapter 5 - Code Snippet tab

EFM User Guide 215

Confidential and Proprietary Information of Verint Systems Inc.

Code Snippet tab
Navigation

Design & Collect tab > Intercepts tab > My Intercepts page > create a new intercept or open an 
existing intercept > click the intercept name to open the intercept designer > Code Snippet tab in the left 
pane.

You can copy the JavaScript code snippet of your intercept. Next, you can insert the copied code into the 
HTML of the Web page where you want the intercept to appear. Visitors will see the intercept according 
to the criteria you set on the Properties tab.
All of the code you need for your intercept to work is available in the field under Code Snippet. The code 
snippet is generated automatically for you. Insert the entire HTML code snippet into the web page and do 
not edit it, otherwise your intercept may perform incorrectly.

 To keep you from changing the code by accident, the code snippet is not editable. You can only 
copy it.

 

Customized Trigger (Advanced)
If you select the Customized Trigger (Advanced) option on the Properties tab, the Customized 
Trigger (Advanced) section appears on the Code Snippet page.
To create a customized trigger that launches an intercept, use the provided JavaScript function in your 
custom Web site logic. Calling this function in your website initiates the process of showing the intercept 
according to the frequency set on the Properties tab.
So, in addition to the code snippet of your intercept (see #1 on image), copy and paste the code snippet 
of the customized trigger (see #2 on image) into your website. Add the code snippet of the trigger to the 
HTML element (link, button, or image) that is associated with the trigger. See example below.

<html>
<head>
 
<script type="text/javascript" src="http://co.vovicidev.com/CurrentDev_

MSSQL/Intercept.ashx?i=7FDA9ED14D9C25A1"></script>
 
</head>
<body>
 
<input onclick=vcInterceptApi['vcIntercept7FDA9ED14D9C25A1'].displayIntercept(); 

type="button" value="click me">
</body>
</html>

 You can place multiple intercepts on the same web page.
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Testing Your Intercept
After adding the copied code snippet of your intercept to the web page, the intercept is considered as 
published. You can test the intercept using information provided in the Testing Your Intercept section. 
Add the following text to the end of your web page's URL to test the intercept:

?trigger_intercept=1

If there is already a question mark "?" in the URL, add the following code instead:
&trigger_intercept=1

Passing URL Parameters
You can pipe URL values and preselect responses on the first survey page by using additional parameters 
separated by an ampersand in the code snippet.

URL piping is available for Fill in the Blank, Short Answer, and Essay questions only. Preselected 
responses are available for Choose One and Choose One with Image questions only.

 

• To pipe URL values:
• In the Preselected field in survey designer, set the URL parameters for the needed 

question/topic, for example, %URL.first% (for details, see Piping URL Query, page 543).
• In the code snippet, type the values for the specified parameters as follows:

&first=Bob&last=Gates&zip=94102

 Names of parameters are case sensitive.
 

• To set preselected responses:
• In the code snippet, type the question heading with the needed choice number as follows: 

&Q1=3&Q2=1
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Reporting on intercept surveys
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing 
survey > add your survey to the intercept and collect some responses >  Analyze tab in the survey 
designer where you can view responses and create reports on your intercept survey results.

You can view responses and report on data collected from the intercept surveys in the same way as for 
the usual surveys. The process of designing a survey and analyzing the results does not change. Each 
survey has its own Response Manager table, and data is stored in the respective surveys. The intercept 
is just the channel for deploying your survey.
The following two columns connected with the web intercepts are added to Response Manager:
• Response Source – This column indicates whether a survey is taken via intercept or any other 

channel.
• Referring URL – This column indicates what Web page the user is on when the intercept is 

presented.

 Currently, you can add to your web intercept the Generate Link surveys only.
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Web Administrator role
Navigation

Administration tab > Roles  tab >  Roles page > Web Administrator role in the roles list.

A new predefined role – Web Administrator – is added to the application. A web administrator can 
design the web intercepts and generate the code for them. The Web Administrator role is locked 

 from any edits. You can create a custom role based on the Web Administrator role by copying 
and editing it.
A web administrator can access all intercepts across the workgroup and has permission to view, create, 
edit, and delete the intercepts. These permissions are assigned by the "all or nothing" rule. See images 
below.
When you select the "View All Intercepts" check box for a custom role, all the check boxes in the Web 
Intercept Administration section are selected automatically.
By default, the web intercept building tool is available for web administrators only. Survey authors can 
also be granted access to the intercept building tool but with the permission to manage only their own 
surveys.

 A web administrator does not have access to the Survey  tab in the intercept designer. If a user 
does not have access to any surveys, the Survey  tab is hidden.
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Survey designer overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu > Design from Scratch option.

After you create a survey (using any of the options provided further in this chapter), the survey designer 
page is displayed, where you can add and edit your survey questions, configure survey logic and design 
options, export, and test your survey.
This topic provides a brief overview of the features available on a blank survey page and basic instructions 
for designing a survey from scratch. For details on adding questions, see Choose One questions, page 247 
as an example.

The Design tab of a new survey

1 Edit the title of a survey.

 To edit your survey title, click the default survey name, type a new name, and then press Enter to 
save the changes.

2 Create or edit a survey on the Design tab.
3 View the status of a survey.
4 Export a survey as a Microsoft Word (.doc), Adobe Acrobat (.pdf), EFM Enterprise (.que) file, or Mobile 

Survey.
5 Test a survey.
6 Change the survey properties, style, and more.
7 Add a question to a survey, and then edit the question text, answers, appearance, validation, and logic 

properties.
8 View a survey in the Edit, Preview, or Outline and Flow mode.
9 View the added questions and answers here.
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Survey design framework
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
Design view.

The Design view is divided into the following areas. See image and description below.

Areas of the Design tab

1 Header, page 227
2 Toolbar, page 227
3 Panel Buttons, page 227
4 Side Panel, page 228
5 Content, page 228

Header
The Header area includes the title of the survey you are designing, the Design, Collect, and Analyze 
tabs. The Header area has a fixed width but a liquid height, which means the Header area expands 
vertically to fit longer titles.

Toolbar
The Toolbar area has the same properties as the Header area. It includes the Actions menu, the Survey 
View toggle keys, the Status indicator, and the Test button. The toolbar has a fixed height but a liquid 
width.

Panel Buttons
The Panel Buttons area of the Design tab contains a number of side tabs, such as Content, Pages, 
Formatting, Labels, Translation, Branching, Advanced, Properties, and Comments. This area has a 



Designing Your Survey Overview Survey design framework

EFM User Guide 228

Confidential and Proprietary Information of Verint Systems Inc.

fixed height, but a liquid width. The width of this area depends on whether you hide or show button 
titles.

Side Panel
The Side Panel area includes survey options that vary depending on the survey content. This area has a 
liquid height and fixed width.

Content
The Content area of the Design tab includes the questions that you have chosen for your survey. In 
addition, you can edit titles of pages and blocks, manage your pages and blocks using the block and page 
menus, and navigate between pages and blocks using the  menus to the left of the block or page  menus. 
This area has a liquid height and width.
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Designer side panels
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design fromScratch option > 
Design view.

You can use the side panels to navigate within feature sets in the Design view. You can select nine panels, 
Content, Pages, Formatting, Labels, Translation, Branching, Advanced, Properties, and 
Comments, to edit your survey and its settings.
You can minimize and expand the side panel section. Click the Minimize link to hide the panel names. 
You can move your pointer over the side panel icon to see its tooltip.

The Designer side panels
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In-survey pagination
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design fromScratch option > 
Design view.

By using the in-survey pagination controls, you can:
• Quickly navigate to any block or page within your survey.
• Manage your blocks and pages using the corresponding drop-down menus on the right side of 

the survey content area header.
• View the total number of blocks and pages in your survey and the number of your current block 

and page.
• Edit the name of a block or page.
The topic describes the behavior of the in-survey pagination controls that are available in the header of 
the survey content area.

The in-survey pagination controls

1 Previous Page and Next Page arrows, page 231
2 Block drop-down menu, page 231
3 Page drop-down menu, page 231
4 Block number indicator, page 232
5 Page number indicator, page 232
6 Block name and page name, page 232
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Previous Page and Next Page arrows
The Previous Page and Next Page arrows provide an easy navigation to the previous and next pages 
within your survey. Click the right arrow to navigate to the next page and the left arrow to navigate to the 
previous page.

 The arrows become active only if there are pages after or before the current page.

Block drop-down menu
The block drop-down menu includes the following options:
• Add Block – Add a new block to your survey. For more information, see Add block, page 390.
• Hide This Block – Hide the current block from the survey respondents. After clicking the option, 

the visibility status bar is displayed below the block name. To make the block visible again, click 

the delete icon  on the rightmost of the visibility status bar.

 If the survey distribution method is Require a Passcode, the Hide This Block option is 
unavailable for the first block in the survey.

• Add Conditional Visibility – Add or edit the block visibility criteria. For more information, see 
Add conditional visibility for block, page 506.

• Add Branch – Add branching and logic rules to your survey. For more information, see Adding 
Branching Criteria, page 442.

• Add Page Rotation – Make pages in the current block appear in a rotated order in your survey. 
For more information, see Blocks and Page Randomization, page 403.

• Add Page Randomization – Make pages in the current block appear in a randomized order in 
your survey. For more information, see Blocks and Page Randomization, page 403.

• Copy – Copy the current block. For more information, see Copy and paste block, page 393.
• Paste – Paste the previously copied block into your survey. The block is added after the current 

block. For more information, see Copy and paste block, page 393.
• Move Block Up – Move the current block one position towards the beginning of the survey.
• Move Block Down – Move the current block one position towards the end of the survey.

 The Move Block Up option is unavailable if the current block is in the first position of the survey. 
Similarly, the Move Block Down option is unavailable if the current block is in the last position 
of the survey.

• Delete Block – Delete the current block from the survey. For more information, see Delete block, 
page 392.

Page drop-down menu
The page drop-down menu includes the following options:
• Add Page – Add a new page to your survey.
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• Add Custom End Page – Create a custom end page in your survey. When saved, this custom end 
page appears on the Pages side tab of the Design tab. For more information, see End Pages 
Pagination Panel, page 396.

• Hide This Page – Hide the current page from the survey respondents. After clicking the option, 
the corresponding visibility status bar is displayed under the page name. To make the page visible 

again, click the delete icon  on the rightmost of the visibility status bar.
• Add Conditional Visibility – Add or edit the page visibility criteria. For more information, see 

Page Conditional Visibility, page 502.
• Add Branch – Add branching and logic rules to your survey. For more information, see Adding 

Branching Criteria, page 442.
• Copy – Copy the current page. For more information, see Copying and pasting pages between 

surveys, page 388.
• Paste – Paste the previously copied page into your survey. The page is pasted after the current 

page. For more information, see Copying and pasting pages, page 387.
• Move Page Up – Move the current page one position towards the start of the survey.
• Move Page Down – Move the current page one position towards the end of the survey.

 The Move Page Up option is unavailable if the current block is in the first position of the survey. 
Similarly, the Move Page Down option is unavailable if the current block is in the last position of 
the survey.

• Delete Page – Use to delete the current page from the survey.

Block number indicator
The block number indicator shows the number of a current block and the total number of blocks in your 
survey, for example, Block 4 of 4.
You can navigate to any block within your survey using the block navigation drop-down menu. To expand 
the menu, click the arrow next to the block number indicator. Clicking the block name in the menu 
navigates you to the first page of the selected block.

Page number indicator
The page number indicator shows the number of a current page and the total number of pages in your 
survey, for example, Page 4 of 4.
You can navigate to any page within your survey using the page navigation drop-down menu. To expand 
the menu, click the arrow next to the page number indicator.

Block name and page name
By default, block and page names contain the block and page numbers. If needed, you can change the 
block and page names. This option is typically used by the survey author to name blocks and pages in a 
descriptive way to easily locate a particular block or page within the survey.
For example, if your survey is about cities, you might name the pages as follows:
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• Geographical position (for Page 1)
• Rank planned visit (for Page 2)
• Next planned visit (for Page 3)
This feature is helpful if your survey has multiple blocks and pages. After you have renamed the block or 
page, their new names appear in the header of the survey content area. Instead of Block 1, Block 2, Page 
1, and Page 2, the descriptive names for each block and page are displayed now, which can help you 
quickly find a question you need.

 If there is an empty block in your survey, you can still view its placeholder in survey designer and 
add pages to it by using the Add Page button.

Edit the page name
1 In the survey designer, click the page name. The page name text field becomes editable.
2 Edit the page name, and then press Enter to save the changes.

Edit the block name
1 In the survey designer, click the block name. The block name text field becomes editable.
2 Edit the block name, and then press Enter to save the changes.
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Navigating text entries
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Add menu.

You can navigate question headings, question text, and responses using the Tab key or the Tab + Shift 
keys. This functionality works within one page. To activate the navigation, click any text field in the 
question. After you press the Tab key or the Tab + Shift keys, the text in the active text field becomes 
highlighted.
• Tab key – Press to navigate to the next text field.
• Shift + Tab keys – Press to return to the previous text field.

 The Tab key does not insert the text as the Enter key; it only navigates to the next text field.
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Scrolling to the top of the survey page
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > scroll down the survey page > Return to the top of the page arrow.

When you scroll down the survey page and survey designer toolbar disappears from your view, the 

Return to the top of the page arrow  appears in the  lower-right corner of the page. You can click 
the arrow to return to the top of the page immediately. Once the toolbar comes in your view, the Return 
to the top of the page arrow disappears. If you scroll up to the survey toolbar manually, the Return to 
the top of the page arrow disappears too.
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Fly-outs
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Add a Question menu > move your pointer over the question name to view a fly-out for 
this question.

When you add a new question to your survey, you can view a fly-out for this question. The fly-out 
includes the question description and its example. Hover over the question name for a couple of seconds 
and the fly-out for this question type appears.

The fly-out for Choose Many with Image
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Add a question
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Add menu.

In the Design view of the survey designer, you can add a question or other content to your survey by 
using the Add button or the Add menu. If you click the Add button, a panel opens from which you can 
add any type of the question. If you click the arrow next to the Add button, the Add  menu opens.

The Add menu

The Add button and the Add menu are available in the content pane if your survey contains at least one 
question or other survey item. If your survey is blank, you will see a panel for adding a question or other 
content instead of the Add button and Add menu.

Procedure 
1 In the Design view of the survey designer, click the down arrow next to the Add button. The Add 

drop-down menu opens with all question types and other survey items available.
2 Click the appropriate question type. 
3 Enter your question text.
4 Enter your question choices.
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Changing question type
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > click any question > Question Options panel.

You can easily switch from one question type to another without having to delete the old question and 
create a new one.

 Changing question type functionality is available only for unpublished surveys. 

In the Question Options panel, you can use a drop-down list to switch between different question 
types. You cannot switch to other content types, such as text, section heading, or code block.

The Question Options panel
 

When you change the question type, the question heading, question text, and choice options remain the 
same. For example:
• When you switch from a Choose One question type to Matrix, the choice options remain.
• When you switch from a Matrix question to a Choose One question, the topics are dropped.
• When you switch from a Matrix question with multiple sides to a Choose One question, the 

sides are dropped.
• When you switch from a Matrix question with multiple sides to a Rank Order question, the sides 

are converted to the topic options.
• When you convert a Choose One or Matrix question to an Essay question, all the choices and 

topics are dropped. If you switch back to Choose One or Matrix, the choices and topics are 
back.

In Test mode only, if you change the question type in the Design view and apply the changes to the 
survey, the validation is performed on a new question type. If it is not valid for the report element, in 
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which it is used, the message appears in a report that the base question type for this report element is 
changed, and the report element is no longer applicable.

Change question type with images
Any images as part of questions with the Add Image button are carried over to other questions with the 
Add Image button. The images added as a part of the question text remain within different question 
types.

Change common properties
When you switch from Choose One to Choose Many questions (and vice versa), the following layout 
options remain the same:
• List
• Scale
• Rows
• Columns
• Table Rows
The rest of the layout options are set to the List default value.
The Conditional Visibility and Destination values are carried over when you switch between different 
question types.
Switching between all questions carries over:
• Show Question Heading
• Answer Required
Any Branching or Conditional Visibility in the survey, which uses choices or topics from a question, is 
broken when that question is changed.



Designing Your Survey Overview Question headings

EFM User Guide 240

Confidential and Proprietary Information of Verint Systems Inc.

Question headings
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Add menu.

You can use question headings to make data mapping easier when typing in shortened versions of the 
questions. Also, you can use headings to number the questions if the Show Question Heading check 
box is selected.
By default, the questions are enumerated with the next incremental number. You can edit the question 
heading by clicking the number above the question text.
You can also show or hide the question heading using the Show Question Heading check box under 
Question Options.

The Show Question Heading option

By default, the Show Question Heading check box is clear, the question heading is not shown, and only 
the question text appears in the survey.

Procedure 
1 In the Design view, add a question to your survey.
2 Click the question heading, which is above the question text.
3 Edit the question heading. All your changes are saved automatically.
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Editing the question heading



Designing Your Survey Overview Auto number question headings

EFM User Guide 242

Confidential and Proprietary Information of Verint Systems Inc.

Auto number question headings
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new survey or open an existing one > 
Actions menu on the toolbar > Auto-Number Question Headings. 

You can change the automatic numbering of your survey question headings.

 The auto-numbering of a survey question heading cannot be turned off. If needed, you can 
specify your custom question heading by typing it in the question heading text box. The default 
numbering format will be replaced with the custom one.

 

 To avoid entering the insecure code in the Auto-Number Question Headings dialog box, on 
the General Setup page, select the Automatically remove untrusted code from survey 
designer check box,  and ensure that the Edit Code Blocks permission is cleared. For more 
information, see General Setup, page 1406.

Procedure 
1 On the My Surveys page, open the needed survey.
2 On the Actions menu, click Auto-Number Question Headings.
3 In the Auto-Number Question Headings dialog box, do the following:

a. Select the numbering format:
- Number Sequentially (default) – Numbers the questions in the ascending order starting 

with the first question on the page. The question number appears in the following format: 
Question Number (1, 2, 3).

- Number by Page – Numbers the questions based on the page number, where the question 
number resets at the start of each page. The question number appears in the following 
format: Page Number + Question Number (1.1, 1.2, 2.1).

- Number by Block – Numbers the questions based on the block number, where the question 
number resets at the start of each block. The question number appears in the following 
format: Block Number + Question Number (1.1, 1.2, 2.1).

 If a block contains a child block, the number by block appears in the following format: Parent 
Block Number + Child Block Number + Question Number (1.1.1, 1.1.2, 2.1.1), where the 
question number resets at the start of each child block.

- Number by Internal ID — Numbers the questions based on the database heading that 
matches the ID column on the Report Options page. The question number appears in the 
following format: DB identifier (Q1, Q4, Q5).

b. To display the question heading in a survey, select Show Question Heading.
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The question heading
 

c. To include hidden questions into auto-numbering, select Include Hidden Questions. If this 
option is not selected, any question with visibility set to Hidden will be excluded from auto-
numbering, and instead it will be labeled separately in alphabetic form going from A-Z, then AA-AZ, 
BA-BZ, and so on.

d. In the Prefix text box, specify a prefix for your question headings if needed. The prefix can 
contain more than one word but without spaces. The question number appears in the following 
format: Prefix + Question Number (Option1, Option2, Option3). 

4 Click Apply.
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Change text in an open survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Add menu > add questions to the survey > Collect view > open the survey.
 

After a survey is opened, you can edit it to correct typos. You can edit the question and choice text and 
change images. You cannot add, delete, or move choices.
When the text is changed, the translations are marked as out of date and need to be updated too.

 The modification of the previously published questions might impact the collected results.

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 In the Design view of the survey designer, edit your survey as required.
3 Click the Apply button at the top of the page to apply your changes to the survey.
Your changes are posted to the same survey URL that is already available.



Designing Your Survey Overview Bulk Changing Survey Owner

EFM User Guide 245

Confidential and Proprietary Information of Verint Systems Inc.

Bulk Changing Survey Owner
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Actions menu > Change Owner option.

The group and survey administrators can bulk reassign surveys (including surveys owned by the other 
workgroup members) to a new owner.
When the survey owner is changed, the survey moves automatically to the new owner's folder on the My 
Surveys page. A new survey owner receives the corresponding email notification. Only one email is sent 
regardless of the number of surveys assigned to a new owner. For example, if you reassign 50 surveys at 
once, the new owner receives only one email; if you reassign 25 surveys and then another 25, two email 
notifications are sent to the new owner.
The reassignment of the survey is recorded as one transactional event per one survey, not for all surveys.

 The Change Owner option is disabled for the surveys in Recycle Bin and for the surveys 
submitted for review.

Bulk change the survey owner

Procedure 
1 Go to the My Surveys page, and then select the check boxes next to the surveys that you want to 

reassign.
2 On the Actions menu on the toolbar, click Change Owner. 
3 In the Bulk Assign Surveys to New Owner dialog box, the current survey owner is outlined in gray.
 

4 Select the user that you want to be the new owner, and then click OK.
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Report Options page
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Actions menu on the toolbar >  Report Options.

You can view and edit report, export, and coded values for the questions on one page to more efficiently 
define these values for every question in your survey.

 To avoid entering the insecure code on the Report Options page, on the General Setup page, 
select the Automatically remove insecure code from survey designer check box, and 
ensure that the Edit Code Blocks permission is cleared. For more information, see General 
Setup, page 1406.

The Report Options grid includes the following columns:
• Display Heading – Page title and question heading.

 You can collapse and expand the page title row if needed. It is expanded by default.

• ID – Question, choice, column, or topic ID used throughout the survey.
• Question – Question, choice, column, or topic text.
• Report Value – Text box for defining or editing the report value
• Export Value – Text box for defining or editing the export value.
• Coded Value – Drop-down menu with the applicable coded value options. Adding a coded value 

to a choice excludes it from the Coded Value  menu for the previous choice.

 You can only add coded values starting from the end of the choice list.

You can filter the information displayed in the Report Options grid by selecting or clearing the following 
check boxes:
• Display all questions – Select to view all survey questions, including the ones that do not 

support report, export, or coded values.

 When accessing the Report Options page for the first time, the Display all questions check 
box is cleared by default. If you change the selection, it is saved for all your surveys.

• Internal – Select to view the Display Heading and ID columns.
• Exporting – Select to view the Export Value column.
• EFM Analysis – Select to view the Report Value and Coded Value columns.

 When accessing the Report Options page for the first time, the Internal, Exporting, and EFM 
Analysis check boxes are selected by default. If you change the selection, it is saved for all your 
surveys.

To get back to your survey designer, click the Return to Survey Designer button.
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Choose One questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Choose One option.

With the Choose One question type, your survey participants can select only one answer for this 
question. This question includes the question text followed by the response options. 
You can customize the appearance of the Choose One question and add the validation and logic 
properties by using the Question Options and Response Options panels.

Adding and customizing question text
Type the text of your Choose One question in the text field, and then format the text with the editing 

toolbar. On the editing toolbar, click the More icon   to open the expanded editor, which provides 
additional editing options. In the expanded editor, you can also use the Spell Check and Word Count 
options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

Adding and customizing choice text
After adding your question text, you need to add the choice text. By default, three choices appear. You 
can add, delete, or move the choices by using the options menu to the right of the individual choice. To 
format the choice text, use the editing toolbar that appears when you click the choice field. You can also 

click the More icon  to access the expanded editor, which provides additional editing options.
You can further customize the response choices of the Choose One question by using the Response 
Options panel in the left pane. The Response Options panel appears when you click the choice.

 For more information on the question and choice properties of the Choose One question, see 
List of property indicators, page 278 and Response options, page 330.

Create a Choose One question

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Choose One. 

The Choose One question is added to your survey.
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 If your survey contains at least one question or other content, you can add a Choose One 
question by clicking the Add button or the Add menu.

3 To change the question heading, click the question number. 
The heading text field becomes editable.

4 Edit the question heading. All your changes are saved automatically. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading option 
in the Question Options section of your question to make the question heading visible to the 
respondents.

5 To edit the question text, click in the question text field. 
The question text field becomes editable.

6 Edit the question text, and then press Enter to save the changes. You can customize your text and 
add images or media to your question by clicking the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

7 On the Question Options panel, customize your question appearance (as appropriate), and add the 
validation and logic properties.

8 To edit the choice, click the appropriate choice text field. The choice text field becomes editable.
9 Edit the choice, and then press Enter to save the changes and switch to the next choice.

 When you switch to another response choice, the changes you have made to the previous choice 
are saved automatically.

10 To add more choices, click the Add Choice link. 
To cancel adding a new choice, press Esc.

11 To preview your survey and your Choose One question, on the survey designer toolbar, click the 
Preview button.
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Choose Many questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Choose Many.

With the Choose Many question type, your survey participants can select more than one answer for a 
question. This question includes the question text followed by the response options. 
You can customize the appearance of your Choose Many question and add the validation and logic 
properties by using the Question Options and Response Options panels.

Adding and customizing question text
Type the text of your Choose Many question in the text field, and then format the text by using the 

editing toolbar. On the editing toolbar, click the More icon   to open the expanded editor, which 
provides additional editing options. In the expanded editor, you can also use the Spell Check and Word 
Count options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

Adding and customizing choice text
After adding your question text, you need to add the choice text. By default, three choices appear. You 
can add, delete, or move the choices by clicking the menu next to each choice. To format the choice text, 
use the editing toolbar that appears when you click the choice field. You can also click the More icon 

 to access the expanded editor, which provides additional editing options.
You can further customize the choices of the Choose Many question by using the Response Options 
panel, which appears when you click the choice.

 For more information on the question and choice properties of the Choose Many question, see 
Choose Many Question Properties, page 285 and Response options, page 330.

Create a Choose Many question
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design tab > Content side tab, click Choose Many. 

The Choose Many question is added to your survey.
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 If your survey contains at least one question or other content, you can add a Choose Many 
question by clicking the Add button or the Add menu.

3 Click the question number to change the question heading. 
The heading text field becomes editable.

4 Edit the question heading. All your changes are saved automatically. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the ShowQuestion Heading option 
in the Question Options section of your question to make the question heading visible to the 
respondents.

5 To edit the question text, click in the question text field. 
The question text field becomes editable.

6 Edit the question text, and then press Enter to save the changes. 
You can customize your text and add images or media to your question by using the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

7 On the Question Options panel, customize your question appearance, and add the validation and 
logic properties.

8 To edit the choice, click in the appropriate choice text field. The choice text field becomes editable.
9 Edit the choice, and then press Enter to save the changes.

 When you switch to another response choice, the changes you have made to the previous choice 
are saved automatically.

10 To add more choices, click the Add Choice link. 
To cancel adding a new choice, press Esc.

11 To preview your survey and your Choose Many question, on the survey designer toolbar, click the 
Preview button.
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Create a Short Answer question
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Short Answer option.

You can create a Short Answer question to collect short answer responses from your participants. The 
Short Answer question is an open-ended question that includes the question text followed by a single 
text field where participants can enter their responses.

 You cannot add any other text fields to a Short Answer question.

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design tab > Content tab, click the Short Answer button.

 To add a Short Answer question to an existing survey with questions, select it from the Add 
menu.

3 Click the question number to change the question heading. 
The heading text field becomes editable.

4 Edit the question heading, and then press Enter to save the changes. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading option 
in the Question Options section of your question to make the question heading visible to the 
respondents.

5 Click the question text field to enter the question text. 
The question text field becomes editable.

6 Edit the question text, and then press Enter to save the changes. 
To cancel the changes, press Esc.

 You can customize your text by using the editing toolbar. While editing the question text, you can 
use the drag handle to move the mini toolbar.

7 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

8 To preview your survey and your Short Answer question, on the survey designer toolbar, click the 
Preview button.
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Essay questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Essay.

With the Essay question type, you can collect responses from your participants in a free form. The  Essay 
question is an open-ended question type. Survey participants can answer your question with their own 
text.

Adding and customizing question text
Type the text of your Essay question in the text field, and then format the text by using the editing 

toolbar. On the editing toolbar, click the More icon   to open the expanded editor, which provides 
additional editing options. In the expanded editor, you can also use the Spell Check and Word Count 
options.
On the Question Options panel of your Essay question, you can show or hide the question heading or 
the entire question. You can also set the validation and logic properties for your Essay question. For 
example, you can require participants to answer your question.

 You can add an Essay question to the side of the Matrix question.

Create an Essay Question

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Essay. 

The Essay question is added to your survey.

 If your survey contains at least one question or other content, you can add an Essay question by 
clicking the Add button or the Add menu.

3 Click the question number to edit the question heading. 
The heading text field becomes editable.

4 Edit the question heading. All your changes are saved automatically. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading check 
box on the Question Options panel to make the question heading visible to the respondents.

5 Click the question text field, and then type the question text. You can customize your text and add 
images or media to your question by using the editing toolbar.
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 The editing toolbar appears when you edit your question. You can use the drag handle to move 
the mini toolbar.

 

 

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

6 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

7 To preview your survey and your Essay question, on the survey designer toolbar, click the Preview 
button.
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Matrix questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Matrix.

The Matrix question is the closed-ended question type, where your participants can select only one or 
many answers. This question includes the rows and choices listed in a series on either side of a matrix. If 
you change the question type of a side, the question options and properties change correspondingly. 
You can add the Choose One, Choose Many, Short Answer, and Essay questions to the sides of your 
Matrix question. If you change the question type of a side, the question options and properties change 
correspondingly. In addition, you can customize your question text, question appearance, and add 
validation and logic properties by using the Question Options, Matrix Side Options, Rows Options, 
and Column Options panels.

Adding and customizing question text
Type the text of your Matrix question in the text field and format the text using the editing toolbar. On 

the editing toolbar, click the More icon   to open the expanded editor, which provides additional 
editing options. In the expanded editor, you can also use the Spell Check and Word Count options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

Adding and customizing row text
After adding your question text, you need to add the row question heading. By default, three rows 
appear. Each row is numbered for your convenience. The row number is displayed in the Edit mode only. 
You can add, delete, or move the rows by clicking the menu next to each row.
To format the row text, use the editing toolbar that appears when you click the row field. You can also 

click the More icon   to access the expanded editor, which provides additional editing options.
You can further customize the response rows of the Matrix question by using the Rows Options panel, 
which appears when you click the row.

 For more information about the question and rows properties of the Matrix question, see Drag 
& Drop Rank Order Question Properties, page 302 and Response options, page 330.

Adding and customizing sides of the Matrix question
You can customize the side of the Matrix question by using the Matrix Side Options panel, which 
appears when you click Category Text on the top of the Matrix question.
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You can select the type of the matrix side by clicking the menu next to the side. You can also click the Add 
Side icon to add more sides to the Matrix question. 
The following question types can be added to the Matrix question as a side:
• Choose One – With this closed-ended question type, your participants can only choose one 

answer.

 The Matrix side options for this question also include Only Allow a Column to be Selected 
Once.

• Choose Many – With this closed-ended question type, your participants can choose more than 
one answer.

• Short Answer – With this open-ended question type, your participants can answer with their 
own topic text. Additionally, you can require your participants to enter different input data, such 
as text, number, dates, ID & phone numbers, and postal codes.

 The Matrix side options for this question also include Show Running Total and Allocation.

• Essay – With this open-ended question type, your participants can answer with their own topic 
text.

When you add a new side to the Matrix question, the Choose One side is added by default. A new side 
is added to the right of the matrix. The multi-sided Matrix question is displayed as single-sided on small 
devices and if the screen size is too small to display the full question.

 The Matrix question with more than one side may not render ideally on assistive technology 
devices.

Adding and customizing column text
By default, three columns appear under single side. You can add, delete, or move the columns by clicking 
the menu next to each column. You can also add a new column by clicking the Insert Column icon next 
to the last column of a side.
To format the column text, use the editing toolbar that appears when you click the column field. You can 

also click the More icon   to access the expanded editor, which provides additional editing options.
You can further customize the columns of the Matrix question by using the Column Options panel. The 
Column Options panel appears when you click the column. When the side type is changed, the column 
options are changed accordingly.

 The columns are available for the Choose One and Choose Many sides only.

Create a Matrix Question with a Choose One Side

Procedure 
1 On the Surveys tab, click the survey name in the grid.
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2 Go to the Design tab > Content side tab, click Matrix. 
The Matrix question is added to your survey.

 If your survey contains at least one question or other content, you can add a Matrix question by 
clicking the Add button or the Add menu.

3 To change the question heading, click the question number, and then edit the question heading. 
All your changes are saved automatically. To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading check 
box on the Question Options panel to make the question heading visible to the respondents.

4 To edit the question text, click in the question text field, edit the question text, and then press Enter 
to save the changes. 
You can customize your text and add images or media to your question by using the editing toolbar.

 While editing the question, row, and column texts, you can use the drag handle to move the mini 
toolbar. 

5 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

6 To edit the side text, click in the side text field on the top of the Matrix question, edit the side text, 
and then press Enter to save the changes.

 By default, the Matrix question has one side. You can add more sides by clicking the Add Side 
icon.

7 To edit the row heading or the row text, click in the corresponding text field, edit the row heading or 
the row text, and then press Enter.

8 To add more rows, click the Add Row link. 
To cancel adding a new row, press Esc.

9 To edit the category text or the column text, click in the corresponding text field, edit the category text 
or the column text, and then press Enter.

 When you switch to another topic, the changes you have made to the previous topic are saved 
automatically.

10 To add more columns, click the Insert Column option on the menu to the left of the column. 
To cancel adding a new column, press Esc.

11 To preview your survey and your Matrix question, on the survey designer toolbar, click the Preview 
button.
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Drag & Drop Rank Order questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Drag & Drop Rank Order.

With the Drag & Drop Rank Order question type, you can add image- or text-based answers to a 
question, and your survey participants can select an item on the left and drag it across the screen to rank 
it on the right.

 This question type may not render ideally on assistive technology devices.

Adding and customizing question text
Type the text of your Drag & Drop Rank Order question in the text field, and then format the text by 

using the editing toolbar. On the editing toolbar, click the More icon   to open the expanded editor, 
which provides additional editing options. In the expanded editor, you can also use the  Spell Check and 
Word Count options. On the Question Options panel, you can customize the appearance of your 
question and add the validation and logic properties.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

 

Adding and customizing topic text and images
After adding your question text, you need to add the topic text and images. By default, three topics 
appear. You can add, delete, or move the topics by clicking the menu next to each topic. To format the 
topic text, use the editing toolbar that appears when you click the topic field. You can also click the More 

icon   to access the expanded editor, which provides additional editing options.
When you add an image to the Drag & Drop Rank Order question, the image name appears to the right 
of the corresponding topic text. You can point to the image name to see the image preview in a tooltip. 
The maximum limit on the image name is set to 30 characters. If the image name contains more than 30 
characters, it is abbreviated to display appropriately in the question. You can delete the image from your 

question by clicking the Delete icon  to the right of the image name.

 You must tie text to images. If you only insert the image, and the participant has JavaScript 
disabled, the questions will be blank. Additionally, if the participant is using a Web reader, there 
will be no label to read.
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You can pipe responses along with images into the Drag & Drop Rank Order question. See Piping 
values in the Question and Response Text, page 531 for the steps on piping responses from one question 
into another one.

Create a Drag & Drop Rank Order question
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design tab > Content side tab, click Drag & Drop Rank Order. 

The Drag & Drop Rank Order question is added to your survey.

 If your survey contains at least one question or other content, you can add an Drag & Drop 
Rank Order question by clicking the Add button or the Add menu.

3 Click the question number to edit the question heading. 
The heading text field becomes editable.

4 Edit the question heading. All your changes are saved automatically. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading check 
box on the Question Options panel to make the question heading visible to the respondents.

5 Click the question text field, and then type the question text. You can customize your text and add 
images or media to your question by using the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

6 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

7 Click the topic text field, and then type the topic text.
8 To add the image associated with the topic, click the Add Image button. The image manager opens.
9 Click the image that you want to insert. 

 Click the Upload button on the toolbar to add more pictures to the list.

10 Click Insert. The selected image is added to the topic. 
To change the image, click the image name.

11 To add more topics, use the Add Topic link. 
To cancel adding a new topic, press Esc.

 To insert answers from the previous question into this question, select the Pipe in Topics option 
on the menu. If you pipe in respondent answers, you cannot add any additional topics.

12 To preview your survey and your Drag & Drop Rank Order question, on the survey designer 
toolbar, click the Preview button.
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Choose One with Image questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Choose One with Image.

You can add image-based answers to a question, and your survey participants can select only one choice 
for this question. This question includes the question text followed by the image-based response options.  
You can customize the appearance of your Choose One with Image question and add the validation and 
logic properties by using the Question Options and Response Options panels.
You can also show or hide the radio buttons and response text for your question while taking a survey 
(also in the Preview and Test modes) by selecting or clearing the Show Radio Buttons or Show 
Response Text check box on the Question Options panel. In this case, you can still select the needed 
option by clicking an image.

 This feature is available in the Modern survey rendering only. If either Show Radio Buttons 
or Show Response Text check box is cleared, you cannot switch to the Classic survey 
rendering mode. By default, both check boxes are selected.

Adding and customizing question text and images
Type the text of your Choose One with Image question in the text field, and then format the text using 

the editing toolbar. On the editing toolbar, click the More icon   to open the expanded editor, which 
provides additional editing options. In the expanded editor, you can also use the Spell Check and Word 
Count options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

Adding and customizing choice text
After adding your question text, you need to add the choice text. By default, three choices appear. You 
can add, delete, or move the choices by clicking the menu of the individual choice. To format the choice 
text, use the editing toolbar that appears when you click the choice field. You can also click the More icon 

 to access the expanded editor, which provides additional editing options.
When you add an image to the Choose One with Image question, the image name with extension and 
the image icon appear to the right of the corresponding response choice. You can point to the image 
name to see the image preview in a tooltip. In the Preview mode, the images are displayed directly in the 
Choose One with Image question.
You can further customize the response choices of the Choose One with Image question by using the 
Response Options panel in the left pane. The Response Options panel appears when you click the 
choice.
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 For more information on the question and choice properties of the Choose One with Image 
question, see Choose One with Image Question Properties, page 308 and Response options, 
page 330.

The maximum limit on the image name is set to 30 characters. If the image name contains more than 30 
characters, it is abbreviated to display appropriately in the question. You can delete the image from your 

question by clicking the Delete  icon to the right of the image name.

 You must tie the text to images. If you only insert the image, and the participant has JavaScript 
disabled, the questions will be blank. Additionally, if the participant is using a Web reader, there 
will be no label to read.
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Creating a Choose One with Image question

Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Choose One with Image.

You can create a Choose One with Image question.

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Choose One with Image. The Choose One with 

Image question is added to your survey.

 If your survey contains at least one question or other content, you can add the Choose One 
with Image question by clicking the Add button or the Add menu.

3 Click the question number to edit the question heading. The heading text field becomes editable.
4 Edit the question heading. All your changes are saved automatically. 

To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading check 
box on the Question Options panel to make the question heading visible to the respondents.

5 To edit the question text, click in the question text field. 
The question text field becomes editable.

6 Edit the question text, and then press Enter to save the changes. 
You can customize your text and add images or media to your question by using the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

7 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

8 To edit the choice text, click in the choice text field. 
The choice text field becomes editable.

9 Edit the choice text, and then press Enter to save the changes and switch to the next choice.
10 To add the image associated with the choice, click the Add Image button. 

The image manager opens.
11 Click the image that you want to insert. 

 Click the Upload button on the toolbar to add more pictures to the list. The maximum image 
upload size is 1,024.00 KB.

12 Click Insert. The image is added to the choice. 
To change the image, click the image name.



Designing Your Survey Overview Creating a Choose One with Image question

EFM User Guide 262

Confidential and Proprietary Information of Verint Systems Inc.

13 To add more choices, click the Add Choice link. 
To cancel adding a new choice, press Esc.

 When you switch to another choice, the changes you have made to the previous topic are saved 
automatically.

14 To preview your survey and your Choose One with Image question, on the survey designer toolbar, 
click the Preview button.
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Choose Many with Image questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Choose Many with Image.

With the Choose Many with Image question type, you can add image-based answers to a question, 
and your survey participants can select more than one choice for this question. This question includes the 
question text followed by the image-based response options. 
You can customize the appearance of your Choose Many with Image question and add the validation 
and logic properties by using the Question Options and Response Options panels.

Adding and customizing question text
Type the text of your Choose Many with Image question in the text field, and then format the text by 

using the editing toolbar. On the editing toolbar, click the More icon  to open the expanded editor, 
which provides additional editing options. In the expanded editor, you can also use the Spell Check and 
Word Count options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

Adding choice text and images
After adding your question text, you need to add the choice text. By default, three choices appear. You 
can add, delete, or move the choices by clicking the menu next to each choice. To format the choice text, 

use the editing toolbar that appears when you click the choice field. You can also click the More icon 
 to access the expanded editor, which provides additional editing options.
When you add an image to the Choose Many with Image question, the image name with extension 
and the image icon appear to the right of the corresponding response choice. You can point to the image 
name to see the image preview in a tooltip. The maximum character limit on the image name is set to 30. 
If the image name contains more than 30 characters, it is abbreviated to display appropriately in the 

question. You can delete the image from your question by clicking the Delete icon  .

 You must tie text to images. If you only insert the image, and the participant has JavaScript 
disabled, the questions will be blank. Additionally, if the participant is using a Web reader, there 
will be no label to read.
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Create a Choose Many with Image question

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click the Choose Many with Image. The Choose Many 

with Image question is added to your survey.

 If your survey contains at least one question or other content, you can add an Choose Many 
with Image question by clicking the Add button or the Add menu.

3 Click the question number to edit the question heading. The heading text field becomes editable.
4 Edit the question heading. All your changes are saved automatically. 

To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading check 
box on the Question Options panel to make the question heading visible to the respondents.

5 To edit the question text, click in the question text field. 
The question text field becomes editable.

6 Edit the question text, and then press Enter to save the changes. 
You can customize your text and add images or media to your question by using the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

7 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

8 To edit the choice text, click in the appropriate choice text field. 
The choice text field becomes editable.

9 Edit the choice text, and then press Enter to save the changes and switch to the next choice.
10 To add the image associated with the choice, click the Add Image button. 

The image manager opens.
11 Click the image that you want to insert. 

 Click the Upload button on the toolbar to add more pictures to the list. The maximum image 
upload size is 1,024.00 KB.

12 Click Insert. The image is added to the choice. 
To change the image, click the image name.

13 To add more choices, use the Add Choice link. 
To cancel adding a new choice, press Esc.

 When you switch to another choice, the changes you have made to the previous topic are saved 
automatically.
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14 To preview your survey and your Choose Many with Image question, on the survey designer 
toolbar, click the Preview button.
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Fill in the Blank questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Fill In the Blank.

With the Fill in the Blank question type, you can collect fill-in-the-blank responses from your 
participants. This question is an open-ended question that includes the question text followed by the 
topic text fields where participants can enter their responses. 
You can customize the appearance of your Fill in the Blank question and add the validation and logic 
properties by using the Question Options and Topic Options panels.

Adding and customizing question text
Type the text of your Fill in the Blank question in the corresponding text field, and then format the text 

by using the editing toolbar. On the editing toolbar, click the More icon   to open the expanded 
editor, which provides additional editing options. In the expanded editor, you can also use the Spell 
Check and Word Count options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

When you open the survey page, all the questions on this page are not selected. You can edit the Fill in 
the Blank question after clicking the question text. On the Question Options panel, you can customize 
the appearance of your question and add the validation and logic properties.

Adding and customizing topic text
After adding your question text, you need to add the topic text. By default, three topics appear. You can 
add, delete, or move the topics by using the drop-down menu to the right of each topic.
To format the topic text, use the editing toolbar that appears when you click the choice field. You can also 

click the More icon   to access the expanded editor, which provides additional editing options.
You can require users to input a specific type of data into an individual text field by selecting the type of 
data on the Input Type menu on the Topic Options panel, which appears when you click the topic.

 In the Modern survey rendering mode, there is a hint text for the Email Address, Whole 
Number, Real Number, Social Security Number, ZIP Code, and ZIP+4 Code input types so 
that the respondent knows how to answer the question.

You can further customize the topics of your Fill in the Blank question by using the Topic Options 
panel.

 You can add the Fill in the Blank question to the Matrix question as a side.
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Create a Fill in the Blank question

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Fill in the Blank. 

The Fill in the Blank question is added to your survey. Enter question text in the Question Text 
field. You can customize your text and add images or media to your question using the editing 
toolbar.

 If your survey contains at least one question or other content, you can add the Fill in the Blank 
question by clicking the Add button or the Add menu.

3 Click the question number to change the question heading. The heading text field becomes editable.
4 Edit the question heading, and then press Enter to save the changes. 

To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading option 
in the Question Options section of your question to make the question heading visible to the 
respondents.

5 To edit the question text, click in the question text field. 
The question text field becomes editable.

6 Edit the question text, and then press Enter to save the changes. 
You can customize your text and add images or media to your question by using the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

7 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

8 To edit the topic, click in the topic text field. The topic text field becomes editable.
9 Edit the topic text, and then press Enter to save the changes and switch to the next choice.

 When you switch to another topic, the changes you have made to the previous topic are saved 
automatically.

10 Specify the type of data you want participants to input into your Fill in the Blank fields by using the 
Topic Options panel.

11 To add more topics, click the Add Topic link. 
To cancel adding a new topic, press Esc.

12 To preview your survey and your Fill in the Blank question, on the survey designer toolbar, click the 
Preview button.
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Scrolling Matrix questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Scrolling Matrix.

With the Scrolling Matrix question type, you can add image- or text-based answers to a question that 
scroll across the screen. Additionally, the interactivity of the respondent experience is enhanced. 
You can customize the appearance of your Scrolling Matrix question and add the validation and logic 
properties by using the Question Options, Topic Options, and Choice Options panels.
The topic text and the image associated with the topic text are displayed in the middle of the question 
box. Only one topic appears at a time. The choices are displayed below the topic and are the same for all 
topics. A counter in the upper-right corner of the question box shows the number of the topic that you 
are answering and the total number of topics.
You can skip the answer by clicking the Skip Choice button in the center of the question box. If the 
answer is required, the Skip Choice button is not displayed.
You can change your answers by clicking the View or Change Answers button. A list with all your 
answers appears, where you can click the answer you want, and then change it. For image-based 
questions, the image appears as your answer, and for text questions, the link appears as your answer. To 
return to the regular view without any edits, click the Hide Answers button.

 This question type may not render ideally on assistive technology devices.

Adding and customizing question text
Type the text of your Scrolling Matrix question in the text field, and then format the text by using the 

editing toolbar. On the editing toolbar, click the More icon  to open the expanded editor, which 
provides additional editing options. In the expanded editor, you can also use the Spell Check and Word 
Count options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

On the Question Options panel, you can customize the appearance of your question and add the 
validation and logic properties.

Adding and customizing topic text and images
After adding your question text, you need to add the topic text. By default, three topics appear. You can 
add, delete, or move the topics by clicking the menu next to each topic. Additionally, you can pipe matrix 
responses along with images into the Scrolling Matrix question by clicking the menu next to the 
corresponding topic. To format the topic text, use the editing toolbar that appears when you click the 
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topic field. You can also click the More icon  to access the expanded editor, which provides 
additional editing options.
When you add an image to the Scrolling Matrix question, the image name appears to the right of the 
corresponding topic text. You can point to the image name to see the image preview in a tooltip. The 
maximum limit on the image name is set to 30 characters. If the image name contains more than 30 
characters, it is abbreviated to display appropriately in the question. You can delete the image from your 

question by clicking the Delete icon  to the right of the image name.

 You must tie text to images. If you only insert the image and the participant has JavaScript 
disabled, the questions will be blank. Additionally, if a participant is using a Web reader, there will 
be no label to read.

Adding and customizing choice text
By default, three choices appear. You can add, delete, or move the choices by clicking the menu to the left 
of the individual choice. To format the choice text, use the editing toolbar that appears when you click in 

the choice text field. On the editing toolbar, you can also click the More icon  to access the 
expanded editor, which provides additional editing options. Select the Edit Together option on the 
menu to edit all choices together in the rich text editor but place each choice on a separate line.
Because the choices are the same across all topics, you should enter only one set of choices. You can 
further customize the choices of the Scrolling Matrix question by using the Choice Options panel, 
which appears when you click the choice.

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content  tab, click Scrolling Matrix. 

The Scrolling Matrix question is added to your survey.

 If your survey contains at least one question or other content, you can add the Scrolling Matrix 
question by clicking the Add button or the Add menu.

3 To change the question heading, click the question number, and then edit the question heading. All 
your changes are saved automatically. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading check 
box on the Question Options panel to make the question heading visible to the respondents.

4 To edit the question text, click in the question text field, edit the question text, and then press Enter 
to save the changes. 
You can customize your text, and add images or media to your question by using the editing toolbar.
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 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

5 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

6 To change the row heading, click in the corresponding text field, edit the row heading, and then press 
Enter.

 The respondent can view and edit the row heading of the Scale Slider question only if the 
JavaScript is turned off in the browser, and the JavaScript Required check box is cleared in the 
Properties tab of the Design view.

7 To edit the topic, click in the topic text field, edit the topic text, and then press Enter to save the 
changes and switch to the next topic.

8 To add the image associated with the topic, click the Add Image button. 
The image manager opens.

9 Click the appropriate image, and then click Insert. The image is added to the topic.
To change the image, click the image name.

 To add more pictures to the list, on the toolbar, click the Upload button.

10 To add more topics, click the Add Topic link. 
To cancel adding a new topic, press Esc.

 To insert answers from the previous question into this question, select the Pipe in Topics option 
on the menu. If you pipe in respondent answers, you cannot add any additional topics.

11 To edit the choice, click in the choice text field in the Choices section. 
The choice text field becomes editable.

12 Edit the choice text, and then press Enter to save the changes.
13 To add more choices, select the Insert Choice option from the on menu to the left of the choice.

 To insert a choice list from the library, on the menu, select the Add Library Scale option.

14 To preview your survey and your Scrolling Matrix question, on the survey designer toolbar, click the 
Preview button.
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Scale Slider questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Scale Slider.

With the Scale Slider question type, you can add image- or text-based answers to a question, and your 
survey participants can move a slider across the scale to answer this question. The Scale Slider question 
includes images that appear to the left of the slider with the corresponding topic text above the slider. 
Each topic is displayed as an individual slider with the same choices across all topics. All choices appear 
across the bottom of the scale with a tick mark representing where the answer is registered. If you drag 
the slider to a point between the ticks, the slider moves to the nearest option. The selected choice is 
displayed in bold and indicates your answer.
You can customize your question appearance and the validation and logic properties by using the 
Question Options, Topic Options, and Choice Options panels.

 Do not rename the N/A label as an answer to the question, for example, Often or Rarely. With 
this option, the respondents have a possibility not to select any of the given choices for the 
question; the value associated with N/A is always zero.

You can answer the Scale Slider question in the following ways:
• Drag the slider to the required choice.
• Click the choice name to move the slider to the selected position.
• Select the slider and move it to the required choice by using the appropriate arrow keys on the 

keyboard.

 This question type may not render ideally on assistive technology devices.

Adding and customizing question text
Type the text of your Scale Slider question in the text field, and then format the text by using the editing 

toolbar. On the editing toolbar, click the More icon  to open the expanded editor, which provides 
additional editing options. In the expanded editor, you can also use the Spell Check and Word Count 
options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

Adding and customizing topic text and images
After adding your question text, you need to add the topic text and edit the row heading. By default, 
three topics appear. You can add, delete, or move the topics by using the drop-down menu next to each 
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topic. To format the topic text, use the editing toolbar that appears when you click the topic field. You can 

also click the More icon  to access the expanded editor, which provides additional editing options.
When you add an image to the Scale Slider question, the image name appears to the right of the 
corresponding topic text. You can point to the image name to see the image preview in a tooltip. The 
maximum limit on the image name is set to 30 characters. 
If the image name contains more than 30 characters, it is abbreviated to display appropriately in the 

question. You can delete the image from your question by clicking the Delete icon  to the right of the 
image name.

 You must tie text to images. If you only insert the image and the participant has JavaScript 
disabled, the questions will be blank. Additionally, if a participant is using a Web reader, there will 
be no label to read.

Adding and customizing choice text
By default, three choices appear. You can add, delete, or move the choices by clicking the drop-down 
menu to the left of the individual choice. To format the choice text, use the editing toolbar that appears 

when you click in the choice text field. On the editing toolbar, you can also click the More icon   to 
access the expanded editor, which provides additional editing options. Select the Edit Together option 
on the  menu to edit all choices together in the rich text editor but place each choice on a separate line.
Because the choices are the same across all topics, you should enter only one set of choices. You can 
further customize the choices of the Scale Slider question by using the Choice Options panel, which 
appears when you click the choice.

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Scale Slider. 

The Scale Slider question is added to your survey.

 If your survey contains at least one question or other content, you can add the Scrolling Matrix 
question by clicking the Add button or the Add menu.

3 To change the question heading, click the question number, and then edit it. All your changes are 
saved automatically. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Headingcheck 
box on the Question Options panel to make the question heading visible to the respondents.

4 To edit the question text, click in the question text field, edit the question text, and then press Enter 
to save the changes. 
You can customize your text and add images or media to your question by using the editing toolbar.
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 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

5 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

6 To edit the row heading, click in the corresponding text field, edit the row heading, and then press 
Enter.

 The respondent can view and edit the row heading of the Scale Slider question only if the 
JavaScript is turned off in the browser, and the JavaScript Required check box is cleared on the 
Design view > Properties tab.

7 To edit the topic, click in the topic text field, edit the topic text, and then press Enter to save the 
changes.

8 To add the image associated with the topic, click the Add Image button. 
The image manager opens.

9 Click the appropriate image, and then click Insert. The image is added to the topic. 
To change the image, click the image name.

 To add more pictures to the list, on the toolbar, click the Upload button.

10 To add more topics, click the Add Topic link. 
To cancel adding a new topic, press Esc.

 When you switch to another topic, the changes you have made to the previous topic are saved 
automatically.

11 To edit the choice, in the Choices section, click in the choice text field, edit the choice text, and then to 
save the changes and switch to the next choice, press Enter.

12 To add more choices, click the Insert Choice option from the menu to the left of the choice. 
To cancel adding a new choice, press Esc.

 To insert a choice list from the library, on the menu, click the Add Library Scale option.

13 To preview your survey and your Scale Slider question,  on the survey designer toolbar, click the 
Preview button.
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Rank Order questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Rank Order.

You can require participants to rank either all or a subset of topics. Your survey participants can use radio 
buttons or a  list to answer this question.

Adding and customizing question text
Type the text of your Rank Order question in the text field, and then format the text by using the 

editing toolbar. On the editing toolbar, click the More icon   to open the expanded editor, which 
provides additional editing options. In the expanded editor, you can also click the Spell Check and Word 
Count options. On the Question Options panel, you can customize the appearance of your question 
and add the validation and logic properties.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

Adding and customizing topic text
After adding your question text, you need to add the topic text and edit the row heading. By default, 
three topics appear. You can add, delete, or move the topics by clicking the  menu next to each topic. To 
format the topic text, use the editing toolbar that appears when you click the topic field. You can also click 

the More icon  to access the expanded editor, which provides additional editing options.
Additionally, you can select the Edit Together option on the menu to edit all topics together in the rich 
text editor. Place each topic on a separate line.
You can pipe responses into the Rank Order question. See Piping values in the Question and Response 
Text, page 531 for the steps on piping responses from one question into another one.

Adding and customizing column text
By default, three columns appear. The number of columns depends on the number of topics. You can 
change the default ranks of 1, 2, and 3 to Top, Neutral, and Bottom, for example.
To format the column text, use the editing toolbar that appears when you click the column field. You can 

also click the More icon   to access the expanded editor, which provides additional editing options.
You can further customize the columns of the Rank Order question by using the Column Options 
panel in the left pane. The Column Options panel appears when you click the column.
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Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Rank Order. 

The Rank Order question is added to your survey.

 If your survey contains at least one question or other content, you can add the  Rank Order 
question by clicking the Add button or the Add menu.

3 To change the question heading, click the question number, and then edit the question heading. All 
your changes are saved automatically. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading check 
box on the Question Options panel to make the question heading visible to the respondents.

4 Click the question text field, and then type the question text. You can customize your text and add 
images or media to your question by using the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

5 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

6 To edit the row heading or the topic text, click in the corresponding text field, edit the row heading or 
the row text, and then press Enter.

7 To add more topics, click the Add Topic link. 
To cancel adding a new topic, press Esc.

 To insert answers from the previous question into this question, select the Pipe in Topics option 
on the menu. If you pipe in respondent answers, you cannot add any additional topics.

8 To edit the column, click in the column text field, edit the column text, and then to save the changes 
and switch to the next column, press Enter.

9 To preview your survey and your Rank Order question, on the survey designer toolbar, click the 
Preview button.
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Create an Image Upload question
 

Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Image Upload.

With the Image Upload question, you can add an image-based answer to a question. You can also collect 
the image geolocation data, add, edit, or remove the image tags.
You can customize the appearance of your Image Upload question and add the validation and logic 
properties by using the Question Options panel. You can also customize your text and add images or 
media to your question by using the editing toolbar.

 The Image Upload question is available only in the Modern survey rendering mode.
 

 

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

The Image Upload question is available for editing in the Preview mode only. 

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Image Upload.

 If your survey contains at least one question or other content, you can add the Image Upload 
question by clicking the Add button or the Add menu.

 

3 To edit a question heading, click the question number, type a new question heading, and then press 
Enter to save the changes. 
To cancel the changes, press Esc.

 By default, the question heading is hidden. To make it visible to the respondents, in the 
QuestionOptions section of your question, click Show Question Heading.

 

4 In the question text field, edit the question text, and then press Enter to save the changes.

 While editing the question, you can use the drag handle to move the mini toolbar.
 

5 To customize your question appearance, on the editing toolbar, on the Question Options panel, add 
validation or logic properties to your question. 

6 To preview your survey and your Image Upload question, on the survey designer toolbar, click 
Preview.
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After selecting the image to answer the question, the respondent can see the progress bar showing the 
progress of uploading the image and the Cancel button next to it. If the respondent proceeds to the 
next page, and then clicks Back, the image is not displayed, only the image name is displayed.

 If the respondent uses Internet Explorer 9 or earlier, only the image name is displayed after 
uploading.

 

When the image is uploaded, its label is immediately shown to the respondent for verification. The 
following image formats are supported: .bmp, .emf, .exif, .gif, .ico, .jpg, .jpeg, .png, .tiff, and .wmf.
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List of property indicators
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > add content to your survey and set some properties for the blocks, pages, questions, and 
choices.

When you set properties for blocks pages, questions, and choices in the survey designer, the 
corresponding property indicators appear in the right content pane. The property indicators for 
questions appear above the question they refer to; the property indicators for pages and blocks appear 
in the corresponding status bars below the block and page names. You can see the indicators when you 
are in the Edit survey view. Hover over the indicator to see its tooltip.

 You can also view the same property indicators on the Pages page.

When more than one indicator of the same type is used, the indicators become stacked. Stacked 
indicators have a numeric value of how many properties are covered by the stack. In the tooltip of a 
stacked indicator, you can view each property on a separate line.

List of Property Indicators 

“Allocation” is set for a “Fill in the Blank” or “Matrix” question with the “Short 
Answer” side.

• Answer Required" is set for a question.
• "Respondent Must Pick" is set for a "Choose Many" question. It is used 

with the "Answer Required" option.
• Respondent Must Rank" is set for a "Drag & Drop Rank Order" or "Rank 

Order" question.
• "Answer Required" is set for a topic in a "Fill in the Blank" question.

• Conditional visibility is set for a question choice. The icon is displayed 
along with a condition summary above the question.

• Conditional visibility is set for a question. The icon is displayed along with 
a condition summary above the question.

• Conditional visibility is set for a row. The icon is displayed along with a 
condition summary in a tooltip.

• "Destination" is set for a question. The icon is displayed along with a 
destination summary below the question.

• "Destination" is set for a question choice. The icon is displayed along with 
a destination summary below the question.

• "Exclusive" is set for a choice in a "Choose Many" question.
• "Only Allow a Column to be Selected Once" is set for the side in a "Matrix" 

question.
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List of Property Indicators 

  • "Fixed Position" is set for a choice in a question. It is used with the 
"Randomize Choices" option.

• "Fixed Position" is set for a row in a "Matrix" question. It is used with the 
"Randomize Table Rows" option.

• "Randomize Choices" is set for a question.
• "Randomize Table Rows" is set for a "Matrix" question.
• "Randomize Topics" is set for a question.
• "Add Page Randomization" is set for a block.

• "Page Rotation" is set for a block.

• Conditional Visibility is set for a page. The icon is displayed along with a 
condition summary below the page name.

• Conditional Visibility is set for a block. The icon is displayed along with a 
condition summary below the block name.

The "Hidden" visibility is set for a question.

• Validation is set for a topic in a "Fill in the Blank" question along with a 
short validation summary in a tooltip.

• Validation is set for a "Short Answer" question along with a short 
validation summary in a tooltip.
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Bulk Edit
Navigation

Design & Collect tab > Surveys tab > create a new survey or open a saved survey from the My Surveys 
grid > Design tab > add a question to your survey > Question Options > Bulk Edit link > Bulk Edit 
dialog box.

You can use the Bulk Edit link to change the properties of survey questions at a time instead of editing 
each one separately. The Bulk Edit option is only applicable to the questions of the current survey, which 
belong to the same question type.
The question properties in the Bulk Edit dialog box differ depending on the selected question type. For 
each question type, you can edit the Appearance and Validation & Logic properties. For Matrix 
questions only, you can also edit the HTML Table Appearance properties.

The Bulk Edit dialog box
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Choose One Question Properties
Navigation

Projects tab > Surveys tab > create a new survey or open an existing survey > Design tab > Content 
tab > Add menu > Choose One button.
You can use the Question Options panel to customize the appearance, validation, and logic properties 
for the Choose One question.
On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Choose One question. With the question properties, you can control how your 
question looks in the survey and set specific conditions and limitations for your question.

Layout
Format your Choose One question by selecting the layout options below. In Classic survey rendering 
mode, the Table Row, List Box, Drop-down Box, and Star Rating layout options are not available if 
the Include “Please Specify” Option check box is selected. In Modern survey rendering mode, only 
the Table Row and Star Rating layout options are not available if the Include “Please Specify” 
Option check box is selected. 

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

• List
 

 The List option is selected by default.

• Scale
Labels for the first and last choices are used as anchor labels, with remaining choice labels hidden. If 
choice groups are applied, labels for the first and last choice groups are used as anchor labels. See Choice 
groups, page 328 for information on applying choice groups in the Choose One questions.
• Rows
• Columns
The Columns option includes a drop-down list where you can specify the number of columns that 
displays in your question.
• Table Row
In Modern survey rendering mode, the width between choices in the Table Row layout for the Choose 
One question is the same no matter how many characters the choice label contains. If the choice label 
contains too many characters, to fit to the width, the word will be moved to a new line, and only if the 
word is too long, it will be broken with proper hyphenation.
• List Box
• Drop-down Box
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The Drop-down Box option includes the Caption drop-down list where you can specify the default text 
that the respondent will see in the drop-down list, such as None, Click here to choose, or Click here 
for choices.
• Star Rating
The number of stars matches the number of question choices. For example, if there are five choices in the 
question, you can rate each choice from 1 to 5 stars. When you hover over the star, the current star and 
all preceding stars appear in yellow, and the current choice text is displayed in a tooltip. Respondents can 
answer the question by clicking the star under the selected position. The selected star and all preceding 
stars appear in green.
If the respondent has JavaScript disabled, the Star Rating layout is changed to the Scale layout for the 
question.
• Button

 The Button layout is available in Modern survey rendering mode only. When switching to 
Classic rendering mode, the Button layout changes to the Scale layout. For more information 
about survey rendering modes, see Survey rendering overview, page 414.

If choice groups are applied, labels for the first and last choice groups are used as anchor labels. For more 
information about applying choice groups in the Choose One questions, see Choice groups, page 328.

Options
Use the following options to customize your Choose One question appearance:
• Show Question Heading – Show the question heading. By default, the question heading is 

hidden, and only the question text appears in the survey.
• Randomize Choices – Sow question choices in a random order when the survey is viewed or 

page is refreshed. The choices within the choice groups are randomized too. The order of choice 
groups is not changed.

 Randomization is not available for the Scale, Table Row, Star Rating, and Button layout 
options.

• Reverse Order of Choices – Show question choices in an opposite order when the survey is 
viewed or page is refreshed.

 For the Star Rating layout option, the Randomize Choices and Reverse Order of Choices 
options are not available.

• Answer Required – Require respondents to answer the question before moving to the next 
page or submitting the survey.

• Answer Required for "Please Specify" Options – Require respondents to type information in 
the specified fields before moving to the next page or submitting the survey. This property is only 
visible if you add the "Please Specify" option to a response.

 When "Please Specify" response option is selected, question layout is changed to List layout.
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• Hide Clear Star Selection Option – Hide the Clear Star Selection option from the 
participants.

• Show Clear Star Selection on Right – Display the Clear Star Selection option to the right of 
the stars.

 The Hide Clear Star Selection Option and Show Clear Star Selection on Right options are 
available only for the Star Rating layout option.

• Display Rating – Display rating to the right of the stars.
• Tile Vertically on Mobile – Display buttons vertically instead of horizontally on mobile devices.
• Button Width (in pixels) – Specify the button width by typing the needed value here. The width 

of the button will not be smaller than this value, but can exceed it to be sufficient for larger choice 
text.

 The Tile Vertically on Mobile and Button Width (in pixels) options are available only for the 
Button layout option.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode. 
Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Preselected
Select an option from this drop-down list to specify the answer that will be selected for your question by 
default. The available options are None and all question choices. None is a default value.

 In Modern survey rendering mode, if the question choice is conditionally preselected, the 
Conditionally Determined option appears in the Preselected drop-down list. For more 
information, see Define response conditional preselection criteria, page 338.
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Destination
Select an option from the Destination drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The Destination functionality requires that the original and target questions are separated by 
page break.

The available options are Not Set, End, and all questions that follow the current question. Not Set is a 
default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Choose Many Question Properties
Navigation

Projects tab > Surveys tab > create a new survey or open an existing survey > Design tab > Content 
tab > Add drop-down menu > Choose Many button.
On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Choose Many question. With the question properties, you can control how your 
question looks in the survey and set specific limitations and conditions for your question.

Layout
Format your Choose Many question by selecting the following layout options:
• List

 The “List” option is selected by default.

• Scale
Labels for the first and last choices are used as anchor labels, with remaining choice labels hidden. If 
choice groups are applied, labels for the first and last choice groups are used as anchor labels. See Choice 
groups, page 328 for information on applying choice groups in the Choose Many questions.
• Rows
• Columns
The Columns option includes a drop-down list where you can specify the number of columns that 
displays in your question.
• Table Row
In Modern survey rendering mode, the width between choices in the Table Row layout for the Choose 
Many question is equal no matter how many characters the choice label contains. If the choice label 
contains too many characters, to fit to the width, the word will be moved to a new line, and only if the 
word is too long, it will be broken with proper hyphenation.

Options
Use the following options to customize your Choose Many question appearance:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
• Randomize Choices – Select to show question choices in a random order every time the survey 

is viewed or page is refreshed. The choices within the choice groups are randomized too. The 
order of choice groups is not changed.

 Randomization is not available for the Scale, Table Row, and Star Rating layout options.

• Reverse Order of Choices – Select to show question choices in an opposite order every time the 
survey is viewed or page is refreshed.
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• Answer Required – Select to require respondents to answer the question before moving to the 
next page or submitting the survey.

• Answer Required for "Please Specify" Options – Select to require respondents to enter 
information in the specified fields before moving to the next page or submitting the survey. This 
property is only visible if you add the "Please Specify" option to a response.

• Respondent Must Pick – Select an option from the "Respondent Must Pick" drop-down list to 
require respondents to provide a minimum, maximum, or exact number of responses. "No 
response required" is a default value.

 If you select the "Answer Required" check box, the default value for "Respondent Must Pick" is "At 
least 1 Choice."

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode.
Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Least Filled Choices
Select the number of choices with the lowest response rate from the Least Filled Choices drop-down 
list to allow autoselection of those choices if the respondent did not choose any.

 The Least Filled Choices option is only available for the Modern survey rendering.
Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

When the respondent starts a survey, choice ranks are determined for any Choose Many questions, 
which use the autoselection option. Each choice is assigned a unique rank based on the number of 
respondents, who selected that choice. If one or more choices have the same count, a rank is assigned at 
random. These ranks are stored in session and used for autoselection.

 If the respondent selects a choice for the question, nothing is autoselected regardless of the 
Least Filled Choices setting.
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Autoselection works for the choices and pages, which are visible or conditionally visible (if the visibility 
criteria are met) for the respondent and all questions regardless of their visibility. Choices marked as 
Exclusive do not support autoselection.

 If the Answer Required option is selected, the Least Filled Choices option is disabled.

Destination
Select an option from the "Destination" drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," and all questions that follow the current question. "Not Set" is 
a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Short Answer question properties
Navigation

Projects tab > Surveys tab > create a new survey or open an existing survey > Design tab > Content 
tab > Add drop-down menu.
Setting the Short Answer question properties helps you control the question appearance and set 
specific conditions and limitations for your question.

Options
Use the following options to customize your Short Answer question:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
• Answer Required – Select to require respondents to answer the question before moving to the 

next page or submitting the survey.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Destination
Select an option from the Destination drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.
The available options are Not Set, End, and all questions that follow the current question. Not Set is a 
default value. You can set the destination to any custom end page by selecting the custom page from the 
drop-down list.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client.

Other Options
• Input Type – Select the type of data you want the participants to input into a particular topic text 

field.
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• Display Spin Buttons – This option is available for the Numbers input type. When the 

Numbers input type is selected, the spin buttons  appear in the text box. By default, this 
check box is not selected.

 For older questionnaires with the ShortAnswer question, the Display Spin Buttons option is 
selected by default.

 The Display Spin Buttons option is available only in the Modern survey rendering mode.

• Display as Slider – This option is available for the Numbers input type. When the Numbers 
input type is selected, the topic is displayed as a slider. Also, a text box appears containing the 
numerical value that the current position of the slider represents. A minimum and maximum 
value must be assigned to represent the range for the slider. The Slider Step defines the 
numerical value used to separate each position on the slider.

 If you select the Display as Slider check box for the Short Answer question, the Display Spin 
Buttons option is unavailable.

• Display as Calendar Pop-up – The calendar pop-up is displayed for the Dates input type.
• Caption – This option is available for the "AutoDropdowns" input type and defines the default 

text that the respondents see in the drop-down list when nothing is currently selected.
• Instructions – If you want to provide additional instructions to your question, type short text in 

the Instructions text box. The instructions text appears right under the question text in a 
survey. You can preview it by clicking the Preview button on the survey designer. The 
Instructions option is available only in Modern survey rendering mode.

 The Classic survey rendering is unavailable for new workgroups. In the future EFM releases, 
Classic survey rendering will not be supported.

• Preselected – The choice is selected by default but can still be modified.
• Alignment – Select the option to align characters in the text box to the left, center, or right.
• Symbol – Select a symbol to display to the right of the text box. The following options are 

available: %, $, and EA.
• Insert symbol to the left of the box – Select the check box to align value selected from the 

Symbol drop-down list to the left of the text box. By default, this option is inactive.
• Minimum Length – The respondent's answer must equal or exceed the value you enter here.
• Maximum Length – The respondent's answer must not exceed the value you enter here.
• Valid Characters – Limit the acceptable characters that can be entered for the question.
• Text Box Width (in characters) – Define the width of the text field in characters. This layout 

option is available only in classic survey rendering mode.
• Text Mask – Define the format for the text entry. Use "9" for numbers, "X" for letters, and "?" for 

any character.
• Validate Topics – Select whether all or only specific entries are allowed. The following options are 

available:
• All Entries are allowed – When you select this option, all entries are valid.
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• Entries must follow this rule – When you select this option, the expression drop-down list and 
the text box to the right are activated. You can specify the validation rule to follow. The available 
expressions depend on what Input Type is associated with the topic.

You can also pipe the profile data into the survey by using the Insert Piped Value icon. When you click 
the Insert Piped Value icon, the Insert Piped Value dialog box opens with all the information that can 
be piped into the survey. The information includes all profiles created inside the current workgroup.
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Fill in the Blank Question Properties
Navigation

Projects tab > Surveys tab > create a new survey or open an existing survey > Design tab > Content 
tab > Add drop-down menu > Fill in the Blank button.
On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Fill in the Blank question. With the question properties, you can control how your 
question looks in the survey and set specific conditions and limitations for your question.

Layout
Use the following options to specify the alignment of question labels and text boxes:
• Top Aligned – Display the topic text above the text box.
• Right Aligned (default) – Display the topic text on the same line as a text box, aligned to the 

right.

 When right-to-left format is applied to the survey, Left Aligned becomes a default alignment.

• Left Aligned – Display the topic text on the same line as a text box, aligned to the left.

 The Layout section is available only in Modern survey rendering. For more information about 
survey rendering modes, see Survey rendering overview, page 414.

Options
Use the following options to customize your Fill in the Blank question appearance:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
• Show Running Total – Select to display the Total field in your Fill in the Blank question that 

shows the total number of respondent's answers. You can edit the name of this field under Total 
Label. The Total Label property appears when you select the Show Running Total check box. 
You can use the Show Running Total together with the Allocation functionality.

Validate all the Fill in the Blank question topics as a real or whole number under Input Type to use the 
Show Running Total feature.

 For a published question, you can change the Show Running Total properties if all Fill in the 
Blank question topics are numeric only.

• Answer Required – Select to require respondents to answer the question before moving to the 
next page or submitting the survey.

• Allocation – Select to require respondents to enter numbers in the Fill in the Blank question 
topics that will total to a specified amount. Next, select the amount to which the respondent's 
answers must total from the drop-down list that appears. The default value is 100.
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Validate all the Fill in the Blank question topics as a real or whole number under Input Type to use the 
Allocation feature.

 For a published question, you can change the Allocation properties if all Fill in the Blank 
question topics are numeric only.

Validate the Fill in the Blank question topic as a real or whole number under Input Type to use the 
Display Spin Buttons feature. When the Display Spin Buttons check box is selected, the spin buttons 

 appear in the text box. By default, this check box is not selected.

 For older questionnaires with the Fill in the Blank question, the Display Spin Buttons option 
is selected by default.

 The Display Spin Buttons option is available only in the Modern survey rendering mode.

If you select the Display as Slider check box for the Fill in the Blank question topic, the Display Spin 
Buttons option is unavailable.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode. Starting with the 
EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the future EFM 
releases, Classic survey rendering will not be supported.

Destination
Select an option from the Destination drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The Destination functionality requires that the original and target questions are separated by 
page break.

The available options are Not Set, End, and all questions that follow the current question. Not Set is a 
default value.
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You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Fill in the Blank questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Fill In the Blank.

With the Fill in the Blank question type, you can collect fill-in-the-blank responses from your 
participants. This question is an open-ended question that includes the question text followed by the 
topic text fields where participants can enter their responses. 
You can customize the appearance of your Fill in the Blank question and add the validation and logic 
properties by using the Question Options and Topic Options panels.

Adding and customizing question text
Type the text of your Fill in the Blank question in the corresponding text field, and then format the text 

by using the editing toolbar. On the editing toolbar, click the More icon   to open the expanded 
editor, which provides additional editing options. In the expanded editor, you can also use the Spell 
Check and Word Count options.

 If the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared, the Media Manager button is hidden in the 
editing toolbar. For more information, see General Setup, page 1406.

When you open the survey page, all the questions on this page are not selected. You can edit the Fill in 
the Blank question after clicking the question text. On the Question Options panel, you can customize 
the appearance of your question and add the validation and logic properties.

Adding and customizing topic text
After adding your question text, you need to add the topic text. By default, three topics appear. You can 
add, delete, or move the topics by using the drop-down menu to the right of each topic.
To format the topic text, use the editing toolbar that appears when you click the choice field. You can also 

click the More icon   to access the expanded editor, which provides additional editing options.
You can require users to input a specific type of data into an individual text field by selecting the type of 
data on the Input Type menu on the Topic Options panel, which appears when you click the topic.

 In the Modern survey rendering mode, there is a hint text for the Email Address, Whole 
Number, Real Number, Social Security Number, ZIP Code, and ZIP+4 Code input types so 
that the respondent knows how to answer the question.

You can further customize the topics of your Fill in the Blank question by using the Topic Options 
panel.

 You can add the Fill in the Blank question to the Matrix question as a side.
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Create a Fill in the Blank question

Procedure 
1 On the Surveys tab, click the survey name in the grid.
2 Go to the Design view > Content tab, click Fill in the Blank. 

The Fill in the Blank question is added to your survey. Enter question text in the Question Text 
field. You can customize your text and add images or media to your question using the editing 
toolbar.

 If your survey contains at least one question or other content, you can add the Fill in the Blank 
question by clicking the Add button or the Add menu.

3 Click the question number to change the question heading. The heading text field becomes editable.
4 Edit the question heading, and then press Enter to save the changes. 

To cancel the changes, press Esc.

 By default, the question heading is hidden. You can select the Show Question Heading option 
in the Question Options section of your question to make the question heading visible to the 
respondents.

5 To edit the question text, click in the question text field. 
The question text field becomes editable.

6 Edit the question text, and then press Enter to save the changes. 
You can customize your text and add images or media to your question by using the editing toolbar.

 While editing the question and choice texts, you can use the drag handle to move the mini 
toolbar.

7 On the Question Options panel, customize your question appearance and add the validation and 
logic properties.

8 To edit the topic, click in the topic text field. The topic text field becomes editable.
9 Edit the topic text, and then press Enter to save the changes and switch to the next choice.

 When you switch to another topic, the changes you have made to the previous topic are saved 
automatically.

10 Specify the type of data you want participants to input into your Fill in the Blank fields by using the 
Topic Options panel.

11 To add more topics, click the Add Topic link. 
To cancel adding a new topic, press Esc.

12 To preview your survey and your Fill in the Blank question, on the survey designer toolbar, click the 
Preview button.
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Essay Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Essay Question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Essay question. With the question properties, you can control how your question 
looks in the survey and set specific limitations and conditions for your question.

Layout
Format your "Essay" question by setting the following layout options:
• Text Box Width – Set the text box width of the Essay question in characters. This layout option 

is available only in classic survey rendering mode.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

• Text Box Height – Set the text box height of the Essay question in lines.

Options
Use the following options to customize your Essay question appearance:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
• Answer Required – Select to require respondents to answer the question before moving to the 

next page or submitting the survey.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.
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 The Instructions option is available only in Modern survey rendering mode.Starting with the 
EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the future EFM 
releases, Classic survey rendering will not be supported.

Preselected
Type the answer that will appear for your question by default. You can type up to 255 characters in the 
field. "None" is a default value.

Destination
Select an option from the "Destination" drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," and all questions that follow the current question. "Not Set" is 
a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Characters Limitation
Manage the characters in your Essay question by using the following options:
• Enable Characters Limitation – Select to limit the amount of text that respondents can enter 

while answering your "Essay" question. In the text box, enter the number of characters to limit.
• Enable Characters Counter – Select to count the number of characters entered in the "Essay" 

question. The counter is available only if you activate the "Enable Characters Limitation" option. 
The respondent can see the number of characters remaining within the text field. Blank spaces 
are counted as characters.

 

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.
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 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Essay Text Box Width and Height
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Question Options panel > Text Box Width and Text Box 
Height text boxes.

You can set the text box width and height of the Essay question and the "Essay" side of the Matrix 
question. The Essay text box width is measured in characters and the text box height-in lines. 
Additionally, you can resize the text box by dragging its edge.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

The table below shows the maximum, minimum, and default values for the Essay width and height.
 

The Essay question

Width (in characters) Height (in lines)

Max 255 Max 255

Min 3 Min 1

Default 62 Default 3

 

The "Essay" side of the Matrix question

Width (in characters) Height (in lines)

Max 255 Max 255

Min 3 Min 1

Default 30 Default 3

For the Essay question, you can adjust the text box width and height on the Question Options panel.
For the "Essay" side of the Matrix question, you can adjust the text box width and height on the Matrix 
Side Options panel.
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Limiting the Characters Number in Essay
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Question Options panel > Enable Characters Limitation 
check box.

You can limit the number of characters that respondents enter when answering an Essay question type. 
The default value is 1500 characters, but you can change it. The minimum value is 0. Blank spaces are 
counted as characters.
Standard validation message appears to notify respondents when they are over the limit. Validation 
message includes the character limit and the number of characters submitted.
To activate the character limitation, select the Enable Characters Limitation check box. The Enable 
Characters Limitation check box is clear by default, and respondents can enter an unlimited number of 
characters when they answer the Essay question.

 You can use "Enable Characters Limitation" together with the "Enable Characters Counter" 
functionality. The respondent can see the number of characters remaining within the text field.

You can also apply the character limitation for an "Essay" side of the Matrix question.

Limit the characters in an Essay Question

Procedure 
1 Add an Essay question.
2 On the Question Options panel to the left, select the Enable Characters Limitation check box.
3 In the text box, enter the limit of characters for your Essay question.

Limit the characters in all the Essay Questions

Procedure 
1 Add the Essay questions to your survey.
2 On the Question Options panel to the left, click the Bulk Edit link. The Bulk Edit dialog box opens.
3 From the Question Type drop-down list, select Essay.
4 Select the Enable Characters Limitation check box.
5 Enter the limit of characters for all the Essay questions.
6 Click Apply All.
7 Click Close.
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Characters Counter in Essay
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Question Options panel > Enable Characters Counter 
check box.

You can provide the respondents with a counter that shows the number of characters remaining within 
an Essay field. The characters are counted automatically as respondents enter the text. Characters 
counter helps better plan the answer to the Essay question.
The counter is available only if you activate the Enable Characters Limitation option. To activate the 
characters counter, select the Enable Characters Counter check box. This check box is selected by 
default.
You can also apply the characters counter for an "Essay" side of the Matrix question. The characters 
counter appears for each field of the Matrix question. See images below.
 

The counter goes backwards. Blank spaces are counted as characters.
You can change the default text of the counter on the Labels tab in the Question Labels section. The 
default text is the following:
• Character limit: %1 for the characters left with JavaScript disabled
• %1 characters left for the characters left with JavaScript enabled

Activate the Characters Counter in an Essay Question

Procedure 
1 Add an Essay question.
2 On the Question Options panel to the left, select the Enable Characters Limitation check box.
3 In the text box, enter the limit of characters for your Essay question.
4 Select the Enable Characters Counter check box.

Activate the Characters Counter in All the Essay Questions

Procedure 
1 Add the Essay questions to your survey.
2 On the Question Options panel to the left, click the Bulk Edit link. The Bulk Edit dialog box opens.
3 From the Question Type drop-down list, select Essay.
4 Select the Enable Characters Limitation check box.
5 In the text box, enter the limit of characters for all the Essay questions.
6 Click Apply All.
7 Select the Enable Characters Counter check box.
 

8 Click Apply All.
9 Click Close.
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Drag & Drop Rank Order Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Question Options panel > Drag & Drop Rank Order 
question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Drag & Drop Rank Order question. With the question properties, you can control 
how your questions look in the survey and set specific limitations and conditions for your question.

 Click the question text field to view the Question Options panel that provides available options 
for your question.

Options
Use the following options to customize your Drag & Drop Rank Order question appearance:
• Show Question Heading – Select to show the question heading to the respondents. By default, 

the question heading is hidden, and only the question text appears in the survey.
• Randomize Topics – Select to show question responses in a random order when the survey is 

viewed or page is refreshed.
• Answer Required – Select to require respondents to answer your question before moving to the 

next page or submitting the survey.
• Respondent Must Rank – Select an option from the "Respondent Must Rank" drop-down list to 

require respondents to rank all, top, minimum, or other number of responses. The following 
options are available:
• Any number of topics – The respondents can rank any number of topics.
• At Least # Topic(s) – The respondents must rank at least # topics.
• At Most # Topic(s) – The respondents must rank no more than # topics.
• Top # Topic(s) – The respondents must rank top # topics.
• All Topics – The respondents must rank all options. This is the default option.

 For the question containing one topic, only "Any number of topics" and "All Topics" options are 
available.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears. The following visibility options are available:
• Shown – The survey question is shown.
• Hidden – The survey question is hidden.
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• Conditional – The question is shown or hidden according to the certain conditions.
If the question is "Conditionally Hidden," no validation is performed on it. Thus if you activate the 
"Destination" and "Answer Required" options for the "Conditionally Hidden" question, they will be 
skipped in the published survey.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode. Starting with the 
EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the future EFM 
releases, Classic survey rendering will not be supported.

Destination
Select an option from the "Destination" drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.
The available options are "Not Set," "End," custom end pages, and all questions that follow the current 
question. "Not Set" is a default value.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.
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Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Rank Order Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Question Options panel > Rank Order question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Rank Order question. With the question properties, you can control how your 
question looks in the survey and set specific conditions and limitations for your question.

Layout
Format your Rank Order question by selecting the following layout options:
• Radio Buttons

 The Radio Buttons layout is selected by default.

• Drop-down Box
The "Drop-down Box" option includes the Caption drop-down list where you can specify the default text 
that the respondent will see in the drop-down list, such as "None," "Click here to choose," or "Click here for 
choices."

Options
Use the following options to customize your Rank Order question appearance:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
• Randomize Topics – Select to show question responses in a random order when the survey is 

viewed or page is refreshed.
• Answer Required – Select to require respondents to answer the question before moving to the 

next page or submitting the survey.
• Respondent Must Rank – Select an option from this drop-down list to require respondents to 

rank all, top, minimum, or any number of responses. "All Topics" is a default value.  The following 
options are available:
• Any number of topics – The respondents can rank any number of topics.
• At Least # Topic(s) – The respondents must rank at least # topics.
• At Most # Topic(s) – The respondents must rank no more than # topics.
• Top # Topic(s) – The respondents must rank top # topics.
• All Topics – The respondents must rank all options. This is the default option.

 For the question containing one topic, only "Any number of topics" and "All Topics" options are 
available.
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Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 For the question containing one topic, only "Any number of topics" and "All Topics" options are 
available.

 

 The Instructions option is available only in Modern survey rendering mode. Starting with the 
EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the future EFM 
releases, Classic survey rendering will not be supported.

Destination
Select an option from the Destination drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," and all questions that follow the current question. "Not Set" is 
a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.
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 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Choose One with Image Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Question Options panel > Choose One with Image 
question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Choose One with Image question. With the question properties, you can control 
how your question looks in the survey and set specific conditions and limitations for your question.

Layout
In Classic survey rendering mode, format your Choose One with Image question by selecting the 
following layout options:
• List – Choices are listed one below the other.
• Columns – From the drop-down list, select the number of columns that appear in your question.

 The Columns option with three columns is selected by default.
 

In Modern survey rendering mode, format your Choose One with Image question by selecting the 
following layout options:
• Small Images
• Large Images

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Options
Use the following options to customize your Choose One with Image question appearance:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
• Randomize Choices – Select to show question responses in a random order when the survey is 

viewed or page is refreshed.
• Reverse Order of Choices – Select to show question choices in an opposite order when the 

survey is viewed or page is refreshed.
• Answer Required – Select to require respondents to answer the question before moving to the 

next page or submitting the survey.
• Answer Required for "Please Specify" Boxes – Select to require respondents to enter 

information in the specified fields before moving to the next page or submitting the survey. This 
property is only visible if you add the "Please Specify" option to a response.



Designing Your Survey Overview Choose One with Image Question Properties

EFM User Guide 309

Confidential and Proprietary Information of Verint Systems Inc.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode.
 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Preselected
Select an option from this drop-down list to specify the answer that will be selected for your question by 
default. The available options are None and all question choices. None is a default value.

 In Modern survey rendering mode, if the question choice is conditionally preselected, the 
Conditionally Determined option appears in the Preselected drop-down list. For more 
information, see Define response conditional preselection criteria, page 338.

Destination
Select an option from the "Destination" drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," and all questions that follow the current question. "Not Set" is 
a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.



Designing Your Survey Overview Choose One with Image Question Properties

EFM User Guide 310

Confidential and Proprietary Information of Verint Systems Inc.

You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Choose Many with Image Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Question Options panel > Choose Many with Image 
question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Choose Many with Image question. With the question properties, you can control 
your questions look in the survey and set specific limitations and conditions for your question.

 Click the question text field to view the Question Options panel that provides available options 
for your question.

The Question Options panel is divided into the "Layout," "Options," and "Visibility" sections, which 
include a number of appearance, validation and logic properties for the Choose Many with Image 
question.

Layout
In Classic survey rendering mode, format your Choose Many with Image question by selecting the 
following layout options:
• List - Choices are listed one below the other.
• Columns - From the drop-down list, select the number of columns that appear in your question.

 The Columns option with three columns is selected by default.

In Modern survey rendering mode, format your Choose Many with Image question by selecting the 
following layout options:
• Small Images
• Large Images

 The Small Images option is selected by default.

 

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Options
Use the following options to customize your Choose Many with Image question appearance:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
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• Randomize Choices – Select to show question choices in a random order when the survey is 
viewed or page is refreshed.

• Reverse Order of Choices – Select to show question choices in an opposite order when the 
survey is viewed or page is refreshed.

• Answer Required – Select to require respondents to answer the question before moving to the 
next page or submitting the survey.

• Answer Required for "Please Specify" Boxes – Select to require respondents to enter 
information in the specified fields before moving to the next page or submitting the survey. This 
property is only visible if you add the "Please Specify" option to a response.

• Respondent Must Pick – Select an option from the drop-down list to require respondents to 
provide a minimum, maximum, or exact number of responses. "No Response Required" is the 
default option.

 If you select the "Answer Required" check box, the default value for "Respondent Must Pick" is "At 
least 1 Choice."

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears. The following visibility options are available:
• Shown – The survey question is shown.
• Hidden – The survey question is hidden.
• Conditional – The question is shown or hidden according to the certain conditions.
If the question is "Conditionally Hidden," no validation is performed. Thus if you activate the 
"Destination" and "Answer Required" options for the "Conditionally Hidden" question, they will be 
skipped in the published survey.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode. Starting with the 
EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the future EFM 
releases, Classic survey rendering will not be supported.

Least Filled Choices
Select the number of choices with the lowest response rate from the Least Filled Choices drop-down 
list to allow autoselection of those choices if the respondent did not choose any.
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 The Least Filled Choices option is only available for the Modern survey rendering. Starting 
with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the 
future EFM releases, Classic survey rendering will not be supported.

When the respondent starts a survey, choice ranks are determined for any Choose Many questions, 
which use the autoselection option. Each choice is assigned a unique rank based on the number of 
respondents, who selected that choice. If one or more choices have the same count, a rank is assigned at 
random. These ranks are stored in session and used for autoselection.

 If the respondent selects a choice for the question, nothing is autoselected regardless of the 
Least Filled Choices setting.

Autoselection works for the choices and pages, which are visible or conditionally visible (if the visibility 
criteria are met) for the respondent and all questions regardless of their visibility. Choices marked as 
Exclusive do not support autoselection.

 If the Answer Required option is selected, the Least Filled Choices option is disabled.

Destination
Select an option from the "Destination" drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," custom end pages, and all questions that follow the current 
question. "Not Set" is a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.
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Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.



Designing Your Survey Overview Matrix Question Properties

EFM User Guide 315

Confidential and Proprietary Information of Verint Systems Inc.

Matrix Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu  > Matrix question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Matrix question. With the question properties, you can control how your question 
looks in the survey and set specific limitations and conditions for your question.

 Click the question text field to view the Question Options panel that provides available options 
for your question.

Options
Use the following options to customize your Matrix question appearance:
• Show Question Heading – Select to show the question heading to the respondents. By default, 

the question heading is hidden, and only the question text appears in the survey.
• Randomize Table Rows – Select to show table rows of a question in a random order every time 

the survey is viewed or page is refreshed. The Matrix question with randomized table rows is 
marked accordingly.

 If you randomize table rows, the "Repeat headings every __ Row(s)" option for Matrix is not 
available.

• Indicate Odd and Even Rows – Select to show a different background color for even and odd 
table rows. The color depends on the survey theme selected for your survey on the Formatting 
tab. Click the Preview button on the survey designer toolbar to view the currently applied theme. 
For information on applying survey themes, see Survey Formatting Tab, page 409.

• Repeat headings every __ Row(s) – Select to show the headings (columns) again after every 
specified number of rows. It is useful for the Matrix questions with a large amount of rows 
because headings may not be visible on the screen when survey participants respond to the later 
question options.

 If you randomize table rows, set a number of visible topics, or pipe in values, the "Repeat 
headings every __ Row(s)" option for Matrix is not available.

• Answer Required – Select to require respondents to answer the question before moving to the 
next page or submitting the survey.

Validate the Matrix question topic as a real or whole number under Input Type to use the Display Spin 

Buttons feature. When the Display Spin Buttons check box is selected, the spin buttons  appear 
in the text box. By default, this check box is not selected.
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 For older questionnaires with the Matrix question, the Display Spin Buttons option is selected 
by default.

 The Display Spin Buttons option is available only in the Modern survey rendering mode.

If you select the Display as Slider check box for the Matrix question topic, the Display Spin Buttons 
option is unavailable.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.
The following visibility options are available:
• Shown – The survey question is shown.
• Hidden – The survey question is hidden.
• Conditional – The question is shown or hidden according to the certain conditions.
If the question is "Conditionally Hidden," no validation is performed on it. Thus if you activate the 
"Destination" and "Answer Required" options for the "Conditionally Hidden" question, they will be 
skipped in the published survey.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode.
 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Number of Rows Visible
Select an option from the "Number of Topics Visible" drop-down list to specify how many of the first 
available topics (rows) in the question your participants will see when taking your survey. The provided 
options are "All" and number of rows available for the current question. Click the Test button on the 
survey designer toolbar to view your selection.
You can also insert values from other questions or profiles by clicking the "Insert Piped Data" icon next to 
the drop-down list. For more information on piping data, see Piping Responses, page 541.

 If you set a number of visible topics or pipe in values, the "Repeat headings every __ Row(s)" 
option for Matrix is not available.
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Destination
Select an option from the "Destination" drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," and all questions that follow the current question. "Not Set" is 
a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Matrix Columns Randomization and Fixing
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Matrix question.

You can randomize columns in a Matrix question to minimize answer bias from respondents. You can 
randomize columns of the Choose One and Choose Many matrix sides. The columns are randomized at 
the side level, so one survey can contain both randomized and not randomized sides. Select the 
Randomize Choices check box on the Matrix Side Options panel to activate this option. The columns 
randomization is not active by default.
When the columns randomization is activated, the corresponding notification appears in the survey 
designer for you. Survey participants do not see this notification when they take a survey.

 The matrix columns randomization does not affect the ability to pipe columns from previous 
questions.

Additionally, you can fix position of one or more columns so that they do not change their position in a 
matrix when other columns are randomized. When you select the Randomize Choices check box, the 
Fixed Position check box appears on the Column Options panel. You can fix position of any matrix 
column by selecting the Fixed Position check box for it.
Fixed columns appear at the end (far right) of the side or beginning (far left) of the side so that both right-
to-left and left-to-right languages are accommodated. If multiple criteria are fixed, they are contiguous at 
the beginning or end of the side.

Activate the matrix columns randomization

Procedure 
1 Go to the Design tab.
2 Add a Matrix question to your survey.
3 Click the "Click to edit category text" text. The Matrix Side Options panel appears to the left of your 

question.
4 Select the Randomize Choices check box.

Fix the column position in a matrix question

Procedure 
1 Go to the Design tab.
2 Add a Matrix question to your survey.
3 Click the "Click to edit category text" text. The Matrix Side Options panel appears to the left of your 

question.
4 Select the Randomize Choices check box.
5 Click the "Column Text" text for the column you want to fix. The Column Options panel appears to 

the left of your question.
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6 Select the Fixed Position check box.
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Scrolling Matrix Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Scrolling Matrix question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Scrolling Matrix question. With the question properties, you can control how your 
question looks in the survey and set specific conditions and limitations for your question.

Layout
The "Columns" option includes a drop-down list where you can specify the number of columns that 
displays in your question.

Options
Use the following options to customize your Scrolling Matrix question appearance:
• Show Question Heading – Select to show the question heading. By default, the question 

heading is hidden, and only the question text appears in the survey.
• Randomize Topics – Select to show question responses in a random order when the survey is 

viewed or page is refreshed.
• Randomize Choices – Select to show question choices in a random order when the survey is 

viewed or page is refreshed.
• Reverse Order of Choices – Select to show question choices in an opposite order when the 

survey is viewed or page is refreshed.
• Answer Required – Select to require respondents to answer the question before moving to the 

next page or submitting the survey.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.
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 The Instructions option is available only in Modern survey rendering mode. 
 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Destination
Select an option from the Destination drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," and all questions that follow the current question. "Not Set" is 
a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">. You can enter a sequence of classes, separating each of 
them with a space. When applied to the generated HTML, any classes that do not match the -?[_a-zA-Z]+[_
a-zA-z0-9-]* regular expressions are not shown. For example, if you type survey 123456, the numeric 
class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question.
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Scale Slider Question Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Scale Slider question.

On the Design tab, you can access the properties for your survey questions. The question properties 
vary depending on the question type you select. This topic provides an overview of all question level 
properties for the Scale Slider question. With the question properties, you can control how your 
questions look in the survey and set specific limitations and conditions for your question.

 Click the question text field to view the Question Options panel that provides available options 
for your question.

Layout
Use the following options to customize your Scale Slider question layout:
• Slider – Each topic is displayed as an individual slider with the same choices across all topics. All 

choices appear across the bottom of the scale with a tick mark representing where the answer is 
registered. If you drag the slider to a point between the ticks, the slider moves to the nearest 
option. The selected choice is displayed in bold and indicates your answer.

• Star – Each topic is displayed as an individual star with the same choices across all topics. The 
respondents can rank variables by using the star rating displayed to the right of each topic. The 
number of stars matches the number of question choices, for example, if there are 5 choices in 
the question, you can rate each choice from 1 to 5 stars. When you hover over the star, the 
current star and all preceding stars appear in yellow, and the current choice text is displayed in a 
tooltip. 
Respondents can answer the question by clicking the star under the selected position. The selected 
star and all preceding stars appear in green. Respondents can clear their selection by clicking the red 
round icon. You can remove this icon from the question by selecting the Hide Clear Star Selection 
Option check box in the Options section.

 The Hide Clear Star Selection Option check box is available only when the “Star" layout option 
is selected.

If the respondent has JavaScript disabled, the "Star" layout is changed to the "Scale" layout for the 
question.
You can add one or multiple coded values (Not Applicable, Don’t Know, and Refused) to a question 
with star and slider layout. To add a coded value, select it from the Coded Value drop-down list on 
the Choice Options panel. Adding a coded value to a question excludes it from the Coded Value  list 
for the current question.

 You can only add coded values starting from the end of the choice list.
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As a result, coded value check boxes appear to the right of a star group or slider. If you set a coded 
value to Not Applicable, Don’t Know, or Refused, be sure to set an appropriate label on a choice to 
convey that meaning.
Selecting a coded value check box clears the previously selected star rating or slider choice. Selecting a 
star or slider choice clears the coded value check box. Only one check box can be selected at a time.

 The coded values are not counted as valid responses in Response Manager and when 
generating reports.

• Slider Width (in pixels) – Specify the width of the slider in pixels.

 For the "Star" layout option, the "Slider Width (in pixels)" option is not available. Also it is not 
available in Modern survey rendering mode.

Options
Use the following options to customize your Scale Slider question appearance:
• Show Question Heading – Select to show the question heading to the respondents. By default, 

the question heading is hidden, and only the question text appears in the survey.
• Randomize Sliders – Select to show your question responses in a random order when the 

survey is viewed or page is refreshed. Your question with randomized sliders is marked 
accordingly in a survey designer.

• Reverse Order of Choices – Select to show your question choices in an opposite order when 
the survey is viewed or page is refreshed.

 For the "Star" layout option, the "Reverse Order of Choices" option is not available.

• Answer Required – Select to require respondents to answer your question before moving to the 
next page or submitting the survey.

• Hide Clear Star Selection Option – Select to hide the Clear Star Selection option from the 
participants.

• Show Clear Star Selection on Right – Select to display the Clear Star Selection option to the 
right of the stars.

• Display Rating – Select to display rating to the right of the stars.

 For the “Slider” layout option, the "Hide Clear Star Selection Option," "Show Clear Star Selection 
on Right," and “Display Rating” options are not available.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, click Conditional, and then 
click the Criteria link that appears. The following visibility options are available:
• Shown – The survey question is shown.
• Hidden – The survey question is hidden.



Designing Your Survey Overview Scale Slider Question Properties

EFM User Guide 324

Confidential and Proprietary Information of Verint Systems Inc.

• Conditional – The question is shown or hidden according to the certain conditions.
If the question is "Conditionally Hidden," no validation is performed. Thus if you activate the 
"Destination" and "Answer Required" options for the "Conditionally Hidden" question, they will be 
skipped in the published survey.

Instructions
If you want to provide additional instructions to your question, type short text in the Instructions text 
box. The instructions text appears right under the question text in a survey. You can preview it by clicking 
the Preview button on the survey designer.

 The Instructions option is available only in Modern survey rendering mode. Starting with the 
EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the future EFM 
releases, Classic survey rendering will not be supported.

Preselected
Select an option from the "Preselected" drop-down list to specify the answer that will be selected for your 
question by default. The available options are "None" and all question choices. "None" is a default value.

Number of Topics Visible
Select an option from the "Number of Sliders Visible" drop-down list to specify how many of the first 
available topics in the question your participants will see when taking your survey. The provided options 
are "All" and number of topics available for the current question. Click the Test button on the survey 
designer toolbar to view your selection.
You can also insert values from other questions or profiles by clicking the "Insert Piped Data" icon next to 
the drop-down list. For more information on piping data, see Piping Responses, page 541.

Destination
Select an option from the Destination drop-down list to specify what respondents will see after they 
answer the question and move to the next page. To move to the next page, insert a page break between 
the original and destination questions.

 The "Destination" functionality requires that the original and target questions are separated by 
page break.

The available options are "Not Set," "End," custom end pages, and all questions that follow the current 
question. "Not Set" is a default value.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information on end pages, see End Pages Pagination Panel, page 396.
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Additional CSS Keywords
If you want to change the question styling of your survey, add a custom CSS class to a question's 
wrapping container. Any text that you type into this text box appears in the containing div for that 
question at the end of the system generated classes. For example, <div id="Q5_WRAPPER" 
class="question essay customclassgoeshere">. You can enter a sequence of classes, separating each of 
them with a space. When applied to the generated HTML, any classes that do not match the -?[_a-zA-Z]+[_
a-zA-z0-9-]* regular expressions are not shown. For example, if you type survey 123456, the numeric 
class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric numbers, whereas the regular 
expression [_a-zA-Z] matches the alphabetic characters.

Custom Properties
Click the Custom Properties link to create additional question properties, which are used by your Web 
Service client. You can add a set of name and value pairs for your question
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Image Upload question properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design view > Content tab > Add menu > Image Upload question.

Setting the Image Upload question properties helps you to control the question appearance and specify 
certain conditions and limitations for your question.

 The ImageUpload question is available only in Modern survey rendering mode. Starting with 
the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the future 
EFM releases, Classic survey rendering will not be supported.

Options
Use the following options to customize your Image Upload question:
• Show Question Heading – Select to show question heading. By default, question heading is 

hidden and only question text appears in the survey.
• Answer Required – Select to require respondents to answer the question before moving to the 

next page or submitting the survey.
• Allow Photo Tagging – Select to allow respondents to add, edit, or remove the image tags. 

Respondents can add a tag by clicking Add Tag or by clicking anywhere in the uploaded image.

 Respondents can add, edit, and delete tags only if the survey is opened and if the JavaScript 
Required check box is selected in the Properties side tab of the Design tab.

• Allow Location Collection – Select to collect the image geolocation data (the latitude and 
longitude that the image was taken at) if available and turned on a device.

Visibility
Select whether to show or hide your question in a published survey. The hidden question is only visible to 
you and is marked accordingly. To set conditions for the question's visibility, on the Question Options 
side tab, select Conditional, and then click the Criteria link that appears to edit the Question Visibility 
details.

Instructions
If you want to provide additional instructions to your question, type the text you want to add in the 
Instructions text box on the Question Options side tab. The instructions text appears right under the 
question text in a survey. You can preview it by clicking the Preview button on the survey designer.
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Destination
If you want to specify what respondents will see after they answer the question and move to the next 
page, select the needed option from the Destination drop-down list on the Question Options side tab. 
To move to the next page, insert a page break between the original and destination questions.

 The Destination functionality requires that the source and target questions are separated by a 
page break.

The available options are Not Set (default value), End, and all questions that follow the current question.
You can set the destination to any custom end page by selecting the custom page from the drop-down 
list. For more information about end pages, see End Pages Pagination Panel, page 396.

Additional CSS Keywords
If you want to change the question style of your survey, on the Question Options side tab, add a 
custom CSS class to a question’s wrapping container. Any text that you type into this wrapping container 
appears in the containing div for that question at the end of the system generated classes. For example, 
<div id=“Q5_WRAPPER” class=”question poem customclassgoeshere”>.
You can enter a sequence of classes, separating each of them with a space. When applied to the 
generated HTML, any classes that do not match the -?[_a-zA-Z]+[_a-zA-z0-9-]* regular expressions are not 
shown. For example, if you type survey 123456, the numeric class is not shown.

 The regular expression [_a-zA-z0-9-] matches the alphanumeric characters, whereas the regular 
expression [_a-zA-Z] matches the alphabetical characters.

Custom Properties
If you want to create additional question properties used by your Web Service client, click the Custom 
Properties link on the Question Options side tab. You can add a set of name and value pairs for your 
question.

 If the browser has JavaScript disabled, and you cleared the JavaScript Required check box in the 
Properties response of the Design tab, the respondent will be able to answer the Image 
Upload question. The response image will not be displayed. To change the response image, the 
respondent needs to click the image name, and then upload a new image.
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Choice groups
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
Design view > Content tab.

You can use choice groups for the Choose One, Choose Many, and Matrix (Choose One and Choose 
Many sides) questions to divide a long series of choices into descriptive groups. Thus you can organize 
responses to make them easier for respondents to understand.
For the Choose One question, choice groups are supported for the following layouts: List, Scale, Table 
Row, List Box, and Drop-down Box. For the Choose Many question, choice groups are supported for 
the following layouts: List, Scale, and Table Row.

 You cannot combine choices with coded values into choice groups.

Add the Choice Groups

Procedure 
1 On the Content tab of the Design view, add a "Choose One" question, for example. The drop-down 

menu icon  appears next to each response within this question.
2 Click the drop-down menu icon next to any of the responses within the question.
3 On the drop-down menu, click Edit Together. The Edit Together dialog box opens.

 You can create choice groups in the Edit Together view only.

4 To add a choice group to a question, enter a "@" sign followed by a space, and then add the text on 
separate lines.
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The choice group in the Designer mode

5 Click Save. 
6 To randomize the choices within the choice groups, on the Question Options panel, select the 

Randomize Choices check box to minimize answer bias from your respondents. The order of choice 
groups is not changed. Randomization is not available for the Scale, Table Row, and Star Rating 
layout options.

 For the Matrix questions, randomization of choice groups is only available in the Modern survey 
rendering.
Starting with the EFM 15.1 FP3 release, the Classic survey rendering is unavailable for new 
workgroups. In the future EFM releases, Classic survey rendering will not be supported.

7 Click the Preview button on the survey designer toolbar to view your question with the applied 
choice groups.

The choice group preview
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Response options
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Add menu > click the question you want to add to the survey > click the 
response within the question > Response Options panel. 
Choice level properties may vary depending on the question type, including the Choose One, Choose 
Many, Fill in the Blank, Matrix, Scrolling Matrix, and Scale Slider.

Choose One and Choose One with Image
• Include "Please Specify" Option – Select the check box so that the respondents can provide 

their own answers.
• Visibility – Define whether the selected response will be shown, hidden, or conditional. The 

choice visibility status appears above the question.
• Preselection – Specify the answer to be selected for your question by default.

The following options are available:
• Unselected
• Selected
• Conditional

• Hint  - Specify the ghost text for the response.  The default text is Please specify.

 This feature is available only when the Include "Please Specify" Option check box is selected.

• Destination – Specify the page and the question to which the respondents will be redirected 
after they select a particular choice/response, and then click Next. The destination status appears 
below the choices.

 You can set destination to any custom end page by selecting the custom page on themenu. For 
more information, see End Pages Pagination Panel, page 396.

• Coded Value – Assign a database code for the response so that this response is ignored for the 
reporting purposes.

 This option is only available for the last question choice and is used for questions with the Other 
or Not Applicable choices.

This option allows a response option to be coded as one of the following items:
• Not Applicable
• Don't Know
• Refused
When coded, the response will be stored in the database as -1 for Not Applicable, -2 for Don't 
Know, and -3 for Refused. The application will disregard this data during the calculation of means 
and other summary statistics within the reporting and analysis modules.
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 If the Randomize Choices or Reverse Order of Choices options are applied to the question, 
the choices with coded values always remain in fixed position at the end of the choice list. This is 
also applicable if choice groups are used in the question

• Report Value – Specify answers to designate the specific types of common answers that will be 
stored in the database with special values. With this option, you can assign a value of positive 
numbers only.

 The report values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the report value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

• Export Value – Define special values to be used for exports (TSV, CSV, SPSS and XLSX). You can 
select to view the export values in the Response Manager grid by clicking the View Data Type 
option on the Actions menu. If export value is not specified for the choice, the default choice 
number is used as an export value.

 The export values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the export value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

The following order of priority determines what value is displayed to the left of the choice in the 
survey designer:
a. Export Value (if set)
b. Report Value (if set)
c. Choice Index

• For example, if both export and report values are set for the choice, the export value is displayed.

Choose Many and Choose Many with Image
• Include "Please Specify" Option – Select the check box so that the respondents can provide 

their own answers.
• Visibility – Define whether the selected response will be shown, hidden, or conditional. The 

choice visibility status appears above the question.
• Preselection – Specify the answer to be selected for your question by default.

The following options are available:
• Unselected
• Selected
• Conditional

• Exclusive – Deselect other choices when this choice is selected.
• Destination – Specify the page and the question to which the respondents will be redirected 

after they select a particular choice/response, and then click Next. The destination status appears 
below the choices.
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• Export Value – Define the values that you choose to be displayed in the Response Manager 
grid. For example, if you want to display negative numbers in the Response Manager grid and in 
the response exports, specify this option in the survey designer. When it is not specified, the 
default choice numbers appear in the Response Manager grid as the export values.

 The export values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the export value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

Matrix

Row options

Visibility – Define whether the selected response will be shown, hidden, or conditional. The choice 
visibility status appears above the question.

Column options
•  Visibility – Define whether the selected column will be shown, hidden, or conditional. The 

visibility status of a choice appears above the question.

 The Visibility option is available only for the Matrix with Choose One and Choose Many 
sides. If the Matrix with Choose One or Choose Many side uses Pipe in Columns, the Visibility 
option is unavailable.

• Preselection – Specify the answer to be selected for the question by default.
The following options are available:
• Unselected
• Selected
• Conditional

• Coded Value – Define the applicable coded value options. Adding a coded value to a choice 
excludes it from the Coded Value  menu for the previous choice. Coded value option is available 
only for the Choose One sides.

 If the Randomize Choices or Reverse Order of Choices options are applied to the question, 
the choices with coded values always remain in fixed position at the end of the choice list. This is 
also applicable if choice groups are used in the question.

• Report Value – Specify answers to designate the specific types of common answers that will be 
stored in the database with the special values. With this option, you can assign a value of positive 
numbers only.

 The report values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the report value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.
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• Export Value – Define the values that you choose to display in the Response Manager grid. For 
example, if you want to display negative numbers in the Response Manager grid and in the 
response exports, specify this option in the survey designer. When it is not specified, the default 
choice numbers appear in the  Response Manager grid as the export values.

 The export values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the export value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

The following order of priority determines what value is displayed to the left of the choice:
a. Export Value (if set)
b. Report Value (if set)
c. Choice Index
For example, if both export and report values are set to the choice, the export value will be displayed.

Scrolling Matrix

Topic options
• Visibility – Define whether the selected response will be shown, hidden, or conditional. The 

choice status of a choice appears above the question.

Choice Options
• Visibility – Define whether the selected response will be shown, hidden, or conditional. The 

choice status of a choice appears above the question. 
• Coded Value – Define the applicable coded value options. Adding a coded value to a choice 

excludes it from the Coded Value menu for the previous choice.

 If the Randomize Choices or Reverse Order of Choices options are applied to the question, 
the choices with coded values always remain in fixed position at the end of the choice list.

• Report Value – Specify the answers to designate the specific types of common answers that will 
be stored in the database with special values. With this option, you can assign a value of positive 
numbers only.

 The report values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the report value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

• Export Value – Define the values that you choose to display in the Response Manager grid. For 
example, if you want to display negative numbers in the Response Manager grid and in the 
response exports, specify this option in the survey designer. When it is not specified, the default 
choice numbers appear in the Response Manager grid as the export values. 
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 The export values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the export value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

• The following order of priority determines what value is displayed to the left of the choice:
a. Export Value (if set)
b. Report Value (if set)
c. Choice Index
For example, if both export and report values are set to the choice, the export value will be displayed.

Scale Slider

Topic options
• Visibility – Define whether the selected response will be shown, hidden, or conditional. The 

visibility status of a choice appears above the question.

Choice options
• Visibility – Define whether the selected response will be shown, hidden, or conditional. The 

visibility status of a choice appears above the question.
• Preselection – Click the option to specify the answer to be selected for your question by default.

The following options are available:
• Unselected
• Selected
• Conditional

• Coded Value – Define the applicable coded value options. Adding a coded value to a choice 
excludes it from the Coded Value menu for the previous choice.

 If the Randomize Choices or Reverse Order of Choices options are applied to the question, 
the choices with coded values always remain in fixed position at the end of the choice list.

• Report Value – Specify the answers to designate the specific types of common answers that will 
be stored in the database with special values. With this option, you can assign a value of positive 
numbers only.

 The report values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the report value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

• Export Value – Define the values that you choose to display in the Response Manager grid. For 
example, if you want to display negative numbers in the Response Manager grid and in the 
response exports, specify this option in the survey designer. When it is not specified, the default 
choice numbers appear in the Response Manager grid as the export values.
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 The export values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the export value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

The following order of priority determines what value is displayed to the left of the choice:
a. Export Value (if set)
b. Report Value (if set)
c. Choice Index
For example, if both export and report values are set to the choice, the export value will be displayed.

Rank Order

Choice Options
• Report Value – Specify the answers to designate the specific types of common answers that will 

be stored in the database with special values. With this option, you can assign a value of positive 
numbers only.

 The report values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the report value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

• Export Value – Define the values that you choose to display in the Response Manager grid. 
For example, if you want to display negative numbers in the Response Manager grid and in the 
response exports, specify this option in the survey designer. When it is not specified, the default 
choice numbers appear in the Response Manager grid as the export values.

 The export values are also visible in the survey designer and criteria designer for branching, 
triggers, quota, and conditional visibility for choices, questions, and pages. When the export value 
is set for a choice, it is displayed instead of the choice index in the survey designer and is used as 
an identifier for the choice.

The following order of priority determines what value is displayed to the left of the choice:
a. Export Value (if set)
b. Report Value (if set)
c. Choice Index
For example, if both export and report values are set to the choice, the export value will be displayed.

Fill in the Blank
You can require users to enter the specific type of data into topic text boxes. On the Input Type menu, 
select the type of data that you want the participants to enter into a particular topic text field. You can 
also require survey participants to provide a response to a selected topic text box in the Fill in the Blank 
question.
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• Answer Required – Set the requirement for the respondents to answer an individual choice 
before they can move to the next page.

• Display as Slider – Display topic as a slider, when the Numbers input type is selected. 

 The option is available for the Numbers input type.

A text box appears containing the numerical value that the current position of the slider represents. A 
minimum and maximum values must be assigned to represent the range for the slider. The Slider 
Step defines the numerical value that is used to separate each position on the slider.

• Display as Calendar Pop-up – Display the calendar pop-up window for the Dates input type.
• Caption – Define the default text that the respondents see in the drop-down list when nothing is 

currently selected. 

 The option is available for the AutoDropdowns input type.

• Preselected – Display the choice that is selected by default but still can be modified.
• Alignment – Select the option to align characters in the text box to the left, center, or right.
• Symbol – Select a symbol to display to the right of the text box. The following options are 

available: %, $, and EA.
• Insert symbol to the left of the box – Display the symbol selected on the Symbol menu to 

the left of the text box. By default, this option is inactive.
• Text Area Width – Set the width of the Text Area by moving a slider. You can set the width 

value to the Smallest, Small, Medium, Wide, or Widest.

 The layout option is available only in the Modern survey rendering mode. For more information, 
see Text Box Width and Text Area Width, page 343.

• Minimum Value – Set the respondent's answer to be equal or exceed the value that you enter.
• Maximum Value – Set the respondent's answer not exceed the value that you enter.
• Valid Characters – Limit the acceptable characters that can be entered for the question.
• Text Box Width (in characters) – Set the width of each text box in characters.

 The layout option is available only in the Classic survey rendering mode. For more information, 
see Text Box Width and Text Area Width, page 343.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

• Text Mask – Define the format for the text entry. Enter 9 for numbers, X for letters, and ? for 
any character.

• Validate Topics – Select whether all or only specific entries are allowed. 
The following options are available:
• All Entries are allowed – When you select this option, all entries are valid.
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• Entries must follow this rule – When you select this option, the expression drop-down list and 
the text box to the right are activated. You can specify the validation rule to follow. The available 
expressions depend on what Input Type is associated with the topic.

You can also pipe the profile data into the survey by clicking the  icon. In the Insert Piped Value dialog 
box, all information that can be piped into the survey is displayed. The information includes all profiles 
created inside the current workgroup. For more information, see Insert profile questions or data, 
page 1248.
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Define response conditional preselection criteria
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > click the response within your question > Response Options panel > 
Preselection section > Conditional option > Criteria link > Response Preselection dialog box.
You can set criteria for question choices and matrix rows.
If a respondent's answer matches the specified criteria, the question choice on the next page is already 
preselected.
In the Modern survey rendering mode, in the conditional visibility criteria designer, you can set a 
response count criterion with the values from 0 to the specific number of choices or columns in the 
Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling Matrix questions.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

You can set the criterion to conditionally preselect choices based on the count of responses provided by 
the respondent. For example, if you want the choice to be preselected and in the response preselection 
criteria designer you specify that the response count criterion equals 2, the choice is conditionally 
preselected, if the respondent's answers match the specified  criterion.

 Preselected option on choice level  is available only in the Modern survey rendering mode and is 
supported by the Choose One, Choose Onewith Image, Choose Many, Choose Manywith 
Image, Matrix (with Choose One and Choose Many sides), and Scale Slider questions.

 

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 On the Analyze tab, click the question choice.
4 On the Response Options panel, in the Preselection section, click the Conditional option.
5 Click the Criteria link that appears next to the Conditional option.
6 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select to apply response preselection based on the survey questions 
or device type.

a. In the first drop-down list, select one of the following options to apply the logic to:
- The survey question
- The response count criterion with the values from 0 to the specific number of choices or 

columns in Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling 
Matrix questions

- The device type criterion
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 The device type and the response count criteria can be combined with other criteria for 
branching.

b. In the second drop-down list, select the expression.
c. In the third drop-down list, select one of the following:

- Question choice
- Number of responses provided by the respondent
- Detected type of device

 The values list includes the actual response options for the question. The choices are numbered 
in the same way as the survey designer. For the Fill in the Blank, Short Answer, Essay, Matrix 
with Short Answer or Essay sides questions, enter the expected response or leave the text box 
empty.

• Participant Information – Select to apply response preselection to the campaign:
a. In the first drop-down list, Campaign Name is selected.
b. In the second drop-down list, click the expression.
c. In the third drop-down list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the 
Collect tab.

• Respondent Location – Select to apply response preselection based on the location parameter:
a. In the first drop-down list, select the needed parameter.
b. In the second drop-down list, select the expression, and then enter the needed value in the 

adjacent box.

 When the report or export value is set for a choice, it is displayed instead of the choice index and 
is used as an identifier for the choice.

7 To save a single criterion, click Save.
8 To add more criteria, click Add Another Criteria, and then add several criteria.

 You can combine criteria of all types.

9 Specify which criteria need to be met by selecting the corresponding Match options:
• All criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – Create the needed logical expressions using the drop-down lists with parentheses 

and the And/Or operators next to each criterion.
10 In the Response Preselection dialog box, click OK. 
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 If more than one choice is conditionally preselected, the choice visibility icon that is showing the 
total number of the preselected choices appears above the question.
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Text Mask Validation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > add the Fill in the Blank question > click the topic within the Fill in the 
Blank question > Topic Options pane > Text Mask text box.

You can use the Text Mask functionality to validate a specific way for participants to respond the Fill in 
the Blank question. 
If you specify a text mask for your question, your survey participants are required to enter the response 
in the designated format. For example, you want your participants to answer a specific question in the 
following format: 999-999-9999. You can specify that you do not want any dashes or perhaps that you 
want parentheses.

 The Text Mask Validation is also available for the Short Answer question.

The Text Mask box with entry

Enter 9 to represent numbers, X to represent letters, and ? for any character. You can use the text mask 
for entering other types of information, like social security number or any other code, email address, etc.
If participants do not enter the information in the specified format, they receive a message that shows 
how to enter the response. In the example below, the participant entered the phone number in the 
wrong format (used parentheses), so the message appeared to show the participant the correct format to 
use for entering the phone number.

A question with text mask applied
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Once the participant enters the phone number in the correct format (999-543-1212), the survey moves 
on to the next question, or the participant can submit the survey.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 On the Analyze tab, select the Fill in the Blank question that you want to use with the Text Mask 

option.
4 To view the Topic Options panel, click the topic within the selected question.
5 In the Text Mask text box, enter the phone number format that you want your participants to use 

for phone numbers.
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Text Box Width and Text Area Width
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > add the Fill in the Blank question > click the topic within the Fill in the 
Blank question > Topic Options pane > Text Box Width text box or Text Area Width slider.

You can set the width of each individual field of the Fill in the Blank question by using the Text Box 
Width box or Text Area Width slider on the Topic Options panel.

 The Text Box Width is also available for the Short Answer and Essay questions.

Text Area Width
You can set the text area for the Fill in the Blank question width by moving a slider.
Each of the Text Area Width values in the Modern survey rendering mode corresponds to a certain 
character width property in the Classic rendering:
• Smallest – 5
• Small – 10
• Medium – 20
• Wide – 40
• Widest – 80

Text Box Width (in pixels)
You can limit maximum text area width for the Fill in the Blank, Short Answer, and Essay questions 
by specifying the needed value (from 66 to 2000 pixels) in the Text Box Width (in pixels) text box. The 
width of this text box will meet this maximum value if space allows, but will shrink down to fit smaller 
screen resolutions.
For the Fill in the Blank question, this value cannot exceed but can be smaller than the Widest Text 
Area Width value.

Text Box Width (in characters)
You can specify the following values for the Fill in the Blank, Short Answer, and Essay text box width 
(in characters):
• Maximum – 255
• Minimum – 0
• Default – 40
 

For the Short Answer side of the Matrix question, you can specify the width of the whole side only, 
which is applied to all text boxes. Additionally, you can adjust the text box width for the Short Answer 
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side of the Matrix question by using the Text Box Width (in characters)text box on the Matrix Side 
Options panel.

 The Text Area Width,Text Box Width (in pixels), and Text Box Width (in characters) 
layout options are available only in the Classic survey rendering mode.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.
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Define conditional visibility for topics
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab >  add the Scrolling Matrix question > click the topic within the  Scrolling 
Matrix question > Topic Options panel.
You can use the Conditional Visibility functionality to customize the survey by hiding some topics based on 
the respondent's answer to the previous questions in the survey.
You can hide topics of the following matrix question types:
• Matrix
• Scale Slider
• Scrolling Matrix
You can hide individual topics based on one or several conditions. Conditional logic is used to hide topics 
depending on how a respondent answers the previous question in the survey. A page break is required 
between the two questions to implement this logic.

 It is recommended to set minimum validation on the dependent questions.

You can fully or conditionally hide a topic by using the Visibility property, which is available at the topic 
level of a question.
To set conditions for the topic's visibility, click the Conditional option, and then click the Criteria link. 
You can specify the test question, expression, value, and operator if you have multiple criteria.
In the Choice Visibility dialog box, the following options are available:
• When the following criteria are met – Select either to show or hide the choice based on the 

visibility criteria by clicking the drop-down list.
• Question – Specify the question to be checked for logic by selecting it in the drop-down list.
• Expression – Select the expression in the drop-down list. 
• Choice – Select the response option in the drop-down list. The list includes the actual response 

options for the selected question.
To save a single criteria, click the Save link. To add more items, click the Add Another Criteria link.  To 
save your settings and exit the dialog box, click OK.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 On the Analyze tab, click the needed topic within the selected question.
4 On the Topic Options panel, click the Conditional option, and then click the Criteria link.
5 In the Choice Visibility dialog box, on the When the following criteria are met menu, select 

either to show or hide the choice based on the visibility criteria.
6 To add the visibility criteria, click the Add Another Criteria link. The question, expression, and choice 

drop-down lists appear.
7 In the questions drop-down list, select the survey question to which you want to apply the logic. You 

can hover over a question to view the full question in a  tooltip.
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 The criteria options are only available from previous pages. You cannot add criteria to questions 
from the current or next pages. Thus for the first survey page you cannot select any question.

8 Select the expression in the drop-down list. The available options are:
• Equal To
• Not Equal To
• Less Than
• Greater Than
• Less Than Or Equal
• Greater Than Or Equal

9 Select the choice option in the drop-down list. 

 The list includes the actual choice options for the selected question. The choices are numbered in 
the same way as in the survey designer for your convenience. You can hover over a choice to 
view a tooltip with the full question and highlighted choice in bold.

10 To save a single criterion, click the Save link.
11 To add more criteria, click the Add Another Criteria link. 

Add several criteria if needed.
12 To specify either all or any of the criteria must be met, select the corresponding radio button next to 

the Match option. 
The following options are available:
• All Criteria – All criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The drop-down lists with parentheses and the And/Or operators appear next to 

each criterion.
13 To apply the selected visibility options to other choices, click the Save and Apply to Others button. 
14 In the Apply to Others dialog box, apply the visibility logic to other choices by selecting the 

corresponding check boxes. 
The check box of the currently selected choice is inactive.

 If the choices already have criteria, the criteria will be overwritten.

15 Click Save.
16 In the Choice Visibility dialog box, click OK. The choice visibility status appears above the question 

text in the right content area.

 You can test your survey to ensure that the appropriate topics are hidden according to the 
specified criteria.

Related topics 
Matrix questions, page 254
Add conditional visibility choices rows columns, page 512
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Fix row position in Matrix question
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab >  add the Matrix question > Question Options panel. 

You can fix the position of one or more rows so that they do not change their position in a matrix when 
other rows are randomized. 
When you select the Randomize Table Rows check box, the Fixed Position check box appears on the 
Row Options panel. You can fix the position of any matrix row by selecting the Fixed Position check 
box.

The Fixed Position check box

When the survey is published, the row with the fixed position stays in the same position as in the survey 
designer.

Procedure 
1 Go to theDesign & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 On the Analyze tab, select the Matrix question.
4 On the Question Options panel, select the Randomize Table Rows check box.
5 In a Matrix question, click the row that you want to fix. 
6 On the Row Options panel, select the Fixed Position check box.

 The Fixed Position check box is available only when the Randomize Table Rows check box is 
selected.
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Activate Scrolling Matrix choices randomization
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab >  Content tab > add the Scrolling Matrix question > Question Options 
panel.

You can randomize choices of the  Scrolling Matrix question to minimize the impact of bias in respondent 
answers. 

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the  My Surveys page, create a new survey or open an existing one.
3 On the Analyze tab, add a Scrolling Matrix question.
4 On the Question Options panel, select the Randomize Choices check box.
When the choices randomization is activated, the Scrolling Matrix choices are displayed in a randomized 
order to a respondent. In addition, the notification about random choices appears in the survey designer. 
The survey participants do not see this notification when they take a survey.

 The choices randomization does not affect the functionality of piping choices from the previous 
questions.
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Managing questions by using the drop-down menu
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 

name a new survey >  Design tab > Content tab > click a question > click the  menu.

You can manage questions by using the  menu in the question heading. 
The following options are available:
• Format question and response text in expanded editor, page 370 – Edit the question text in the 

expanded editor that provides additional editing options.
• Edit report options, page 371 – Edit the report and export values for all question choices. The 

specified values are used when reporting on the question or exporting it.

 You can change the question report and export values when designing a survey or after its 
publishing.

• Checking spelling, page 373 – Check the spelling in the question text.
• Messages and Labels tab, page 418 – Edit the default messages and labels in a question. Selecting 

this option redirects you to the Labels tab (specifically to Question Labels), where you can 
change the default text for the question you need.

 This option is available for the Rank Order, Drop & Drag Rank Order, Scale Slider, and 
Scrolling Matrix questions only.

• Defining Advanced Table Properties, page 351 – Edit the advanced table properties such as layout, 
borders, and accessibility. For the Modern survey rendering mode, the borders and layout 
properties are not available.

 This option is available for the Matrix and Rank Order questions only.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the next EFM releases, the Classic survey rendering will not be supported.

•  Question Conditional Visibility, page 509 – Set the survey questions visibility to define whether 
certain questions are visible or hidden based on a set of predefined criteria.

• Copying and pasting questions, page 353 – Copy a question to paste it somewhere else within 
your survey.

• Moving questions up and down, page 354 – Change the position of a question by moving it up or 
down within your survey.

• Deleting questions, page 357 – Remove a question from your survey.
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The question drop-down menu

 The  menu is also available for other survey elements such as text blocks, code blocks, 
comments, and section headings.
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Defining Advanced Table Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new one 

with a Rank Order or Matrix question > click the  menu > click Show Advanced Table 
Properties > Advanced Table Properties dialog box.

The Advanced Table Properties option is available only for the Rank Order and Matrix  questions. 
The Advanced Table Properties dialog box contains the following sections:
• Borders
• Layout
• Accessibility

Borders section
In the Borders section, you can define the borders of your table.
• Border Rules – Customize the borders of your table by applying the following rules:

• Blank – Use the default theme-based borders with no special styling applied.
• Outline – Use outside borders only. The outside borders are visible only if their width is defined 

and equals 1 or more.
• Groups – Use outside borders and borders between groups of cells within your table.
• Rows – Use outside borders and borders between rows.
• Columns – Use outside borders and borders between columns.
• All – Use outside borders and borders between rows and columns.
• Border Width – Customize the depth of the outside border lines.

 The Border Width option is disabled, if the Border Rules option is set to Blank.

Layout section
In the Layout section, you can define the table and column width properties.
• Table Width – Specify the width of the table in pixels or specify what percentage of the window 

size the table width should equal.

 Setting a fixed table width may negatively impact the mobile experience of your survey in the 
Modern survey rendering mode.

• Table Alignment – Align the content in the table cells to the left or to the right or center it. This 
property may be overruled by the settings in the assigned theme.
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 For the Modern survey rendering mode, the Table Alignment option is enabled only when the 
Table Width value is specified.

• Cell Padding – Set extra space to separate cell walls from their contents. 
• Cell Spacing – Set space between cells.
• Width – Specify what percentage of the table width the width of each column should equal. If the 

table width is not specified, the width of each column will be determined by its content.
• Wrap – If the width for the table columns is defined and the Wrap check box is selected for a 

particular column, the content in that column will be wrapped to fit the column width. If the width 
for the table columns is not defined and the Wrap check box is selected for a particular column, 
the content in that column will be wrapped to fit the minimum column width.

Accessibility section
In the Accessibility section, you can define the properties for labeling your question according to the 
Internet accessibility standards.
• Summary – Use this field to enter a summary statement.

 The Summaryoption is available in the Classic survey rendering mode only.

• Caption – Use this field to enter a caption for your table. The caption appears between the 
question text and the table.

 In the Modern survey rendering mode, caption is not displayed in the survey, but it is visible for 
screen readers.
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Copying and pasting questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question that you want to copy and paste 
somewhere else within your survey.

You can copy a question and paste it somewhere else within your survey.
You can copy a question in your survey in the following ways:
• Copy and paste questions by using the drop-down menu, page 353
• Copy and paste questions by using the Copy Item link, page 353

Copy and paste questions by using the drop-down menu

Procedure 

1 Go to the Design tab > Content tab, click a question or point to it, and then click  icon.

2 On the  menu, click Copy. 
The Paste button appears next to each Add button within your survey.

3 Choose the appropriate location for the copied question, and then click Paste.

 You can also copy other survey elements such as text blocks, code blocks, comments, and section 

headings in a survey by clicking the  menu.

Copy and paste questions by using the Copy Item link

Procedure 
1 Go to the Design tab > Content tab, select a question by clicking it.
2 Scroll down to the section below the Question Options panel, and then click Copy Item. 

The Paste button appears next to each Add button within your survey.
3 Choose the appropriate location for the copied question, and then click Paste.

 The Copy Item link is not available for other survey elements such as text blocks, code blocks, 
comments, and section headings.
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Moving questions up and down
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question that you want to move up or down.

You can change the order of your questions by moving them up or down. 
You can move questions up and down within a survey in the following ways:
• Moving questions up and down by using the drop-down menu, page 354
• Moving questions up and down by using the up and down arrows, page 354
• Moving questions up and down by using the Up and Down links, page 354

Moving questions up and down by using the drop-down menu

Procedure 

1 Go to the Design tab > Content tab,  click a question or point to it, and then click    icon.

2 On the  menu, click Move Up to move the question up or click Move Down to move the 
question down.

 You can also move other survey items such as text blocks, code blocks, comments, and section 

headings up and down within your survey by clicking the  icon.

Moving questions up and down by using the up and down arrows

Procedure 
1 Go to the Design tab > Content tab,  click a question or point to it. 

The up and down arrows appear in the editing area of the question.
2 Click the up arrow to move the question up, or click the down arrow to move the question down.

 You can also move other survey items such as text blocks, code blocks, comments, and section 
headings up and down within your survey by clicking the up and down arrows.

Moving questions up and down by using the Up and Down links

Procedure 
1 Go to the Design tab > Content tab, select a question by clicking it.
2 Scroll down to the section below the Question Options panel.
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3 Click Up to move the question up, or click Down to move the question down.

 The Up and Down links are not available for other survey items such as text blocks, code blocks, 
comments, and section headings.
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Dragging questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question that you want to drag.

You can rearrange your questions within a survey by dragging them.

 The drag-and-drop functionality is also available for other survey items such as text blocks, code 
blocks, comments, and section headings.

Moving questions within a survey by dragging them

Procedure 
1 Go to Design tab > Content tab,  and then select a question by clicking it.

The Drag-and-drop icon  appears in the question heading area.

2 Point to the Drag-and-drop icon .

3 When the pointer becomes a four-headed arrow  , drag the pointer to move the question to the 
appropriate location.

 You can also move a question by dragging its heading. The same applies to other survey items 
such as text blocks, code blocks, comments, and section headings.
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Deleting questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question that you want to delete.

You can delete a question from a survey in the following ways:
• Delete questions by using the drop-down menu, page 357
• Delete questions by using the Delete Item link, page 357

 You can delete a question only when your survey is in the Design or Test mode and has not yet 
been opened. If the survey is in the Open mode, the Delete option is disabled.

Delete questions by using the drop-down menu

Procedure 
1 Go to the Design tab > Content tab, and then click a question or point to it. 

2 Click the  menu, and then click Delete. 
3 In the confirmation dialog box, click Delete. 

The question will be permanently removed from your survey.

 You can also delete other survey elements such as text blocks, code blocks, comments, and 

section headings from a survey by clicking the  menu.

Delete questions by using the Delete Item link

Procedure 
1 Go to the Design tab > Content tab, select a question.
2 Scroll down to the section below the Question Options panel.
3 Click Delete Item. 
4 In the confirmation dialog box, click Delete. 

The question will be permanently removed from your survey.

 The Delete Item link is not available for other survey elements such as text blocks, code blocks, 
comments, and section headings.
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Managing responses by using the drop-down menu
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new 

survey > Design tab > Content tab > select the question that you want to add to your survey >  
menu appears next to each response.

You can manage responses by clicking the  menu that is available for each response within a 

question. The set of options available on the  menu varies depending on the question type.
• Format question and response text in expanded editor, page 370 – Edit the response text in the 

expanded editor that provides additional editing options.
• Editing responses together, page 360 – Edit all responses at one go by using the Edit Together 

dialog box.
• Checking spelling, page 373 – Check the spelling in the response text.
• Add conditional visibility choices rows columns, page 512 – Set the conditional visibility for a 

choice to define whether certain choices are visible or hidden based on a set of predefined criteria.
• Adding responses to questions, page 361 – Pipe responses from the previous questions into the 

topics within the current question. This option is available for the Rank Order, Drag & Drop 
Rank Order, and Scrolling Matrix questions. For the Matrix question, the Pipe in Rows and 
Pipe in Columns options are available. 

• Piping Responses, page 541 - Delete responses piped in the columns of your Matrix question 

from a previous question. This option is available only for the Matrix questions (on the   
menu at the column level).

• Add a choice list, page 363 – Insert a choice list from the library into the topics, rows, or columns 
within your question. This option is available for the following types of questions:
• Choose One
• Choose Many
• Choose One with Image
• Choose Many with Image
• Matrix with a Choose One question as a side
• Matrix with a Choose Many question as a side

• Piping in topics, page 539 – Insert a new choice immediately above the currently selected 
response. Depending on the question type, this option can read Insert Topic, Insert Row, or 
Insert Column. To cancel adding a new choice, press Esc.

• Move responses up and down, page 366 – Change the position of a response by moving it up or 
down within your question.
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• Move responses left and right, page 367 – Change the position of a response by moving it left or 
right within your question. This option is available for the Scale Slider, Scrolling Matrix, and 
Matrix questions.

• Delete responses, page 369 – Remove a response from your question.

 You can also set up the automatic permanent response deletion of all your responses for closed 
surveys after a fixed period of time on the Configuration tab > Data Policies tab > Responses 
tab > Data Retention section. To automatically delete all responses to the Recycle Bin, go to the 
Responses tab > Automation section.
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Editing responses together
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new 
survey > Design tab > Content tab > select the question  responses of which you want to edit.

With the Edit Together feature, you can edit all responses within your question at one go by using a 
variety of formatting options. 
In the Edit Together dialog box, you can also check all responses within a question for spelling mistakes 
and view the total number of words in the responses. You can also add responses to a question by using 
the Edit Together dialog box.

 The Edit Together feature is not available for the image-based responses.

Procedure 
1 Go to Design tab > Content tab, select a question. 

2 Click the  menu  next to any of the responses within the question, and then click Edit 
Together.

 To avoid entering the insecure code into the Edit Together dialog box, on the General Setup 
page, select the Automatically remove insecure code from survey designer check box and 
ensure that the Edit Code Blocks permission is cleared. For more information, see General 
Setup, page 1406.

3 If needed, add more responses to the question.

 Place each response on a separate line by pressing the Enter key.

4 Customize your responses by using the editing toolbar.

 You can point to any icon on the editing toolbar to see its label. The set of editing options varies 
slightly depending on the question type.

5 Save the changes.
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Adding responses to questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question that you want to add a response.

You can add a response to your question (if needed).

 You can add responses only to the questions that have not been published yet.

Adding responses by using the drop-down menu

Procedure 
1 Go to Design tab > Content tab, click a question or point to it. 

2 Click the  menu next to the response above which you want to add a new response.

3 On the  menu, click Insert Choice. 
A new response is inserted immediately above the currently selected response. 
To cancel adding a new response, press Esc.

 Depending on the question type, the Insert Choice option can become Insert Topic, Insert 
Row, or Insert Column.
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Adding responses by using the Add Choice link

Procedure 
1 Go to Design tab > Content tab, click a question.
2 Click the Add Choice link below the responses. 

A new response line is added at the end of the response list. 
To cancel adding a new response, press Esc.

 Depending on the question type, the Add Choice link can become Add Topic or Add Row.
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Add a choice list
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new 
survey > Design tab > Content tab > select the question that you want to add to your survey.

You can insert a choice list from the library into the columns of your Choose One, Choose Many, 
Choose One with Image, Choose Many with Image, Scale Slider, Scrolling Matrix, or Matrix 
question.

Procedure 
1 On the Design tab, on the Content tab, click a Choose One, Choose Many, Choose One with 

Image, Choose Many with Image, Scale Slider, Scrolling Matrix, or Matrix question. 

2 On the  menu, next to each choice or column within the question, click Add from Library.
3 In the Add Choice List dialog box, select the choice list that you need, and then click OK. 

 The items from the choice list are added as additional columns or choices to the already existing 
columns or choices in your question.
For the information on how to create a choice list in the library, see Library Choice Lists tab, 
page 1277.

Related topics 
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Piping in topics
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option 

> name a new survey >  Design tab > Content  tab >  click a question >  click  icon > Pipe in Topics 
option.
You can insert responses from any Choose Many, Choose Many with Image, Matrix, or Scrolling 
Matrix question into the topics, rows, or columns of a later question in your survey. The corresponding 
images are also piped in the target questions provided that they support images.

 The Piping functionality requires that the source and target questions are separated by a page 
break.

You can pipe responses into the questions of the following types:
• Matrix (does not support responses with images)
• Drag & Drop Rank Order
• Rank Order (does not support responses with images)
• Scrolling Matrix

 If you pipe the respondent's answers, you cannot add any additional responses.

Example: The respondent answers a question, and then the selected responses are piped into 
the next question.

The source question
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The destination question

Piping choices and topics

Procedure 
1 Go to the Design tab > Content tab, add a Matrix question.
2 Insert a page break.
3 Add a Rank Order question.

 To prevent validation that the piping cannot meet, indicate that the respondent must rank all 
topics in your Rank Order or Drag & Drop Rank Order question.

4 Click the  icon next to any topic in the Rank Order question. 

5 On the  menu, click Pipe in Topics.  
6 In the Piped Choices dialog box, select the column of the Matrix question that you want to use for 

piping.
7 Indicate whether to pipe Selected or Not Selected responses.
8 Click OK. 

A placeholder is inserted instead of the topics.

 Click the Clear Piping link below the topics to remove the piped responses. For the columns of 

the Matrix questions, the Clear Piping option is available on the  menu at the column level.
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Move responses up and down
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question responses of which you want to 
move up or down.

You can change the order of your responses within a question by moving them up or down.

Procedure 
1 Go to Design tab > Content tab, and then select a question. 

2 Click the  icon next to the response that you want to move up or down.

3 On the  menu, click Move Up to move the response up or click Move Down to move the 
response down.

 You cannot move responses up and down within the questions if your survey is in the Open 
mode.
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Move responses left and right
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new one 
with a Scale Slider, Scrolling Matrix, or Matrix question > select the Scale Slider, Scrolling Matrix, or 
Matrix question  responses of which you want to move left or right.

You can change the order of responses within the Scale Slider, Scrolling Matrix, or Matrix questions 
by moving them left or right.

Procedure 
1 Go to Design tab > Content tab, select a question. 

2 Click the  icon next to the response that you want to move left or right.

3 On the  menu, click Move Left  to move the response left or click Move Right to move the 
response right.

 You cannot move responses left and right within the questions if your survey is in the Open 
mode.
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Dragg responses within a question
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question responses of which you need to 
reorder.

You can rearrange the responses within your question by dragging them.

Procedure 
1 Go to Design tab > Content tab, select a question. 

The drag-and-drop icon  appears on  each response line.
2 Point to the appropriate drag-and-drop icon.

3 When the pointer becomes a four-headed arrow   , drag the pointer to move the response to the 
appropriate location.

 You cannot move responses within the questions if your survey is in the Open mode.
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Delete responses
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option > 
name a new survey >  Design tab > Content tab > select the question responses of which you want to 
delete.

You can delete a response from your question if needed.

Procedure 
1 Go to Design tab > Content tab, select a question. 

The  menu icon  appears next to each response within this question.

2 Click the  menu next to the response that you want to delete.

3 On the  menu, click Delete. 
The response is removed from the question.

 You cannot delete responses within the questions if your survey is in the Open mode.

 You can also set up the automatic permanent response deletion of all your responses for closed 
surveys after a fixed period of time on the Configuration tab > Data Policies tab > Responses 
tab > Data Retention section. To automatically delete all responses to the Recycle Bin, go to the 
Responses tab > Automation section.
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Format question and response text in expanded 
editor

Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new one > 
Content tab > select the question that you want to edit in the expanded view. 

The Edit in Expanded View feature is available for all question types. Other survey elements such as 
text blocks, section headings, and end pages can also be formatted by means of the expanded editor. For 
comments and code blocks, the expanded editor provides a limited set of editing options.

Procedure 
1 Go to Design tab > Content tab, click a question or response text.

2 To open Expanded Editor, click the  icon in the upper-right corner of the question or 

response, and then select Edit in Expanded View, or click the More icon .
3 Customize your question or response text by using the editing toolbar in the expanded editor. The set 

of editing options in the expanded editor varies depending on the question type.

 The Media Manager button is hidden in the editing toolbar of he Expanded Editor dialog box 
if the Automatically remove insecure code from survey designer check box is selected 
and the Edit Code Blocks permission is cleared. For more information, see General Setup, 
page 1406.

The Expanded Editor dialog box

 For comments and code blocks, the following options are available within the expanded editor: 
Undo, Redo, Cut, Copy, Paste, and Insert Piped Value.
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Edit report options
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 

select a question that you want to edit >  menu > click Edit Report Options.

You can set the report and export values for question choices to use these values later for reporting.

 To avoid entering the insecure code in the Edit Report Options dialog box, on the General 
Setup page, select the Automatically remove insecure code from survey designer check 
box and ensure that the Edit Code Blocks permission is cleared. For more information, see 
General Setup, page 1406.

When you change the report values, it updates the calculations in report elements that use this question. 
When you change the export values, it updates the exported values when you export the responses from 
this question.

 You can change the question report and export values when designing a survey or after its 
publishing.

The Edit Report Options feature is available for the following question types:
• Choose One
• Choose One with Image
• Choose Many
• Choose Many with Image
• Matrix with the Choose One and Choose Many sides
• Rank Order
• Scale Slider
• Scrolling Matrix

 For the Choose One and Choose One with Image questions, when the report value or export 
value is set for a choice, it is displayed instead of the choice index in the survey designer and is 
used as an identifier for the choice.

Procedure 
1 On the Surveys tab, open an existing survey or create a new one.
2 On the Content tab, select the question, the report options of which you want to edit.

3 On the  menu of the question, click Edit Report Options.
4 In the Edit Report Options dialog box, set the report and export values for each question choice.
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 For a Matrix question, you can switch between the topics and sides using the Matrix Section 
list. When you switch between the sides, all changes are remembered.

5 Click Save.
The report and export values are set to be used for reporting on this question.

 



Designing Your Survey Overview Checking spelling

EFM User Guide 373

Confidential and Proprietary Information of Verint Systems Inc.

Checking spelling
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Design tab > Content tab > select the question that you want to check.

You can choose to check the spelling in the entire survey at one go or to check the spelling in each field 
with question text or response text separately.
• Checking spelling in the entire survey, page 373
• Checking spelling in the question text, page 374
• Checking spelling in the response text, page 374
• Checking spelling in the End Page text, page 374

Checking spelling in the entire survey

Procedure 
1 On the Advanced tab of the Design tab, click the All Survey Spell Check link. 

The Spell Check dialog box opens.

The Spell Check dialog box

 In the Not in the Dictionary section, the word that is not found in the EFM dictionary is 
highlighted in bold. In the Suggestions section, all possible spelling variations of the missing 
entry appear.

2 Manage the missing entries by using the following options:



Designing Your Survey Overview Checking spelling

EFM User Guide 374

Confidential and Proprietary Information of Verint Systems Inc.

• Ignore – Ignore the highlighted entry and proceed to the next entry.
• Ignore All – Ignore all occurrences of the entry during the current spelling check.
• Add Custom – Add the entry to the custom dictionary.
• Change – Replace the entry with the highlighted suggestion or save the changes that you have 

made manually in the Not in Dictionary section.
• Change All – Replace all occurrences of the entry with the highlighted suggestion or with the 

word that you have entered manually in the Not in Dictionary section.
3 Click OK when you complete the spelling check.

Checking spelling in the question text

Procedure 
1 On the Content tab of the Design tab, click a question or point to a question. 

The    menu appears in the  question heading area.
2 On the  menu, click Spell Check to check the spelling in the question text only. 
3 In the Spell Check dialog box, manage the missing entries as appropriate.
4 Click OK when you complete the spelling check.

Checking spelling in the response text

Procedure 
1 On the Content tab of the Design tab, click a question. 

The    menu appears for each response within this question.
2 Click the icon next to the response text that you want to check for spelling mistakes.
3 On the  menu, click Spell Check. The Spell Check dialog box opens.
4 In the Spell Check dialog box, manage the missing entries as appropriate.
5 Click OK when you complete the spelling check.

Checking spelling in the End Page text
1 On the Pages tab of the Design tab, select the end page you want to check for spelling mistakes. 

The Design End Page dialog box opens in the expanded view. 

2 Click the Spell Check icon  on the toolbar of the expanded editor. 
The spell checking mode turns on.

3 Manage the missing entries as appropriate.
4 Click OK when the spell check is complete.
5 Click Save.
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 You can also use the Spell Check option in the Expanded Editor to check the questions and 
responses text for spelling mistakes.
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Create a list in the question
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
select a question that you want to edit in the expanded view.

You can create bulleted and numbered lists in your question using the corresponding options in 
Expanded Editor dialog box.

Procedure 
1 On the Content tab of the Design tab, select the question that you want to add.

2 In the   menu  of the question, click Edit in Expanded View.
3 In the Expanded Editor dialog box, click the Bullet List or Numbered List icon to format your 

question text as needed.

The Expanded Editor dialog box

4 Click Save.
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How to test your survey
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new survey or open an existing one > 
Design view > Test button. 

You can test your survey while you are in Design mode. In addition, you can test logic, branching, 
formats, and response collection within the testing window. Data collected from respondents is available 
for exporting and reporting.
Testing a survey is available by clicking the Test button in the Design view.
Test mode allows the greatest range of features to be accessed during the survey design process. You can 
test your survey in every way possible, modify it if required, and test again until you are satisfied. You can 
test a survey as frequently as you want with no impact on the mode or on the live production version of 
the survey. You should test all survey features before you open the survey. Test mode allows switching 
between the three device type options without exiting Test mode. 

 When a survey is republished or opened, all test data is deleted.

There are the following device type options available:
• Desktop
• Tablet
• Mobile
You can find the device type icons in the upper-right corner of the Testing Your Survey window.
The Auto option is the default device type option of a survey opened using a certain device.

 To enable different device type options in Test mode, select the Generate Mobile HTML check 
box on the Properties tab.

For multiple-campaign surveys, the campaigns are tested in the following order:
1 Survey Link, Social Media, and Offline Device campaigns
2 Email List or Panelist campaign (the campaign that was added last is tested first)

How to test your survey

Procedure 
1 On the Design tab, click the Test button. 

The Test Your Survey dialog box opens.
2 Click OK.

 When you click OK, a new version of the survey is created for testing. All data for the previous 
test version of the survey is deleted.

3 In the Testing Your Survey window, test your survey and make appropriate changes if required. 
You can copy and paste the survey testing URL if needed.
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Survey publishing workflow overview
Navigation

Administration tab > Users tab > click the name of the user that you want to edit.

 The target audience for this topic is administrators.

Before a survey is  opened, some organizations for the survey and invitation content need to be reviewed 
and approved by someone other than the author (for example, manager, marketing representative, legal 
department, other) before the survey becomes externally available.
Users who require approval to activate a survey are referred to as Assisted Survey Authors. Users who 
have the ability to approve surveys are called Reviewers. These user roles are set by your Administrator 
per user. An Assisted Survey Author is not be able to open a survey without a Reviewer approving the 
content first. 
The Reviewer Status menu in the Edit User dialog box > Workgroup tab  allows an Administrator to 
select the appropriate workflow assignment for the user. The options include: 
• Assisted Survey Author – A user that has rights to create and edit a survey, but cannot open a 

survey until it is approved by a Reviewer. That Assisted Survey Author user must send their survey 
to one or more Reviewer users for survey publish workflow approval.

• Standard Survey Author – A user that is mapped to the Survey author default role.
• Survey Author with Reviewer Access – A user that has the Reviewer permission  enabled. This 

Reviewer is mapped to, and have survey publish authority on behalf of the Assisted Survey 
Author.
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Approval process workflow
An Assisted Survey Author is a user who has the ability to create and edit a survey but cannot open it. 
Assisted Survey Authors require approval from  assigned Reviewers within their organization before 
publishing a survey.
The diagram below depicts the survey approval process for an Assisted Survey Author.

The survey approval process
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Submit a survey for review
Navigation

Design & Collect tab > Surveys tab > click the title of a survey > Collect tab.

An Assisted Survey Author can submit the survey for review. After that, a system generated email is 
sent to the specified Reviewer.

Procedure 
1 On the Collect tab, choose how to collect your survey results.
2 In the Open Survey window, click the Open Survey Now (*) button.
3 In the Submit for Review dialog box, on the Submit tab, in the Reviewer to Notify menu, choose 

the Reviewer.
4 Add comments, and click the OK button.

 When the message is received and accepted by the Reviewer, the survey is moved to the For 
Review folder and is locked from further editing.
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Reviewing a survey
Navigation

Design & Collect tab > Surveys tab > For Review folder > Actions menu.

When a survey is sent to a Reviewer by an Assisted Survey Author, the survey is displayed in the For 
Review folder. Reviewer must decide whether to accept or decline the survey.

Workflow 
1 Reviewers can accept or decline the survey submitted by the Assisted Survey Author. 

The Accept and Decline options are available on the My Surveys page, in the Actions menu . 
2 If Accept is selected, the Accept Survey dialog box appears. 

a. The Reviewer adds comments, and clicks OK.
These comments become part of the History.

b. After the Reviewer added comments, a system-generated email message is sent back to the 
Assisted Survey Author with the updated status and comments entered by the Reviewer.

c. The survey is removed from the For Review folder and placed in the My Surveys folder of the 
Assisted Survey Author.
The survey is unlocked for editing and the action that required the review (such as Open or 
Reopen a Survey) no longer has the asterisk (*) associated with it.

d. If a survey that has already been accepted is modified, it has to be submitted for approval again.

The For Review folder

3 If Decline is selected, a system-generated email is sent to the Assisted Survey Author.
a. The survey is removed from the For Review folder and placed in the appropriate user folder.
b. The action needs to be resubmitted when new changes are made.

4 An Assisted Survey Author can also withdraw the survey from review to unlock the survey for editing 
and resubmission.
The Withdraw from Review option is available on the My Surveys page, in the Actions menu.
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Unlocking a survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey accepted by 
reviewer or submitted for review > Design view > Unlock Survey button.

The Assisted Survey Author and Reviewer can view a survey (approved or waiting for review) so that they 
can easily verify it without restarting the survey approval process. When a survey is submitted for review, 
accepted by Reviewer, or published, the Edit mode is disabled, and the survey is locked. Still, the Reviewer 
can scroll and navigate through the pages of the locked survey. During the survey approval process, the 
Assisted Survey Author can only edit the survey declined by the Reviewer.
You can unlock the survey by clicking the Unlock Survey button on the toolbar in the survey designer.

The Unlock Survey button in the survey designer

Unlocking the survey restarts the survey approval process. The Assisted Survey Author needs to send the 
survey for approval again.
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Pages Page
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab.

You can manage blocks and pages within your survey by using the Pages page.
All survey pages are included into blocks. Each page can be included only in one block.
The surveys created prior to the 15.1 release are updated to place all pages that previously were not in 
blocks into blocks. The block numbers are changed correspondingly. For example, the survey that 
previously contained Page 1, Page 2, and Block 1 with Page 3 and Page 4 changes to Block 1 containing 
Page 1 and Page 2, and Block 2 containing Page 3 and Page 4.
Each block has a block number and an editable block name. You can expand and collapse each block by 
using the arrow to the left of the block name. All blocks are expanded by default to present the pages 
they include.
Each page in the block is displayed as a separate bar with a page number and an editable page name. To 
view the content of each page, you can expand a page bar by using the arrow to the left of the page 
name. Each item on the page is displayed as a separate bar with the question heading and question text 
for questions and text content for non-questions. The item type is specified to the right of the item bar.
On the Pages page, you can perform the following actions on the blocks by using the block drop-down 

menu  to the rightmost of the block bar:
• Add Block – Add a new block to your survey. The added block is empty. For more information, 

see Add block, page 390.
• Add Page Block from Library - Add a page block to your survey. This option is not available in 

the block drop-down menu. For more information see Add page block, page 391.
• Hide This Block – Hide the current block from the survey respondents. After clicking the option, 

the visibility icon  is displayed on the right side of the block bar. To make the block visible 

again, in survey designer, click the delete icon  to the rightmost of the visibility status bar.

 If the survey distribution method is Require a Passcode, the Hide this block option is 
unavailable for the first block in the survey.

• Add Conditional Visibility – Add or edit the block visibility criteria. For more information, see 
Add conditional visibility for block, page 506.

• Add Branch – Add branching to your survey. For more information, see Adding Branching 
Criteria, page 442.

• Add Page Rotation – Make pages in the current block appear in a rotated order in your survey. 
For more information, see Blocks and Page Randomization, page 403.

• Add Page Randomization – Make pages in the current block appear in a randomized order in 
your survey. For more information, see Blocks and Page Randomization, page 403.

• Add Block Rotation – Make child blocks in the current block appear in a rotated order in your 
survey. For more information, see Blocks and Page Randomization, page 403.
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• Add Block Randomization – Make child blocks in the current block appear in a randomized 
order in your survey. For more information, see Blocks and Page Randomization, page 403.

 The Add Block Rotation and Add Block Randomization options are available only for the 
blocks that contain child blocks.

• Copy – Copy the current block. For more information, see Copy and paste block, page 393.
• Paste – Paste the previously copied block into your survey. The block is added after the current 

block. For more information, see Copy and paste block, page 393.
• Move Block Up – Move the current block one position towards the beginning of the survey.
• Move Block Down - Move the current block one position towards the end of the survey.

 The Move Block Up option is unavailable if the current block is in the first position of the survey. 
Similarly, the Move Block Down option is unavailable if the current block is in the last position 
of the survey.

• Delete Block – Delete the current block from the survey. For more information, see Delete block, 
page 392.

On the Pages page, you can perform the following actions on the pages by using the page drop-down 
menu to the rightmost of the page bar:
• Add Page – Add a new page to your survey.
• Add Custom End Page – Create a custom end page in your survey. When saved, this custom end 

page appears on the Pages page of the Design tab. For more information, see End Pages 
Pagination Panel, page 396.

• Hide This Page – Hide the current page from the survey respondents. After clicking the option, 

the visibility icon  is displayed on the right side of the page bar. To make the page visible 

again, in survey designer, click the delete icon  to the rightmost of the visibility status bar.
• Add Conditional Visibility – Add or edit the page visibility criteria. For more information, see 

Page Conditional Visibility, page 502
• Add Branch – Add branching to your survey. For more information, see Adding Branching 

Criteria, page 442.
• Copy – Copy the current page. For more information, see Copying and pasting pages, page 387.
• Paste – Paste the previously copied page into your survey. The page is added after the current 

page. For more information, see Copying and pasting pages, page 387.
• Move Page Up – Move the current page one position towards the beginning of the survey.
• Move Page Down – Move the current page one position towards the end of the survey.

 The Move Page Up option is unavailable if the current page is in the first position of the block. 
Similarly, the Move Page Down option is unavailable if the current page is in the last position of 
the block.

• Delete Page – Delete the current page from the survey.
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Open a page

Procedure 

1 On the Design tab, click the Pages page icon .
2 On the Pages page, navigate to the page you want to open and point to the text indicating the 

number of questions on the page. The text turns to the Go to Page link.
3 Click the Go to Page link.

Edit the block or page name

Procedure 

1 On the Design tab, click the Pages page icon .
2 On the Pages page, click the block or page name you want to edit
3 In the text field, edit the block or page name. The default block or page name is Untitled.

 To cancel the changes, press Esc.

4 Press Enter to save the changes.
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Pages Page tree view
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab.

On the Pages panel, you can switch the pages view between Thumbnails and Tree. The Tree view 
shows the question and answer level information on each page in your survey. In addition, you can 
rename and delete pages in the Tree view using a shortcut menu.
Thumbnails is the default view of survey pages. To see the page's hierarchical structure, click the Tree 
icon on the Pages panel.
To view the question headings on a certain page, click a black arrow next to that page to expand it. You 
can expand or collapse all pages and view their content by clicking the Expand All or Collapse All 
options respectively.
To view the answers for a certain question, click an arrow next to the question heading.

 When you click the page, question heading, or answer on the Pages panel, it displays in the 
survey content area.

Delete a page

Procedure 

1 On the Design tab, click the Pages panel icon  . 
The Pages panel opens.

2 On the Pages panel, click the Tree view icon.
3 Select the page you want to delete. Click Delete Page.

 You can delete a question the same way as a page. For more information on managing pages 
within your survey, see Pages Page, page 383.
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Copying and pasting pages
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab.

You can copy entire page to duplicate questions in bulk. The pasted page has all survey questions from 
the copied page except for the profile questions. The branching and conditional logic is not copied.
The name of the pasted page is <copied page name> (1) for a page that is pasted once, <copied page 
name> (2) for a page that is copied and pasted twice, etc. You can rename the pasted pages.

Copy Pages

Procedure 
1 On the Pages panel, select the page you want to copy.
2 On the drop-down menu, click the Copy option. The Paste option becomes available.
3 Click the Paste option. The page is inserted after the copied page.

 You can access the same functionality from the block drop-down menu on the Content tab of 
the survey designer.
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Copying and pasting pages between surveys
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab.

You can copy a page from one survey to another survey. The pasted page has all survey questions from 
the copied page except for the profile questions. The branching and conditional logic is not copied. The 
name of the pasted page is <copied page name> (1) for a page that is pasted once, <copied page name> 
(2) for a page that is copied and pasted twice, etc. You can rename the pasted pages.

Copy and paste pages between surveys

Procedure 
1 On the Pages panel, select the page you want to copy.

2 In the drop-down menu , click the Copy option. The Paste option becomes available.
3 Navigate to the survey you want copy the page to.
4 On the Pages panel, click the page after which you want to insert the copied page.
5 Click the Paste option. The page is inserted.

 You can also copy and paste pages by using the corresponding options in the page drop-down 
menu in the header of the survey content area.
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Drag pages
 

Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab.

You can rearrange pages within a survey by dragging them. You can also drag your questions within a 
survey following the same procedure.

 You cannot drag a page to a block that contains child blocks.
 

Procedure 
1 Navigate to the My Surveys tab.
2 In the Design view of the survey designer, click the Pages tab.
3 On the Pages page, expand the Block section.
4 In the Block section, click in the needed page.
5 Drag the page to the appropriate location.

 When dragging a page over a collapsed block, the page is added to the end of the block. If you 
hover over the block for a second, it is automatically expanded. Similarly, when dragging a 
question over a collapsed page, a question is added to the end of the page. If you hover over the 
page for a second, it is automatically expanded.
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Add block
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab >  icon.

You can add new blocks to your survey to create a questionnaire that meets your needs to the full.

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For details, see Contact us, 
page 50.

Procedure 
1 On the Design tab of the survey designer, click the Pages tab.
2 On the Pages page, do the following:

• To add another block to your survey, click the Add Block option below the last block bar. The new 
block is added after the last survey block.

 You can access the same functionality from the block menu on the Pages or Content tabs of the 
survey designer.

In Modern survey rendering mode, to add a child block to your block, click the Add Block link at the 
bottom of the block bar.

 The Add Block link is not available for the blocks that contain pages. For more information, see 
Blocks within blocks, page 407.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

3 In the Name Your Block dialog box, enter a name for your new block. The default block name is 
Untitled.

4 Click OK.
The new empty block is added after the current block. You can drag pages from other blocks to your 
block or add new pages.
If you add a new block from the survey designer, the new block splits the current block with all its pages 
starting from the current one moving to the new block. For example, if you add a new block from the 
second page of the block with 4 pages, the added block will include the second, third, and fourth pages of 
the previous block; and the previous block will preserve only its first page.

 In the survey designer, the Add Block option is unavailable for the first page of each block. You 
need to have at least two pages in your block to be able to add a new block after it.
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Add page block
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab > Add Page 
Block from Library.

You can add page blocks to your survey which contain groups of multiple questions. This allows you to 
design your survey quickly and efficiently. 

Procedure 
1 On the Design tab of the survey designer, click the Pages tab. 
2 On the Pages page, click the Add Page Block from Library option below the last block bar to add 

the new block after the last survey block.
3 In the Insert Item dialog box > Page Blocks tab, blocks are sorted by categories.
4 In the Categories list, select the category with the page block that you want to insert. 
5 In the Blocks list, select the block you wish to add. 

Block preview is available in the right pane.
6 Click OK. 

The selected page block is added to your survey.

 Conditional visibility logic can be applied only to Pages and Question Types which are within the 
same page block. Applying this logic across multiple page blocks is not supported.
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Delete block
 

Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab >  icon.

You can delete the whole block from your survey at a time or merge its pages with another block without 
having to delete individual pages.

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For details, see Contact us, 
page 50.

 

Procedure 
1 In the Design view of the survey designer, click the Pages tab.

2 On the Pages page, in the block drop-down menu  to the rightmost of the block bar, click 
Delete Block.

 You can access the same functionality from the block drop-down menu on the Pages or 
Content tabs of the survey designer.

 

3 In the Delete Block dialog box, select one of the following options:
• Delete block content (All N page(s) and their content will be deleted). – Deletes the 

current block with all its content. This is the default option.
• Merge block’s content with previous block – Deletes the current block and inserts all its child 

blocks and pages at the end of the previous block.
• Merge block’s content with following block – Deletes the current block and inserts all its child 

blocks and pages at the beginning of the following block.
4 Click OK.
 

When deleting a parent block that is the only block in the survey, the options in the Delete Block dialog 
box are the following:
• This container will be removed. All child blocks will be preserved. – Deletes the parent 

block and preserves all its child blocks. This is the default option.
• Delete block content (All N page(s) and their content will be deleted). – Deletes the 

parent block with all its content and creates a new empty block in the survey.
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Copy and paste block
 

Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab >  icon.

You can copy an entire block to duplicate pages in bulk. The pasted block contains all pages and questions 
from the copied block, except for the profile questions. The branching and conditional logic is not copied. 
The name of the pasted block is <copied block name> (1) for a block that is copied and pasted once, 
<copied block name> (2) for a block that is copied and pasted twice, and so on. You can rename the 
pasted blocks.

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For details, see Contact us, 
page 50.

 

In Modern survey rendering mode, you can also copy a child block into a parent block containing at least 
one child block.

 To copy a child block into a parent block, make sure you use the child blocks’ drop-down menus 
both for the Copy and Paste options.

 

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Procedure 
1 In the Design view of the survey designer, click the Pages tab.

2 On the Pages page, in the block drop-down menu  to the rightmost of the block bar, click 
Copy. 
The block contents is copied to the clipboard.

 Only one block can be copied to the clipboard at a time. Any previously copied block is 
overwritten.

3 In the block drop-down menu, click Paste. The duplicate of the copied block is inserted after the 
current block.

 You can access the same functionality from the block drop-down menu on the Pages or 
Content side tabs of the survey designer.
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You can also use the Copy and Paste options to copy blocks from one survey into another. A block 
copied to the clipboard is available for pasting into other surveys as long as the EFM session is active.
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Drag blocks
 

Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab >  icon.

You can rearrange blocks within a survey by dragging them.

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For details, see Verint 
Resources, page 50.

In Modern survey rendering mode, you can also drag a block into another block.

 You can drag a block only into a block which is empty or which contains other child blocks (you 
cannot mix blocks and pages in a block.)

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Procedure 
1 Navigate to the My Surveys tab.
2 On the Design tab of the survey designer, click the Pages tab.
3 On the Pages page, click in the needed block.
4 Drag the block to the appropriate location.

 When dragging a block over a collapsed block, the child block is added to the end of the block. If 
you hover over the collapsed block for a second, it is automatically expanded.
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End Pages Pagination Panel
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab > End Pages 
section.

You can create a wide range of end pages for your survey. You can also edit, test, and delete your end 
pages using the end page drop-down menu on the corresponding end page bar.

 Available types of end pages vary based on the survey settings and survey distribution method 
you select. For more information, see the end pages description below.

 

From the End Pages section on the Pages tab, you can add the following end pages to your survey:
• Survey Completed – This page appears when a respondent completes the survey and clicks the 

Submit button.
Example
Thank you for completing this survey.

• Survey Saved – This page appears when a respondent saves the survey to complete it later and 
clicks Save. By default, this page provides the URL for a respondent to access the survey again 
and complete it. You can provide the survey URL using the %URL% placeholder. When a 
respondent takes the survey and saves it, the %URL% placeholder is replaced with the survey URL.

Example:  
Your responses to the survey have been saved.
Save the following link to complete the survey later.
%URL%

 The Survey Saved end page is shown in the End Pages section only if the Save button is 
selected on the Formatting tab.

 

• Branched Out – This page appears when a respondent does not meet the required criteria to 
continue answering the survey. If respondents fulfill the simple or advanced branching criteria for 
an early exit from the survey, they are taken to the end page and their responses are not counted 
as completed.
Example
Thank you for completing this survey.

 The Branched Out end page is shown in the End Pages section only if one or more branches or 
destinations are set in the survey.

 

• Invalid Access – This page appears when a respondent enters an invalid key to access the 
survey.
Example
Invalid access key. Please use the Back button in your browser and try again.
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 The Invalid Access end page is shown in the End Pages section only if the survey distribution 
method is Require a Passcode.

 

• Prevent Updates – This page appears when a respondent has already completed the survey and 
tries to access it again.
Example
You have already submitted a response to this survey.

 The Prevent Updates end page is shown in the End Pages section only if the Allow 
respondent to update a completed survey option is not selected on the Properties  tab.

 

• Survey Closed – This page appears when a respondent tries to access the survey when it is 
closed.
Example
This survey is now closed. Thank you for your interest.

• Quota Reached – This page appears when a respondent tries to answer the survey but enough 
responses have already been collected and the defined quota has been reached.
Example
The quota for this survey based on your demographics has already been met. Thank you for your 
interest.

 The Quota Reached end page is shown in the End Pages section only if one or more quotas are 
set for the survey on the Quotas tab.

 

• Opt Out – This page appears when a respondent unsubscribes from future survey invitations. 
Respondent can still take the survey if they have the survey link.

 This functionlity is available for the Require a Passcode and Create a List surveys.

Example
You will not receive further survey invitations from this list. You can still take surveys.
Thank you for your time!

• JavaScript Required – This page appears when JavaScript is not active in the respondent's 
browser. Respondent has to activate Javascript in the browser settings to be able to take the 
survey.
Example
This survey will not be accessible if the browser has JavaScript disabled. Please enable JavaScript in 
your browser settings to continue with the survey (Press F1 for Browser Help).

 The JavaScript Required end page is shown in the End Pages section only if the JavaScript 
Required option is selected on the Properties tab.

 

• Custom end page – You can use this page to create a unique message and apply it as the survey 
end page.
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End Page Behavior Options
In the end page designer, you can define the behavior of the survey end page using the following options 
from the Behavior drop-down list.
• Standard Confirmation Page – Use this option to define a standard Thank You message. 

Default messages are available for each end page type but you can also edit the page content.
• Redirect to an existing Web page – Use this option to redirect respondents to a specific Web 

page outside the EFM application. Start the address with http://, for example, 
http://www.vovici.com

• Display Live Results – Use this option to provide respondents with a summary of the current 
survey results. In addition, you can allow respondents to view their own answers highlighted in 
red as well as to print or email their answers by selecting the corresponding check boxes in the 
end page designer.

• Display Respondent Answers – Use this option to provide respondents with their own 
responses. You can allow respondents to print or email their answers by selecting the Allow the 
respondent to print and e-mail this page check box.

In Modern survey rendering mode, the Display Live Results and the Display Respondent Answers 
survey end pages are displayed correctly for all screen sizes automatically.

 For Display Live Results and Display Respondent Answers only pages, questions, and 
choices that were visible to the respondent are displayed.

Edit an End Page

Procedure 
1 On the Pages side tab, expand the End Pages section.
2 Click the end page you want to edit.

 You can also open the Design End Page dialog box by clicking the Go to Page link, which 
appears when hovering over the page you want to edit, or by selecting the Edit Page option 
from the page drop-down menu.

 

3 In the Design End Page dialog box, edit the end page title in the Displayed Title field if needed.
4 Select the end page behavior option from the Behavior drop-down list. For detailed information, see 

the section End Page Behavior Options, page 398 earlier in this topic.
5 Edit the contents of the end page, if needed.
6 To check spelling, click the Spell Check icon.
7 Click Save.

 You can customize text and add media to the end page using the editing toolbar.
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Add a Custom End Page

Procedure 
1 On the Pages side tab, expand the End Pages section.
2 Click the Add Custom Page link.
3 In the Design Custom End Page dialog box, type the custom end page name in the Displayed Title 

field.
4 From the Behavior drop-down list, select the custom end page behavior option. For detailed 

information, see the section End Page Behavior Options, page 398 earlier in this topic.
5 From the Count respondents who reach this page as drop-down list, select the appropriate 

option.
6 Type the content of your custom end page.
7 To check spelling, click the Spell Check icon.
8 Click Save.

 You can customize text and add media to your end page using the editing toolbar.
 

Test a Custom End Page

Procedure 
1 On the Pages tab, expand the End Pages section.
2 Select the end page you want to test and click the end page drop-down menu.
3 In the end page drop-down menu, click Test.

The testing your survey window opens, where you can view the end page with a survey theme 
applied. You can copy and paste the testing URL as you need.

 For the Display Live Results and Display Respondent Answers end page options, if there 
are no responses collected, random data are displayed.

 

Delete a Custom End Page

Procedure 
1 On the Pages tab, expand the End Pages section.
2 Select the end page you want to delete and click the end page drop-down menu.
3 In the end page drop-down menu, click Delete.

 You cannot delete system end pages.
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Branched Out and Over Quota on the End Pages
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab > End Pages 
section.

You can use two additional statuses on the end pages Branched Out and Over Quota. With the new 
statuses, you can track and single out respondents who are branched out of your survey or are over the 
quota limit.

 To avoid entering the insecure code into the End Page designer, on the General Setup page, 
select the Automatically remove insecure code from survey designer check box. For more 
information, see General Setup, page 1406.

Branched Out
You can select whether respondents who reach the Branched Out end page are treated as Completed 
or as Branched Out. By default, the responses are considered as Branched Out. You can change this 
setting while designing the Branched Out end page. Use the Count respondents who reach this 
page as list to set the status.
Respondents who have the Branched Out status do not receive any reminder emails to take the survey.

 For all surveys created before the 6.3 release, the Branched Out end page is set to the 
Completed status by default.

Over Quota
You can select whether respondents who reach the Quota Reached end page are treated as Started or 
as Over Quota. By default, the responses are considered as Over Quota. You can change this setting 
while designing the Quota Reached end page. Use the Count respondents who reach this page as 
list to set the status.
Respondents who have the Over Quota status do not receive any reminder emails to take the survey.

 For all surveys created before the 6.3 release, the Over Quotaend page is set to the Started 
status by default.

Set the Branched Out Status

Procedure 
1 In the Design view, click the Pages tab in the left pane.
2 Click the End Pages section to expand it.
3 Click the Branched Out end page to open it in the end page designer.
4 In the Count respondents who reach this page as list, select the Branched Out status.
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5 Click Save.

 Set the Over Quota Status

Procedure 
1 In the Design view, click the Pages tab in the left pane.
2 Click the End Pages section to expand it.
3 Click the Quota Reached end page to open it in the end page designer.

 The Quota Reached end page and the Over Quota status appear only if the Quota 
Management functionality is available for your workgroup.

4 From the Count respondents who reach this page as list, select the Over Quota status.
5 Click Save.
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Branched Out and Over Quota on the Custom End 
Pages

 

Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab > Custom End 
Pages section.

You can assign additional statuses to the survey respondents on the custom end pages. With the new 
statuses, you can track and single out respondents who are branched out of your survey or are over the 
quota limit.

 To avoid entering the insecure code into the Custom End Page designer, on the General Setup 
page, select the Automatically remove insecure code from survey designer check box. For 
more information, see General Setup, page 1406.

You can set the following statuses for respondents who reach the custom end page of your survey:
• Started – Respondents who start taking the survey.
• Completed – Respondents who complete the survey.
• Branched Out – Respondents who do not meet the certain criteria and are branched out of your 

survey.
• Over Quota – Respondents who are over the quota limit defined for your survey.
You can track these statuses and create more accurate reports using them. By default, the status on the 
custom end page is set to Completed.
Respondents who have the Over Quota or Branched Out status do not receive any reminder emails to 
take the survey.
For all surveys created before the 6.3 release that have the Do not count respondents who reach 
this page as “Completed” check box selected on the custom end page, the default status is set to 
Started.

Procedure 
1 In the Design view, click the Pages tab in the left pane.
2 Click the Custom End Pages section to expand it.
3 Click the Add a Custom Page button to create a new custom page.

 You can also add a new custom end page by using the Add Custom End Page option in the page 
drop-down menu on the survey designer toolbar.

 

4 Click the page icon to open the page in the end page designer.
5 From the Count respondents who reach this page as drop-down list, select the status you want 

to set for respondents.
6 Click Save.
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Blocks and Page Randomization
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab.

You can choose in which order the pages and child blocks are displayed in the blocks.

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For details, see Verint 
Resources, page 50.

The following types of page order are available:
• Fixed order – Displays pages and child blocks within a block in an ascending order and is the 

same for all respondents. By default, all pages and child blocks are displayed in a fixed order.
• Random order – Displays pages or child blocks within a block in a randomized order to your 

respondents.
• Rotated order – Displays pages or child blocks within a block in a rotated order to your 

respondents. For example, if a block contains pages 6, 7, 8, and 9, and the first respondent sees 
the pages in the initial order of 6, 7, 8, 9, then the second respondent sees 7,8,9,6, and the third 
respondent sees 8,9,6,7.

Add page or child block rotation
1 On the Pages page, click the block drop-down menu to the rightmost of the block that you want to 

edit.
2 To rotate pages in your block, in the block drop-down menu, click the Add Page Rotation option.
3 To rotate child blocks in your block, in the parent block drop-down menu, click the Add Block 

Rotation option.

 You can also access the same functionality from the block drop-down menu in the header of the 
survey content area in the survey designer.

Add page or child block randomization
1 On the Pages page, click the block drop-down menu to the rightmost of the block that you want to 

edit.
2 To randomize pages in your block, in the block drop-down menu, click the Add Page Randomization 

option.
3 To randomize child blocks in your block, in the parent block drop-down menu, click the Add Block 

Randomization option.

 You can also access the same functionality from the block drop-down menu in the header of the 
survey content area in the survey designer.

4 In the Page Randomization dialog box, click one of the following options:
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• Show All Pages – click to show every page in the block in a random order.
• Maximum Pages to Show Randomly – click to show only the defined number of pages in the 

block in a random order. For example, if you select “3”, the survey engine selects any three pages 
from the block to show randomly.

5 In the Block Randomization dialog box, click one of the following options:
• Show All Blocks – click to show every child block in the block in a random order.
• Maximum Blocks to Show Randomly – click to show only the defined number of child blocks 

in the block in a random order. For example, if you select “3”, the survey engine selects any three 
child blocks from the block to show randomly.

6 Click OK.

 If a block contains a single page, the Add Page Rotation and Add Page Randomization 
options are disabled. Similarly, if a block contains a single child block, the Add Block Rotation 
and Add Block Randomization options are disabled.

In Classic survey rendering mode, for the block containing the first or last page of the survey, page 
randomization and rotation are unavailable and the page order is set to fixed. In Modern survey 
rendering mode, if the block contains the first page of the survey and the distribution method is Require 
a Passcode, page randomization and rotation are unavailable, and the page order is set to fixed. When 
changing from Classic to Modern rendering, the page order in the blocks with the mentioned conditions 
is automatically set to fixed.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.
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Rotate and Randomize Survey Questions
When you add questions to a survey page, you can randomize the order that the questions appear to 
your respondents. Randomization helps to prevent question order bias, where a respondent can react 
differently to questions based on the order in which the questions appear.
You can also choose to rotate questions so that they appear in a different order for each respondent.

Only one option can be used at a time. For example, if you select Question Randomization for a page but 
then select Question Rotation, Question Randomization is turned off and Question Rotation is used.

 The Page Rotation permission must be enabled to use this feature.

Add question rotation

Procedure 
1 In the Design and Collect > Surveys > My Surveys > Design > Pages tab, click the page drop-

down menu to the right of the page that you want to edit.
2 To rotate questions in your page, in the page drop-down menu, click Add Question Rotation. The 

rotation icon is displayed on the page level banner in the same manner as the page and block rotation 
icons.

 The Add Question Rotation option is available when your page contains more than one 
question.

3 To change back to the default question order, in the page drop-down menu, click Remove Question 
Rotation.

Add question randomization

Procedure 
1 In the Design and Collect > Surveys > My Surveys > Design > Pages tab, click the page drop-

down menu to the right of the page that you want to edit.
2 To randomize questions in your page, in the page drop-down menu, click Add Question 

Randomization. The crossed arrows icon is displayed on the page level banner in the same manner 
as the page and block randomization icons.

 The Add Question Randomization option is available when your page contains more than one 
question.

3 In the Question Randomization dialog, choose the Maximum Questions to Show Randomly 
option and select the number of questions you want to randomize from the drop-down menu.

4 Click OK.
5 To change back to the default question display in the page drop-down menu, click Remove 

Question Randomization.
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Blocks within blocks
 

Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab.

You can include a block into another block by clicking the Add Block link at the bottom of the block bar 
or by dragging a block into another block on the Pages page.

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For details, see Contact us, 
page 50.

 

You can include a child block only into a block that is empty or contains other child blocks (you cannot 
mix blocks and pages in a block.)

 Only two levels of block hierarchy are allowed, that is you cannot include a block into a child 
block.

 

Parent and child block drop-down menus
When using the parent and child block drop-down menus, the blocks’ levels of hierarchy are taken into 
account. This way the parent block menu differs from the child block menu by the following:
• The Add Block option in the parent block menu adds a block after the current parent block. The 

Add Block option in the child block menu adds another child block after the current one.
• The Add Block Rotation and Add Block Randomization options are available in the parent 

block menu. The Add Page Rotation and Add Page Randomization options are available in the 
child block menu.

Blocks within blocks representation in survey designer
In the survey designer, you cannot view a parent block, only its child blocks. You can open the parent 
block in the Pages page by clicking the link with the parent block’s name placed above the child blocks’ 
name in the survey content area header.
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Export Visible Questions
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Pages tab. Survey 
Completed end page.

You can allow respondents to view, print, or email the survey they took. After completing a survey, 
respondent is presented with a survey version where only the questions asked to this particular 
respondent are visible. The questions that are hidden or not asked of the respondent (due to different 
conditions, piping, and so on) are not shown in the report.
To display the exact respondent answers, you need to configure the survey end page. On the Pages tab, 
open the Survey Completed end page. This page appears when a respondent completes and submits 
the survey.
In the Survey Completed dialog box, define the following options:
• Select the Display Respondent Answers option in the Behavior list to allow the respondents 

to view only their own responses after completing a survey.
• Select the Allow the respondent to print and email this page check box to allow the 

respondents to print and email only their own responses. With this check box selected, 
respondents will see the Email this Report and Send to Printer links after completing a survey.

Email a Taken Survey

Procedure 
1 After you completed a survey, your survey responses display.
2 Click the Email this Report link. The following dialog box opens.
3 Enter the email address of this report recipient.
4 Click OK. The report is sent.

 It takes some time for the report to be delivered.

Print a Taken Survey

Procedure 
1 After you have completed a survey, your survey responses display.
2 Click the Send to Printer link.
3 Set up your print options, and then click Print. The report is printed.
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Survey Formatting Tab
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Formatting tab. 

The Formatting tab of your survey designer provides a number of options to control how your survey 
appears when published. You can select the survey theme, define the survey buttons, tag line, and 
progress bar, and set the survey title visibility and the Web accessibility options. The Formatting tab is 
available on the left-hand side of the Design view.
The survey formatting properties are divided into the following sections:
• Formatting, page 409
• Buttons, page 410
• General, page 411
• Progress Bar, page 411
• Web Accessibility, page 412

 You can view any formatting changes you make to your survey in the right preview pane 
immediately.

Formatting
In the Formatting section, you can select the survey theme, edit the survey title, and decide on the 
survey title visibility.

Survey Theme
Select a theme from the Survey Theme drop-down list. Themes help you to change the look and feel of 
your survey. You can use a wide variety of predefined themes or create your own custom theme. For 
more information on survey themes, see Survey themes, page 1288.

Survey Title
Enable the Show option to display the survey name to respondents. You can edit the current survey 
name in the provided text box. The font and text size of the survey title is controlled by specifications of 
the selected theme. To change the appearance of the survey title however, you may insert HTML tags 
directly in the text box. You can change a font color, size, alignment, and so on. For example, to center the 
survey title, type the following text:
<center>Survey Title</center>

Survey Language
Change your survey language to any other language by using the Survey Language drop-down list on 
the Formatting tab. So, if you want to create a survey in a different language, you can change the 
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default language on a per survey basis and do not need to change your account settings.

Survey Rendering
Select how you want the survey to be rendered from the Survey Rendering drop-down list. Switching 
between survey rendering modes might impact the availability of certain features. Code Blocks and Web 
Services may no longer be compatible. For more information, see Survey rendering overview, page 414.
The following options are available:
• Classic – Select this mode to support your previous ongoing or customized surveys.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

• Modern – Select this mode to support multi-device rendering so you can create a survey once for 
any device. With the Modern rendering, surveys work across all screen sizes automatically.

 Switching a survey from Classic to Modern survey rendering mode may impact your custom 
survey themes.

Buttons
In the Buttons section, you can select the buttons you want to display in your survey and edit default 
text of your survey buttons.
• Reset – Delete all answers respondents provide on the current page and reload the page.
• Back – Take respondents to the previous survey page. The entered answers are saved.

 The Preselected Values are saved if respondents have changed their answers.

• Save – Allow respondents to save the survey results and continue the survey later. For the 
Generate Link surveys, when the respondents click Save, a page appears with a new link for 
them to access the saved survey.

• Jump – Allow respondents to jump to a specific page in the survey. You can select whether to 
display page name, number, or both by selecting the corresponding option. Upon clicking this 
button, respondents are presented with a list of all pages of the survey, from which they can 
navigate forwards and backwards inside the survey. This will allow respondents to access any 
page in the survey regardless of branching. It will allow them to enter data that might be invalid if 
branching rules were followed. The Validate Record functionality in Manage Responses needs 
to be used to validate responses in this case.

 If you add a page block to your survey, the Jump button is disabled.

• Next – Take respondents to the next survey page. The entered answers are saved.
• Submit – Take respondents to the Survey Completed end page.

 The Submit and Next buttons appear automatically in the survey.
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To edit default text of your survey buttons, click the Edit Button Labels link. The Messages and 
Labels tab opens where you can change button names in the provided text boxes.

General
In the General section, you can select the tag line you want to appear in your survey. The survey tag line 
is text that appears at the bottom of every page of your survey.
You can select the default survey tag line or add your own text and custom link. To create a link, use 
HTML tags. For example, to create the Click here link, type the following text:
<a href="http://www.example.com">Click here</a>

Progress Bar
In the Progress Bar section, you can select how you want the progress bar to appear in your survey. The 
progress bar appears at the bottom of every page of your multipage survey and shows the respondents 
their progress through the survey.
• Show Progress Indicator – Select to show respondents the amount of survey completed as a 

progress indicator.

• Show Progress Percent – Select to show respondents the amount of survey completed as 
progress percent. Use this option together with the Show Progress Indicator functionality.

• Show Page Number – Select to show respondents the amount of survey completed as page 
numbers.

Define text for the page numbers in your survey in the text box under Show Page Number. The default 
value is Page %1 of %2, where %1 is a placeholder for the current page the respondent is on and %2 is a 
placeholder for the total number of pages in the survey.



Designing Your Survey Overview Survey Formatting Tab

EFM User Guide 412

Confidential and Proprietary Information of Verint Systems Inc.

Appearance
Select how you want the progress bar to appear in the survey from the Appearance drop-down list.
In Classic survey rendering, the available options are discrete and continuous.
• Discrete – Progress bar is broken down into smaller pieces.
 

• Continuous – Progress bar is a one long rectangle.
 

In Modern survey rendering mode, the available options are default, striped bar, and striped bar with 
animation.
• Default – Progress bar is a one long rectangle.

• Stripped Bar – Progress bar with lines of color.

• Stripped Bar with Animation – Progress bar with lines of color and animation.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Web Accessibility
The Web Accessibility section is available only in classic survey rendering mode. In the Web 
Accessibility section, you can apply the Web accessibility options to your survey by selecting the Use 
fieldset tags check box. It groups the question elements together, resulting in a border around the 
question. When you generate the survey HTML, label tags and title attributes are created by default. 
These options allow the generation of 508 Compliant HTML that conforms to Web form guidelines for 
users with disabilities.
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Survey language
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Formatting tab > Survey 
Formatting pane > Survey Language list.

You can change your survey language to any other language by using the "Survey Language" drop-down 
list on the Formatting tab. So, if you want to create a survey in a different language, you can change the 
default language on a per survey basis and do not need to change your account settings.
In the "Survey Language" list, the survey languages are divided into two groups:
• Language Pack Support – This group includes the survey languages that are supported by the 

system language packs. A language pack contains the default validation messages, labels, and end 
pages of the survey in a certain language and is applied to your survey automatically.

• Additional Translation Required – This group includes all languages, except the languages 
supported by the system language packs. You need to translate the validation messages, labels, 
and end pages of your survey into the selected language.

When you change the survey language, the validation messages, labels, and end pages in your survey are 
updated accordingly. You can select to keep any changes you have made to the validation messages, 
labels, and end pages or discard the changes.

 Survey Formatting pane opens where you can access the Survey Language  list.

Procedure 
1 Create a survey or open a saved survey on the Surveys tab. The Design tab opens.
2 Click the Formatting tab on the left panel. The Survey Formatting pane opens.
3 From the "Survey Language" drop-down list, select the language you want to apply to your survey. 
4 To keep any changes you have made to the validation messages, labels, and end pages, click Keep my 

changes. To use the default validation messages, labels, and end pages in your survey, click Discard 
my changes.
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Survey rendering overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Formatting tab > Survey 
Formatting pane > Survey Rendering list.

Modern survey rendering
A Modern survey rendering supports multi-device rendering so you can create a survey once for any 
device. This ensures that respondents have an optimum survey taking experience, independent of the 
device that they use. With the Modern survey rendering, surveys work across all screen sizes 
automatically and have a modern look and feel.
The following features are specific for the Modern survey rendering only:
• Least filled choices
• Least filled criteria
• Blocks within blocks
• Block conditional visibility
• Image Upload question
• Conditional preselection
• Count placeholders
• Export value placeholders
• Matrix (Choose One and Choose Many) topic count criteria
• Multiple-campaign surveys (the exception is Offline Device campaign that can be added to 

Generate Link surveys in Classic rendering)

 You cannot change the survey rendering mode from Modern to Classic if the survey contains 
Empty Blocks, Blocks within Blocks, or Image Upload question. If you change your rendering 
mode to Classic, Code Blocks and Web Services might become unusable and customized Survey 
Themes might need updating and testing.

The following are advantages of using the Modern survey rendering:
• Possibility to clear the previously selected radio buttons
• Image placeholder for the Choose One with Image and Choose Many with Image questions 

if the image is not yet provided
• Hint text for the Email Address, Whole Number, Real Number, Social Security Number, ZIP 

Code, and ZIP+4 Code input types in the Fill in the Blank question so that the respondent 
knows how to answer the question

• Instructions option for question text
• Small and large images support in the Choose One with Image and Choose Many with Image 

questions
• Please Specify option support in Drop-down Box and List Box for a Choose One question
• Enhanced and more intuitive question appearance
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• Improved validation error highlighting
• Improved accessibility
• Improved respondent experience
The following functionality is not available in the Modern survey rendering:
• Text Box Width (in characters) for Fill in the Blank, Short Answer, Essay, and Matrix with a 

Short Answer side
• Slider Width (in pixels) for a Scale Slider question
• Advanced table properties, Summary for the Rank Order and Matrix questions
• Formatting > Web Accessibility
• Properties > Generate Mobile HTML
• Advanced > Edit HTML
Code Blocks and Web Services may no longer be compatible.

Survey Themes
Switching a survey from Classic to Modern survey rendering mode may impact your custom survey 
themes. If you have customized survey themes and want to start using them with the new Modern 
survey rendering, your customized survey themes will need to be tested with and most likely updated for 
the new Modern rendering due to the enhanced rendering capabilities.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Code Block Best Practices
When working with code blocks in Modern survey rendering mode, be sure to follow these best practices:
• HTML content of survey questions may change from version to version without a publish from 

the author.
• IDs will probably be safe between versions.
• Using methods like .parent() to walk the DOM structure is strongly advised against.
• Do not rely on any undocumented client-side methods or libraries used by the survey as they may 

change from version to version without a publish from the author.

 For both Modern and Classic renderings, to avoid entering the insecure code when taking a 
survey, on the General Setup page, select the Automatically remove untrusted code from 
survey designer check box.

Classic survey rendering support
Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. If you 
belong to a workgroup created in EFM 15.1 FP3 or later versions, you use only Modern survey rendering.
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 Profiles are still rendered in Classic survey rendering only.

If you are an existing user that upgrades to the EFM 15.1 FP3, the Classic survey rendering works as 
usual.

 In the future EFM releases, Classic survey rendering will not be supported.
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Jump button
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Formatting tab > Survey 
Formatting pane.

Upon clicking the Jump button, you are presented with a list of all pages of the survey, from which you 
can navigate forwards and backwards inside the survey (in a Panel survey, no questions should appear 
on page one of the survey). The page value contains the hyperlink, which when clicked, will "jump" the 
respondent to the selected page. You can also select whether to display page name, number, or both by 
selecting the corresponding option. 

 If you add a page block to your survey, the Jump button is disabled.
You can display Page Name and Number in Modern survey rendering only.

If participants change their mind, they can click Close and continue the survey as usual.
If you add branching criteria to your survey, respondents can skip to other pages in the survey. They can 
skip to a location in the survey where their previous answers should not have been allowed, due to skip 
patterns either by Advanced Branching logic (see Branching Tab, page 441) or by setting a Destination 
statement under the Properties Panel (see Properties Panel, page 1) defined in the survey. You can use 
Validate Record or Validate All Records under Analyze > View Responses > Actions drop-down 
menu that will validate the data based on the skip patterns that are defined in the survey. If a participant 
should not have seen the question, their responses to these skipped questions will be replaced with the 
Not Asked value for reporting purposes.
If you plan on using the Validate Records function in the product, the following additional restrictions 
on branching must be adhered to, otherwise unintended data deletion may occur.
• The advanced branch checkpoint question must be the last question on a page.
• A question that has basic branching in it must be the last question on a page.
• The target question of a branch must be the first question on a page.
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Messages and Labels tab
Navigation

Design and Collect tab > Surveys tab > My Surveys page > Design view > Labels tab.

On the Labels tab, you can view and edit the button, question, and survey results' labels and validation 
messages. As long as you can edit the message text, the variable information (%Q, %1, or %2) in the 
message should remain. The %Q bookmark displays the question heading or topic label, while the %1 and 
%2 bookmarks display the lower and upper character count for topics of text type or number range for 
topics of number type. Keep in mind that the whole survey is updated when you make changes on the 
Labels tab.
You can access the Labels tab from the left pane of the Design view.
You can filter all of your survey labels and messages by the following categories:
• Show Everything – View and edit all the potential messages and labels in all the categories.
• Button Labels – View and edit all the button labels in your survey, for example, Next or Submit.
• Question Labels – View and edit all the validation messages depending on the question type, for 

example, "Hide Answers" or "Drag here."
• Validation Messages – View and edit all the general validation messages in your survey, for 

example, "Choose date from calendar."
• Respondent Survey Results' Labels – View and edit all the labels that are displayed to the 

respondents when they are provided with the survey results, for example, "Your responses are 
highlighted in the results below."

 You cannot use the HTML for writing labels and messages.
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Translation module overview
Navigation

Design and Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Translation tab.

In the translation module you can do the following:
• Translate the survey, page 426.
• Translations import and export , page 429 to different file formats.
• Add mappings to the survey, page 428. For more information, see Translation Mappings, 

page 427.
• View the translation progress for each language.
• Mark the outdated translations.
• Switch the translation view between All Pages and Separate Pages.
After creating the original survey in a survey designer, you can translate it into multiple languages to 
deploy it to a global audience. You can translate the questionnaire, validation messages, labels, end pages, 
page names. Additionally, each time you edit a translation, your work is saved automatically to reduce the 
risk of data loss. 
The Translation tab is available on the left panel in the survey designer.

 To go back to the survey designer, click the Return link in the upper-left corner of the page.
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Language Packs
Navigation

Design and Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> to view the messages and labels of your survey, click the Labels tab > to view the messages and labels of 
your translation, click Translation tab.

Language packs are used to update the default validation messages, labels, and end pages of your survey 
to the currently selected survey language.
Language pack is an XML file, which contains the default validation messages, labels (including progress 
bar and scoring labels), and end pages of the survey in a certain language. When you create a new survey 
or change the language of your survey, the language pack is automatically applied to your survey in the 
closest matching language. In addition, when you translate your survey, the corresponding language 
packs are applied to the source language and target language of your translation automatically.
Thus, you do not need to translate the validation messages, labels, and end pages of your survey if the 
language pack is available for the selected language. For example, if you create your survey in French, the 
validation messages, labels, and end pages of the survey appear in French automatically.
If you translate your survey from French into English, for example, the French and English language packs 
are applied to your base language and your translation accordingly.
Language packs are stored on the Library tab on the Language Packs side tab. There are default 
(system) language packs and language packs imported by the users. Default language packs are locked 
and cannot be deleted or replaced. Language packs imported by the users are not locked. Default 
language packs are shared across the application while the user's language packs are shared within the 
workgroup only
For details on importing and exporting the language packs, see Import and export language packs, 
page 422.
Default language packs support the languages available for the EFM application interface. Currently, the 
EFM application supports 11 default language packs:
• Chinese (Simplified)
• English
• French
• German
• Italian
• Japanese
• Portuguese (Brazil)
• Portuguese (Portugal)
• Russian
• Spanish
• Thai
In the application, the following preference is used for applying a language pack:
1 Check all workgroup language packs to match the base culture exactly.
2 If there is no language pack, check all default language packs to match the base culture exactly.
3 If there is no language pack, check all workgroup language packs for the closer matching.
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4 If there is no language pack, check all default language packs for the closer matching. 
5 If there is no language pack, apply the same language pack as for the application interface.
You can manage the language packs by using the corresponding options on the toolbar:
• Import and export language packs, page 422
• Delete a language pack, page 423 

 Since the system language packs are locked , you cannot delete them.



Designing Your Survey Overview Import and export language packs

EFM User Guide 422

Confidential and Proprietary Information of Verint Systems Inc.

Import and export language packs
Navigation

Library tab > Language Packs tab.

You can export, import, and delete the language packs on the Language Packs side tab of the Library 
tab. A language pack contains default validation messages, labels, and end pages of the survey in a certain 
language and is applied to your survey automatically.

 For more information about the language packs, see Language Packs, page 420.

Procedure 
1 Import a language pack:

a. On the Language Packs side tab, click the Import button on the toolbar.
b. In the Upload Language Pack dialog box, select the language, for which you want to upload a 

new language pack.
 

c. Select the Show regional variations for each language check box to view the variations for all 
languages in the drop-down list. For example, for the Italian language, the Italian (Italy) and Italian 
(Switzerland) variations appear.

d. Click Browse and locate a file that you want to upload, and then click Open.

 You can import an XML file only.

e. Click Add.
The Upload Language Pack dialog box remains open so that you can add more language packs.

f. Click Close.
2 Export a language pack:

a. On the Language Packs side tab, select the check box next to the language pack that you want 
to export.

 You can export one file at a time only.

b. Click the Export button on the toolbar.
c. In the Export Language Pack dialog box, click Export. The exported file is generated in the XML 

file format.
d. Click the link to download the exported file.
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Delete a language pack
Navigation

Library tab > Language Packs tab.

Procedure 
1 On the Language Packs tab, select the check box next to the language pack that you want to delete.

 You cannot delete the system language packs.

2 Click the Delete button on the toolbar.
3 In the confirmation dialog box, click Delete.
For more information about language packs, see Language Packs, page 420 and Import and export 
language packs, page 422.
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Translation page
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one from the My Surveys 
grid > Translation tab > Languages section.

After you click any of the added languages, the corresponding translation page opens, where you can 
translate the survey questions, end pages, validation messages, and labels. This page contains the 
following tabs:
• Questions – Text of the survey including questions, instructions, response options, section 

headings, and prefilled text for the Fill in the Blank questions.

 To avoid entering the insecure code into your survey, on the GeneralSetup page, select the 
Automatically remove insecure code from survey designer check box. For more 
information, see General Setup, page 1406.

• End Pages – Text of the end pages in your survey, such as Survey Saved, Survey Closed, 
Quota Reached, Prevent Updates, and Survey Submitted.

• Validation Messages – Text of the messages that appears to a respondent if the answer does 
not meet the specific limitations and conditions applied to the question.

• Labels – Text of the buttons (for example, Next, Save, or Submit) in your survey, title of the 
survey, text on the progress bar, and passing and failing messages for surveys with scoring.

 The validation messages, labels, and end pages of your survey are translated for you if the 
language pack is available in the application for the selected language. For more information 
about language packs, see Language Packs, page 420.

You can use the pagination bar to navigate through your survey translation and switch the translation 
view between View All Pages and View Separate Pages.

 To preview the translated survey, click Preview on the survey designer toolbar, and then click the 
necessary language in the Language  list.

Also, in the right pane of the translation page, you can do the following:
• View the survey source (base) language in the left pane and the target (translation) language in the 

right pane. To switch between the translations, click the translation that you want from the 
Language  list.

• Translations import and export , page 429.
• View statistics associated with your survey translation by clicking the Statistics link. The 

summary shows the progress of your survey translation based on the words and phrases. Details 
for each language are listed separately.
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Language Selection page
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one from the My Surveys 
grid > Translation tab > Languages section.

In the Options section, you can manage the Language Selection page. Click Edit to open the 
Language Selection Page Designer, where you can create a page for the multilingual surveys where 
participants can select a language to take a survey.
You can also use the following options:
• Let the user manually select the survey language – Select to show the language selection 

page to your respondents each time they take a multilingual survey, regardless of the web 
browser's default language.

• Include country flags – Select to show the country flags according to the chosen languages on 
the language selection page (in Modern survey rendering only). 

You can also change the default country flag by clicking it, and then uploading the needed image from 
your computer.

 The uploaded image is shrunk to the size of the default flags only in the Language Selection 
Page Designer. For the respondents (on the language selection page), it is shown in its actual 
size.

In Modern survey rendering, the %Languages% placeholder includes all languages selected in the right 
pane.
In the right pane, you can select the check boxes next to the languages that you want to display on the 
language selection page. By default, all languages specified in the Languages section are selected. You 
can change their order by dragging them, and you can edit the language text as needed.

 To avoid entering the insecure code into Language Selection Page Designer, on the General 
Setup page, select the Automatically remove insecure code from survey designer check 
box. For more information, see General Setup, page 1406.

In Classic survey rendering, the Language Links right pane includes the links to each translated version 
of your survey. To add a language to the page, double-click that language or select the needed language, 
and then click the Insert Link button.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.
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Translate the survey
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one from the My Surveys 
grid > Translation tab > Languages section.

While translating your survey, you can use the editing toolbar to format your translation text. In addition, 
you can mark an item as translated if it sounds the same in the target language, for example.
The translated text appears in black while the untranslated text appears in red. If you make any changes 
in the base language, the corresponding text in your translation is marked in gray and has the Out of 

Date icon   next to it. This functionality helps you to identify the changes and make any edits to your 
translation, if required. You can view the list of the outdated elements for the currently selected 
translation in the Translations Out Of Date  menu.

 The Out Of Date functionality does not apply to the images.

Procedure 
1 Add translation languages:

a. On the Translation tab, in the Languages section, click the Add Language button.
b. In the Select the language to add dialog box, select the needed language, and the click OK.

 You can also add the translation language by using the Language option in the Actions  menu 
on the survey designer toolbar.

 

 To delete the survey translation with all its content, click Delete  next to the translation 
language you want to delete.

2 Translate your survey:
a. In the Translation pane, from the Languages list, click the needed language.
b. On the Translation page, click the text that you want to translate. The text becomes editable.
You can view the progress for each translation in the Languages section.

3 Translate the text, and then move to the next item. The translated text becomes black. 
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Translation Mappings
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one from the My Surveys 
grid > Translation tab > Mappings section.

You can assign multiple languages to your survey translation so that you do not need to translate your 
survey for the similar languages. When the survey is first accessed, it appears to participants in their Web 
browser's preferred language. You can use mappings to manually assign languages to specific survey 
translations. For example, you can set up mappings to direct the French survey participants from France 
and Canada to your survey in French.
You can map languages to translations on the Translation tab in the survey designer. For details, see 
Add mappings to the survey, page 428.

 If you make any changes to your survey in v5 of the EFM application, the language mappings are 
lost.

After determining the web browser's default language, the application uses the following preference to 
direct a survey participant to a survey in a certain language:
1 Check all translation languages to match the web browser's default language exactly.
2 If there is no translation, check all mapped languages to match the web browser's default language 

exactly.
3 If there is no translation, check all translation languages not taking into account the regional code 

(Spanish-MX -> Spanish).
4 If there is no translation, check all mapped languages not taking into account the regional code.
5 If there is no translation, present the survey in the base language.

 If you configure the language selection page for your participants, it has the highest priority for 
determining a survey language.
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Add mappings to the survey
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one from the My Surveys 
grid > Translation tab > Mappings section.

You can map languages to translations on the Translations tab in the survey designer. For more 
information about mappings, see Translation Mappings, page 427.

Procedure 
1 On the Translation tab, click the Mappings section to expand it.
2 Click Add Mapping.
3 In the Map Languages to Translations dialog box, select a survey translation to which you want to 

assign the languages.
4 Select the check box next to the languages that you want to associate with the specified translation.
5 Click Apply.



Designing Your Survey Overview Translations import and export

EFM User Guide 429

Confidential and Proprietary Information of Verint Systems Inc.

Translations import and export 
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one from the My Surveys 
grid > Translation tab > Import or Export link.

You can export your translations into the .xlsx, .csv, .xlf, or .zip file formats, and then import them back 
to the EFM application. With the new file formats, you can quickly and easily combine translations from 
external translators and upload them to the EFM application. You can export and import multiple 
translations. After importing the translation, you can still make the changes. For faster uploading, 
compress your files to a .zip archive. The contents of the .zip file is scanned before extraction to check 
whether it contains the supported file formats. You can export and import the questionnaire, validation 
messages, labels, end pages, and page names. In Excel files, these sections are placed on the separate 
worksheets.

 To avoid importing or exporting translations that contain the insecure code, on the General 
Setup page, select the Automatically remove insecure code from survey designer check 
box. For more information, see General Setup, page 1406.

 

 It is recommended that you import the content exported from the current survey only. 
Importing other surveys or content in an invalid format may cause some issues in your survey.

 

 You can give a user the permission only to view and import translations by selecting 
Administration > Roles > Group Administration > LibraryItems > Translate check box.

Procedure 
1 Import the translation:

a. On the translation page, click Import in the upper-left corner.
b. In the Import Translations dialog box, click Browse, and then locate the needed file.
c. Click Next.
d. Click Import.

 If you try to import a translation again, the list of translations to be overwritten appears in the 
dialog box.

2 Export the translation:
a. On the translation page, click Export in the upper-left corner.
b. In the Export Translations dialog box, select the needed file format.
c. To compress the file to a .zip archive, select the Create zip archive check box.
d. Click Next.
e. Click the file link to download the exported file, and then click Close.
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Preview the translated survey
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one from the My Surveys 
grid > Translation tab > Preview button > Language menu.

To ensure that the translated text will look properly in a published survey, you can use the Preview option 
while designing your survey.

Before you begin 
• Verify that your survey is translated into at least one language.

Procedure 
1 On the My Surveys page, open the translated survey.
2 On the survey designer toolbar, click the Preview button, and then select the needed language from 

the Language drop-down menu.
The translated survey appears in Preview mode.
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Culture code table
You can identify the correct culture for the language you are currently using to import users or work with 
translations.
For a list of language/culture names, see the Culture code table below.

Language/Region Culture name

Afrikaans - South Africa af-ZA

Albanian - Albania sq-AL

Alsatian - France gsw-FR

Amharic - Ethiopia am-ET

Arabic - Algeria ar-DZ

Arabic - Bahrain ar-BH

Arabic - Egypt ar-EG

Arabic - Iraq ar-IQ

Arabic - Jordan ar-JO

Arabic - Kuwait ar-KW

Arabic - Lebanon ar-LB

Arabic - Libya ar-LY

Arabic - Morocco ar-MA

Arabic - Oman ar-OM

Arabic - Qatar ar-QA

Arabic - Saudi Arabia ar-SA

Arabic - Syria ar-SY

Arabic - Tunisia ar-TN

Arabic - U.A.E. ar-AE

Arabic - Yemen ar-YE
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Language/Region Culture name

Armenian - Armenia hy-AM

Assamese - India as-IN

Azerbaijani - Azerbaijan (Cyrillic) az-Cyrl-AZ

Azerbaijani - Azerbaijan (Latin) az-Latn-AZ

Bangla (Bangladesh) bn-BD

Bangla - India (Bengali Script) bn-IN

Bashkir - Russia ba-RU

Basque - Basque eu-ES

Belarusian - Belarus be-BY

Bosnian - Bosnia and Herzegovina (Cyrillic) bs-Cyrl-BA

Bosnian - Bosnia and Herzegovina (Latin) bs-Latn-BA

Breton - France br-FR

Bulgarian - Bulgaria bg-BG

Burmese - Myanmar my-MM

Catalan - Catalan ca-ES

Central Atlas Tamazight (Latin) - Algeria fr-FR

Central Atlas Tamazight (Latin) - Algeria tzm-Latn-DZ

Central Atlas Tamazight (Tifinagh) - Morocco tzm-Tfng-MA

Central Kurdish (Iraq) ku-Arab-IQ

Cherokee (Cherokee, United States) chr-Cher-US

Chinese - PRC zh-CN

Chinese - Taiwan zh-TW

Corsican - France co-FR

Croatian - Bosnia and Herzegovina hr-BA
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Language/Region Culture name

Croatian - Croatia hr-HR

Czech - Czech Republic cs-CZ

Danish - Denmark da-DK

Dari - Afghanistan prs-AF

Divehi - Maldives dv-MV

Dutch - Belgium nl-BE

Dutch - Netherlands nl-NL

Dzongkha dz-BT

English - Australia en-AU

English - Belize en-BZ

English - Canada en-CA

English - Caribbean en-029

English - India en-IN

English - Ireland en-IE

English - Jamaica en-JM

English - Malaysia en-MY

English - New Zealand en-NZ

English - Philippines en-PH

English - Singapore en-SG

English - South Africa en-ZA

English - Trinidad en-TT

English - Great Britain en-GB

English - United States en-US

English - Zimbabwe en-ZW
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Language/Region Culture name

Estonian - Estonia et-EE

Faroese - Faroe Islands fo-FO

Filipino - Philippines fil-PH

Finnish - Finland fi-FI

French - Belgium fr-BE

French - Canada fr-CA

French - France fr-FR

French - Luxembourg fr-LU

French - Monaco fr-MC

French - Switzerland fr-CH

Frisian - Netherlands fy-NL

Fulah (Latin, Senegal) ff-Latn-SN

Galician - Galician gl-ES

Georgian - Georgia ka-GE

German - Austria de-AT

German - Germany de-DE

German - Liechtenstein de-LI

German - Luxembourg de-LU

German - Switzerland de-CH

Greek - Greece el-GR

Greenlandic - Greenland kl-GL

Guarani - Paraguay gn-PY

Gujarati - India (Gujarati Script) gu-IN

Hausa (Latin) - Nigeria ha-Latn-NG
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Language/Region Culture name

Hawaiian - United States haw-US

Hebrew - Israel he-IL

Hindi - India hi-IN

Hungarian - Hungary hu-HU

Icelandic - Iceland is-IS

Igbo - Nigeria ig-NG

Inari Sami - Finland smn-FI

Indonesian - Indonesia id-ID

Inuktitut (Latin) - Canada iu-Latn-CA

Inuktitut (Syllabics) - Canada iu-Cans-CA

Irish - Ireland ga-IE

isiXhosa / Xhosa - South Africa xh-ZA

isiZulu / Zulu - South Africa zu-ZA

Italian - Italy it-IT

Italian - Switzerland it-CH

Japanese - Japan ja-JP

Javanese (Latin) - Indonesia jv-Latn-ID

Kannada - India (Kannada Script) Kannada - India (Kannada Script)

Kazakh - Kazakhstan kk-KZ

Khmer - Cambodia km-KH

K'iche - Guatemala qut-GT

Kinyarwanda - Rwanda rw-RW

Konkani - India kok-IN

Korean(Extended Wansung) - Korea ko-KR
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Language/Region Culture name

Kyrgyz - Kyrgyzstan ky-KG

Lao - Lao PDR lo-LA

Latvian - Legacy lv-LV

Latvian - Standard lv-LV

Lithuanian - Lithuania lt-LT

Lower Sorbian - Germany dsb-DE

Lule Sami - Norway smj-NO

Lule Sami - Sweden smj-SE

Luxembourgish - Luxembourg lb-LU

Macedonian - F.Y.R.O.M mk-MK

Malay - Brunei ms-BN

Malay - Malaysia ms-MY

Malayalam - India (Malayalam Script) ml-IN

Maltese - Malta mt-MT

Maori - New Zealand mi-NZ

Mapudungun - Chile arn-CL

Marathi - India mr-IN

Mohawk - Mohawk moh-CA

Mongolian (Cyrillic) - Mongolia mn-MN

Mongolian (Mongolian) - Mongolia mn-Mong-MN

Mongolian (Mongolian – PRC – Legacy) mn-Mong-CN

Mongolian (Mongolian– PRC – Standard) mn-Mong-CN

N'ko – Guinea nqo-GN

Nepali - Federal Democratic Republic of Nepal ne-NP
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Language/Region Culture name

Northern Sami - Finland se-FI

Northern Sami - Norway se-NO

Northern Sami - Sweden se-SE

Norwegian - Norway (Bokmål) nb-NO

Norwegian - Norway (Nynorsk) nn-NO

Occitan - France oc-FR

Odia - India (Odia Script) or-IN

Pashto - Afghanistan ps-AF

Persian fa-IR

Polish - Poland pl-PL

Portuguese - Brazil pt-BR

Portuguese - Portugal pt-PT

Punjabi - India (Gurmukhi Script) pa-IN

Punjabi (Islamic Republic of Pakistan) pa-Arab-PK

Quechua - Bolivia quz-BO

Quechua - Ecuador quz-EC

Quechua - Peru quz-PE

Romanian - Romania ro-RO

Romansh - Switzerland rm-CH

Russian - Russia ru-RU

Sakha - Russia sah-RU

Sanskrit - India sa-IN

Scottish Gaelic - Great Britain gd-GB

Serbian - Bosnia and Herzegovina (Cyrillic) sr-Cyrl-BA
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Language/Region Culture name

Serbian - Bosnia and Herzegovina (Latin) sr-Latn-BA

Serbian - Montenegro (Cyrillic) sr-Cyrl-ME

Serbian - Montenegro (Latin) sr-Latn-ME

Serbian - Serbia (Cyrillic) sr-Cyrl-RS

Serbian - Serbia (Latin) sr-Latn-RS

Serbian - Serbia and Montenegro (Former) (Cyrillic) sr-Cyrl-CS

Serbian - Serbia and Montenegro (Former) (Latin) sr-Latn-CS

Sesotho sa Leboa / Northern Sotho - South Africa nso-ZA

Setswana / Tswana - Botswana tn-BW

Setswana / Tswana - South Africa tn-ZA

Shona – Zimbabwe sn-Latn-ZW

Sindhi (Islamic Republic of Pakistan) sd-Arab-PK

Sinhala - Sri Lanka si-LK

Skolt Sami - Finland sms-FI

Slovak - Slovakia sk-SK

Slovenian - Slovenia sl-SI

Southern Sami - Norway sma-NO

Southern Sami - Sweden sma-SE

Spanish - Argentina es-AR

Spanish - Bolivarian Republic of Venezuela es-VE

Spanish - Bolivia es-BO

Spanish - Chile es-CL

Spanish - Colombia es-CO

Spanish - Costa Rica es-CR
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Language/Region Culture name

Spanish - Dominican Republic es-DO

Spanish - Ecuador es-EC

Spanish - El Salvador es-SV

Spanish - Guatemala es-GT

Spanish - Honduras es-HN

Spanish - Latin America es-419

Spanish - Mexico es-MX

Spanish - Nicaragua es-NI

Spanish - Panama es-PA

Spanish - Paraguay es-PY

Spanish - Peru es-PE

Spanish - Commonwealth of Puerto Rico es-PR

Spanish - Spain (International Sort) es-ES

Spanish - Spain (Traditional Sort) es-ES_tradnl

Spanish - United States es-US

Spanish - Uruguay es-UY

Standard Moroccan Tamazight - Morocco zgh-Tfng-MA

Swahili - Kenya sw-KE

Swedish - Finland sv-FI

Swedish - Sweden sv-SE

Syriac - Syria syr-SY

Tajik - Tajikistan tg-Cyrl-TJ

Tamil - India ta-IN

Tamil - Sri Lanka ta-LK
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Language/Region Culture name

Tatar – Russia (Legacy) tt-RU

Tatar – Russia (Standard) tt-RU

Telugu - India (Telugu Script) te-IN

Thai - Thailand th-TH

Tibetan - PRC bo-CN

Tigrinya (Eritrea) ti-ET

Tigrinya (Ethiopia) ti-ET

Turkish - Turkey tr-TR

Turkmen - Turkmenistan tk-TM

Ukrainian - Ukraine uk-UA

Upper Sorbian - Germany hsb-DE

Urdu – India ur-IN

Urdu (Islamic Republic of Pakistan) ur-PK

Uyghur - PRC ug-CN

Uzbek - Uzbekistan (Cyrillic) uz-Cyrl-UZ

Uzbek - Uzbekistan (Latin) uz-Latn-UZ

Valencian - Valencia ca-ES-valencia

Vietnamese - Vietnam vi-VN

Welsh - Great Britain cy-GB

Wolof - Senegal wo-SN

Yi - PRC ii-CN

Yoruba - Nigeria yo-NG



Designing Your Survey Overview Branching Tab

EFM User Guide 441

Confidential and Proprietary Information of Verint Systems Inc.

Branching Tab
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Branching tab.

Branching allows you to customize the survey so that individual respondents only see specific sections of 
the survey based on how they answer certain questions in your survey. With advanced branching, you can 
create surveys that change their behavior based on the input of a respondent. Therefore, you can set one 
or more logic rules that are considered when a respondent answers questions in a survey.
Branching requires that questions be separated by page breaks. Specifically, in order to branch to a 
certain question based on responses to previous questions, the target question must be separated from 
the previous questions by at least one page break.
If you plan on using the Validate Records function in the product, the following additional restrictions on 
branching must be adhered to, otherwise unintended data deletion may occur.
• The advanced branch checkpoint question must be the last question on a page.
• A question that has basic branching in it must be the last question on a page.
• The target question of a branch must be the first question on a page.
You can easily access the advanced branching functionality from the Branching tab in the left pane of 
the survey designer.
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Adding Branching Criteria
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Branching tab > Add Branch 
button.

You can add branching criteria by using the Add Branch dialog box. To add new criteria, click the Add 
Another Criteria link. The drop-down lists appear, where you can specify the question, expression, and 
value.
The branching criteria can be based on more than one question. For example, a branch may contain 
criteria based on Question 1 (respondent gender) and Question 2 (respondent age). So, respondents who 
are both female and between the ages of 21 and 29 are branched to a question or series of questions 
related directly to them.
Under branching criteria designer, there is a Device Type criterion with the Desktop and Mobile values. 
You can use this criterion to branch based on the detected device type. By adding this branching criterion, 
you can set the path through your questions similarly to how you add branching logic to your survey. The 
Device Type criteria can be combined with other branching criteria.

 iPad and tablets are considered Desktop devices.

In Modern survey rendering mode, under branching criteria designer, there is a response count criterion 
with the values from 0 to the specific number of choices or columns in Choose Many, Matrix with 
Choose One or Choose Many sides, or Scrolling Matrix questions.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

You can add branching criteria to set the path through your questions based on the count of responses 
provided by the respondent. For example, if you want to branch to the appropriate question and in the 
branching criteria designer you specify that the response count criterion equals 2, the respondent is 
directed to the specified question, if the respondent's answers match the specified criterion.
The options for expression vary depending on the question type. For example, the Multiple Choice: 
Choose One questions support the following expressions:
• Equal To
• Not Equal To
• Less Than
• Greater Than
• Less Than Or Equal
• Greater Than Or Equal
The Fill in the Blank questions support the following expressions for text responses:
• Equal To
• Not Equal To
• Contains
• Does Not Contain
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• Begins With
• Ends With
For example, if you define the word "car" as a conditional branch phrase by selecting Contains and then 
typing the word "car," any respondent who enters the word "car" is branched to the appropriate 
question.
In the case where multiple criteria are needed, the order of each criterion determines the order they are 
applied in the survey. It is possible, for example, that one criterion may invalidate other criteria if it 
branches past questions that are referenced in other criteria.

Add Branch to the Survey

Procedure 
1 On the Design tab of the survey designer, click the Branching side tab.
2 On the Branching page, click Add Branch.

 You can also access the Add Branch dialog box by clicking the Add Branch link at the bottom of 
the survey designer page or by clicking the Add Branch option in the block or page drop-down 

menus  in the survey designer.

3 In the Branch Description field, enter the name or description of a particular branching rule. It will 
appear as a link to the Edit Branch dialog box in the survey designer. If no description is added, the 
default link name is Untitled.

4 In the destination drop-down list, select the survey question that will appear to the respondent when 
branching occurs.
If the page order in the block containing the destination page is changed from rotated or randomized 
to fixed, the destination becomes invalid, and the corresponding message is displayed in the Edit 
Branch dialog box and on the Branching page. Also, if the block containing the destination page 
becomes a child block, the branch becomes invalid, and the corresponding message is displayed in the 
Edit Branch dialog box and on the Branching page.

 The pages and questions that belong to the rotated or randomized blocks are not included in the 
destination drop-down list; such blocks appear as Block # End in the list. Also, no child blocks 
appear in the destination drop-down list, only the parent blocks they belong to.

5 To add branching criteria, click the Add Another Criteria link.
6 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select to apply branching criteria based on the survey questions or 
device type.

a. In the first drop-down list, click one of the following options to apply the logic to:
• The survey question
• The response count criterion with the values from 0 to the specific number of choices or 

columns in Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling 
Matrix questions

• The device type criterion
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 The device type and the response count criteria can be combined with other criteria for 
branching.

b. In the second drop-down list, click the expression.
c. In the third drop-down list, click one of the following:

• Question choice
• Number of responses provided by the respondent
• Detected type of device

 The values list includes the actual response options for the question. The choices are numbered 
in the same way as the survey designer. For the Fill in the Blank, Short Answer, Essay, Matrix 
with Short Answer or Essay sides questions, type in the expected response or leave the text 
box empty.

• Participant Information – Select to apply branching criteria to the campaign:
a. In the first list, Campaign Name is selected.
b. In the second list, click the expression.
c. In the third list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the 
Collect tab.

• Respondent Location – Select to apply branching criteria based on the location parameter:
a. In the first drop-down list, click the needed parameter.
b. In the second drop-down list, click the expression, and then type the needed value in the adjacent 

box.
7 To save a single criterion, click Save.
8 To add more criteria, click Add Another Criteria, and then add several criteria.

 You can combine criteria of all types.

9 Specify which criteria need to be met by selecting the corresponding Match options:
• All criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – Create the needed logical expressions using the drop-down lists with parentheses 

and the And/Or operators next to each criterion.
10 Click the link next to the This branch is evaluated after option. The link displays a question in the 

survey where the branch will be applied (check point). After clicking the link, the list with all the 
available survey questions appears. By default, the check point is set to the criteria question that is 
the furthest from the beginning of the survey.
If the block containing the branch check point is changed from rotated or randomized to fixed, the 
branch becomes invalid, and the corresponding message asking to select a question in the block is 
displayed in the Edit Branch dialog box and on the Branching page. Also, if the block containing the 
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branch check point becomes a child block, the branch becomes invalid, and the corresponding 
message is displayed in the Edit Branch dialog box and on the Branching page.

 The pages and questions that belong to the rotated or randomized blocks are not included in the 
list; such blocks appear as Block # Start in the list. For the surveys created in the previous 
versions of the EFM product, if a check point was set to Block End of a fixed block, it is 
automatically reset to the last question on the last page of the block. Also, no child blocks appear 
in the check point list, only the parent blocks they belong to.

11 From the list, select the survey question where you want the branch to be applied.
12 Click OK.
13 To save the whole set of branching criteria, click OK. The added criteria appear on the Branching 

page.

 All branches evaluated on the currently viewed page appear at the bottom of the survey designer 
page.
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Adding Branch advanced options
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Branching tab > Add Branch 
button.

You can define the advanced branching criteria for your survey logic by combining different criteria using 
parentheses and And / Or operators.

Procedure 
1 Create a new survey or open a saved survey in the survey designer.
2 On the Design tab, click the Branching tab in the left pane. 
3 On the Branching page, click the Add Branch button in the upper-right corner. The Add Branch 

dialog box opens, where you can define advanced branching and logic rules for your survey.

 You can also access the Add Branch dialog box by clicking the Add Branch link at the bottom of 
the survey designer page or by clicking the Add Branch option in the options menu of a 
corresponding survey element.

4 In the Add Branch dialog box, in the Branch Description text box, enter the name or description of 
a particular branching rule. It will appear as a link to the Edit Branch dialog box in the survey 
designer.

 If no description is added, the default link name is Untitled.

5 From the list that follows, select the survey question that will appear to the respondent when 
branching occurs (destination).

6 Click the Add Another Criteria link to add branching criteria. Add several criteria.
7 Select the Advanced option next to the Match option. The And / Or operators and parentheses lists 

appear next to each criterion.
8 Select the parenthesies to group multiple criteria according to your needs.
9 Select the And / Or operators to combine the defined criteria groups according to the logic that you 

need for the branch:. 
• the And operator denotes that two or more criteria are met at the same time.
• the Or operator denotes that one of the criteria is met.
For example, in a survey with four pages and four Choose One questions, you can define the following 
advanced criteria:
((Q1=1 OR Q1=2) AND (Q2=1 OR Q2=2)) Or (Q3=1 AND Q4=2)
In fact, we have six criteria here (Q1=1, Q1=2, Q2=1, Q2=2, Q3=1, and Q4=2) that are combined into 
advanced criteria by using the corresponding logical operators.

10 Use the following options to the right of each criterion to manage your criteria:
• Move Up – Move the criterion up in the list.
• Move Down – Move the criterion down in the list.
• Delete – Remove the criterion.
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11 Click the link next to the This branch is evaluated after option; the link displays a question in the 
survey after which the branch will be applied (check point). By default, the check point is set to the 
criteria question that is the furthest from the beginning of the survey. The list with all the available 
survey questions appears.

12 From the list, select the survey question where you want the branch to be applied.
13 Click OK to save the whole set of branching criteria. The added criteria appear on the Branching 

page.

 All branches evaluated on the currently viewed page appear at the bottom of the survey designer 
page.
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Branching page structure
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Branching tab.

The branches with check points set to the pages from fixed blocks are grouped in page buckets; the 
branches with check points set to the pages from rotated or randomized blocks are grouped in block 
buckets. All branches that are evaluated on the same page or block are grouped together in one 
collapsible bucket. The bucket title appears as the word "Page" or "Block" correspondingly with the page 
or block number and the page or block name if you have defined it.
By default, all buckets are collapsed. The collapsed buckets display only the number of branches in the 
bucket. You can expand the buckets to see the branching details by clicking the black down arrow  to the 
left of the bucket title. The expanded buckets display detailed information about the branch: its title or 
description, criteria, check point, and destination.
 

You can perform the following actions on each branch by using the corresponding icons to the rightmost 
of each branch:
• Move Down – Move the branch down in the list.
• Move Up – Move the branch up in the list.
• Copy – Duplicate the branch.
• Delete – Remove the branch.
If there are errors in the branch, the corresponding error messages are displayed above that branch. The 
branches, for which check point questions no longer exist, are displayed in the Orphaned Branches 
bucket.
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Improved Criteria Builder
The criteria builder is redesigned with a more intuitive layout. You can see the new layout in the following 
areas:
• Adding Branching Criteria, page 442
• Create an email trigger, page 1039
• WS Event Handler, page 474
• Filters, page 723
• Filter single report element , page 727
• Add conditional visibility choices rows columns, page 512
• Page Conditional Visibility, page 502
• Question Conditional Visibility, page 509
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Branching Edit Criteria
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Branching tab > Add Branch 
button.

You can edit branching criteria on the Branching tab by using the Edit Branch dialog box. You can 
access the Edit Branch dialog box by clicking the branch description link on the Branching tab.
When you click the branch description link, the Edit Branch dialog box opens. You can edit the existing 
branching rules and add new criteria by following the same steps as in the Add Branch dialog box.
 

 For the steps on how to add a branch, see Adding Branching Criteria, page 442.
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Viewing Branching in the Content pane
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > add branches to your survey > 
Content tab.

You can add branches directly from the content pane by using the Add Branch link at the bottom of the 
survey designer page. All branches evaluated on the currently viewed page appear at the bottom of the 
page. Branches include the criteria summary and destination.
Branches are listed according to their evaluation order (check point).
Only the advanced branching logic is visible in this area. The individual question destinations are visible in 
the question area.
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Errors Validation
The criteria in your logic statements are validated for any errors. If the logic is no longer valid, you will see 
the error messages in the criteria dialog box. Criteria validation works in the following areas:
• Branching
• Conditional pages
• Conditional questions
• Conditional choices and rows
• Email triggers
• Quotas
• Report filters
• Report element filters
The following logic is verified:

Does the check point exist?
Error messages:
• Check Point Block {0} does not exist.
• Check Point question {0} does not exist.

Does the destination exist?
Error messages:
• Destination Block {0} does not exist.
• Destination question {0} does not exist.

Does the branch have any criteria?
Error message:
• No criteria set.

Does the criteria heading still exist and is valid?
Error messages:
• Comparison question {0} does not exist.
• Comparison choice {0} does not exist in question {1}.
• Comparison topic {0} does not exist in question {1}.
• Question element {0} does not exist.
• Comparison question {0} has a dynamic topic list.
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Is the expression valid for the field data type?
Error message:
• Expression {0} is invalid for question {1}.

Is the value still valid?
Error messages:
• Choice count {0} is out of range for question {1}.
• Comparison value {0} for question {1} must be numeric.
• Comparison value {0} for question {1} must be a valid date.



Designing Your Survey Overview Branching Tab destination view

EFM User Guide 454

Confidential and Proprietary Information of Verint Systems Inc.

Branching Tab destination view
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Branching tab > 
Destinations button.

You can toggle between two types of view—Branches and Destinations. The Branches option is 
selected by default. With the Destinations view selected, you can see all survey's destinations in one 
place so that you do not have to visit every question and choice individually. When you switch to the 
Destinations view, you can see the list of survey pages as collapsible sections. By default, the page 
sections are collapsed. You can expand the sections to see all destination details by clicking the black right 
arrow  to the left of the section title.
 

The expand/collapse settings are not saved across the sessions. When you re-open the Branching tab, all 
sections are collapsed, including previously expanded. The section title appears as the word Page with its 
number, for example, Page 3 and the page name if you have defined it. The expanded page section 
displays all questions that the corresponding page contains.
You can set the destination for choices and questions by using the destination drop-down list. 
Destination is a page or question that the respondents will see after they answer the current question. 
The available options are Not Set, End, and all questions that follow the current question. The Not Set is 
a default option.

Procedure 
1 In the Design view, create a new survey or select an existing survey from the My Surveys grid.
2 Click the Branching tab in the left pane.
3 On the Branching page, click the Destinations button in the right content area.
4 To find the question or choice you need, in the Destinations view, click the black right arrow to the 

left of the page or block section.
5 From the corresponding drop-down list, next to the question or choice, select the destination point 

for that survey question or choice.
If the block containing the destination question or choice is changed from rotated or randomized to 
fixed, the destination is cleared. Also, if the block containing the destination question or choice becomes a 
child block, the destination is cleared.

 The pages and questions that belong to the rotated or randomized blocks are not included in the 
question and choice drop-down lists; such blocks appear as Block # Start in the lists. Also, no 
child blocks appear in the question and choice drop-down lists, only the parent blocks they 
belong to.



Designing Your Survey Overview Exporting Branches and Destinations

EFM User Guide 455

Confidential and Proprietary Information of Verint Systems Inc.

Exporting Branches and Destinations
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Branching tab > Add Branch 
button > Actions menu > Export option.

When you export a survey, you can include the survey branching logic into the export file. The following 
logic is exported:
• Advanced branching
• Question destinations
• Choice destinations
The branches and destinations appear at the end of each survey page according to their evaluation order.
Based on the export example above:
• Destination: Page 2 (Set in 3. Color (red)) is a choice destination with the criteria.
• Destination: Survey Submitted (Set in 3. Color) is a question destination with the criteria.
• Branch to: Page 3 (3. Color = green OR 3. Color = blue) is the advanced branching logic with the 

criteria.
To test, create a survey with advanced branching. Then, export your survey to MS Word or Adobe PDF 
and see the visual references included in your export file as in the example above.
If you use an MS Word file, import to create your survey, the branching logic is imported as a "comment" 
in the questionnaire. In order for this functionality to work properly, you need to manually program this 
functionality (branching logic) once you complete the import.

Procedure 
1 On the My Surveys page, open a survey with branching.
2 In the Actions menu on the toolbar, point to Export, and then select the Microsoft Word or PDF 

option.
3 When exporting to the Microsoft Word format, select the Content Review survey type to export all 

the survey branching, and then click the Export button. The export file is generated in the selected 
format.

4 Click the link with the file name to save or open the file.
5 Click Close. The branches and destinations appear at the end of each survey page in the order in 

which they will be evaluated.
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Advanced Branching and Destination Logic Rules
The order of priorities for logic is as follows:
1 Advanced Branches (If more than one exists for a check point, they are evaluated in branching order. 

Advanced branches always take precedence over destinations.)
2 Destinations

• Choice Destinations
• Question Destinations

Choice and Question destinations are evaluated in question order. If the first question on a page has a 
destination, and the second question has a choice destination, the question destination will win. 
However, if a question has both a choice and question destination on it, the choice destination will win.
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Quotas
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Quotas tab.

With the Quotas feature, you can set quotas to limit the number of participants who can respond to your 
survey, and add the criteria for excluding a respondent from the survey. For example, you can limit the 
survey responses to a gender, age group, income level, product purchased, or geographic location.
If multiple people access the survey and complete the survey questions, it allows the number of 
responses to be slightly in excess of the quota limit. Thus, it is recommended that survey invitations be 
sent to participants by batches and not all at once.

 The Quotas tab is available in the Design and Collect view if you have a license for the 
QuotaManagement feature.

After clicking the Quotas tab, the following page opens where you can select the quota evaluation 
method, set the response limit, and add individual quotas.
You can select one of the following quota evaluation methods:
• Started Responses, Allow Overages

Every started response counts against the quota. Completed responses are not guaranteed because 
participants may leave the survey or meet another quota. Participants can complete a survey that has 
been started before the quota is reached.

• Completed Responses, Allow Overages
Only completed responses count against the quota. Participants can complete a survey that has been 
started before the quota is reached.

• Completed Responses, Do Not Allow Overages
Only completed responses count against the quota. When the quota is reached, all participants 
currently taking the survey will be directed to an end page.

Under the Options section, you can do the following:
• Limit total number of responses to – Select this check box to set the response limit for your 

survey, and then type the number in the provided box.
• Add Quota – Click this link to set individual quota criteria to exclude certain responses from your 

survey. For details about adding quota criteria, see Add quota criteria, page 459.

 To update the quota settings for the open survey, click the Apply Changes button in the Design 
or Collect view.

After adding individual quotas, they appear as rows on the Quotas page. If the Limit total number of 
responses to check box is selected, the Total Responses quota row appears. It tracks the total number 
of responses and displays the same information as other quota rows.
When you add or edit the quota criteria in an open survey, participants who pass the survey and meet the 
quota criteria will be counted in the quota row, but the Over Quota status and the Quota Reached 
page will appear only after you apply the changes.  
You can manage quota rows as follows:
• Reorder quota rows by dragging them.
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• View the status of each quota row. Quota can have one of the following statuses: 
• Gray – No respondents meet a quota. 
• Yellow – Quota is in progress.
• Green – Quota is complete.

• Open the Quota Management dialog box by clicking the quota title.
• View the progress details on the progress bar.

 To view the percentage of quota progress, point to the progress bar.

• Duplicate and delete the quota row by clicking  or  icon correspondingly.
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Add quota criteria
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Quotas tab > Add Quota 
button >  Quota Management dialog box.

With the Add Quota option, you can set the criteria to exclude certain respondents from the survey. For 
example, you can limit the survey responses to a gender, age group, income level, product purchased, or 
geographic location.

Procedure 
1 On the Quotas page, click the Add Quota button or the Add Quota link (if any quotas already exist).
2 In the Quota Management dialog box, in the Description box, type the name or description of the 

quota criteria.
3 In the Limit box, type the number of responses to be collected for the given criteria.
4 Click Add Another Criteria.
5 Click the link next to Source, and then in the drop-down menu, click one of the following options:

• Current Survey (default) – Click the name of your survey to apply quota criteria based on the 
survey questions or device type.

a. In the first drop-down list, click the survey question to apply the logic to.
b. In the second drop-down list, click the expression.
c. In the third drop-down list, click the question choice.
• Column – Select one of the following options:

- Participant Information – Apply quota criteria to the campaign name parameter. This type 
of source is designed for use with multiple-campaign surveys (seeAdding multiple campaigns 
to survey, page 586).

 This option is available if at least one campaign is added to the survey.

- Respondent Location – Apply quota criteria to the location parameter. You can use these 
criteria to limit the survey responses based on a city, country, state, zip or postal code.

 When the report or export value is set for a choice, it is displayed instead of the choice index and 
is used as a choice identifier.

6 To save a single criterion, click Save.
7 To add more criteria, click Add Another Criteria, and then add several criteria.
8 Specify which criteria need to be met by selecting the corresponding Match options:

• All criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – Create the needed logical expressions using the drop-down lists with parentheses 

and the And/Or operators next to each criterion.
Criteria can be based on more than one question and are checked for logic when a survey participant 
clicks the Next or Jump button.
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9 Click OK.
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Branching in quotas
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Quotas tab.

You can set how the respondents that reach the Branched Out end page are counted against the quota 
limit.
When you set the general quota to Completed Responses, Allow Overages or Completed 
Responses, Do Not Allow Overages and limit a total number of responses, only the responses marked 
as Complete are counted against the limit. In this case Started, Over Quota, and Branched Out responses 
are not counted against the limit. The Branched Out responses are counted as complete only if the 
Branched Out end page is set to Completed (for details, see Branched Out and Over Quota on the End 
Pages, page 400).
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Triggers overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Triggers tab. 

You can define email and case triggers and alerts for your survey based on the specific survey responses 
and respondent location. You can set case and email triggers at a time. You can also send messages to 
any email address and create cases when a respondent submits a certain answer, a defined combination 
of several answers, or belongs to a specified location. 

When you click the Add Trigger button at the right side, the Add Trigger dialog opens where you can 
define criteria for your triggers, create an alert message, and specify a person who receives an email and 
details of the case that is created based on the respondent’s answers or location.

Triggers are activated after a respondent clicks the Submit button or the Save button or after a 
respondent is directed to the end of the survey through branching logic.  If you want the trigger to be sent 
on survey submission only, set up the criteria for the trigger on the last survey page.

 The case triggers are available only if you have a license for the Case Management feature.

In the Add Trigger dialog, the following options are available:

• Description – Enter a short summary of the trigger in the text box.
• Trigger Action – In the drop-down list, click the trigger action that will be performed when a 

respondent submits a certain answer, a defined combination of several answers, or a specified 
respondent location. The following options are available:
• Send Email
• Create a Case
• Create a Case and Send Email

Depending on the trigger action, multiple tabs are displayed in the dialog:
• Criteria – Add the criteria for sending an email and/or case trigger.
• Email – Create an alert message and specify a person who receives an email when respondents 

match the selected criteria.
• Case Details – Define the details of the case that will be created based on the specific 

respondent's answer or location.

Criteria tab
To add a criterion, click the Add Another Criteria link.  The Criteria section expands where you can 
specify the source for your trigger: a survey or a respondent location. For survey, specify the test question, 
expression, value, and operator if you have multiple criteria. For respondent location, specify state or 
province, city, ZIP or postal code, and country.

If you select My Survey as a source, you can specify the following:

• Question – Specify the question to be checked against the criteria by selecting it from the drop-
down list.
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• Expression – Select the expression from the drop-down list.  The available options vary 
depending on the question type.

For example, the Choose One questions support the following expressions:

• Equal To
• Not Equal To
• Less Than
• Greater Than
• Less Than Or Equal
• Greater Than Or Equal

The Fill in the Blank questions support the following expressions for text responses:

• Equal To
• Not Equal To
• Contains
• Does Not Contain
• Begins With
• Ends With

• Value – Click the response option in the drop-down list. The available options vary depending on 
the question type. For example, the Choose One questions include all response options, and the 
Fill in the Blank questions have a blank text box.

• Save – Click the link or anywhere else in the dialog to save your criterion.

If you add multiple criteria, you can combine them using the following Match options:

• All Criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The drop-down lists with parentheses and the And / Or operators appear next to 

each criterion.

In the dialog, you can copy, move up or move down, and delete the criteria. To edit the criteria, click its 
name.

After you create the criteria, click the Email or Case Details tab depending on the type of the trigger you 
have selected.
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Email triggers
Navigation

Design & Collect tab > Triggers tab > Add Trigger button.

Use the Email Triggers feature to add email triggers and alerts to your survey based on specific survey 
responses.  It is possible to send messages to any email address when a respondent submits a certain 
answer, a defined combination of answers, or a specified respondent location.
For the email triggers, you need to define criteria for your triggers, create an alert message, and specify a 
person who receives an email when respondents select the specific answer or belong to a specified 
location.

You can pipe different fields in your message body and the To, Cc, or Bcc field using the Piped Value icon  
 on the tool bar. To insert the piped value in the To, Cc, or Bcc field, add the piped value to the message 

body and then copy and paste the value into the To, Cc, or Bcc field.  When you send your email, the piped 
field is replaced by the appropriate value.

 The question containing the piped value must be on the previous page in relation to the criteria 
for the trigger, otherwise the piping does not work.

You can also edit the HTML of your message in the email trigger to modify the appearance of your 
message.  The HMTL option is available in the lower-left part of the dialog box.

How to Create an Email Trigger
1 On the Triggers side tab in the survey designer, click the Add Trigger button.
2 In the Add Trigger dialog box, in the Description text box, enter a short summary of the trigger.
3 In the Trigger Action drop-down list, click Send Email.
4 On the Criteria tab, click the Add Another Criteria link.
5 Click the link next to Source, and then select one of the following sources:
• Current Survey (default) – Select the filter parameter, expression, and value from the drop-down 

lists:
a. In the first drop-down list, click one of the following options to apply the logic to:

• Survey question
• Response count criterion with the values from 0 to the specific number of choices or columns 

in Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling Matrix questions
• Device type criterion

 The device type and the response count criteria can be combined with other criteria for 
conditional visibility.

b. In the second drop-down list, click the expression.
c. In the third drop-down list, click one of the following:

• Question choice
• Number of responses provided by the respondent
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• Detected type of device

 When the report or export value is set for a choice, it is displayed instead of the choice index and 
is used as an identifier for the choice.

• Participant Information – Select the filter parameter, expression, and value from the drop-down 
lists:
a. In the first drop-down list, Campaign Name is selected.
b. In the second drop-down list, click the expression.
c. In the third drop-down list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the Collect 
tab.

• Respondent Location – Select the filter parameter, expression, and value from the corresponding 
drop-down lists:
a. In the first drop-down list, click the needed parameter.
b. In the second drop-down list, click the expression, and then type the needed value in the adjacent 

box.
6 Click the Save link to save your criteria.
7 Click the Add Another Criteria link to add more criteria.
8 Specify if either all or any of the criteria need to be met by selecting the corresponding Match option.
9 Click the Email tab.
10 In the To field, type the email address of the person to be notified by the trigger.
11 In the Cc (carbon copy) and Bcc (blind carbon copy) fields, type the email addresses if required.

 Recipients in the Cc and Bcc fields also get the message. The names of the recipients in the Bcc 
field are not visible to other recipients.

12 In the Subject field, type the message short description.
13 In the message body, type the content of your email. You can customize the text by using the 

additional editing options from the tool bar. You can also pipe different fields in your message using 
the Insert Piped Value icon EmailTriggers6.png on the tool bar.

14 Click OK. The created trigger appears on the Triggers tab.
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From address in email triggers
Navigation

Design & Collect tab > Surveys tab > My Surveys tab > create a new survey or open an existing one > 
Design view > Triggers tab > Add Trigger button > Add Trigger dialog box >  Criteria tab > Email tab.

You can specify different email addresses in the From field in an email trigger. The From address is a 
sender's email address. By customizing the sender's email address, you increase the probability that the 
email is opened and prevent it from being sent to the Junk Email folder.
The administrator of a workgroup can activate this functionality and define the list of email addresses to 
be used on the Administration > Mail Setup  tab.
Emails from this list are available in the From  list when you create an alert message for the email trigger.

Add an email address to the list

Procedure 
1 Go to the Administration tab, and then click the Mail Setup  tab in the left pane. The Mail Setup 

page opens.
2 In the From Address section, select the Enable all emails in the list below to be used as From 

addresses on invitations, reminders and email triggers check box.
3 Click the New button. The Add Email dialog box opens.
4 Enter the email address you want to add in the Email Address field.
5 Enter the name of the email sender in the Display Name field.
6 Click OK.
7 Click the Save Setup button.

Delete an email address from the list

Procedure 
1 Go to the Administration tab, and then click the Mail Setup  tab in the left pane. The Mail Setup 

page opens.
2 In the From Address section, select the Enable all emails in the list below to be used as From 

addresses on invitations, reminders and email triggers check box.
3 Select the email address you want to delete from the list.
4 Click the Delete button.
5 Click the Save Setup button.
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Case triggers
Navigation

Design & Collect tab > Triggers tab > Add Trigger button.

You can define case triggers to create cases based on the specific survey responses and respondent 
location. For the case triggers, you need to define criteria for your triggers and specify a person who 
receives the details of the case that is created when respondents select the specific answer or belong to a 
specified location.

 The case triggers are available only if you have a license for the Case Management feature and 
the Case Administration > Cases permission enabled.

 

On the Case Details tab, in the Add Trigger dialog box, you can add the following information for the 
case:
• Assigned to
• Priority
• Title
• Notify Users
• Case Description
Optional fields:
• Contact's Email
• Contact's First Name
• Contact's Last Name
• Contact's Business
• Contact's Phone

Create a case trigger

Procedure 
1 On the Triggers tab in the survey designer, click the Add Trigger button.
2 In the Add Trigger dialog box, in the Description text box, enter a short summary of the trigger.
3 In the Trigger Action drop-down list, click Create a Case.
4 On the Criteria tab, click the Add Another Criteria link.
5 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select the filter parameter, expression, and value from the drop-down 
lists:

a. In the first drop-down list, click one of the following options to apply the logic to:
• Survey question
• Response count criterion with the values from 0 to the specific number of choices or columns 

in Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling Matrix questions
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• Device type criterion

 The device type and the response count criteria can be combined with other criteria for 
conditional visibility.

b. In the second drop-down list, click the expression.
c. In the third drop-down list, click one of the following:

• Question choice
• Number of responses provided by the respondent
• Detected type of device

 When the report or export value is set for a choice, it is displayed instead of the choice index and 
is used as an identifier for the choice.

• Participant Information – Select the filter parameter, expression, and value from the drop-
down lists:

a. In the first drop-down list, Campaign Name is selected.
b. In the second drop-down list, click the expression.
c. In the third drop-down list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the Collect 
tab.

• Respondent Location – Select the filter parameter, expression, and value from the 
corresponding drop-down lists:

a. In the first drop-down list, click the needed parameter.
b. In the second drop-down list, click the expression, and then type the needed value in the adjacent 

box.
6 Click the Save link to save your criteria.
7 Click the Add Another Criteria link to add more criteria.
8 Specify if either all or any of the criteria need to be met by selecting the corresponding Match option.
9 Click the Case Details tab.
10 In the Assigned to text box, type the name of the workgroup member, to whom you want to assign 

the case. By default, the case is unassigned. The Assigned to text box is an autocompletion text box.

 You can also pipe values in the Assigned to text box from any question in the survey by typing 
the placeholder value in the text box, for example, %Q1_1%. You can pipe the user name or 
email. When the trigger is activated, the piped value is matched to a user name or email. If no 
match is found, the case is unassigned.

11 In the Priority drop-down list, click the case priority. 4 - Medium is the default option.
12 In the Title text box, type the case summary.
13 In the Notify Users text box, enter the names of the persons to receive a notification that a new case 

is created. When there are more than 50 members in a workgroup, the Notify Users option appears 
as an autocompletion text box.
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14 In the Case Description text box, type the case description. You can customize the case description 
by using the additional editing options from the toolbar.

 You can also pipe different fields in your case description using the Insert Piped Value icon  on 
the toolbar.

15 In the Contact's Email text box, enter the email address of the person, who can provide the detailed 
information about the case.

16 In the Contact's First Name text box, type the first name of the contact person.
17 In the Contact's Last Name text box, type the last name of the contact person.
18 In the Contact's Business text box, type the company name of the contact person.
19 In the Contact's Phone text box, type the phone number of the contact person.
20 In the Custom Properties section, select the custom case property. The case properties are available 

only if specified on the Case Setup tab by Case Administrator.
21 Click OK. The created trigger appears on the Triggers tab.
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Piping Responses in the Case Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content tab > add a Choose One or Fill in the Blank question > Triggers tab > Add 
Trigger button.
You can pipe question responses into the custom properties of the cases created by triggers. When the 
trigger is activated, the response used by trigger criteria is applied to the newly created case as a custom 
property.

 The case triggers are available only if you have a license for the Case Management feature.

When the survey responses are piped into a case custom properties, the system maps them to the 
available property choices. If they match, the case property is set. If they do not match, the response is 
added to the choices' list of the custom property, but not applied to the case. In the multiple language 
surveys, only the default survey language is used for matching and adding the custom properties.
• For the Choose One question, the responses are piped into the Choose One custom property 

type.
• For the Fill in the Blank question with the Dates input type, the responses are piped into the 

Date custom property type.
• For the Fill in the Blank question with the Text input type and the Choose One question with 

the activated Please Specify option, the responses are piped into the Date custom property 
type.

You can create multiple properties from a single response.

Procedure 
1 On the Content tab of the survey designer, add a Choose One question to the survey.
2 On the Triggers tab, click the Add Trigger button. 
3 In the Add Trigger dialog box, in the Description text box, enter a short summary of the trigger.
4 On the Trigger Action menu, select the Create a Case option.
5 On the Criteria tab, define the trigger criteria.
6 Click the Case Details tab.
7 On the Case Details tab, define the case details.

 The case properties are available only if specified on the Case Setup tab by Case Administrator.

8 In the Custom Properties section, click the  icon next to the custom property into which you want 
to pipe the survey response. 

9 In the Insert Piped Value dialog box, select the question that you want to use for piping.
10 Click OK. 
11 In the Add Trigger dialog box, click OK.
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Advanced Tab
 

Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option > 
Design view > Advanced tab.

You can add advanced properties to your survey when you create or edit it in a survey designer. 
On the Advanced tab, the following options are available:
• Advanced Features Survey Glossary, page 472 – Define the keywords you want to highlight and 

explain within your survey. Click the option and type a keyword with its definition to clarify it for 
your survey participants.

• WS Event Handler, page 474 – Enter your own Web Services provider for advanced integration 
options. Click the option to specify the URL and select when the survey engine calls the Web 
Service.

 This option is available if you have a license for the Web Service feature.

• Advanced Features Scoring, page 477 – Assign scores to questions in your survey and indicate to 
respondents whether they succeed or fail to reach the specified score. Click the option to create 
passing and failing score messages, specify a minimum score to pass, and assign scores to 
answers.

• Version History, page 478 – View and restore the previous version of your survey. Click the option 
and select the version you want to restore.

• Editing Survey HTML, page 479 – Upload, download, and edit your survey HTML. This option 
becomes available when you open your survey. The Edit HTML property is available only in 
classic survey rendering mode.

 Modifying the HTML of a survey has several risks. To avoid them, use the Code Block 
functionality, specifically designed to allow you to customize your survey without these risks. To 
learn more about code blocks, see Code Blocks, page 489.

 Starting with the EFM 15.1 FP3, the Classic survey rendering mode is unavailable for new 
workgroups. In the future EFM releases, Classic survey rendering will not be supported.

• All Survey Spell Check, page 481 – Ensure that all words are spelled correctly within your entire 
survey.



Designing Your Survey Overview Advanced Features Survey Glossary

EFM User Guide 472

Confidential and Proprietary Information of Verint Systems Inc.

Advanced Features Survey Glossary
 

Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option > 
Design view > Advanced tab > Survey Glossary option.

With the Survey Glossary advanced option, you can explain the keywords in your survey that can be 
unfamiliar to your survey participants. Click the Survey Glossary option and type a keyword with its 
definition to clarify it. The keywords are marked with a dotted line in your survey. Your survey participants 
can hover over a keyword to view its definition in a tooltip.

 Switch to Preview mode to test your survey glossary term.

The keywords that you create using the survey glossary are not added automatically to the custom spell 
check dictionary. See the Steps section in this topic for the procedure of adding survey glossary terms to 
the custom dictionary.
You can access the Survey Glossary option on the Design tab in the Advanced Properties section.

Add a Keyword to Survey Glossary

Procedure 
1 On the Advanced tab, in the Advanced Properties section, click Survey Glossary. 
 

 You can define the relevant language for your keyword using the provided list.

2 Click the New Keyword link. Type a new keyword in the Keyword box in the right pane.
3 Type the definition of your keyword in the text area.
4 Click OK.

 To avoid entering the insecure code into Survey Glossary, on the General Setup page, select 
the Automatically remove insecure code from survey designer check box. For more 
information, see General Setup, page 1406.

Delete a Keyword
1 On the Advanced tab, in the Advanced Properties section, click the Survey Glossary option. 
2 In the dialog box, select the keyword you want to remove.

3 Click the Delete icon  .
4 Click Delete in the confirmation dialog box.
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Add a Keyword to Custom Dictionary

Procedure 
1 On the Advanced tab, in the Advanced Properties section, click the All Survey Spell Check 

option. 
2 In the Spell Check dialog box, select the needed word, and click the Add Custom button.
3 Click OK in the confirmation dialog box to add your glossary term to the custom dictionary.
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WS Event Handler
Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option > 
Design view > Advanced tab > Web Services Event Handler option.

With the Web Services Event Handler advanced option, you can use your own Web Services provider 
to handle survey events.

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For the EFM contact 
information, Getting Started overview, page 49.

Click the option to specify the URL of an external Web Service and select when the survey engine calls the 
Web Service.

 The Web Services Event Handler option is available if you have a license for the Web Service 
feature.

You can access the Web Services Event Handler option on the Design tab under the Advanced 
Properties section.
After selecting the Web Services Event Handler, the Web Service dialog box opens, where you can 
specify the URL to the Web Service and select when you want events to occur in your survey. You can also 
specify an email address to receive notifications when your Web Service fails.

Use examples
• A receipt code survey where custom business logic validates what the respondent enters.
• Recording survey responses simultaneously to alternative data stores within your company.
• Changing the rendering of the survey for specific participants.
• Custom validation.
• Piping in custom data for the participant from an alternative data store (such as a CRM system).

 For more information about Web Services Event Handler, see the EFM Web Services Technical 
guide.

Format
You can select the format of the Web Service Event Handler call outs: JSON or XML.

 This option is available only for Modern survey rendering mode. Starting with the EFM 15.1 FP3, 
the Classic survey rendering is unavailable for new workgroups. In the future EFM releases, 
Classic survey rendering will not be supported.
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Authentication Token
With the Web Services Event Handler, you can provide an authentication token for your Web Service. 
You can set up a user name and password when calling the external Web Service. The Authentication 
Token field is optional.

Show Error Page on Event Handler Errors
If the survey event handler is unavailable, then the error page is shown notifying you that the web 
browser could not link to the requested survey page and listing possible solutions. This option is selected 
by default.

Notify the email address about Web Service Errors
You can set up receiving the email notifications when your Web Service fails. You can enter the needed 
email in the corresponding text box. The following information is available in the email message: event, 
URL, survey, respondent, and error. This option is selected by default.

Control Over Events Occurrence
You can select when the survey engine calls the Web Service as follows:
• Survey Start – Calls the Web Service when participants begin the survey. Only preloaded data is 

sent from the survey engine to the Web Service during this event.
• Page Submit – Calls the Web Service while participants are completing the survey. You can select 

the following options from the drop-down list:
• None (fast)
• Only the Responses Submitted for the Page (average)
• All Non-empty Responses for the Survey (slow)

• Survey End – Calls the Web Service when participants complete the survey. All response data is 
sent from the survey engine to the Web Service during this event.
• None (fast)
• Only the Responses Submitted for the Page (average)
• All Non-empty Responses for the Survey (slow)

Pre-Save and Pre-Response Check Boxes
• Pre-Save – Called before data is saved to the database. This option allows the Web Service to stop 

or change data from being saved to the response table.
• Pre-Response – Called before the page is rendered back to the respondent. This option allows 

the Web Service to return a table of replacement fields that the survey engine will expand and 
replace on the page about to be displayed to the respondent.
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Response Data Sent
You can select when you want events to occur in your survey. For example, the survey author can have 
the event occur at the start of a survey or at the start of the survey and every page in the middle of the 
survey.

Procedure 
1 On the Advanced tab, click the Web Services Event Handler option. 
2 In the URL box of the Web Service dialog box, type a valid URL to the Web Service.

 You can pipe data in the URL box from the survey data.

3 In Modern survey rendering mode, in the Format drop-down menu, select the JSON or XML format.
4 In the Authentication Token box, type the security token. (This field is optional.)
5 To receive email notifications when your Web Service fails, select the Notify Survey Author on Web 

Service Errors check box. By default, this option is selected.
6 Select when the survey engine calls the Web Service.

 To ensure that the Web Service is called correctly, test the functionality by clicking the Test 
button.

7 Click Save.
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Advanced Features Scoring
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu > Design from Scratch option > 
Design view > Advanced tab > Scoring option.

With the Scoring advanced option, you can assign scores to questions in your survey and show 
respondents whether they succeed or fail to reach the specified score. Click the option to create the 
passing and failing score messages, specify a minimum score to pass, and assign the scores to each 
response.
The Scoring option is available on the Design tab > Advanced Properties section.
After clicking the Scoring option, the dialog box opens where you can define the following settings:
• Calculate scores for this survey – Select this check box to calculate scores for the current 

survey.
• Passing Score Message – Type the message that appears to respondents who pass your 

survey. You can pipe values from the survey into this box.
• Failing Score Message – Type the message that appears to respondents who fail to pass your 

survey. You can pipe values from the survey into this box.
• Minimum Score to Pass – Define the minimum score value to pass your survey.

 To update the data in the dialog box and save changes, click the Refresh button.

Scoring piped values
You can use different placeholders to show a respondent's score and result.

 Insert the placeholders on the next page in relation to the questions to be scored.

• To show a respondent's score – Insert the %PdcScore% placeholder either in the survey 
question text or on the survey end page.

• To report on a respondent's score – Create a Fill in the Blank question on the last survey 
page and insert the %PdcScore% placeholder in the Preselected field. Respondent does not see 
this score, so it is recommended that you hide this question.

• To show a respondent's result – Insert the %PdcScoreResult% placeholder to show the 
passing or failing score message based on the respondent's score and the minimum score to pass 
the survey. Insert the placeholder on the survey end page only.
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Version History
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu > Design from Scratch option > 
Design view > Advanced tab > Version History option.

With the Version History advanced option, you can view and restore the previous version of your survey. 
Click the option and select the version you want to restore. The history of the last twenty changes of your 
survey is available.

 You can restore the changes made in a survey designer only. Other changes are not reset, for 
example, publishing the survey.

The Version History option is available on the Design tab > Advanced Properties section.
After clicking the Version History option, the following dialog box opens where you can select the 
survey version you want to restore.
• Version – Number of the change made to the survey.
• Date – Day and time of the change.
• User Name – Name of the user who made the change.
• Description – Short summary of the change.

Procedure
1 On the Advanced tab, click the Version History option. A dialog box opens.
2 Select the survey version you want to restore.
3 Click the Restore button. Your survey is updated in a survey designer.
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Editing Survey HTML
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu > Design from Scratch option > 
Design view > Advanced tab > Version History option.

 The Edit HTML property is available only in classic survey rendering mode.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

 The Edit HTML functionality will be removed in a future release. You can use the Code Blocks 
functionality to customize your survey instead.

You can edit your survey HTML in the HTML editor or locally by downloading it to your computer. The 
changes can be uploaded back into the application environment. At the top of the Survey HTML Editor 
dialog box, you can select the survey language from the corresponding drop-down menu and view the 
Page  menu with the following options:
• Page
• End Pages
• Invalid Access Page
• Jump Page
 
On the toolbar, the following options are available:
• Download – Use to download the selected page to the local machine to edit HTML outside the 

application.
• Upload– Use to upload the edited HTML from your computer into the application.
• Revert – Use to revert the changes made in the HTML to the state in which it was opened.
• Save – Use to save all the changes.

Download Survey HTML

Procedure 
1 On the Advanced tab, click Edit HTML. The Survey HTML Editor dialog box opens.
2 On the toolbar, click Download. The Download HTML Files dialog box opens.
3 Click the survey page you want to download. The page is downloaded to your computer.
4 Click Back to return to the Survey HTML Editor dialog box.
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Upload Edited Survey HTML

Procedure 
1 On the Advanced tab, click Edit HTML. The Survey HTML Editor dialog box opens.
2 On the toolbar, click the Upload button. The Upload HTML Files dialog box opens.
3 Click the Browse button to locate your HTML file.
4 Click OK. You have now uploaded the HTML file.
5 Save the changes.
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All Survey Spell Check
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu > Design from Scratch option > 
Design view > Advanced tab > All Survey Spell Check option.

With the All Survey Spell Check advanced option, you can ensure that all words are spelled correctly within 
your entire survey.
You can access the All Survey Spell Check option on the Design tab in the Advanced Properties section.
 

 You can also use the All Survey Spell Check option for individual questions when you edit a 
question in a survey designer.

After selecting the All Survey Spell Check, the Spell Check dialog box opens where you can view and 
manage the incorrect or specific words in your survey.
• Not in Dictionary – In this section, the word that is not found in the EFM dictionary is 

highlighted in bold.
• Suggestions – In this section, the potential spelling variations of the found word appear.
You can use the following functionality to manage the found words:
• Ignore – Ignores the current missing entry in the dictionary and proceeds to the next missing 

entry.
• Ignore All – Ignores all occurrences of the missing entry during the current spell check.
• Add Custom – Adds the missing entry to the custom dictionary.
• Change – Replaces the found word with the highlighted suggestion or with the edits you make 

manually in the Not in Dictionary section.
• Change All – Replaces all occurrences of the found word with your changes.

Check Spelling in All Survey
Procedure 
1 On the Advanced tab, click the All Survey Spell Check option. The Spell Check dialog box opens 

with the potentially incorrect word highlighted in bold.
2 Select the correct word in the Suggestions section.

 You can also edit the found word in the Not in Dictionary section.

3 Click Change.
4 Click OK when the message appears that the spell check is complete.
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Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Properties tab.

On the Properties panel, you can set general properties for your survey operation, edit the survey 
description, define the survey owner, access portal options related to your survey, view your survey 
statistics, and create custom survey properties.
The Properties tab is available on the left-hand side of the Design view.
The survey properties include the following sections:
• General, page 482
• Portal Options, page 485
• Statistics, page 485
• Custom Properties, page 485

General
In the General section, you can define the following properties:
• Allow respondent to update a completed survey – Allow respondents to change their survey 

responses after completing the survey.
You can edit the message that appears to the respondents when they try to update a completed 
survey under the End Pages section on the Pages tab.

• Resume survey from last page – Automatically direct respondents to the last visited survey 
page if they save the survey and try to access it again.

 The Allow respondent to update a completed survey and Resume survey from last 
page options are unavailable while your survey is in the Test mode. This allows you to take the 
survey more than once while testing it and check the survey logic properly.

• Track Respondent Information (selected by default) – Automatically gather the following 
respondent information upon survey submission: 
• Respondent Fields: IP address and HostName.
• Respondent System Information: Record ID, Browser Family, Browser Version, Operating 

System Family, Operating System Name, and Device Type.
• Respondent Location: City, State/Province, ZIP/Postal Code, Country, Latitude, and Longitude.

 The Track Respondent Information feature is not available for SMS surveys.

You can view the gathered respondent information on the Manage Participants and Manage 
Responses pages (by using the Columns button). 
Also, you can use the Respondent Fields and Respondent Location data for filtering:

- On the Manage Participants page
- On the Manage Responses page
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- On the Reports page (Analyze tab) for filtering reports and report elements
- On the Images page (Analyze tab) for filtering images gathered from the responses to the 

Image Upload question
In addition, you can use the Respondent Location data for the following purposes:

- As a source for conditional visibility for choices, questions, pages, and blocks (for details, see 
Add conditional visibility for block, page 506).

- As a source for branching (for details, see Adding Branching Criteria, page 442).
- As a source for quotas (for details, see Quotas, page 457).
- To pipe Respondent Location values into question or response text (for details, see Piping 

values in the Question and Response Text, page 531).
• Block potentially unsafe content from responses – Detect malicious content in survey 

responses and protect user information. The HTML and scripts are stripped from the Essay and 
Fill in the Blank (textual) responses.

• Generate Mobile HTML – Create the mobile version of your survey. When you create a new 
survey, this check box is selected by default.
Generate Mobile HTML does not apply to Modern survey rendering mode.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

• JavaScript Required – Require participants to activate JavaScript in their browsers to be able to 
take the survey. By default, this check box is selected for all new surveys. The following survey 
features require JavaScript:
• Choose One question with the randomized choices
• Choose Many question with the randomized choices
• Choose One question with the Please Specify option
• Choose Many question with the Please Specify option
• Choose One with Image question
• Choose Many with Image question
• Fill in The Blank question with the Date input type
• Fill in The Blank question with the Numbers input type and the Display as Slider topic option 

selected
• Piping URL query in the Fill in the Blank question
• Showing running total in the Fill in the Blank question
• Preselected topics in the Fill in the Blank question
• Character counter in the Essay question
• Indication of the odd and even rows in the Matrix question with the Drop-down layout
• Indication of the odd and even rows in the Matrix question with the randomized rows
• Indication of the odd and even rows in the Matrix question with the Hidden or Conditional row 

visibility criteria
• Piping in the Matrix question columns
• Matrix question with the randomized topics or columns
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• Drag & Drop Rank Order question
• Scrolling Matrix question
• Scale Slider question (both Slider and Star layouts)
• Page conditional visibility (if you disable JavaScript, the same page conditional visibility logic is 

cleared)
• Jump button
• Hierarchical questions
• Code blocks
• Survey glossary
• Allowing the respondent to email the survey end page

 If the browser has JavaScript disabled, and you cleared the JavaScript Required check box in the 
Properties panel of the Design tab, the respondent will be able to take your survey.

• Allow respondent to uncheck radio buttons – Allow respondents to clear the previously 
selected radio buttons if they want to change their answer. This option applies to the Choose 
One, Matrix with the Choose One side, Choose One with Image, and Rank Order questions.

 This option is available for Modern survey rendering mode only.
 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

• Enable Survey Engine API – Enable the usage of Survey Engine API. If this option is cleared, the 
request to Survey Engine API returns an error page. The option is cleared by default. For more 
information about Survey Engine API, see Web Services Technical Guide.

 For SMS surveys, Survey Engine API is always enabled by default with no option to change it.

Description

Type a description of your survey in the provided text box. This entry is optional. You can use it to 
remember the function of the survey.

Tags

Add tags to your survey for searching and reporting on your surveys. You can add new tags, view existing 
tags, and remove the tags you do not need anymore. You can create up to 4 tags for a single survey. You 
can view tags in an expanded view of the survey on the Surveys tab.

Survey Owner

Click the Edit link to select and assign an owner to the survey. The survey owner is an EFM user who has a 
full access to the survey. The survey owner property does not extend the security role assigned to the 
user account. A survey owner should be assigned a security role similar to the standard "Survey Author" 
role with respect to survey edit permissions.
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Share Access

Click the Share Survey link to allow other users to access your survey. For details on the survey sharing, 
see Share a survey, page 188.

Portal Options
In the Portal Options section, you can define the following properties. 

 The portal functionality is only available in the EFM if you purchase the EFM Community Builder 
product.

• Active Surveys
Show estimated time to complete the survey – Select the check box and provide a number in minutes 
to show your survey participants approximate time they need to complete the survey.

• Completed Surveys
Allow all panelists to see survey results – Select the check box to allow all portal respondents to view 
the survey results after they complete the survey.

Statistics
With the Statistics option, you can view the general data associated with your current survey such as the 
number of words, questions, pages, and languages. 

Custom Properties
With the Custom Properties option, you can store and access metadata for your survey. Metadata 
typically includes the survey title, description of the survey content, author name, and any other survey 
details. You can use this option to tag your survey for easy identification when you deal with hundreds of 
surveys. The metadata tag helps you to find the survey you are searching for within your database very 
quickly.

 This option is available if you have a license for the Custom Properties feature.

Click the Custom Properties option and define custom properties by creating a set of name and value 
pairs for your survey. These custom properties are added to the internal system file and are used by your 
Web Service client.



Designing Your Survey Overview Comments tab

EFM User Guide 486

Confidential and Proprietary Information of Verint Systems Inc.

Comments tab
Navigation

Design & Collect tab > Comments tab.

With the Comments tab, you can add comments for the survey author or reviewer regarding your whole 
survey. The survey author, reviewer, or any other user who has access rights to your survey can add their 
comments too. The added comments appear in the Survey Comments pane directly under the text 
area. The most recent comments appear first. For each comment, you can view the name of a user who 
entered the comment, the date and time the comment is entered, and the comment itself.

Procedure 
1 In the Design view, click the Comments tab in the left pane. The Survey Comments pane opens.
2 Click inside the text area and enter your comments.
3 Click Submit.
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Text Blocks
Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option > 
Design view > Content tab > Text button > Add menu.

Text block is a non-question content. You can use a text block to add descriptive text about a section or 
instructions for your questions.
Select whether to show or hide your content in a published survey. The hidden content is only visible to 
you and is marked accordingly. To set conditions for the content's visibility, click Conditional, and then 
click the Criteria link that appears.
The following visibility options are available:
• Shown – The text block is shown.
• Hidden – The text block is hidden.
• Conditional – The text block is shown or hidden according to the certain conditions.
If conditional visibility is not valid anymore, the warning icon appears next to the conditional visibility icon 

. 

Add a Text Block to Your Survey
1 On the Content tab of the Design view, click the Text button. The text block is added to your 

survey.

 If your survey contains at least one question or other content, you can add a text block by using 
the Add button or the Add  menu.

2 Click Click to edit text, and then type your text. To cancel the changes, press Esc. You can customize 
the text and add images or media by using the editing toolbar.

 The editing toolbar appears when you edit the text.
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Section Headings
Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option > 
Design view > Content tab >   Add menu > Section Heading option.

A section makes it easier for you and participants to navigate the survey. You can arrange the questions, so 
that relevant information is grouped together. Sections are optional and useful in providing a structure for 
long surveys. You can use a section to break your survey into smaller pieces (for example, to separate 
demographic information about respondents from other questions).

 Section Heading is just a means of visual representation of survey sections, and it does not affect 
the survey logic or any reporting options.

Visibility
Select whether to show or hide your content in a published survey. The hidden content is only visible to 
you and is marked accordingly. To set conditions for the content's visibility, click Conditional, and then 
click the Criteria link that appears.
The following visibility options are available:
• Shown – The section heading is shown.
• Hidden – The section heading is hidden.
• Conditional – The section heading is shown or hidden according to the certain conditions.

 If conditional visibility is not valid anymore, the warning icon  appears next to the conditional 

visibility icon .

Procedure 
1 On the Content  tab of the Design view, click the Section Heading button. The section heading is 

added to your survey.

 If your survey contains at least one question or other content, you can add a section heading by 
using the Add button or the Add  menu.

2 Click the Click to edit section heading text, and then type the text of your section heading, for 
example, Demographics Section. To cancel the changes, press Esc. You can customize the text and add 
images or media to your section heading by using the editing toolbar.

 The editing toolbar appears when you edit the section heading.

3 To use additional options for text formatting and the spelling checker, click the More icon .
4 To preview the section heading, click the Preview button on the survey designer toolbar.
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Code Blocks
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu > Design from Scratch option > 
Design view > Content tab > Code Block button > Add menu.

The Code Block feature is a better alternative to the survey HTML edits because it saves changes to your 
custom code even if you republish your survey or the product is upgraded. Additionally, you can include 
different validation criteria in your survey and add your own warning messages.
In the survey designer, the actual code is displayed. The code is rendered when you preview or test the 
survey.

Code Block Best Practices
When working with code blocks in the Modern survey rendering mode, be sure to follow these best 
practices:
1 HTML content of survey questions may change from version to version without a publish from the 

author.
2 IDs will probably be safe between versions.
3 Using methods like .parent() to walk the DOM structure is strongly advised against.
4 Do not rely on any undocumented client-side methods or libraries used by the survey as they may 

change from version to version without a publish from the author.

Visibility
Select whether to show or hide your content in a published survey. The hidden content is only visible to 
you and is marked accordingly. To set conditions for the content's visibility, click Conditional, and then 
click the Criteria link that appears.
The following visibility options are available:
• Shown – The code block is shown.
• Hidden – The code block is hidden.
• Conditional – The code block is shown or hidden according to the certain conditions.
If conditional visibility is not valid anymore, the warning icon  appears next to the conditional visibility icon 

.

Add a Code Block to Your Survey

Procedure 
1 In the Add Other Content area, click the Code Block button. The code block is added to your 

survey.
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 If your survey contains at least one question or other content, you can add a text block by using 
the Add button or the Add  menu.

2 Click the Click to edit code block text and enter the code. To cancel the changes, press Esc.
3 Click the Edit in Expanded View link in the options  menu  to edit the code in the expanded editor.

 You cannot format the code text.
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Insert piped values into code blocks
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content  tab > select a question > click  icon.
You can insert the piped values into code blocks to enhance your own JavaScript code in the survey.

 The Piping functionality requires that source questions and code blocks are separated by a page 
break.

Procedure 

 In this example, the Choose One question is used.

1 In the Design view, add the Choose One question.
2 On the next page, in the Add Other Content area, click the Code Block.
3 Click the Click to edit code block text and enter the code.
4 On the editing toolbar, click the  icon.
5 In the Insert Piped Value dialog box, select the value that you want to insert into the code block, 

and then click OK.
The piped value is inserted into the code block.
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Comments
Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option > 
Design view > Content tab > Comment button > Add menu.

You can use comments to add personal notes about the survey or notes to other users working on the 
survey. For example, you can add a note asking if a question is necessary or if a certain validation is 
needed on a particular question. Survey comments provide a means to document questionnaire design 
workflow.
Comments are visible only to people who work on the survey. They are displayed in Design mode, but 
they are not visible to survey respondents after opening the survey.

Visibility
Select whether to show your content in a survey HTML or hide it. To set conditions for the content's 
visibility, click Conditional, and then click the Criteria link that appears. The following visibility options 
are available:
• Shown – The comment is shown in the survey HTML.
• Hidden – The comment is hidden from the survey HTML.
• Conditional – The comment is shown or hidden according to the certain conditions.
If conditional visibility is not valid anymore, the warning icon  appears next to the conditional visibility icon 

.

Add a Comment to Your Survey

Procedure 
1 On the Content tab of the Design view, click the Comment button. The comment is added to your 

survey.

 If your survey contains at least one question or other content, you can add a comment by using 
the Add button or the Add  menu.

2 Click the Click to edit comment text, and then type your text. To cancel the changes, press Esc.

 You cannot format the code text.
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Page Breaks
Navigation

Design & Collect tab > Surveys tab > My Surveys page. > New menu > Design from Scratch option > 
Design view > Content tab > Page Break button > Add menu.

When you insert a page break, a new page is added to your survey. Thus you can create new pages and 
design a multi-page survey.
A page break is placed at the insertion point in the survey, and the following questions are moved to a 
new page.
When you publish the survey and view it in a Web browser, the Next button appears at each point where 
a page break is inserted. On the final page of the survey, the Submit button appears.
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Manage image subfolders
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > add question with the Add Image option.
You can create new subfolders to group your images for different purposes and minimize loading time if 
there are many images in the folder.

Create a subfolder

Procedure 
1 In the Image Manager dialog box, select the folder for which you want to create a subfolder.
2 On the Image Manager menu, click the Folder icon. 

 To create a new subfolder, right-click the folder, and then click Create a New Subfolder.
 

3 In the Enter the new folder name dialog box, change the name of your folder.
4 Click OK. 

 You can create subfolders in Group Media folder if you have the Upload Group Media 
permissions.

 

Rename a subfolder

Procedure 
1 In the Image Manager dialog box, right-click the subfolder that you want to rename. 
2 On the subfolder shortcut menu, click Rename.
3 Edit the name of your subfolder, and then press Enter.

 You can rename the Group Media subfolders if you have the Delete Group Media 
permissions.

 

Delete a subfolder

Procedure 
1 In the Image Manager dialog box, right-click the subfolder that you want to delete. 
2 On the subfolder shortcut menu, click Delete. 
3 In the confirmation dialog box, click OK. 
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 You can delete the Group Media subfolders if you have the Delete Group Media permissions.
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Manage media access restrictions
Navigation

Administration tab > Roles tab > Roles grid > Create Role button > Create Role page.
You can control the ability to upload and download images and media based on the user role set of 
permissions. 
You can activate the Images and Media functionality for a user by creating a new role or editing the 
existing ones. 

 When the Allow User Media option in the Images and Media section is not selected, the user 
cannot see the file folders in the Image Manager dialog box.

Activate the media access for a new role

Procedure 
1 Go to the Administration tab > Roles tab.
2 On the Roles page, click the Create Role button.
3 On  the Create Role page, fill the Name and Description text boxes.
4 In the Images and Media section, select the Allow User Media check box.
5 Click Save.

Disable the media access for a role

Procedure 
1 Go to the Administration tab > Roles tab.
2 On the Roles page, click the name of the role that you want to edit. 
3 On the Edit Role page, in the Images and Media section, clear the Allow User Media check box.
4 Click Save.

 By default, the Allow User Media check box is selected for all roles.
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Upload images to Image Manager
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Add menu > select the image-based question > Add Image button > 
Image Manager dialog box.
You can upload  and place your images in different folders, and then insert them into your survey.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one. 
3 On the Analyze tab > Content tab,  add the image-based question.
4 Click the Add Image button. 
5 In the Image Manager dialog box, on the toolbar, click the Upload button.

 In the Upload dialog box, you can find the information on the maximum file size and extensions 
that are allowed.

The Upload dialog box

6 In  the Upload dialog box, click the Select button to locate your image.
7 Select the image, and then click Open.

 To add many images at once, click the Add button. You can also replace the images with the same 
file name by selecting the Overwrite if the file exists check box.

8 Click the Upload button.
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Add images to questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Add menu > add question with the Add Image option > click the Add 
Image button > Image Manager dialog box.
You can add images to the survey questions after uploading them into the Image Manager dialog box.

 You cannot paste any images directly into the survey questions, topic or choice text, sections, or 
text blocks.

1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing survey.
3 On the Analyze tab, on the Content tab,  add the image-based question.
4 Click the Add Image button. 
5 In the Image Manager dialog box, select the image that you want to insert. 

The Preview and Properties tabs become active.

The Properties tab

 On the Properties tab, you can change the image width and height, border color and border 
width, add text, and set margins for your image.

 

6 In the Image Manager dialog box, click the Insert button.
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Add image to customized theme
Navigation

Library tab > Survey Themes tab > Survey Themes content pane > click the New button.
You can insert an image into the HTML or CSS template of your theme to customize it. 
It is also possible to insert an image into the older themes, created before the 8.1 release. Based on your 
permissions, you can insert images from the User Media or Group Media folder.

Add image to CSS theme 

Procedure 
1 Go to the Library tab > Survey Themes tab.
2 On the Survey Themes page,  on the toolbar, click New. 
3 On the Create a Survey Theme page, on the toolbar, click the CSS button.
4 Enter your custom CSS and place the pointer at the position where you want to insert the image.
5 On the toolbar, click the Image Manager button.
6 In the Image Manager dialog box, click the Upload button.
7 In the  Upload dialog box , click the Select button to locate your image.
8 Select the image, and then click Open.
9 Click the Upload button. 
10 Select the image, and then click Insert. 
11 Click Save.

 You can preview your theme by clicking the Preview in New Window button on the Create a 
Survey Theme page.

Add image to HTML theme

Procedure 
1 Go to the Library tab > Survey Themes tab.
2 On the Survey Themes page,  on the toolbar, click New. 
3 On the Create a Survey Theme page, on the toolbar, click the HTML button.
4 Place the pointer at the position where you want to insert the image.
5 On the toolbar, click the Image Manager button.
6 In the Image Manager dialog box, click the Upload button.
7 In the  Upload dialog box , click the Select button to locate your image.
8 Select the image, and then click Open.
9 Click the Upload button. 
10 Select the image, and then click Insert. 
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11 Click Save.

 You can preview your theme by clicking the Preview in New Window button on the Create a 
Survey Theme page.
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Enable blocked content
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Properties tab > Block potentially unsafe content from responses check box.
The Block potentially unsafe content from responses option prevents respondents from accessing 
user data through the malicious attacks.
If the system detects the malicious content in survey responses, it removes the potentially dangerous 
content and stores only the safe one.
You can allow the respondent to type the executable code or query string parameters if the survey 
questions require responses that contain such type of information.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing survey.  
3 On the Design tab, click the Properties tab.
4 In the General section, clear the Block potentially unsafe content from responses check box.

Your changes are saved automatically.
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Page Conditional Visibility
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 

Design tab  >  menu > click Add Conditional Visibility.

You can define whether certain survey pages are shown or hidden. The hidden pages are not displayed to 
the respondents, and the next logical page appears to them instead. Multiple pages can be skipped in a 
sequence. Certain survey pages can also be shown or hidden based on specific conditions. For example, if 
you define the survey page as Conditionally Hidden and the respondent's answer matches the specified 
criteria, the page is not displayed to the respondent.

If conditional visibility is set on a page, the  icon and the conditions are shown at the top of the 
survey designer page. If conditional visibility is not valid anymore, the warning icon  appears next to the 

conditional visibility icon . 
After validating records, all fields on a hidden page are set to Not Asked in Response Manager. If there 
are no more valid pages in a block to be displayed, the block is exited, and the next logical page outside of 
the block appears to the respondent. For example, if the block is set to display three out of five pages and 
two have been displayed but none of the next three are defined to be visible, the block conditions are 
considered met and the next page outside of the block appears.
In the conditional visibility criteria designer, there is a Device Type criterion with the Desktop and 
Mobile values. You can use this criterion to show conditionally or hide pages based on the detected 
device type. The Device Type criteria can be combined with other criteria for conditional visibility.

You can access the page visibility options by clicking the Add Conditional Visibility on the   
menu.
The visibility status appears to the right of the page name in the survey designer.
There are the following statuses:
• Shown
• Hidden
• Conditionally Shown
• Conditionally Hidden

Define Page Visibility 

Procedure 
1 On the Design tab of the survey designer, click the Pages tab.
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2 On the Pages page, on the   menu to the rightmost of the page bar, click Add Conditional 
Visibility. 
The Add Conditional Visibility option is unavailable for the first page in the survey.

 You can access the same functionality from the page  menu on the Content  tab of the 
survey designer.

3 In the Page Visibility dialog box, in the When the following criteria are met  list, select whether 
to show or to hide the page based on the visibility criteria. 
Hide This Page is a default option.

 To hide the survey page without setting any criteria, click the Hide this page in the page  
menu.

4 To add visibility criteria, click Add Another Criteria.
5 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select to apply conditional visibility based on the survey questions or 
device type.

a. In the first list, click one of the following options to apply the logic to:
• Survey question
• Response count criterion with the values from 0 to the specific number of choices or columns 

in Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling Matrix 
questions

• Device type criterion

 The device type and the response count criteria can be combined with other criteria for 
conditional visibility.

b. In the second drop-down list, click the expression.
c. In the third drop-down list, click one of the following:

• Question choice
• Number of responses provided by the respondent

d. Detected type of device

 The values list includes the actual response options for the question. The choices are numbered 
in the same way as in the survey designer. For the Fill in the Blank, Short Answer, Essay, 
Matrix with Short Answer or Essay sides questions, type in the expected response or leave the 
text box empty.

• Participant Information – Select to apply conditional visibility to the campaign:
a. In the first list, Campaign Name is selected.
b. In the second list, click the expression.



Designing Your Survey Overview Page Conditional Visibility

EFM User Guide 504

Confidential and Proprietary Information of Verint Systems Inc.

c. In the third list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the 
Collect tab.

• Respondent Location – Select to apply conditional visibility to the location parameter:
a. In the first list, click the needed parameter.
b. In the second list, click the expression, and then type the needed value in the adjacent box.

 If conditional visibility is set on a page, the corresponding icon and the visibility conditions are 
shown in the visibility status bar under the page name on the top of the survey designer page. To 

remove page visibility properties, click the delete   icon to the rightmost of the visibility 
status bar.

6 To save a single criterion, click Save.
7 To add more criteria, click Add Another Criteria, and then add several criteria.
8 Specify which criteria need to be met by selecting the corresponding Match options:

• All criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – Create the needed logical expressions using the drop-down lists with parentheses 

and the And/Or operators next to each criterion (see Create advanced criteria, page 523).
9 To apply the selected visibility criterion to the other pages, click Save and Apply to Others.
10 Apply the visibility logic to the other pages by selecting the corresponding check boxes.

 If the pages already have criteria, the criteria are overwritten.

11 Click Save.
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Same Page Conditional Visibility
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 
Design tab  > select the question that you want to show or to hide > Question Options panel > click the 
Conditional option > click the Criteria link > Question Visibility dialog box > Same Page Conditional 
Visibility check box.

You can set conditional visibility on the same page for the survey questions, text blocks, and section 
headings. When you select this option, only the questions on the same page before the current question 
are available for setting the criteria. 
The following questions types are applicable:
• Choose One
• Choose One with Image
• Choose Many
• Choose Many with Image
When you select the Same Page Conditional Visibility check box and you have any existing criteria 
defined, the existing criteria are deleted.
To enable the conditional visibility on the same page, activate the JavaScript Required functionality. If you 
make JavaScript unavailable for the survey with the Same Page Conditional Visibility logic applied, the 
existing Same Page Conditional Visibility logic is cleared. For more information on activating the JavaScript 
Required option, see Properties, page 482.
If you set conditional visibility for questions on the first survey page, the Same Page Conditional Visibility 
check box must be selected. The only conditional visibility you can set for questions on the first page is on 
the same page.

 When copying and pasting survey elements with the applied Conditional Visibility settings, 
remember that the visibility settings can be stripped and set to Shown if they are not valid 
anymore (for details, see Copying Conditional Visibility, page 518.
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Add conditional visibility for block
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey with at least two blocks or 

open an existing one > Pages page >  menu > click the Add Conditional Visibility option.

You can set the visibility of survey blocks to define whether certain blocks are visible or hidden based on a 
set of predefined criteria. The hidden blocks are not displayed to the respondents, and the next logical 
block appears to them instead.

If conditional visibility is set on a block, the  icon and the conditions are shown at the top of the 
block. If conditional visibility is not valid anymore, the warning icon  appears next to the conditional 

visibility icon .

 This feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, contact your Account Manager or Sales. For details, see Contact us, 
page 50.

Procedure 
1 On the Design tab of the survey designer, click the Pages tab.

2 On the Pages page, on the   menu to the rightmost of the block bar, click Add Conditional 
Visibility. 
The Add Conditional Visibility option is disabled for the first block in the survey.

 You can access the same functionality from the   menu on the Content side tab of the 
survey designer.

3 In the Block Visibility dialog box, in the When the following criteria are met list, click whether to 
show or to hide the block based on the visibility criteria. 
The default option is Hide this block.

 To hide the survey block without setting any criteria, click the Hide this block on the page menu.

4 To add visibility criteria, click Add Another Criteria.
5 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select to apply conditional visibility based on the survey questions or 
device type.

a. In the first  list, click one of the following options to apply the logic to:
• Survey question
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• Response count criterion with the values from 0 to the specific number of choices or columns 
in Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling Matrix 
questions

• Device type criterion

 The device type and the response count criteria can be combined with other criteria for 
conditional visibility.

b. In the second list, click the expression.
c. In the third list, click one of the following:

• Question choice
• Number of responses provided by the respondent
• Detected type of device

 The values list includes the actual response options for the question. The choices are numbered 
in the same way as in the survey designer. For the Fill in the Blank, Short Answer, Essay, 
Matrix with Short Answer or Essay sides questions, type in the expected response or leave the 
text box empty.

• Participant Information – Select to apply conditional visibility to the campaign:
a. In the first list, Campaign Name is selected.
b. In the second list, click the expression.
c. In the third list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the 
Collect tab.

• Respondent Location – Select to apply conditional visibility to the location parameter:
a. In the first list, click the needed parameter.
b. In the second list, click the expression, and then type the needed value in the adjacent box.

 If conditional visibility is set on a block, the corresponding icon and the visibility conditions are 
shown in the visibility status bar under the block name on the top of the survey designer page. 

To remove block visibility properties, click the delete   icon to the rightmost of the visibility 
status bar.

6 To save a single criterion, click Save.
7 To add more criteria, click Add Another Criteria, and then add several criteria.
8 Specify which criteria need to be met by selecting the corresponding Match options:

• All criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – Create the needed logical expressions using the drop-down lists with parentheses 

and the And/Or operators next to each criterion (see Create advanced criteria, page 523).
9 Click Save.
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 When copying and pasting survey elements with the applied Conditional Visibility settings, 
remember that the visibility settings can be stripped and set to Shown if they are not valid 
anymore (for details, see Copying Conditional Visibility, page 518).
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Question Conditional Visibility
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 
Design tab  > select the question that you want to show or to hide > Question Options panel > Visibility 
option.

You can set the conditional visibility for a question so if a respondent's answer matches the specified 
criteria, the question is shown or hidden. For example, if you define the question as Conditionally Hidden 
and the respondent's answer matches the specified criteria, the question is not displayed to the 
respondent.

If conditional visibility is set on a question, the  icon and the conditions are displayed next to the 
question heading. If conditional visibility is not valid anymore, the   warning icon appears next to the 

conditional visibility   icon. 
The following visibility options are available:
• Shown – The survey question is shown.
• Hidden – The survey question is hidden.
• Conditional – The question is shown or hidden according to the certain conditions.
Under conditional visibility criteria designer, there is a Device Type criterion with the Desktop and 
Mobile values. You can use this criterion to show conditionally or hide questions based on the detected 
device type. The Device Type criteria can be combined with other criteria for conditional visibility.
In the Modern survey rendering mode, under conditional visibility criteria designer, there is a response 
count criterion with the values from 0 to the specific number of choices or columns in the Choose Many, 
Matrix with Choose One or Choose Many sides, or Scrolling Matrix questions.

 The Classic survey rendering is unavailable for new workgroups. In the future EFM releases, the 
Classic survey rendering will not be supported.

You can use this criterion to hide conditionally or show questions based on the count of responses 
provided by the respondent. For example, if you want to hide the selected question and in the 
conditional visibility criteria designer you specify that the count of responses equals 2, the question is not 
displayed to the respondent, if the respondent's answers match the specified criterion.
If the question is Conditionally Hidden, no validation is performed on it. Thus if you activate such 
validation and logic options as Destination, Preselected, and Answer Required for the Conditionally 
Hidden question, they will be skipped in the published survey.
After validating records, the Conditionally Hidden questions are set to Not Asked on the Response 
Manager page. If a page is visible, and a question on that page is hidden, but has preselected values, the 
preselected values are shown in the Response Manager grid. Validating records does not set it to Not 
Asked.
If all items on the survey page are hidden or empty, the page is not displayed to the respondents, and the 
next logical page appears instead.
All conditionally hidden questions that were not shown to respondents do not appear on the Display 
Live Results and Display Respondent Answers survey end pages. Additionally, when respondents 
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print or send their responses via email, the conditionally hidden questions are not shown in the printed 
files and email messages.

 When copying and pasting survey elements with the applied Conditional Visibility settings, 
remember that the visibility settings can be stripped and set to Shown if they are not valid 
anymore (see Copying Conditional Visibility, page 518).

Procedure
1 On the Design tab of the survey designer, click the Pages tab.

2 On the Pages page, on the  menu, click Add Conditional Visibility. 
The Add Conditional Visibility option is unavailable for the first question in the survey.

 You can access the same functionality from the   menu on the Content tab of the survey 
designer.

3 In the Question Visibility dialog box, in the When the following criteria are met  list, click 
whether to show or to hide the question based on the visibility criteria.  
The default option is Hide this question.

4 To add visibility criteria, click the Add Another Criteria link.
5 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select to apply conditional visibility based on the survey questions or 
device type.
- In the first list, click one of the following options to apply the logic to:

- Survey question
- Response count criterion with the values from 0 to the specific number of choices or 

columns in the Choose Many, Matrix with Choose One or Choose Many sides, or 
Scrolling Matrix questions

- Device type criterion

 The device type and the response count criteria can be combined with other criteria for 
conditional visibility. 

- In the second  list, click the expression.
- In the third list, click one of the following:

- Question choice
- Number of responses provided by the respondent
- Detected type of device
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 The values list includes the actual response options for the question. The choices are numbered 
in the same way as in the survey designer. For the Fill in the Blank, Short Answer, Essay, 
Matrix with Short Answer or Essay sides questions, type in the expected response or leave the 
text box empty.

• Participant Information – Select to apply conditional visibility to the campaign:
- In the first list, Campaign Name is selected.
- In the second list, click the expression.
- In the third list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the 
Collect tab.

• Respondent Location – Select to apply conditional visibility to the location parameter:
- In the first list, click the needed parameter.
- In the second list, click the expression, and then type the needed value in the adjacent box.

 If conditional visibility is set on a question, the corresponding icon and the visibility conditions are 
shown in the visibility status bar above the question heading on the survey designer page. To 

remove question visibility properties, click the delete icon  to the rightmost of the visibility 
status bar.

6 To save a single criterion, click Save.
7 To add more criteria, click Add Another Criteria, and then add several criteria.
8 Specify which criteria need to be met by selecting the corresponding Match options:

• All criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – Create the needed logical expressions using the drop-down lists with parentheses 

and the And/Or operators next to each criterion (see Create advanced criteria, page 523).
9 To apply the selected visibility criterion to the other questions, click Save and Apply to Others.
10 Apply the visibility logic to the other questions by selecting the corresponding check boxes.

 If the questions already have criteria, the criteria are overwritten.

11 Click Save.

 All existing conditional criteria created before the 6.5 release are conditionally hidden. All 
conditionally hidden questions that were not shown to respondents do not appear on the 
Display Live Results and Display RespondentAnswers survey end pages. Additionally, when 
respondents print or send their responses via email, the conditionally hidden questions are not 
shown in the printed files and email messages.
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Add conditional visibility choices rows columns
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 

 menu > click the Add Conditional Visibility option..

You can set conditional visibility for question choices, rows and columns (for Matrix question), and topics 
(for Scrolling Matrix and Scale Slider questions) to define whether they are shown or hidden in a 
survey based on a set of predefined criteria.

If conditional visibility is set on a question choice, row, column, or topic, the  icon and conditions are 
displayed next to the question heading. If conditional visibility is not valid anymore, the   warning icon 

appears next to the conditional visibility icon .

 The following procedure describes how to set conditional visibility for a choice. To set conditional 
visibility for a row, column, or topic, follow the same procedure.

Procedure 

1 On the Content tab of the survey designer, on the   menu, click Add Conditional Visibility.
2 In the Choice Visibility dialog box, in the When the following criteria are met list, click whether 

to show or to hide the choice based on the visibility criteria.
3 To add visibility criteria, click Add Another Criteria.
4 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select to apply conditional visibility based on the survey questions or 
device type.

a. In the first list, click one of the following options to apply the logic to:
• Survey question
• Response count criterion with the values from 0 to the specific number of choices or columns 

in Choose Many, Matrix with  Choose One or Choose Many sides, or Scrolling Matrix 
questions

• Device type criterion

 The device type and the response count criteria can be combined with other criteria for 
conditional visibility.

b. In the second  list, click the expression.
c. In the third  list, click one of the following:

• Question choice
• Number of responses provided by the respondent
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• Detected type of device

 The values list includes the actual response options for the question. The choices are numbered 
in the same way as in the survey designer. For the Fill in the Blank, Short Answer, Essay, 
Matrix with Short Answer or Essay sides questions, type in the expected response or leave the 
text box empty.

• Participant Information – Select to apply conditional visibility to the campaign:
a. In the first list, Campaign Name is selected.
b. In the second list, click the expression.
c. In the third  list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the 
Collect tab.

• Respondent Location – Select to apply conditional visibility to the location parameter:
a. In the first  list, click the needed parameter.
b. In the second list, click the expression, and then type the needed value in the adjacent box.

 When the report or export value is set for a choice, it is displayed instead of the choice index and 
is used as an identifier for the choice.

5 To save a single criterion, click Save.
6 To add more criteria, click Add Another Criteria, and then add several criteria.
7 Specify which criteria need to be met by selecting the corresponding Match options:

• All criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – Create the needed logical expressions using the drop-down lists with parentheses 

and the And/Or operators next to each criterion (see Create advanced criteria, page 523).
8 To apply the selected visibility options to the other choices, click Save and Apply to Others.
9 In the Apply to Others dialog box, apply the visibility logic to other choices by selecting the 

corresponding check boxes. The check box of the currently selected choice is unavailable.

 If the choices already have criteria, the criteria are overwritten.

10 Click Save.

 All existing conditional criteria created before the 6.5 release are conditionally hidden. All 
conditionally hidden choices that were not shown to respondents do not appear on the Display 
Live Results and Display RespondentAnswers survey end pages. Additionally, when 
respondents print or send their responses via email, the conditionally hidden choices are not 
shown in the printed files and email messages.

When copying and pasting survey elements with the applied Conditional Visibility settings, remember 
that the visibility settings can be stripped and set to Shown if they are not valid anymore (for details, see 
Copying Conditional Visibility, page 518).
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Page and Question Visibility Rules
In the EFM application, the following page and question visibility rules are defined:

 Text Elements are not considered Questions for visibility rules.

1 Any Object (Page, Question, Choice, Row/Topic) on Page 1 of a survey, can only be set to Shown or 
Hidden, as criteria can only be based on fields on prior pages. Objects are set to Shown and criteria 
cleared if moved to Page 1.

2 Any Object (Page, Question, Choice, Row/Topic) which is set to Conditional (Show this Object or Hide 
this Object) with no criteria, or criteria which is no longer valid, is considered Visible for the purpose of 
survey taking and validating records.

3 A Page is considered Visible for survey taking and validating records if:
• Explicitly set to Shown and:

No Questions (To support text elements)
OR
All Questions explicitly Hidden
OR
At least one Visible Question (explicitly Shown or based on conditions)

• Explicitly set to Conditional (Show this Page) and:
Criteria met
AND
No Questions (To support text elements) OR At least one Visible Question (explicitly Shown or 
based on conditions)

If all Questions are explicitly Hidden, Page is not shown. A Page with all explicitly Hidden Questions 
must be set to Shown to pass in data.
• Explicitly set to Conditional (Hide this Page) and:

Criteria not met
AND
No Questions (To support text elements) OR At least one Visible Question (explicitly Shown or 
based on conditions)

If all Questions are explicitly Hidden, Page is not shown.
Next Page is displayed if there are no text elements on the Page, and data is collected in hidden fields.

4 A Question is considered Visible for survey taking and validating records if:
• Explicitly set to Shown
• Explicitly set to Conditional (Show this Question) and criteria met
• Explicitly set to Conditional (Hide this Question) and criteria not met

5 Validation
• If a Question is explicitly set to Hidden or Hidden (based on conditions), no validation is 

performed on it.
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• If a Question is explicitly set to Shown or Visible (based on conditions), validation is performed on 
it.

6 Special rules for Questions which are Hidden (based on conditions) and do not contain preselected 
values on Pages considered Visible by Rule 3:
• Fields are set to Not Asked (NULL) during survey taking and validating records.
• Question and Choice Destinations are not evaluated.
• Fields are treated as Not Asked (NULL) for all other Logic (Advanced Branching, Triggers, Quotas, 

Visibility, etc.).
7 Special rules for Questions which are explicitly set to Hidden or Hidden (based on conditions) and 

contain preselected values on Pages considered Visible by Rule 3:
• Fields are allowed to collect data in Survey Engine
• Fields are allowed to contain data in Validate Records

8 Jump Page
• A Page which is explicitly set to Hidden or Hidden (based on conditions) does not appear in Jump 

Page.
• A Question which is explicitly set to Hidden or Hidden (based on conditions) does not appear in 

Jump Page.
9 Results Pages

• A Page which is explicitly set to Hidden or Hidden (based on conditions) does not appear in Results 
Pages.

• A Question which is explicitly set to Hidden or Hidden (based on conditions) does not appear in 
Results Pages.

 When copying and pasting survey elements with the applied Conditional Visibility settings, 
remember that the visibility settings can be stripped and set to Shown if they are not valid 
anymore (for details, see Copying Conditional Visibility, page 518).
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Exporting Conditional Visibility
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 
Design tab > add conditional visibility to pages, questions, and choices > Actions menu  > select the 
Export option > Conditional Visibility notifications in the exported file.

You can define whether certain survey pages, questions, and choices are shown, hidden, or conditionally 
visible. When you export the survey with conditional visibility to the Microsoft Word or Adobe PDF 
format, the corresponding notification appears in the export file. The notification also includes a 
description of the visibility criteria that must be met.
The pages and questions with the Hidden visibility status are not exported.

 Notification about the page conditional visibility appears at the beginning of a survey page.

Notification about the question conditional visibility appears above the question.
Notification about the choice or row conditional visibility appears above the question.

To test, create a survey with conditional visibility. Then, export your survey to Microsoft Word or Adobe 
PDF and see the visual references included in your export file as in the example above.
If you use an Microsoft Word file, import to create your survey, the conditional visibility logic is imported 
as a comment in the questionnaire. In order for this functionality to work properly, you need to program 
this functionality manually (conditional visibility) once you complete the import.

Procedure 
1 Go to the My Surveys grid, and then create a new survey or open an existing one. 
2 Define the visibility criteria for the survey pages, questions, and choices.
3 On the Actions menu, click Export, and then select the Microsoft Word or PDF option.
4 When exporting to the Microsoft Word format, select the Content Review survey type to export all 

the survey conditional visibility, and then click the Export button.
5 The export file is generated in the selected format.
6 To save or open the file, click the link with the file name.
7 Click Close. 

In the exported survey, you can see the notifications about the conditionally visible pages, questions, 
and choices.
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Copying Conditional Visibility
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 
add the Choose Many or Choose Many with Image question on the first page of your survey > add 
another page with any question > access the page, question, or choice visibility criteria builder.

When copying and pasting survey elements with the applied Conditional Visibility settings, take into 
account the following rules to avoid unexpected results in the flow of your survey:
• If visibility for the copied and pasted block (or parent block), page, question, or choice (column, 

topic, or row) is set to Conditionally Hidden or Conditionally Shown, it is stripped and set to 
Shown if visibility criteria become invalid due to the new position of the element. For example, the 
pasted page appears before the question that is referenced in the visibility criteria.

• When a block or page is copied and pasted:
• The Conditional Visibility settings for all its child elements are stripped and set to Shown if the 

visibility criteria reference questions within the copied block or page.
• The Conditional Visibility settings for its child elements remain unchanged if the visibility criteria 

reference questions that are before the copied block or page and are still valid for the current 
position of the pasted block or page.
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Least filled quota visibility condition
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 
add the Choose Many or Choose Many with Image question on the first page of your survey > add 
another page with any question > access the page, question, or choice visibility criteria builder.

You can use the Least Filled Quota functionality to specify what question, page, or choice is shown to 
users based on their previous answers.
This functionality allows you to follow a specified number of options chosen by the least amount of 
respondents by setting up the subsequent pages accordingly.
For example, you want to investigate 9 most popular pets in the country. You create a Choose Many 
question that contains typical animals as choices. You know that cats and dogs are the most widespread 
pets; however, you need information about other animals that are less popular. Also, you want an equal 
distribution of responses across all animals. For this, on the subsequent pages of the survey, you can ask 
about animals chosen by a minimum of respondents. For this purpose, use the Least Filled Quota 
functionality.
To set up the Least Filled Quota functionality, use the Is in Bottom option in the corresponding visibility 
dialog box. For details, see Add the least filled quota visibility condition, page 522.

 The Is in Bottom option is available only for the Modern survey rendering mode.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

Example:  
You are asking the respondents what pets they prefer.

Choose Many question
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On the subsequent page, the respondent is shown questions about the pet that has the least responses. 
This means that if the respondent chose cat and gold fish, and if the gold fish is one of the options with 
the least responses, the question about gold fish will be shown. If the number of responses is equal for 
two bottom options, then the subsequent page is selected randomly for one of them.

Subsequent page

Assume that a new respondent answers the Choose Many question about pets, and the previously 
collected responses are as follows:

Cat 235

Dog 400

Lizard 9

Hamster 321

Snake 8

Chinchilla 367

Gold fish 7

Spider 1

With the Least Filled Quota functionality turned on for the bottom two options, based on the 
respondent’s answers, the subsequent pages will be shown as follows:

1 option (chinchilla) Page for chinchilla

2 options (dog and hamster) Pages for dog and hamster

3 options (cat, dog, gold fish) Pages for gold fish and cat, because they have fewer 
responses than the other two

4 options (cat, dog, lizard, hamster) Pages for lizard and cat, because they have fewer 
responses than the other two
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Autoselection
With the autoselection feature, you can set up a Least Filled Choices condition for the Choose Many 
and Choose Many with Image questions. A defined number of least filled choices is autoselected, so 
that you can conduct a least filled quota analysis.
You can use autoselection in the following cases:
• If a respondent does not select any option, but you want to collect answers for the bottom two 

pets.
• If the question is hidden and you want to show pages for bottom two pets.
To set up autoselection, in the Question Options pane, in the Least Filled Choices section, select the 
needed item in the list.
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Add the least filled quota visibility condition
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 
add the Choose Many or Choose Many with Image question on the first page of your survey > add 
another page with any question > access the page, question, or choice visibility criteria builder.

Use the Least Filled Quota functionality to specify what question, page, or choice is shown to users based 
on their previous answers.

Procedure 

1 On the Content tab of the survey designer, on the  menu, click Add Conditional Visibility.
2 In the visibility criteria builder, in the first list, click the needed Choose Many choice.
3 In the second (expression)  list, click Is In Bottom.
4 In the third list, specify the needed value.

 A number of options available in the value list is one less than the number of the Choose Many 
choices.
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Create advanced criteria
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >  create a new survey or open an existing one > 

 menu of a needed survey element (question, page, block, etc.) > click Add Conditional Visibility > 
visibility criteria builder.

You can define the advanced conditional visibility criteria for your survey logic by combining different 
criteria using parentheses and And / Or operators.

Procedure 
1 In the visibility criteria builder, add several criteria (see Question Conditional Visibility, page 509).
2 Select the Advanced option next to Match. 

The And / Or operators and parentheses lists appear next to each criterion.
3 To group multiple criteria according to your needs, select the parentheses.
4 Select the And / Or operators to combine the defined criteria groups according to the logic that you 

need for the conditional visibility:
• The And operator denotes that two or more criteria are met at the same time.
• The Or operator denotes that one of the criteria is met.
For example, in a survey with four pages and four Choose One questions, you can define the following 
advanced criteria:
((Q1=1 OR Q1=2) AND (Q2=1 OR Q2=2)) Or (Q3=1 AND Q4=2)
In fact, we have six criteria here (Q1=1, Q1=2, Q2=1, Q2=2, Q3=1, and Q4=2) that are combined into 
advanced criteria by using the corresponding logical operators.

5 To manage your criteria, use the following options to the right of each criterion.
• Move Up – Move the criterion up in the list.
• Move Down – Move the criterion down in the list.
• Delete – Remove the criterion.
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Outline and Flow Overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Outline and Flow button.

You can view the outline of the survey questions and possible logical flows by switching to the Outline 
and Flow view during the survey designing or editing process. This can help to identify problem areas in 
your survey. You can access the Outline and Flow view from the survey designer by using the Outline 
and Flow button on the toolbar.
The Outline and Flow view displays the survey structure, including questions, pages, blocks, and logical 
flows like branching, visibility, destination, etc.
Under the toolbar, you can see a number of options, which you can use to customize the Outline and 
Flow view. The following options are available:
• View – Define the survey items that are displayed in the Outline and Flow view by selecting the 

corresponding check boxes to the right of the "View" option. The following options are available:
• Blocks – Show all page blocks.
• Pages – Show all pages.
• Branches – Show all branches and destinations.
• Logic – Show all decision points and conditional visibility indicators.
By default, all check boxes are selected even if the survey does not contain the corresponding items. 
For example, the "Branches" check box is selected even if there are no branches in the survey.
The element is hidden when you clear the corresponding check box. For example, when the "Blocks" 
check box is clear, all block entries become hidden. Selecting the check box will show them again.
Hiding elements does not change the behavior of the page. For example, if a branch skips two pages, 
those pages are skipped even when the branch is hidden.
The "View" settings are not saved across the sessions.

• Device Type – From the Device Type drop-down menu, you can select the Desktop or Mobile 
device type. According to the selected type, you can view the corresponding branching and 
conditional visibility of a survey. By default, the Device Type value is set to Desktop.

• Expand All – Show all decision points.
• Collapse All – Hide all decision points.
• Clear All – Clear and revert all decision points back to their original state.
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Survey pages and questions in Outline and Flow 
view

Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Outline and Flow button.

You can see all survey pages and questions in a single view by switching to the Outline and Flow view in 
the survey designer.
Each page and question has its own line in this survey outline. The page line is displayed as the word Page 
with the page number, for example, Page 1, and the page name to the right. Pages that do not have a 
name are called Untitled.
The question line is displayed as the question heading and text without any images or media. The 
question heading is highlighted in bold. When the question text contains many characters, it is 
abbreviated in the middle so that it does not exceed a single line. The icon showing the question type 
appears to the right of the question.
When the Answer Required option is activated for the question, an asterisk (*) appears to the left of the 
question in the Outline and Flow view.
For the Matrix questions, each topic and side combination appears on its own line.
When you hover over the question text, the fly-out with the full question appears. Images are not 
displayed in the Outline and Flow view, the image file name appears instead.
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End Pages and Custom End Pages in Outline and 
Flow view

Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Outline and Flow button.

You can see what type of end page is displayed to a respondent by switching to the Outline and Flow 
view in the survey designer.
The end page has its own line in the survey outline and appears below the last survey page. The end page 
is displayed as the word Page with the next incremental number and the end page type to the right. The 
type of the end page depends on the survey logic.
• If the respondent is branched to the end page, the end page is called End (Branched Out).
• If the respondent is branched to the custom end page, the name of this custom end page is 

displayed.
• If the respondent is not branched to the end page, the end page is called End (Survey 

Completed).

 The Survey Saved, Prevent Updates, Survey Closed, and Quota Reached end page types are not 
displayed in the Outline and Flow view.
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Page Blocks and other content in Outline and Flow 
view

Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Outline and Flow button.

You can see all page blocks and other survey content in a single view by switching to the Outline and 
Flow view in the survey designer.
Each block has its own line indicating the beginning and the end of each block. These lines appear as the 
word Block with the block number, and the word Begin or End to the right, for example, Block 1 
(Begin).
When the Random Order or Rotated Order option is activated for the page block, the corresponding 
notification appears at the beginning of the block in the Outline and Flow view.
The other survey items, such as section heading, code block, text block, and comment also appear at their 
own line in the Outline and Flow view. The icon showing the content type appears to the right of the 
survey item.
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Branches and Destinations in Outline and Flow view
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Outline and Flow button.

You can see the destination and branching applied to the survey and test the survey logic by switching to 
the Outline and Flow view in the survey designer. Each branch and destination has its own line in the 
survey outline.
The branch line starts with the words Branch to: followed by the destination page and branching criteria 
indicating the question that the branching is applied to. If you hover over the question, a tooltip 
containing the full question text appears.
The destination line starts with the word Destination followed by the destination page and the 
destination criteria to the right. If you hover over the question, a tooltip containing the full question text 
appears.
If the page contains more than one branch or destination, they appear according to their evaluation 
order.
The Decision Point icon appears to the left of the question where the branching or destination occurs. 
When you click the Decision Point icon,  the Choices section expands displaying question choices. 
When the choice text contains many characters, it is abbreviated. You can hover over the choice to see 
the full choice text in a tooltip. For the Choose One with Image and Choose Many with Image questions, 
the image appears in a tooltip.

 The Choices section is collapsed by default.

The Decision Point icon appearance depends on whether the Choices section is collapsed or expanded.
Clicking the icon again will collapse the Choices section back to its original state.
You can interact with the survey by clicking a choice to see where the respondent is taken in the survey. 
Both the question choice and the destination applied to it appear in green color. The survey content 
becomes hidden based on what a respondent will see when taking the survey.
For the Choose One or Choose Many question, each choice appears as a button.
For the Fill in the Blank or Essay question, a text box appears next to each choice. Enter the text in the 
text box and click the Apply link to the right of it to test the survey flow. For the Fill in the Blank 
questions with the Dates input type, the date picker appears when you click the date field.
To clear your selections, click the Clear Responses link to the right of the question. When you clear the 
choice selection, the survey flow is re-evaluated.
When a question has no choice selected, it is treated as not asked in reference to the survey flow.
If you select a choice with no destination applied, the survey flow is not affected.
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Conditional Visibility in Outline and Flow view
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design view > Outline and Flow button.

You can see which pages and questions are conditionally hidden or shown by switching to the Outline 
and Flow view in the survey designer. The Conditional Visibility icon appears to the left of the question 
or page where the visibility logic is applied.
If you hover over the icon, a tooltip containing the full visibility criteria appears.
You can interact with the survey by clicking a choice to see when the survey page or question is shown or 
hidden based on a set of pre-defined criteria. The Conditional Visibility icon changes its color 
depending on the visibility status of the page or question in the following way:

 – The icon appears for the Hidden status.
When the survey page is conditionally hidden, the page line is inactive, and its content is hidden.
When the survey question is conditionally hidden, the question line appears as inactive, its content is 
hidden, and the question text is struck through. Such question is treated as not asked in reference to the 
survey flow.
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List of indicators in Outline and Flow view
The list of indicators used in the Outline and Flow view:

The Decision Point icon for the collapsed Choices section.

The Decision Point icon for the expanded Choices section.

The Conditional Visibility icon for the survey pages and questions with 
the Hidden status.

The criteria icon for the questions containing destination or branch.

The Answer Required icon for questions.

The Rotated Order notification for the page blocks.

The Random Order: All notification for the page blocks.

The Random Order: # Page(s) notification for the page blocks.
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Piping values in the Question and Response Text
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content tab > select a question > click  icon.
You can insert a respondent's answer from a question into a later question in your survey. You can pipe 
values both in the question text and response text (the choice, topic, row, column, and category text). 
Also, you can pipe values in the choices that will be preselected for particular topics in the Fill in the 
Blank question.
For the Matrix and Scale Slider questions, you can use the piping functionality when defining the 
number of topics or sliders that should be visible to the respondents. In this case, the piping will work if 
the following two conditions are met:
1 There is a Fill in the Blank question on the previous pages of your survey.
2 The input type for the field from which you want to pipe a value is set to Whole Number.

 The Piping functionality requires that the source and target questions are separated by a page 
break.

Pipe Report Values
You can pipe report values to easily pass the underlying values for categorical variables and use it for 
conditional visibility, branching, and reporting.
When piping a value, below each question you can see the report value for that question in the following 
format: Report Value for <question>.

Pipe Export Values
In Modern survey rendering mode, you can pipe export values defined for the question choices.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

The selected choice with the defined export value is piped into the question text or response text of the 
next page, if it is selected by the respondent. If the selected choice does not have an export value 
defined, it is piped into the question text or response text of the next page, but the choice value is 
returned. If the choice is not selected, but is piped, the blank value is returned.

 For more information, see Piping export values, page 534.

Pipe Response Counts
In Modern survey rendering mode, you can pipe the count of responses selected in Choose Many, 
Matrix with Choose One or Choose Many sides, and Scrolling Matrix questions into the question 
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text or response text of the next page. When a respondent takes your survey, the count placeholder is 
replaced with the number of answers provided by the respondent.

 The count placeholder for the Choose Many question is [[Question Title]][Q ID]CNT; the count 
placeholder for the Matrix with Choose One or Choose Many sides, and Scrolling Matrix 
questions is [[Question Title]][Q ID]_[Side]_[RepsponseID]CNT.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Pipe Respondent Fields and Respondent Location values 
You can pipe Respondent Fields and Respondent Location values into question, choice, and topic text 
by using the Other side tab in the Insert Piped Value dialog box. For details about Respondent Fields 
and Respondent Location data, see Properties, page 482.

Pipe values for multi-campaign surveys
When you add multiple campaigns to your survey, piped values for the Invite Panelists campaign are 
hidden from the respondents that belong to other campaign types. Therefore, the question is shown, but 
the question placeholder is blank.

Pipe values from the file import
You can pipe values from file import into question, choice, and topic text and as preselected responses 
into Short Answer, Fill in the Blank, and Essay questions. For details, see Pipe values from a file 
import, page 548.

 Piping from file import is available only for the surveys that have participants added from this file 
import via the Add Participants to a Survey trigger (see Create a file import trigger, 
page 1175).

How to Pipe Values

 In the following example, Fill in the Blank questions are used.

Procedure 
1 On the Content side tab of the Design tab, add a Fill in the Blank question, and then insert a page 

break.
2 On the second page of your survey, add another Fill in the Blank question.
3 On the editing toolbar, click the  icon.
4 On the Insert Piped Value dialog box, click the Questions tab, and then select the question from 

which you want to pipe data.
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5 Click OK.
The placeholder for the selected value is inserted in the question text. For more information, see Piping 
export values, page 534.

 In the Insert Piped Value dialog box, you can also pipe the following values by clicking the 
Other tab: Survey URL, Culture, Key 1, Key 2, Key 3, Group ID, Project ID, Record ID, Panelist ID, 
Session ID, and also the following respondent location values: City, State/Province, Country, and 
Zip Code/Postal Code.
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Piping export values
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content tab > select a question > click  icon.
You can pipe the defined export values both in the question text and response text (the choice, topic, row, 
column, and category text). Also, you can pipe values in the choices that will be preselected for particular 
topics in the Fill in the Blank question.

 You can pipe export values only in Modern survey rendering mode.
Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

In the Insert Piped Value dialog box, placeholders appear for all choices of Choose One, Choose 
Many, and Matrix (with Choose One and Choose Many sides) questions that have an export value 
defined, similar as for report values.

 Piping export values in the Scrolling Matrix, Scale Slider, and RankOrder questions works in 
the same was as for the Matrix with the Choose One side questions.

You cannot define export values for the Fill in the Blank, Short Answer, Essay, Matrix (with Short 
Answer and Essay sides), and Drag & Drop Rank Order questions.

 The Piping functionality requires that the source and target questions are separated by a page 
break.

The export value which is defined in the selected choice is piped into the question text or response text of 
the next page. If the selected choice does not have an export value defined, it is piped into the question 
text or response text of the next page, and the choice value is returned. If the choice is not selected, but is 
piped, the blank is returned.
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Insert piped values into code blocks
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content  tab > select a question > click  icon.
You can insert the piped values into code blocks to enhance your own JavaScript code in the survey.

 The Piping functionality requires that source questions and code blocks are separated by a page 
break.

Procedure 

 In this example, the Choose One question is used.

1 In the Design view, add the Choose One question.
2 On the next page, in the Add Other Content area, click the Code Block.
3 Click the Click to edit code block text and enter the code.
4 On the editing toolbar, click the  icon.
5 In the Insert Piped Value dialog box, select the value that you want to insert into the code block, 

and then click OK.
The piped value is inserted into the code block.
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Export values – placeholder formats
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content tab > select a question > click  icon.
There are different placeholder formats for export values for certain types of questions.
 

Placeholder format Question types

%[1]Q1EVAL% Choose One questions.

%[1]Q1EVAL_1%
%[1]Q1EVAL_2%

Choose Many questions.

%[1]Q1_A_1EVAL%
%[1]Q1_B_2EVAL%
%[1]Q1_C_3EVAL%

Matrix questions with the Choose One side.
If there is more than one side added, the corresponding 
letters are specified in the placeholder (A, B, C, and so 
on).

%[1]Q1_AEVAL_1%
%[1]Q1_BEVAL_2%
%[1]Q1_CEVAL_3%

Matrix questions with the Choose Many sides.
If there is more than one side added, the corresponding 
letters are specified in the placeholder (A, B, C, and so 
on).
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Adding Choice List
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 

>  Design tab > Content tab > select a question > click  icon > Pipe in Topics option.
You can insert responses from any Choose Many, Choose Many with Image, Matrix, or Scrolling 
Matrix question into the topics, rows, or columns of a later question in your survey. The corresponding 
images are also piped in the target questions provided that they support images.

 The Piping functionality requires that the source and target questions are separated by a page 
break.

You can pipe responses into the questions of the following types:
• Matrix (does not support responses with images)
• Drag & Drop Rank Order
• Rank Order (does not support responses with images)
• Scrolling Matrix

 If you pipe the respondent's answers, you cannot add any additional responses.

See an example below where a respondent answers a question, and then the selected responses are 
piped into the next question.

Piping Choices and Topics

Procedure 
In this example, the Matrix and Rank Order questions are used.
1 On the Content tab of the Design tab, add a Matrix question.
2 Insert a page break.
3 Add a Rank Order question.

 To prevent validation that the piping cannot meet, indicate that the respondent must rank all 
topics in your Rank Order or Drag & Drop Rank Order question.

4 Click the  icon  next to any topic in your Rank Order question. 
5 On the  menu, click Pipe in Topics. 
6 In the Piped Choices dialog box, select the column of your Matrix question that you want to use for 

piping.
7 Indicate whether to pipe Selected or Not Selected responses.
8 Click OK. 
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 Click the Clear Piping link below the topics to remove the piped responses. For the columns of 
the Matrix questions, the Clear Piping option is available on the drop-down menu at the 
column level.
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Piping in topics
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option 

> name a new survey >  Design tab > Content  tab >  click a question >  click  icon > Pipe in Topics 
option.
You can insert responses from any Choose Many, Choose Many with Image, Matrix, or Scrolling 
Matrix question into the topics, rows, or columns of a later question in your survey. The corresponding 
images are also piped in the target questions provided that they support images.

 The Piping functionality requires that the source and target questions are separated by a page 
break.

You can pipe responses into the questions of the following types:
• Matrix (does not support responses with images)
• Drag & Drop Rank Order
• Rank Order (does not support responses with images)
• Scrolling Matrix

 If you pipe the respondent's answers, you cannot add any additional responses.

Example: The respondent answers a question, and then the selected responses are piped into 
the next question.

The source question
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The destination question

Piping choices and topics

Procedure 
1 Go to the Design tab > Content tab, add a Matrix question.
2 Insert a page break.
3 Add a Rank Order question.

 To prevent validation that the piping cannot meet, indicate that the respondent must rank all 
topics in your Rank Order or Drag & Drop Rank Order question.

4 Click the  icon next to any topic in the Rank Order question. 

5 On the  menu, click Pipe in Topics.  
6 In the Piped Choices dialog box, select the column of the Matrix question that you want to use for 

piping.
7 Indicate whether to pipe Selected or Not Selected responses.
8 Click OK. 

A placeholder is inserted instead of the topics.

 Click the Clear Piping link below the topics to remove the piped responses. For the columns of 

the Matrix questions, the Clear Piping option is available on the  menu at the column level.
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Piping Responses
Navigation

Design & Collect tab > Surveys tab > My Surveys page > New menu  > Design from Scratch option 

> name a new survey >  Design tab > Content tab >  click a question >  click  icon > Pipe in Topics 
option.
You can insert responses from multiple columns and questions into the topics, rows, or columns of your 
Matrix, Drag & Drop Rank Order, Rank Order, or Scrolling Matrix question. The corresponding 
images are also piped in the target questions provided that they support images.

 The Piping functionality requires that the source and target questions are separated by a page 
break.

You can pipe multiple responses from the questions of the following types:
• Choose Many
• Choose Many with Image
• Matrix
• Scrolling Matrix

Rules for Piping
The following rules apply to piping from the multiple questions and columns:
1 For the Choose Many questions, you select whether to show Selected or Not Selected responses 

for the whole question, not for the individual topics.
2 For the Choose Many of a Matrix question, you select whether to show Selected or Not Selected 

responses for an individual column.
3 You cannot pipe responses from the same column or Choose Many question twice. After piping 

from a column or question, that column or question is removed from the piping list for that question 
to avoid confusion.

4 If there is a conflict of piping criteria and the logic is set to show and then not to show the same 
response, the response is shown by default.

Duplicate Topics
When you pipe topics from different sides of a matrix, these sides are treated as separate questions. So, 
you can accidentally repeat topics if you pipe them from a multi-sided matrix or from multiple questions 
with the same choice lists. Make sure the topics are not duplicated when you design your survey.

Piping from Multiple Questions and Columns
In this example, the Matrix and Rank Order questions are used.
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Procedure 
1 On the Content tab of the Design tab, add a Matrix question.
2 Insert a page break.
3 Add a Rank Order question.

4 Click the  icon next to any topic in your Rank Order question.
5 On the  menu, click Pipe in Topics. 
6 In the Piped Choices dialog box, select the column the column from which to pipe responses.
7 Indicate whether to pipe Selected or Not Selected responses.

 For example, if needed, you can choose to include the Selected responses from one question 
and Not Selected from another one.

8 Click OK. A placeholder is inserted instead of the topics.

 After piping from a column or Choose Many question, that column or question is removed as an 
option for that question.

9 Click the  icon next to the placeholder, and then repeat steps 5-8 to pipe multiple times.

 If you want to remove a particular placeholder, click Delete on the corresponding  menu. To 
delete all piped responses, click the Clear Piping link.
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Piping URL Query
To have a question that allows pulling a value from the URL into the survey, a placeholder is needed in the 
preselected area of the topic for Fill in the Blank , Short Answer, and Essay questions on the first page 
of a survey. See the Steps section below to locate the Preselected field of a Fill in the Blank question.

 The survey engine can only get values from the URL on the first page of the survey.

The placeholder is composed of a flag ("URL") and the variable name that the survey engine is going to 
look for in order to grab the value from the URL and put it into the question in the survey.
The placeholder will look something like %URL.id% and will be put under Preselected on the Topic 
Options panel for Fill in the Blank, Short Answer, and Essay questions on the first page of the 
survey.
For example, %URL.first%, %URL.last%, and %URL.zip% can be used to add the first name, last name, and 
zip code into the survey. The used URL is the default URL of the survey with an added ampersand and 
then the variables and values for the information to pass into the survey. In Modern survey rendering 
mode, the survey URL is different and you need to add ?before the first parameter.
Based on the example above, the URL looks this way:
Classic survey rendering mode

http://survey.vovici.com/se.ashx?s=091430145468A283&amp;first=John&amp;last=Smith&amp;zip=90
210

Modern survey rendering mode

http://survey.vovici.com/se/091430145468A283?first=John&amp;last=Smith&amp;zip=90210

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Procedure 
1 Add a Fill in the Blank (Short Answer or Essay) question on the first page of your survey.
2 Click the topic within the Fill in the Blank question.
3 In the Topic Options panel, type the desired placeholder in the Preselected box. Repeat if needed 

for additional values to be piped in.
4 Design the remainder of the survey, test and/or open the survey and add the variables and values to 

the URL.

 Passing variables from the URL into the survey is not foolproof. Smart users can change values in 
the URL, some browsers will not pass the values properly to the survey engine and in some cases 
the code we use in the survey will not run and populate the values in the fill in the blank topics.

If there is information about a participant that is known and that needs to be part of the survey 
responses, it is best to use the Create a List, Require a Passcode, or Invite Panelists types of survey 
distribution and preload the data with the participants or panelists.
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Hidden IDs and Piping URL Query String Parameter Value

Hidden IDs
You can pipe additional information into a survey by using the survey link.

Part A. Determine the Placeholder

The placeholder is what takes the place in the survey for the value being piped in the URL. This should be 
determined first.
A "%" sign is needed at the beginning and at the end of the placeholder. This tells the survey engine to 
pipe values into the survey. The text URL in capital letters tells the survey engine to pipe the value of the 
identifier from the survey URL into the survey. A period (.) separates the URL and the identifier.
%URL.identifier%
For example:
First Name to %URL.first%
Last Name to %URL.last%
Zip Code to %URL.zip%

Part B. Build the URL

An ampersand followed by the identifier tells the survey engine a value is to be piped into the survey. If 
you use Modern survey rendering mode, you need to add a question mark before the first parameter.

Example:  
Classic survey rendering mode

http://www.surveys.com/Vovici/se.ashx?s=0B87A62B33A0810F&amp;first=Bob&amp;last=Gates&amp;
zip=94102

Modern survey rendering mode

http://www.surveys.com/Vovici/se/0B87A62B33A0810F?first=Bob&amp;last=Gates&amp;zip=94102

 The survey invitation designer does not support passing the identifier using this URL. These 
instructions should be used primarily for passing data to a survey from an existing URL or when 
using a third party mailer when more secure methods are not available, such as pre-loading data 
by .CSV/.TSV (using an External Access List), Web services or using borrowed questions or piping 
within the survey.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, Classic survey rendering will not be supported.

Part C. Setting up the Hidden ID question

1 Add a Fill in the Blank question as the first question in your survey.
For example:
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Please provide some demographic information
First Name _________
Last Name _________
Zip Code ___________

2 Hide the question by using the Visibility section on the Question Options panel. Ensure that the 
Show Question Heading and Show Question check boxes are not selected.

3 Enter the desired placeholder under Preselected.
4 Design the remainder of the survey, save and publish the survey.
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Piping Responses in the Case Properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content tab > add a Choose One or Fill in the Blank question > Triggers tab > Add 
Trigger button.
You can pipe question responses into the custom properties of the cases created by triggers. When the 
trigger is activated, the response used by trigger criteria is applied to the newly created case as a custom 
property.

 The case triggers are available only if you have a license for the Case Management feature.

When the survey responses are piped into a case custom properties, the system maps them to the 
available property choices. If they match, the case property is set. If they do not match, the response is 
added to the choices' list of the custom property, but not applied to the case. In the multiple language 
surveys, only the default survey language is used for matching and adding the custom properties.
• For the Choose One question, the responses are piped into the Choose One custom property 

type.
• For the Fill in the Blank question with the Dates input type, the responses are piped into the 

Date custom property type.
• For the Fill in the Blank question with the Text input type and the Choose One question with 

the activated Please Specify option, the responses are piped into the Date custom property 
type.

You can create multiple properties from a single response.

Procedure 
1 On the Content tab of the survey designer, add a Choose One question to the survey.
2 On the Triggers tab, click the Add Trigger button. 
3 In the Add Trigger dialog box, in the Description text box, enter a short summary of the trigger.
4 On the Trigger Action menu, select the Create a Case option.
5 On the Criteria tab, define the trigger criteria.
6 Click the Case Details tab.
7 On the Case Details tab, define the case details.

 The case properties are available only if specified on the Case Setup tab by Case Administrator.

8 In the Custom Properties section, click the  icon next to the custom property into which you want 
to pipe the survey response. 

9 In the Insert Piped Value dialog box, select the question that you want to use for piping.
10 Click OK. 
11 In the Add Trigger dialog box, click OK.
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Using Mathematical Formulas in the Preselected 
Fields

Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content tab > select a Fill in the Blank or Short Answer question.
You can apply various mathematical formulas to the preselected fields of the Fill in the Blank and 
Short Answer questions in your survey. For example, you can calculate a total for particular fields of the 
Fill in the Blank questions in your survey so that this total is shown in a particular preselected topic of a 
particular Fill in the Blank question. This feature is called Calculate Fields. The data obtained through 
calculations can be used for later data analysis.

 The input type for the fields of the above-mentioned types of questions must be set to Whole 
Number or Real Number if you want to apply the Calculate Fields feature to these fields. 
Otherwise, the values entered in the fields will be ignored.

In the example below, the following Fill in the Blank question is added to your survey.
The following formula can be applied to the preselected Total topic: %[1]Q1_1%+%[1]Q1_2%+%[1]Q1_
3%+%[1]Q1_4%+%[1]Q1_5%+%[1]Q1_6% (no spaces).
When the respondents take the survey, the values entered in each field of this question will be added and 
the total will be displayed in the Total field (the total will be calculated each time a value is entered in any 
of those fields).

 More complicated mathematical formulas can be used, such as %[1]Q1_1%*(%[2]Q2_1%+%
[2]Q2_2%).

Procedure 
1 On the Content tab of the Design tab, add a Fill in the Blank question.
2 Make sure that the fields that you want to use in calculations are of the Whole Number or Real 

Number input types.
3 Select the topic that you want to be predefined by default.
4 On the Topic Options panel, under Preselected, enter the appropriate mathematical formula in the 

text box. The mathematical formula appears in the text field next to the preselected topic.
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Pipe values from a file import
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Content tab > select a question > click  icon.
If you added participants to your survey from file import by using the Add Participants to a Survey 
trigger (see Create a file import trigger, page 1175), you can pipe values from this file import into 
question, choice, and topic text and as preselected responses into Short Answer, Fill in the Blank, and 
Essay questions.

 Piping from file import is available only for the Create a List and SMS surveys.

Procedure 
1 On the Content tab of the Design tab, select the needed question.
2 To insert the file import value into the question, choice, or topic text of any survey question, click the 

needed label, and then on the editing toolbar, click the  icon.
3 To insert the file import value into a Short Answer, Fill in the Blank, or Essay question as a 

preselected response, in the Question Options or Topic Options panel correspondingly, click the 
 icon  in the Preselected section.

4 In the Insert Piped Value dialog box, click the File Imports tab, and then select the file import field 
that you want to insert into the selected question text or response.

 The File Imports tab is available only if the Add Participants to a Survey trigger is defined for 
this survey under File Import tab of the Data Sources tab (see Create a file import trigger, 
page 1175).

5 Click OK.
The value placeholder is inserted into the selected question text or response.

When a participant that was added from the file import takes the survey, the value from the 
corresponding file import field is inserted into the selected question, choice, or topic text or as a 
preselected response for the corresponding question.

 If you delete a  file import that is used as a source for piping, then the corresponding piped values 
will return no data.
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Survey Status
Since the product is built to be a workflow environment, the survey design is broken up into different 
stages. These stages are assigned a Survey Status where in some cases only certain features can be 
accessed. This is important to keep in mind as your survey progresses through the survey life-cycle.

Status Details
• Design status, page 550 – This is the state before the survey is opened for the first time.
• Test Mode, page 551 – After the survey is created, it enters Test mode. All features of the survey 

should be tested at this time, before the survey is opened.
• Open a survey, page 553 – The survey is "live" and collecting real data from the survey 

participants.
• Closed survey, page 554 – The survey is closed and no longer collecting results. The survey can be 

re-opened under Schedule. Any participants accessing the survey will see the survey's Closed 
Page.
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Design status
Each survey begins with this survey status. This is the early design phase of the survey.
Since the data tables do not exist until the survey is opened (only at that point the product knows what 
number and type of questions are going to be asked), some features are limited.

What can be edited when a survey is in the Design status
Surveys with the Design status only allow access to the following areas:
• Survey Designer – Used to create and modify the survey.
• Manage Participants – Select the survey respondents. The Participants link is not available for 

the Generate Link survey distribution type.
• Write Invitations – Compose the invitation text.
• Schedule – This would not generally be used until a survey is designed. It could be used to deploy 

a survey that was created from an existing questionnaire, template, or imported questionnaire 
file.

What cannot be edited when a survey is in the Design status
Survey with the Design status has some limitations. Since the data table for the survey is not created yet, 
the following features cannot be accessed:
• Publish Location – There will be no URL to view the survey as it does not appear online until you 

open it.
• Response Manager page.
• My Reports page.
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Test Mode
You can test your survey using the Test button. Test mode allows the greatest range of features to be 
accessed during the survey design process. This allows the survey to be tested in almost every way 
possible, modified if needed, and tested again, until everyone working on the survey is satisfied with it.
All features of the survey should be tested at this time, before the survey is opened.
A simple example of what should be tested is:
• Survey Appearance – Look and feel (survey theme especially) of the survey, such as the 

question order, structure, and design.
• Functionality – How the survey functions, such as branching, validation, scoring, and end pages.
• Survey data – If data can be extracted from the survey test results in the desired format. 

Ultimately, the survey is created to collect data that either provides information to build a future 
plan or to rate past performance. If the current design of the survey does not provide the desired 
information, it needs to be fixed in Test mode. Waiting until after the survey is Closed is too late.

• Reporting – If the reports generated for the survey make sense and contain the right 
information for the questions being asked. Different questions have different options when 
reporting. It is important to be sure that the presentation of the data in reports is what is wanted.

 Republishing a survey in Test mode will result in the data table for the survey being dropped and 
all test records will be deleted. This is important to note if testing on the survey data is still being 
conducted.

What can be edited in Test mode
Test mode allows all sections of survey design to be edited.

What cannot be edited in Test mode
There are no restrictions in Test mode about what can be edited.

What features work differently in Test mode
The following features work differently in Test mode.
• Invite Panelists surveys – As soon as a workgroup member has been added on the Manage 

Participants page, opening survey from the Collect tab will allow surveys to be submitted.
• Create a List surveys – After a participant has been added under Manage Participants, 

opening survey from the Collect tab will allow surveys to be submitted.
• Allow respondent to update completed survey – This is unavailable while a survey is in Test 

mode. This option is set on the Properties side tab, which is accessed from the left pane in the 
survey designer. This allows taking the survey more than once while testing it and checking the 
survey logic properly. Once a survey is opened, this feature will be turned on and only one 
submission per respondent will be allowed.
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• Resume survey from last page – This is unavailable in Test mode, so that survey logic 
(branching, email triggers, conditional responses, and so on.) is tested.

• Data table dropped on republish – When the survey is republished in Test mode, the survey’s 
data table is dropped, deleting all current responses. This is why it is important that the survey is 
opened from the Schedule page before collecting live data.
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Open a survey
An open survey collects live data to the database for analysis. Once a survey is opened some features can 
no longer be accessed. The sections below explain what can and cannot be edited, added or deleted 
depending on the survey status.

What edits can be made while the survey is Open
A survey that has the Open status allows the following items to be edited:
• All questions can have the following items edited:

• Question headings
• Question text
• Choice and topic text
• Images

 The modification of the previously published questions might impact the collected results.

• Text block (images and media can be added as well)
• Page breaks
• Section
• Comments
The following modifications can be performed:
• Move items up or down, except for choices
• Delete the following items:

• Text block (including images and media)
• Page breaks
• Section
• Comments

Full questions of all types can be added to the survey.

What cannot be edited while the survey is Open
A survey that has the Open status restricts the following items from being edited:
• Add, delete, or move choices
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Closed survey
This is generally the last stage in the survey life cycle. A closed survey no longer collects new data. A 
participant trying to access a closed survey will see the survey's Closed page. Once the survey is closed, 
data analysis begins (although, inside the product, the data can be analyzed at any time in the process).

What can be edited while the survey is Closed
A survey that has a status of Closed allows the following things to be edited:
• The survey can be re-opened from the Schedule page.
• Reports can be created, edited, and viewed from the My Reports page.
• Survey data can be viewed, modified, and deleted from the Response Manager page.

What cannot be edited while the survey is Closed
A survey that has a status of Closed restricts all of the items not mentioned above from being edited.
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Reopen a closed survey
After a survey has been closed it is still possible to open the survey again on the Schedule page. This can 
be used to collect more results to the data table.
When a survey is reopened, the status is changed to Open.

Reopen a survey immediately

Procedure 
1 On the Collect tab of the survey, click the Schedule link. The Schedule page opens.
2 In the row labeled Open Survey, click the Now  icon. The confirmation dialog box opens, and then 

click OK.

Reopen a survey at an assigned time

Procedure 
1 On the Collect tab of the survey, click the Schedule link. The Schedule page opens.
2 Select the check box to the left of the Open Survey.
3 Click the Edit button on the toolbar. The New Task – Open Survey dialog box opens.

4 Specify the Start day from the calendar by using the Calendar .

5 Specify the time from the drop-down menu by using the Clock icon  .
6 In the Recurrence section, specify whether to open your survey multiple times for a set or infinite 

period. You can set your survey not to open or open daily, weekly, or monthly.

 For more information, see Survey schedule options, page 675.

7 In the Range of Recurrence section, set an end date by using the End By option or select No End 
Date.

8 In the Advanced section, define whether to receive an email confirmation when the task is complete, 
and then clock OK.

 If you reopen the survey, the scheduled responses delivery is performed till the end date expires.
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SMS survey overview
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > New menu on the toolbar > click the Design 
SMS Survey option.

You can create SMS surveys by using the EFM standard interface. You can design surveys that will be sent 
to participants as SMS (Short Message Service) messages.

 You need to have a license for the SMS feature to design, author, and distribute your SMS 
surveys.

SMS surveys allow establishing instant connection with customers and getting in-the-moment feedback 
that ensures higher response rates.
The SMS survey questions are passed to the SMS interface module and formatted for transmission to 
SMS Gateway. From there, they are delivered to the specified mobile participants. The first SMS message 
sent to the participants denotes they are invited to take the SMS survey. After getting the feedback, you 
can manage the achieved responses and have them analyzed with EFM and Text Analytics.
SMS feature is fully integrated into the EFM application, which allows using the standard EFM 
functionality with certain limitations. There is no option to redesign an SMS survey to be an online survey.
 



SMS surveys Activate SMS Survey feature for a user role

EFM User Guide 558

Confidential and Proprietary Information of Verint Systems Inc.

Activate SMS Survey feature for a user role
Navigation

Administration tab > Roles tab > select the role that you want to edit > Edit Role page.

The group and survey administrators can control if the workgroup members can create and distribute SMS 
surveys based on the user role set of permissions.
You can activate the SMS Surveys functionality for a user by creating a new role or editing the existing 
ones. By default, the SMS Surveys permission is enabled for the Group Administrator, Survey 
Administrator, and Survey Author roles.

 If the SMS Surveys feature is disabled for a user, the access to the previously created SMS 
surveys is still available.

Before you begin 
• Verify that you have a license for the SMS feature.

Procedure 
1 Go to the Administration tab > Roles tab.
2 Click the name of the role that you want to edit.
3 On the Edit Role page, in the Surveys section, select the SMS Surveys check box.
4 Click Save.
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SMS Gateway Settings
Navigation

Configuration tab > SMS Gateway Settings tab > SMS Gateway Settings page.

You can define the SMS gateway settings for your workgroup. By default, the SMS gateway settings are 
read only. To edit the SMS gateway settings, select the Enable SMS Gateway check box.

 The SMS Gateway Settings tab is only available for the workgroups with the SMS license 
enabled. To enable the license, contact your System Administrator.

In the SMS Gateway Type list, you can select the type of the SMS gateway to be used: OPG, SMPP, 
MacroKiosk,  Telefonica SDF, or Twilio. The default value is OPG.

OPG SMS gateway type
The following settings are available for the OPG SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
Incoming Message Settings
• Incoming Message URL – URL to which the SMS gateway sends messages.
• Incoming Message Username – User name used by the SMS gateway when sending messages 

to the EFM system.
• Incoming Message Password – Password used by the SMS gateway when sending messages to 

the EFM system.
Originating Number Settings
• Originating Number – Number from which the participants receive messages and to which they 

can reply.
Invitation Originating Identity Settings
• Invitation Originating Identity - Originating number or branded text that the invitation 

message comes from. This setting is optional.
• Request Reply for Contact List Invitations - Option that indicates if the message can be 

replied to the sender. When the check box is selected, then originating number is used for sending 
the invitation messages. By default, the check box is cleared, in this case the participants receive a 
message from the company.
This value applies only to SMS invitations and does not apply to two-way SMS surveys.

Extended parameters
• Send Message Encoding – Gateway specific coding that is used for SMS messages. The default 

value is windows-1252.
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
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• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

SMPP SMS gateway type
The following settings are available for the SMPP SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
• Second Outgoing Message Server – Backup server or address for sending messages via the 

SMPP-Type 1 SMS gateway.
• Port – Port for sending messages via the SMS gateway.
• SMPP Version – Indication of the SMPP protocol version. The default value is v3.3.
Originating Number Settings
• Originating Number – Number from which the participants receive messages and to 

which they can reply.
• Source TON – Type of number (TON) value of a sender for sending messages via the SMS 

gateway.
• Source NPI – Numbering plan identification (NPI) value of a sender for sending messages via the 

SMS gateway.
• Destination TON – Type of number (TON) value of a recipient for sending messages via the SMS 

gateway. The default value is 0.
• Destination NPI – Numbering plan identification (NPI) value of a recipient for sending messages 

via the SMS gateway.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from. This setting is optional.
• Invitation Source TON – TON value of a sender for sending the first messages via the SMS 

gateway.
• Invitation Source NPI – NPI value of a sender for sending the first messages via the SMS 

gateway.
• Invitation Destination TON – TON value of a recipient for receiving the first messages via the 

SMS gateway. The default value is 0.
• Invitation Destination NPI – NPI value for receiving the first messages via the SMS 

gateway.
Extended Parameters
• Receiver Parameters – Parameters of a recipient.
• Transmitter Parameters – Parameters of a sender.
• Send Message Encoding – Gateway specific coding that is used for SMS messages. The default 

value is utf-8.
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
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• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

MacroKiosk SMS gateway type
The following settings are available for the MakroKiosk SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
Incoming Message Settings
• Incoming Message URL – URL to which the SMS gateway sends messages.
Originating Number Settings 
• Originating Number – Number from which the participants receive messages and to which they 

can reply. 
• Originating Routing Token – Value used for sending messages via the SMS gateway. This 

setting is optional.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from.  This setting is optional.
• Service ID – Value used for sending messages via the SMS gateway.
Extended Parameters
• Send Message Encoding – Gateway specific coding that is used for SMS messages. The default 

value is utf-8.
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

Telefonica SDF SMS gateway type
The following settings are available for the Telefonica SDF SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
• Outgoing Header Username – User name value used to communicate with the SMS gateway.
• Outgoing Header Password – Password value used to communicate with the SMS gateway.
Incoming Message Settings
• Incoming Message URL – URL to which the SMS gateway sends messages.
• Incoming Message Username – User name used by the SMS gateway when sending messages 

to the EFM system.
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• Incoming Message Password – Password used by the SMS gateway when sending messages to 
the EFM system.

Originating Number Settings
• Originating Number – Number from which the participants receive messages and to which they 

can reply.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from.  This setting is optional.
Extended Parameters
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

Twilio SMS gateway type
The following settings are available for the Twilio SMS gateway type:
Twilio Settings
• Account SID and Authentication Token – Credentials that are received while configuring Twilio 

account. 
• Webhook URL – The URL to the machine where ESI service is running.
Originating Number Settings
• Originating Number – Number from which the participants receive messages and to which they 

can reply.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from.  This setting is optional.
Extended Parameters
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

General settings
The following settings are available for all SMS gateway types:
• Start Sending Time – Specifies the time of the day when sending of outgoing SMS invitation 

messages starts.
• Stop Sending Time – Specifies the time of the day when sending of outgoing SMS invitation 

messages stops.
• Sending Time Zone – Specifies the time zone used to interpret the Start Sending Time and 

Stop Sending Time.
• Sending Days – Specifies the days of the week when sending of outgoing SMS invitation 

messages occurs.
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• Opt Out Terms – Specifies the terms that, if included in a participant's response SMS, denote 
that a participant opts out of taking a survey. The default opt out term is stop. You can add more 
terms in a pipe (|) delimited list.

 If no sending days are selected, the error message notifying that no SMS invitation is sent 
appears after clicking the Save Setup button.

• Error Survey URL – Specifies the address of a survey that is used to collect error messages.
• Maximum Outgoing Messages per Second – Specifies the maximum number of outgoing 

messages per second. The default value is 0. This setting is optional.

SMS staging directories
For each valid SMS gateway, the defined SMS gateway settings are stored in the staging directories located 
in the AppData directory. You can find the staging directories in the following locations:
• {EFM install} AppData/{Groupld}/sms/incoming
• {EFM install} AppData/{Groupld}/sms/realtime
• {EFM install} AppData/{Groupld}/sms/archive
• {EFM install} AppData/{Groupld}/sms/error
• {EFM install} AppData/{Groupld}/sms/process
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Create an SMS survey
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > New menu on the toolbar > click the Design 
SMS Survey option.

You can create a survey to be sent to participants as an SMS. The duplicate of an SMS survey is another 
SMS survey. There is no option to redesign an SMS survey to be an online survey.

Before you begin 
• Verify that you have a license for the SMS feature.

Procedure 
1 On the My Surveys page, on the New menu, select Design SMS Survey.
2 In the Name Your Survey dialog box, type your survey name, and then click OK.
3 On  the Design tab > Content tab, select the question that you want to add. 

The question is added to your survey.

 With EFM 15.1 FP4, SMS surveys are rendered only in the Modern survey rendering mode with 
no option to change it. The SMS Surveys that were created prior to 15.1 FP4 are automatically 
republished to the Modern survey rendering mode (republishing may take some time). For more 
information about survey rendering modes, see Survey rendering overview, page 414.
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SMS survey design overview
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > New menu on the toolbar > click the Design 
SMS Survey option > Design tab.

You can design your SMS survey using the available design options and features to create the appropriate 
look and feel of your SMS survey.
Each page in an SMS survey can contain only one visible question. A visible question from the first page is 
sent to the SMS survey participant, which creates a session for this participant. All the hidden questions 
are ignored and are not sent to the participant. A participant can proceed to the next question only after 
the completion of the previous one.

 If there are no visible questions or there is more than one visible question on the page, the 
corresponding warning messages appear at the top of the page.

SMS survey supports the Short Answer question, Essay question, and Text block. You can also make 
your SMS survey organization scoped by adding one of the library system questions (Organization 
External ID or Employee External ID). The organization scoped questions are added to an SMS survey 
as hidden with no option to change the visibility.

 You can copy and paste questions from other surveys if they are valid for the SMS survey.

SMS survey limitations
All the content available in an SMS survey functions similarly to an online survey with the following 
limitations:
• Question Options are limited to Visibility, Destination, Additional CSS Keywords, and 

Custom Properties.

 The Conditional Visibility option is not available for the SMS survey questions.

• Text formatting is not available.
• The editing toolbar contains only the Insert Piped Value option.

 There is a counter for the entered text characters available only for an SMS survey.

The following features are not available when designing an SMS survey:
• Export to EFM Offline Mobile feature
• Bulk Edit link at the bottom of the Content tab
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Design tab in  SMS survey
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Design tab.

You can  customize the look and feel of your SMS survey.
The Design tab in an SMS survey is limited to the following tabs:
• Content
• Pages
• Branching
• Quotas
• Triggers
• Advanced
• Properties
• Comments

 The Formatting, Labels, and Translation tabs are not available in the SMS survey.

The Content tab functions as in a regular mode with certain question limitations. For more information, 
see Create an SMS survey, page 564.
The Branching, Triggers, and Comments tabs function as in a regular mode.
The Pages tab does not support text formatting. The editing toolbar contains only the Insert Piped 
Value option. The Behavior option in page designer is limited to Standard Confirmation Page. Also 
the following end pages are not available: Survey Saved, Invalid Access, Prevent Updates, and 
JavaScript Required.
The Advanced tab includes only the Web Services Event Handler, Version History, and All Survey 
Spell Check properties.
The Properties tab includes only four General sections (Description, Tags, Survey Owner, and Share 
Access), Statistics, and Custom Properties.
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Block sending of SMS survey end page
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > Collect tab > Overview dashboard for  SMS 
survey.

You can block sending of the SMS survey end page to the respondents using the IGNORE_END_PAGE 
token.

Procedure 
1 Log in to the EFM application.
2 Create an SMS survey with more than one page.
3 In the SMS survey designer, click the Pages tab.
4 On the Pages page, expand the End Pages section.
5 Click the Add Custom End Page link.
6 In the Design Custom End Page dialog box, on the Count respondents who reach this page as 

menu, click Completed.
7 In the text editing area, type IGNORE_END_PAGE.
8 Click Save.
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Overview dashboard for SMS survey
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab > Overview dashboard for SMS survey.

You can use the Overview dashboard to view information about general activity in your SMS survey and 
about survey participants.
When distributing an SMS survey, you cannot choose among different distribution methods. The SMS 
Survey distribution is the only available method. It is based on the Email List distribution method.

 There is no option to create an invitation for your SMS survey. The first SMS message is sent to 
the specified participants, which means they are invited to take the SMS survey.

The participants statuses pie chart
The participants statuses pie chart displays the relative counts of SMS survey participants. You can 
choose to view the All Participants chart or Overall Campaign chart by selecting one of these options 
on the Chart menu.
When the All Participants chart is selected, the following pie chart sections are displayed:
• Not Yet Invited – The participants who are added to the SMS survey.
• Invited – The participants who are invited to take the SMS survey.
• Started – The participants who started the SMS survey.
• Completed – The participants who completed the SMS survey.
When the Overall Campaign chart is selected, the following pie chart sections are displayed:
• Sent or (In Queue) – The participants to whom the invitation to take the SMS survey was sent. 

The In Queue status appears if the invitation was sent, but there was no delivery confirmation 
from the mail server.

• Undeliverable – The participants to whom the sending of SMS invitation failed.
• Unsubscribed – The participants who opted out from taking the SMS survey.
• Started – The participants who started the SMS survey.
• Completed – The participants who completed the SMS survey.

 If an SMS fails to be sent to a participant, a message notifying about the failure appears in the 
Message column on the Manage Participants page. This column is not visible by default.

You can also view the total number of participants at the bottom of the Campaign pie chart section.

Quick access links
You can quickly access the main distribution options clicking the following links positioned above and 
below the Campaign pie chart:
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• Additional Distribution Options – Opens the Keyword Trigger section where you can enter a 
keyword that is used as a trigger to send a survey to the participants. The participants need to 
text the keyword to a specific phone number. This option is only available when the survey is 
open.

 Only one keyword can be used at a time for a survey. You can change the existing keyword.

• View Participants – Opens the Manage Participants page.
• Import Participants – Opens the Import Participants dialog box.
• Email this Report – Opens the Send Report dialog box, where you can enter the email address 

to send the copy of the report.
• Printable View – Opens the Printable View dialog box, where you can view and print the 

Campaign SMS report.

 The Email this Report and Printable View options are available only for the Overall 
Campaign chart.

The Scheduled Import grid
The Scheduled Import grid allows you to schedule the import of files containing participants' 
information. Click the Schedule a File Import link to open the Schedule Import dialog box. When the 
file import is scheduled, the file name and the import date are displayed in the Scheduled Import grid. 
You can change the schedule import settings by clicking the file name. You can also import the file at any 
suitable time by clicking the Import Now button next to the file name. For more information about the 
schedule import process, see Schedule Participants Import, page 655.

The Activity grid
The Activity grid displays the information about the file import activity. You can view the following 
columns:
• File Delivered – Shows the file name.
• Import Start – Shows the time when EFM started importing the file.
• Import End – Shows the time when EFM completed importing the file and delivered it to the SMS 

interface.
• Elapsed Time – Shows the amount of time the importing process took.
• Invite Start – Shows the time when the participants invitation process started.
• Invite End – Shows the time when the participants invitation process finished.
• Status – Shows the status of the imported file.
• Rows – Shows the total number of rows (participants) in the imported file.
• Invalid Rows – Shows the number of invalid rows (participants) in the imported file.
• Invited – Shows the total number of participants invited to take the survey.
• Completed – Shows the total number of participants who completed the survey.
• Details – Enables users to view the import task details.
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 The Invited and Completed counts are links, which take you to the Manage Participants grid 
where you can view the information about all the invited participants or participants who 
completed the survey.
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SMS survey—Manage Participants
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab >  click the Participants link or Participants tab.

You can add participants to your survey, view their contact information and invitation status, import a list 
of participants into the survey, and export their data into different file formats.

Viewing participants information
The Manage Participants grid provides you information about each participant added to the survey. 
You can sort survey participants in the grid by clicking the column heading. To change the width of a 
column, drag its edge.
In addition, you can display more or fewer participants in the Manage Participants grid. At the bottom 
of the grid, the toolbar enables you to adjust the number of participants displayed on one page. The 
default number of participants per page is 10; however, you can select up to 100 participants to be 
displayed in your grid.
In the Manage Participants grid, the following fields are available:
• Record ID – Unique record ID in the database.
• Mobile Number – Participant’s mobile number.
• Started – Time when the participant first accessed the survey.
• Completed – Time when the participant completed the survey.
• Branched Out – Time when the participant was branched out of your survey.
• Over Quota – Time when the participant reached the over quota limit.
• Last Modified – Last time when the participant accessed the survey.
• Invitation Status – Status of whether the invitation is sent to the participant.
• Campaign Status – High priority action taken by the participant while answering the survey.

 You can add additional fields to the Manage Participants grid, using the Columns button on 
the toolbar.

Click the Record ID value in a specific row to view the detailed information on the participant.
To manage all participants, select the check box next to the Record ID column heading.

Adding participants to your survey
On the Manage Participants page, you can add participants to your survey by clicking the Add menu 
options:
• Mobile Numbers Only – Enter the mobile number of the person you want to invite to the 

survey. You can type a list of delimited mobile numbers directly or copy a list of mobile numbers 
into the field.



SMS surveys SMS survey—Manage Participants

EFM User Guide 572

Confidential and Proprietary Information of Verint Systems Inc.

• Add Individual Participant – Enter the mobile number, culture, and keys (1-3) for the individual 
participant to access the survey. The second and third keys are optional and all of the keys must 
be entered correctly by the participant in order to access the survey.

• Import Participants – Upload a file with a list of participants into the survey. You can import 
.csv, .tsv, .txt, and .xlsx file formats. The first line in a file must contain only identifying headers 
going from left to right. These headers are used to tell the product what values are assigned to 
each column in the database when the file is imported. Each participant entry must start on a new 
line in the file.

 When importing participants from a .csv or .xlsx file, remove any extra worksheets from the file.

• Schedule Import – Upload participants from a file automatically. For more information about 
the schedule import process, see Schedule Participants Import, page 655.

After you add participants to a survey, a .csv file containing each participant's mobile number and survey 
URL is generated and placed at {EFM install}AppData/{group ID}/sms/incoming. The .csv file is generated 
only when the survey is open. If you open a survey with the already added participants, the dialog box 
confirming the invitation of those participants opens. After the .csv file is generated and delivered to the 
EFM SMS Interface module, the participants are marked as invited.
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Add individual participants to an SMS survey
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab > Participants tab > Manage Participants page > Add menu > click Add Individual 
Participant.

You can add an individual participant to your SMS survey by specifying the mobile number, keys, and 
culture.

Procedure 
1 On the Manage Participants page, on the Add menu, click Add Individual Participant.
2 In the Add Individual Participant dialog box, in the Mobile Number text box, enter the mobile 

number of the participant.
3 Click the Optional Fields link to select the participant’s culture and enter the keys for the participant 

to access the survey.
4 In the Key 1 field, enter the first key.
5 In the Key 2 field, enter the second key.
6 In the Key 3 field, enter the third key.
7 In the Culture list, select the participant’s language.
8 Click Add Participant.
The participant is displayed in the Manage Participants grid.
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Add participants to an SMS survey by importing
Navigation

Design & Collect tab > Surveys tab > My Surveys grid >create a new SMS survey or open an existing 
one > Collect tab > Participants tab > Manage Participants page > Add menu > click Import 
Participants.

You can add multiple participants to your SMS survey by importing a file with a list of participants. You can 
import .csv, .tsv, .xlsx, txt, and .zip file formats.
The first line in a file must contain only identifying headers going from left to right. These headers are 
used to tell the application what values are assigned to each column in the database when the file is 
imported. Each participant entry must start on a new line in the file.

Before you begin 
• When importing participants from a .csv or .xlsx file, remove any extra worksheets from the file.

Procedure 
1 On the Manage Participants page, on the Add menu, click Import Participants.
2 In the Import Participants dialog box, click Browse to navigate to the file you want to upload.

 All times must be imported in UTC time. When you upload them, they appear in the default time 
zone set on the My Account tab.

3 Select the file, click Open, and then click Next.
4 In the Map Fields dialog box, match the imported columns to the corresponding respondent fields, 

and then click Next.
5 Click Import.
The imported participants list is displayed in the Manage Participants grid.
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Add participants to an SMS survey by mobile
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab >  Participants tab > Manage Participants page > Add menu > click Import 
Participants.

You can add multiple participants to your SMS survey by specifying their mobile numbers.
You can also add participants to an SMS invitation from here. For more details, see Add participants by 
mobile numbers, page 651.

Procedure 
1 On the Manage Participants page, on the Add menu, click Import Participants.
2 In the Add Mobile Numbers dialog box, enter participants' mobile numbers, separated by commas 

or semicolons.
3 Click Add Participants.
The new participants are displayed in the Manage Participants grid.
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Export SMS survey participants list to a file
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab > Participants tab > Manage Participants page > Export menu > select the 
appropriate file format.

You can export your participant list to the different file.
On the Export menu, the following file formats are available:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS

Procedure 
1 On the Manage Participants page, on the Export menu, select the appropriate file format. The 

export file is generated in the selected format.

 Time stamps are exported in UTC time.

2 Click the link that appears to save or open the file.
3 Click Close.
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Search for SMS survey participants
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab > Participants tab > Manage Participants page > Search option.

You can quickly find the required participants by their mobile numbers.

Procedure 
1 In the Manage Participants grid, in the Mobile Number search field,  type the mobile number of 

the participant that you want to find.

2 Click the Search icon .
Entries with a similar mobile number appear in the Manage Participants grid.
To remove the current filter conditions, in the Quick Search notification message, click the clear link. 
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View SMS survey participant information
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab > Participants tab > Manage Participants page > click the Record ID value.

You can view the detailed information about each participant added to your survey.

Procedure 
1 In the Manage Participants grid, click the Record ID value in a specific row.
2 In the Participant Information dialog box, view the detailed information on the selected 

participant.
3 To close the dialog box, click Close.

To print the information, click Print.
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Delete participants from an SMS survey
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new SMS survey or open an existing 
one > Collect tab > Participants tab > Manage Participants page > Delete menu on the toolbar.

You can remove participants from your SMS survey. When you delete the participants on the Manage 
Participants page, they will no longer be able to access the survey or edit their responses.

Procedure 
1 On the Manage Participants page, select the check boxes next to the participants that you want to 

remove from your survey.
2 On the Delete menu, select Delete Selected Participant(s).
3 In the Delete Participant(s) dialog box, click Delete Participant.

 To remove the targeted participant responses associated with the current survey, on the Delete  
menu, click Clear Participant Responses.
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Overview dashboard
Navigation

My Surveys grid > Collect view > the needed distribution method. For Create a List, Require a 
Passcode, and Invite Panelists, click the Skip to Dashboard button to access the Overview 
dashboard.

You can view, add, and manage your survey campaigns by using the corresponding widgets.

 If more than one campaign is added to the survey, the Overview dashboard is renamed to 
Campaigns. For details about multi-campaign surveys, see Adding multiple campaigns to survey, 
page 586.

To learn more about widgets functionality, on the Overview dashboard for each campaign type, follow 
these links:
• Generate Link – Overview dashboard, page 595
• Create a List - Overview dashboard, page 601
• Invite Panelists - Overview dashboard, page 611
• Social Media campaign, page 589
• Offline Device campaign, page 593
• QR Code campaign, page 591
• Require a passcode – Overview dashboard, page 606
To learn about Overview dashboard for SMS survey, follow this link:
• Overview dashboard for SMS survey, page 568
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Map survey or profile to file import
Navigation

Create a new survey or open an existing one from the My Surveys grid. Click the Collect tab. On the 
Choose How to Collect Your Survey Results page, select one of the distribution methods. For the 
Create a List, Require a Passcode, and Invite Panelists distribution methods, click Skip to 
Dashboard. On the Overview dashboard, click Open Now. Click the Data Channels side tab.
OR
On the Analyze tab, click View Responses. On the Response Manager page, click the Data Channels 
side tab.
OR
On the Panel tab, click the Profiles side tab. Select the profile, go to the Analyze Profile tab, and then 
click the Data Channels side tab.
On the Data Channels side tab, you can map your survey or profile to a data store via data channel to 
add more attributes to the participant data. After adding a data store to a survey or profile, you use it to 
view its data on the Response Manager grid and to create report elements.
The survey or profile that you want to map to a data store need to have at least one Short Answer 
question that matches the data type of the data store unique field.

 The data from the data store becomes available on the Response Manager grid and for 
reporting only after a survey respondent submits a survey with the response that matches to 
one of the values from the corresponding data store column.

Before you begin:
• Verify that your data store is published.
• Verify that your survey is open and the profile is published.

Procedure 
1 On the Data Channels page, click the Add File Import link.
2 In the Add File Import dialog box, select the data store that you want to use, and then click Add.

 Only published data stores and the ones that have not been used to create a data channel for the 
current survey or profile are shown in the dialog box.

3 In the Matching Survey Question or Matching Profile Question drop-down menu, click the 
question that matches the specified data field. The selected question will be used to identify the 
matching record in the data store and update the profile or survey data accordingly.

 If none of the survey or profile questions match the specified data field, the Matching Survey 
Question and Matching Profile Question drop-down menus are unavailable.

4 To save the created data channel, click in the area out of the data channel. You cannot edit the data 
channel anymore.

5 To add another data store to your survey or profile, click the Add Data Store link.
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 To delete the data channel, click the delete icon to the rightmost of this data channel. When 
deleting a data channel, any elements associated with this data channel (report elements, filters, 
Response Manager columns, and others) become unavailable.
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Participant status
Navigation

My Surveys grid > open an existing survey or create a new one >  Collect tab > select the survey 
distribution method >  Overview dashboard > view the campaign statuses for your survey.

In the EFM application, survey participants can have different statuses that depend on their participation 
in the survey.
Following are the primary participant statuses:
• Not Yet Invited – Participants that were not invited to take the survey.
• Invited – Participants that were invited to take the survey.
• Started – Participants that started the survey.
• Completed – Participants that completed the survey.
Following are the secondary participant statuses, which are the subcategories of the Invited status:
• In Queue – Participants to whom the invitation was sent, but there was no delivery confirmation 

from the mail server.
• Sent – Participants to whom the invitation was sent.
• Confirmed Received – Participants that opened the invitation but did not click the survey URL 

(to make sure that the Confirmed Received status is tracked for your survey, select the Enable 
"Confirmed Received" tracking check box in the invitation designer > Advanced Features 
dialog box (see Advanced Features of invitation, page 625).

• Unsubscribed – Participants that opened the invitation and clicked the unsubscribe link.
• Bounced Back – Participants to whom the invitation was sent, but email did not make it to the 

participant and bounced back from server or email address.
• Undeliverable – Participants to whom the invitation was sent, but an immediate notification 

from the server was received, which can be caused by numerous reasons.

 The participants statuses pie chart on the Overview dashboard (Collect tab) displays only the 
primary statuses and the Branched Out and Over Quota statuses (for details, see Branched 
Out and Over Quota statuses, page 585).
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Branched Out and Over Quota statuses
Navigation

My Surveys grid > open an existing survey or create a new one >  Collect tab > select the survey 
distribution method >  Overview dashboard > view the campaign statuses for your survey.
 

You can report on the Branched Out and Over Quota participants as a part of your campaign to have the 
better vision of the exact status of each participant. These statuses are available for all survey distribution 
types.
When you define the participant's status on the end page, the participant’s campaign status is updated 
accordingly. For example, if you select the Branched Out status on the end page, the participant’s 
campaign status is Branched Out if they reach this page (for details, see Branched Out and Over Quota on 
the End Pages, page 400).
If no Branched Out or Over Quota end page is used in a survey, no status appears. If a Branched Out or 
Over Quota end page is used but no participants reach it, the status appears and the number of 
respondents is 0.
You can view the Branched Out and Over Quota statuses in the Campaign Status column on the 
Manage Participants and Response Manager pages. You can also view these statuses on the 
participant status pie chart on the Overview page.

 The participant status pie chart is also available in a survey summary on the My Surveys page 

upon clicking   next to the needed survey.
 

You can click any pie slice to go to the Manage Participants page and view only the participants that 
have the selected status. For example, click the Branched Out pie slice to view the list of participants who 
are branched out from your survey (for details, see Create a List - Overview dashboard, page 601).
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Adding multiple campaigns to survey
Navigation

My Surveys page > create a new survey or open an existing one > Collect tab > select the survey 
distribution method (except for Require a Passcode) > Overview dashboard > Add Campaign menu.

On the Overview dashboard, you can add multiple campaigns to your survey. With this functionality, 
you can distribute the same survey via different methods without creating and publishing a new survey 
each time.

 Multiple-campaign surveys cannot be distributed via the Require a Passcode method. If a survey 
is already distributed as Require a Passcode, you cannot add other campaigns to it.

 

Adding a campaign automatically creates a corresponding widget on the Campaigns* dashboard that is 
used to manage this campaign.

 Once you add more than one campaign to your survey, the Overview dashboard is renamed to 
Campaigns.

 

To add a new campaign, click the Add Campaign menu at the bottom of the existing widget.
 

 In Classic survey rendering, multiple-campaign feature is only available for Generate Link surveys, 
and you can add only the Offline Device campaign. For details about Classic survey rendering, see 
Survey rendering overview, page 414.

 

You can add the following campaigns to your survey:

• Survey Link – Add a Survey Link campaign, and then use the widget to take a survey using the 
generated survey URL, or view a live version of your survey. You can also copy the URL and paste 
it into an email message or a website. For details, see Generate Link – Overview dashboard, 
page 595.

• Contact List – Add a Contact List campaign, and then use the widget to add participants to this 
campaign. You can add multiple Contact List campaigns to a survey and provide custom names 
for each of them. For details, see Create a List - Overview dashboard, page 601.

 Participants with preloaded data can be imported only into a Contact List campaign. Make sure 
that the survey is open.

• Panelist – Add a Panelist campaign, and then use the widget to add panelists to this campaign. 
You can add multiple Panelist campaigns to a survey and provide custom names for each of them. 
For details, see Invite Panelists - Overview dashboard, page 611.

 For Contact List and Panelist campaigns, creating an Initial Invitation, reminders, or a Thank You 
message directly from a widget adds these messages to the corresponding campaign only.
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Profile questions and piped values for the Panelist campaign are hidden from the respondents that 

belong to other campaign types. For the profile questions, the conditional visibility icon  appears 
next to the question heading in the survey designer.
• Social Media – Add a Social Media campaign, and then use the widget to select one or multiple 

websites where you wish to post your survey URL. (for details, see Social Media campaign, 
page 589).

 Make sure that the Enable publishing to social media sites check box is selected on the 
Administration tab > General Setup side tab. If you do not have access to the General Setup 
side tab, contact your Group Administrator.

You can post to the following websites:
• Facebook
• LinkedIn
• Twitter
• Reddit
• Pinterest
• Google+

• Offline Device – Add an Offline Device campaign, and then use the drop-down menu  on 
the widget to distribute your survey via the following options:
• Add Device – Select the device to send your survey to. You can select any device that is registered 

on the Administration tab (see Register a Device, page 1388 and Send a survey to the device, 
page 1471). After adding at least one device, the Offline Devices side tab appears on the Collect 
tab, where you can manage all devices that are added to the survey (see Manage Offline Access, 
page 1468).

• Import Devices from Survey – Select the survey to import devices from (see Import a device 
from another survey, page 1470).

• Export to EFM Offline Mobile – Export your survey into the EFM Offline Mobile product in the 
.que format (same as clicking Export > EFM Offline Mobile in survey designer, see MS Word and 
PDF export options, page 185).

 The Export > EFM Offline Mobile option in survey designer is available only for open surveys 
with the Offline Device campaign.

 

For surveys created prior to EFM 15.1 FP4, if there are devices added to the survey, the Offline Device 
campaign is automatically created and displayed on the Campaigns dashboard.

• QR Code – Add a QR Code campaign, and then use the widget to download a QR Code image. You 
can take a survey by scanning a QR code that will redirect you to a survey. The survey URL is 
unique for this campaign. Click the Download Image link to download the QR Code image.

 You can add Survey Link, Social Media, Offline Device, and QR Code campaigns only once for a 
survey.
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In addition, on each widget, you can view the participant status pie chart and table, test the survey, 
and delete the campaign (before the survey is opened).

 In the Response Manager grid, for multiple-campaign surveys, the Campaign Type column 
appears by default. In addition, you can add the Campaign Name (custom name for Contact 
List and Panelist campaigns) column to the grid by using the Columns button.
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Social Media campaign
Navigation

Design & Collect tab > Surveys side tab > My Surveys page > select the needed survey > Collect tab > 
select any distribution type except for Require a Passcode > Overview dashboard > Add Campaign 
menu > Social Media campaign.

You can post your survey to one or multiple websites by adding the Social Media campaign on the 
Overview (Campaigns) dashboard.

 Make sure that the Enable publishing to social media sites check box is selected on the 
Administration tab > General Setup tab. If you do not have access to the General Setup side 
tab, contact your Group Administrator.

You cannot add a Social Media campaign if this campaign already exists for the current survey or if your 
survey is distributed via Require a Passcode method.
To add a Social Media campaign to your survey, use the Add Campaign menu on the Overview 
(Campaigns) dashboard (see Adding multiple campaigns to survey, page 586).
After adding a Social Media campaign, the corresponding widget appears on the Campaigns dashboard.

Social Media widget on Campaigns

With the Social Media widget, you can do the following:
• In the Participants section, view the participant status pie chart or table for the campaign. The 

following participant statuses are available for the Social Media campaign:
• Started – Participants who have started the survey.
• Completed – Participants who completed the survey
• Branched Out – Participants who were branched out from the survey. This status is available 

only if branching was designed for the survey.
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• Over Quota – Participants who reached the Over Quota status. This status is available only if the 
responses quota was set on the Design or Collect tab > Quotas side tab.

• In the Websites section, select the website to post your survey link to. You can post to the 
following sites by clicking the corresponding icon:
• Facebook
• LinkedIn
• Twitter
• Reddit
• Pinterest
• Google+

 You need to open the survey before you can post it to websites.

Clicking a website icon opens a page of the corresponding website in a new tab, where you can edit 
and share your post.
The survey link is the same for all sites, which means that the responses collected from different sites 
are added to a single Social Media campaign.

• Use the drop-down menu to complete one of the following actions (only before the survey is 
opened for the first time):
• Participant Details – View a campaign chart and a table with the participant information 

collected for a campaign. You can print or send an email massage with a report by clicking the 
Print or Email button correspondingly.

• Test – Test the look and feel of your survey.
• Delete – Remove the Social Media campaign.
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QR Code campaign
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey > Collect tab > 
select any distribution type except for Require a Passcode > Overview dashboard > Add Campaign 
menu > QR Code campaign.

You can generate a QR code image for your survey, and then download and attach it to any needed 
content. Participants can take a survey by scanning the QR code that will redirect them to a survey.

 You can add only one QR Code campaign to your survey, but you can also add other campaigns 
to the same survey (see Adding multiple campaigns to survey, page 586).

The survey URL is unique for this campaign.
For details about the QR Code widget, see the following image and table.

QR Code widget on Campaigns dashboard

Item Description

1 Switch between a pie chart and a table view of the participant statuses. Table view 
additionally displays the percentage for each participant status and the total number 
of participants.
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Item Description

2 View the participants statuses pie chart for the current survey campaign. By default, 
the pie chart displays statuses for all participants. The following participant statuses 
are available for the QR Code campaign:
• Started – Participants who have started the survey, but not completed the 

survey yet.
• Completed – Participants who completed the survey.
• Branched Out – Participants who were branched out from the survey. This 

status is available only if branching was designed for the survey.
• Over Quota – Participants who reached the Over Quota status. This status is 

available only if the responses quota was set on the Design or Collect tab > 
Quotas side tab.

3

Click the  menu to select one of the following actions:
• Click to Generate– Generate a QR code for your survey. 
• Download the Image – Download a QR code.
• Participant Details – View a campaign chart and a table with the 

participant information collected for a campaign. You can print or send an 
email massage with a report by clicking the Print or Email button 
correspondingly.Test – Test the look and feel of your survey (available only 
before the survey is opened for the first time).

 When a survey is opened, all the test data is deleted.

• Delete – Remove the current campaign and return to the Choose How to 
Collect Your Survey Results page (available only before the survey is 
opened for the first time).
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Offline Device campaign
Navigation

Design & Collect tab > Surveys side tab > My Surveys page > select the needed survey > Collect tab > 
select any distribution type except for Require a Passcode > Overview dashboard > Add Campaign 
menu > Offline Device campaign.

You can add devices to your survey, import devices from a survey, and export devices to EFM Offline 
Mobile by using the Offline Device campaign.

 You can add only one Offline Device campaign to your survey, but you can also add other 
campaigns to the same survey (see Adding multiple campaigns to survey, page 586).

For details about the Offline Device widget, see the following image and table.

The Offline Device widget

Item Description

1 Switch between a pie chart and a table view of the participant statuses. Table view 
also displays the percentage for each participant status and the total number of 
participants.
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Item Description

2 View the participants statuses pie chart for the current survey campaign. By default, 
the pie chart displays statuses for all participants. The following participant statuses 
are available for the Offline Device campaign:
• Started – Participants who have started the survey, but not completed the 

survey yet.
• Completed – Participants who completed the survey.
• Branched Out – Participants who were branched out from the survey. This 

status is available only if branching was designed for the survey.
• Over Quota – Participants who reached the Over Quota status. This status is 

available only if the responses quota was set on the Design or Collect tab > 
Quotas side tab.

3

Click the  menu to select one of the following actions:
• Add Device  – Select the device where to send your survey. You can select any 

device that is registered on the Administration tab (see Send a survey to the 
device, page 1471 and Devices, page 1388).

• Import Devices from Survey – Select the survey from which to import 
devices.

• Export to EFM Offline Mobile – Export a survey to the EFM Offline Mobile 
application.

• Participant Details – View a campaign chart and a table with the 
participant information collected for a campaign. You can print or send an 
email message with a report by clicking the Print or Email button 
correspondingly.

• Test – Test the look and feel of your survey (available only before the 
survey is opened for the first time).

 When a survey is opened, all test data is deleted.

• Delete – Remove the current campaign and return to the Choose How to 
Collect Your Survey Results page (available only before the survey is 
opened for the first time).
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Generate Link – Overview dashboard
Navigation

Design & Collect tab > Surveys  tab > My Surveys page > select the needed survey > Choose How to 
Collect Your Survey Results page > Generate Link distribution method.

With the Overview dashboard for the Generate Link distribution method, you can view the status of 
survey participants and the survey URL by using the widget for your Survey Link campaign.
Access to the Generate Link survey is unrestricted, and anyone with the URL to this survey can take it; 
therefore, there is no participants list for this type of survey. For more information, see Copy survey URL, 
page 598.

 You can add only one Survey Link campaign to your survey, but you can also add other 
campaigns to the same survey (see Adding multiple campaigns to survey, page 586).

For details about the Overview dashboard functionality, see the following image and table.

Survey Link widget on the Overview dashboard
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Item Description

1 View the status of the current survey campaign and manage your survey distribution 
by using the corresponding buttons that guide you through the process:
• Open Survey Now – Open your survey to make it available for respondents 

via the survey URL. After opening the survey, some survey features become 
locked.

• Apply Changes to Survey – Apply the latest changes that were made to your 
survey in the survey designer. Clicking this button also opens your survey if it is 
closed.

• Close Survey Now – Close your survey to make it unavailable for respondents. 
After closing the survey, anyone trying to access it will be redirected to the 
Survey Closed page.

For details about survey statuses, see Survey Status, page 549.

2 Switch between a pie chart and a table view of the participant statuses. Table view 
additionally displays the percentage for each participant status and the total number 
of participants.

3 View the participants statuses pie chart for the current survey campaign. By default, 
the pie chart displays statuses for all participants. The following participant statuses 
are available for the Survey Link campaign:
• Started – Participants who have started the survey, but not completed the 

survey yet.
• Completed – Participants who completed the survey.
• Branched Out – Participants who were branched out from the survey. This 

status is available only if branching was designed for the survey.
• Over Quota – Participants who reached the Over Quota status. This status is 

available only if the responses quota was set on the Design or Collect tab > 
Quotas side tab.

4

Click the drop-down menu  to select one of the following actions:
• Participant Details – View a campaign chart and a table with the participant 

information collected for a campaign. You can print or send an email message 
with the report by clicking the Print or Email button correspondingly. Test – 
Test the look and feel of your survey (available only before the survey is opened 
for the first time).

 When a survey is opened, all test data is deleted.

• Delete – Remove the current campaign and return to the Choose How to 
Collect Your Survey Results page (available only before the survey is opened 
for the first time).
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Item Description

5 Click the URL to take a survey or to view a live version of your survey. You can copy 
this URL, paste it into an email message or a website, and add it to an email or a 
website. 
If the survey is in Design mode, and the survey URL is not generated yet, click the 
Click to Generate link in the URL panel. This generates the survey URL and 
performs the same action as the Test option.

 If the survey is closed, the Survey Closed end page opens upon clicking 
the survey URL.

For details, see Copy survey URL, page 598.

6 Copy and paste the HTML snippet of your survey to your website.

 If the survey is closed, an HTML link is not available.

For details, see Add HTML snippet to website, page 599.
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Copy survey URL
 

Navigation

Design & Collect tab > Surveys side tab > My Surveys page > select the needed survey > Choose How 
to Collect Your Survey Results page > Generate Link distribution method > Overview dashboard.

Using the URL panel, you can do the following with the survey URL:
• Copy and paste it onto a web page or an email message. 
• Click to take the survey or view and test a live version of your survey. 
 

Procedure 
1 Click the Collect tab.
2 On the Choose How to Collect Your Survey Results page, click Generate Link. 
3 In the Open Your Survey Now dialog box, click Open Survey Now.
4 On the Overview dashboard, in the URL panel, click the survey URL to view a live version of your 

survey. You can also copy this URL and add it to an email message or a website.

The survey URL
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Add HTML snippet to website
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey > Choose How to 
Collect Your Survey Results page > Generate Link distribution method > Overview dashboard.

On the Overview dashboard of Generate Link distribution method, you can copy and paste the HTML 
snippet of your survey into your website, blog, or any other place. 
This code provides your website visitors with a formatted link to your survey titled "Click here to take a 
survey." 

The HTML snippet on the Overview dashboard

Procedure 
1 On the Overview dashboard, in the URL panel, copy the generated anchor tag.
2 Paste the anchor tag into the HTML of your website.

 You can replace the default title with your own custom title by deleting "Click here to take a 
survey" in the code snippet and typing your own title in its place (for example, "Please participate 
in our short survey").
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Create a List distribution method
 

Navigation

Design & Collect tab > Surveys  tab > My Surveys page > select the needed survey > Choose How to 
Collect Your Survey Results page > Create a List distribution method.

Use the Create a List distribution method to restrict access to your survey to specific participants. Only 
the respondents who received survey invitations to their email addresses can complete the Create a List 
survey.
After you click Create a List on the Choose how to Collect Your Survey Results page, the Initial 
Invitation page opens, where you can:
• Compose your survey invitation (for details, see Write Invitations, page 616)
• Add participants via Manage Participants link (for details, see Add individual participant, 

page 652)
• Test your invitation (for details, see Test invitation, page 627)
• Schedule your invitation delivery (for details, see Scheduling invitations delivery, page 674)
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Create a List - Overview dashboard
 

Navigation

Design & Collect tab > Surveys  tab > My Surveys page > select the needed survey > Choose How to 
Collect Your Survey Results page > Create a List distribution method > Initial Invitation page > Skip 
to Dashboard button > Overview dashboard.

With the Overview dashboard for the Create a List distribution method, you can view general statistics 
on the survey participant statuses, add participants, and manage survey invitations and scheduling 
settings by using the widget for your Contact List campaign.
For details about the Overview dashboard, see the following image and table.

Create List widget on the Overview dashboard
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Item Description

1 View the status of the current survey campaign and manage your survey distribution 
by using the corresponding buttons that guide you through the process:
• Create Invitation – Access the invitation designer to compose the Initial 

Invitation (unless you did this before getting to the Overview dashboard).
• Manage Participants – Access the Manage Participants page to add 

participants to your survey campaign.
• Apply Changes to Survey – Apply the latest changes that were made to your 

survey in the survey designer. Clicking this button also opens your survey if it is 
closed.

• Open Survey Now – Open your survey to make it available for respondents 
via the survey URL. After opening the survey, some survey features become 
locked.

• Close Survey Now – Close your survey to make it unavailable for respondents. 
After closing the survey, anyone trying to access it will be redirected to the 
Survey Closed page.

For details about survey statuses, see Survey Status, page 549.

2 Rename your Contact List campaign by clicking the default Untitled List name and 
typing the custom name. The campaign name must be unique within a multi-
campaign survey if more than one Contact List campaign is added.

3 View the participants statuses pie chart for the current survey campaign. By default, 
the pie chart displays statuses for all participants. The following participant statuses 
are available for the Contact List campaign:
• Not Yet Invited – Participants who are not invited to take the survey.
• Invited – Participants who are invited to take the survey. The Invited status 

includes a number of subcategories that are accounted for but not displayed as 
separate slices on the pie chart (for more information, see Participant status, 
page 584).

• Started – Participants who have started the survey but not completed it yet.
• Completed – Participants who completed the survey.
• Branched Out – Participants who were branched out from the survey. This 

status is available only if branching was designed for the survey.
• Over Quota – Participants who reached the Over Quota status. This status is 

available only if the responses quota was set on the Design or Collect tab > 
Quotas side tab.

• Bounced Back – Participants to whom the invitation was sent, but email 
did not make it to the participant and bounced back from server or email 
address.

• Undeliverable – Participants to whom the invitation was sent, but an 
immediate notification from the server was received, which can be caused 
by numerous reasons.
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Item Description

4 If there is at least one invitation created, you can set the pie chart to display 
participant statuses based on a certain invitation by clicking the arrow  next to the 
Participants link and selecting the needed option from the menu, for example, 
Initial Invitation or Second Reminder.
The Participants link changes to Initial Invitation, Reminder, or Thank You 
correspondingly. Clicking this link brings you to the Manage Participants page.

5 Switch between a pie chart and a table view of the participant statuses. Table view 
additionally displays the percentage for each participant status and the total number 
of participants.
Clicking a pie slice or a status link in the table takes you to the Manage Participants 
grid with the corresponding filter applied. For example, if you click the pie slice that 
represents the Invited participant status, you will be redirected to the Manage 
Participants grid where only the participants invited to take the survey are 
displayed.
Also, if you set the pie chart to display participant statuses based on a certain 
invitation, the Manage Participants grid (displayed after clicking a pie slice) will be 
filtered accordingly (showing only participants invited via First Reminder, for 
example).

6 Click the Schedule link to go to the Schedule page, where you can manage schedule 
settings for different survey events, such as Open Survey, Send Initial Invitation, 
Close Survey, and other events. For details, see Schedule page, page 672.

7 Create and manage survey invitations, reminders, and Thank You message by clicking 
the corresponding link (to go to the invitation designer) and the corresponding 
button to the right (to send or resend the invitation). You can delete the schedule 
settings defined for a certain invitation by
clicking the delete icon  to the rightmost of this invitation.
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Item Description

8 Click the drop-down menu  to select one of the following actions:
• Add Individual Participant – Type the email address of the individual 

participant. You can also optionally provide the culture and keys (1-3) for 
the individual participant to access the survey (for details, see Add individual 
participant, page 652).

• Add Email Addresses – Type the email address of the person that you 
want to invite to the survey. You can type a list of delimited email addresses 
directly or copy a list of email addresses into the field. The application 
supports simple and extended email formats, for example, user@vovici.com 
and <First name, Last name> user@vovici.com (for details, see Add 
participants by email addresses, page 650).

• Add Mobile Numbers – Type the mobile number of the person that you 
want to invite to the survey. You can type several mobile numbers 
separated by commas or semicolons (for details, see Add participants by 
mobile numbers, page 651).

• Import Participants – Upload a file with a list of participants into the 
survey. You can import .csv, .tsv, .xlsx, txt, and .zip file formats. The first line 
in a file must contain only identifying headers going from left to right. These 
headers are used to tell the product what values are assigned to each 
column in the database when the file is imported. Each participant entry 
must start on a new line in the file (for details, see Add participants by 
importing a file, page 654).

 

• Schedule Import – Upload participants from a file automatically. For 
details about the schedule import process, see Schedule Participants 
Import, page 655.

• Participant Details – View a campaign chart and a table with the 
participant information collected for a campaign. If there are any invitations 
for the campaign, you can filter the information for a particular type of 
invitation. By default, Overall Campaign is selected. You can also print or 
send an email message with the report by clicking the Print or Email button 
correspondingly.

• Test – Test the look and feel of your survey after adding survey participants 
(available only before the survey is opened for the first time).

• Delete – Remove the current campaign and return to the Choose How to 
Collect Your Survey Results page (available only before the survey is 
opened for the first time).



Collect your survey results Require a Passcode distribution method

EFM User Guide 605

Confidential and Proprietary Information of Verint Systems Inc.

Require a Passcode distribution method
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey > Choose How to 
Collect Your Survey Results page > Require a Passcode distribution method.

Use the Require a Passcode distribution method to restrict access to your survey by using up to three 
keys and requiring that participants type these keys before starting the survey.
The Require a Passcode survey must start with a Short Answer or Fill in the Blank question that 
includes up to three topics with the Text, IDs and Phone Numbers, and Postal Codes input types and 
has its visibility set to Shown. Otherwise, participants will not be able to take the survey.
To access the survey, participants need to type the keys. For example, you may ask, "What is your 
name?", and the participant is required to type this information correctly before the survey opens. The 
information that participants type must match the keys you created for each participant in the Manage 
Participants grid. You can send the keys to participants along with the invitation to take the survey. 
Values to be typed as keys are case insensitive.
After you select the Require a Passcode distribution method, you need to create an invitation, schedule 
it, and add invitation recipients. For further steps, see Write Invitations, page 616.
After you click Require a Passcode on the Choose how to Collect Survey Results page, the Initial 
Invitation page opens, where you can:
• Compose your survey invitation (for details, see Write Invitations, page 616)
• Add participants via Manage Participants link (for details, see Manage Participants Overview, 

page 646)
• Test your invitation (for details, see Test invitation, page 627)
• Schedule your invitation delivery (for details, see Scheduling invitations delivery, page 674)
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Require a passcode – Overview dashboard
Navigation

Design & Collect tab > Surveys  tab > My Surveys page > select the needed survey > Choose How to 
Collect Your Survey Results page > Require a Passcode distribution method > Initial Invitation 
page > Skip to Dashboard button > Overview dashboard.

With the Overview dashboard for the Require a Passcode campaign, you can view the general statistics 
about your survey participants, add participants, and manage survey invitations and scheduling settings 
by using the widget for your Require a Passcode campaign.
For details about the Overview dashboard, see the following image and table.

Require a Passcode widget on the Overview dashboard
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Item Description

1 View the status of the current survey campaign and manage your survey distribution 
by using the corresponding buttons that guide you through the process:
• Create Invitation – Access the invitation designer to compose the Initial 

Invitation (unless you did this before getting to the Overview dashboard).
• Manage Participants – Access the Manage Participants page to add 

participants to your survey campaign.
• Apply Changes to Survey – Apply the latest changes that were made to your 

survey in the survey designer. Clicking this button also opens your survey if it is 
closed.

• Open Survey Now – Open your survey to make it available for respondents 
via the survey URL. After opening the survey, some survey features become 
locked.

• Close Survey Now – Close your survey to make it unavailable for respondents. 
After closing the survey, anyone trying to access it will be redirected to the 
Survey Closed page.

2 View the participants statuses pie chart for the current survey campaign. By default, 
the pie chart displays statuses for all participants. The following campaign statuses 
are available for the Require a Passcode survey:
• Not Yet Invited – Participants who are not invited to take the survey.
• Invited – Participants who are invited to take the survey. The Invited status 

includes a number of subcategories that are accounted for but not displayed as 
separate slices on the pie chart.

• Started – Participants who have started the survey, but not completed yet.
• Completed – Participants who completed the survey.
• Branched Out – Participants who were branched out from the survey. This 

status is available only if branching was designed for the survey.
• Over Quota – Participants who reached the Over Quota status. This status is 

available only if the responses quota was set on the Design or Collect tab > 
Quotas side tab.

• Bounced Back – Participants to whom the invitation was sent, but email 
did not make it to the participant and bounced back from server or email 
address.

• Undeliverable – Participants to whom the invitation was sent, but an 
immediate notification from the server was received, which can be caused 
by numerous reasons.

3 If there is at least one invitation created, you can set the pie chart to display 
participant statuses based on a certain invitation by clicking the arrow next to the 
Participants link and selecting the needed option from the drop-down menu, for 
example Initial Invitation or Second Reminder.
The Participants link changes to Initial Invitation, Reminder, or Thank You 
correspondingly. Clicking this link brings you to the Manage Participants page.
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Item Description

4 Switch between the pie chart and table view of the participant statuses. Table view 
additionally displays the percentage for each participant status and the total number 
of participants.
Clicking a pie slice or a status link in the table takes you to the Manage 
Participants grid with the corresponding filter applied. For example, if you click the 
pie slice that represents the Invited participant status, you will be redirected to the 
Manage Participants grid where only the participants invited to take the survey 
are displayed.
Also, if you set the pie chart to display participant statuses based on a certain 
invitation, the Manage Participants grid (displayed after clicking a pie slice), will be 
filtered accordingly (showing only participants invited via First Reminder, for 
example).

5 Click the URL to take a survey or to view a live version of your survey. You can copy 
this URL, paste it into an email message or a website, and add it to an email or a 
website. 
If the survey is in Design mode, and the survey URL is not generated yet, click the 
Click to Generate link in the URL panel. This generates the survey URL and 
performs the same action as the Test option.
For details, see Copy survey URL, page 598.

6 Click the Schedule link to go to the Schedule page, where you can manage schedule 
settings for different survey events, such as Open Survey, Send Initial Invitation, 
Close Survey, and other events. For details, see Schedule page, page 672.

7 Create and manage survey invitations, reminders, and Thank You message by 
clicking the corresponding link (to go to the invitation designer) and the 
corresponding button to the right (to send or resend the invitation). You can delete 
the schedule settings defined for a certain invitation by
clicking the delete icon  to the rightmost of this invitation.
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Item Description

8 Click the drop-down menu  to select one of the following actions:
• Add Individual Participant – Enter the email address of the individual 

participant. You can also optionally provide the culture and keys (1-3) for 
the individual participant to access the survey (for details, see Add individual 
participant, page 652).

• Import Participants – Upload a file with a list of participants into the 
survey. You can import .csv, .tsv, .xlsx, txt, and .zip file formats. The first line 
in a file must contain only identifying headers going from left to right. These 
headers are used to tell the product what values are assigned to each 
column in the database when the file is imported. Each participant entry 
must start on a new line in the file (for details, see Add participants by 
importing a file, page 654).

• Schedule Import – Upload participants from a file automatically. For 
details about the schedule import process, see Schedule page, page 672

• Participant Details – View a campaign chart and a table with the 
participant information collected for a campaign. If there are any invitations 
for the campaign, you can select the needed invitation type from the list 
and view only the information for this type of invitation. By default, 
Overall Campaign is selected. You can also print or send an email message 
with the report by clicking the Print or Email button correspondingly.

• Test – Test the look and feel of your survey after adding survey 
participants (available only before the survey is opened for the first time).

• Delete – Remove the current campaign and return to the Choose How to 
Collect Your Survey Results page (available only before the survey is 
opened for the first time).
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Invite Panelists distribution method
Navigation

Design & Collect tab > Surveys  tab > My Surveys page > select the needed survey > Collect view > 
Invite Panelists.

The Invite Panelists distribution method is used when you want to restrict access to your survey for 
panelists within a workgroup. Only invited panel members from the workgroup can complete the Invite 
Panelists survey. 
On the Choose How to Collect Your Survey Results page, after you click Invite Panelists, the Initial 
Invitation page opens where you can:
• Compose your email message (for details, see Write Invitations, page 616)
• Add panelists via Manage Participants (for details, see Manage Participants for Invite Panelists, 

page 664)
• Test your invitation (for details, see Test invitation, page 627)
• Schedule your invitation delivery (for details, see Scheduling invitations delivery, page 674)
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Invite Panelists - Overview dashboard
Navigation

Design & Collect tab > Surveys  tab > My Surveys page > select the needed survey > Choose How to 
Collect Your Survey Results page > Invite Panelists distribution method > Initial Invitation page > 
Skip to Dashboard button > Overview dashboard.

With the Overview dashboard for the Invite Panelist distribution method, you can view general 
statistics of the survey participant statuses, add participants, and manage survey invitations and 
scheduling settings by using the widget for your Panelist campaign.

 You can add only one Panelists campaign to your survey, but you can also add other campaigns 
to the same survey (see Adding multiple campaigns to survey, page 586).

For details about the Overview dashboard, see the following image and table.

Invite Panelists widget on the Overview dashboard
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Item Description

1 View the status of the current survey campaign and manage your survey distribution 
by using the corresponding buttons that guide you through the process:
• Create Invitation – Access the invitation designer to compose the Initial 

Invitation (unless you did this before getting to the Overview dashboard).
• Manage Participants – Access the Manage Participants page to add 

participants to your survey campaign.
• Apply Changes to Survey – Apply the latest changes that were made to your 

survey in the survey designer. Clicking this button also opens your survey if it is 
closed.

• Open Survey Now – Open your survey to make it available for respondents 
via the survey URL. After opening the survey, some survey features become 
locked.

• Close Survey Now – Close your survey to make it unavailable for respondents. 
After closing the survey, anyone trying to access it will be redirected to the 
Survey Closed page. For details about survey statuses, see Survey Status, 
page 549.

2 Rename your Invite Panelists campaign by clicking the default Untitled Panelists 
name and typing the custom name. The name of the campaign must be unique 
within multi-campaign survey if more than one  Panelist campaign is added.

3 View the participants statuses pie chart for the current survey campaign. By default, 
the pie chart displays statuses for all participants. The following participant statuses 
can be available for the Invite Panelists survey:
• Not Yet Invited – Participants who are not invited to take the survey.
• Invited – Participants who are invited to take the survey. The Invited status 

includes a number of subcategories that are accounted for but not displayed as 
separate slices on the pie chart.

• Started – Participants who have started the survey, but not completed it yet.
• Completed – Participants who completed the survey
• Branched Out – Participants who were branched out of the survey. This status 

is available only if branching was designed for the survey.
• Over Quota – Participants who reached the Over Quota status. This status is 

available only if the responses quota was set on the on the Design or Collect 
tab > Quotas side tab.

• Bounced Back – Participants to whom the invitation was sent, but email 
did not make it to the participant and bounced back from server or email 
address.

• Undeliverable – Participants to whom the invitation was sent, but an 
immediate notification from the server was received, which can be caused 
by numerous reasons.
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Item Description

4 If there is at least one invitation created, you can set the pie chart to display 
campaign statuses based on a certain invitation by clicking the arrow  next to the 
Participants link and selecting the needed option from the drop-down menu, for 
example, Initial Invitation or Second Reminder.
The Participants link changes to Initial Invitation, Reminder, or Thank You 
correspondingly. Clicking this link brings you to the Manage Participants page.

5 Switch between the pie chart and table view of the participant statuses. Table view 
additionally displays the percentage for each participant status and the total number 
of participants.
Clicking a pie slice or a status link in the table takes you to the Manage 
Participants grid with the corresponding filter applied. For example, if you click the 
pie slice that represents the Invited participant status, you will be redirected to the 
Manage Participants grid where only the participants invited to take the survey 
are displayed.
Also, if you set the pie chart to display participant statuses based on a certain 
invitation, the Manage Participants grid (displayed after clicking a pie slice) will be 
filtered accordingly (showing only participants invited via First Reminder, for 
example).

 On the Manage Participants grid, if the filter dependent on 
the pie slice or status link is applied, the Filter button on the toolbar is 
disabled until you clear the current filter.

6 Click the Schedule link to go to the Schedule page, where you can manage schedule 
settings for different survey events, such as Open Survey, Send Initial Invitation, 
Close Survey, and other events. For details, see Schedule page, page 672.

7 Create and manage survey invitations, reminders, and Thank You message by 
clicking the corresponding link (to go to the invitation designer) and the 
corresponding button to the right (to send or resend the invitation). You can delete 
the schedule settings defined for a certain invitation by
clicking the delete icon  to the rightmost of this invitation.

 On the Manage Participants grid, if the filter dependent on 
the pie slice or status link is applied, the Filter button on the toolbar is 
disabled until you clear the current filter.
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Item Description

8 Click the drop-down menu to select one of the following actions:
• Add Panelists – Add panelists to be invited to your survey via filtering 

options (for details, see Add panelists via filtering options, page 665).
• Add Panelists One at a Time – Add one individual participant to be 

invited to your survey (for details, see Add panelists one at a time, 
page 666).

• Advanced Properties – Disable panelists health score updates for the 
survey.

 For details about adding and managing survey participants, 
see Manage Participants for Invite Panelists, page 664.

• Participant Details – View a campaign chart and a table with the 
participant information collected for a campaign. If there are any invitations 
for the campaign, you can select the needed invitation type from the list 
and view only the information for this type of invitation. By default, 
Overall Campaign is selected. You can also print or send an email message 
with the report by clicking the Print or Email button correspondingly.

• Test – Test the look and feel of your survey (available only before the 
survey is opened for the first time).

 When a survey is opened, all test data is deleted.

• Delete – Remove the current campaign and return to the Choose How to 
Collect Your Survey Results page (available only before the survey is 
opened for the first time).
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Write Invitations
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page.
OR 
Overview side tab > Create Invitation button > Initial Invitation page.

On the invitation designer page, you can create an email and SMS messages of your invitation, schedule 
the time when they will be delivered to your survey participants, and preview them.

If you want to have the same invitation text  for both email and SMS messages, compose one of the 
messages, and the text will be automatically duplicated to another one. If you want to have  two different 
messages, edit another message correspondingly. For more information about all survey invitations, see 
Invitations page, page 631.

Email message
You can create an email message of your invitation by using the Email tab on the invitation designer 
page.
For definition of the Email message area, use the following image and table.
For more information, see Compose Initial Invitation, page 623.

The Email tab

Item Description

1 Campaign – Name of the survey campaign that the invitation is associated with. It is 
displayed only for multiple-campaign surveys.
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Item Description

2 To – Add participants by typing a participant’s email address directly in the box, or 
click the Add Participants/Panelists via Manage Participants link to navigate to 
Manage Participants where you can add participants or panelists to your survey. 
You can add multiple email addresses by separating them with commas or 
semicolons. For more information, see Add invitation recipients, page 620.

3 From – The box is filled in automatically using the current user's email address. 
Other options may be provided in a list as configured by your Survey Administrator.

4 Subject – Add a subject line for your email (for example: Please take my survey).

5 Insert Survey Link – Click to insert the survey link in the invitation, which opens 
the first page of the survey. If your survey is translated to other languages, you can 
create survey links to each survey translation by clicking the needed language in the 
Languages list. The created link navigates to the needed survey translation.

6 Insert Field* – Double-click any field that you want to insert into the body of your 
email. The General folder contains basic participant/panelist information, including 
email, survey URL, unsubscribe URL, keys, and close date. Additional folders 
reference each profile and include each profile question into the body of the 
invitation (for details, see Insert fields in the invitation, page 624).

7 Insert Response Link – Click to insert the survey link, which opens the first survey 
page with the preselected question (Choose One or Choose One with Image 
only). Respondents can change the preselected response or leave it as it is, and then 
proceed to the next survey questions. Specify the link text, question (from the first 
survey page only), and the preselected response (for details, see Insert Response 
Link, page 644).
This functionality works in Modern survey rendering only. For more information 
about survey rendering modes, see Survey rendering overview, page 414.

8 Toolbar – Click to add formatting options for your email message such as font, bold, 
underline, find and replace, print, spell check, etc. Hover over each icon to see a 
tooltip.

9 Message body – Type your email message text here.

10 Design or HTML – Switch between the Design and HTML modes.

 *The Fields dialog box contains fields that may be used to insert information into your invitation 
message from your panel database.

SMS message
You can create an SMS message of your invitation by using the Mobile tab on the invitation designer 
page.
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Before you begin 
• Ensure that System Administrator activated the SMS license for your workgroup.
• Ensure that Group Administrator configured the SMS Gateway settings for your workgroup.
For definition of the SMS message area, use the following image and table. 

The Mobile tab

Item Description

1 Campaign – Name of the survey campaign that the invitation is associated with. It is 
displayed only for multiple-campaign surveys.

2 To – Add participants by typing the participant’s mobile number directly in the box, 
or click the Add Participants/Panelists via Manage Participants link to navigate 
to the Manage Participants page, where you can add participants to your survey. 
You can add several mobile numbers by separating them with commas or 
semicolons. For more information, see Add invitation recipients, page 620.

3 From – The box is filled in automatically using the mobile number provided on the 
SMS Gateway Settings page > the Invitation Originating Number box.

4 Insert Survey Link – Click to insert the survey link in the invitation, which opens 
the first page of the survey. If your survey is translated to other languages, you can 
create survey links to each survey translation by clicking the needed language in the 
Languages list. The created link navigates to the needed survey translation.

5 Insert Field – Double-click any field that you want to insert into the body of your 
SMS message. The General folder contains basic participant or panelist information, 
including email, survey URL, unsubscribe URL, keys, and close date. Additional 
folders reference each profile and include each profile question into the body of the 
invitation.
If a user copies and pastes a placeholder with custom link text from an email 
invitation into an SMS invitation, the link text is ignored.



Write invitations Write Invitations

EFM User Guide 619

Confidential and Proprietary Information of Verint Systems Inc.

Item Description

6 Toolbar – Click to add formatting options and functions for your SMS message such 
as cut, copy, paste, undo, and redo. Hover over each icon to see a tooltip.

7 Message body – Type your SMS message text here.

8 Character count – View the number of characters and the number of SMS 
messages in your invitation. You can send a multi-part SMS invitation that contains 
up to six messages.
If your SMS invitation contains only one message, the maximum number of 
characters in the message is 70 or 160 depending on character encoding. If your 
SMS invitation contains two or more messages, the maximum number of characters 
in one SMS message is 67 or 153 depending on character encoding.
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Add invitation recipients
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page.
OR 
Overview side tab > Create Invitation button > Initial Invitation page.
You can add invitation recipients by typing each recipient’s email address or mobile number directly in the 
To box. You can also use the Add Participants via Manage Participants link on the Email and Mobile 
tabs to add individual participants to your survey or upload a file with a list of participants into the survey.

Procedure 
1 On the Initial Invitation page, next to the To box, click the Add Participants via Manage 

Participants link.
2 On the Manage Participants page, add participants that you want to invite to your survey.

For more details, see Add participants, page 647. 
3 To continue composing the invitation, on the Manage Participants page, click the Return to 

Invitation Designer button.
4 In the To box, the name, email address, or mobile number of the participant (panelist) selected as an 

invitation recipient appears. 
If both first and last names of the participant (panelist) are specified, they are displayed in the To box. 
The email address or mobile number of the participant (panelist) is displayed in the To box if neither 
first nor last name of the participant (panelist) is specified. 
Multiple recipients appear in the To text box separated by commas or semicolons. If the total number 
of recipients is more than three, they are displayed in the following way: participant 1, participant 2, 
participant 3...(# More Participants), where # is a counter for all participants who exceed 3.
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Add Reply To, CC, BCC, and Subject to the invitation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page.
OR 
Overview side tab > Create Invitation button > Initial Invitation page.
You can add email addresses to the Cc and Bcc boxes and specify a Reply To address by using the To 
button in the Email Message area.

Procedure 
1 On the Initial Invitation page, click the To button.
2 In the Invitation Respondents dialog box, select the Send to all eligible participants check box 

to send an email messages to your campaign participants only, or clear the check box, and in the To 
text box, provide the needed email addresses.

 To enable the Send to all eligible participants check box, on the Mail Setup side tab, select 
the Enable address piping in To field of Invitation permission.

 Any email address added in the Invitation Respondents dialog box will receive all invitations 
sent to participants. This may cause handling a large volume of email messages.

3 In the Invitation Respondents dialog box, provide the email addresses in the corresponding Cc and 
Bcc text boxes.

 You can only select one address in the Reply To list.

The recipients added to the Cc box receive the copy of the invitation. If you add recipients to the Bcc box, 
a copy of the message is sent to them, but their email addresses are not visible to other recipients of the 
invitation.

Related topics 
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Delivering invitations
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page.
OR 
Overview side tab > Create Invitation button > Initial Invitation page.
In the Delivery Schedule area of the Initial Invitation page, select the needed options for the delivery 
of your invitation to the participants.
The following options are available :
• No Scheduling – Use this option to send your invitation later. You may want to select it if you 

have not finished adding participants, writing your invitation message, or have not yet decided 
when to send the invitation.

• Send Now – Use this option to send your invitation immediately. There may be a delay of several 
minutes before your invitation is delivered to participants.

• Send at a specific date and time (using the calendar function) – Use this option to specify a 
date and time when you want to deliver your invitation. You can either type the date and time 
manually into the available text field or select the date and time from pop-up menus. Click the 
Show Recurrence Options link to specify recurrence options for your invitation delivery. Use 
this functionality to send an invitation multiple times on a daily, weekly, or monthly basis. You can 
also set an end date or select No End Date. For more details, see Scheduling invitations delivery, 
page 674.

 If the Send at a specific date and time option is selected, the Save Invitation button 
changes to Save Schedule, clicking on which saves both the composed email message and 
schedule settings.

The Delivery Schedule section

 To ensure a high level of security and mail delivery reliability, EFM does not support external file 
attachments to any email messages sent from the application (including survey invitations, 
reminders, and Thank You messages.) If you need to share a file via EFM email, it is recommended 
that you place it on an accessible web location and provide a link to the location in the email.
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Compose Initial Invitation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page.
OR 
Overview side tab > Create Invitation button > Initial Invitation page.
You can compose the email or SMS message of your invitation.

 To compose reminders and a Thank You message, use the same steps.
 

Procedure 
1 On the Email or Mobile tab, use the From  list to select an email address or specify a mobile number 

from which you want to send your invitation.
2 Click the Add Participants via Manage Participants link to add participants to your survey.

For more details, see Manage Participants Overview, page 646.

 To continue composing the invitation, click the Return to Invitation Designer button on the 
Manage Participants page.

3 To add the Cc, Bcc, or Reply To email addresses, click the To button. Separate email addresses by 
commas or semicolons.

4 In the Subject field, type the invitation subject.
5 In the body of your invitation, type the content of the email or SMS message and customize it by 

using the editing toolbar.
6 To insert the survey URL into your invitation, click the Insert Survey Link or Insert Response Link 

on the toolbar.
For more details, see Insert Response Link, page 644.

7 To pipe data into your invitation, place the pointer in the body of the message, click the Insert Field 
on the toolbar, and then in the Fields dialog box, double-click the needed field. 
For more details, see Insert fields in the invitation, page 624.

8 To test your invitation before delivering it, click the Test Invitation button. 
9 In the Test Your Invitation dialog box, type your email address or mobile number, and then click the 

Send button.
For more details, see Test invitation, page 627.

10 In the Delivery Schedule section, select the appropriate option for your invitation delivery.
11 Click Save Invitation.

 The name of the saving button varies depending on the delivery option that you select.

Related topics 
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Insert fields in the invitation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page > Insert Field button.
OR 
Overview side tab > Create Invitation button > Initial Invitation page > Insert Field button.
You can insert certain fields into the email or SMS invitation that will be populated with the appropriate 
values from the database upon sending to the specific recipient.

Procedure 
1 Place your cursor in the message body where you want to insert a field, and then on the toolbar, click 

Insert Field.
2 In the Fields dialog box, double-click the name of the field to be inserted. 

It will be placed in the body of your message at the point of your cursor. When the message is sent, 
the field will be replaced with the appropriate value from the database.

 For panelists, you can additionally insert respondent location values (specified when adding a 
panelist) into the invitations: City, State, Country, Zip Code/Postal Code, Address 1, and Address 
2.

3 Click the Preview button to view how your message will appear before it is sent.
Email messages can be viewed and sent in HTML or Text format,  SMS  messages only in Text format.
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Advanced Features of invitation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page > Advanced Features link.
OR 
Overview side tab > Create Invitation button > Initial Invitation page > Advanced Features link.
On the Initial Invitation page, you can specify the advanced features for your invitation.

The Advanced Features dialog box

In the Advanced Features dialog box, the following options are available:
• Notify survey owner by email of task status – If selected, the survey owner receives 

notification of invitation status via email.
• Embed images into emails – If selected, you can embed images into the invitation email or link 

them. 
For more details, see Embed Images into Invitations, page 639.

• Enable "Confirmed Received" tracking (selected by default) – If selected, this option provides 
tracking of the Confirmed Received status for each sent invitation and each participant in your 
survey (see Participant status, page 584). 
The Confirmed Received status is displayed in the following places in EFM:
• Collect tab > Invitations page and invitation mail details dialog box.
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• Manage Participants page (Campaign Status column and invitations status columns).

 To turn on this functionality on a user level, see Mail Preferences, page 1417. To turn on this 
functionality on a workgroup level, contact your Group Administrator.

• Use email instead of mobile number if both present (for Contact List only) – If selected, 
participants with both email address and mobile number specified, receive an email invitation 
preferred to SMS invitation. The participant’s Preferred Contact Method value updates 
correspondingly.
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Test invitation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page > Email or Mobile tab > Test Invitation.
OR 
Overview side tab > Create Invitation button > Initial Invitation page > Email or Mobile tab > Test 
Invitation.
On the Initial Invitation page, you can test your invitation by using the Test Invitation option on the 
Email and Mobile tabs. Use this option to send an email or SMS message to yourself or others to test 
the look and feel of your invitation before sending the invitation out to your participants.

Procedure 
1 After composing your invitation, on the Email or Mobile tab, click Test Invitation.
2 In the Test Your Invitation dialog box, type an email address or mobile number to test the email or 

SMS message correspondingly.
3 Click Send.

 If you insert the Survey Link box in your test invitation, the URL placeholder for the survey link 
appears in the test invitation. However, the survey link in the test invitation is not a working 
survey link.
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Previewing invitation
Navigation

Collect tab > select Create a List, Require a Passcode, or Invite Panelists distribution method > 
Initial Invitation page > Email or Mobile tab > Preview.
OR
Overview dashboard > Create InvitationEmail or Mobile tab > Preview.
On the Initial Invitation page, you can preview your email or SMS invitation by using the Preview 
option on the Email  or Mobile tabs correspondingly.
In the Preview dialog box, you can do the following:
• View the actual email or SMS message of your invitation.

 If participants (panelists) are added to the participant list, participant data will be inserted in place 
of the Field bookmarks.

• For email invitations only, select to view different invitations from the Messages area.

 Additional invitations may be inspected by using the arrows at the bottom of the message 
preview.

• For email invitations only, switch between HTML and Text view of the invitation in the Format 
area.

When invitation preview is completed, click the Close button at the bottom of the Preview dialog box to 
return to the invitation designer or scheduler.
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The Preview dialog box

 



Write invitations Reminders and Thank You message

EFM User Guide 630

Confidential and Proprietary Information of Verint Systems Inc.

Reminders and Thank You message
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Overview side tab > Schedule pane > Add a Reminder or Add Thank 
You link.
You can remind the survey participants to take your survey by sending them reminders. You can also 
thank your survey participants for taking the survey by sending a Thank You message.

 You can send up only to four reminders.

You can create a reminder or Thank You message by using one of the following options:
• On the Overview side tab, in the Schedule section, click the needed link (Add a reminder or 

Add Thank You) or click the Create button.
• On the Invitations side tab, on the Invitations page, in the New menu, click the needed option 

(Reminder or Thank You).
Using either of the described options takes you to the invitation designer, where you can compose and 
schedule your reminder or Thank You message.

 An initial invitation and reminders can only be created in sequential order, which means that you 
cannot create the second Reminder before the first Reminder.

 

You can compose, edit, schedule, and send the reminders and Thank You message the same way as 
survey invitations. To view details about your reminders and Thank You message, see Invitations page, 
page 631.

 The message and subject text of a reminder along with the From, Cc, Bcc, and Reply To fields 
are copied from the previous invitation or reminder into the next ones. The images and 
translations are copied too.

When you add and schedule a reminder, it appears in the Schedule section with the corresponding name 
(First Reminder or Second Reminder, for example). Clicking the needed reminder link takes you to the 
invitation designer, where you can edit this reminder. You can also delete the scheduled settings for the 

needed reminder or Thank You message by clicking the  icon  next to the needed message.
Reminders are sent only to the participants who were sent the previous invitation or reminder and have 
Invited status (see Participant status, page 584). Thank You message is sent only to the participants who 
completed the survey. If there are no participants that are eligible for the selected reminder or Thank You 
message, the email will not be sent.

 To ensure a high level of security and mail delivery reliability, EFM does not support external file 
attachments to any email messages sent from the application (including survey invitations, 
reminders, and ‘Thank You’ messages.) If you need to share a file via EFM email, it is 
recommended that you place it on an accessible web location and provide a link to the location in 
the email.
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Invitations page
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Overview page > Invitations side tab > Invitations page.
On the Invitations page, you can view and manage all your invitations (including reminders and a Thank 
You message) in a single grid.

 An initial invitation and reminders can only be created in sequential order, which means that you 
cannot create the second Reminder before the first Reminder.

The following table describes the details that you can view about each invitation.

Invitation type   Type of the invitation: Initial Invitation, Reminder, or 
Thank You. You can access the invitation designer by 
clicking the needed invitation type link.

Campaign   Name of the campaign that the invitation is associated 
with (for details about multiple campaigns, see Adding 
multiple campaigns to survey, page 586).

Last modified   Date when the invitation was last modified.

Not Yet Invited Number of participants to whom the invitation has not 
been sent yet.

In Queue Number of invitation email messages that are being sent.

Sent Number of invitation email messages that are successfully 
sent.

Confirmed Received Number of invitation email messages that are received 
and opened by the participants.

Unsubscribed Number of invitation email messages that are sent to the 
participants who unsubscribed from your survey.

Undeliverable Number of invitation email messages that could not be 
delivered to the participants.

Bounced Back Number of invitation email messages that bounced back 
from the server or email address and could not be 
delivered to the participants.

Started Number of surveys that are started after participants 
received the invitation email message.
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Completed Number of surveys that are completed after participants 
received the invitation email message.

Status   Status of the invitation:
• Not Scheduled – The invitation is composed but not 

scheduled yet.
• Scheduled – The invitation is scheduled but not sent 

yet.
• In Progress – The invitation is being sent.
• Completed – The invitation is sent successfully to all 

recipients.
• # Error(s) – Errors occurred when sending the 

invitation (Undeliverable or Bounced Back status).
• Failed – The invitation task failed due to an EFM 

system error. The email message with the task error 
details is sent to the survey author. The participant 
statuses remain unchanged.

To see the mail details of the invitation, click its status link 
(see Invitation mail details, page 634).

The total number of the participants in each row accounts for all participants that are eligible for the 
current invitation (have Invited status for the previous invitation), except for participants with Over 
Quota, Branched Out, and Not Eligible statuses. However, you can view the participants with these 
statuses in the mail details dialog box (see Invitation mail details, page 634).

 Participants that have not completed the survey are listed as Not Eligible for the Thank You 
message.

The numbers in each column change according to the current status of participants. For example, when 
the invitation is sent to a participant, 1 is added to the Sent column; when this participant takes and 
completes the survey, 1 is added to the Completed column, and 1 is subtracted from the Sent column.

Actions  menu
Use the Actions  menu on the toolbar to complete the following actions:
• Version History – View version history of the selected invitation.

For more details, see Invitation version history, page 636. 
• Download Details – Export the Invitations grid content to a .csv file.
• Resend Invitation – Resend the selected invitation if it was not sent yet or failed to be sent. To 

make this option available, select a single invitation from the grid.
• Delete – Delete the selected invitation. To make this option available, select a single invitation 

from the grid. You cannot delete the invitation that was already sent at least once.

 If you have an Initial Invitation and several reminders, you can delete only the latest reminder 
that has not been sent yet.
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New  menu
Use the New menu on the toolbar to create the following items:
• Initial Invitation – Create an Initial Invitation in the invitation designer. This option is not 

available if the Initial Invitation already exists.
• Reminder – Create a reminder in the invitation designer. This option is not available if the Initial 

Invitation does not exist or if all four reminders are already created.
• Thank You – Create a Thank You message in the invitation designer. This option is not available if 

the Thank You message already exists.

 Alternatively, you can create the next invitation in the order by simply clicking the New button 
without having to select the needed option from the drop-down menu. It creates an Initial 
Invitation if no invitations are created yet, First Reminder if an Initial Invitation is created, and so 
on.

If a survey has multiple campaigns (Email List or Panelist), you can use the New menu only after selecting 
the needed campaign name from the Campaign menu at the top-right corner of the page. The 
Invitations grid then shows and handles only the invitations associated with the selected campaign. Also, 
all new invitations are created only for the selected campaign. All Campaigns is selected by default.
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Invitation mail details
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Overview page > Invitations side tab > Invitations grid > Status 
column.
On the Invitations page, you can view the mail details for the specific invitation by clicking the needed link 
in the Status column.
The following statuses appear as links in the Status column: Completed, # Errors, In Progress, and 
Scheduled.

 Scheduled status appears as a link only if the invitation is already sent to at least one recipient.

Clicking one of the links opens the mail details dialog box for the specific invitation, where you can view 
the following information about each participant from the current campaign.

Status Status of the invitation email for the specific participant:

  The email is scheduled to be sent
  The email is currently being sent

  The email was sent

  There was a problem when sending the email

Contact Info Email address or mobile number of the participant; depends on the 
specified Preferred Contact Method value (see Add individual 
participant, page 652).

Date Date when the invitation was sent to the specific participant or when 
the most recent campaign status was received.

Campaign Status Campaign status of the participant: Not Yet Invited, Invited, In Queue, 
Started, Completed, Sent, Confirmed Received, Unsubscribed, 
Undeliverable, Bounced Back, Over Quota, Branched Out, or Not 
Eligible.
• Not Eligible status is displayed for the participants who previously 

completed the survey, were unsubscribed, reached Over Quota 
status, or branched out from the survey. As a result, these 
participants cannot be sent the current reminder.

• For Undeliverable or Bounced Back statuses,
hover over the status to view the details.
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Actions Drop-down menu that allows you to complete the following actions on 
the selected participant:
• Resend Invitation – Resend the invitation to the participant. 

This option is not available for participants with the following 
statuses: Completed, Branched Out, Over Quota, and Not Eligible.

• Delete Participants – Delete the participant from the survey.
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Invitation version history
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Overview page > Invitations side tab > Invitations page >  select a single 
invitation from the grid > Actions menu > Version History.
With the Version History option on the Invitations page, you can view information about changes 
made to the specific invitation.

 You can view the history of the last 20 changes of your invitation.

To view version history, select the needed invitation from the grid, and then in the Actions menu, click 
Version History.

 You can delete only a single invitation at a time.

In the Version History dialog box, you can view the following information:
• Version – Number of the change made to the invitation.
• Date – Day and time of the change.
• User Name – Name of the user who made the change.
• Description – Short summary of the change. The following changes are tracked and displayed in 

the Description column:
• Created – Invitation is created.
• Invitation Updated – Subject or body text of the invitation is changed and saved.
• Schedule Updated – Schedule settings of the invitation are changed.
• Header Updated – To, From, Cc, or Bcc field of the invitation is changed and saved.
• Properties Updated – Options in the Advanced Features dialog box are changed and saved.
• Schedule Updated – Schedule settings are changed and saved.
• Language (Name_OF_Language) Added – New invitation language is added.
• Language (Name_OF_Language) Deleted – Invitation language is deleted.
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Add invitation language
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page > Email or Mobile tab > Language menu.
You can add a new language, and then set it for your invitations and reminders by using the Language 
menu in the invitation designer.
The invitation can be designed in languages other than your default language. You can view the current 
invitation language next to the Language menu. 

The Language menu

Procedure 
1 Create a survey, and then go to the Collect tab.
2 Select any survey distribution method with closed participation, and then on the Initial Invitation 

page, compose your invitation (see Compose Initial Invitation, page 623).

 The invitation language depends on your default survey language.

3 In the Language menu in survey designer, click Add New Language.
4 In the Add New Language dialog box, select a new language in which you want to create your 

invitation.
5 Click OK. The selected language is added to the Language menu.

Now you can type the email or SMS message in the added language, which will be saved as a separate 
message for the selected invitation.
If you send the invitation to the participants of the specific culture, the email or SMS message will 
display in the corresponding language for them (if this language was previously added to the 
invitation). For example, if the participant’s culture is Arabic, and you added the message in Arabic to 
the invitation, the participant will automatically see the received invitation in Arabic.

6 To delete the invitation language, select the needed language from the Language menu, and then 

click the delete icon   next to the menu. 
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 You cannot delete the default invitation language, which is set under My Account page, 
page 1444.
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Embed Images into Invitations
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page > Email tab > Advanced Features link.
OR 
Overview side tab >Create Invitation button > Initial Invitation page  > Email tab > Advanced 
Features link.
You can choose to embed images into the invitation email by selecting the Embed images into emails 
check box in the Advanced Features dialog box.

 By default, the Embed images into emails check box is cleared, and images are linked in your 
invitations.

 

Embedding images guarantees that all respondents will see your images and also increases the amount of 
time to send the invitations by up to 6 times. But at the same time it increases the chance that the email 
will be marked as spam and the respondents may not see the invitations, which can decrease your 
response rate.

 In the test invitations, images are always embedded.
 

Procedure 
1 On the Collect tab, select the Create a List, Invite Panelists, or Require a Passcode distribution 

method.
2 On the Initial Invitation page, compose an invitation message. 

For more information, see Compose Initial Invitation, page 623.

3 On the toolbar, click the icon.
4 In the image manager, select the image, and then click Insert.

The image manager

5 Click the Advanced Features link, and then select the Embed images into emails check box.
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The Embed images into emails check box

6 Click Save.
When you send the invitation, the image will be embedded into it.
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Hyperlink Manager
With the Hyperlink Manager, you can insert a hyperlink in almost any text editor in EFM application.
Hyperlink Manager is available in the following areas of the application: 
• Expanded Editor for questions, choices, columns, and text blocks
• Add Trigger dialog box
• Survey Glossary (by pressing Ctrl+K)
• End page designer (by pressing Ctrl+K)
• Library tab: Add Text Block dialog box, Hierarchical Question designer (by pressing Ctrl+K)
• Cases tab: Create New Case dialog box (by pressing Ctrl+K)
• Invitation designer for Initial Invitation, reminders, and Thank You message
• Schedule Export Delivery Page on the Response Manager page
• Schedule Report Delivery on the Reports side tab of the Cases tab
You can insert three types of hyperlinks: Hyperlink, Anchor, and Email.

The Hyperlink Manager dialog box
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Hyperlink tab
On the Hyperlink tab, you can define a link to a URL. You can also link any text element or image to the 
specified URL. You need to set the following properties:
• URL – The URL of the hyperlink.
• Response URL – Insert the survey link in the invitation, which opens the first survey page with 

the preselected response to a Choose One or Choose One with Image question. Respondents 
can change the preselected response or leave it as it is, and then proceed to the next survey 
questions. Specify the link text, question (from the first survey page only), and the preselected 
response.

 You cannot specify hidden questions and choices as preselected.

 Response URL option is available only in invitation designer and only in Modern survey 
rendering. For more information about survey rendering modes, see Survey rendering overview, 
page 414.

The Generate Response URL dialog box

• Link Text – Text that appears instead of the URL and works as a link.
• ID – The unique ID for an HTML element (the value must be unique within the HTML document).
• Target – The way the link opens when clicked. Choose the preset target from the menu or 

customize your own target.
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 All preset targets open the link in a new window except for the Same Window target.

• Existing Anchor – If an anchor is defined, it appears in this menu and populates the URL field.
• Tooltip – Text that appears when you hover over the link.
• CSS Class – Link formatting. If selected, the link will be formatted according to the class 

characteristics. The class must be defined in the survey theme. If the class is not defined in the 
theme, it will be ignored, and the link will have no class formatting.

Anchor tab
On the Anchor tab, you can define an anchor to create hyperlinks to a specific location on a page. This 
provides a convenient way to link to a different point on a long page. You need to set the following 
properties:
• ID – Unique ID for an HTML element (the value must be unique within the HTML document).
• Name – Name of the anchor point.

Email tab
On the Email tab, you can define a link to an email address. The link will open the default email client with 
the To and Subject fields populated as specified on the Email tab. You need to set the following 
properties:
• Address – Type a valid email address.
• Link Text – Text that appears as the link instead of the email address.
• Subject – Text that appears in the Subject line of the email message when clicking the link.
• ID – Unique ID for an HTML element (the value must be unique within the HTML document).
• CSS Class – Link formatting. If selected, the link will be formatted according to the class 

characteristics. The class must be defined in the survey theme. If the class is not defined in the 
theme, it will be ignored, and the link will have no class formatting.

• Tooltip – The text that appears when you hover over the link.
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Insert Response Link
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Collect tab > Create a List, Require a Passcode, or Invite Panelists distribution 
method > Initial Invitation page > Email tab > Insert Response Link button.
OR 
Overview side tab > Create Invitation button > Initial Invitation page  > Email tab >  Insert 
Response Link button.
With the Insert Response Link feature, you can insert a link to a specified question response in your 
invitation.
The link will open the first survey page with the preselected response to a Choose One or Choose One 
with Image question. Respondents can change the preselected response or leave it as it is, and then 
proceed to the next survey questions.

 This functionality works in Modern survey rendering only. For more information about survey 
rendering modes, see Survey rendering overview, page 414.

Procedure 
1 In the invitation designer, type the question text.
2 On the toolbar, click Insert Response Link.

 You can also add a link to a question response by clicking the  icon > Response URL. For 
more information, see Hyperlink Manager, page 641.

3 In the Insert Response Link dialog box, specify the following:
a. In the Link Text box, type the text of the link that you want to appear in the invitation.
b. In the Question menu, click the question for which you want to select the response.

 You can select only the  Choose One or Choose One with Image question.

c. In the Selected Response menu, click the preselected response.
4 Click OK.
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Manage Participants Overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or select the needed one 
(that is not opened yet) > Collect tab > click Create a List or Require a Passcode > Initial Invitation 
page > click the Add Participants via Manage Participants link > Participants tab > Manage 
Participants page.

You can add participants to your survey, view their contact information and invitation status, import a list 
of participants into the survey, and export their data into different file formats.

 The Manage Participants feature is available only for closed participation distribution 
methods, such as Create a List, Require a Passcode, and Invite Panelists (see Manage 
Participants for Invite Panelists, page 664).

Use the following links to navigate quickly to the information that you need:
• Manage Participants grid, page 646
• Add participants, page 647
• Filter participants, page 648
• Delete participants/panelists, page 648
• Set invitation status, page 648
• Export, page 649
• Search, page 649

Manage Participants grid
The Manage Participants grid provides you information about each participant that is added to the 
survey. You can sort survey participants in the grid by clicking the column heading. To change the width 
of a column, drag its edge.
In addition, you can adjust the number of participants that are displayed in the Manage Participants 
grid by using a toolbar at the bottom of the grid. The default number of participants per page is 10. 
However, you can select up to 100 participants to be displayed in your grid.
If a survey has multiple campaigns (Contact List or Panelist), you can select the needed campaign name 
from the Campaign list at the upper-right corner of the page. The Manage Participants grid then 
shows and handles only the participants associated with the selected campaign. Also, when adding new 
participants, they are added to the selected campaign only. All Campaigns is selected by default.
The following columns are available in the Manage Participants grid by default:
• Record ID – Unique record identifier of the participant.
• Panelist ID – Unique identifier of the panelist.
• Email – Participant's email address.
• Campaign – Name of the campaign associated with the participant. This column appears only for 

multiple-campaign surveys.
• Started – Time when the participant first accessed the survey.
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• Completed – Time when the participant completed the survey.
• Branched Out – Time when the participant was branched out of your survey.
• Over Quota – Time when the participant reached the over quota limit. 
• Last Modified – Last time when the participant accessed the survey.
• Invitation Status – Last invitation sent to the participant.
• Campaign Status – High priority action taken by the participant while answering the survey.

For Require a Passcode:
• Key 1 – The first key the participant uses to access the survey.

 The Require a Passcode survey must start with a Fill in the Blank question with up to three 
topics for participants to access the survey. The number of keys in the Manage Participants 
grid depends on the number of topics that you enter in the first Fill in the Blank question.

• Key 2 – The second key the participant uses to access the survey.
• Key 3 – The third key the participant uses to access the survey.
To add more columns to the grid, click the Columns button on the toolbar. For details, see Add a column 
in Manage Participants, page 669.
To view the detailed information about the participant, click the Record ID value in a specific row. You 
can click the previous or next link in the Participant Information dialog box to browse through the list 
of participants.
To manage all participants, select the check box in the upper-left part of the Manage Participants grid.

Add participants
On the Manage Participants page, you can add participants to your survey by using the following Add 
menu options:
• Email Addresses Only (For Create a List only) – Type the email address of the person that you 

want to invite to the survey. You can type a list of delimited email addresses directly or copy a list 
of email addresses into the field. The application supports simple and extended email formats, for 
example, user@vovici.com and <First name, Last name> user@vovici.com (for details, see Add 
participants by email addresses, page 650).

• Mobile Numbers Only (For Create a List only) – Type the mobile number of the participant. 
You can add several mobile numbers separated by comma or semicolon. For details, see Add 
participants by mobile numbers, page 651.

• Add Individual Participant – Type the email address of the individual participant. You can also 
optionally provide the culture and keys (1-3) for the individual participant to access the Require a 
Passcode survey. The second and third keys are optional and all of the keys must be entered 
correctly by the participant to access the survey (for details, see Add individual participant, 
page 652).

• Import Participants – Upload a file with a list of participants into the survey. You can import 
.csv, .tsv, .xlsx, .txt, and .zip file formats. The first line in a file must contain only identifying 
headers going from left to right. These headers are used to tell the product what values are 
assigned to each column in the database when the file is imported. Each participant entry must 
start on a new line in the file (for details, see Add participants by importing a file, page 654).
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 When importing participants from a .csv or .xlsx file, remove any extra worksheets from the file.

• Schedule Import – Upload participants from a file automatically (for details, see Schedule 
Participants Import, page 655).

If a survey contains both Email List and Panelist campaigns and the grid is set to show All Campaigns, 
the panelist adding options are also available on the Add menu:
• Add Panelists – Develop your participants list from your panel workgroup. For details, see Add 

panelists via filtering options, page 665.
• Add Panelists One at a Time – Add each individual panelist at a time. For details, see Add 

panelists one at a time, page 666.
You can also add participants from the Email Invitation window. Any email address typed in the To field 
appears as a separate account on the Manage Participants page.

Filter participants
You can apply a custom filter to the Manage Participants grid to view the participants who only meet 
certain criteria. For example, you can filter by participants who have received the First Reminder to take 
the survey. You can create the filter using the Filter button on the Manage Participants toolbar. For 
details, see Filter participants, page 662.

Delete participants/panelists
On the Manage Participants page, you can remove participants from your survey. When you delete 
participants from the Manage Participants page, they will no longer be able to access the survey or edit 
their responses.
On the Delete menu, you can do the following:
• Delete Selected Participants – Select the check box next to the participants you want to delete 

from your survey, and then on the Delete menu, click Delete Selected Participant(s).
• Clear Participant Responses – Select the check box next to the participants you want to target. 

On the Delete menu, click Clear Participant Responses. All targeted participant responses 
associated with the current survey will be removed.

Set invitation status
You can set the invitation status for your participants to resend an initial invitation or a reminder if the 
respondents have not received it by using the Set Invitation Status menu on the toolbar. 

 The message and subject text of a reminder along with the From, Cc, Bcc, and Reply To fields 
are copied from the previous invitation or reminder into the next one. Images and translations 
are copied too.

The following options are available in the Set Invitation Status menu:
• Not Yet Invited
• Invitation Sent
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• First Reminder Sent
• Second Reminder Sent
• Third Reminder Sent
• Fourth Reminder Sent
• Thank You Sent

 To ensure a high level of security and email delivery reliability, EFM does not support external file 
attachments to any email messages sent from the application (including survey invitations, 
reminders, and ‘Thank You’ messages.) If you need to share a file via the EFM email, we 
recommend that you place it on an accessible web location and provide a link to the location in 
the email message.

Export
On the Manage Participants page, you can export your participants list to different file formats using 
the following Export menu options:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS
For details, see Export participants list to file, page 660.

Search
Using the Search option, you can quickly find the required participant in the Manage Participants grid. 
You can search participants by their email address. For details, see Search for participants, page 661.
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Add participants by email addresses
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey or create a new one 
> Collect tab > click Create a List > Initial Invitation page > click the Add Participants via Manage 
Participants link > Participants tab > Manage Participants page.

For Create a List campaign, you can add participants to your survey by simply typing their email 
addresses in the Add Email Addresses box.

Procedure 
1 On the Manage Participants page, on the Add menu, click Email Addresses Only.
2 If your survey contains multiple campaigns of the same type and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participants will be 
added to the selected campaign only.

3 In the Add Email Addresses dialog box, type the email addresses of your survey participants 
separated by commas or semicolons.

4 Click Add Participants.
The added participants appear in the Manage Participants grid. The Preferred Contact Method 
column displays Email for these participants (to add columns in the Manage Participants grid, see Add 
a column in Manage Participants, page 669).
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Add participants by mobile numbers
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey or create a new one 
> Collect tab > click Create a List > Initial Invitation page > click the Add Participants via Manage 
Participants link > Participants tab > Manage Participants page.

You can add participants to the Contact List campaign of your survey by typing their mobile numbers in 
the Add Mobile Numbers box.

Procedure 
1 On the Manage Participants page, on the Add menu, click Mobile Numbers Only.
2 If your survey contains multiple campaigns of the same type, and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participants will be 
added to the selected campaign only.

3 In the Add Mobile Numbers dialog box, type the mobile numbers of your survey participants 
separated by commas or semicolons.

4 Click Add Participants.
The added participants appear in the Manage Participants grid. The Preferred Contact Method 
column displays Mobile Number for these participants (to add columns in the Manage Participants 
grid, see Add a column in Manage Participants, page 669).
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Add individual participant
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey or create a new one 
> Collect tab > click Create a List > Initial Invitation page > click the Add Participants via Manage 
Participants link > Participants tab > Manage Participants page.

You can add an individual participant to your survey by using the Add Individual Participant option on 
the Manage Participants page.

Procedure 
1 On the Manage Participants page, in the Add menu, click Add Individual Participant.
2 If your survey contains multiple campaigns of the same type, and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participants are 
added to the selected campaign only.

3 In the Add Individual Participant dialog box, type the email address or mobile number of the 
participant in the Email or Mobile Number boxes correspondingly.
You are required to provide at least one contact method. You can view the specified contact method 
information (Email or Mobile Number) in the Preferred Contact Method column on the Manage 
Participants page for Contact List and Panelist campaigns.

 If your survey contains both Contact List and Panelist campaigns, to view the Preferred Contact 
Method column for the two campaigns, just select it either from Respondent Fields or 
Panelists folders. However, to hide this column, you need to clear it in both Respondent Fields 
and Panelists folders.

If both email and mobile number are provided for a participant, you can specify which contact 
method to use for sending a specific invitation in the Advanced Features of the invitation 
(Advanced Features of invitation, page 625). The Preferred Contact Method column displays 
Invitation Preference for this participant.

 Mobile Number box is displayed in the Add Individual Participant dialog box only if the SMS 
feature is configured for your workgroup by System Administrator.

4 For Require a Passcode distribution method, define the keys in the provided fields to enable 
participants to access the survey.

5 For Create a List distribution method, click the Optional Fields link to do the following:
• Define keys in the provided fields to enable adding participants with the same email address. If 

you define keys for the participant, you can enter the email address that is already in use by 
another participant. The survey URLs for these participants are different and different records are 
created for them.

• Select the participant's culture in the Culture menu (also available for Require a Passcode).
6 Click Add Participant.
The added participant appears in the Manage Participants grid. The Preferred Contact Method 
column displays Email or Mobile Number correspondingly. 
To add columns in the Manage Participants grid, see Add a column in Manage Participants, page 669.
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Add participants by importing a file
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey or create a new one 
> Collect tab > click Create a List > Initial Invitation page > click the Add Participants via Manage 
Participants link > Participants tab > Manage Participants page.

You can import a list of participants with the corresponding fields from a file without having to manually 
add each individual participant.
For Email List and Require a Passcode campaigns, you can also preload participants’ responses to the 
questions that are available in your survey. When participants that are associated with these responses 
access the survey, the responses are preselected. The participants can edit the preselected responses or 
leave them as they are, and proceed to other questions.

 You can preload participants’ responses only if the survey is open.

Procedure 
1 On the Manage Participants page, on the Add menu, click Import Participants.
2 If your survey contains multiple campaigns of the same type and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participant will be 
added to the selected campaign only.

3 In the Import Participants dialog box, click Choose File to navigate to the file that you want to 
upload. You can import .csv, .tsv, .xlsx, .txt, and .zip file formats.

 All times must be imported in UTC time. When you upload them, they appear in the default time 
zone set on the My Account tab.

4 Select the file, and then click Next.
5 In the Map Fields dialog box, map the imported columns to the corresponding respondent fields, 

and then click Next.

 Preloaded participants’ responses are available in the Map Fields dialog box only if the survey is 
open. 

6 Click Import.
The imported participants’ fields and preloaded data now appear in the Manage Participants grid.
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Schedule Participants Import
Navigation

Design & Collect tab > Surveys tab > My Surveys page > select the needed survey or create a new one 
> Collect tab > click Create a List > Initial Invitation page > click the Add Participants via Manage 
Participants link.
You can schedule to  import participants from a file automatically.

 The automatic participants’ import is available for the Create a List and Require a Passcode 
campaigns.

In addition, you can preload participants’ responses to the questions that are available in your survey. 
When participants that are associated with these responses access the survey, the responses are 
preselected. The participants can edit the preselected responses or leave them as they are, and proceed 
to other questions.

 You can preload participants’ responses only if the survey is open.

During import, all files (if a wild card is used) that match the file name are picked up according to the 
schedule set by you. Each row in the imported files is imported into the participant list based on the 
defined mapping. After the successful import, the files are renamed. The file is renamed to {existing file 
name} -yyyy-mm-dd-hh-mm.bak. The date is the current time that the file is imported.

Procedure 
1 On the Manage Participants page, on the Add menu, click Schedule Import.
2 If your survey contains multiple campaigns of the same type, and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participant will be 
added to the selected campaign only.

3 In the Schedule Import dialog box, click Choose File to navigate to the file that you want to import. 
You can import .csv, .tsv, .xlsx, .txt, and .zip file formats.

4 Select the file, and then click Open.
5 On the Map Import tab, map the imported columns to the corresponding respondent fields, and 

then click Next.

 Preloaded participants’ responses are available on the Map Import tab only if the survey is open. 

6 On the Import Settings tab, on the Import Method menu, select whether you want to import the 
file with participants from the SFTP site or the EFM folder. The EFM folder path for participants import 
is {EFMinstall}AppData\{groupID}\import.

 For the EFM Folder option, you need to specify only the file name.

7 In the Server Name text box, type the name of the server where the file to import is located.

 The port number in the Port text box is fixed at 22 and is not changeable.
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8 In the Path text box, type the path to the import file.
9 In the File Name text box, type the name of the file to import.

 The file name supports a wild card character (*) that allows using a dynamic file name. For 
example, survey1234participantsdate*.csv (all files that start with "survey1234participantsdate" 
and end with ".csv").

10 In the User Name and Password text boxes, type the user name and password to access the server.
11 To allow sending a survey to the same participant multiple times, select the Allow duplicate emails 

in imported file(s) check box.

 Email address is used to check for the duplicates.

12 To import new or existing participants that did not receive invitations within the specified period, 
select the Only import participants who have not been emailed in the past [ ] days check 
box, and then enter the number of days in the text box.

 If you select both Allow duplicate emails in imported file(s) and Only import participants 
who have not been emailed in the past [ ] days check boxes, in this case, the preload data 
will not be updated.

13 To test the SFTP connection, click Test.
14 Click Next.
15 On the Import Frequency tab, select the option for the frequency of the file import. The following 

options are available:
• Not Scheduled – Select this option to import the file later.
• Import Now – Select this option to import the file immediately.
• Import participants at a specific date and time – Select this option to import the file at a 

date and time of your choosing. You can enter a date and time manually or select a date and time 
by clicking the respective icons. Select a valid start date and time, otherwise the file will not be 
imported.

• Show Recurrence Options – Select this option to import the file multiple times for a set or 
infinite period. You can set your import to occur every 15 minutes, hourly, daily, weekly, or 
monthly. In addition, you can set an end date or select no end date.

16 To send a status email with the results of the import transaction, select the Notify survey owner by 
email of import status check box.

17 Click Finish.

 You can use the Back button to go back to the previous tab. After the initial setup is configured, 
you can navigate between the tabs by clicking the tab name.
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View participant details
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one > Collect tab > click 

the needed distribution method > Overview dashboard >  menu > Participant Details option.

You can view a campaign chart and a table with the participant information collected for a particular 
campaign. You can also print or send an email message with the participant information report. For 
Contact List, Panelist, and Require a Passcode campaigns, if there are any invitations, you can select 
the needed invitation type from the list and view information for this type of invitation.

Procedure 
1 On the Collect tab, click the Overview tab.

2 In the needed campaign widget, click the  menu, and then click Participant Details.
3 To view information for a particular type of invitation, select it from the list.

By default, Overall Campaign is selected.
4 To print or send a report by email, click the Print or Email button correspondingly.
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Delete participants
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
Add Participants via Manage Participants link.

You can delete the selected participants from the Manage Participants grid. If you delete a participant, 
all data related to the participant including responses will be deleted.

 The deleted participant has no access to the survey.

Procedure 
1 On the Manage Participants page, select the check box next to the participant that you want to 

delete. 
2 On the Delete menu, on the toolbar, click one of the following options:

• Delete Selected Participant(s) – Delete the selected participant(s).
• Delete from Panel – Delete the panelist, and, if needed, delete the participants.
• Clear Participant Responses – Delete the selected participant responses that are associated 

with the current survey.
3 In the confirmation dialog box, click the Delete Participant(s), Delete, or Clear button 

correspondingly.
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Set Invitation Status
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can set the invitation status for a specific participant. You can use this option if you do not want to 
send certain invitations (including Reminders and Thank You message) to some participants. For example, 
if you set the Second Reminder Sent status for a participant, this participant will not receive Second 
Reminder and all the previous invitations: Initial Invitation, First Reminder, and Second Reminder.

Procedure 
1 On the Manage Participants page, select the check box next to the participant that you want to set 

the invitation status for. 
You can select multiple participants at a time.

2 On the Set Invitation Status menu, click the needed invitation status. 
3 In the Set Invitation Status dialog box, set time and date of the selected invitation status, and then 

click OK.
The selected invitation status appears in the Invitation Status column.
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Export participants list to file
Navigation

Design & Collect tab > Surveys side tab > My Surveys page > create a new survey or open an existing 
one > Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation 
page > click the Add Participants via Manage Participants link.

You can export a list of participants into a file.

Procedure 
1 On the Manage Participants page, on the Export menu, click the appropriate file format. The 

available options are .csv, .tsv,  .xlsx, and spss.
The export file is generated in the selected format.

 Time stamps are exported in UTC time.

2 To save or open the file, click the link that appears in the Export Participants dialog box.
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Search for participants
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can search for participants by their email address by using the Search box.

Procedure 
1 On the Manage Participants page, type a partial or whole email address in the Search box.

2 Click the Search icon  .
The participants that match your input are displayed in the grid.
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Filter participants
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can filter participants by the custom filter criteria.

Procedure 
1 On the Manage Participants page, click the Filter button.
2 In the Filter dialog box, click the Add button or the Add Filter Criteria link.
3 In the Add Filter Criteria dialog box, in the Source list, click the source data for your filter: 

Participant Information,  Respondent System Information, or Respondent Location. For 
details about respondent location data, see Properties, page 482.

4 In the corresponding lists, click the field, expression, and value by which you want to filter 
participants. For example, to filter participants who have received an initial invitation, select Initial 
Invitation Status = Sent.

5 Click the Add button. 
The new filter appears in the Filter dialog box.

6 Click the Apply Filter button. 
The Manage Participants grid now displays participants who meet the Initial Invitation Status = 
Sent criteria.

 To edit the filter, click the edit link. To remove the filter, click the clear link.
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Filter participants by organization
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can filter participants by the organization that they belong to.

Procedure 
1 In the Manage Participants grid, click the Filter button.
2 In the Filter dialog box, click the Add button to add a new filter. 
3 On the Source menu, click Participant Information.
4 On the Field menu, click Organization.
5 Use the Expression and Value menus to specify the organization that you want to use for or exclude 

from filtering.
6 Click the Add button to save the filter criteria.

The created filter is displayed in the Filter dialog box.
7 Click the Apply Filter button to filter participants according to the created criteria.
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Manage Participants for Invite Panelists
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click Add Panelists via Manage Participants link.

You can invite the panelists from your panel workgroup to take your survey.
Select the panelists from the available workgroup by clicking the Add Panelists via Manage 
Participants link. Once you click this link, the Manage Participants page opens. There are numerous 
filtering options available from the Add Panelists dialog box. Use filtering to target a specific group of 
panelists who meet your survey criteria or add your participants one at a time searching by first name, 
last name, or email.
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Add panelists via filtering options
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can use several filtering options available in the Add Panelists dialog box to help you develop your 
participant list from your panel workgroup.
Typically, only a subset of your panelists is used as participants for your survey.

Procedure 
1 On the Manage Participants page, on the Add Panelists menu, click Add Panelists.
2 If your survey contains multiple campaigns of the same type and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participant will be 
added to the selected campaign only.

3 In the Add Panelists dialog box, select one of the following options to define your participant list:
• Limit Number of Panelists to – Limit the number of Panelists in your survey based on a 

number you specify.
• Apply Saved Filter – Select filters you previously set up on the Panel > Filters tab.
• Add Filter Criteria – Define filter criteria for your panelists.
• Filter by Activity (expand Activity section) – Define participant list by filtering panelist activities. 

For example, you can add to the participant list all panelists that had their invitations sent 3 days 
ago or the panelists that have never been sent an invitation.

• Filter using Advanced options (expand Advanced section) – Select participants according to 
the panelist's original source (how they were added to the panel) or how many days the panelist 
has been a member of the Panel workgroup.
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Add panelists one at a time
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can add each individual panelist at a time.

Procedure 
1 On the Manage Participants page, on the Add Panelists menu, click Add Panelists One at a 

Time.
2 If your survey contains multiple campaigns of the same type and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participant will be 
added to the selected campaign only.

3 In the Find Using dialog box, type the panelist’s first name, last name, or email address in the 
corresponding boxes, and then click Find.
The names of the panelists that meet the search criteria appear in the Panelists box. You can use one 
or all of these fields to find the needed panelist.

 Select the Exact Matches Only check box if you want the search to return only names that 
exactly match the information you entered. For example, if you don't select the Exact Matches 
Only check box and enter the name John, the search might return Johnson as well as John.

4 To add the found panelists to the participant list, click Add. 
To conduct another search, click Close.
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Add the same panelist multiple times
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can add the same panelist multiple times to the survey participant list by using key identifiers in the 
Add Panelists or Add Panelists one at a time options.
Typically, panelists are asked to take a survey only once, however, in some cases you may want to send 
the same survey out to the same panelists more than once (for example, a quarterly employee 
satisfaction survey). To do this, you need to provide a key identifier each time you send the same survey 
out to the same panelists. For example, you may have an employee satisfaction survey that you send out 
quarterly and you might designate the key identifiers as follows:
• The first time you send out the survey: Key 1 = Q1 and Key 2 = 2010
• The second time you send out the survey: Key 1 = Q2 and Key 2 = 2010
To further clarify, at the end of Q1 2010, you send out an employee satisfaction survey to all of your 
employees to gather information (employees = panelists). At the end of Q2 2010, you send out the same 
employee satisfaction survey to all of your employees, but in this instance you need to add a key 
identifier because your employees have already answered this survey in Q1 2010. The product only 
allows a panelist to reply once to a survey. If you try to resend the same survey to the same panelists, you 
will receive an alert that you have already added these panelists or they have already received this survey. 
By using the key identifiers, you can resend the same survey to the same group of panelists because you 
are associating the panelists with a key reference (for example, Q1 2010).

 The keys can be used for any purpose desired by the user but must be populated in order to 
allow a panelist to access a survey more than once. You can also use key identifiers in Course 
Evaluation (for details, see Course evaluation, page 668).

Procedure 
1 Add panelists by clicking the Add Panelists or Add Panelists one at a time option.
2 If your survey contains multiple campaigns of the same type and the grid is set to show All 

Campaigns, in the Add to this campaign list, select the needed campaign. The participant will be 
added to the selected campaign only.

3 Configure key identifiers in one of the following ways:
• If the Add Panelists option is selected:
a. In the Add Panelists dialog box, select the Configure User Keys check box, and then click 

Next.
b. Type the key identifiers in the corresponding Key fields, and then click Next.
• If the Add Panelists one at a time option is selected:
a. In the Find Using dialog box, type the key identifiers in the corresponding Key fields.

4 Click Add.
The added panelists are now associated with the corresponding key identifiers, and the panelists can take 
the same survey again.
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Course evaluation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > click Create a List, Require a Passcode, or Invite Panelists > Initial Invitation page > 
click the Add Participants via Manage Participants link.

You can use key identifiers defined through the Add Panelists or Add Panelists one at a time option 
for course evaluation.
For example, you want your students to evaluate a course each time it is completed. You use the same 
survey, but they are evaluating a different course. In the example provided below, Key 1 = course name, 
Key 2 = professor, and Key 3 = semester and year.
A Panelist with an External ID of 34GDRT3 (in this panel, it's the Student ID number). The first time this 
panelist is added, the following keys are assigned:
• Key 1: English Literature 101
• Key 2: Professor Leyland
• Key 3: Winter 2005
If another panelist with an External ID of 25FGDF8 is added at the same time, they will also receive:
• Key 1: English Literature 101
• Key 2: Professor Leyland
• Key 3: Winter 2005
To add different key information for panelist 34GDRT3, specify the following keys, and then click Add 
again:
• Key 1: English Literature 101
• Key 2: Professor Fowler
• Key 3: Spring 2005
Key 1 is the same in this round of imports, but Key 2 and Key 3 are different. Only one of the keys needs 
to be different to add the Panelist more than once, as all of the keys specified are verified in order to 
allow access. In this example, only External ID of 34GDRT3 is added twice. Panelist 25FGDF8 can only 
access the survey one time, but Panelist 34GDRT3 can access the survey twice.
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Add a column in Manage Participants
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > Participants tab > Manage Participants page > Columns button.

You can specify which columns you want to display in the Manage Participants grid. Also, you can 
export the columns and filter on them.
You can add fields from the following folders as columns: 
• Respondent Fields 
• Respondent System Information
• Respondent Location

 Respondent System Information, Respondent Location, and some of the Respondent 
Fields data are available only if the Track Respondent Information check box is selected on 
the Properties tab in survey designer. For more information, see Properties, page 482.

For the Invite Panelists survey, you can also add the panelists and profiles information as columns. 
However, for surveys with multiple campaign types, the Profiles folder is unavailable.

Procedure 
1 On the Manage Participants page, click the Columns button.
2 In the Select Columns dialog box, click the arrow next to the needed folder to expand it.
3 Select the check box next to the fields that you want to add.
4 Click Apply.
The added columns are now displayed in the Manage Participants grid. You can export the columns 
and filter on them.
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Participant source reference
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Collect tab > Participants tab > Manage Participants page > Columns button.

You can associate the participants added to your survey with the corresponding task to better understand 
the success of your campaigns.
The following columns can be added to the Manage Participants grid and to the Responses grid:
• Source Type – Shows the type of source used to add participants, for example, manual entry, file, 

Web Service, active directory, survey, and so on.

 The Source Type value is applicable to all participants added to the survey irrespective of the 
way you added them.

• Task ID – Shows the unique ID number of the task.
• Occurrence – Shows the number of the task occurrences.

 You can also use the Source Type, Task ID, and Occurrence values as criteria to filter 
participants or responses.
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Schedule page
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > select the needed survey > Collect tab > click 
the Create a List, Require a Passcode, or Invite Panelists distribution method > Initial Invitation 
page > click Skip to Dashboard > Overview tab > Schedule link.

You can view and manage schedule settings of the survey and invitation tasks, such as Open Survey, 
Close Survey, Send Initial Invitation, and other tasks. Survey tasks and invitation tasks are presented 
in two separate grids with the corresponding headings.
If a survey has multiple campaigns (Email List or Panelist), you can select the needed campaign name 
from the Campaign list at the top-right corner of the page. The Schedule grid then shows and handles 
only the tasks associated with the selected campaign. The All Campaigns option is selected by default.
You can schedule survey tasks in the Standard or Transactional mode. By default, the Schedule page 
opens in the Standard mode. To switch between the modes, from the Schedule using list at the top-
right corner of the page, select the needed option.

 When switching between the schedule modes, all existing scheduled tasks are removed.

Standard mode
With the Standard mode, you can schedule each survey tasks separately without any dependencies 
between the tasks. Just select the task in the grid, and then click one of the following buttons on the 
toolbar to complete the needed action:
• Edit – Open the Edit Task dialog box, where you can do the following:

• Set the task start date – In the Task section, type the start date and time in the box.
• Set the task recurrence options – In the Recurrence section, set the task to occur multiple times 

for a set or infinite period of time. You can set the task to occur daily, weekly, or monthly. In 
addition, you can specify an end date or select the No End Date option.

• Set the task advanced options – In the Advanced section, set to notify the survey owner of the 
task status. For reminders, in the Advanced section, you can additionally select the following 
options:
- Send reminders to the participants who have begun but not yet competed the survey.
- Send reminders to the participants who have not received a prior invitation to this survey in 

the specified number of days.
• Remove – Remove the schedule settings of the task.The task status changes to Removed.
• History – View the task history.

To perform a task immediately, click the  icon in the New column.
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Transactional mode
With the Transactional mode, you can schedule sending of invitations to occur over a specified period of 
time based on the date when the participant was provided access to the survey by being added via 
Manage Participants.

 For Open survey and Close survey tasks, scheduling in the Transactional mode works the same 
way as in the Standard mode.
To perform Open survey or Close Survey task immediately and override the transaction timing, 
select the task from the grid, and then click Execute Now on the toolbar.

To schedule sending of an invitation in Transactional mode, select the needed task in the grid, and then 
click Schedule on the toolbar. In the Schedule dialog box, you can set the time when each of the 
invitations is sent by clicking one of the following options in the corresponding menu:
• Not Scheduled (default) – Send the invitation later.
• As Soon As Possible – Send the invitation as soon as possible after the Access Granted date. This 

option is available only for the Initial Invitation and Thank You message.
• After Set Period – Send the invitation after the specified period of time, which is calculated 

based on the Access Granted date.
• Access Never Revoked – The access to the survey is never canceled.

Tips

• You can make changes to any triggered task if the task has not occurred yet.
• While using Transactional mode, you still have the option to close a survey. This will cancel the 

process and pending reminders will not be sent. Thank You messages will not be sent, because the 
process is terminated; however, you can manually send the Thank You message.

Example:  
On the following image, the sending of invitations is scheduled as follows:
• The Initial Invitation is scheduled to be sent as soon as possible after the Access Granted date.
• The First Reminder is scheduled to be sent at 12:45 A.M., two days after the Access Granted date.
• The Second Reminder is scheduled to be sent at 12:45 P.M., three days after the Access Granted 

date.
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Scheduling invitations delivery
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > select the needed survey > Collect tab > click 
the Create a List, Require a Passcode, or Invite Panelists distribution method > Initial Invitation 
page > Delivery Schedule area.

You can specify when your invitation will be sent by using the Delivery Schedule options in the invitation 
designer.

 An invitation cannot be sent if the status of the survey is Closed.

You can schedule your invitations by using three different methods:
• No Scheduling – Send your invitation later. Select this option if you have not finished adding 

participants, writing your invitation message, or have not yet decided when to send the invitation.
• Send Now – Send your invitation immediately. To send your invitation, click the Send Invitation 

Now button and in the pop-up dialog box, click the Send Now button. There may be a delay of 
several minutes before your invitation is delivered to participants.

• Send at a specific date and time – Specify the date and time when you want to send your 
invitation. You can either type the date and time manually in the available box or select the date 

and time from the pop-up menus. Click the   and   icons correspondingly to select date 
and time to send your invitation. You can adjust invitation delivery settings on the Schedule page 
(for details, see Schedule page, page 672).

• Show Recurrence Options – Send your invitation multiple times for a set or infinite period of 
time. You can set your invitation to be sent daily, weekly, or monthly. In addition, you can specify 
an end date or select the No End Date option.

 To save your Delivery Schedule settings and invitation, click the Save Schedule button. If you 
do not want to save changes to your invitation, including the Delivery Schedule, click Skip to 
Dashboard, and then click the Continue without Saving button.
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Survey schedule options
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > select the needed survey > Collect tab > click 
the Generate Link distribution method > click Schedule the Survey.

With the Schedule the Survey option, for the Generate Link distribution method, you can schedule 
survey open and close dates and set the recurrence options for these tasks. For example, you can set 
your survey to open and close every 15 days for two months.
On the Schedule the Survey page, you can select the following scheduling options:
• Open Now (default) – Open the survey now. Survey status is set to Opened on the Overview 

dashboard.
• Open the survey at a specific date and time – Open the survey at the date and time of your 

choosing. You can enter the date and time manually or select them by clicking the corresponding 

 and   icons.
• Show Recurrence Options – Open the survey multiple times for a set or infinite period of time. 

You can set your survey not to open or open daily, weekly, or monthly. In addition, you can set an 
end date or select the No End Date option.

• Do not open survey – Save the survey schedule options, navigate to the Overview dashboard, 
and set your survey status to Not Yet Opened.

• Do not close survey – Let the survey remain open.
• Close the survey at a specific date and time – Close the survey at the date and time of your 

choosing. You can enter the date and time manually or select them by clicking the corresponding 

 and   icons.

 You can schedule the automatic survey closure period for all your surveys on the Configuration 
tab > Data Policies tab > Surveys tab > Option section. 

• Show Recurrence Options – Close the survey multiple times for a set or infinite period of time. 
You can set your survey not to close or close daily, weekly, or monthly. In addition, you can 
specify an end date or select the No End Date option.
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Report landing page
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > report landing page.
You can create your own custom report from scratch, view the report responses, and save the report data 
in different file formats.
When you create the first report on the survey, the report landing page opens.

The report landing page

On the report landing page, the following options are available:
• View Standard Report – You can open the standard report with charts and tables for each 

survey question in the report designer and customize it to your needs or access other stock 
reports.

• Design from Scratch – You can open the report designer and create a custom report with charts 
and tables for each survey question.

• View Responses – You can open the Response Manager page where you can view, edit, filter, 
and export the survey responses to different file formats. To save the report data directly in CSV, 
TSV, Microsoft Excel, or SPSS format, click the Quick Download option. To download the data, 
click the required file type icon.

• Export Text Analytics – You can export the survey responses for advanced text analysis.
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Reports page overview
Navigation

Design & Collect tab > Surveys tab  > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page.
You can create reports based on the results of a selected survey and save them for the later use.
You can set the order of your reports and customize how many reports are displayed in the grid.
By default, your reports are sorted by the Last Modified column in the Reports grid. If you want to 
change how your reports are displayed in the grid, click a column header (Report Title, Primary Source, 
Source Type, Owner, Last Modified, or Published). An arrow is displayed up (ascending) or down 
(descending) to show the sort order. You can also change a column width by dragging the edge of the 
column header.
The default number of reports per page is 10. You can select up to 100 reports to be displayed on the 
Reports page.
To manage all reports, select the check box next to the Reports Title column header.
On the Reports page, the following columns are available:
• Report Title – Name of a report. 
• Primary Source – Name of the project (survey or profile), to which the report belongs.
• Source Type – Project type (survey or profile) to which the report belongs.
• Owner – The user to whom the report belongs.
• Last Modified – The last time when the report was changed.
• Published – The sharing status of the report.
• Public Link – The link to the public report.
On the Reports page, the following tabs are available:
• Reports – Create a new report for your survey, open, download, share, or delete an existing 

report.
• Responses – View, edit, export, or delete the survey responses.
• Weighting – Calculate the specific weight per survey respondent to ensure the accurate 

representation of a specific population, for example, males vs. females, within the data set.
• Advanced Text – Export the survey response data to the Text Analytics to analyze 

respondents’ sentiment based on their responses to the Essay questions in your survey.
• Insights – Evaluate the verbatims in the Text Analytics by using the industry standard 

classification models.
• Data Channels – Map survey to the imported data.

 If the survey contains an Image Upload question, the Images tab appears in the left pane. For 
more information, see Images side tab, page 868.

On the Reports toolbar the following options are available:
• Actions – Perform a certain action to the selected report. 

The following actions are available:
• Duplicate – Create a copy of your report.
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• Download – Save a selected report in the Adobe PDF, Microsoft Word, or Microsoft PowerPoint 
format and create a cluster report. 

 You can download the Cross-tab Analysis report only in the Microsoft Excel format.

• Schedule Report Email – Send email messages to the report viewers at the specified date and 
time.

• Share with Other Users – Share your report with other users. You can select which users can 
view the report, change the report name, and notify users by email that the report is available to 
view.

• Make Report Public – Allow the users that do not have access to the product to view a report.
• Delete – Remove the report from the grid.

• New – Create different types of reports. You can create a new report from scratch, standard 
report, or other reports and view the response data from your survey. For more information 
about report types, see Predefined reports, page 693.

• Download Report – Export your report to the selected format.
• Share – Share your report with other users. 

The following share options are available:
• Share with Other Users – Share your report with other users.
• Make Report Public – Allow the users that do not have access to the product to view a report.

In the Reports grid, you can sort reports by the Report Title, Owner, Last Modified, or Published 
columns. To open a report, click on it or select a check box next to the report title, and then on the 
toolbar, click the appropriate option. 
According to your permissions, the report opens in the Preview or Edit report views. For example, if you 
have permission to edit reports, and you have full access to the shared report, then the report opens in 
the Edit report view. Otherwise, the report opens in the Preview report view. Additionally, the public link 
is displayed to the right of the Edit column in the grid for public reports.
By default, the Reports grid displays only the first 10 reports. To view more saved reports per page, click 
25, 50, or 100 next to the View per Page section at the bottom of the Reports grid.
In addition, if the Reports grid is longer than one page, you can navigate between pages using the page 
navigation arrows in the lower-right corner of the Reports grid.
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Create report on unpublished survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > report landing page or Reports page. 
You can create reports not only for published (open) surveys but also during the survey designing process.
For the first report on your survey, you can create the report on the report landing page. If you have any 
saved reports, you can create reports on the Reports page.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to  the Analyze tab > report landing page, and then select one of the following options:

• View Standard Report
• Design from Scratch
• View Responses
• Export Text Analytics
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Name a report
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > report landing page or Reports page > New menu  > click the report type 
you want to create > Name Your Report dialog box.
You can name the report directly when you create it, either on the Reports grid or on the report landing 
page.
The default name is the report type followed by the next incremental number, for example, Standard 
Report 2. Naming a report makes it easier to organize and find the report later.
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > report landing page.

In the Reports grid, the first report appears unless you have already saved reports.
4 To create a standard report, click the View Standard Report button.
5 To create your own custom report, click the Design from Scratch button.

 You can also create other report types by clicking the New menu. 

6 In the Name Your Report dialog box,  in the Report Name text box, enter the name of a report.
7 Click OK.
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Duplicate reports
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > Actions menu > Duplicate button. 
OR
Report & Analyze tab > Project Reports tab > Reports page > Actions menu > click the Duplicate 
button. 
You can copy the saved reports, edit the report copy, and save it. 
The theme of the original report is automatically applied to the new copied report.

 You can copy only one report at a time.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then select a check box next to the report that you want 

to copy.
4 On the Reports toolbar, on the Actions menu,  click the Duplicate button.
5 In the Duplicate a Report dialog box, in the Report Name text box, enter the name of the report.
6 Click OK.
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Delete reports
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > Actions menu >  Delete button. 
OR
Report & Analyze tab > Project Reports tab > Reports page > Actions menu > Delete button. 
You can delete one, a few, or all your reports.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then select a check box next to the report that you want 

to delete.
4 On the Reports toolbar, on the Actions menu,  click the Delete button.
5 In the confirmation dialog box, click Delete.

The confirmation dialog box
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Report types
Navigation

Report & Analyze tab > Survey Reports tab > Reports page > New menu. 
You can  automatically generate a wide variety of default reports with the predefined collection of report 
elements. 
The following types of reports are available:
• Blank Report – The report type that allows you to insert charts, tables, and other report 

elements for a selected question manually. For more information, see Blank report overview, 
page 696.

• Standard Report – The default report that generates charts and tables for every question within 
your survey automatically. For more information, see Manage standard reports, page 687.

• Frequency Report – The report that shows the frequency distributions with counts and 
percentages of each close-ended question.

• Verbatim Report – The report that shows all responses to the verbatim (open-ended) questions.
• Comprehensive Report – The report that shows charts, summary statistics, and frequency 

distribution by selected question.
• Executive Summary Report – The report that shows overall summary information about each 

question.
• Cross-Tab Analysis Report – The report that shows a cross-tabulation of multiple variables at 

the same time.
• Organization Performance Analysis Report – The report that shows survey responses results 

associated with organizations and users.
• Statistics Report – The report that shows the summary statistics of the results, including means, 

medians, and standard deviations.
• Single-Question Banner Report – The report that shows a cross-tabulation of data based on 

selections for a specific question as compared with a demographic question of the Multiple 
Choice type.

• Trend Report – The report that shows an analysis of the survey data over a specified time 
period. By default, it provides the mean of each response, but you can customize it to your needs.

• Summary of Means Report– The report that shows a cross-tabulation of means for each 
question with options and provides a summary statistics as compared with two demographic 
questions of the Multiple Choice type.
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Standard Report
Navigation

Report & Analyze tab > Project Reports tab > New menu.
You can automatically generate default reports with charts and tables for every question within your 
survey. 

Create a standard report

Procedure 
1 Go to the Report & Analyze tab > Survey Reports tab.
2 On the New menu, click the Standard Report.

In the Create Report dialog box, you have access to the folders with the existing surveys, comment 
cards, profiles, data sets, and data stores.

 You can also search for the needed source by entering its name in the Search text box, and then 
clicking the Search button.

3 Click the arrow next to the folder that you need to expand, and then select the report source.

 Only published data stores are available in the Data Stores folder.

4 Click Create.

Rename a Report

Procedure 
1 In the report designer, click the report name.
2 Edit  the report name.
3 To apply changes, press Enter.
Every question with its report is placed on a separate page. For page names, the corresponding question 
text is used.
Once you create a standard report, the element editor opens in the left pane. You can customize the 
report to your needs by changing the report element properties in the element editor.
The standard report creates a report element for each survey question depending on the question type. 
Each report element is shown on a separate page in the same order as the questions in the survey 
designer.  Each page is named according to the question text.
In the standard report, the Response List report element is used by default for the Fill in the Blank 
and Essay questions. Frequency Chart report element is used for all the other questions. For the 
Matrix question, the generated report elements depend on the side being reported.
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Manage standard reports
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > report landing page or Reports page   > click the View Standard Report 
button.
You can automatically generate default reports with charts and tables for every question within your 
survey.

Create a standard report (for survey without reports)

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > report landing page.

In the Reports grid, the first report appears unless you have already saved reports.
4 To create a standard report, click the View Standard Report button. 
5 In the Name Your Report dialog box,  in the Report Name text box, enter the name of a report. 
6 Click OK.

Create a standard report (for survey with reports)

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports toolbar, and then click the New menu.
4 In  the New menu, click the Standard Report.
5 In the Name Your Report dialog box,  in the Report Name text box, enter the name of a report.
6 Click OK.

Rename a report

Procedure 
1 In the report designer, click the report name.
2 In the text box that appears, edit the report name.
3 To apply changes, press Enter.
Every question with its report is placed on a separate page. The corresponding question text is used  for 
the page names. For the first report on your survey, you can create the standard report on the report 
landing page. If you have any saved reports, you can create the standard report on the Reports page.
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Once you create a standard report, the element editor opens in the left pane. You can customize the 
report to your needs by changing the report element properties in the element editor.
The standard report creates a report element for each survey question depending on the question type. 
Each report element is shown on a separate page in the same order as the questions in the survey 
designer. Each page is named according to the question text.
In the standard report, the Response List report element is used by default for the Fill in the Blank 
and Essay questions, and the Frequency Chart report element is used for all the other questions. For 
the Matrix question, the generated report elements depend on the side being reported.



How to Create a Report Share reports

EFM User Guide 689

Confidential and Proprietary Information of Verint Systems Inc.

Share reports
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab >  Analyze tab > Reports page > Actions  menu > click Share with Other Users.
OR
Report & Analyze tab > Project Reports tab > Reports page > Actions  menu > click Share with 
Other Users.
You can share your reports with other users or organizations with a view access to them and  view the 
reports that are shared with you by other users.

 This feature is also available for the profiles.

When the report is shared with you, you are informed about it by email. The shared reports appear on 
the Reports tab when you use the Shared with Me quick filter.

 If one report has been shared with you several times, only the last modified copy appears on the 
Reports tab. If you have the corresponding permission, you can scroll and navigate through the 
shared report pages, export the report, and filter the shared report data.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then select the check boxes next to the reports that you 

want to share.
4 On the Reports  toolbar, on the Actions menu, click Share with Other Users.
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The Select Other Users dialog box

5 In the Select Other Users dialog box, select a check box next to the user or the organization, and 
then click the right arrow button to move them to the View Access box.

 All users that are assigned to the selected organization as well as all child organizations will be 
moved to the right box too. You can share the report with the users or organizations that you do 
not want by selecting the corresponding check boxes and clicking the left arrows button.

6 To send an email notification to the users that are allowed to view the reports, select the Notify 
Users by Email check box. 
The check box is selected by default.

7 To allow users to click the embedded text analytics report elements, such as the Word Cloud element 
or Sentiment Chart element, and view responses that represent them, select the Allow drill-down 
to response list for text elements check box. 
The check box is selected by default.

 For more details, see Word Cloud – Filtering, page 918 and Sentiment Chart – Filtering, page 897.
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8 To allow users to apply filters to the reports that are shared with them while viewing, select the Allow 
report viewers to filter the data being shared with them check box. 
The check box is clear by default.

9 Click OK.
10 In the Notify Users dialog box, edit the email notification.

The Notify Users dialog box

 The Notify Users dialog box opens only if the Notify Users by Email check box is selected.

11 Click OK.

 If the report that is containing the response image is shared with users with no view access, the 
Permission Denied message appears.
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Stop reports sharing
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab >  Analyze tab > Reports page > Actions  menu > click Share with Other Users.
OR
Report & Analyze tab > Project Reports tab > Reports page > Actions  menu > click Share with 
Other Users.
You can share your reports with other users or organizations with a view access to them and  view the 
reports that are shared with you by other users. You can also stop reports sharing with other users.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then select the check boxes next to the previously shared 

report.
4 On the Reports  toolbar, on the Share menu, click Share with Other Users.
5 In the Select Other Users dialog box, in the View Access text box, select the user or organization 

with which you want to stop the report sharing
6 To move the selected user or organization to the Users text box, click the left double arrow button.
7 Click OK.

The report is no longer available for viewing by the user or organization.

 When the multiple reports are selected, you can only add the report viewers.  To view the list of 
users who have access to the report and stop the report sharing, select a single report.
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Predefined reports
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design tab > Analyze tab > Reports page 
> New menu.
You can automatically generate a wide variety of default reports with the predefined collection of the 
report elements.
On the New menu, the following report types are available:
• Blank Report – The report type in which you can manually insert charts, tables, and other report 

elements for the selected question (see Blank report overview, page 696).
• Standard Report – The default report, that automatically generates charts and tables for every 

question within your survey (see Manage standard reports, page 687).
• Frequency Report – The report type in which the frequency distributions with counts and 

percentages of each close-ended question are displayed.
• Verbatim Report – The report type in which all responses to the verbatim (open-ended) 

questions are displayed.
• Comprehensive Report – The report type in which the charts, summary statistics, and frequency 

distribution by selected question are presented.
• Executive Summary Report – The report type in which the overall summary information about 

each question is presented.
• Cross-Tab Analysis Report – The report type in which the cross-tabulation of multiple variables 

at the same time is available.
• Organization Performance Analysis Report – The report type in which the survey responses 

results associated with organizations and users are displayed.
• Statistics Report – The summary statistics of the results, including means, medians, and 

standard deviations are presented.
• Single-Question Banner Report – The report type in which the cross-tabulation of data based 

on the selections for the specific question as compared with a demographic question of the 
Multiple Choice type is available.

• Trend Report – The report type in which the analysis of the survey data over the specified time 
period is displayed. By default, it provides the meaning of each response, but you can customize it 
to your needs.

• Summary of Means Report – The report type  in which the cross-tabulation of means for each 
question with options and the summary statistics as compared with two demographic questions 
of the Multiple Choice type is available.
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Create predefined report
Navigation

Report & Analyze tab > Survey Reports tab > Reports page > New menu. 
You can automatically generate a wide variety of default reports with the predefined collection of the 
report elements.
In this example,  creation of the Single-Question Banner report is described.

Procedure 
1 Go to the Report & Analyze tab > Survey Reports tab.
2 On the New menu, select the report type that you want to create.
3 In the Create Report dialog box, you have access to the folders with the existing  surveys, profiles, 

comments, data sets, Speech Analytics projects,   Unified Data Set projects,  ForeSee projects, or file 
imports.

 You can also search for the needed source by entering its name in the Search text box, and then 
clicking the Search button.

 Data from the Unified Data Set is available only if the System Administrator activates the  Unified 
VoC license for your workgroup.

4 Click the arrow next to the folder that you need to expand, and then select the report source.
5 Click Create. 
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The Single-Question Bannder dialog box

6 In the Single-Question Banner dialog box, in the Select a banner question menu, select the 
question.

7 In the Percentage menu, select the type of percentage to be displayed in your report.
8 Click OK.
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Blank report overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  Reports page > Design from Scratch option. 
You can create and manage your reports on the collected response data. You can insert charts, tables, and 
other report elements for the selected question. 

 For more information, see Report Options page, page 246.

When you open a new Blank Report, the report does not display any charts or tables (report elements) 
in the Report Content area. You can create your own custom report. The types of available report 
elements depend on the selected question. Different questions have different chart and table options.
Other features of the Blank Report include the ability to organize your report into sections, manage 
report properties, download report data, print the report, and so on.

Blank Report features

Item Description

1 Display the Edit report view of the report where you can add report elements and 
other content.

2 View the report pages.

3 View the report properties.

4 Add question text or free-form text to the report.
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Item Description

5 Download the report to a Microsoft PowerPoint, Microsoft Word, or Adobe PDF 
format.

6 Add a chart or table to the report on the Add a Report Element menu. You can edit 
report elements on the Edit Content Panel.

7 Edit the page title of the report.

8 Toggle between the Edit and Preview report views of the report.

9 Insert and organize charts and tables in the content area.

10 Filter the report based on data criteria and dates.

11 Prepare the report email message and schedule the date for its delivery.
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Create a blank report
Navigation

Report & Analyze tab > Survey Reports tab > Reports page > New menu. 
You can create and manage several types of reports on the collected response data by using the product. 
You can create several report types, including the Blank Report. You can insert charts, tables, and other 
report elements for a selected question. For more information, see the Report Options page, page 246.
When you open a new Blank Report, your report does not display any charts or tables (report elements) 
in the Report Content area. You can create your own custom report. The types of available report 
elements depend on the selected question. Different questions have different chart and table options.

 For more information, see Blank report overview, page 696.

Procedure 
1 Go to the Report & Analyze tab > Survey Reports tab.
2 On the toolbar, click the New button. The Create Report dialog box opens showing the folders with 

the existing  surveys, comments, profiles, data sets, Speech Analytics projects,   Unified Data Set 
projects,  ForeSee projects, and file imports  to which you have access.

 You can also search for the needed source by entering its name in the Search text box, and then 
clicking Search next to the text box.

 Data from the Unified Data Set is available only if the System Administrator activates the Unified 
VoC license for your workgroup.

 

3 Click the arrow next to the folder that you need to expand, and then select the report source.

 Only published file imports are available in the File Imports folder.

4 Click Create.

 You can also create a blank report by clicking the Blank Report option on the New menu on the 
toolbar.
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Report preview mode
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab >  Analyze tab > Reports page > create a new report or open an existing  one > click the 
Preview button.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > click the Preview button.
You can view your report current appearance during the report designing or editing process, export your 
report to the Microsoft Word, Microsoft PowerPoint, or Adobe PDF format, and create a cluster report.
You can access the report Preview mode by clicking the Preview button. If you are logged in to the 
application as a report viewer, click the report title to preview the report.

 For more information on how to preview a report as a report viewer, see Report Viewer Grid, 
page 863.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then create a new report or open a saved one.
4 On the report designer, on the toolbar, click the Preview button.
5 In the report preview window, navigate through the report pages by clicking the Previous Page and 

Next Page buttons or Go to Page menu.

 If you rename the report pages, the Go to Page menu contains those names.

6 To export the report to the Microsoft Word, Microsoft PowerPoint, or Adobe PDF format, and create a 
cluster report to view the report results outside the product, click the Download Report menu.

 For more information on how to download the reports, see Downloading reports, page 1012 and 
Cluster Reports, page 1013.
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Add a Report Element panel
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  Reports page > create a new report or open an existing one > Add a 
Report Element panel.
You can add different elements to your report.
On the Add a Report Element panel, 19 report elements and 2 other content options are available:
• Frequency Table – Table that displays both the number and percentage of respondents who 

answered the specified question.
• Frequency Chart – Chart that displays the frequency of responses to a selected question.
• Trend Table – Table that reports a time series analysis on the selected question.
• Trend Chart – Chart that reports a time series analysis on the selected question.
• Summary Table – Table that displays the results of one question's responses against two 

demographic fields.
• Summary of Means – Table that reports the means of the responses based on two questions.
• Cross-tab – Report element that is a cross tabulation of two selected questions. 
• Response List – Report element that displays answers from an open-ended question in the 

report.
• Statistics –  Report element that is a various statistics from a question.
• Correlation – Report element that is a statistical technique that is showing how strongly a pair of 

variables is related. The range of potential values is from -1.0 to +1.0. A correlation approaching 
1.0 signifies that two values are strongly related to one another in the same direction.

• Gap – This element reports on the differences between two numerical values. The Gap element 
subtracts the mean of the Comparison question from the mean of the Basis question. The Gap 
element is displayed both numerical and in a horizontal bar chart.

• Top Box – Report element that displays a cumulative value of the top two items of a rating scale. 
Researchers often combine the top two ratings as a way of comparing or evaluating preferences. 
Add this report element to define the number of rating points that are used in the top and 
bottom box calculation and choose from several options including the ability to display counts or 
percentages.

• Top Box Cross-tab – Report element that creates a summary of the responses to a question that 
is broken down by the responses of another question and presents the results by using a Top 
Box analysis format.

• Gauge – Report element that visualizes your scale-based questions as a gauge.
• Campaign Statistics – Report element that provides a quick overview of your campaign 

performance.
• Cross-tab Chart – Report element that provides a visual cross-tabulation of two selected 

questions as a chart.
• Image Slideshow - Report element with the help of which you can easily view and rotate images 

that are uploaded by the respondent when answering the Image Upload question.
• Statistics Map  – Report element that adds a statistics map to your report that displays the 

specific metrics from a question.
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• Respondent Map – Report element that adds a respondent map to your report that displays the 
geographical distribution of the survey respondents.

• Text – Add text to your report.
• Question – Insert the text of a question into the report.
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Report elements selection
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > Add a 
Report Element panel.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel.
You can customize your report by adding and editing report elements.
When you create or edit a report, in the Add a Report Element panel, the following all report elements 
are available:
• Frequency Table
• Statistics
• Correlation
• Gap
• Top Box
• Top Box Cross-tab
• Gauge
• Cross-tab Chart
• Frequency Chart
• Trend Table
• Trend Chart
• Summary Table
• Summary of Means
• Cross-tab
• Campaign Statistics
• Image Slideshow
• Image Tag Cloud
• Statistics Map
• Respondent Map

Organization Report Elements
• Bar Chart Organization Cross-tab
• Top Box Organization Cross-tab
• Organization Cross-tab Table
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Text Analytics
• Sentiment Chart
• Sentiment Summary
• Sentiment Table
• Sentiment Trend Table
• Word Cloud
• Heat Map
• Trend Chart
• Response List

Add Other Content
• Text
• Question
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Add report elements 
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > Add a 
Report Element panel.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add a Report Element panel.
You can add a new report element from the right content area by clicking the Add button.

 The Add button is displayed only if at least one report element is added to your report. You can 
paste the copied report element by clicking the Paste button next to the Add button.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then  create a new report or open  an existing one.
4 In the Add a Report Element panel, add at least one report element.
5 To add a new element, click the Add button.
6 In the left pane, click the Text button, for example, to add free-form text to your report.
7 In the Edit Content Panel, edit your text element.

Edit text element



How to Create a Report Add report elements

EFM User Guide 705

Confidential and Proprietary Information of Verint Systems Inc.

 You can add a number of report elements to a report depending on the question type. The 
procedure above is applicable for all report elements, except for the Text element.



How to Create a Report Add report elements from different sources

EFM User Guide 706

Confidential and Proprietary Information of Verint Systems Inc.

Add report elements from different sources
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one >  Add a 
Report Element panel.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel.
You can have report elements from different projects in one report. 
You can use all surveys and profiles to which you have access, including the My Surveys, Shared 
Surveys, Other Users' Surveys, Comments, Profiles, Data Sets, Speech Analytics, and File 
Imports folders.
You can also view a notice of the report element source on each report element. For more information, 
see Show Multi-Source Citation, page 708.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then create a new report or open an existing one.
4 In the Add a Report Element panel, click the report element that you want to add to your report.

 For this example,  the Trend Table report element is used.

5 In the Select data for your report element dialog box, next to the Data Source option, click the 
project name which appears as a link.

 By default, the current project name is displayed.
 

6 Select the survey, comment, profile, data set, Speech Analytics project,  Unified Data Set project,  
ForeSee projects, or file import from which you want to add a report element.

 Items in the Design report view are not shown.
 

 Data from the Unified Data Set is available only if the System Administrator activates the Unified 
VoC license for your workgroup.

7 To search for the specific survey, comment, profile, data set, Speech Analytics project,   Unified Data Set 
project, or file import, enter a partial or whole name of the item in the search box, and then click the 
Search button. The list of surveys, profiles, comments, data sets, Speech Analytics projects,   Unified 
Data Set projects, or file imports that match your input displays.

8 On the Questions menu, select the source question for the Trend Table element.
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 Only questions appropriate for this report element are displayed.
 

9 Click Add. 
Data filtering is not allowed for reports that use multiple sources, so the Data Filter section is limited in 
functionality. If a filter is applied to a report and you add a new element from different source, the 
current report filter is removed.
If the Logged-in User filter is applied to a multi-source report, and a new report element is added for a 
non-organization scoped survey (without the Employee External ID or Organization External ID 
question), the filtering is removed on a report level. For more information about the Logged In User 
filter, see Filters, page 723.
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Show Multi-Source Citation
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > add an 
element to the report > Report Element menu.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > add an element to the report > Report Element menu.
You can view the element data source if the report uses more than one data source. 
You can activate this option by selecting the Show Multi-Source Citation check box on the Report 
Element menu. This option is active by default. When the Show Multi-Source Citation check box is 
selected, the source is displayed on all report elements, including exported reports and widgets. If the 
same source is used for all report elements, the source citation is not displayed.

The report element source
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Activate auto-sizing option
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > Add a 
Report Element panel > add the Trend Chart or Frequency Chart report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add a Report Element panel > add the Trend Chart or Frequency Chart report element.
You can select the auto-sizing option for better appearance of the Frequency Chart and Trend Chart 
report elements. 
When the Size Charts Automatically check box is selected, the charts fit the current window size 
automatically.
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The Size Charts Automatically check box

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then create a new report or open an existing one.
4 On the Add a Report Element panel, add the Frequency Chart or Trend Chart report element.
5 Click the Appearance menu, and then select the Size Charts Automatically check box.
If you activate the auto-sizing option and resize the browser window, the high chart components shrink 
or extend accordingly, so that the chart fits the window.

 The Size Charts Automatically check box is selected by default.
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When the auto-sizing option is activated, all the other report elements also resize to fit the window, but 
the tables containing a large amount of columns may not shrink. The maximum width of the chart with 
the auto-sizing option activated is set to 900 pixels. The auto-sizing option does not change the height of 
the high chart component. The minimum width and height of the chart are set to 480 and 360 pixels 
correspondingly. The auto-sizing option does not affect embedded report elements, since they have a 
default height and width.

 When the Size Charts Automatically check box is selected, the Width and Height text boxes 
in the Chart Appearance menu are inactive.
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Drag report elements 
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > add an 
element to report > select an element that you want to drag.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > add an element to report > select an element that you want to drag.
You can rearrange your elements within a report by dragging them. 

 This feature is also available for the profiles and such report elements as text and question.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then create a new report or open an existing one.
4 On the report designer page, hover over a report element that you want to drag.
5 Move the element to the appropriate location by dragging its top bar.
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Returning to the top of the report page
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > scroll down 
the report page > click Return to top of page arrow.
When you scroll down the report page and report designer toolbar disappears from your view, the Return 
to the top of the page arrow appears in the lower-right corner of the page. 
You can click the arrow to return to the top of the page immediately. Once the toolbar comes into your 
view, the Return to the top of the page arrow disappears. This functionality is available in the 
Preview and Edit report views.

 For the public reports, this functionality is not available.
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Report toolbar options 
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing saved one > 
Reports toolbar.
OR
Report & Analyze tab > Survey Reports tab > Reports page >  create a new report or open an existing 
one > Reports toolbar.
You can use the toolbar options in the report designer to manage your report. 
On the Reports toolbar, the following options are available:
• Language – You can view the report in every language into which the survey is translated.
• Report View – You can switch between the Edit and Preview modes for your report.
• Filter Report Data – You can apply data and date filters to your report. To apply selected filters, 

click OK.
• Schedule Report Email – You can send the email messages to the report viewers at the specified 

date and time.
• Download Report – You can  export your report to a Microsoft Word, Microsoft PowerPoint, or 

Adobe PDF format or create a cluster report.
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Multilanguage reports
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing saved one > 
Reports toolbar > Language menu.
OR
Report & Analyze tab > Project Reports tab > Reports page >  create a new report or open an existing 
saved one > Reports toolbar > Language menu.
You can view the report in every language into which the survey is translated.
To switch between the languages, on the Report toolbar, on the Language menu,  select the needed 
language.
You can view the survey base language in the report designer to see which language is used for your 
report. The Survey Language text box is available on the Formatting tab. You cannot change the 
survey base language from this location. You can use it only for information purposes.

The survey base language in the report designer

You can export the report with the translations, but this functionality does not apply to the widgets. You 
can export widgets only in the base language.
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Schedule report delivery
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > Reports 
toolbar > Schedule Report Email button.
OR
Report & Analyze tab > Project Reports tab > Reports page >  create a new report or open an existing 
one > Reports toolbar > Schedule Report Email button.
You can schedule reports to be delivered regularly to the report viewers so that they can access them. 
On the Schedule Report Delivery page, you can create the email message, add recipients, select the file 
format, and schedule the delivery.

 You can also access the report scheduling functionality by clicking the Schedule Report Email 
option  on the Reports page, on the Actions menu.

If there is an organization hierarchy defined for a workgroup, the report data is scoped to the recipient’s 
organization access. For external emails, the data is scoped according to the task creator’s organization 
access.

 If you close a survey, the scheduled responses export is performed one more time. If you reopen 
the survey, the export of responses is performed till the scheduled date expires.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then  create a new report or open an existing one.
4 On the toolbar, click the Schedule Report Delivery button.

 The Cross-tab Analysis report can be downloaded only in Microsoft Excel format. If you want 
to zip the attachment, click the Zip attachments check box, and the report in the selected 
format is attached to the email message in a ZIP archive.

5 On the Schedule Report Delivery page, in the To text box, enter the email address of the recipient. 

 You can add multiple addresses separating them by commas or semicolons.

6 To select the recipients within the organization hierarchy, click the To button. 
7 In the Survey Report Recipients dialog box, select the check box next to the user or organization, 

click the right arrow button  to add them to the Recipients list, and then click OK.
8 In the From text box, specify the email address from which you want to send your message. 

By default, your email address is selected.
9 In the Subject text box, enter the message subject.
10 In the email text box, enter the message text and customize it by using the editing toolbar.
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11 To preview your message, click the Preview button.
12 To test your message before delivering it to the recipient, click the Send Test Email button. 
13 In the Send Test Email dialog box, in the Email Address text box, enter your email address, and 

then click Send.
14 In the Delivery Schedule section, define the message delivery schedule and the recurrence options. 

The following options are available:
• No Scheduling – You can send your message later. You may want to select it if you have not 

finished adding recipients, writing your message, or have not yet decided when to send the 
message. This option removes scheduling.

• Send Now – You can send your message immediately. There may be a delay of several minutes 
before your email is delivered to participants.

• Send at a specific date and time – You can specify a date and time when you want to deliver 
your email. You can either type the date and time manually into the available text box or select 
the date and time from the pop-up menus. Select a valid start date and time, otherwise the email 
will not be saved. 

 To specify the recurrence options for your message delivery, click the Show Recurrence 
Options link. Use this functionality to send a message multiple times on a daily, weekly, or 
monthly basis. You can also set the end date or select the No End Date option.

15 Click Save.
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Pages tab
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  Reports page > create a new report or open an existing one > Content 
pane > Pages tab.
OR
Report & Analyze tab > Project Reports tab > Reports page >  create a new report or open an existing 
one >  Content pane > Pages tab.
You can change the page order, view, rename, add, and delete pages from the report. 

The Pages side tab

In the Pages pane, you can manage your reports in the following way:
• To open the page, click the page icon.
• To add a page to the report, click the Add Page link.
• To delete the current page from the report, click the Delete Page link.
• To rename a report page, click the page name, edit it, and then press Enter.
• To move a page within the report, drag the page icon into a new position.

• To change the page icons size, click the   icon or    icon.
In the Pages panel, you can switch the page between the Thumbnails and Tree views.
The Thumbnails view is the default view of the report pages. To see the hierarchical structure of the 
page,  on the Pages panel, click the Tree icon.
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The Tree view shows the report element level information on each page in your report. The icon that is 
showing the report element type appears to the left of the question heading. The question heading or 
question text can appear in the Tree view depending on the report element or report theme settings.
To view the report elements on a certain page, click the black arrow next to that page to expand it. You 
can expand or collapse all pages and view their content by clicking the Expand All  or Collapse All  

options (  and  icons correspondingly). By default, all pages are collapsed.

The Tree view

 When you click the page or element heading on the Pages panel, it appears in the report content 
area.
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Formatting tab
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  Reports page > create a new report or open an existing one > Content 
pane > Formatting tab.
OR
Report & Analyze tab > Project Reports tab > Reports page >  create a new report or open an existing 
one > Content pane > Formatting tab.
You can change the look of your report by applying a report theme.
When you create a new report, the report theme currently defined as default theme on the Library tab, 
on the Report Themes tab. You can change the theme of your report without changing the default 
theme of the other reports. The selected theme applies to all elements in your report.
If you modify a report element, its new properties override the theme settings for the existing elements 
of this type in your report. New elements of this type that are added to the report will still use the current 
theme settings.

The Formatting side tab

 For more information, see Report Themes, page 1299.
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Change a report theme
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  Reports page > create a new report or open an existing one > Content 
pane > Formatting tab.
OR
Report & Analyze tab > Project Reports tab > Reports page >  create a new report or open an existing 
one > Content pane > Formatting tab.
You can change the look of your report by applying a report theme.
When you create a new report, the report theme currently defined as default theme on the Library tab, 
on the Report Themes tab. You can change the theme of your report without changing the default 
theme of the other reports. The selected theme applies to all elements in your report.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then create a new report or open an existing one.
4 To open the Report Themes pane, click the Formatting side tab.
5 On the Theme menu, select the report theme . 
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Pagination bar overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  report landing page or Reports page > click the report type you want to 
create.
OR
Report & Analyze tab > Project Reports tab > report landing page or Reports page > click the report 
type you want to create.
You can navigate through the report pages and add new pages to your report, edit your report name, and 
switch between the Edit and Preview report views.

The report pagination bar

On the report pagination bar, the following options are available:
• Page # of # – You can view the number of the current page and the total number of the report 

pages, for example, Page 1 of 3.
• Go to Page – You can navigate to another report page.
• Add Page – You can add a new page to your report. When you click the Add Page link, a new 

page is added immediately after the current page and opens for viewing or editing.
• Delete Page – You can remove the page from your report. When you click the Delete Page link, 

the confirmation dialog box opens that is showing the number of report elements on the selected 
page. To confirm the page removing, click Delete.

• Report View – You can switch between the Edit and Preview report views. When you click the 
Preview link, a new window opens that is showing the report in its current state with the theme 
applied.

• Page navigation – You can navigate to the next or previous report page by clicking the arrows.
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Filters
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  Reports page > create a new report or open an existing one > Reports 
toolbar > Filter Report Data button.
OR
Report & Analyze tab > Project Reports tab >  Reports page > create a new report or open an existing 
one > Reports toolbar > Filter Report Data button.
You can apply the data and date filters to your report to view only the certain results. 
The data filter is based on questions, columns, or profile data. The date filter is based on the date when 
responses are last modified and on the selected time period. 
The filter dialog box includes the Data Filter and Date Filter sections where you can set both filters at 
the same time.

Creating the report filter

Data filtering is not allowed for reports that use multiple sources so the Data Filter section is limited in 
functionality.

 If a filter is applied to a report and you add a new element from another source, the current 
report filter is removed.

When you use a filter like the Last Week, Last Month, Last Quarter, and the rest, the filter  will 
continue to update accordingly to the current date and not the date when it is created.

Data Filter
In the Data Filter section, you can define the filter criteria based on your report data by clicking the Add 
Another Criteria link.
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• Source – Click the My Survey link to apply the Current Survey, Columns, Profiles, or Data 
Channels filtering criteria to your report element.
• Current Survey – Questions from the survey are available as criteria.
• Columns – The Participant Information, Respondent System Information, and 

Respondent Location data from the Response Manager are available as criteria.
• Profile – Basic information taken from the Panelist profile is available as criteria.
• Data Channels – The corresponding file import columns mapped to a survey are available as 

criteria.

 For more information about data channels, see Map a file import to project or profile, page 1174.

• Filter parameter – Click the question or column by which you want to filter your report data in 
the drop-down list.

• Expression – Click the expression in the drop-down list to make a comparison between the Filter 
parameter and Value.

 The options vary depending on the filter type.

The Data Filter section

• Value – Click the response choice for comparison in the drop-down list. The available options vary 
depending on the question type and column. For example, the Multiple Choice: Choose One 
and Multiple Choice: Choose Many questions include all available options, and for the Fill in 
the Blank questions you need to specify the response choice.

• Save – Click the link or anywhere else in the dialog box to save your criterion.

• Remove – Click the   icon to delete the filter.

• Up/Down – Click the Up or Down arrows to move the selected filter up or down one level in the 
list. Filters are applied in a sequential manner, and their position in the list is important.

You can have a combination of the Current Survey, Columns, and Profiles filtering criteria. If you add 
multiple criteria, you can combine them by using the following Match options:
• All Criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The drop-down lists with parentheses and the And/Or operators appear next to 

each criterion. The And operator defines that two or more filters are true for the responses 
included in the report. The Or operator defines that one of the filters linked together is true.
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Date Filter
In the Date Filter section, you can set the filter based on the date when responses are last modified and 
based on the selected time period.
• Select Date Field – Click an option in the drop-down list to filter the responses based on their 

modification date. The following options are available:
• None – Applies no date filters and is selected by default.
• Started Date – Applies the filter based on the date when the survey was started.
• Modified Date – Applies the filter based on the date when the survey was last modified.
• Completed Date – Applies the filter based on the date when the survey was submitted.

• Time Period – Click an option in the drop-down list to filter the responses based on a certain time 
period. The following options are available:
• None – Applies no time period filters and is selected by default.
• Today – Shows the responses that are submitted today.
• Current Month – Shows the responses for the current month, no matter the current date.
• Current Quarter – Shows the responses for the current three months, no matter the current 

date.
• Current Year – Shows the responses for the current calendar year, no matter the current date.
• Year to Date – Shows the responses for the period starting January 1st of the current year up 

until the current date.
• Last Week – Shows the responses for the past week.
• Last Month – Shows the responses for the past month.
• Last Quarter – Shows the responses for the past three months.
• Last Year – Shows the responses for the past year.

To set the default values for the Date Filters, click the Clear All Date Filters link.
For the Fill in the Blank survey questions with date fields, you can apply date filters in the Data Filter 
section. In such case, the date filter options appear in the Data Filter section.

The Date Filter section

Other
In the Other section, the following options are available:
• Only show completed responses – Include only the complete responses while creating a 

report so that the report covers all the valid responses.
• Logged in User Filter – Include data for the currently logged in user only. This option is available 

only for the surveys with the Organization External ID or Employee External ID questions. 
You can add a report element with the applied logged in user filter to dashboard and view the 
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data filtered accordingly. If you share the filtered report or report element with other users, they 
will view only the data available for them according to the logged in user filter.

 The Embed Report Element option is not available for the report elements that are filtered by 
logged in user.

• Include data from deleted panelists – Include data from deleted panelists in the report 
calculations. This option is available only for the profile reports.

Organization
In the Organization section, you can set the filter based on the organization of which you are a member. 
This section shows up in the Filter Report Data dialog box only for the reports based on the surveys 
that contain the External ID System Questions option.
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Filter single report element 
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 

>  Design tab > Analyze tab >  Reports page > move the pointer over a report element >  icon.
OR
Report & Analyze tab > Project Reports tab > select a survey that has received responses > Analyze 

tab > Reports page > move the pointer over a report element >  icon.
You can view the certain results for a single report element. The data filter is based on questions, columns, 
or profile data. You can access the report element filter by clicking the Filter icon in the right pane of the 
report designer.

The Filter icon in the report designer

In the Filter Element Data dialog box, you can define the filter criteria for the single report element.
The following options are available:
• Report Filter – This option applies the report data filter to the single report element.
• No Filter – This option does not apply any filters to the report element.
• Custom Filter – This option applies the custom filter to the single report element.

You can define the custom filter by clicking the Add Another Criteria link.
If your survey contains the Organization External ID or Employee External ID questions, you can 
select the Logged In User Filter option to include the data only for the currently logged in user. You can 
add a report element with the applied logged in user filter to dashboard and view the data that is filtered 
accordingly. If you share the filtered report element with other users, they will view only the data 
available for them according to the logged in user filter.

 The Embed Report Element option is not available for report elements that are filtered by 
logged  in user.

In the Data Filter section, you can define the filtering criteria based on your report data by clicking the 
Add Another Criteria link.

 For more information, see Filters, page 723.
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Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then  create a new report or open an existing one.
4 Hover over the report element, and then click the Filter icon.
5 In the Data Filter dialog box, select the filter that you want to apply to your report element and 

define the filter criteria, if required.
6 Click OK.
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Displayed Values panel
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab >  Reports page > Displayed Values panel.
OR
Report & Analyze tab > Project Reports tab > select a survey that has received responses > Analyze 
tab > Reports page > Displayed Values panel.
You can set the additional properties within your report to include the Rows Per Page, ID column, and 
Display Newest Responses First options.
• Rows Per Page – Enter in the text box a number that designates the number of rows that you 

want to display per page.  To confirm the action, click Apply All.
• ID Column – Select the ID Column check box, to display the ID column in your report.   The ID 

column represents the unique identifier for a particular respondent.  When you select this check 
box, and then click Apply All, this column is displayed within your report.  You can click the red ID 
number within the ID column and view the response record for that particular participant.

• Display Newest Responses First – Select the Display Newest Responses First check box, to 
display the newest responses from your survey in your report. To verify the action and  confirm 
your request, click Apply All.
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Report elements status messages
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
that contains data set information.
You can view the data set updates information for the report elements that are based on the data sets.
Data is unavailable in a report element based on data set information in the following cases:
• Filters that filter out all the data are applied.
• The data is not processed yet.
When you publish or republish the data set, it takes some time for the report elements to be updated. In 
such case, the No Data Available message appears for the report element body. Additionally, the 
following message appears at the top of the report element:
The requested data is being recompiled from scratch. This may take some time. Thank you 
for your patience.
If the data set is in the Processing status, it takes some time for the report elements based on the data 
set to be updated. In such case, the message is the following:
Processing, please check back shortly.
If the data points that are used in your report elements have new answers, the report element shows the 
existing answers in the report element and the message  is the following:
Additional responses have been received but are pending processing. Chart will be updated 
shortly.
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Use Element Hover Controls functionality
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > report 
designer.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > report designer.
You can  add your report elements to the dashboard, filter, copy, delete, move up, or move down them by 
using the Element Hover Controls feature.

Copy, paste, and delete report element

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > Reports page, and then  create a new report or open an existing one.
4 Hover your pointer over a report element.

5 To copy a report element, click the  icon. 
6 To insert a copy of the report element, click the Paste button .

7 To delete the report element, hover your pointer over a report element, and then click the   icon.

Move report element up and down

Procedure 
1 Hover your pointer over a report element.

2 To move a report element up,  click the  icon.

3 To move a report element down, click the   icon.

 If a Move Up or Move Down icon appears dimmed, you cannot move the element up or down 
because the element you have selected is at the top or bottom of the report section.
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Advanced chart properties
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > Add a 
Report Element panel > add a report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add a Report Element panel > add a report element.
You can use the advanced chart properties to customize your chart in a more detailed way by clicking the 

 icon.
The following options are available:
• Chart Values
• Series Text
• X-Axis Series
• Y-Axis Series
• Axis Labels

Chart Values
You can enter the minimum and maximum values for your chart into the corresponding text boxes by 
clicking the Chart Values tab. If you do not provide any values, the default values are applied to the 
chart.
To cancel changes, click Reset. 

Series Text
You can edit the series labels for your data to fit the text within the chart by clicking  the Series Text tab. 
On the Series Text tab, the following columns are available :
• Original Label – The original labels of the values that are displayed by the report element. The 

set of values depends on the selected element type.
• Custom Label – Edit the series labels by entering your own text into the text boxes to the right of 

the corresponding original label. Custom labels are truncated to 30 characters by design. If you do 
not provide any values, the default values are applied to the chart.

• Show Value – Select the check box next to the chart value which you want to display in your 
report element. By default, this option is active.

To cancel changes, click Reset.
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X-Axis Series
You can edit the series labels for your data to fit the text within the chart by clicking the X-Axis Series 
tab.
On the X-Axis Series tab,  the following columns are available:
• Original Label – The original labels of the values displayed by report element. The set of values 

depends on the selected element type.
• Custom Label – Edit the series labels by entering your own text into the text boxes to the right of 

the corresponding original label. Custom labels are truncated to 30 characters by design. If you do 
not provide any values, the default values are applied to the chart.

• Show Value – Select the check box next to the chart value which you want to display in your 
report element. By default, this option is active.

To cancel changes, click Reset.

 This tab is available only for the Cross-tab Chart report element.

Y-Axis Series
You can edit the series labels for your data to fit the text within the chart by clicking the Y-Axis Series 
tab. 
On the Y-Axis Series tab,  the following columns are available:
• Original Label – The original labels of the values displayed by report element. The set of values 

depends on the selected element type.
• Custom Label – Edit the series labels by entering your own text into the text boxes to the right of 

the corresponding original label. Custom labels are truncated to 30 characters by design. If you do 
not provide any values, the default values are applied to the chart.

• Show Value – Select the check box next to the chart value which you want to display in your 
report element. By default, this option is active.

To cancel changes, click Reset.

 This tab is available only for the Cross-tab Chart report element.

Axis Labels
You can define the axis labels for your chart by clicking  the Axis Labels tab. You can enter the X- and Y-
axis labels into the corresponding text boxes.
To cancel changes, click Reset.

 To return to the standard view, click the Chart icon.
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Advanced properties for report elements
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one > Add a 
Report Element panel.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add a Report Element panel.
You can customize your report element in a more detailed way by using the advanced properties. 
The  following options are available:
• Row Labels
• Column Labels
This option is available for the Summary Table, Summary of Means, Cross-tab, Top Box, Top Box 
Cross-tab, Trend Table, and Frequency Table report elements.

 To return to the standard view, click the  icon.
 

Row Labels
Use the Row Labels tab to edit or hide the row labels for your table. 
On the Row Labels tab, the following columns are available:
• Original Label – The original labels of the values displayed by report element. The set of values 

depends on the selected element type.
• Custom Label – Edit the row labels by entering your own text into the text boxes to the right of 

the corresponding original label. Custom labels are truncated to 30 characters by design. If you do 
not provide any values, the default values are applied to the table.

• Show Row – Select the check box next to the table row which you want to display in your report 
element. By default, this option is active.

To set the row labels to the original survey values, click Reset.

Column Labels
Use the Column Labels tab to edit or hide the column labels for your table. 
On the Column Labels tab, the following columns are available:
• Original Label – The original labels of the values displayed by report element. The set of values 

depends on the selected element type.
• Custom Label – Edit the column labels by entering your own text into the text boxes to the right 

of the corresponding original label. Custom labels are truncated to 30 characters by design. If you 
do not provide any values, the default values are applied to the table.
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• Show Column – Select the check box next to the table column which you want to display in your 
report element. By default, this option is active.

To set the column labels to the original survey values, click Reset.
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Chart labels improvements
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one >  add the 
Trend Chart or Frequency Chart report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > add the Trend Chart or Frequency Chart report element.
The chart labels in the Trend Chart and Frequency Chart report elements have the following 
improvements:
• The limit of characters for the chart labels is increased from 15 characters to the largest value 

available for the chart.
• If the label contains more characters than you set in the Chart Appearance properties menu, it is 

abbreviated and followed by an ellipsis. The label text is shown in a tooltip when you hover over 
the chart.

• If the label contains a large amount of text, it wraps to show appropriately on the chart.

 To add a line break to the series text, access the chart advanced properties, and then insert "/r" in 
the text.
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Displaying chart columns in different color
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab > Analyze tab > Reports page > create a new report or open an existing one >  add the 
Trend Chart or Frequency Chart report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > add the Trend Chart or Frequency Chart report element.
You can select the Use different color for each bar (column) check box for the Frequency Chart and 
Trend Chart report elements to display each bar or column in the chart in different color. 
This option is available only for the Column and Bar chart types that render all bars or columns in the 
same color. 
When the Use different color for each bar (column) option is activated, the color series that are used 
by the report theme is applied to the report element. You can view and change the selected color series 
by using the Series Palette option.
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The Use Different Color for Each Column check box
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Net Score overview
Net score is used to run the customer satisfaction surveys. Basically, every company's customers can be 
divided into three groups: Promoters, Passives, and Detractors. By asking a question–How likely is it that 
you would recommend us to a friend or colleague?–you can track these groups and get a clear measure 
of your company's performance through its customers' eyes. Customers respond on a 0-to-10 point 
rating scale and are categorized as follows:
• Promoters (score 9-10) are loyal customers who recommend your company to other people.
• Passives (score 7-8) are satisfied but unenthusiastic customers who can buy the goods or 

services from your competitors.
• Detractors (score 0-6) are unhappy customers who can damage your brand.

Related topics 
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Net Score in Top Box
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports side tab > create a new report or open an existing one with the Top Box report 
element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one with the Top Box report element.
You can add the net score calculation to the Top Box report element. With the net score calculation, you 
can see the difference between the top and bottom items of a rating scale. To apply the net score to the 
Top Box report element, select the Net Score check box in the Displayed Values section.
You can use any scale-based question as a source for the net score calculation, for example: "How polite 
were our employees?". The responses are divided into three groups: Top (score 9-10), Neutral (score 7-
8), and Bottom (score 0-6). The percentage of the Bottom group is then subtracted from the percentage 
of the Top group to get a net score.

The Net Score calculation in the Top Box report element

You can set the range of the Top and Bottom groups in the Data properties menu.
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The Data properties menu

• Range of Top Group – Use this text box to define the number of choice items to be combined 
when generating the top group calculation. The default is set to the top 2. For example, on a ten-
point scale all responses of 9 and 10 are combined.

• Range of Bottom Group – Use this text box to define the number of choice items to be 
combined when generating the bottom group calculation. The default is set to the bottom 6. For 
example, on a ten-point scale all responses of 1, 2, 3, 4, 5, and 6 are combined.

 The range of Top and Bottom groups cannot be negative or overlap.
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Net Score in Top Box Cross-tab
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports side tab > create a new report or open an existing one with the Top Box Cross-
tab report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one with the Top Box Cross-tab report element.
You can add the net score calculation to the Top Box Cross-tab report element. With the net score 
calculation, you can see the difference between the top and bottom items of a rating scale. To apply the 
net score to the Top Box Cross-tab report element, select the Net Score check box in the Displayed 
Values section.

 For more information on the net score, see Net Score overview, page 740.

You can use any scale-based question as a source for the net score calculation, for example: "How likely is 
it that you would recommend us to a friend or colleague?". The responses are divided into three groups:
• Top (score 9-10)
• Neutral (score 7-8)
• Bottom (score 0-6)
Net Score = Top Group – Bottom Group
The net score is calculated by subtracting the percentage of the bottom group from the percentage of the 
top group.
The default values of the top and bottom groups are set to 18% and 62% of the general number of 
response choices respectively. You can set the range of the top and bottom groups in the Data section. 
The range of top and bottom groups cannot be negative or overlap.
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The Data properties menu

• Range of Top Group – In this text box, you can specify the number of choices to be used for 
defining the top group. For example, if the top group range is set to 2, all responses of 9 and 10 
on a 0-10 scale are included in the top group.

• Range of Bottom Group – In this text box, you can specify the number of choices to be used for 
defining the bottom group. For example, if the bottom group range is set to 7, all responses of 0, 
1, 2, 3, 4, 5, 6, and 7 on a 0-10 scale are included in the bottom group. 
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Net Score in Trend Table
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports side tab > create a new report or open an existing one with the Trend Table 
report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one with the Trend Table report element.
You can add the net score calculation to the Trend Table report element. With the net score calculation in 
the trend table, you can see the customers' satisfaction over the specified time periods. To apply the net 
score to the Trend Table report element, select the Net Score check box in the Displayed Values 
section.

The Displayed Values properties menu

You can use any scale-based question as a source for the net score calculation, for example: "Do you plan 
to continue using this service?". The responses are divided into three groups:
• Top (score 9-10)
• Neutral (score 7-8)
• Bottom (score 0-6)
The percentage of the Bottom group is then subtracted from the percentage of the Top group to get a 
Net Score.
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The Net Score calculation in the Trend Table report element

The default values of the Top and Bottom groups are set to 18% and 62% of the general number of 
response choices respectively. You can set the range of the Top and Bottom groups in the Data 
properties menu.

The Data properties menu

• Range of Top Group – Define the number of choice items to be combined when generating the 
top group calculation. For example, if the top is set to 2 on a ten-point scale, all responses of 9 
and 10 are combined.
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• Range of Bottom Group – Define the number of choice items to be combined when generating 
the bottom group calculation. For example, if the bottom is set to 6 on a ten-point scale, all 
responses of 1, 2, 3, 4, 5, and 6 are combined.

 The range of Top and Bottom groups cannot be negative or overlap.
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Net Score in Trend Chart
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports side tab > create a new report or open an existing one with the Trend Chart 
report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one with the Trend Chart report element.
You can view the net score in the Trend Chart report element and track the customer satisfaction over 
the specified time periods. To apply the net score to Trend Chart, select the Net Score check box in the 
Displayed Values section.
You can use any scale-based question as a source for the net score calculation, for example: "How helpful 
were our employees?". The responses are divided into three groups:
• Top (score 9-10)
• Neutral (score 7-8)
• Bottom (score 0-6)
The net score is calculated by subtracting the percentage of the bottom group from the percentage of the 
top group.
Net Score = Top Group – Bottom Group

The net score in Trend Chart

 Net score is available for all chart types, including bar, column, and time series. For more 
information on the net score, see Net Score overview, page 740.

The default values of the top and bottom groups are set to 18% and 62% of the general number of 
response choices respectively. You can set the range of the top and bottom groups in the Data section. 
The range of top and bottom groups cannot be negative or overlap.



Net Score Net Score in Trend Chart

EFM User Guide 749

Confidential and Proprietary Information of Verint Systems Inc.

The Data properties menu

• Range of Top Group – In this text box, you can specify the number of choices to be used for 
defining the top group. For example, if the top group range is set to 2, all responses of 9 and 10 
on a 0-10 scale are included in the top group.

• Range of Bottom Group – In this text box, you can specify the number of choices to be used for 
defining the bottom group. For example, if the bottom group range is set to 7, all responses of 0, 
1, 2, 3, 4, 5, 6, and 7 on a 0-10 scale are included in the bottom group.
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Net Score in Statistics Map
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports side tab > create a new report or open an existing one with the Statistics Map 
report element.
OR
Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one with the Statistics Map report element.
With the Net Score functionality, you can determine the customer loyalty and satisfaction with your 
products and services. If you want to view the statistics map of your customer attitudes, apply the net 
score to the Statistics Map report element.
You can use any scale-based question as a source for the net score calculation. The responses are divided 
into three groups:
• Top (score 9-10)
• Neutral (score 7-8)
• Bottom (score 0-6)
The net score is calculated by subtracting the percentage of the bottom group from the percentage of the 
top group.
The default values of the top and bottom groups are set to 18% and 62% of the total number of 
response choices respectively.
You can set the range of the top and bottom groups in the Data section:
• Range of Top Group – Define the number of choice items to be combined when generating the 

top group calculation. The default value is set to 18%. The top map calculation can be set to 1, 2, 
or 3 choices. For example, if the top is set to 2 on a ten-point scale, all responses of 9 and 10 are 
combined.

• Range of Bottom Group – Define the number of choice items to be combined when generating 
the bottom group calculation. The default value  is set to 62%. The bottom map calculation can be 
set to 1, 2, or 3 choices. For example, if the bottom is set to 6 on a ten-point scale, all responses of 
1, 2, 3, 4, 5, and 6 are combined.

 The range of Top and Bottom groups cannot be negative or overlap.



C h a p t e r  1 3  

Cross-tab Analysis

Topics 

Cross-tab Analysis report 752

Significance testing 756

Apply weighting to the Cross-tab Analysis report 758

Cross Tab Analysis Base Total Calculation 761



Cross-tab Analysis Cross-tab Analysis report

EFM User Guide 752

Confidential and Proprietary Information of Verint Systems Inc.

Cross-tab Analysis report
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab >  Analyze tab > Reports page > New  menu > click Cross-tab Analysis Report.
OR
Report & Analyze tab > Project Reports tab > Reports page > New  menu > click Cross-tab Analysis 
Report.
You can create a Cross-tab Analysis report showing a cross-tabulation of multiple variables at the same 
time. 
When you create a new Cross-tab Analysis report, you can use the following tabs:
• Rows and Columns 
• Properties 

Rows and Columns 
On the Rows and Columns tab, you can select the questions for columns and rows of your Cross-tab 
Analysis report. See image and description below.
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The Rows and Columns tab

• Questions to appear as rows – Define the row question for the cross-tabulation.
For the rows, you can use the following question types:
• Multiple Choice: Choose One
• Multiple Choice: Choose One with Image
• Multiple Choice: Choose Many
• Multiple Choice: Choose Many with Image
• Matrix with a "Multiple Choice: Choose One" question as a side
• Matrix with a "Multiple Choice: Choose Many" question as a side
• Rank Order
• Drag & Drop Rank Order
• Scrolling Matrix
• Scale Slider
• Fill in the Blank with the "Numbers" input type

• Include all questions – Include all survey questions as rows for the cross-tabulation (selected by 
default).

• Banner Points to appear as columns – Define the column question for the cross-tabulation. 
For the columns, you can use the following question types:
• Multiple Choice: Choose One
• Multiple Choice: Choose One with Image
• Multiple Choice: Choose Many
• Multiple Choice: Choose Many with Image
• Matrix with a "Multiple Choice: Choose One" question as a side
• Matrix with a "Multiple Choice: Choose Many" question as a side
• Rank Order
• Drag & Drop Rank Order
• Scrolling Matrix.
• Scale Slider

• Include all banner points – Include all survey questions as columns for the cross-tabulation.

Properties
The Properties tab contains the Labels and Data sections, both providing a number of customization 
options.
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The Properties tab
 

• Question Labels – Select  the question label for your report. The available options are Question 
Heading and Report Heading.

• Caption – Type your text in this edit box to show a brief description below your report.
• Base Total (label) – Edit the label for total amount of response choices selected by respondents. 

Base is a default label. If you do not provide any value, the default value is applied to the report.
• Significance Testing – Turn on or turn off the significance testing on the Choose One variables 

by selecting the On or Off option correspondingly. Off is a default option.
• Confidence Interval – Select the confidence interval for significance testing. The available 

options are 90%, 95% and 99%.

 The Confidence Interval option is only available when you enable the significance testing for 
your Cross-tab Analysis report.

• Displayed Values – Select the response data appearance in your report. The following options 
are available:
• Numbers and Percentages – This option shows both percentage and number of the response 

choices selected by respondents. The response choices number appears above the percentage.
• Percentages only – This option shows only percentage of the response choices selected by 

respondents.
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• Numbers only – This option shows only number of the response choices selected by 
respondents.

• Decimal Places – Define the decimal places for the values in the report. The available options are 
0, 1, 2, and 3.

To apply changes that you made to the report properties, click OK.

Viewing the Cross-tab Analysis Report
If your Cross-tab Analysis report contains more than 52 columns, it shows on the multiple tabs.
The response data of one question are shown on the same tab. For example, Question 1 has 20 response 
choices, Question 2 has 30 response choices, and Question 3 has 8 response choices, then Tab 1 contains 
all responses for Questions 1 and 2 (which add up to 50), and all 8 responses for Question 3 appear on 
the Tab 2.

 The public report generation does not currently support the Cross-tab Analysis report types. The 
Cross-tab Analysis report types are now disabled for the public reports.

Exporting the Cross-tab Analysis Report
You can export the Cross-tab Analysis report to the Microsoft Excel file to view the results outside the 
EFM application. In the Microsoft Excel file, each tab is placed on a separate worksheet.
You can export the report by using the Download Report menu.

 For more information about how to download the reports, see Downloading reports, page 1012.
 

Create a Cross-tab Analysis Report

Procedure 
1 On the  Reports page, on the New, click Cross-tab Analysis. 
2 In the Name Your Report dialog box, in the Report Name text box, enter the name of a report.
3 Click OK. 
4 In the Cross-tab Wizard dialog box, on the Rows and Columns and Properties tabs, define report 

properties.
5 Click OK.
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Significance testing
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
>  Design tab >  Analyze tab > Reports page > New  menu > click Cross-tab Analysis Report.
OR
Report & Analyze tab > Project Reports tab > Reports page > New  menu > click Cross-tab Analysis 
Report.
You can perform the significance testing on the Choose One (including the Matrix sides) variables by using 
the Cross-tab Analysis report. You can use the significance testing to compare whether the proportion of 
respondents in one column is significantly different from the proportion in the other column within the 
single variable. To manage the significance testing options, access the Properties tab in your Cross-tab 
Analysis report.
• Significance Testing – Turn on or turn off the significance testing on the Choose One variables 

by selecting the On or Off option correspondingly. Off is a default option.
• Confidence Interval – Select the confidence interval for significance testing. The available 

options are 90%, 95% and 99%.  95% is a default option.

 For the steps on how to create the Cross-tab Analysis report, see Cross-tab Analysis report, 
page 752.

When you perform the significance testing, the reference letters show as the column ID in the column 
headers below the column titles. For the columns 1-26, lowercase English letters are shown (a, b, c, …, y, z), 
and, for the columns 27-52, uppercase English letters are shown (A, B, C, …, Y, Z). If the difference 
between the columns is significant, the ID of one column shows under the response data of the other 
column. See image and example below.
If the number of degrees of freedom (responses) is less than 30, no significance testing is calculated and 
published, and a footnote on the table states Base too small for significance testing between 
columns [a-b, a-c, b-c]. If the number of degrees of freedom is less than 100, the significance testing is 
calculated and published, and a footnote on the table states Caution  – small bases for columns [c-d, 
c-e, c-f]. Depending on the selected confidence interval, a footnote showing the chosen risk level appears 
on the table. For example, if you select the 95% confidence interval, a footnote states Proportions: 
Columns Tested (5% risk) [a-c, b-c, a-c].
The significance testing is not saved if you close the report. When you open the saved report later, the 
previous test results are cleared. You can perform a new test if you want.
You can also export the significance testing results to the Microsoft Excel file format as a part of the 
Cross-tab Analysis report to view the test data outside the product.

Significance testing calculation
The application uses the same significance test calculations as described in Quantum's Special T statistics 
(Quantum volume 3, Section 7) for the T-test on column proportions. This example compares the values 
of the proportions in two columns of a table. For each of the two columns (k=1, 2), the sample 
proportions are defined as:
 

P1 = Cell frequency 1 / Base 1
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P2 = Cell frequency 2 / Base 2
Population variance is calculated as:
P = (Cell frequency 1 + Cell frequency 2) / (Base 1 + Base 2)
The variable T is calculated as:
T = (P1  – P2) / Sqrt (p x (1-p) x (1 / Base 1 + 1 / Base 2) / (1  – 1 / (Base 1 + Base 2)))

Procedure 
1 On the Reports page, on the New menu, click Cross-tab Analysis Report.  
2 In the Name Your Report dialog box,  in the Report Name text box, enter the name of a report.
3 Click OK. 
4 Define your Cross-tab Analysis report properties.
5 On the Properties tab, on the Significance Testing menu, select the On option.
6 On the Confidence Interval menu, select the confidence interval for significance testing.
7 Click OK. 

Enable significance testing for a workgroup
1 Go to the Configuration tab > General tab.
2 In the Workgroup Setup section, select the Enable significance testing in Cross-tab Analysis 

check box.
3 Click Save Setup.
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Apply weighting to the Cross-tab Analysis report
Navigation

Design & Collect tab > Surveys tab > My Surveys page > Design tab > Analyze tab > Weighting side 
tab > Weighting page > add weighting criteria > Reports page > New menu > Cross-tab Analysis 
Report option > Rows and Columns tab > Properties tab > Display Weighted Values check box.
You can apply previously defined weighting scheme to the Cross-tab Analysis report. When you name a 
report, you can apply weighting to it by selecting the "Apply a weighting scheme to the report" check box 
in the Name Your Report dialog box.

 For the steps on how to create the Cross-tab Analysis report, see Cross-tab Analysis report, 
page 752.

When weighting is applied to the Cross-tab Analysis report, the corresponding notification is shown in 
the upper-left corner of the window.
You can also turn on or turn off weighting for the Cross-tab Analysis report by selecting the Display 
Weighted Values check box on the Properties tab. If weighting is activated, only weighted values are 
displayed in the Cross-tab Analysis report.

 The Display Weighted Values check box is only available if you have a weighting scheme 
defined. For more details about how to define a weighting scheme, see Weighting overview, 
page 1016.

If you export the Cross-tab Analysis report that contains weighting scheme to the Microsoft Excel file 
format, the weighting scheme also shows in the exported report.

The Cross-tab Analysis Calculation Example

Gender Weight Q1 Q2

Male 0.750 2 4

Male 0.750 3 5

Male 0.750 4 3

Male 0.750 5 3

Male 0.750 4 1

Female 1.100 1 3

Female 1.100 3 4

Female 1.100 4 3
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Gender Weight Q1 Q2

Female 1.100 2 5

Female 1.100 1 2

Unweighted

  Q2 Q2 Q2 Q2 Q2

Q1 1 2 3 4 5

1 0 1 1 0 0

2 0 0 0 1 0

3 0 0 0 1 1

4 1 0 2 0 0

5 0 0 1 0 1

Weighted

  Q2 Q2 Q2 Q2 Q2

Q1 1 2 3 4 5

1 0 1.1 1.1 0 0

2 0 0 0 0.75 0

3 0 0 0 1.1 0.75

4 0.75 0 1.85 0 0

5 0 0 0.75 0 1.1

Procedure 
1 On the Weighting page, define a weighting scheme.
2 Navigate to the Reports page.
3 On the Reports page, in the New menu, click the Cross-tab Analysis Report. The opens.
4 In the Name Your Report dialog box, enter the name for your report.
5 Click OK.
6 On the Rows and Columns tab, select the questions and banner points for your report.
7 Click the Properties tab.
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8 Select the Display Weighted Values check box.
9 Click Save.
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Cross Tab Analysis Base Total Calculation
Overall bases represent the number of respondents who answered the question. Answering the question 
is counted by selecting at least one choice or entering a value for that question.
The row bases (this is the green column in the grid) represent the number of respondents who selected 
that choice or entered that value.
The column bases (this is the green row associated with each row question) represent the number of 
respondents who both selected the column choice and answered the row question.
 

Question Type Base Calculation

• Multiple Choice: Choose One
• Matrix with a "Multiple Choice: Choose One" side
• Matrix with a "Fill in the Blank" question with a 

"Real Number" input type as a side
• Matrix with a "Fill in the Blank" question with a 

"Whole Number" input type as a side
• Scrolling Matrix
• Scale Slider
• Fill in the Blank with a "Whole Number" input 

type
• Fill in the Blank with a "Real Number" input type
• Rank Order
• Drag and Drop Rank Order

The base equals the total number of 
respondents who answered the 
question.

• Multiple Choice: Choose Many
• Matrix with a "Multiple Choice: Choose Many" 

side

The base equals the total number of 
respondents who selected any choice 
in the question.

• Essay
• Fill in the Blank with a "Text" input type
• Fill in the Blank with a "Dates" input type
• Fill in the Blank with a "IDs & Phone Numbers" 

input type
• Fill in the Blank with a "Postal Codes" input type

These question types are not 
supported in the Cross-tab Analysis 
report.

Prior to the October 29th 2011 update, bases for Multiple Choice: Choose Many and Matrix with a 
Multiple Choice: Choose Many side were calculated by tallying the total number of choices selected. The 
calculations for all other bases remain the same.
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Public reports
Navigation

Design & Collect tab  > Surveys tab > create a new survey or open an existing one > Analyze tab > 
Reports page > Share menu.

You can generate the report public link, paste the link into the email, and send the email to the user, 
whom you want to allow viewing a report. Thus users who do not have access to the product can view a 
report by clicking a report public link.
When the report public link is generated, Public Link appears in the Reports grid.
The theme of the original report is automatically applied to the public report. If you change the report 
theme for the original report, the public report updates immediately. Switch to the Web page showing the 
public report and refresh the page to see the updates.

 Elements with logged-in user filtering cannot be shared publicly. They will be excluded from the 
public report.

In addition, you can secure the public report by password. If you set password for the public report, the 
lock icon shows next to Public Link on the Reports page.
If you delete the public shared report, the public link will no longer open this report and the The public 
report you requested is not available at this time message will appear.
 



Public Reports Manage public reports

EFM User Guide 764

Confidential and Proprietary Information of Verint Systems Inc.

Manage public reports
Navigation

Design & Collect tab  > Surveys tab > create a new survey or open an existing one > Analyze tab > 
Reports page > Share menu > Make Report Public option > Share Public Report dialog box.

You can allow users who do not have access to the product view a report by generating a report public 
link. 

 The public report generation does not currently support the Cross-tab Analysis report types. The 
Cross-tab Analysis report types are now disabled for the public reports.

Generate a report public link

Procedure 
1 On the Reports page, select a check box next to the report that you want to share.
2 On the Share menu, click Make Report Public.
3 In the Share Public Report dialog box, select the Allow the report to be accessed publicly check 

box.

The Share Public Report dialog box

4 To set the password for accessing your public report, select the Require a password for the public 
report check box, and then type the password in the box.

5 To generate the report public link, click Apply Changes .
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Generated report public link

6 Click Close.

 To stop report public sharing,  clear the Allow the report to be accessed publicly check box. 
The report is no longer available for viewing by a report public link.

View public report protected by password

Procedure 
1 Open an email that contains the report public link and password.
2 Click the generated report public link.
3 On the report access page, type the password for a public report in the Password box.
4 Click Access Report.

Enable public report for workgroup

Procedure 
1 Go to  Configuration tab > General tab.
2 Select the Enable public report check box.
3 Click Save Setup.
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 For the steps on how to enable public report based on the user role, see Public report–Role-based 
access, page 767.
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Public report–Role-based access
Navigation

Administration tab  > Roles tab.

Group administrator can control the workgroup members' access to public reports creation based on the 
user role set of permissions. You can enable public reports for a user by creating a new role or editing the 
existing ones.

 For details on public reports, see the Public reports, page 763.

Activate public report for a user role

Procedure 
1 Go to the Administration tab > Roles tab.
2 Click the name of the role that you want to edit. 
3 On the Edit Role page, in the Experience section, select the Public Report check box.
4 Click Save.

 For details on the user roles, see Roles, page 1378.
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Adding public report link to widget
Navigation

Design & Collect tab  > Surveys tab > create a new survey or open an existing one > Analyze tab > 
Reports tab > create a new report or open an existing one > Share menu > Make Report Public option > 
open the report designer > add a report element > expand the Embed Report Element section > select 
the Add link to public report check box.

You can include a link to the public report in both the generated code snippet and element URL to allow 
users access the full public report while viewing the report element. 

Procedure 
1 Open a publicly shared report in the report designer.
2 Add a report element that you want to embed into a custom page. 
3 Click the Embed Report Element section to expand it.
4 Click the Generate Code button. 

The code snippet and URL for the report element are generated.
5 Select the Add link to public report check box. 

Both the code snippet and URL are updated to include the link to the full public report.

 The Add link to public report check box appears after you share your report publicly.

6 Click within the text box with the URL to select the whole link, and then copy it. 
7 Place the copied URL on the custom page. 

The report element with the link to the full public report appears.

 For the steps on how to use the code snippet, see Embed Report Element, page 969.

When you select the Add link to public report check box, both the code snippet and element URL are 
regenerated immediately. However, the previously created widgets are not updated accordingly. You 
need to replace the code snippet and URL for these elements to create new widgets. If you stop the 
report public sharing, the link to the public report is no longer available.

 For details on the public reports functionality, see Public reports, page 763.

The link appears at the bottom of the report element in your widget. Click the link to access the full public 
report. 
For the password protected public reports, the report access page appears after you click the public 
report link.



Public Reports Adding public report link to widget

EFM User Guide 769

Confidential and Proprietary Information of Verint Systems Inc.

The report access page

To access the public report, enter the password provided by email.
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Frequency Table
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Frequency Table report element.
You can manage and customize your Frequency Table report element by using the following sections in 
the left pane:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
In the Report Element section of the Frequency Table report element, you can show or hide the 
question text, description, and caption.
The Frequency Table properties include the following sections:
• Type – The selected report element type.

Question – The source question.
You can select all question types except Essay and Image Upload. To change a question, use the 
Question menu.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Report Values - Select the check box to display the report values on your report element.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type your text in the text box and 

customize its font size and style. You can select the color of caption foreground and background 
in the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.
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Appearance
In the Appearance section of the Frequency Table element, you can change the look and feel of the 
element.
The Appearance properties include the Row and Header sections, both providing a number of 
customizing properties:
• Color – Select the background color for the data or header rows.
• Text Color – Select the text color for data or header rows. It is recommended that contrasting 

color selections be made when changing the color and text color settings.
• Font Name – Select in a list of web-compatible fonts for data and header text.
• Font Size – Select in a list of web-compatible font sizes for data and header text.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes that you made to all Frequency Table elements in your report, click Apply All.

Data
The Data section contains the following properties:
• Sort Order – Shows the order the values appear in the report element. The available options are 

Original (Survey order), Alphabetical Order, and By Count. Original (Survey order) is a 
default value. Use the Sort Order menu to change the order. The frequency table updates to 
show data in the newly selected order.

 The Original (Survey Order) option is unavailable if the Frequency Table report element uses 
a file import column.

To view the values in reverse order and group the individual responses rather than treating them as a 
separate item on the table, select the Invert Sort Order and Group unique responses into 
'Other Responses' check boxes correspondingly.

• Number Formatting – Shows a set of text boxes that you can use to define the decimal places 
for the values that the frequency table shows.

 The set of properties depends on the question type.

To apply changes that you made to all Data elements in your report, click Apply All.

Displayed Values
• Calculation used for graph – Select the calculation type from the menu. 

The following options are:
• Show Percent of Valid Responses (default) – Count of people who have been shown the 

question and made a selection. 
• Show Percent of Total Responses – Count of everyone who has started the survey regardless 

of what questions they were shown or answered.
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• Show Percent of Sample – Count of everyone who has started the survey regardless of what 
questions they were shown or answered.

 The percentages are derived by taking the number of respondents who selected a choice and 
dividing it by one of the three overall counts. The divisors are based on the different number of 
ways to define a response to a survey.

• Statistics – Define which statistics to show within the frequency table.
• Row Counts – Define the row count values to show.
• Percentages – Define the percentage values to show.

• Cumulative Percentages – This is accomplished by adding the row percentages within the table.
• Percent of Valid Responses (default) – Count of people who have been shown the question 

and made a selection.
• Percent of Total Responses – Count of everyone who has started the survey regardless of what 

questions they were shown or answered.
• Percent of Sample – Count of everyone who has started the survey regardless of what 

questions they were shown or answered.

 If only one of these percentage options is selected, the Frequency column might appear for it.

• Maximum Rows – Define the number of rows to show within the frequency table by using the 
Number of Rows to Display text box. The valid range of values is from 10 to 15,000. The 
default value is set to 150. Setting the value greater than 150 may decrease performance.
For the Frequency Table report element with more than 15,000 unique answers, the frequency 
data is irrelevant. This applies to the Fill in the Blank, Short Answer, and Matrix questions 
with a Short Answer side. Click the Filter Report Data button to apply data and date filters to 
your report.

 The set of properties depends on the question type.

To apply changes that you made to all Displayed Values elements in your report, click Apply All.
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Frequency Chart report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Frequency Chart report element.
With the Frequency Chart report element, you can view the frequency of responses to a selected 
question. 
For the Frequency Chart report element with more than 15,000 unique answers, the frequency data is 
irrelevant. This applies to the Fill in the Blank, Short Answer, and Matrix questions with a Short 
Answer side. Click the Filter Report Data button to apply data and date filters to your report.
When you insert the frequency chart into your report, the element editor panel shows a number of 
collapsible menus, including:
• Report Element
• Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Chart Type, Question, Labels, and Caption sections, 
providing a number of customization properties.
• Chart Type – The selected report element type. Use the Chart Type menu to change the 

frequency chart type.
• Question – The source question. Use the Question menu to change a question. The frequency 

chart updates to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Report Values - Select the check box to display the report values on your report element.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
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 The Show Question Heading option is unavailable if the Frequency Chart report element 
uses a file import column.

• Caption – A brief description below your report element. Type your text in the text box and 
customize its font size and style. You can select the color of caption foreground and background 
in the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
The Appearance properties include a number of customization properties.
• Chart Type – Select in a menu the chart type for your report element.

• Bar
• Column
• Pie
• Doughnut
• Area
• Line
• Scatter
• Spline
• Spline Area
• 3D Column
• 3D Pie (not for Matrix)
• 3D Doughnut (not for Matrix)
• Pyramid

Additionally, for a Matrix question only:
• Stacked Bar
• Stacked Bar Percentage
• Stacked Column
• Stacked Column Percentage
• 3D Stacked Column
• 3D Stacked Column Percentage

• Background Color – Select the background color  for your frequency chart from a palette. Select 
from a range of colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and Brightness), and 
HSV (Hue, Saturation, and Value).
If you know the hexadecimal value of a color, you can enter it manually into the Background Color 
menu or click Custom Color to adjust red, green, blue, hue, saturation, and black level values.

• Gradient End Color – Select the gradient color for the uppermost area of your frequency chart 
from a palette.

• Border Color – Select the border color of your frequency chart  from a palette.
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• Border Width – Adjust the width of borders in your frequency chart. Values that you input into 
this field are measured in pixels.

• Border Radius – Change this value to increase or decrease the roundness of border corners in 
your frequency chart.

• Use Different Color for Bar or Column chart types - Select this check box to show each chart 
type in different color.

• Series Color – Click the Series Colors button to select a theme for the series in your chart from 
the Series Palette dialog box and color for each data point from a palette.

• Show Legend - Clear this check box to hide the legend on the frequency chart report element.
• Legend Location - In the Legend Location menu, click the needed legend location (top, 

bottom, left, or right).
• Show Grid Lines - Clear this check box to hide the grid lines on the chart background. Show Grid 

Lines check box is available for Bar, Column, Area, Line, Scatter, Spline, and Spline Area chart 
types. If you clear the Show Grid Lines check box, the grid lines disappear in the preview, test, 
and design modes.

• Label Rotation Angle – Use this text box to define the label rotation angle in degrees.
• Maximum Characters – Use this text box to define the maximum number of characters for 

your frequency chart.
• Size Charts Automatically - Select this check box to make the charts fit the current window size 

automatically.
• Width – Use this text box to define the width of your frequency chart. Values you input into this 

field are measured in pixels.
• Height – Use this text box to define the height of your frequency chart. Values you input into this 

field are measured in pixels.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes that you made to the Appearance properties, click Apply All.

Data
The Data properties include the following options:
• Sort Order – Shows the order the values appear in the report element. The available options are 

Original (Survey order), Alphabetical Order, and By Count. Original (Survey order) is a 
default value. Use the Sort Order menu to change the order. The frequency chart updates to 
show data in the newly selected order.

• Invert Sort Order – Shows the values in reverse order.
• Group unique responses into 'Other Responses' – Group the individual responses rather 

than treating them as a separate item on the chart.
• Decimal Places – Use this text box to define the decimal places for the values that the frequency 

chart shows.
To apply changes that you made to the Data properties, click Apply All.
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Displayed Values
The Displayed Values properties contain a set of values that appears in a Frequency Chart element if 
you select the corresponding check boxes.
• Label – Data label that provides details on a particular data point on the Pyramid chart type.

 The Lable option is active only when the Pyramid chart type is selected. The Pyramid chart type 
uses highcharts-labels and highcharts-data-label to show labels, values, and percents on the 
chart.

• Value – Shows the minimum and maximum values for your chart.
• Percent – Shows the percentage for each response.
• Percent by Total – Shows the percentage for each response calculated by total number of 

responses.
• Show Goal Line – The goal line representing your chart data against a goal.
• Goal Line Value – In this text box, set the goal line value. By default, it is set to 0.
• Label – In this text box, define the goal line name. The goal line name appears on the legend.
• Color – Select the goal line color from a palette.

 The Goal Line Value, Label, and Color options are active only when the Show Goal Line check 
box is selected.

To apply changes that you made to the Displayed Values properties, click Apply All.

Embed Report Element
In the Embed Report Element section of the report designer, you can generate a code snippet and URL 
to use the Frequency Chart report element outside of the EFM application. For example, you can place 
it into an IFrame on custom webpage. The HTML code of the report element is generated automatically. 
You can also configure the width and height of the Frequency Chart report element by editing the code 
snippet in an HTML or text editor.

 For more information, see Manage Embed Report Element, page 970 and Publish widget to URL, 
page 972. 
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Add a Frequency Chart
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Frequency Chart report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Trend Table report element.

You can add the Frequency Chart element to the report either from the Add a Report Element left 
pane or from the Add menu. 

Procedure 
1 In the Add a Report Element area, click the Frequency Chart element. 
2 In the Select data for your report element dialog box, in the Questions menu, define the source 

question for the frequency chart.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

3 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Trend Table
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Trend Table report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Trend Table report element.

You can manage and customize your Trend Table report element by using the following sections in the 
left pane:
• Report Element, page 780
• Appearance, page 781
• Data, page 781
• Displayed Values, page 782
• Embed Report Element, page 782

Report Element
In the Report Element section, you can show or hide the question text, description, and caption.
The Trend Table properties include the following sections:
• Type – The selected report element type.

Question – The source question.
The following question types can be added as additional values: Choose One-based, Fill in the 
Blank (Whole Number/Real Number), Short Answer (Whole Number/Real Number), and Matrix 
Short Answer (Whole Number/Real Number).
 To change a question, use the Question menu. To add multiple questions (maximum four) from the 
same survey to the trend table element, use the Add a question button. This allows you to see how 
the selected variables (questions) vary with time and with respect to each other. The trend table is 
updating to show data from the newly selected questions.

 For the Trend Table report element that is based on multiple questions, the properties in the 
Data and Displayed Values drawers are limited.

If the data channel is defined for the survey, the columns from the corresponding file import are also 
available in the Question menu.  For more information, see Map survey or profile to file import, 
page 582.

• Labels – The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
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• Align Question Text and Description - Select the needed option from the list to align the 
question text and description.

• Show Source Citation - Select the check box to display the element data source if the report 
uses more than one data source.

• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
in the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
In the Appearance section, you can change the look and feel of the element.
The Appearance properties include the Row and Header sections, both providing a number of 
customizing properties:
• Color – Select the background color for the data or header rows.
• Text Color – Select the text color for data or header rows. It is recommended that contrasting 

color selections be made when changing the color and text color settings.
• Font Name – Select in a list of web-compatible fonts for data and header text.
• Font Size – Select in a list of web-compatible font sizes for data and header text.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes that you made to all Trend Table elements in your report, click Apply All.

Data
The Data section contains the following properties:
• Time Period – Select the time period to break down the selected question data. 

 Large data sets may take more time to load depending on the number of responses.

• Reverse Order – View the values in opposite order.
• Range of Top Group – Define the number of choice items to be combined when generating the 

top group. For example, on a five-point scale, all responses of 0 and 1 will be combined. The top 
group calculation can be set to 1, 2, or 3 choices. The default is set to the top 1.

• Range of Bottom Group – Define the number of choice items to be combined when generating 
the bottom group calculation. For example, on a five-point scale, all responses of 4 and 5 will be 
combined. The bottom group calculation can be set to 1, 2, or 3 choices. The default is set to the 
bottom 2.

• Decimal Places – Define the number of decimal places for the values in the table.

 The range of Top and Bottom groups should not overlap and be negative.

To apply changes that you made to all Trend Table elements in your report, click Apply All.
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Displayed Values
In the Displayed Values section, you can select the values to be displayed in a Trend Table element by 
selecting the following check boxes:
• Count – The number of responses selected for each response item.
• Mean – The sum of values divided by the number of values that is an average value.
• Minimum – The minimum value (question choice) selected by the respondents.
• Maximum – The maximum value (question choice) selected by the respondents.
• Sum – The total value of all responses.
• Standard Deviation – The distribution of the responses around the mean.
• Net Score – The net score calculation.
• Top Count – The top group of responses.
• Neutral Count – The neutral group of responses.
• Bottom Count – The bottom group of responses.

 The Count and Mean check boxes are selected by default.

To apply changes that you made to all Trend Table elements in your report, click Apply All.

Embed Report Element
In the Embed Report Element section, you can generate a code snippet and URL to use the Trend 
Table report element outside of the EFM application. For example, you can place it into an IFrame on 
custom webpage. The HTML code of the report element is generated automatically. You can also 
configure the width and height of the Trend Table element by editing the code snippet in an HTML or 
text editor.

 For more information, see Manage Embed Report Element, page 970 and Publish widget to URL, 
page 972. 
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Add Trend Table report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Trend Table report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Trend Table report element.

With the Trend Table report element, you can view a time series analysis for any selected question in the 
survey. You can add the Trend Table element to the report either from the Add a Report Element left 
pane or using the Add list.

Procedure 
1 In the Add a Report Element area, click the Trend Table report element.

In the Select data for your report element dialog box, select the survey question. The following 
question types can be added as additional values: Choose One-based, Fill in the Blank (Whole 
Number/Real Number), Short Answer (Whole Number/Real Number), and Matrix Short Answer 
(Whole Number/Real Number).

2 Click Add.
3 To change the source question, in the Report Element section, in the Question menu, click another 

question.
4 To add multiple questions (maximum four) from the same survey, click Add a Question button, and 

then click the needed question in the list.

 To delete additional question, click the Delete a Question button.

5 To change element properties, use the element editor in the left pane. 

 For more details, see Trend Table, page 780.

6 To manage your Trend Table, use the toolbar in the upper-left corner of the Trend Table dialog box. 
You can add a Trend Table to dashboard, filter, copy, move, or delete it.
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Trend Chart
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Trend Chart report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Trend Chart report element.

You can manage and customize your Trend Chart report element using the following sections in the left 
pane:
• Report Element, page 784
• Appearance, page 785
• Data, page 785
• Displayed Values, page 786
• Embed Report Element, page 786

Report Element
In the Report Element section, you can show or hide the question text, description, and caption.
The Trend Chart properties include the following sections:
• Type – The selected report element type.
• Question – The source question.

The following question types can be added as additional values: Choose One-based, Fill in the 
Blank (Whole Number/Real Number), Short Answer (Whole Number/Real Number), and Matrix 
Short Answer (Whole Number/Real Number).
To change a question, use the Question menu. To add multiple questions (maximum four) from 
the same survey to the trend chart element, use the Add a question button. This allows you to 
see how the selected variables (questions) vary with time and with respect to each other. The 
trend chart updates to show data from the newly selected questions.

 For the Trend Table report element that is based on multiple questions, the properties in the 
Data and Displayed Values drawers are limited.

If the data channel is defined for the survey, the columns from the corresponding file import are also 
available in the Question drop-down list. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties.
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
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• Align Question Text and Description - Select the needed option from the list to align the 
question text and description.

• Show Source Citation - Select the check box to display the element data source if the report 
uses more than one data source.

• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
in the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
In the Appearance section, you can change the look and feel of the element.
The Appearance properties include the Row and Header sections, both providing a number of 
customizing properties:
• Chart Type – Select in a list the chart type for your report element.
• Background Color – Select the background color of the trend chart.

If you know the hexadecimal value of a color, you can enter it manually into the Background Color 
menu or click Custom Color to adjust red, green, blue, hue, saturation, and black level values.

• Gradient End Color – Select the gradient color for the uppermost area of the element.
• Border Color – Select the border color of the element.
• Border Width – Adjust the width of trend chart borders (in pixels).
• Border Radius – Change this value to increase or decrease the roundness of border corners in 

your trend chart element.
• Series Color – Click the button to select a theme for the series in your chart from the Series 

Color dialog box and a color for each data point.
• Show Legend - Clear this check box to hide the legend on the trend chart report element.
• Legend Location - In the Legend Location menu, click the needed legend location (top, 

bottom, left, or right).
• Show Grid Lines - Clear this check box to hide the grid lines on the chart background. If you clear 

the Show Grid Lines check box, the grid lines disappear in the preview, test, and design modes.
• Label Rotation Angle – Define the label rotation angle (in degrees).
• Maximum Characters – Define the maximum number of characters for your element.
• Width – Set the width of the trend chart element (in pixels).
• Height – Set the height of the trend chart element (in pixels).

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes that you made to all Trend Chart elements in your report, click Apply All.

Data
The Data section contains the following properties:



Report Element Types Trend Chart

EFM User Guide 786

Confidential and Proprietary Information of Verint Systems Inc.

• Decimal Places – Define the number of decimal places for the values in the table. The default 
value is set to 3.

• Range of Top Group – Define the number of choice items to be combined when generating the 
top box calculation. For example, on a five-point scale all responses of 1 and 2 will be combined. 
The top box calculation can be set to 1, 2, or 3 choices. The default is set to the top 2. 

• Range of Bottom Group – Define the number of choice items to be combined when generating 
the bottom box calculation. For example, on a five-point scale all responses of 4 and 5 will be 
combined. The bottom box calculation can be set to 1, 2, or 3 choices. The default is set to the 
bottom 2.

 Large data sets may take more time to load depending on the number of responses and length 
of time requested.

To apply changes that you made to all Trend Chart elements in your report, click Apply All.

Displayed Values
In the Displayed Values section, you can select the values to be displayed in a Trend Chart element by 
selecting the followingcheck boxes.
• Count – The number of responses selected for each response item.
• Mean – The sum of values divided by the number of values that is an average value.
• Minimum – The minimum value (question choice) selected by the respondents.
• Maximum – The maximum value (question choice) selected by the respondents.
• Sum – The total value of all responses.
• Standard Deviation – The distribution of the responses around the mean.
• Value – The minimum and maximum values for your chart.
• Net Score – The net score calculation.
• Top Box – The cumulative total of the top two items of a rating scale. This option is available only 

for the Bar, Column, Line, and Area chart types.
• Show Goal Line – The goal line representing your chart data against a goal.
• Goal Line Value – Set the goal line value. The default is set to 0.
• Label – Define the goal line name. The goal line name appears on the legend.
• Color – Select the goal line color.

 The Count and Mean check boxes are selected by default.

To apply changes that you made to all Trend Chart elements in your report, click Apply All.

Embed Report Element
In the Embed Report Element section, you can generate a code snippet and URL to use the Trend 
Chart report element outside of the EFM application. For example, you can place it into an IFrame on 
custom webpage. The HTML code of the report element is generated automatically. You can also 
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configure the width and height of the Trend Chart element by editing the code snippet in an HTML or 
text editor.

 For more information, see Manage Embed Report Element, page 970 and Publish widget to URL, 
page 972. 
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Add a Trend Chart report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element.

You can visualize your survey verbatim datasets in a trend chart for better understanding of the verbatim 
responses.
1 In the Add a Report Element left pane, in the Text Analytics section, click the Trend Chart 

element.

 You can add the Trend Chart element to the report either from the Add a Report Element left 
pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions or click All Verbatim Questions.

 You can select another source for your report element by clicking the Data Source option at the 
top of the dialog box.

3 To get the Trend Chart report element in the right pane and element editor in the left, click Add.

 You can add a Trend Chart report element when your survey has the Open or Closed status 
only.
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Image Slideshow report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Image Slideshow report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Image Slideshow report element.

With the Image Slideshow report element, you can easily view and rotate images that are uploaded by a 
respondent when answering the Image Upload questions.

 You can select another data source for your report element by clicking the survey link in the 
Select data for your report element dialog box.

If you have already added other elements to the report, click the Add  menu to add the Image Slideshow 
element. Images are displayed according to the date uploaded.

When clicking  on the Image Slideshow report element, the Image dialog box opens, where you can 
view the image itself, date when it was uploaded, location where it was taken, and tags added to the 
image. You can also download the image by clicking the Download Image link, rate the image, and 
change the rating previously added to the image.

 The rating option is not editable if the Edit Responses permission is not activated for your user 
role.

In the element editor pane, you can customize the Image Slideshow report element in the following 
way:
• Report Element - Use to customize element properties:

• Type - View the selected report element type.
• Question - View the source question. Use the Question menu to change the source question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels - The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
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• Show Source Citation - Select the check box to display the element data source if the report 
uses more than one data source.

• Caption - Add a brief description below your report element. Type your text in the text box and 
customize its font size and style. You can select the color of caption foreground and background 
from the foreground color and background color drop-down menus. To check the spelling, click 
Spell Check.

Embed Report Element
Use the HTML code snippet to place the report elements into a custom webpage outside of the product. 
You can also configure the report element by editing the code snippet in HTML or text editor.

 The flow of the images or images themselves may appear blurry or distorted depending on which 
browser you use.
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Image Tag Cloud report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Image Tag Cloud report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Image Tag Cloud report element.

With the Image Tag Cloud report element, you can view a word cloud of tags that were added by the 
respondent when answering the Image Upload question.

 You can select another data source for your report element by clicking the survey link in the 
Select data for your report element dialog box.

If you have already added other elements to the report, click the Add menu to add the Image Tag Cloud 
element. 
In the element editor pane, you can customize the Image Tag Cloud report element in the following 
way:
• Report Element - Use to customize element properties.

• Type – Use to view the selected report element type.
• Question – Use to view the source question. Use the Question menu to change the source 

question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – Add a brief description below your report element. Type your text in the text box and 

customize its font size and style. You can select the color of caption foreground and background 
in the  menus. To check the spelling, click Spell Check.
• Appearance – Use to customize the look and feel of the word cloud of tags.
• Cloud Shape – Select the form of the word cloud of tags in menu: elliptic or rectangular.
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• Background Color – Select the background color for your word cloud of tags from a palette. 
Select from a range of colors in the Web Palette, RGB Sliders, Hue, Saturation, and Brightness 
(HSB), and Hue, Saturation, and Value (HSV). If you know the hexadecimal value of a color, you 
can enter it manually.

• Border Color – Select the border color of your word cloud of tags from a palette.
• Border Width – Adjust the width of borders in your word cloud of tags (in pixels).
• Size Cloud Automatically – Select this check box to make the word cloud of tags fit the current 

window size automatically.
• Data – Use to manage the amount of content in your word cloud of tags.

• Maximum Items – Enter the number of tags that you want to be displayed in the word cloud. By 
default, 100 items are displayed.



Report Element Types Summary Table report element

EFM User Guide 793

Confidential and Proprietary Information of Verint Systems Inc.

Summary Table report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add theSummary Tablereport element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Summary Table report element.

With the Summary Table report element, you can view the results of one question's responses against 
two demographic fields, for example, a report on a salary against age and gender. You can add the 
Summary Table element to the report either from the Add a Report Element left pane or from the 
Add menu.
Once you insert the summary table into your report, the element editor panel to the left shows a number 
of collapsible menus, including:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Row Question, Column Question, Question, 
Labels, and Caption sections, providing a number of customization properties.
• Type – The selected report element type.
• Row Question – The source row question. Use the Row Question menu to change a question. 

The summary table updates to show data from the newly selected question.
• Column Question – The source column question. Use the Column Question menu to change a 

question. The summary table is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Row Question and Column Question menus. For more information, see 
Map a file import to project or profile, page 1174.

• Question – The source question. Use the Question menu to change a question. The summary 
table is updating to show data from the newly selected question.

• Labels – The customizing properties.
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
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• Align Question Text and Description - Select the needed option from the list to align the 
question text and description.

• Show Report Values - Select the check box to display the report values on your report element.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type your text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
in the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections, both providing a number of 
customization properties.
 

• Color – Select the background color for the data or header rows from a palette.
• Text Color – Select the text color for data or header rows from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The Data properties section includes the following options:
• Decimal Places – Use this text box to define the number of decimal places for the values that 

the summary table shows.
• Show Values Using Color – Select this check box to apply color to the values based on the 

Calculation used to color cells option.
• Calculation used to color cells – Use this menu to select calculation options for the value 

coloring.
To apply changes you have made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain a set of values that appears in a Summary Table element if 
you select the corresponding check boxes.
• Count – The number of responses selected for each response item.
• Mean – The sum of values divided by the number of values that is an average value.
• Minimum – The minimum value (question choice) selected by the respondents.
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• Maximum – The maximum value (question choice) selected by the respondents.
• Sum – The total value of all responses.
• Standard Deviation – The distribution of the responses around the mean.
• Local Maxima – The maximum value of each interval. It is shown in bold.
• Group unique responses into 'Other Responses' – Use this option to group the individual 

responses rather than treating them as a separate item on the table.

 The Mean and Local Maxima values are selected by default.



Report Element Types Add Summary Table report element

EFM User Guide 796

Confidential and Proprietary Information of Verint Systems Inc.

Add Summary Table report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Summary Table report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Summary Table report element.

You can add the Summary Table report element to the report either from the Add a Report Element 
left pane or from the Add menu. 

Procedure 
1 In the Add a Report Element area, click the Summary Table element. 
2 In the Select data for your report element dialog box, in the Questions menu, define the source 

question for the summary table.
3 In the Row Question menu, define the row question for the summary table.
4 In the Column Question menu, define the column question for the summary table.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

5 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Summary of Means report element 
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Summary of Means report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Summary of Means report element.

With the Summary of Means report element, you can view the means of the responses based on two 
questions in a single table. You can add the Summary of Means element to the report either in the Add 
a Report Element left pane or in the Add menu.
When you add the Summary of Means element to your report, the element editor panel to the left 
shows a number of collapsible menus, including:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Question, Broken Down By, Labels, and Caption 
sections, providing a number of customization properties.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The Summary 

of Means element is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Broken Down By – The breaking-down question. Use the Broken Down By menu to change a 
question. The Summary of Means element is updating to show data from the newly selected 
question.

• Labels – The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Report Values - Select the check box to display the report values on your report element.
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• Show Source Citation - Select the check box to display the element data source if the report 
uses more than one data source.

• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections, both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows  from a palette.
• Text Color – Select  the text color for data or header rows  from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The Data properties include the following options.
• Decimal Places – Use this text box to define the number of decimal places for the values that 

the summary of means shows.
• Show Values Using Color – Select this check box to apply color to the values based on the 

Calculation used to color cells option.
• Calculation used to color cells – Use this menu to select calculation options for the value 

coloring.
• To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain a set of values that appears in a Summary of Means element 
if you select the corresponding check boxes.
• Count – The number of responses selected for each response item.
• Mean – The sum of values divided by the number of values that is an average value.
• Minimum – The minimum value (question choice) selected by the respondents.
• Maximum – The maximum value (question choice) selected by the respondents.
• Sum – The total value of all responses.
• Standard Deviation – The distribution of the responses around the mean.
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• Group unique responses into 'Other Responses' – Use this option to group the individual 
responses rather than treating them as a separate item on the table.

• Local Maxima – The maximum value of each interval. It is shown in bold.

 The Mean, Group unique responses into 'Other Responses', and Local Maxima check 
boxes are selected by default.
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Add Summary of Means report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Summary of Means report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Summary of Means report element.

You can add the Summary of Means report element to the report either in the Add a Report Element 
left pane or in the Add menu. 

Procedure 
1 In the Add a Report Element area, click the Summary of Means element. 
2 In the Select data for your report element dialog box, in the Questions menu, define the source 

question for the summary of means.
3 In the Broken Down By menu, define the breaking-down question for the summary of means. You 

can select any type of question in the menu.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

4 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Cross-tab report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Cross-tab report element.

With the Cross-tab report element, you can view a cross-tabulation of two selected questions. You can 
add the Cross-tab element to the report either in the Add a Report Element left pane or in the Add  
menu.
When you add the cross-tabulation to your report, the element editor panel to the left shows a number 
of collapsible menus, including:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
The  Report Element properties include the Type, Row Question, Column Question, Labels, and 
Caption sections, providing a number of customization properties.
• Type – The selected report element type.
• Row Question – The source row question. Use the Row Question menu to change a question. 

The Cross-tab element is updating to show data from the newly selected question.
• Column Question – Shows the source column question. Use the Column Question menu to 

change a question. The Cross-tab element is updating to show data from the newly selected 
question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available in the Row Question and Column Question menus. For more information, see 
Map survey or profile to file import, page 582.

• Labels – The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Report Values - Select the check box to display the report values on your report element.
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• Show Source Citation - Select the check box to display the element data source if the report 
uses more than one data source.

• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections, both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows  from a palette.
• Text Color – Select the text color for data or header rows  from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select  web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The Data properties include the following options.
• Decimal Places – Use this text box to define the decimal places for the values that the cross-

tabulation shows.
• Calculation used to color cells – Use this menu to select calculation options for the value 

coloring.
To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain a set of values that appears in a Cross-tab element if you 
select the corresponding check boxes.
• Response Count – Select this check box to show the number of cross responses on the column 

and row questions.
• Percent by Column – Select this check box to show the percentage for each response calculated 

by column.
• Percent by Row – Select this check box to show the percentage for each response calculated by 

row.
• Percent by Total – Select this check box to show the percentage for each response calculated by 

total number of responses.
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• Local Maxima – Select this check box to show the maximum value of each interval. It is shown in 
bold.

• Group unique responses into 'Other Responses' – Use this option to group the individual 
responses rather than treating them as a separate item on the table.

• Show Values Using Color – Select this check box to apply color to the values based on the 
Calculation used to color cells option.

 The Percent by Column and Percent by Total check boxes are clear by default.

To apply changes that you made to the Displayed Values properties, click Apply All.
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Add Cross-tab report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Cross-tab report element.

You can add the Cross-tab report element to the report either in the Add a Report Element left pane or 
in the Add menu. 

Procedure 
1 In the Add a Report Element pane, click the Cross-tab element. 
2 In the Select data for your report element dialog box, in the Column Question menu, define the 

column question for the cross-tabulation.
3 In the Row Question menu, define the row question for the cross-tabulation.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

4 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Cross-tab Chart report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Cross-tab Chart report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Cross-tab Chart report element.

With the Cross-tab Chart report element, you can view a cross-tabulation of two selected questions as a 
chart. The size of the chart bubbles depends on the number of responses to the corresponding question. 
You can add the Cross-tab Chart report element to the report either in the Add a Report Element left 
pane or in the Add menu.
When you add the cross-tab chart to your report, the element editor panel to the left shows a number of 
collapsible menus, including:
• Report Element
• Appearance
• Data
• Displayed Values
• Embed Report Element

Report Element
The  Report Element properties include the Chart Type, X-Axis question, Y-Axis question, Labels, 
and Caption sections, providing a number of customization properties. 
• Chart Type – The selected report element type. Use the Chart Type menu to change the Cross-

tab Chart type.
• X-Axis Question – The source question for the X axis of the chart. Use the X-Axis Question 

menu to change the question. The cross-tab chart element is updating to show data from the 
newly selected question.

• Y-Axis Question – The source question for the Y axis of the chart. Use the Y-Axis Question 
menu to change the question. The cross-tab chart element is updating to show data from the 
newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
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• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Report Values - Select the check box to display the report values on your report element.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type the text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
The  Appearance properties include a number of customization properties. 
• Chart Type – Select in a menu the chart type for your report element. 

• Bubble
• 3D Bubble
• Scatter Plot– A chart which describes values for two variables for a set of data.

 The default chart type value is Bubble.

• Background Color – Select the background color for your cross-tab chart  from a palette. Select 
from a range of colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and Brightness), and 
HSV (Hue, Saturation, and Value).
If you know the hexadecimal value of a color, you can enter it manually into the Background Color 
menu or click Custom Color to adjust red, green, blue, hue, saturation, and black level values.

• Gradient End Color – Select the gradient color for the uppermost area of your cross-tab chart 
from a palette.

• Border Color – Select the border color of your cross-tab chart from a palette.
• Border Width – Adjust the width of borders in your cross-tab chart. Values you input into this 

field are measured in pixels.
• Border Radius – Change this value to increase or decrease the roundness of border corners in 

your cross-tab chart.
• Use Different Color for Each Bubble – Select this check box to show each bubble in the chart in 

different color.
• Series Colors – Click the Series Colors button to select a theme for the series in your chart in the 

Series Palette dialog box and color for each data point from a palette.
• Show Legend – Select this check box to display the legend on the cross-tab chart. This check box 

is clear by default. The legend appears to the right of the chart. You can click the label to show or 
hide the chart values.

• Legend Location - In the Legend Location menu, click the needed legend location (top, 
bottom, left, or right).



Report Element Types Cross-tab Chart report element

EFM User Guide 807

Confidential and Proprietary Information of Verint Systems Inc.

• Show Grid Lines - Clear this check box to hide the gray lines on the chart background. If you 
clear the Show Grid Lines check box, the grid lines disappear in the preview, test, and design 
modes.

• Label Rotation Angle – Use this text box to define the label rotation angle in degrees.
• Maximum Characters – Use this text box to define the maximum number of characters for 

your cross-tab chart.
• Size Charts Automatically – Select this check box to make the cross-tab charts fit the current 

window size automatically.
• Width – Use this text box to define the width of your cross-tab chart. Values you input in this 

field are measured in pixels.
• Height – Use this text box to define the height of your cross-tab chart. Values you input in this 

field are measured in pixels.

 You can also customize your chart appearance by using the advanced chart properties. For more 
information, see Advanced chart properties, page 732.

Data

 These properties are available only when weighting scheme is applied to your cross-tab chart.
 

• Decimal Places – Use this text box to define the decimal places for the values that the cross-tab 
chart shows.

• Display Weighted Values – Select this check box to display weighted values in your cross-tab 
chart.

Displayed Values
• Show Total Responses – Select this check box to display the total number of responses.
• Show Total Responses Weighted – Select this check box to display the total number of 

responses covered by weighting.
• Response Count – Select this check box to show the number of cross responses on the X-axis 

and Y-axis questions.
• Show Regression Line – Select this check box to have a regression line displayed on a Scatter 

Plot chart. You can also set a label and color for a regression line.
• Label – In this text box, define the regression line name. The regression line name appears on the 

legend.
• Color – Select the regression line color from a palette.

 The Show Total Responses and Show Total Responses Weighted check boxes are available 
only when weighting scheme is applied to your cross-tab chart and the Display Weighted 
Values check box in the Data section is selected.

 The Show Regression Line check box is available only for a Scatter Plot chart type.
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Embed Report Element
You can generate a code snippet and URL to embed the Cross-tab Chart report element into external 
applications.
You can use the code snippet to place the Cross-tab Chart report element into a custom page. The 
HTML code of the report element is generated automatically for you. You can also configure the width 
and height of the cross-tab chart by editing the code snippet in an HTML or text editor.
You can use the URL to place the Cross-tab Chart report element into an IFrame on a custom page. The 
URL of the report element is generated automatically for you. You can also configure the width and 
height of the cross-tab chart on your custom page.

 For more information, see Manage Embed Report Element, page 970 and Publish widget to URL, 
page 972. 
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Add Cross-tab Chart report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Cross-tab Chart report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Cross-tab Chart report element.

You can add the Cross-tab Chart report element to the report either in the Add a Report Element left 
pane or in the Add menu. 

Procedure 
1 In the Add a Report Element panel, click the Cross-tab Chart element. 
2 In the Select data for your reportelement dialog box, in the Y-Axis Question menu, select the Y-

axis source question for the cross-tab chart.
3 In the X-Axis Question menu, select the X-axis source question for the cross-tab chart.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

4 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Response List report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Response List report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Response List report element.

The Response List report element enables you to insert the responses of any open-ended questions 
(Essay and Fill in the Blank) of your survey into your report. You can add the Response List element 
to the report either in the Add a Report Element left pane or in the Add menu.
When you add the response list to your report, the element editor panel to the left shows a number of 
collapsible menus, including:
• Report Element
• Table Appearance
• Displayed Values

Report Element
The Report Element properties are divided into the Type, Question, Labels, and Caption sections, 
providing a number of customization properties.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The response 

list is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
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 The Show Question Heading option is unavailable, if the Frequency Chart report element 
uses a file import column.

• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties are divided into the Row and Header sections, both providing a 
number of customization properties.
• Color – Select the background color for the data or header rows from a palette.
• Text Color – Select the text color for data or header rows from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.
To apply changes that you made to the Table Appearance properties, click Apply All.

Displayed Values
The Displayed Values properties enable you to define the rows number per page in your response list. 
Select the ID column check box to add the ID column to the response list. 
To apply changes that you made to the Displayed Values properties, click Apply All.
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Add Response List report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Response List report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Response List report element.

You can add the Response List report element to the report either in the Add a Report Element left 
pane or in the Add menu. 

Procedure 
1 In the Add a Report Element panel, click the Response List element. 
2 In the Select data for your report element dialog box, in the Questions menu,  click the question 

you want to add.
3 In the X-Axis Question menu, select the X-axis source question for the cross-tab chart.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

4 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Statistics report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Statistics report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Statistics report element.

With the Statistics report element, you can collect statistical data in a single table. The Statistics 
element can be used with the following question types: Choose One and multiple choice questions within 
a Matrix. You can add the Statistics element to the report either in the Add a Report Element left pane 
or in the Add menu.
When you add the statistics element to your report, the element editor panel to the left shows a number 
of collapsible menus, including:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Question, Labels, and Caption sections, providing a 
number of customization properties.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The statistic 

element is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. 
Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
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• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections, both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows from a palette.
• Text Color – Select  the text color for data or header rows from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The  Data properties menu contains the text box which you can use to set the number of decimal places 
for the values in the table.
To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties menu shows the type of statistics element that appears in the table. 
You can select the statistics element type from the Statistics menu. The available options are Standard, 
Detailed, and Basic.

 The Standard set of values is selected by default.

• Detailed – Contains the following set of values for the selected question:
• Kurtosis – The relatively peaked or flat distribution compared with the normal distribution. 

Positive kurtosis means a relatively peaked distribution. Negative kurtosis means a relatively flat 
distribution.

• Maximum – The maximum value (question choice) selected by the respondents.
• Mean – The sum of values divided by the number of values that is an average value.
• Mean Absolute Deviation – The sum of absolute values of the differences from the mean.
• Median – The numerical value in the center after ordering all the values. It has an equal number 

of values below and above it.
• Minimum – The minimum value (question choice) selected by the respondents.
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• Mode – The value representing the highest frequency.
• Poisson – The probability of a particular event occurrence in a specific time period.
• Range – The difference between the largest and smallest data point.
• Skew – The degree of distribution asymmetry around its mean. Positive skews mean a 

distribution with an asymmetric tail extending toward more positive values (to the right). Negative 
skews mean a distribution with an asymmetric tail extending toward more negative values (to the 
left).

• Standard Deviation – The distribution of the responses around the mean.
• Sum – The total value of all responses.
• Total Responses – The total number of responses.
• Valid Responses – The number of valid responses.
• Variance – The spread of the data around the mean.

• Standard – Contains the following set of values for the selected question:
• Maximum – The maximum value (question choice) selected by the respondents.
• Mean – The sum of values divided by the number of values that is an average value.
• Median – The numerical value in the center after ordering all the values. It has an equal number 

of values below and above it.
• Minimum – The minimum value (question choice) selected by the respondents.
• Mode – The value representing the highest frequency.
• Standard Deviation – The distribution of the responses around the mean.
• Sum – The total value of all responses.
• Total Responses – The total number of responses.
• Valid Responses – The number of valid responses.

• Basic – Contains the following set of values for the selected question:
• Mean – The sum of values divided by the number of values.
• Standard Deviation – The distribution of the responses around the mean.
• Total Responses – The total number of responses.
• Valid Responses – The number of valid responses.

To apply changes that you made to the Displayed Values properties, click Apply All.
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Add Statistics report element 
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Statistics report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Statistics report element.

You can add the Statistics report element to the report either in the Add a Report Element left pane or 
in the Add menu. 

Procedure 
1 In the Add a Report Element area, click the Statistics report element. 
2 In the Select data for your report element dialog box, in the Questions menu,  click the question 

you want to add.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

3 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Correlation report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Correlation report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Correlation report element.

With the Correlation report element, you can compare two variables from your survey. The range of 
potential values is -1.0 to 1.0. A correlation approaching 1.0 signifies that two values are strongly related. 
You can add the Correlation element to the report either in the Add a Report Element pane or on the 
Add menu.
When you add the Correlation element to your report, the element editor panel to the left shows a 
number of collapsible menus, including:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Variable 1, Variable 2, Labels, , and Caption 
sections providing a number of customization properties. 
• Type – The selected report element type.
• Variable 1 – The first question to be compared. Use the Variable 1 menu to change a question. 

The Correlation element is updating to show data from the newly selected question.
• Variable 2 – The second question to be compared. Use the Variable 2 menu to change a 

question. The Correlation element is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  on the Variable menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
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• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
on the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections both providing a number of 
customization properties.
 

• Color – Select the background color for the data or header rows  from a palette.
• Text Color – Select the text color for data or header rows  from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

 

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The  Data properties include the following options:
• Decimal Places – Use this text box to define the number of decimal places for the values that 

the Correlation element shows.
• Significance Cutoff – Use this menu to define the significance value for your correlation 

element. The following options are available:
• p < 0.5
• p < 0.2
• p < 0.1
• p < 0.05
• p < 0.02
• p < 0.01
• p < 0.001

To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain the Significance Column check box. Select the Significance 
Column check box to show values based on the Significance Cutoff option.
To apply changes that you made to the Displayed Values properties, click Apply All.
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Add Correlation report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Correlation report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Correlation report element.

You can add the Correlation report element to the report either in the Add a Report Element left pane 
or in the Add menu. 

Procedure 
1 In the Add a Report Element area, click the Statistics report element. The Select data for your 

report element dialog box opens.
2 In the Select data for your report element dialog box, in the Variable 1 and Variable 2 menus, 

define two questions to be compared.
• On the Variable 1 menu, the following question types are available:

- Multiple Choice: Choose One
- Multiple Choice: Choose Many
- Fill in the Blank (numeric)
- Matrix

• On the Variable 2 menu, the following question types are available:
- Multiple Choice: Choose One
- Multiple Choice: Choose Many
- Mean calculation of Fill in the Blank questions (numeric)
- Mean calculation of the Matrix questions based on the Multiple Choice: Choose One and 

Multiple Choice: Choose Many questions

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

3 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Gap report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Gap report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Gap report element.

With the Gap report element, you can identify the differences between two numerical values. This report 
is run against the numerical Fill in the Blank questions or different sides of a Matrix question. A 
common gap analysis is to compare the satisfaction and importance ratings for a question topic. The Gap 
element subtracts the mean of the Comparison question from the mean of the Basis question. You can 
add the Gap element to the report either in the Add a Report Element left pane or on the Add menu.
When you add the Gap element to your report, the element editor panel to the left shows a number of 
collapsible menus including:
• Report Element
• Table Appearance
• Data

Report Element
The Report Element properties include the Type, Comparison, Basis, Labels, and Caption sections 
providing a number of customization properties.
• Type – The selected report element type.
• Comparison – The first question to be compared. Use the Comparison menu to change a 

question. The Gap element is updating to show data from the newly selected question.
• Basis – The second question to be compared. Use the Basis menu to change a question. The 

Gap element is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Comparison and Basis menus. For more information, see Map survey or 
profile to file import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.



Report Element Types Gap report element

EFM User Guide 821

Confidential and Proprietary Information of Verint Systems Inc.

• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows from a palette.
• Text Color – Select the text color for data or header rows from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select  web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The Data properties menu contains the Decimal Places text box which you can use to set the number 
of decimal places for the values in the Gap report element.
To apply changes that you made to the Data properties, click Apply All.
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Top Box report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Top Box report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Top Box report element.

With the Top Box report element, you can view the cumulative total of the top two items of a rating scale 
and define the number of rating points used in the top and bottom box calculation. You can add the Top 
Box element to the report either in the Add a Report Element left pane or on the Add menu.
When you add the top box to your report, the element editor panel to the left shows a number of 
collapsible menus including:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Question, Labels, and Caption sections providing a 
number of customization properties.
• Type – Shows the selected report element type.
• Question – Shows the source question. Use the Question menu to change a question. The Top 

Box is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type your text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
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from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows  from a palette.
• Text Color – Select the text color for data or header rows  from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The Data properties include the following options:
• Reverse Order – Use this check box to view the values in an opposite order.
• Decimal Places – Use this text box to define the decimal places for the values that the top box 

shows.
• Range of Top Group – Use this text box to define the number of choice items to be combined 

when generating the top box calculation. The default is set to the top 2. For example, on a five-
point scale all responses of 1 and 2 will be combined. The top box calculation can be set to 1, 2, or 
3 choices.

• Range of Bottom Group – Use this text box to define the number of choice items to be 
combined when generating the bottom box calculation. The default is set to the bottom 2. For 
example, on a five-point scale all responses of 4 and 5 will be combined. The bottom box 
calculation can be set to 1, 2, or 3 choices.

To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain a set of values that appears in a Top Box element if you select 
the corresponding check boxes.
• Mean – Select this check box to show the sum of values divided by the number of values (average 

value).
• Local Maxima – Select this check box to show the maximum value of each interval. It is shown in 

bold.
• Bar Chart Labels – Select this check box to show the percentage labels on responses bar chart.
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• Box Ranges in Column Headers – Select this check box to show the range of responses in 
column headers.

To apply changes that you made to the  Displayed Values properties, click Apply All.
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Add Top Box report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Top Box report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Top Box report element.

You can add the Top Box report element to the report either in the Add a Report Element left pane or in 
the Add menu. 

Procedure 
1 In the Add a Report Element area, click the Top Box report element. 
2 In the Select data for your reportelement dialog box, in the Questions menu, click the question 

you want to add.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

3 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Top Box Cross-tab report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Top Box Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Top Box Cross-tab report element.

With the Top Box Cross-tab report element, you can create a summary of the responses to a question 
broken down by the responses of another question. You can add the Top Box Cross-tab element to the 
report either in the Add a Report Element left pane or on the Add menu.
When you add the Top Box Cross-tab element to your report, the element editor panel to the left shows 
a number of collapsible menus including:
• Report Element
• Table Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Question, Broken Down By, Labels, and Caption 
sections providing a number of customization properties.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The Top Box 

Cross-tab element is updating to show data from the newly selected question.
• Broken Down By – The breaking-down question. Use the Broken Down By menu to change a 

question. The Top Box Cross-tab element is updating to show data from the newly selected 
question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question and Broken Down By menus. For more information, see Map 
survey or profile to file import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Report Values - Select the check box to display the report values on your report element.
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• Show Source Citation - Select the check box to display the element data source if the report 
uses more than one data source.

• Caption – A brief description below your report element. Type your text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Table Appearance
The Table Appearance properties include the Row and Header sections both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows  from a palette.
• Text Color – Select the text color for data or header rows  from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.

 Several Table Appearance properties can be assigned throughout the report with the report 
theme.

To apply changes that you made to the Table Appearance properties, click Apply All.

Data
The Data properties include the following options:
• Reverse Order – Use this check box to view the values in an opposite order.
• Decimal Places – Use this text box to define the decimal places for the values that the top box 

cross-tabulation shows.
• Range of Top Group – Use this text box to define the number of choice items to be combined 

when generating the top box calculation. The default is set to the top 2. For example, on a five-
point scale all responses of 1 and 2 will be combined. The top box calculation can be set to 1, 2, or 
3 choices.

• Range of Bottom Group – Use this text box to define the number of choice items to be 
combined when generating the bottom box calculation. The default is set to the bottom 2. For 
example, on a five-point scale all responses of 4 and 5 will be combined. The bottom box 
calculation can be set to 1, 2, or 3 choices.

• Group unique responses into 'Other Responses' – Use this option to group the individual 
responses rather than treating them as a separate item on the table.

To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain a set of values that appears in a Top Box Cross-tab element if 
you select the corresponding check boxes.
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• Mean – Select this check box to show the sum of values divided by the number of values (average 
value).

• Local Maxima – Select this check box to show the maximum value of each interval. It is shown in 
bold.

• Bar Chart Labels – Select this check box to show the percentage labels on responses bar chart.
• Box Ranges in Column Headers – Select this check box to show the range of responses in 

column headers.
To apply changes that you made to the  Displayed Values properties, click Apply All.
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Add Top Box Cross-tab report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Top Box Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Top Box Cross-tab report element.

You can add the Top Box Cross-tab element to the report either in the Add a Report Element left pane 
or on the Add menu.

Procedure 
1 In the Add a Report Element area, click the Top Box report element. 
2 In the Select data for your reportelement dialog box, in the Questions menu, define the source 

question for the top box cross-tabulation.
3 In the Broken Down By list, define the breaking-down question for the top box cross-tabulation.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

4 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Respondent Map report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Respondent Map report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Respondent Map report element.

You can manage and customize your Respondent Map report element by using the following sections in 
the left pane:
• Report Element
• Appearance
• Embed Report Element

Report Element
In the Report Element section, you can show or hide the element text, description, and caption. The 
Respondent Map properties include the following sections:
• Type – The selected report element type.
• Labels – The customizing properties. Use this section to customize the following properties:

• Show Element Text - Select the check box to show the element text.
• Show Element Description - Select the check box to show the element description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source. 
• Caption – A brief description below your report element. Type the text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
color in the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
In the Appearance section, you can specify the look and feel of the element. The appearance settings 
can change according to different report themes. The following properties are available:
• Background Color – Select the background color of the map.
• Gradient End Color – Select the gradient color for the uppermost area of the  element.
• Border Color – Select the color of the border of the element.
• Border Width – Adjust the width of map borders (in pixels).
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• Border Radius – Change this value to increase or decrease the roundness of border corners in 
your respondent map element.

• Series Colors – Click the button to select a theme for the series in your pie chart from the Series 
Colors dialog box and a color for each data point.

• Show Legend – Select this check box to display the legend on the respondent map. This check 
box is selected by default.

• Legend Location - In the Legend Location list, click the needed legend location (top, bottom, 
left, or right).

• Size Charts Automatically – Select this check box to make the respondent map element fit the 
current window size automatically.

• Width – Set the width of the respondent map element (in pixels).
• Height – Set the height of the respondent map element (in pixels).

 The Width and the Height options become available if you clear the Size Charts 
Automatically check box

Click the Apply All button to apply changes to all Respondent Map elements in your report.

Embed Report Element
In the Embed Report Element section, you can generate a code snippet and URL to use the 
Respondent Map report element outside of the EFM application. For example, you can place it into an 
IFrame on custom webpage. The HTML code of the report element is generated automatically. You can 
also configure the width and height of the Respondent Map element by editing the code snippet in an 
HTML or text editor.
For more information, see Manage Embed Report Element, page 970 and Publish widget to URL, 
page 972.

 For the Statistics Map and Respondent Map report elements, the drill-down within continents 
and countries is unavailable in embedded report element.
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Add Respondent Map report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Respondent Map report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Respondent Map report element.

With the Respondent Map report element, you can view the geographical distribution of the survey 
respondents which is based on the number of responses gathered from different locations. In the 
Respondent Map dialog box, you can see the total number of responses to your survey.
The Respondent Map indicates areas of the maximum survey participation with different colors. It 
displays the respondents spread geographically: by the world, by continent, and by country/state. The 
following countries support the drill-down within a country: USA, Canada, United Kingdom, Germany, 
Australia, and New Zealand. For example, if there are respondents from different states of USA, you can 
view them distributed by their states. If all survey participants are from the same country, only this 
country is displayed on the Respondent Map.

 For the responses from the United Kingdom, clicking on England, Wales, Northern Ireland, or 
Scotland drills down to the next regional level.

Procedure 
1 In the Add a Report Element area, click the Respondent Map report element.
2 In the Select data for your report element dialog box, select the source survey for the 

Respondent Map, and then click Add.

3 To view the number and percentage of participants on the map, click the locations or use zoom in  

and zoom out  buttons.
4 To change the element properties, use the element editor in the left pane. 

For more details, see Respondent Map report element, page 830.
5 To manage your Respondent Map, use the toolbar in the upper-right corner of the Respondent 

Map dialog box. 
You can add a Respondent Map to dashboard, filter, copy, move, and delete it.
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Statistics Map report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Statistics Map report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Statistics Map report element.

You can manage and customize your Statistics Map report element by using the following sections in the 
left pane: 
• Report Element
• Appearance
• Data
• Displayed Values
• Embed Report Element

Report Element
In the Report Element section, you can show or hide the heading, text, and description of the selected 
question.
The Statistics Map properties include the following sections:
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The element is 

updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type the text in the edit box and 

customize its font size and style. You can select the color of caption text from the Foreground 
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Color, and background color from the Background Color menus. To check the spelling, click 
Spell Check.

Appearance
In the Appearance section, you can specify the look and feel of the element. 
The appearance settings can change according to different report themes.
The following properties are available:
• Background Color – Select the background color of the map.
• Gradient End Color – Select the gradient color for the uppermost area of the element.
• Border Color – Select the color of the border of the element.
• Border Width – Adjust the width of map borders (in pixels).
• Border Radius – Change this value to increase or decrease the roundness of border corners in 

your respondent map element.
• Series Colors – Click this button to select a theme for the series in your pie chart from the Series 

Colors dialog box and a color for each data point.
• Show Legend – Select this check box to display the legend on the right side of the statistics map. 

This check box is selected by default.
• Legend Location - In the Legend Location list, click the needed legend location (top, bottom, 

left, or right).
• Size Charts Automatically – Select this check box to make the respondent map element fit the 

current window size automatically.
• Width – Set the width of the respondent map element (in pixels).
• Height – Set the height of the respondent map element (in pixels).

 The Width and Height options become available if you clear the Size Charts Automatically 
check box.

To apply changes to all Statistics Map elements in your report, click the Apply All button.

Data
The Data section contains the following options:
• Reverse Order – View the values in an opposite order.
• Decimal Places – Define the decimal places for the values in the report element.
• Range of Top Group – Define the number of choice items to be combined when generating the 

top group calculation. The default value is 18%. The top map calculation can be set to 1, 2, or 3 
choices. For example, if the top is set to 2 on a ten-point scale, all responses of 9 and 10 are 
combined.

• Range of Bottom Group – Define the number of choice items to be combined when generating 
the bottom group calculation. The default value is 62%. The bottom map calculation can be set to 
1, 2, or 3 choices. For example, if the bottom is set to 6 on a ten-point scale, all responses of 1, 2, 
3, 4, 5, and 6 are combined.
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To apply changes to all Statistics Map elements in your report, click the Apply All button.

 The range of Top and Bottom groups cannot be negative or overlap.

Displayed Values
In the Displayed Values section, you can select the report metrics to be displayed on the map. By 
default, Mean is selected. Hover over the map element to view a tooltip with the selected metrics.

 Metrics selected from the menu are used as a source for displaying colors on the map. Metrics 
selected in check boxes are only displayed in the element tooltip.

The following metrics are available:
• Minimum – The minimum value (question choice) selected by the respondents.
• Maximum – The maximum value (question choice) selected by the respondents.
• Range – The difference between the largest and smallest data point.
• Sum – The total value of all responses.
• Mean – The sum of values divided by the number of values that is an average value.
• Median – The numerical value in the center after ordering all the values. It has an equal number 

of values below and above it.
• Mode – The value representing the highest frequency.
• Variance – The spread of the data around the mean.
• Total Responses – The total number of responses.
• Valid Responses – The number of valid responses.
• Top – The top group of responses.
• Neutral – The neutral group of responses.
• Bottom – The bottom group of responses.
• Net Score – The net score calculation. For more information, see Net Score in Statistics Map, 

page 750.

Embed Report Element
In the Embed Report Element section, you can generate a code snippet and URL to use the Statistics 
Map report element outside of the EFM application. For example, you can place it into an IFrame on 
custom webpage. The HTML code of the report element is generated automatically. You can also 
configure the width and height of the Statistics Map element by editing the code snippet in an HTML or 
text editor.
For more information, see Manage Embed Report Element, page 970 and Publish widget to URL, 
page 972. 
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 For the Statistics Map and Respondent Map report elements, the drill-down within continents 
and countries is unavailable in embedded report element.
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Add Statistics Map report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Statistics Map report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Statistics Map report element.

With the Statistics Map report element, can view the geographical distribution of the specific metrics 
based on responses to the selected survey question.
The Statistics Map displays the respondents spread geographically: by the world, by continent, and by 
country/state. The following countries support the drill-down within a country: USA, Canada, United 
Kingdom, Germany, Australia, and New Zealand. For example, if there are respondents from different 
states of USA, you can view them distributed by their states.

 For the responses from the United Kingdom, clicking on England, Wales, Northern Ireland, or 
Scotland drills down to the next regional level.

The Statistics Map report element can include information based on the following questions:
• Choose One
• Choose One with Image
• Scrolling Matrix
• Matrix Choose One
• Scale Slider
• Drag & Drop Rank Order
• Rank Order
• Short Answer (Whole Number and Real Number)
• Fill in the Blank (Whole Number and Real Number)

Procedure 
1 In the Add a Report Element area, click the Statistics Map report element.
2 In the Select data for your report element dialog box, click the Data Source survey link, and then 

select the source survey and the needed question for the statistics map.
3 Click Add.

4 To view the statistics for specific locations on the map, click the locations or use zoom in  and 

zoom out  buttons.
5 To change the element properties, use the element editor in the left pane. 

For more details, see Statistics Map report element, page 833.
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6 To manage your Statistics Map, use the toolbar in the upper-left corner of the Statistics Map 
dialog box. 
You can add your Statistics Map to dashboard, filter, copy, move, and delete it.
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Campaign Statistics report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports side tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Campaign Statistics report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Campaign Statistics report element.

You can manage and customize your Campaign Statistics report element by using the following sections 
in the left pane:
• Report Element
• Appearance
• Displayed Values
• Embed Report Element

Report Element
In the Report Element section of the Campaign Statistics element, you can show or hide the element 
text, description, and caption.
The Campaign Statistics properties include the following sections:
• Chart Type – The selected report element type.
• Labels – The customizing properties. Use this section to customize the following properties:

• Show Element Text - Select the check box to show the element text.
• Show Element Description - Select the check box to show the element description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type the text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
in the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
In the Appearance section of the Campaign Statistics element, you can change the look and feel of 
the element.
There are the following Appearance properties:
• Chart Type – Select the chart type for your report element. The default value is Pie and it is not 

editable.
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• Background Color – Select the background color of the element .
• Gradient End Color – Select the gradient color for the uppermost area of the element.
• Border Color – Select the border color  of the element.
• Border Width – Adjust the width of campaign statistics borders (in pixels).
• Border Radius – Increase or decrease the roundness of border corners in your element.
• Series Color – Click the button to select a theme for the series in your pie chart from the Series 

Palette dialog box and a color for each data point.
• Show Legend – Display the legend on the campaign statistics. This check box is selected by 

default.
• Legend Location - In the Legend Location list, click the needed legend location (top, bottom, 

left, or right).
• Show Grid Lines - Clear this check box to hide the grid lines on the chart background. Show Grid 

Lines check box is available for Bar and Column chart types. If you clear the Show Grid Lines 
check box, the grid lines disappear in the preview, test, and design modes.

• Label Rotation Angle – Define the label rotation angle (in degrees).
• Maximum Characters – Define the maximum number of characters for the labels on your 

campaign statistics element.
• Size Charts Automatically – Fit the element to the current window size automatically.
• Width – Set the width of the campaign statistics element (in pixels).
• Height – Set the height of the campaign statistics element (in pixels).

 The Width and the Height options become available if you clear the Size Charts 
Automatically check box.

 

Several Appearance properties can be assigned throughout the report with the report theme.
To apply changes to all Campaign Statistics elements in your report, click the Apply All button.

Displayed Values
The Displayed Values properties include a set of values that appear on the campaign statistics element 
if you select the corresponding check boxes.
• Label – Data label that provides details on a particular data point on the Pyramid chart type.

 The Lable option is active only when the Pyramid chart type is selected. The Pyramid chart type 
uses highcharts-labels and highcharts-data-label to show labels, values, and percents on the 
chart.

• Value – Number of participants for each campaign status.
• Percent – Percentage of participants for each campaign status.
To apply changes to all Campaign Statistics elements in your report, click the Apply All button.
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Embed Report Element
In the Embed Report Element section, you can generate a code snippet and URL to use the Campaign 
Statistics report element outside of the EFM application. For example, you can place it into an IFrame on 
custom webpage. The HTML code of the report element is generated automatically. You can also 
configure the width and height of the Campaign Statistics element by editing the code snippet in an 
HTML or text editor.
For more information, see Manage Embed Report Element, page 970 and Publish widget to URL, 
page 972.
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Add Campaign Statistics report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Campaign Statistics report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Campaign Statistics report element.
 

With the Campaign Statistics report element, you can add a chart of your survey campaign status to 
your report.
The campaign status is displayed as a pie chart for total participants with sectors for different participant 
statuses. Hover over the status on the pie chart to view the count and percentage of participants that 
represent it. The Campaign Statistics report element shows the following participant statuses: Sent (or 
In Queue), Confirmed Received, Started, Undeliverable, Completed, Bounced Back, Unsubscribed, 
Branched Out, and Over Quota (for definitions of the statuses, see Participant status, page 584).
You can add the Campaign Statistics element to your report either in the Add a Report Element left 
pane or on the Add menu.

 The Campaign Statistics report element is not applicable to the Profile reports.
 

Procedure 
1 In the Add a Report Element area, click the Campaign Statistics report element.
2 In the Select data for your report element dialog box, select the survey.

 The Campaign Statistics report element is calculated only for the surveys that have Open or 
Closed status.

 

3 Click Add.
4 To change element properties, use the element editor in the left pane. 

For more details, see Campaign Statistics report element, page 839.
5 To manage your Campaign Statistics, use the toolbar in the upper-right corner of the Campaign 

Statistics dialog box. You can add a Campaign Statistics to dashboard, filter, copy, move, or delete 
it.

 The Campaign Statistics element is added to the Executive Summary Report by default. When 
you create the Executive Summary Report, campaign statistics automatically appears as the first 
element on the first page of the report.
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Gauge report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Gauge report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Gauge report element.

With the Gauge report element, you can view your scale-based questions as a gauge. The gauge element 
is divided into three segments. You can customize your gauge element by selecting the color and width 
for each segment.
You can create the Gauge element by using the following questions:
•  Choose One
• Fill in the Blank (Numeric)
• Matrix with Choose One
• Fill in the Blank (Numeric)
• Choose One with Image
• Scale Slider
The Gauge report element differs in displaying results for some question types:
• For the Choose One questions, the left part of the gauge is the first choice value (1) with the label 

and the right part of the gauge is the last choice value (n) with the label. The pointer shows the 
mean of all responses value for the question.

• For the numeric questions, the left part of the gauge is the lowest numeric value of all response 
data and the right part of the gauge is the highest numeric value of all response data. The pointer 
shows the mean of all responses value for the question.

You can add the Gauge element to your report either in the Add a Report Element left pane or on the 
Add menu.
After inserting the gauge element into your report, the element editor panel to the left shows a number 
of collapsible menus, including:
• Report Element
• Appearance
• Data
• Displayed Values
• Segments
• Embed Report Element

Report Element
In the Report Element section of the Gauge element, you can select a base question for the element 
and show or hide the question text, description, and caption.
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The Report Element properties include the Type, Question, Labels, and Caption sections.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change the question. The gauge 

element is updated to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Report Values - Select the check box to display the report values on your report element.

• Show Source Citation - Select the check box to display the element data source if the report 
uses more than one data source.

• Caption – A brief description below your report element. Type the text in the edit box and 
customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
In the Appearance section, you can change the look and feel of the gauge element in your report. The 
section provides a number of customization properties.
• Background Color – Select the background color for the gauge scale from the palette.
• Border Color – Select the color for the border of the gauge element from the palette.
• Border Width – Adjust the width of borders in your gauge element in pixels.
• Border Radius – Change this value to increase or decrease the roundness of border corners in 

your gauge element.
• Maximum Characters – Set the maximum number of characters for the labels on your gauge 

element.
• Size Charts Automatically – Select this check box to make the gauge element fit the current 

window size automatically.
• Width – Set the width of the gauge element in pixels.
• Height – Set the height of the gauge element in pixels.

 The Width and the Height options become available if you clear the Size Charts 
Automatically check box.

Several Appearance properties can be assigned throughout the report with the report theme.
To apply changes to all Gauge elements in your report, click the Apply All button.
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Data
In the Data section, you can control the sort order and decimal places displayed in the gauge element. 
The section includes options to manage the content in your Gauge element. 
• Reverse Order – Use this check box to view the values in an opposite order. You can use this 

option together with the net score. Select the Net Score radio button in the Displayed Values 
section.

• Decimal Places – Use this text box to set the number of decimal places for the values on the 
gauge element.

To apply changes to all Gauge elements in your report, click the Apply All button.

Displayed Values
The Displayed Values properties include a set of values that appear on the gauge element if you select 
the corresponding radio buttons.
• Mean – Select this radio button to show the sum of values divided by the number of values 

(average value).
• Net Score – Select this radio button to show the difference between the top and bottom items of 

a rating scale, which reflects the customer's satisfaction.

 For the Net Score, the gauge range is set from -100 to 100.

• Median – Select this radio button to show the numerical value in the center after ordering all the 
values. It has an equal number of values below and above it.

• Mode – Select this radio button to show the value representing the highest frequency.
To apply changes to all Gauge elements in your report, click the Apply All button.

Segments
In the Segments section, you can set the look of the segments of your gauge element, selecting the color 
and width for each segment. 
The section is divided into three sections – Segment 1, Segment 2, and Segment 3  – each providing 
segment width and color properties. See description below.
• Segment End – Set the width of the segment.
• Color – Select the color for the segment from the palette.
Segment 3 has only the Color property as its width is determined by the Segment End property of the 
Segment 1 and Segment 2 sections.

Embed Report Element
You can embed a Gauge element into a custom page to share your report results outside of the product 
by generating a code snippet and URL to embed the Gauge report element into external applications.
The functionality is available in the Embed Report Element section in the report designer.
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 You cannot drill down into the embedded gauge element to view responses.

You can use the code snippet to place the Gauge report element into a custom page. The HTML code of 
the report element is generated automatically for you. You can also configure the width and height of the 
gauge element by editing the code snippet in an HTML or text editor.
You can use the URL to place the Gauge report element into an IFrame on a custom page. The URL of 
the report element is generated automatically for you. You can also configure the width and height of the 
gauge element on your custom page.
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Add Gauge report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports side tab > create a new report or open an existing one >  Add a Report Element 
panel > add the Gauge report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Add a Report Element panel > add the Gauge report element.

You can add the Gauge report element to the report either in the Add a Report Element left pane or on 
the Add menu. 

Procedure 
1 In the Add a Report Element area, click the Top Box report element. 
2 In the Select data for your reportelement dialog box, in the Questions menu,  select the source 

question.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

3 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Bar Chart Organization Cross tab element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one >  Organization Report 
Elements panel > add the Bar Chart Organization Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one >  Organization Report Elements panel > add the Bar Chart Organization Cross-tab report 
element.

With the Bar Chart Organization Cross-tab report element, you can view the hierarchy in cross-tab 
report that shows the response mean in the form of the bar with the percentage.
When adding a new report element, you can choose to view the results by organizations or employees. If 
you choose the view by an organization, the results gathered from all the child organizations that belong 
to the main organization are also added to the report. If you choose the view by employees, the results 
gathered from all the employees that belong to the selected organization are included to the report.
You can add the Bar Chart Organization Cross-tab report element to the report based on a survey, 
profile, or data set that contains the External ID System Question. Only organizations and employees that 
have associated data for the report scope are included in the report.
When you add the Bar Chart Organization Cross-tab element to your report, the element editor panel 
to the left shows a number of collapsible menus including:
• Report Element
• Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Question, Broken Down By, Labels, and Caption 
sections, providing a number of customization properties.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The Bar Chart 

Organization Cross-tab element is updating to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Broken Down By – The breaking-down organization. The Broken Down By menu shows the 
organizations to which user has access. The Bar Chart Organization Cross-tab element 
updates to show data from the newly selected organization. You can view the results by users or 
organizations by selecting the corresponding option.

• Labels – The customizing properties. Use this section to customize the following properties:
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• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type your text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
The Appearance properties include the Row and Header sections, both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows  from a palette.
• Text Color – Select the text color for data or header rows  from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select  web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.
• To apply changes that you made to the Appearance properties, click Apply All.

 Several Appearance properties can be assigned throughout the report with the report theme.

Data
The Data properties include the Decimal Places option. Use this text box to define the decimal places 
for the values that the bar chart cross-tabulation shows.
To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain a set of values that appears in the Bar Chart Organization 
Cross-tab element if you select the corresponding check boxes.
• Question Count – Select this check box to view the total number of responses for the selected 

question in your report.
• Mean – Select this check box to show the sum of values divided by the number of values (average 

value).
• Values – This option shows the percentage of the response choices selected by respondents.
• Bars – This option shows the bar with the percentage of the response choices selected by 

respondents.
To apply changes that you made to the Displayed Values properties, click Apply All.
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Add Bar Chart Organization Cross-tab report 
element

Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Organization Report 
Elements panel > add the Bar Chart Organization Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Organization Report Elements panel > add the Bar Chart Organization Cross-tab report 
element.

You can add the Bar Chart Organization Cross-tab report element to the report either in the  
Organization Report Elements left pane or on the Add menu. 

Procedure 
1 In the Organization Report Elements area, click the Bar Chart Organization Cross-tab element. 
2 In the Select data for your report element dialog box, in the Questions menu,  select the source 

question.
3 In the Select Organization list, define the organization.
4 Select the Organizations or Users option to view the results by organizations or users.

 You can select another source for your report element in the left pane of the dialog box. To 
search for the specific survey, type a partial or whole survey name in the search box, and then 
click the Search button. The list of surveys that match your input displays.

 

5 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Top Box Organization Cross-tab element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Organization Report 
Elements panel > add the Top Box Organization Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Organization Report Elements panel > add the Top Box Organization Cross-tab report 
element.

With the Top Box Organization Cross-tab report element, you can view the top box cross-tabulation of 
the responses gathered by organizations.
When adding a new report element, you can choose to view the results by organizations or employees. If 
you choose the view by an organization, the results gathered from all the child organizations that belong 
to the main organization are also added to the report. If you choose the view by employees, the results 
gathered from all the employees that belong to the selected organization are included to the report.
You can add the Top Box Organization Cross-tab report element to the report based on a survey, 
profile, or data set that contains the External ID System Question. Only organizations and employees that 
have associated data for the report scope are included in the report.
When you add the Top Box Organization Cross-tab element to your report, the element editor panel 
to the left shows a number of collapsible menus including:
• Report Element
• Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Question, Broken Down By, Labels, and Caption 
sections, providing a number of customization properties.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The Top Box 

Organization Cross-tab element updates to show data from the newly selected question.
• Broken Down By – The breaking-down organization. The Broken Down By drop-down list 

shows the organizations that the user has access to. The Top Box Organization Cross-tab 
element updates to show data from the newly selected organization. You can view the results by 
users or organizations by selecting the corresponding option.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question  and Broken Down By menus. For more information, see Map 
survey or profile to file import, page 582.

• Labels – The customizing properties. Use this section to customize the following properties:
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• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type your text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
The Appearance properties include the Row and Header sections both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows from a palette.
• Text Color – Select the text color for data or header rows from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select web-compatible font sizes for data and header text.
To apply changes that you made to the Appearance properties, click Apply All.

 Several Appearance properties can be assigned throughout the report with the report theme.

Data
The Data properties include the following options:
• Reverse Order – Use this check box to view the values in an opposite order.
• Decimal Places – Use this text box to define the decimal places for the values that the top box 

cross-tabulation shows.
• Range of Top Group – Use this text box to define the number of choice items to be combined 

when generating the top box calculation. The default is set to the top 2. For example, on a five-
point scale all responses of 1 and 2 will be combined. The top box calculation can be set to 1, 2, or 
3 choices.

• Range of Bottom Group – Use this text box to define the number of choice items to be 
combined when generating the bottom box calculation. The default is set to the bottom 2. For 
example, on a five-point scale all responses of 4 and 5 will be combined. The bottom box 
calculation can be set to 1, 2, or 3 choices.

To apply changes that you made to the Data properties, click Apply All.



Report Element Types Top Box Organization Cross-tab element

EFM User Guide 853

Confidential and Proprietary Information of Verint Systems Inc.

Displayed Values
The Displayed Values properties contain a set of values that appears in the Top Box Organization 
Cross-tab element if you select the corresponding check boxes.
• Question Count – Select this check box to view the total number of responses for the selected 

question in your report.
• Top – The number of the responses in the top choice group.
• Neutral – The number of the responses in the neutral choice group.
• Bottom – The number of the responses in the bottom choice group.
• Percent of Row Total – This option shows the percentage in addition to the number of 

responses for each response choice.
• Bar Chart Labels – Select this check box to show the percentage labels on responses bar chart.
To apply changes that you made to the Displayed Values properties, click Apply All.
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Add Top Box Organization Cross-tab report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Organization Report 
Elements panel > add the Top Box Organization Cross-tab report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Organization Report Elements panel > add the Top Box Organization Cross-tab report 
element.

You can add the Top Box Organization Cross-tab report element to the report either in the  
Organization Report Elements left pane or on the Add menu. 

Procedure 
1 In the Organization Report Elements area, click the Top Box Organization Cross-tab element. 
2 In the Select data for your report element dialog box, in the Questions menu,  select the source 

question.
3 In the Select Organization list, define the organization.
4 Select the Organizations or Users option to view the results by organizations or users.

 You can select another source for your report element in the left pane of the dialog box. To 
search for the specific survey, type a partial or whole survey name in the search box, and then 
click the Search button. The list of surveys that match your input displays.

 

5 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.



Report Element Types Organization Cross-tab Table element

EFM User Guide 855

Confidential and Proprietary Information of Verint Systems Inc.

Organization Cross-tab Table element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Organization Report 
Elements panel > add the Organization Cross-tab Table report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Organization Report Elements panel > add the Organization Cross-tab Table report element.

With the Organization Cross-tab Table report element, you can view the hierarchy in cross-tab report 
showing each response in a table.
When adding a new report element, you can choose to view the results by organizations or employees. If 
you choose the view by an organization, the results gathered from all the child organizations that belong 
to the main organization are also added to the report. If you choose the view by employees, the results 
gathered from all the employees that belong to the selected organization are included to the report.
You can add the Organization Cross-tab Table report element to the report based on a survey, profile, 
or data set that contains the External ID System Question. Only organizations and employees that have 
associated data for the report scope are included in the report.
When you add the Organization Cross-tab Table element to your report, the element editor panel to 
the left shows a number of collapsible menus including:
• Report Element
• Appearance
• Data
• Displayed Values

Report Element
The Report Element properties include the Type, Question, Broken Down By, Labels, and Caption 
sections, providing a number of customization properties.
• Type – The selected report element type.
• Question – The source question. Use the Question menu to change a question. The 

Organization Cross-tab Table element updates to show data from the newly selected 
question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Broken Down By – The breaking-down organization. The Broken Down By menu  shows the 
organizations to which the user has access. The Organization Cross-tab Table element updates 
to show data from the newly selected organization. You can view the results by users or 
organizations by selecting the corresponding option.

• Labels – The customizing properties. Use this section to customize the following properties:
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• Show Question Heading - Select the check box to show the question heading.
• Show Question Text - Select the check box to show the question text.
• Show Question Description - Select the check box to show the question description.
• Align Question Text and Description - Select the needed option from the list to align the 

question text and description.
• Show Source Citation - Select the check box to display the element data source if the report 

uses more than one data source.
• Caption – A brief description below your report element. Type your text in the edit box and 

customize its font size and style. You can select the color of caption foreground and background 
from the Foreground Color and Background Color menus. To check the spelling, click Spell 
Check.

Appearance
The Appearance properties include the Row and Header sections both providing a number of 
customization properties.
• Color – Select the background color for the data or header rows  from a palette.
• Text Color – Select the text color for data or header rows  from a palette. It is recommended that 

contrasting color selections be made when changing the color and text color settings.
• Font Name – Select web-compatible fonts for data and header text.
• Font Size – Select of web-compatible font sizes for data and header text.
To apply changes that you made to the Appearance properties, click Apply All.

 Several Appearance properties can be assigned throughout the report with the report theme.

Data
The Data properties include the Decimal Places option. Use this text box to define the decimal places 
for the values that the cross-tabulation shows.
To apply changes that you made to the Data properties, click Apply All.

Displayed Values
The Displayed Values properties contain a set of values that appears in the Organization Cross-tab 
Table element if you select the corresponding check boxes.
• Count – Select this check box to view the number of responses for each response choice and total 

number of responses for the selected question in your report.
• Percent of Row Total – This option shows the percentage in addition to the number of 

responses for each response choice.
• Bars – This option shows the bar with the count for each response choice.
To apply changes that you made to the Displayed Values properties, click Apply All.
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Text report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Add Other Content panel > 
add the Text report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add Other Content panel > add the Text report element.

The Text Element feature enables you to insert text into a report. You can add a Text Element by clicking 
the Text button in the Add Other Content section on the Analyze tab. Enter text and format it by 
using the editing toolbar. 
The edit box provides you with a number of editing options. Standard options include:
• Font Size
• Bold
• Italic
• Underline
• Font Color
• Background Color
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Add Text report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Add Other Content panel > 
add the Text report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add Other Content panel > add the Text report element.

You can add the Text report element to the report either in the Add Other Content left pane or on the 
Add menu. 

Procedure 
1 In the Add Other Content area, click the Text element.
2 In the Report Element section, enter text into the edit box. 
3 Customize your text by using the editing toolbar.

 Your text element appears in the right content area in real time. To delete the text element, hover 

your pointer over the Text element in the right content area, and then click the  icon.
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Question report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Add Other Content panel > 
add the Question report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add Other Content panel > add the Question report element.

You can add a specific survey question to your report. You can add the Question element to the report 
either in the Add Other Content left pane or on the Add menu. 
When you add the question element into your report, the element editor panel to the left shows the 
Report Element collapsible menu. The Report Element properties include the Type, Question, and 
Caption sections.
• Type – Shows the selected report element type.
• Question – Shows the survey question added to the report. Use the Question menu to change 

a question. The question element updates to show data from the newly selected question.

 If the data channel is defined for the survey, the columns from the corresponding file import are 
also available  in the Question menu. For more information, see Map survey or profile to file 
import, page 582.

• Caption – Shows a brief description below your report element. Type your text in the edit box 
and customize its font size and style. You can select the color of caption foreground and 
background from the Foreground Color and Background Color menus. To check the spelling, 
click Spell Check.
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Add Question report element
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > Add Other Content panel > 
add the Question report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > Add Other Content panel > add the Question report element.

You can add the Question element to the report either in the Add Other Content left pane or on the 
Add menu.

Procedure 
1 In the Add Other Content area, click the Question element.
2 In the Select data for your report element dialog box, in the Questions menu,  select the source 

question.

 You can select another source for your report element by using the Data Source option at the 
top of the dialog box.

 

3 Click Add. 
The element editor opens in the left pane, and the element appears in the right pane. You can change 
the element properties in the element editor.
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Showing report values
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Reports tab > create a new report or open an existing one > add a report element.

OR

Report & Analyze tab > Project Reports tab > Reports page > create a new report or open an existing 
one > add a report element.

You can view the report values on your report elements to better understand how the values are 
calculated.
If you set the report values for choices when designing a survey, they can be displayed on your report 
elements later on the analyze stage. This option is applicable to all questions that support the Report 
Value option. You can activate this option by selecting the Show Report Values check box on the 
Report Element menu. This option is active by default.
The Show Report Values option is available for the following report elements:
• Frequency Table
• Frequency Chart
• Summary Table
• Summary of Means
• Cross-tab
• Cross-tab Chart
• Top Box Cross-tab
• Gauge
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Report Viewer Grid
Navigation

Log into the product as a report viewer > Report & Analyze tab > Project Reports tab > Reports page. 
You can share your saved reports with other users giving them the view access to your reports. With a 
Report Viewer as a security role, you can view the reports shared with you on the Reports page.
When you log in as a Report Viewer, the Reports grid shows the saved reports to which you have access.
The following columns are available on the Reports page:
• Report Title – Name of a report. Click the report name to view the report.
• Primary Source – Name of the project (survey or profile) to which the report belongs.
• Source Type – Project type (survey or profile)  to which the report belongs.
• Owner – The user  to whom the report belongs.
• Last Modified – The last time when the report was changed.
• Published – The publishing status of the report.

 You can open multiple reports at the same time with each report in a new window.

By default, the Reports grid shows the first 10 reports. To view more saved reports per page, use the 
View per Page option at the bottom of the Reports grid. Select the 25, 50, or 100 link to display more 
saved reports. In addition, if the Reports grid is longer than one page, you can navigate between the 
pages using the navigation arrows in the lower-right corner.

Searching for a report
To search for a report from the Reports grid, enter the name, source, or owner of the report in the 
Search text box on the toolbar, and then click Search next to the text box. The results of the search 
appear in the grid with the corresponding notification. You can click the Clear link to cancel the search 
parameters and view all reports.

View a report

Procedure 
1 In the Reports grid, click the report you want to view. The report preview window opens.

 The navigation and exporting options available on the title bar depend on individual viewer rights 
based on assigned user role.

2 Navigate through the report pages by clicking the Previous Page and Next Page buttons or the 
Page # menu. If report pages are renamed, the Page # menu contains those names.

3 To export the report data to the Microsoft Word, Microsoft PowerPoint, or Adobe PDF format and 
create a cluster report to view the report results outside the product,  click the Download Report 
menu.
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 For the steps on how to download the reports, see Downloading reports, page 1012 and Cluster 
Reports, page 1013.
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Report Viewer Filters
Navigation

Log into the product as a report viewer > Report & Analyze tab > Project Reports tab > Reports page. 
A report viewer can see the filter defined by the report author to know how the report is filtered. Report 
viewers cannot remove the filter set by the report author. They can create and remove their own filters.
There are two filter types:
• Filter Using – Shows the filter created by the report author. It is the primary filter on the report.
• Report Viewer Filter – Shows the filter created by the report viewer. Any filter defined by the 

report viewer appears on top of the existing filter.
The applied filters merge together and show data that meets all defined criteria.

 The filters are defined at the report level, not at the report element level.

Create a filter

 Report viewers can create filters for the report if report authors activate this functionality for 
them when sharing the report.

Procedure 
1 On the Reports page, click the name of the report that you want to filter. The report opens in a new 

window.
2 On the toolbar, click  the Filter Report Data button. 
3 In the Filter Report Data dialog box, in the question list, select the survey question by which you 

want to filter the report data.
4 Select the appropriate expression in the  list.
5 In the value  list, select the response choice by which you want to filter.
6 To save the filter criteria, click the Save link.

 Click the Add Another Criteria link to add more criteria.

7 Click OK. 

Remove a Filter

Procedure 
1 On the Reports page, click the name of the report.
2 Click the Clear link next to the filter that you want to remove.

 Report viewers cannot remove the filter defined by the report author.
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Activating Filters for Report Viewers
Navigation

Report & Analyze tab > Survey Reports tab > Reports page > select a report > Share menu > Select 
Other Users option.  
Report authors can define whether a report viewer can filter the shared report. When sharing a report 
with other users, a report author can select the Allow report viewers to filter the data being shared 
with them check box to turn the filtering on for the report viewers. By default, this check box is clear.
When filtering is activated, the Filter Report Data button is available for report viewers when they view 
a report. Report viewers can create and remove their own filters, but they cannot remove the filter set by 
the report author.
The filters are defined at the report level. So, when the report author activates the filtering functionality, 
the filtering is turned on for all the report viewers with whom the report is shared. If you, as a report 
author, want to share the same report with other users, but not allow them to filter your report, you need 
to copy the report, and then share it without selecting the Allow report viewers to filter the data 
being shared with them check box.

Activate a filter for report viewers

Procedure 
1 On the Reports page, select the check box next to the report that you want to share.
2 On the Share menu, click Select Other Users. The report sharing dialog box opens.
3 In the Select Users dialog box, in the Users section, select the name of the user with whom you 

want to share your report.
4 Click the right double arrows button to allow this user to view your report. 

The user name is moved to the View Access section.
5 To activate the filter for the selected users, select the Allow report viewers to filter the data 

being shared with them check box.
6 Click OK.

 Report viewers can filter the shared report using the Filter Report Data button.
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Images side tab
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports page > Images side tab.
Use the Images side tab to view, sort, size, delete, and rate images uploaded by respondent when 
answering the Image Upload question.

 The Images side tab is available only if the survey contains the Image Upload question.

On the toolbar the following options are available:
• View – Use this menu to select images that you want to view on the Images page. For example, 

you can select to view all images or those images that are the answers to certain questions.
• Sort – Use this menu to specify the order in which images will be displayed on the Images page. 

You can sort images by rate or by date.
• Size – Use this slider to view and change the thumbnail size for images (you can select one of ten 

available values).
You can specify what thumbnail details will be displayed or delete the selected response images by using 
the Actions menu. For more information, see Define thumbnail details, page 869 and Delete images, 
page 870.
You can view up to 120 thumbnails on the Images page. If there are more than 120 images uploaded by 
the respondent, the Show More Images button appears. After clicking this button, other image 
thumbnails are displayed.

 When the respondent uploads the image, it is resized to 725 × 725 pixels and is converted to .jpg 
format. The size of a thumbnail is 256 × 256 pixels.

You can rate the thumbnails on the Images page by clicking the corresponding rate on the thumbnail. To 

remove the rating, click the  icon.
You can filter images according to their rate, by clicking the needed rate in the Rating scale and by clicking 
one of the following values in the  menu: and Higher, and Lower, or Exactly. To filter images according 
to their tags, type the tag name or part of the tag name in the Tags text box, and then click Search.

 The rating option is not editable if the Edit Responses permission is not activated for your user 
role.

Upon clicking   on the image, the Image dialog box opens, where you can view the image itself, date it 
has been uploaded, location it has been taken at, and tags added to the image. You can also download 
the image by clicking the Download Image link, rate the image, and change the rating previously added 
to the image. 
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Define thumbnail details
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports page > Images side tab > Actions menu > Details option > Thumbnail 
Details dialog box.
 

Select the following check boxes in the Thumbnail Details dialog box to define what specific details to 
display on the Images side tab:
 

• Image – Select this option to view the thumbnail name.
• Date – Select this option to view the date when the response image was downloaded.
• Rating – Select this option to rate thumbnails and to view the existing rates.

Before you begin 
• Verify that respondents uploaded images to answer the Image Upload question in your survey.

Procedure 
1 From the Analyze tab, navigate to the Reports page.
2 In the left pane, click the Images side tab.
3 On the Actions menu, click the Details option.
4 In the Thumbnail Details dialog box, select the information to be shown in each thumbnail on the 

Images side tab.

 If you change the thumbnail size after defining its details, this thumbnail defaults to the original 
view.
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Delete images
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports page > Images side tab.
 

You can view and delete the response images from the Images side tab. The response images will be also 
deleted from the Response Manager grid. 

Procedure 
1 From the Analyze tab, navigate to the Reports page.
2 In the left pane, click the Images side tab.
3 On the Images page, choose the image thumbnail you want to delete by selecting the check box or by 

clicking anywhere on the thumbnail. 
4 On the Actions menu, click Delete. 
5 In the confirmation dialog box, click Delete. 

 The Delete option is not available if the image you want to delete is not selected or if the Edit 
Responses permission is not activated for your user role.
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Filtering images
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports page > Images side tab > Filter option.
You can filter the collected images based on the respondent information to view the certain results only. 
You can apply the Data, Date, and Other filters to the images.

Data filter
The Data filter is based on questions and columns. In the Data Filter section, click the Add Another 
Criteria link to specify the following:
• Source – Click the My Survey link, and then click Current Survey to make questions from the 

survey available as criteria or click Columns to make the Participant Information or 
Respondent Location data from the Response Manager available as criteria.

• Filter parameter – In the menu, click the question or column by which you want to filter your 
images.

• Expression – In the menu, click the expression to make a comparison between Filter parameter 
and Value. The options depend on the Filter parameter.

• Value – In the menu, click the response choice for comparison. The options depend on the 
question type and column.

 You can save the filter criterion by clicking the Save link, or remove and move up or down the 
filter criterion by clicking the corresponding buttons.

You can have a combination of the Current Survey and Columns filtering criteria. If you add multiple 
criteria, you can combine them using the following Match options:
• All Criteria – All the criteria are met.
• At Least One Criterion – At least one of the criteria is met.
• Advanced – Select the parentheses and the And or Or to define that one of the filters linked 

together is true and to define that two or more filters are true for the responses included in the 
report correspondingly.

 The Add Another Criteria link is available if you have at least one type of question different 
from the Image Upload question type.

Date Filter
The Date filter is based on the date responses were last modified and on the period of time they were 
created. In the Date Filter section, the following options are available:
• Select Date Field – Select an option on the Select Date Field  menu to filter responses based on 

the date they were created. The following options are available:
• None – No date filters.
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• Started Date – Based on the date the survey was started.
• Modified Date – Based on the date the survey was last changed.
• Completed Date – Based on the date the survey was submitted.

• Time Period – Select an option on the Time Period  menu to filter the responses created during a 
certain period of time.

 If you want to set the default values for the Date Filters, click the Clear All Date Filters link.

Other
The Other filter is based on whether the survey is completed or not. Select the Only show completed 
responses check box to include only completed responses.
Click OK to save the filters criteria. After that, you can view the filters criteria on the Images page. You 
can edit the Filter Response Data dialog box by clicking the edit link and you can clear the filters criteria 
by clicking the clear link.
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Export images
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Analyze tab > Reports page > Images side tab.
 

You can export images from the Images side tab, and then use them locally. Images are exported as full-
size .jpg files. You can export all images or select which images you want to export. Also, you can apply 
filter to the images to be exported.

 If an email address is associated with the participant who uploaded the image, the file name of 
the exported image is Record ID - Q# - Email Address.jpg; otherwise, the file name is Response ID 
- Q#.jpg.

Procedure 
1 On the Images side tab, click the Export button, or select this option on the Actions menu.
2 In the Export Images dialog box,  in the Images and Filter sections, select the needed options.

 The Current Filter is the filter defined by a user including rating and tag search.

3 Click Next. 
A link to the generated .zip file is displayed in the Export Images dialog box. Click the link to 
download the exported images.

 If export takes longer than the Email Confirmation for Long Processes time limit defined on 
the My Account page, you can close the Export Images dialog box. When images are exported, 
you will receive an email message with a link to the generated  .zip file.
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Advanced Text Analytics overview
Navigation

Design & Collect tab  > Surveys tab > My Surveys page > create a new survey or open an existing one > 
Analyze tab > Export Text Analytics button > Advanced Text page.

You can export the survey response data to the advanced text analytics as a new project to analyze 
respondents' sentiment based on their responses to the Essay questions in your survey. 

 You can perform advanced text analysis only after opening your survey.

The exported surveys are counted against your credits. Each answered Essay question is counted as one 
credit. Each survey can have multiple Essay questions. Also, every additional 2048 characters in the 
response is an additional credit.
Verbatim credits are valid for verbatim in size of 2048 characters or less. For any verbatim exceeding 
2048 characters, you need to purchase one additional credit per increment of 2048 characters. You are 
also re-charged for previously exported responses if additional Essay questions are selected or any 
changes are applied to the previously exported responses.

 You can export all question types to the Text Analytics, but advanced text analysis is performed 
for the Essay questions only.

On the Advanced Text page, the following sections are available:

• Login – Enter your user name and password for the Text Analytics in the corresponding fields.
• Project Name – The automatically generated name of your project based on the survey name 

and ID to guarantee uniqueness.
• Columns – Select the survey questions to export. 

The following options are available:
• All – The advanced text analysis is performed for all survey questions.
• Selected – You can select the questions that you want to export for advanced text analysis. 
To open the question selection dialog box, click Configure, and then select the check box next to the 
survey question that you want to export.

 To export all survey questions, select the check box next to the survey name.

 The Configure button is active only if the Selected option is selected.

• Schedule – Define the time to transfer the data for the advanced text analysis. Records that are 
modified after the initial export are updated. 
The following options are available:
• Do not update automatically – The new or modified responses are not exported to the Text 

Analytics automatically since the initial export.
• Update daily at – The new or modified responses are exported at scheduled time since the last 

update. The existing project in Text Analytics is updated. 
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To open the time picker, click the Time View icon  .

 Define the project updating schedule either using the text box or the time picker.

• Notify survey owner by email of task status – The survey owner receives daily notification 
via email when scheduled responses export is performed, when the option is selected.

The Advanced Text page

To open the Text Analytics login page in a new window, click Go to Advanced Text Analysis.
To save the defined set of exporting options, click Save.
To export the survey response data to the Text Analytics, click Export Now.
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Advanced Text Analytics–Export responses
Navigation

Design & Collect tab  > Surveys tab > create a new survey or open an existing one > Analyze tab > 
Export Text Analytics button > Advanced Text page.

You can export the survey response data to the advanced text analytics as a new project. 

 You can export all question types to the Text Analytics, but advanced text analysis is performed 
for the Essay questions only.

Procedure 
1 On the My Surveys page, create a new survey or open a saved one that contains the Essay 

questions. 
2 Go to Analyze tab > Choose How to Report on Your Survey page, and then click the Export Text 

Analytics button. 
3 On the Advanced Text page, define the export options for your project.
4 For the initial export, click Export Now.
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Advanced Text Analytics–Administrator control
Navigation

Configuration tab  > General tab.

The advanced text analytics permission and URL are provided by a system administrator only. 
Group administrators can control the workgroup members' access to the advanced text analytics.

 The Advanced Text Analytics feature is available only if you have a license for it and Advanced 
Text Analytics is enabled for a workgroup.

You can use the Batch Size option to control the number of records to be exported to the Text Analytics 
at one time. The export task is triggered each hour. If the Text Analytics job is not completed within an 
hour, you receive the following message: “Waiting for previous text analytics job to complete–system will 
retry in 1 hour”. 
To see the status of Text Analytics job, go to Administration tab >  System Tasks tab. 
The minimum batch size value is 500. The maximum batch size value is 100,000. The default value is 
100,000.
The advanced text analytics is available for all users having permissions to create reports.

 For details on the advanced text analysis, see Advanced Text Analytics–Export responses, 
page 877.

Enable Advanced Text Analysis for a workgroup

Procedure 
1 Go to Configuration tab > General tab.
2 In the Advanced Text Analytics section, clear the Disable Export for Text Analysis check box.
3 Specify the batch size value.
4 Click Save Setup.
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Text Analytics report elements overview
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new report > Report designer page > Add menu.

Respondents provide a lot of valuable feedback when answering the Essay questions in the survey. You 
can analyze all feedback and create statistic charts based on this data. With the Text Analytics report 
elements added to the EFM reporting functionality, you can view the analyzed verbatim responses for 
Essay and Matrix with Essay side questions. The data is broken down by top level categories, category 
leaves, terms, and relationships and shows a sentiment for each of them. 
Sentiment illustrates opinions, emotions, and attitudes associated with an element within an interaction, 
expressed through a word or phrase, from very positive to extremely negative. 
Sentiment types are represented as coefficients and range from positive to negative:
• Negative -5 to -0.5
• Neutral -0.4 to 0.4
• Positive 0.5 to 5

 If your Text Analytics data is not updated or used for more than 30 days, it is deleted due to 
inactivity.

You can add the following Text Analytics report elements:
• Sentiment Chart – Stacked bar chart that shows the sentiment breakdown by topic for a 

question.
• Sentiment Summary – Bar chart that shows the overall sentiment breakdown for the question.
• Sentiment Table – Table that shows the verbatim analysis results.
• Sentiment Trend Table – Table that shows the verbatim analysis results over the selected date 

range.
• Word Cloud – Set of words represented as a cloud that appears in different size and color, thus 

giving greater prominence to words that occur more frequently in the source text.
• Heat Map – A graphical representation of data that appears in different size and color. The size 

indicates volume of words that occur more frequently in the source text.
• Trend Chart – Chart that shows the top ten items as trend lines.

 The Text Analytics report elements are available only if you have a license for the Embedded Text 
Analytics.

A specific set of steps needs to be performed to get the analyzed data on these report elements.Text 
Analytics structures responses by identifying the categories and relationships between those categories 
and assigning the sentiment to them. The analyzed data is returned to the EFM application by Web 
Services and is represented in the report elements.
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The data structuring

 You can perform text analysis only after opening your survey.

Example: Data Structuring
I highly recommend the NY Standard – superior service. Fantastic rooms. Mind-blowing views! Book it!
• Top Level Categories: Room, Service, View
• Terms: highly, recommend, NY Standard, fantastic
• Relationships: Room > Impression, View > Reaction
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Text Analytics–Role-based access
Navigation

Administration tab > Roles tab.

A survey administrator can control if the workgroup members can add the Text Analytics elements to the 
report by creating a new role or editing the existing ones. By default, the Add Text Analytics Elements 
permission is enabled for all roles that have the report editing permission.

 This permission bit is available only if you have a license for the Embedded Text Analytics.

Activate the Add Text Analytics Elements functionality

Procedure 
1 On the Roles tab, click the name of the role that you want to edit.
2 On the Edit Role page, in the Experience section, select the Add Text Analytics Elements check 

box.
3 Click Save.
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Insights Embedded Text Analytics
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Insights side tab > 
Insights Embedded Text Analytics page.

You can use the industry standard classification models to evaluate the verbatims in Text Analytics based 
on your use case.

 To select the Embedded Text Analytics service, go to the Configuration tab > General tab.
The Insights tab is unavailable for workgroups with disabled Embedded Text Analytics. For 
more information, go to Embedded Text Analytics, page 1408.

The Model Used for Analysis list provides the theme detection models.When you select a model in the 
Model Used for Analysis list and click Save, the model is saved and the verbatims are reevaluated in 
Text Analytics.
If you change the model after adding the Text Analytics report elements to a report, it will re-export Text 
Analytics data and reinitiate the analysis with the new model. Changing the model restarts the analysis on 
any existing Text Analytics report elements.
It takes some time for the report elements, which are based on the model that has not been created yet, 
to be updated. In such case, the processing status message appears above the report element.
If you are an original report author, you can select the model that introduces changes to the report from 
the Model Used for Analysis  list. The Model Used for Analysis  list is disabled for the reports shared 
with you by other users. The models available in the Model Used for Analysis list vary depending on 
the selected Embedded Text Analytics service.
For Verint Text Analytics Services provider, the following Text Analytics models are available:
• Customer Experience
• Insurance
• Telco
• Travel and Leisure
• Banking
• Retail
Languages available for Text Analytics report elements are English, German, Spanish, Portuguese, and 
French. Each language supports all models, but Retail model is available only in English.

 When Retail model is selected, language option on report element level has only English option if 
it is present in the survey, otherwise—language option is empty.
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Text Analytics–Extended data filtering capabilities
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Filter Report Data button > Filter Report 
Data dialog box > Data Filter section. 

OR
Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > move the pointer over a report element > 

Filter icon  > Filter Element Data dialog box > Data Filter section. 
With new data filtering options, you can filter results in the Text Analytics reports by the culture of 
participant, campaign status, dates of survey completion, location of respondents, and other participant 
properties.
On the report level, you can set filtering by clicking the Filter Report Data button on the toolbar of any 
report of analyzed Text Analytics data. For the individual report element, you can set filtering by moving 

the pointer over any report element, and then clicking Filter icon .
In the Data Filter section, you can define the filter criteria based on your report data or individual report 
element data by clicking the Add Another Criteria link.
• Source – Click the My Survey link to apply the Current Survey, Columns, or Profiles filtering 

criteria to your report element.
• Current Survey – Questions from the survey are available as criteria.
• Columns – The Participant Information, Respondent System Information, and 

Respondent Location data from the Response Manager grid are available as criteria.
- Participant Information – Enables filtering by the culture of participant, campaign status, 

dates of survey completion and other participant properties.
- Respondent System Information – Enables filtering by the device type that was used to 

access the survey.
- Respondent Location – Enables filtering by the city, state/province, ZIP/postal code, or 

country of respondent.
• Profiles – The Basic Information data is available as criterion. Enables filtering by properties 

that are specific to the panelists.

 The Basic Information option is available only if there are Panel campaigns in the current 
survey.

• Filter parameter – Click the question or column by which you want to filter your report data in 
the list.

• Expression – Click the expression in the list to make a comparison between Filter parameter 
and Value.

 The options vary depending on the filter type.
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• Value – Click the response choice for comparison in the list. The available options vary depending 
on the question type and column.

• Save – Click the link or anywhere else in the dialog box to save your criterion.

• Remove – Click the Remove icon  to delete the filter.

• Up/Down – Click the Up    or Down   arrows to move the selected filter up or down one 
level in the list. Filters are applied in a sequential manner, and their position in the list is important.

You can have a combination of the Current Survey, Columns, and Profiles filtering criteria. If you add 
multiple criteria, you can combine them using the following Match options:
• All Criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The drop-down lists with parentheses and the And/Or operators appear next to 

each criterion. The And operator defines that two or more filters are true for the responses 
included in the report. The Or operator defines that one of the filters linked together is true.

In the Date Filter section, you can proceed setting filters based on the date when responses are last 
modified and based on the selected time period.
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Sentiment Chart element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element.

With the Sentiment Chart report element, you can view the sentiment breakdown by topic for a 
question. The breakdown is between the Positive, Neutral, and Negative sentiments. 
You can view data for the top level categories, category leaves, terms, or relationships created within the 
responses to the question. Data is represented as a stacked bar chart. Categories with the most number 
of responses appear at the top of the list. 

The Sentiment Chart report element

 You can drill down into the sentiment chart to view the responses.

To navigate through the pages of the sentiment chart, click the navigation arrows at the bottom of the 
element.
After adding the sentiment chart into your report, the element editor panel appears in the left pane with 
a number of collapsible menus:
• Sentiment Chart – Report Element, page 890
• Sentiment Chart – Appearance, page 891
• Sentiment Chart – Data, page 893
• Sentiment Chart – Displayed Values, page 894
• Sentiment Chart – Embed Report Element, page 896
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Add a Sentiment Chart report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element.

You can use the Sentiment Chart report element to analyze responses to the open-ended questions 
and create comprehensive charts showing a breakdown of content and sentiments.

Procedure 
1 In the Add a Report Element left pane, in the Text Analytics section, click the Sentiment Chart 

element.

 You can add the Sentiment Chart element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions, or click All Verbatim Questions.

 You can select another source for your report element by clicking the Data Source option at the 
top of the dialog box.

3 To get the Sentiment Chart report element in the right pane and element editor in the left, click Add.

 You can add a Sentiment Chart report element when your survey has the Open or Closed 
status only.
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Sentiment Chart – Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element > Report Element section in the 
left pane.

In the Report Element section of a Sentiment Chart element, you can select a chart type and question 
for the element as well as show or hide the question text, description, and caption for the element.
The Report Element section includes the following properties:
• Chart Type – The selected report element and chart type. You can select the sentiment chart 

type from the  list.

The Chart Type drop-down list

• Question – The source question. You can select the source question from the list. The sentiment 
chart is updated to show data from the newly selected question.

• Labels – Displaying or hiding the question heading, text, description, and source citation. You can 
customize the question or description text by typing your own question or description in the 
Show Question Text or Show Question Description text box.

• Caption – A brief description below your report element. You can enter the text and customize its 
font size and style in the edit box. You can select the color of caption foreground and background 
from the Foreground Color and Background Color drop-down lists. 
To check the spelling, click Spell Check.
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Sentiment Chart – Appearance
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element > Appearance section in the left 
pane.

In the Appearance section of a Sentiment Chart element, you can change the look and feel of the 
sentiment chart in your report.
The Appearance section includes the following properties:
• Chart Type – The selected chart type of the report element. You can select the sentiment chart 

type for your report element from the list. 
The following options are available:
• Area
• Line
• Scatter
• Spline
• Spline Area
• Bar
• Stacked Bar
• Stacked Bar Percentage
• Column
• Stacked Column
• Stacked Column Percentage
• Gap

• Background Color –  The background color of your sentiment chart.You can select from a range 
of colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and Brightness), and HSV (Hue, 
Saturation, and Value).

If you know the hexadecimal value of a color, you can enter it manually or click the  icon to 
adjust red, green, blue, hue, saturation, and black level values.

• Gradient End Color – The gradient color for the uppermost area of your sentiment chart. You 
can select the color from a palette.

• Border Color – The border color of your sentiment chart. You can select the color from a palette.
• Border Width – You can adjust the width of borders in your sentiment chart. Values you enter in 

the text box are measured in pixels.
• Border Radius – You can increase or decrease the roundness of border corners in your 

sentiment chart.
• Plot Area Color – The plot area color of your sentiment chart. You can select the color from a 

palette.
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• Plot Area Gradient End Color – The gradient color for the uppermost area of your sentiment 
chart plot area. You can select the color from a palette. This value is limited to the plot area and 
does not affect the background gradient of the chart.

• Show Legend – The legend (Positive, Neutral, and Negative) appears below the sentiment chart. 
By default, the check box is selected

• Label Rotation Angle – You can define the label rotation angle in degrees.
• Maximum Characters – You can define the maximum number of characters for your sentiment 

chart.
• Size Charts Automatically – You can make the sentiment charts fit the current window size 

automatically.
• Width – You can define the width of your sentiment chart. Values you enter in the text box are 

measured in pixels.
• Height – You can define the height of your sentiment chart. Values you enter in the text box are 

measured in pixels.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes to all Sentiment Chart elements in your report, click Apply All.
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Sentiment Chart – Data
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element > Data section in the left pane.

In the Data section of a Sentiment Chart element, you can select the language used for the analysis, 
control the sort order, decimal places, and content displayed in the sentiment chart.
The Data section includes the following properties:
• Language used for Analysis – You can select the language for your sentiment chart.

 List of available languages is based on languages supported by Text Analytics, translations 
present in the survey, and selected model used for the analysis.

• Sentiment Chart Content – You can select the content that you want to be displayed in the 
sentiment chart.
The Text Analytics application structures responses by identifying the following items:
• Top Level Categories
• Category Leaves
• Relationships
• Terms

• Sort Order – You can select the order of the top level categories (category leaves, relationships, or 
terms) in the sentiment chart. The Count option is a default value. When you change the order, 
the sentiment chart is updated to show data in the newly selected order. In the View Responses 
dialog box, the order is updated too. 
The following options are available:
• Alphabetical Order
• Count
• Most Negative
• Most Neutral
• Most Positive

• Invert Sort Order – You can select the check box to display the top level categories (category 
leaves, relationships, or terms) in reverse order in the sentiment chart.

• Decimal Places – You can define the decimal places for the values displayed in the sentiment 
chart.

To apply changes to all Sentiment Chart elements in your report, click Apply All.
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Sentiment Chart – Displayed Values
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element > Displayed Values section in the 
left pane.

In the Displayed Values section of a Sentiment Chart element, you can define the number of 
categories on each chart page, configure the chart export settings, and display the response count and 
percentage on the sentiment chart.
The Displayed Values section includes the following properties:
• Items per Page – You can control how many categories are shown on each page of the 

sentiment chart to ensure that the chart is readable. By default, the top 10 categories appear on 
the first page of the element.

• Pages to Export – You can control how many pages of the sentiment chart you want to export 
to PDF, Microsoft Word, or Microsoft PowerPoint. For example, if you set the value to 10, the first 
10 pages of the sentiment chart are exported. Each chart appears on a new page in the export 
document. The pages are numbered. By default, only the first page of the sentiment chart is 
exported.

• Count – You can control  the number of responses for each category (word or relationship) 
sentiment.

• Sentiment Percentage – You can control the percentage of responses for each category (word 
or relationship) sentiment.

• Sentiment Percentage by Total – You can control  the percentage of responses for each 
category (word or relationship) sentiment calculated by total number of responses.
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The Sentiment Chart with the count and percentages

To apply changes to all Sentiment Chart elements in your report, click Apply All.
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Sentiment Chart – Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element > Embed Report Element section 
in the left pane.

You can generate a code snippet and URL to embed a Sentiment Chart report element into external 
applications.
The sort order and number of categories per page in the embedded sentiment chart are the same as in 
the actual report element. However, paging is not supported. Only the first page of the sentiment chart is 
displayed if the chart is embedded. You can control the data you want to display by filtering or changing 
the sort order and number of categories per page.

 You cannot drill down into the embedded sentiment chart to view the responses.

You can use the code snippet to place a Sentiment Chart report element into a custom page. The HTML 
code of the report element is generated automatically for you. You can also configure the width and 
height of the sentiment chart by editing the code snippet in an HTML or text editor.
You can use the URL to place a Sentiment Chart report element into an IFrame on a custom page. The 
URL of the report element is generated automatically for you. You can also configure the width and 
height of the sentiment chart on your custom page.
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Sentiment Chart – Filtering
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element.

On a sentiment chart, you can click a sentiment or top level category and view the text that represents a 
portion of the chart. You can switch between the different sentiments and top level categories and view 
the full respondents' answers.

Filter responses by top level category

Procedure 
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the 

Sentiment Chart report element.

 You can add the Sentiment Chart element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 Click the name of the top level category that you want to investigate further.

The top level category name

3 In the View Responses dialog box with all the sentences that represent that top level category 
regardless of the sentiment, navigate through the list of responses by clicking the scroll arrows.

 Content that cannot be categorized for the Sentiment Chart report element goes to the Global 
Other top level category. It does not depend on the Sort Order or Invert Sort Order option.

Filter responses by sentiment segment

Procedure 
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the 

Sentiment Chart report element.
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 You can add the Sentiment Chart element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 Click the sentiment segment next to the top level category that you want to investigate further.
3 In the View Responses dialog box with all the sentences that contributed to that top level category 

and sentiment, navigate through the list of responses by clicking the scroll arrows
If you want to view all the positive feedback on the Service top level category, click the Positive segment 
next to Service.

The Positive segment next to Service top level category
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In the View Responses dialog box, the selected sentiment and top level category are highlighted.

The positive responses for the Service category

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all the responses for the selected category, including positive, negative, and 
neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages of responses by clicking the scroll arrows at the 
bottom of the dialog box.
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Under Category, all the categories for the selected question are listed. The categories appear in the same 
order as on the chart. Thus, categories with the most number of responses appear at the top of the list. 
You can scroll between the categories by clicking the up and down arrows. When you select a different 
category, the response list on the right is updated to show the responses that represent that category.

 You can select only one category and one sentiment at a time.
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Sentiment Summary element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Summary report element.

With a Sentiment Summary report element, you can view how the overall sentiment for the question 
breaks down between the Positive, Neutral, and Negative ranges. The data is represented as a bar 
chart.

The Sentiment Summary report element

After adding the sentiment summary chart into your report, the element editor panel appears in the left 
pane with a number of collapsible menus:
Sentiment Summary – Report Element, page 903
Sentiment Summary – Appearance, page 905
Sentiment Summary – Data, page 907
Sentiment Summary – Displayed Values, page 908
Sentiment Summary – Embed Report Element, page 909
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Add a Sentiment Summary report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Summary report element > add the Sentiment 
Summary report element.

You can use the Sentiment Summary report element to analyze responses to the open-ended 
questions and create comprehensive charts showing the overall sentiment breakdown.

Procedure 
1 In the Add a Report Element left pane, in the Text analytics section, click the Sentiment 

Summary element.

 You can add the Sentiment Summary element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions or click All Verbatim Questions.

 You can select another source for your report element by clicking the Data Source option at the 
top of the dialog box.

3 To get the Sentiment Summary report element in the right pane and element editor - in the left, 
click Add.

 You can add a Sentiment Summary report element when your survey has the Open or Closed 
status only.

 

Sentiment Summary element, page 901
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Sentiment Summary – Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Summary report element > add the Sentiment 
Summary report element > Report Element section in the left pane.

In the Report Element section of a Sentiment Summary element, you can select the chart type and 
question for the element as well as show or hide the question text, description, and caption for the 
element.
The Report Element section includes the following properties:
• Chart Type – The selected report element and chart type. You can select the sentiment chart 

type from the list.

The Chart Type  list

• Question – The source question. You can select the source question from the list. The sentiment 
summary is updated to show data from the newly selected question.

• Labels – Displaying or hiding the question heading, text, description, and source citation. You can 
customize the question or description text by typing your own question or description in the 
Show Question Text or Show Question Description text box.
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• Caption – A brief description below your report element. You can enter the text and customize its 
font size and style in the edit box. You can select the color of caption foreground and background 
from the Foreground Color and Background Color drop-down lists. 
To check the spelling, click Spell Check.
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Sentiment Summary – Appearance
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Summary report element > add the Sentiment 
Summary report element  > Appearance section in the left pane.

In the Appearance section of a Sentiment Summary element, you can change the look and feel of the 
sentiment summary chart in your report.
The Appearance section includes the following properties:
• Chart Type – The selected chart type of the report element. You can select the sentiment chart 

type for your report element from the list. 
The following options are available:
• Bar
• Stacked Bar
• Stacked Bar Percentage
• Column
• Stacked Column
• Stacked Column Percentage
• Pie
• Doughnut

• Background Color – The background color for your sentiment summary chart. You can select 
from a range of colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and Brightness), and 
HSV (Hue, Saturation, and Value).

If you know the hexadecimal value of a color, you can enter it manually or click the  icon to 
adjust red, green, blue, hue, saturation, and black level values.

• Gradient End Color – The gradient color for the uppermost area of your sentiment summary 
chart. You can select the color from a palette.

• Border Color – The border color of your sentiment summary chart. You can select the color from 
a palette.

• Border Width – You can adjust the width of borders in your sentiment summary chart. Values 
you enter in the field are measured in pixels.

• Border Radius – You can increase or decrease the roundness of border corners in your 
sentiment summary chart.

• Plot Area Color – The plot area color for your sentiment summary chart. You can select the color 
from a palette.

• Plot Area Gradient End Color – The gradient color for the uppermost area of your sentiment 
summary chart plot area. You can select the color from a palette. This value is limited to the plot 
area and does not affect the background gradient of the summary chart.

• Show Legend – The legend (Positive, Neutral, and Negative) appears below the summary chart 
and is available for the Pie and Doughnut chart types only. By default, the check box is selected. 

• Label Rotation Angle – You can define the label rotation angle in degrees.
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• Maximum Characters – You can define the maximum number of characters for your sentiment 
summary chart.

• Size Charts Automatically – You can make the sentiment summary charts fit the current 
window size automatically.

• Width – You can define the width of your sentiment summary chart. Values you enter in the text 
box are measured in pixels.

• Height – You can define the height of your sentiment summary chart. Values you enter in the 
text box are measured in pixels.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes to all Sentiment Summary elements in your report, click Apply All.
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Sentiment Summary – Data
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Summary report element > add the Sentiment 
Summary report element   > Data section in the left pane.

In the Data section of a Sentiment Summary element, you can select the language used for the 
analysis, control the sort order, decimal places, and scale values displayed in the sentiment summary 
chart.
The Data section includes the following properties: 
• Language used for Analysis – You can select the language for your sentiment summary chart.

 List of available languages is based on languages supported by Text Analytics, translations 
present in the survey, and selected model used for the analysis.

• Sort Order – You can select the order of the sentiment bars in the chart. The Positive to 
Negative option is a default value. When you change the order, the sentiment summary chart is 
updated to show data in the newly selected order. 
The following options are available:
• Positive to Negative
• Negative to Positive

• Calculate as Percentage – You can select the check box to show a percentage on the chart scale 
rather than a count. The check box is selected by default.

• Decimal Places – You can define the decimal places for the values displayed in the sentiment 
summary chart.

To apply changes to all Sentiment Summary elements in your report, click Apply All.
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Sentiment Summary – Displayed Values
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Summary report element > add the Sentiment 
Summary report element    > Displayed Values section in the left pane.

In the Displayed Values section of a Sentiment Summary element, you can display the response 
count and percentage on the sentiment summary chart.
The Displayed Values section includes the following properties:
• Count – You can control  the number of responses for each sentiment.
• Sentiment Percentage – You can control the percentage of responses for each sentiment.
To apply changes to all Sentiment Summary elements in your report, click Apply All.
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Sentiment Summary – Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Chart report element > Embed Report Element section 
in the left pane.

You can generate a code snippet and URL to embed a Sentiment Summary report element into 
external applications.

 You cannot drill down into the embedded word cloud to view the responses.

You can use the code snippet to place a Sentiment Summary report element into a custom page. The 
HTML code of the report element is generated automatically for you. You can also configure the width 
and height of the sentiment summary chart by editing the code snippet in an HTML or text editor.
You can use the URL to place a Sentiment Summary report element into an IFrame on a custom page. 
The URL of the report element is generated automatically for you. You can also configure the width and 
height of the sentiment summary chart on your custom page.
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Sentiment Summary – Filtering
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new report > Report designer page > Add menu.

With a Sentiment Summary report element, you can view how the overall sentiment for the question 
breaks down between the Positive, Neutral, and Negative ranges. The data is represented as a bar 
chart. 
On a sentiment summary chart, you can click a sentiment bar and view the text that represents a portion 
of the chart. You can switch between the different sentiments and categories and view the full 
respondents' answers.

Filter responses in the sentiment summary chart

Procedure 
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the 

Sentiment Summary report element.

 You can add the Sentiment Summary element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 Click the sentiment that you want to investigate further.
3 In the View Responses dialog box with all the sentences that represent that sentiment including all 

the categories, navigate through the list of responses by clicking the scroll arrows.

 You can switch between the different sentiments and categories in the dialog box.

If you want to view all the positive feedback on the Positive category, click the Positive sentiment bar in 
the Sentiment Summary element.

The Positive sentiment bar in the Sentiment Summary element

In the View Responses dialog box, the selected sentiment is highlighted.
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The Positive responses for the Service category

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all the responses for the selected category, including positive, negative, and 
neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment bar.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages of responses by clicking the scroll arrows at the 
bottom of the dialog box.
Under Category, all the categories for the selected question are listed. You can scroll between the 
categories by clicking the up and down arrows. When you select a different category, the response list on 
the right is updated to show the responses that represent that category.

 You can select only one category and one sentiment at a time.
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Word Cloud element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Word Cloud report element.

You can use a Word Cloud report element to view the volume and sentiment for the words that are used 
in the unstructured text. The data appears in the form of a word cloud. Word cloud is a set of words 
represented as a cloud that appears in different size and color. The cloud gives greater prominence to 
words that occur more frequently in the source text. The color indicates the Positive, Neutral, and 
Negative sentiments. 

The Word Cloud report element

 You can drill down into the word cloud to view the responses.

After adding the word cloud into your report, the element editor panel appears in the left pane with a 
number of collapsible menus:
• Word Cloud Report Element, page 914
• Word Cloud – Appearance, page 915
• Word Cloud – Data, page 916
• Word Cloud – Embed Report Element, page 917
• Word Cloud – Filtering, page 918
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Add a Word Cloud report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Word Cloud report element.

Using the Word Cloud report element, you can view data for the terms, top level categories, category 
leaves, and relationships created within the responses to the question.

Procedure 
1 In the Add a Report Element left pane, in the Text Analytics section, click the Word Cloud 

element.

 You can add the Word Cloud report element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions or click All Verbatim Questions.

 You can select another source for your report element by clicking the Data Source option at the 
top of the dialog box.

3 To get the Word cloud report element in the right pane and element editor in the left, click Add.

 You can add a Word Cloud report element when your survey has the Open or Closed status 
only.
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Word Cloud Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Word Cloud report element > Report Element section in the left 
pane.

In the Report Element section of a Word Cloud element, you can select a base question for the element 
and show or hide the question text, description, and caption.
The Report Element section includes the following properties: :
• Type – The selected report element type.
• Question – The source question. You can select the source question from list. The word cloud is 

updated to show data from the newly selected question. 
• Labels – Displaying or hiding the question heading, text, description, and source citation. You can 

customize the question or description text by typing your own question or description in the 
Show Question Text or Show Question Description text box.

• Caption – A brief description below your report element. You can enter the text and customize its 
font size and style in the edit box. You can select the color of caption foreground and background 
from the Foreground Color and Background Color lists. 
To check the spelling, click Spell Check.
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Word Cloud – Appearance
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Word Cloud report element > Appearance section in the left pane.

In the Appearance section of a Word Cloud element, you can change the look and feel of the word 
cloud in your report.
The Appearance section includes the following properties:
• Cloud Shape – The selected cloud form of the report element. You can select the cloud shape of 

your report element from the list. The following options are available:
• Elliptic
• Rectangular

• Background Color – The background color for your word cloud. 
You can select from a range of colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and 
Brightness), and HSV (Hue, Saturation, and Value).

If you know the hexadecimal value of a color, you can enter it manually or click the  icon to 
adjust red, green, blue, hue, saturation, and black level values.

• Border Color – The border color of your word cloud. You can select the color from a palette.
• Border Width – You can adjust the width of borders in your word cloud. Values you enter in the 

text boxare measured in pixels.
• Show Legend – The legend (Positive, Neutral, and Negative) appears above the word cloud. By 

default, the  check box is selected.
• Size Cloud Automatically – You can make the word cloud fit the current window size 

automatically.
• Width – You can define the width of your word cloud. Values you enter in the text box are 

measured in pixels.
• Height – You can define the height of your word cloud. Values you enter in the text box are 

measured in pixels.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes to all Word Cloud elements in your report, click Apply All.
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Word Cloud – Data
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Word Cloud report element > Data section in the left pane.

In the Data section of a Word Cloud element, you can select the language used for the analysis and 
control the content displayed in the word cloud.
The Data section includes the following properties:
• Language used for Analysis – You can select the language for your word cloud.

 List of available languages is based on languages supported by Text Analytics, translations 
present in the survey, and selected model used for the analysis.

• Cloud Content – You can select the type of content that you want to be displayed in the word 
cloud. The Text Analytics application structures responses by identifying the following items:
• Terms (default option)
• Relationships
• Top Level Categories
• Category Leaves

• Maximum Items – You can enter the number of terms to be displayed in the word cloud. By 
default, 100 items are displayed.

To apply changes to all Word Cloud elements in your report, click Apply All.
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Word Cloud – Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Word Cloud report element > Embed Report Element section in the 
left pane.

You can generate a code snippet and URL to embed a Word Cloud report element into external 
applications.

 You cannot drill down into the embedded word cloud to view the responses.

You can use the code snippet to place a Word Cloud report element into a custom page. The HTML code 
of the report element is generated automatically for you. You can also configure the width and height of 
the word cloud by editing the code snippet in an HTML or text editor.
You can use the URL to place a Word Cloud report element into an IFrame on a custom page. The URL of 
the report element is generated automatically for you. You can also configure the width and height of the 
word cloud on your custom page.
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Word Cloud – Filtering
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Word Cloud report element.

You can interact with the Word Cloud report element by clicking a term and exploring further the actual 
sentences that contributed to that selected term. The data can be filtered by terms and sentiments. You 
can switch between the different sentiments and terms and view the full respondents' answers.

Filter responses in the Word Cloud

Procedure 
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the Word 

Cloud report element.

 You can add the Word Cloud element to the report either from the Add a Report Element left 
pane or from the Add menu.

2 Click the term that you want to investigate further.
3 In the View Responses dialog box with all the sentences that represent that term regardless of the 

sentiment, navigate through the list of responses by clicking the scroll arrows.

 You can switch between the different sentiments and terms in the dialog box.

If you want to view responses containing the Service term, click it within the word cloud. In the View 
Responses dialog box, the selected term is highlighted.
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The responses for the Service term

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all the responses for the selected term, including positive, negative, and 
neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on the page. The default number of responses per 
page is 10. You can also navigate through the pages of responses by clicking the scroll arrows at the 
bottom of the dialog box.
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Under Terms, all the terms for the selected question are listed. The terms appear in the same order as 
used for sizing the word cloud. Thus, terms with the most number of responses appear at the top of the 
list. You can scroll between the terms by clicking the up and down arrows. When you select a different 
term, the response list on the right is updated to show the responses that represent that term.

 You can select only one term and one sentiment at a time.
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Heat Map element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element.

With the Heat Map report element, you can view a graphical representation of data that appears in 
different size and color. The size indicates volume of words that occur more frequently in the source text. 
The color indicates the Positive, Neutral, and Negative sentiments.

The Heat Map report element

 You can drill down into the heat map to view responses.

After adding the heat map into your report, the element editor panel appears in the left pane with a 
number of collapsible menus:
• Heat Map – Report Element, page 923
• Heat Map – Appearance, page 924
• Heat Map – Data, page 925
• Heat Map – Displayed Values, page 926
• Heat Map – Embed Report Element, page 927
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Add a Heat Map report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element.

Using the Heat Map report element, you can view data for the top level categories and category leaves 
created within the responses to the question.

Procedure 
1 In the Adda Report Element left pane, in the Text Analytics section, click the Heat Map element.

 You can add the Heat Map report element to the report either from the Add a Report Element 
left pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions or click All Verbatim Questions.

 You can select another source for your report element by clicking the DataSource option at the 
top of the dialog box.

3 To get the Heat Map report element in the right pane and element editor in the left, click Add.

 You can add a Heat Map report element when your survey has the Open or Closed status only.
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Heat Map – Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element > Report Element section in the left pane.

In the Report Element section of a Heat Map element, you can select a base question for the element 
and show or hide the question text, description, and caption.
The Report Element section includes the following properties:
• Type – The selected report element type.
• Question – The source question. You can select the source question from the list. The heat map 

is updated to show data from the newly selected question.
• Labels – Displaying or hiding the question heading, text,description, and source citation. You can 

customize the question or description text by typing your own question or description in the 
Show Question Text or Show Question Description text box.

• Caption – A brief description below your report element. You can enter the text and customize its 
font size and style in the edit box. You can select the color of caption foreground and background 
from the Foreground Color and Background Color drop-down lists. To check the spelling, click 
Spell Check.
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Heat Map – Appearance
Navigation

Projects tab > Surveys side tab > open an existing survey > Analyze tab > Reports side tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element > Appearance section in the left pane.

In the Appearance section of a Heat Map element, you can change the look and feel of the heat map in 
your report.
The Appearance section includes the following properties:
• Border Color – The border color of your heat map. You can select the color from a palette.
• Border Width – You can adjust the width of borders for your heat map. Values you enter in the 

text box are measured in pixels.
• Size Charts Automatically – You can make the heat maps fit the current window size 

automatically.
• Width – You can define the width of your heat map. Values you enter in the text box are 

measured in pixels.
• Height – You can define the height of your heat map. Values you enter in the text box are 

measured in pixels.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes to all Heat Maps elements in your report, click Apply All.
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Heat Map – Data
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element > Data section in the left pane.

In the Data section of a Heat Map element, you can select the language used for the analysis, control 
the sort order and content displayed in the heat map.
The Data section includes the following options:
• Language used for Analysis – You can select the language for your heat map.

 List of available languages is based on languages supported by Text Analytics, translations 
present in the survey, and selected model used for the analysis.

• Heat Map Content – You can select the content that you want to be displayed in the heat map. 
The Text Analytics application structures responses by identifying the following items:
• Top Level Categories (default option)
• Category Leaves

• Sort Order – You can select the order of the top level categories (category leaves) in the heat 
map. The Count option is a default value. When you change the order, the heat map is updated 
to show data in the newly selected order. In the View Responses dialog box, the order is 
updated too. 
The following options are available:
• Count – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Count – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
To apply changes to all Heat Maps elements in your report, click Apply All.
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Heat Map – Displayed Values
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element > Displayed Values section in the left 
pane.

In the Displayed Values section of a Heat Map element, you can display the response count and 
percentage on the heat map.
The Displayed Values section includes the following properties:
• Count – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Count – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
To apply changes to all Heat Maps elements in your report, click Apply All.
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Heat Map – Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element > Embed Report Element section in the 
left pane.

You can generate a code snippet and URL to embed a Heat Map report element into external 
applications.

 You cannot drill down into the embedded heat map to view responses.

You can use the code snippet to place a Heat Map report element into a custom page. The HTML code of 
the report element is generated automatically for you. You can also configure the width and height of the 
heat map by editing the code snippet in an HTML or text editor.
You can use the URL to place a Heat Map report element into an IFrame on a custom page. The URL of 
the report element is generated automatically for you. You can also configure the width and height of the 
heat map on your custom page.
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Heat Map – Filtering
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Heat Map report element.

On a Heat Map report element, you can click a top level category name and view the text that represents 
a portion of the heat map. You can switch between the different sentiments and top level categories and 
view the full respondents' answers.

Filter responses in the Heat Map

Procedure 
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the Heat 

Map report element.

 You can add the Heat Map report element to the report either from the Add a Report Element 
left pane or from the Add menu.

2 Click the category leaf that you want to investigate further. 
3 In the View Responses dialog box with all the sentences that represent that category leaf regardless 

of the sentiment, navigate through the list of responses by clicking the scroll arrows.

 You can switch between the different sentiments and category leaves in the dialog box.

If you want to view responses containing the Support Email category leaf, click the selected category on 
the heat map. 
In the View Responses dialog box, the selected category leaf is highlighted.
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The Service category leaf on the Heat Map

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all the responses for the selected category leaf, including positive, negative, 
and neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages of responses by clicking the scroll arrows at the 
bottom of the dialog box.
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Under Top Level Category, all category leaves for the selected question are listed. You can scroll 
between the category leaves by clicking the up and down arrows. When you select a different category 
leaf, the response list on the right is updated to show the responses that represent that category leaf.

 You can select only one category leaf and one sentiment at a time.



Text Analytics Trend Chart element

EFM User Guide 931

Confidential and Proprietary Information of Verint Systems Inc.

Trend Chart element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element.

With the Trend Chart report element, you can track the top ten items as trend lines. You can view data 
for the top level categories, category leaves, terms, or relationships created within the responses to the 
question. 

The Trend Chart report element

 You can drill down into the trend chart to view responses.

After adding the trend chart into your report, the element editor panel appears in the left pane with a 
number of collapsible menus:
• Trend Chart – Report Element, page 933
• Trend Chart – Appearance, page 934
• Trend Chart – Data, page 935
• Trend Chart – Displayed Values, page 937
• Trend Chart – Embed Report Element, page 938

 The Trend Chart report element added to the dashboard does not support the dashboard date 
filter.
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Add a Trend Chart report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element.

You can visualize your survey verbatim datasets in a trend chart for better understanding of the verbatim 
responses.
1 In the Add a Report Element left pane, in the Text Analytics section, click the Trend Chart 

element.

 You can add the Trend Chart element to the report either from the Add a Report Element left 
pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions or click All Verbatim Questions.

 You can select another source for your report element by clicking the Data Source option at the 
top of the dialog box.

3 To get the Trend Chart report element in the right pane and element editor in the left, click Add.

 You can add a Trend Chart report element when your survey has the Open or Closed status 
only.
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Trend Chart – Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element > Report Element section in the left 
pane.

In the Report Element section of a Trend Chart element, you can select a base question for the 
element and show or hide the question text, description, and caption.
The Report Element section includes the following properties:.
• Type – The selected report element type.
• Question – The source question. You can select the source question from the list. The trend chart 

is updated to show data from the newly selected question.
• Labels – Displaying or hiding the question heading, text, description, and source citation. You can 

customize the question or description text by typing your own question or description in the 
Show Question Text or Show Question Description text box.

• Caption – A brief description below your report element. You can enter the text and customize its 
font size and style in the edit box. You can select the color of caption foreground and background 
from the Foreground Color and Background Color  lists. To check the spelling, click Spell 
Check.
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Trend Chart – Appearance
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element > Appearance section in the left pane.

In the Appearance section of a Trend Chart element, you can change the look and feel of the trend 
chart in your report.
The Appearance section includes the following properties:
• Background Color – The background color for your trend chart. You can select from a range of 

colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and Brightness), and HSV (Hue, 
Saturation, and Value).

If you know the hexadecimal value of a color, you can enter it manually or click the   icon to 
adjust red, green, blue, hue, saturation, and black level values.

• Gradient End Color – The gradient color for the uppermost area of your trend chart. You can 
select the color from a palette.

• Border Color – The border color of your trend chart. You can select the color from a palette.
• Border Width – You can adjust the width of borders in your trend chart. Values you enter in the 

text box are measured in pixels.
• Border Radius – You can increase or decrease the roundness of border corners in your trend 

chart.
• Plot Area Color – The plot area color for your trend chart. You can select the color from a palette.
• Plot Area Gradient End Color – The gradient color for the uppermost area of your trend chart 

plot area. You can select the color from a palette. This value is limited to the plot area and does 
not affect the background gradient of the chart.

• Show Legend – The legend appears to the right of the chart. By default, the check box is 
selected.

• Label Rotation Angle – You can define the label rotation angle in degrees.
• Maximum Characters – You can define the maximum number of characters for your trend 

chart.
• Size Charts Automatically – You can make the trend charts fit the current window size 

automatically.
• Width – You can define the width of your trend chart. Values you enter in the text box are 

measured in pixels.
• Height – You can define the height of your trend chart. Values you enter in the text box are 

measured in pixels.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes to all Trend Chart elements in your report, click Apply All.
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Trend Chart – Data
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element > Data section in the left pane.

In the Data section of a Trend Chart element, you can select the language used for the analysis, control 
the sort order and content displayed in the trend chart.
The Data section includes the following properties:
• Language used for Analysis  – You can select the language for your trend chart.

 List of available languages is based on languages supported by Text Analytics, translations 
present in the survey, and selected model used for the analysis.

• Trend Chart Content – You can select the content that you want to be displayed in the trend 
chart. The Text Analytics application structures responses by identifying the following items:
• Top Level Categories (default option)
• Category Leaves
• Relationships
• Terms

• Sort Order – You can select the order of the top level categories (category leaves, relationships, or 
terms) in the trend chart. The Count option is a default value. When you change the order, the 
trend chart is updated to show data in the newly selected order. In the View Responses dialog 
box, the order is updated too. The following options are available:
• Count – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Count – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
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• Invert Sort Order – You can select the check box to display the top level categories (category 
leaves, relationships, or terms) in reverse order in the trend chart.

• Decimal Places – You can define the decimal places for the values displayed in the trend chart.
To apply changes to all Trend Chart elements in your report, click Apply All.
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Trend Chart – Displayed Values
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element > Displayed Values section in the left 
pane.

In the Displayed Values section of a Trend Chart element, you can display the response count and 
percentage on the trend chart.
The Displayed Values section includes the following properties:
• Volume – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Volume – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
To apply changes to all Trend Chart elements in your report, click Apply All.
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Trend Chart – Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element > Embed Report Element section in 
the left pane.

You can generate a code snippet and URL to embed a Trend Chart report element into external 
applications.

 You cannot drill down into the embedded trend chart to view responses.

You can use the code snippet to place a Trend Chart report element into a custom page. The HTML code 
of the report element is generated automatically for you. You can also configure the width and height of 
the trend chart by editing the code snippet in an HTML or text editor.
You can use the URL to place a Trend Chart report element into an IFrame on a custom page. The URL 
of the report element is generated automatically for you. You can also configure the width and height of 
the trend chart on your custom page.
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Trend Chart – Filtering
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Trend Chart report element.

On a trend chart, you can click a top level category and view the text that represents a portion of the 
chart. You can switch between the different sentiments and top level categories and view the full 
respondents' answers.

Filter responses in the Trend Chart
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the Trend 

Chart report element.

 You can add the Trend Chart element to the report either from the Add a Report Element left 
pane or from the Add menu.

2 Click the trend line of the top level category that you want to investigate further.
3 In the View Responses dialog box with all the sentences that represent that category regardless of 

the sentiment, navigate through the list of responses by clicking the scroll arrows.
If you want to view responses containing the Service top level category, click its trend line on the chart.

The Service top level category on the chart

In the View Responses dialog box, the selected category is highlighted.
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The responses for the Service top level category

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all the responses for the selected top level category, including positive, 
negative, and neutral. When you select a different sentiment, the response list on the right is updated to 
show the responses that represent that sentiment segment.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages of responses by clicking the scroll arrows at the 
bottom of the dialog box.
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Under Top Level Categories, all top level categories for the selected question are listed. You can scroll 
between the top level categories by clicking the up and down arrows. When you select a different top 
level category, the response list on the right is updated to show the responses that represent that top 
level category.

 You can select only one category and one sentiment at a time.
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Sentiment Table element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element.

You can visualize your survey verbatim datasets in a table for better understanding of the verbatim 
responses.
With the Sentiment Table report element, you can view your Text Analysis results in a table. The color 
indicates the Positive, Neutral, and Negative sentiments. 

The Sentiment Table report element

 You can drill down into the sentiment table to view responses.

To navigate through the pages of the sentiment table, click the navigation arrows at the bottom of the 
element.
After adding the sentiment table into your report, the element editor panel appears in the left pane with a 
number of collapsible menus:
• Sentiment Table – Report Element, page 944
• Sentiment Table – Appearance, page 945
• Sentiment Table – Data, page 946
• Sentiment Table – Displayed Values, page 948
• Sentiment Table – Embed Report Element, page 949
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Add a Sentiment Table report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element.

Using the  Sentiment Table report element, you can view data for the terms, top level categories, 
category leaves, and relationships created within the responses to the question.
1 In the Add a Report Element left pane, in the Text Analytics section, click the Sentiment Table 

element.

 You can add the Sentiment Table element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions or click All Verbatim Questions.

 You can select another source for your report element by clicking the Data Source option at the 
top of the dialog box.

3 To get the Sentiment Table report element in the right pane and element editor in the left, click Add.

 You can add a Sentiment Table report element when your survey has the Open or Closed 
status only.
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Sentiment Table – Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element > Report Element section in the 
left pane.

In the Report Element section of a Sentiment Table element, you can select a base question for the 
element and show or hide the question text, description, and caption.
The Report Element section includes the following properties:
• Type – The selected report element type.
• Question – The source question. You can select the source question from the list. The sentiment 

table is updated to show data from the newly selected question.
• Labels – Displaying or hiding the question heading, text, description, and source citation. You can 

customize the question or description text by typing your own question or description in the 
Show Question Text or Show Question Description text box.

• Caption – A brief description below your report element. You can enter the text  and customize its 
font size and style in the edit box. You can select the color of caption foreground and background 
from the Foreground Color and Background Colordrop-down lists. To check the spelling, click 
Spell Check.
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Sentiment Table – Appearance
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element > Appearance section.

In the Appearance section of a Sentiment Table element, you can change the look and feel of the 
sentiment table in your report.
The Appearance section is divided into Row and Header subsections including the following properties:
• Color – The background color for the data or header rows. You can select the color from a palette.
• Text Color – The text color for data or header rows. You can select the color from a palette. It is 

recommended to select contrasting colors in text color settings.
• Font Name – You can select web-compatible fonts for data and header text from a list.
• Font Size – You can select web-compatible font sizes for data and header text from a list.
• Top Level Categories (Category Leaves, Terms, or Relationships) – You can type your text 

to rename the column header of the content type.
• Volume – You can type your text to rename the column header of the Volume displayed value.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes to all Sentiment Table elements in your report, click Apply All.
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Sentiment Table – Data
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element > Data section in the left pane.

In the Data section of a Sentiment Table element, you can select the language used for the analysis, 
control the sort order and content displayed in the sentiment table.
The Data section includes the following properties:
• Language used for Analysis – You can select the language for your sentiment table.

 List of available languages is based on languages supported by Text Analytics, translations 
present in the survey, and selected model used for the analysis.

• Sentiment Table Content – You can select the content that you want to be displayed in the 
sentiment table. The Text Analytics application structures responses by identifying the following 
items:
• Top Level Categories (default option)
• Category Leaves
• Relationships
• Terms

• Sort Order – You can select the order of the top level categories (category leaves, relationships, or 
terms) in the sentiment table. The Count option is a default value. When you change the order, 
the sentiment table is updated to show data in the newly selected order. In the View Responses 
dialog box, the order is updated too. 
The following options are available:
• Alphabetical Order – The item displays the data based on the alphabet.
• Count – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Count – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
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• Invert Sort Order – You can select the check box to display the top level categories (category 
leaves, relationships, or terms) in reverse order in the sentiment table.

• Decimal Places – You can set the number of decimal places for the values in the sentiment table. 
The default value is set to 3 or the highest value supported by Text Analytics if it is less than 3. 
This option is not applicable to the Volume displayed value.

To apply changes to all Sentiment Table elements in your report, click Apply All.
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Sentiment Table – Displayed Values
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element > Displayed values section in the 
left pane.

In the Displayed Values section of a Sentiment Table element, you can control the Rows per Page 
value and display the response count and percentage on the sentiment table.
The Displayed Values section includes the following properties:
• Rows per Page – The number of rows displayed per page of the sentiment table.
• Volume – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Volume – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
To apply changes to all Sentiment Table elements in your report, click Apply All.
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Sentiment Table – Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element > Embed Report Element section 
in the left pane.

You can generate a code snippet and URL to embed a Sentiment Table report element into external 
applications.

 You cannot drill down into the embedded sentiment table to view responses.

You can use the code snippet to place a Sentiment Table report element into a custom page. The HTML 
code of the report element is generated automatically for you. You can also configure the width and 
height of the sentiment table by editing the code snippet in an HTML or text editor.
You can use the URL to place a Sentiment Table report element into an IFrame on a custom page. The 
URL of the report element is generated automatically for you. You can also configure the width and 
height of the sentiment table on your custom page.
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Sentiment Table – Filtering
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Table report element.

On a sentiment table, you can click a top level category and view the text that represents a portion of the 
table. You can switch between the different sentiments and top level categories and view the full 
respondents' answers.

Filter responses in the Sentiment Table

Procedure 
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the 

Sentiment Table report element.

 You can add the Sentiment Table element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 Click the top level category that you want to investigate further. 
3 In the View Responses dialog box with all sentences that represent that category regardless of the 

sentiment, navigate through the list of responses by clicking the scroll arrows.

 You can switch between the different sentiments and categories in the dialog box.

If you want to view responses containing the Mail top level category, click its name on the table.

The Mail top level category on the table

In the View Responses dialog box, the selected category is highlighted.
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The responses for the Service top level category

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all responses for the selected top level category, including positive, negative, 
and neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appears on one page. The default number of responses per 
page is 10. You can also navigate through the pages of responses by clicking the scroll arrows at the 
bottom of the dialog box.
Under Top Level Categories, all top level categories for the selected question are listed. You can scroll 
between the top level categories by clicking the up and down arrows. When you select a different top 
level category, the response list on the right is updated to show the responses that represent that top 
level category.

 You can select only one category and one sentiment at a time.
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Sentiment Trend Table element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element.

With the Sentiment Trend Table report element, you can view your text analysis results over the 
selected date range in a table. The color indicates the Positive, Neutral, and Negative sentiments. 

The Sentiment Trend Table report element

 You can drill down into the sentiment trend table to view responses.

To navigate through the pages of the sentiment table, click the navigation arrows at the bottom of the 
element.

 The Sentiment Trend Table report element added to the dashboard does not support the 
dashboard date filter.

After adding the sentiment trend table into your report, the element editor panel appears in the left pane 
with a number of collapsible menus:
• Sentiment Trend Table – Report Element, page 954
• Sentiment Table – Appearance, page 945
• Sentiment Trend Table – Data, page 956
• Sentiment Trend Table – Displayed Values, page 958
• Sentiment Trend Table – Embed Report Element, page 959
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Add a Sentiment Trend Table report element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element.

Using the Sentiment Trend Table report element, you can view data for the terms, top level categories, 
category leaves, and relationships created within the responses to the question.

Procedure 
1 In the Add a Report Element left pane, in the Text Analytics section, click the Sentiment Trend 

Table element.

 You can add the Sentiment Trend Table element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 In the Select data for your report element dialog box, select the source question from the list of 
the Essay and Matrix with an Essay side questions or click All Verbatim Questions.

 You can select another source for your report element by clicking the Data Source option at the 
top of the dialog box.

3 To get the Sentiment Trend Table report element in the right pane and element editor in the left, 
click Add.

 You can add a Sentiment Trend Table report element when your survey has the Open or 
Closed status only.
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Sentiment Trend Table – Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element > Report Element section 
in the left pane.

In the Report Element section of a Sentiment Trend Table element, you can select a base question 
for the element and show or hide the question text, description, and caption.
The Report Element section includes the following properties:
• Type – The selected report element type.
• Question – The source question. You can select the source question from the list. The sentiment 

trend table is updated to show data from the newly selected question.
• Labels – Displaying or hiding the question heading, text, description, and source citation. You can 

customize the question or description text by typing your own question or description in the 
Show Question Text or Show Question Description text box.

• Caption – A brief description below your report element. You can enter the text  and customize its 
font size and style in the edit box. You can select the color of caption foreground and background 
from the Foreground Color and Background Color lists. 
To check the spelling, click Spell Check.
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Sentiment Trend Table – Appearance
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element > Appearance section in 
the left pane.

In the Appearance section of a Sentiment Trend Table element, you can change the look and feel of 
the sentiment trend table in your report.
The Appearance section is divided into Row and Header subsections including the following properties:
• Color – The background color for the data or header rows. You can select the color from a palette.
• Text Color – The text color for data or header rows. You can select the color from a palette. It is 

recommended to select contrasting colors in text color settings.
• Font Name – You can select web-compatible fonts for data and header text from a list.
• Font Size – You can select web-compatible font sizes for data and header text from a list.
• Top Level Categories (Category Leaves, Terms, or Relationships) – You can type your text 

to rename the column header of the content type.
• Volume – You can type your text to rename the column header of the Volume displayed value.

 Several Appearance properties can be assigned throughout the report with the report theme.

To apply changes to all Sentiment Trend Table elements in your report, click Apply All.
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Sentiment Trend Table – Data
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element > Data section in the left 
pane.

In the Data section of the Sentiment Trend Table element, you can select the language used for the 
analysis, control the sort order, trend over period, and content displayed in the sentiment trend table.
The Data section includes the following properties: 
• Language used for Analysis – You can select the language for your sentiment trend table.

 List of available languages is based on languages supported by Text Analytics, translations 
present in the survey, and selected model used for the analysis.

• Sentiment Trend Table Content – You can select the content that you want to be displayed in 
the sentiment trend table. 
The Text Analytics application structures responses by identifying the following items:
• Top Level Categories (default option)
• Category Leaves
• Relationships
• Terms

• Sort Order – You can select the order of the top level categories (category leaves, relationships, or 
terms) in the sentiment trend table. The Count option is a default value. When you change the 
order, the sentiment trend table is updated to show data in the newly selected order. In the View 
Responses dialog box, the order is updated too. 
The following options are available:
• Alphabetical Order – The item displays the data based on the alphabet.
• Count – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Count – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• % Change in Volume – The item displays the percent change in the total number of distinct 

verbatims returned from Text Analytics over the selected date range.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
• % Change in Sentiment Score – The item displays the percent change in the rolled-up 

sentiment score for each content type as returned from Text Analytics over the selected date 
range.

• Trend Over – You can define the period over which you want to track the data. The following 
options are available:
• Day over Day – Shows the result on a daily basis.
• Week over Week – Shows the results on a weekly basis.



Text Analytics Sentiment Trend Table – Data

EFM User Guide 957

Confidential and Proprietary Information of Verint Systems Inc.

• Month over Month – Shows the results on a monthly basis.
• Quarter over Quarter – Shows the results on a quarterly (three months) basis.
• Year over Year – Shows the results on a yearly basis.

• Invert Sort Order – You can select the check box to display the top level categories (category 
leaves, relationships, or terms) in reverse order in the sentiment trend table.

• Decimal Places – You can set the number of decimal places for the values in the sentiment trend 
table. The default value is set to 3 or the highest value supported by Text Analytics if it is less than 
3. This option is not applicable to the Volume displayed value.

To apply changes to all Sentiment Trend Table elements in your report, click Apply All.
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Sentiment Trend Table – Displayed Values
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element > Displayed Values section 
in the left pane.

In the Displayed Values section of a Sentiment Trend Table element, you can control the Rows per 
Page value and display the response count and percentage on the sentiment trend table.
The Displayed Values section includes the following properties: 
• Rows per Page – The number of rows displayed per page of the sentiment trend table.
• Volume – The item displays the data based on the total number of distinct verbatims returned 

from Text Analytics.
• % of Total Volume – The item displays the data based on the percent of total verbatim volume 

returned from Text Analytics.
• % Change in Volume – The item displays the percent change in the total number of distinct 

verbatims returned from Text Analytics over the selected date range.
• Sentiment Score – The item displays the rolled-up sentiment score for each content type as 

returned from Text Analytics.
• % Change in Sentiment Score – The item displays the percent change in the rolled-up 

sentiment score for each content type as returned from Text Analytics over the selected date 
range.

To apply changes to all Sentiment Trend Table elements in your report, click Apply All.
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Sentiment Trend Table – Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element > Embed Report Element 
section in the left pane.

You can generate a code snippet and URL to embed a Sentiment Trend Table report element into 
external applications.

 You cannot drill down into the embedded sentiment trend table to view responses.

You can use the code snippet to place a Sentiment Trend Table report element into a custom page. The 
HTML code of the report element is generated automatically for you. You can also configure the width 
and height of the sentiment trend table by editing the code snippet in an HTML or text editor.
You can use the URL to place a Sentiment Trend Table report element into an IFrame on a custom 
page. The URL of the report element is generated automatically for you. You can also configure the width 
and height of the sentiment trend table on your custom page.
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Sentiment Trend Table – Filtering
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> Text Analytics section > add the Sentiment Trend Table report element.

On a sentiment trend table, you can click a top level category and view the text that represents a portion 
of the table. You can switch between the different sentiments and top level categories and view the full 
respondents' answers.

Filter responses in the Sentiment Trend Table

Procedure 
1 In the Add a Report Element area in the left pane, in the Text Analytics section, click the 

Sentiment Trend Table report element.

 You can add the Sentiment Trend Table element to the report either from the Add a Report 
Element left pane or from the Add menu.

2 Click the top level category that you want to investigate further. 
3 In the View Responses dialog box with all sentences that represent that category regardless of the 

sentiment, navigate through the list of responses by clicking the scroll arrows.

 You can switch between the different sentiments and categories in the dialog box.

If you want to view responses containing the Support top level category, click its name on the table.

The Support top level category on the table

In the View Responses dialog box, the selected category is highlighted.
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The responses for the Service top level category

Under Sentiment, you can switch between the positive, negative, and neutral responses. The 
Everything option shows all responses for the selected top level category, including positive, negative, 
and neutral. When you select a different sentiment, the response list on the right is updated to show the 
responses that represent that sentiment segment.
The total number of responses for the selected sentiment is displayed at the bottom of the dialog box. 
You can adjust the number of responses that appear on one page. The default number of responses per 
page is 10.You can also navigate through the pages of responses by clicking the scroll arrows at the 
bottom of the dialog box.
Under Top Level Categories, all top level categories for the selected question are listed. You can scroll 
between the top level categories by clicking the up and down arrows. When you select a different top 
level category, the response list on the right is updated to show the responses that represent that top 
level category.

 You can select only one category and one sentiment at a time.
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Text Analytics – Status messages
When you first add the Embedded Text Analytics elements to your report, the data may take up to 15 
minutes to load. For all the further updates–up to an hour. Different messages appear for the report 
elements to notify you on the current status.
The status message appears above the report element that it refers to.

The status message

The following status messages may appear:
• Processing, please check back shortly.
• Additional responses have been received but are pending processing. Chart will be updated 

shortly.
• Too few valid comments were processed to generate meaningful results. Please try again once 

additional comments have been processed.
• Data is not currently available, please try again in a few minutes.
• The following data may be incomplete since text entries are still being processed.
• Filtering is not available yet, please check back later.
If you export the report, the status messages are exported too and appear as plain text in red in the 
export document.
If the number of records to be processed exceeds the batch size (100,000), you receive the following 
message: “Waiting for previous text analytics job to complete—system will retry in 1 hour.” 
On the Administration tab, on the System Tasks  tab, you can view the status of your Text Analytics 
job.
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Activate the drill-down to response list
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports page > create a 
report with a Text Analytics report element > select the check box next to the created report > click Share 
menu > click Share with Other Users option > Select Other Users dialog box > select Allow drill-
down to response list for text elements check box.

Report authors can control whether a report viewer can drill down into the Embedded Text Analytics 
report elements to view the response list. 

Procedure 
1 On the Reports page, select the check box next to the report created with a Text Analytics report 

element. 
2 On the toolbar, click Share>Share with Other Users.
3 In the Select Other Users dialog box, in the Organization Unit or User text box, select the name 

of the user with whom you want to share your report.
4 To allow the selected user to view your report, click the right double arrows button.

The user’s name is moved to the View Access text box.
5 To activate the drill-down for the selected user, select the Allow drill-down to response list for 

text elements check box.
6 Click OK.

 By default, the Allow drill-down to response list for text elements check box is selected.
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View the full response
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> add an element from the Text Analytics section > click the top level category (term) or sentiment > 
View Responses dialog box.

For the Text Analytics report elements, you can expand the response to view the full text. 

Procedure 
1 On the Report designer page, add a Text Analytics report element.
2 Click the top level category (term) or sentiment that you want to investigate further.
3 In the View Responses dialog box, click the response that you want to view for more details.
4 To get the full response, hover over it, and then click the Show More Text link.
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View all respondent's answers
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> add an element from the Text Analytics section > click the top level category (term) or sentiment > 
View Responses dialog box.

For the Text Analytics report elements, you can view the full respondent record for the selected response.

 You need the View access to responses to view the respondent's answers.

Procedure 
1 On the Report designer page, add a Text Analytics report element.
2 Click the top level category (term) or sentiment that you want to investigate further.
3 In the View Responses dialog box, click the response that you want to view for more details.
4 To view all respondent's answers to the survey, hover over the selected response, and then click the 

Go to Response link.
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Export the response list
Navigation

Design & Collect tab > Surveys tab > open an existing survey > Analyze tab > Reports tab > open an 
existing report or create a new one > Report designer page > Add a Report Element area in the left pane 
> add an element from the Text Analytics section > click the top level category (term) or sentiment > 
View Responses dialog box.

You can export the list of responses for the Text Analytics report elements. The data is exported to a text 
file (.txt). The exported file is represented as a list of sentence fragments, not the entire responses. Each 
response starts on a new line. The first line indicates the filter applied to the exported data. This includes 
the sentiment and top level categories (category leaves, terms, or relationships) filter plus the report filter, 
if any.

Procedure 
1 On the Report designer page, add a Text Analytics report element.
2 Click the top level category or sentiment that you want to investigate further.
3 In the View Responses dialog box, select the check box next to the Response title.
4 To select all responses that represent the selected top level category or sentiment, click the Select all 

"N" entries in this grid link.

 You can manually select the check boxes next to the individual responses you want to export.

5 To generate the export file, click Export.
6 In the Export Responses dialog box, to save or open the generated file, click the link that appears.
7 Click Close.
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Change the sentiment colors
Navigation

Library tab > Report Themes tab > select an existing theme or create a new one > Report Theme 
designer page > Charts tab > Sentiment section.

You can customize the color of the sentiments in the Text Analytics report elements.By default, the 
following colors are set for the sentiments:
• Negative sentiment – Red
• Neutral sentiment – Light Gray
• Positive sentiment – Blue
• Category – Dark Gray

Procedure 
1 On the Report Themes page, open a theme, and click the Charts tab. 
2 In the Sentiment section, select a color for the Negative, Neutral, and Positive sentiments and 

category from a palette.
You can select from a range of colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and 
Brightness), and HSV (Hue, Saturation, and Value).

If you know the hexadecimal value of a color, you can enter it manually or click the   icon to 
adjust red, green, blue, hue, saturation, and black level values.
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The Sentiment section

 You can preview the applied changes to the report element in the right pane.
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Manage Embed Report Element
Navigation

Design & Collect tab > Surveys tab > open a survey or create a new one > Analyze tab > Reports page 
>  open a report or create a new one >  select the report element  to add to the report > Embed Report 
Element section.

You can use the HTML code snippet to place the report elements into a custom Web page and share your 
report results outside of the product. The HTML code of the selected report element is generated 
automatically for you. In addition, you can configure the report element by editing the code snippet in an 
HTML or text editor.
To access the code snippet of the report element, click the Embed Report Element collapsible menu on 
the report element editor panel.

 You cannot embed the Response List report element. To display the embedded report element 
on the Web page, you should enable JavaScript and cookies in your browser's settings.

Generate and add a code snippet to a custom web page

Procedure 
1 On the Reports page, create a new report.
2 In the Name Your Report dialog box, in the Report Name field, enter the name of a report.
3 Click OK. 
4 On the report designer page, in the Add a Report Element area, select the report element. 
5 In the element editor panel, click the Embed Report Element menu.
6 To generate the HTML code snippet for the selected report element, click the Generate Code button.
7 To select the entire generated code snippet, click within the text box.
8 Right-click the selected code, and click Copy.
9 Open any text editor, for example, Notepad, and insert the copied code snippet in the text editor.
10 Save the text file with the code snippet in the HTML format.
11 Open the saved HTML file, and you can view the report element in your Web browser.

Edit a code snippet

Procedure 
1 Open the text file with the saved  code snippet of the report element.
2 Edit the code snippet. 

You can configure the following parameters using the code snippet:
• W – Define the width of the report element by setting a number, for example, &w=480. The value 

you input is measured in pixels.
• H – Define the height of the report element by setting a number, for example, &h=360. The value 

you input is measured in pixels.
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• R – Define the number of rows for the Frequency Table report element by adding the r 
parameter to the code snippet next to the h parameter, for example, &r=15. The valid range of 
values is from 10 to 150.

3 Save the changes in the HTML format.
4 Open the saved HTML file, and you can view the report element in your Web browser.

 You can switch to the Web page showing the report element and refresh the page to see the 
updated report element. It may take up to several minutes for the report element to update. So, 
it is recommended to clear the browser's cache to display the last changes correctly.

Delete a code snippet

Procedure 
1 In the application, select the report element with the generated code snippet.

2 In the content area, click the Delete icon  . 
3 In the confirmation dialog box, click Delete. 
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Publish widget to URL
Navigation

Design & Collect tab > Surveys tab > open a survey or create a new one > Analyze tab > Reports page 
>  open a report or create a new one >  select the report element  to add to the report > Embed Report 
Element section.

You can generate a URL with the report element (widget) in addition to the code snippet. Some Web 
pages do not allow the JavaScript code to be cut and pasted into the page. So, you have a choice of either 
embedding the JavaScript code or, if that is not possible, copying and pasting a link.
You can generate a URL with the widget while designing your report, and then copy and paste the URL 
into an IFrame on a custom page. The URL of the selected report element is generated automatically for 
you. In addition, you can edit the width and height of the report element on your custom page.

 You cannot embed the Response List report element.

Generate and add a URL to a custom page

Procedure 
1 In the report designer, add a report element for which you want to generate a URL.
2 Click the Embed Report Element section.
3 Click the Generate Code button. 

The URL for the element is generated automatically.

 The Generate Code button disappears after generation.

4 To select the whole link, click within the text box with the URL. 
5 Right-click in the text box, and click Copy.
6 Open the custom page where you want to place the report element.
7 Insert the copied URL into an IFrame on the custom page. 

The report element appears.

 You can insert the link directly in the Address bar of your Web browser and share the link with 
others.

 

Edit a report element on the custom page
The copied URL looks like this:

http://cog.example.com/Current/ 
ReportWidget.ashx?wid=ksGP30rsyt&w=480&h=360&htmlwrap=1

You can configure the following parameters for the embedded report element in the copied URL:
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• W – Define the width of the report element by setting a number, for example, &w=480. The value 
you input is measured in pixels.

• H – Define the height of the report element by setting a number, for example, &h=360. The value 
you input is measured in pixels.

• R – Define the number of rows for the tables by adding the "r" parameter next to the "h" 
parameter, for example, &r=15. The valid range of values is from 10 to 150.

 Also, you can edit the report element in the report designer as usually.

You may need to refresh the page to see the updated report element. It may take up to several minutes 
for the report element to update.

Delete a report element from the custom page

Procedure 
1 In the report designer, select the report element with the generated URL that you want to delete.

2 In the right pane, hover over the report element, and click the Delete icon  . 
3 In the confirmation dialog box, click Delete. 
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Response Manager Grid
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid.

You can view, delete, edit, and export your survey response data. In addition, you can filter, show or hide, 
validate, and sort response data. By default, the Response Manager grid displays the response data of 
10 respondents, the dates they started and completed your survey, and the date you last modified their 
response data.

Actions menu
The Actions menu shows you a number of options how to customize your view of the Response 
Manager grid, edit responses, filter responses, import responses, and more. The following options are 
available:
• View Data Type – Specify what type of data you want to view in your Response Manager grid.

• Raw Data – Display numeric values associated with responses.
If a respondent does not see a question due to the designed survey logic, the choices of the 
skipped question are recorded as NULL* (not asked) in the Response Manager grid.
For Choose Many, Choose Many with Image, and Choose Many Matrix questions, a choice 
(column or row) that is not displayed to the respondent (due to using Hidden, Conditional 
Visibility, Number of Rows Visible options, or piping) is also recorded as NULL (not asked) in 
the Response Manager grid.
All report elements that support Choose Many, Choose Many with Image, or Choose Many 
Matrix questions record choices as the following values:
NULL (not asked), 0 (not selected), and 1 (selected). NULL is the database value that is displayed 
as blank space in the EFM application.

• Choice Labels – Display text associated with responses.

 You cannot re-import data that includes Choice Labels.

• Export Values – Display values that you define in your survey. For example, if you want to 
display negative numbers in your Response Manager grid, specify this in the survey, and display 
it in the Response Manager grid.

• Columns – Specify which columns you want to display in your Response Manager grid. For 
example, you can hide the Started survey date and display your respondents' Completed survey 
date in the Response Manager grid.
Clicking the Columns button opens the Select Columns dialog box, where you can select fields from 
the following folders: Current survey, Respondent Fields, Respondent System Information, 
Respondent Location, or Surveys.
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 You can track the Respondent System Information and Respondent Location only if the 
Track Respondent Information check box is selected on the Properties tab in survey 
designer. For more information, see Properties, page 482.

For Contact List campaign and multi-campaign survey (Contact List and Panelist campaigns), 
Email and Mobile Number columns are selected by default. For Panelist campaign, only Panelist 
ID column is selected by default.

 For multi-campaign survey, if Email and Mobile Number columns are shown but values are 
empty for the Panel respondent, select the check box in Columns > Panelists > Email and 
Mobile Number.

If your survey has campaigns of different types, the Surveys and Profiles folders are not available in 
the Select Columns dialog box. In the Surveys folder, the surveys with multiple-campaign types are 
not available for selection if the current survey is a single-campaign one.
If there are one or more file imports mapped to your survey, then an additional section Data 
Channels appears in the Select Columns dialog box. You can make the columns from the selected 
file import visible in the Response Manager grid.

 The data from the file import becomes available in the Response Manager grid only after a 
survey respondent submits a survey with the response that matches one of the values from the 
corresponding file import column.

• Edit – Use this feature to modify the response data submitted by a specific respondent. Select a 
response in the Response Manager grid, and then select the Edit option on the Actions menu. 

• Filter – Use this feature to control types of information displayed in your Response Manager 
grid by defining certain filtering criteria. For example, you can exclude all responses that are larger 
than a certain value. You can also use the Filter option to search for a response you need by 
using the record ID.
• In the Add Filter Criteria dialog box, if multiple campaign types are added to your survey, the 

Surveys option is hidden in the Source  box.
• In the Surveys folder, the surveys that contain multiple campaign types are unavailable for 

selection.
• Clear All Filters – Use this feature to remove any filter from your Response Manager grid. This 

means that responses will be displayed in your Response Manager grid based on the default 
view.

• Generate Test Data – Use this feature to insert test data into your survey automatically. You 
can define the number of responses that you want to generate and select the even or random 
response distribution type.

 Generate Test Data is available for Generate Link distribution method only when the survey 
is in the Design mode. For Create a List, Invite Panelists, and Require a Passcode 
distribution methods, the Generate Test Data feature is not available. For multiple-campaign 
surveys, you can generate test data if the survey contains at least one Survey Link, Social 
Media, or Offline Device campaign.
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• Import – Use this feature to import responses from a file or another survey into the current 
survey. For example, if you have collected the response data in a different survey and want to 
include this data into the current survey, select Import > From Other Survey on the Actions 
menu. 

 You can only import responses into a Generate Link campaign. The time should be set to UTC 
time zone.

• Export – Use this feature to export data from the Response Manager grid into different file 
formats using the Export option. Select the export file format from the list of file types, which 
includes .csv, .tsv, xlsx, and .spss. If you have Tableau configured for your workgroup, you can 
also export responses into Tableau by clicking the Export via Tableau button. This will generate 
a URL that you will paste into Tableau Web Data Connector to export responses into Tableau. For 
information, see Import data from EFM into Tableau using Tableau WDC, page 1099.
During the export process, you can customize how you want your data to be exported.

 You can also access the Export list on the toolbar of the Response Manager grid.

• Validate Record – Use this feature to clean data submitted by a respondent to account for skip 
patterns in your survey. This feature is only available if you select a certain response in the 
Response Manager grid.

• Validate All Records – Use this feature to clean data submitted by all respondents to account 
for skip patterns in your survey. This feature is only available if you select multiple responses in 
the Response Manager grid.

• Update Profiles – Use this option to update the profile information provided by panelists when 
responding the survey by using the Update Profiles option in the Actions drop-down menu on 
the Response Manager page. The Update Profiles option is available only for the Invite 
Panelist survey distribution method.

• Export Selected Responses to PDF – Export the responses that you need to the .pdf format. 
You can export single record and multiple records. For more information about exporting your 
responses to the .pdf format, see Print Respondent Record, page 989.

• Delete Selected Respondent – Use this feature to delete a selected respondent and all their 
response data from your Response Manager grid. This feature is only available if you select a 
respondent in the Response Manager grid.

 Some options on the Actions menu are disabled if no respondents are selected.

Date Filter
You can display response data based on the date when respondents provided their answers by clickig the 
Date Filter menu. For example, you can set the Date Filter to include responses from surveys that 
respondents completed today.

 If you select any Date Filter command, the response data is updated according to the current 
date.
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Schedule Export
You can schedule export and email delivery of the responses to the recipients to analyze answers 
externally. You can schedule export by Email, to Folder, and to SFTP. You can export file in .csv, .tsv, 
.xlsx, and .spss file format. If there is an organization hierarchy defined for a workgroup, the export of 
responses is scoped according to the user’s access level. For more information about scheduling import, 
see Schedule responses delivery, page 991.

 The scheduled export of responses is synchronized with the current date.

Frequency Chart

In your Response Manager grid, click the Frequency Chart icon   to view the Frequency Chart, 
which displays both the number and the percentage of respondents who answered the specified 
question.

Navigate the Response Manager grid
By default, the Response Manager grid only displays data for the first 10 respondents. To view more 
respondents per page, locate the View per Page options at the bottom of the Response Manager grid. 
Select the 25 link to display more respondents.
In addition, if your Response Manager grid is longer than one page, you can navigate between pages 
clicking the page navigation arrows in the lower-right corner of the Response Manager grid. 

Additional columns in the Response Manager grid
If a survey includes the Image Upload question, additional columns displaying the Image link and rate 
are displayed in the grid. 
To view the image:
• Click the Image link.

OR
• Click the image Record ID, and then in the Responses dialog box, click the Image link.
If an image contains geolocation data, two more columns displaying the image's latitude and longitude 
are displayed. Also, if a respondent added tags to the image, a column displaying these tags is shown.
Click the Image link in the Response Manager grid to open the Image dialog box where you can view 
the image itself, the date when it was uploaded, the location it was taken at, and the tags added to the 
image. You can also rate the image and download it by clicking the Download Image link.

 In the Image dialog box, you can change the rating previously added to the image.

You can download the response image from the Response Manager page. After clicking the Image link 
in the Response Manager grid, click the Download Image link below the displayed image. If the 
response image is deleted from the Images tab, it is also deleted from the Response Manager grid.
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Filter responses
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid > click the Filter button.

You can control which responses to display in the Response Manager grid. For example, you can exclude 
all responses that are larger than a certain value.
You can add, copy, move up or move down, and delete the criteria.

Procedure 
1 In the Response Manager grid, on the toolbar or on the Actions menu, click Filter.
2 In the Filter dialog box, click Add or Add Filter Criteria.
3 In the Add Filter Criteria dialog box, on the Source menu, select source data for your filter. 

You can choose data from the Current Survey, Columns (Participant Information,  Respondent 
System Information, or Respondent Location), Surveys, or Data Channels.

 The Data Channels group becomes available when at least one data channel is created for the 
survey.

If multiple campaign types are added to your survey, the Surveys group is not available on the 
Source menu. In the Surveys  group, the surveys with multiple campaigns are not available for 
selection. 

4 On the Fields menu, select a question or field to be checked against the criteria.
5 On the Expression menu, select the expression. 

The available options vary depending on the question type.
6 In the Value text box, specify the value that the field should match.
7 Click Add. 

You can combine your filters by selecting the check boxes and using menus with logical operators next 
to each criterion.

8 To see the result, in the Response Manager grid, click Apply Filter.
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Test Data Generator
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid > Actions menu  > click Generate Test Data.

With the test data generator, you can insert test data into your survey automatically. It is a quick and easy 
way to test your survey. You can specify how many responses you want to generate and whether the 
responses are distributed evenly or randomly. 

 Generate Test Data is available only when the survey is in the Design mode.

 The test data generator is intended for testing and demonstration purposes only. The process of 
generating test data includes inserting random data into your survey and cannot be undone, 
which can significantly affect your reports and analysis data.

On the Response Manager page, the generated test data appears. By default, the Response Manager 
grid shows the first 10 responses. To view more responses per page, click the View per Page option. 
Select the 25 link to display more responses. In addition, if the Response Manager grid is longer than 
one page, you can navigate between the pages by clicking the navigation arrows.

Generate Test Data

Procedure 
1 On the My Surveys page, create a new survey or open a saved one. 

The survey designer opens.
2 Go to the Analyze tab > Responses tab. 

The Response Manager page opens.
3 On the Actions menu, select the Generate Test Data option. 

The test data generator dialog box opens.
4 In the Number of Responses to Generate box, enter the number of responses that you want to 

generate. 
Default value is 100.

5 To enable even or random response distribution, in the Distribution Type box, select the 
corresponding option.

6 To include the responses for not answered and not asked questions,  in the Response Options 
section, select the corresponding check boxes.

7 To facilitate trending, in the Trend Options section, define the start and end dates. 

You can use the Calendar icon   or enter the dates into the calendar boxes manually.
8 Click Next. 
9 To begin the generating test data process, in the confirmation dialog box, click the Generate Test 

Data button. 
The test data is generated, and the task completion message appears.
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10 Click Close. 
In the Response Manager grid, the generated responses test data are displayed.
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Survey link in response data
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid.

You can access the survey through a piped link in the response data. The survey link is available in the 
responses grid and in the response record for all survey types. The survey link should start with a survey 
engine path for the current group to appear as a link, otherwise it appears as text.

 The survey engine path is specified on the Configuration tab > Publishing tab.

Procedure 
1 Go to the Responses tab.
2 In the Responses grid, in the response column, click the survey link. 

The survey opens for you.

 To access the response record, click the Record ID value in the specific row.
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Tracking the response source
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid > add the Response Source column (if not 
available).

You can track whether a survey is completed via the intercept, mobile, or any other channel to see which 
channels are the most popular. 
In the Response Source column, there are five types of response source that are displayed:
• Web Intercept – Survey responses received via a web intercept.
• Mobile – Survey responses received via a mobile browser.
• Online – Survey responses received via a survey link.
• Offline – Survey responses received via Mobile Survey PC Edition.
• SMS – Survey responses received via the SMS interface.
By default, the Response Source column is not available. You can add this column to the Responses 
grid by clicking the Columns button on the toolbar.

 View the Response Source column

Procedure 
1 On the Responses tab, click the Columns button. 
2 Click the arrow next to the Respondent Fields folder name to expand it.
3 Select the check box next to the Response Source column.
4 Click Apply. 

The column appears on the responses grid.

Filter by response source

Procedure 
1 On the Responses tab, click the Filter button. 
2 In the Filter dialog box, click the Add button or the Add Filter Criteria link. 
3 In the Add Filter Criteria dialog box, in the Source list, select Participant Information.
4 In the Field list, select Response Source.
5 In the Expression list, select "=" to include the survey responses in the filter or select "≠" to exclude 

them.



Manage Responses Tracking the response source

EFM User Guide 985

Confidential and Proprietary Information of Verint Systems Inc.

6 In the Value list, select the response channel by which you want to filter.
7 Click Add. 

The filter appears in the Filter dialog box.
8 Click the Apply Filter button.
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Referring URL
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid > add the Referring URL column (if not 
available).

You can view what web page the users are on when the intercept is displayed. Using this data, you can 
optimize the future deployment of the intercept. 
When the survey is taken from a mobile offline device, the ID of the device registered on the 
Administration tab appears in the Referring URL column.
By default, the Referring URL column is not available. You can add this column to the responses grid by 
clicking the Columns button on the toolbar.

View the Referring URL column

Procedure 
1 On the Responses tab, click the Columns button. 
2 Click the arrow next to the Respondent Fields folder name to expand it.
3 Select the check box next to the Referring URL field.
4 Click Apply. 

The column appears on the responses grid.
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Hiding the Email column
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid > Email column.

You can hide the Email column in the Responses grid. If you hide the Email column, you cannot add 
columns to your survey from other surveys. The Survey folder is hidden in the Select Columns dialog 
box.
By default, the Email column appears in the Responses grid.

Procedure 
1 On the Responses tab, click the Columns button. 
2 In the Select Columns dialog box, click the red arrow next to the Respondent Fields folder to 

expand it.
3 Clear the check box next to the Email field.
4 Click Apply. 

The Email column disappears from the  Responses grid.
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Displaying only complete responses
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid.

You can select the Completes Only response type so that only valid and full responses are included in 
the reports. This functionality is also available for the profiles. You can toggle between the two response 
types Completes Only and All Responses in the Responses grid and in the report designer. The All 
Responses option is selected by default.
This functionality applies only to the current response grid and report. Thus, different reports can have it 
activated or not. You can select between the following response types:
• Completes Only – Click to view complete responses only. The Responses grid is updated and 

shows the complete responses only. The response is set to complete status when the respondent 
submits the survey.

• All Responses – Click to view all responses. The responses grid is updated and shows all the 
responses.

In the report designer, you can toggle between the response types by selecting the Only show 
completed responses check box in the Filter Report Data dialog box.

Select the response type in the report designer

Procedure 
1 In the report designer,  on the toolbar, click the Filter Report Data button. 
2 In the Filter Report Data dialog box , select the Only show completed responses check box.
3 Click OK. 

The Completed Responses Only notification is displayed at the top of the report designer in yellow.
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Print Respondent Record
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > Actions menu on the toolbar > Print 
Selected Responses to PDF option.

You can export respondent records to the Adobe PDF format, and then print them to have a hard copy of 
how the person answered your survey. You can export single record and multiple records. The 
respondent record ID is included into the export file to differentiate responses from different users. 
Responses from different users are also separated by a page break. 
The following information is exported:
• Question Text
• Response
• Status

 You need to have permissions to export responses.

Print a single response to PDF

Procedure 
1 In the Response Manager grid, click the respondent record that you want to export.
2 In the Responses dialog box, click the Export Response to PDF link in the upper-right corner.

The file is exported to the Adobe PDF format.
3 Click the link with the file name to save or open the file.
4 Click Close.

Print multiple responses to PDF

Procedure 
1 In the Response Manager grid, select the check boxes next to the responses that you want to 

export.

 To select all records on the page, select the check box to the left of the Record ID column. To 
select all records on all pages, click the Select all "N" entries in this grid link.

2 On the Actions menu on the toolbar, click Export Selected Responses to PDF.
The file is exported to the Adobe PDF file format.

3 In the Print Responses to PDF dialog box, click the link with the file name to save or open the file.
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 If the amount of selected responses is too large for export, select fewer responses and export 
again.

4 Click Close.
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Schedule responses delivery
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > Schedule Export list > click the  Email, 
Folder, or SFTP delivery type.

You can schedule export of the survey responses to analyze externally.
If there is an organization hierarchy defined for a workgroup, the export of responses is scoped according 
to the user’s access level.
The following schedule export options are available:
• Schedule Export by Email, page 992
• Schedule Export to Folder, page 994
• Schedule Export to SFTP, page 995

 If you close a survey, the scheduled responses export is performed one more time. If you reopen 
the survey, the export of responses is performed till the scheduled date expires.
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Schedule Export by Email
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > Schedule Export list >   Email.

You can schedule export and email delivery of responses to the recipients.

 If you close a survey, the scheduled responses export is performed one more time. If you reopen 
the survey, the export of responses is performed till the scheduled date expires.

Procedure 
1 On the Responses tab, in the Schedule Export list, click Email.
2 On the Schedule Export Delivery Page, in the Select Format list, select the file format of the 

report (CSV, TSV, Microsoft Excel, or SPSS). If you want to zip the attachment, click the Zip 
attachments check box, and the report in the selected format is attached to the email message in a 
ZIP archive.

 If you want to specify the formatting options for your scheduled response exports, click the 
Export Options link next to the Select Format list, and then select the appropriate options.
In the Export Responses dialog box, after saving the formatting option specifications, the 
generated export file of the next scheduled occurrence adhere to the last customized specified 
format options.

 If you applied a filter in the Export Responses Scheduled dialog box for your scheduled 
response exports previously, you need to make sure that your newly set filter is enabled for the 
next scheduled export. To enable the currently applied filter to your report when scheduling 
export of your responses not for the first time, on the Schedule Export Delivery page, click the 
Export Options link, in the Export Responses Scheduled dialog box, make sure that the 
Current Filter option is selected, and then click Save.

3 To add the recipients, do the following:
a. In the To text box, type the email address.

 You can add multiple addresses separating them by commas or semicolons.

b. If there are organizations in a workgroup, you can click the To button to select the recipients. In 
the Survey Responses Recipients dialog box, select a check box next to the user or 
organization, click the right arrow button to add them to the Recipients list, and then click OK.

4 In the From text box, specify the email address from which you want to send your message. By 
default, your email address is selected.

5 In the Subject text box, type the message subject. 
By default, it is Responses for <survey name>.

6 In the email body, type the message text and customize it by using the editing toolbar.
7 To preview your message, click the Preview button.
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8 To test your message before delivering it to the recipient, do the following:
a. Click the Send Test Email button.
b. In the Send Test Email dialog box, in the Email Address field, type the test email address, and 

then click the Send button.
9 In the Delivery Schedule section, define when and how to deliver the responses:

• No Scheduling – Select to send your message later. You may need it if you have not finished 
adding recipients or writing your message, or have not yet decided when to send the message. 
This option removes scheduling and stops sending of email notifications.

• Send Now – Select to end your message immediately.

 There may be a delay of several minutes before your email is delivered.

• Send at a specific date and time – Specify a date and time when you want to deliver your 
email message. Select a valid start date and time; otherwise, the email message will not be saved.

 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set an end date or select No End Date.

10 Click Save.

 When the Send Now option is selected in the Delivery Schedule section, the Send Report 
button is displayed instead of the Save button.
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Schedule Export to Folder
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > Schedule Export list > click  Folder.

You can schedule export of responses to the EFM local folder, which is located in {EFM Install}\AppData\
{groupID}\Responses\{projectID}.

 If you close a survey, the scheduled responses export is performed one more time. If you reopen 
the survey, the export of responses is performed till the scheduled date expires.

Procedure 
1 On the Responses tab, in the Schedule Export list, click Folder.
2 On the Schedule Export Delivery Page, in the Select Format list, select the format of the file (CSV, 

TSV, Microsoft Excel, or SPSS) to export to the EFM local folder. The file in the selected format will be 
exported to the EFM local folder.

 If you want to specify the formatting options for your scheduled response exports, click the 
Export Options link next to the Select Format list, and then select the appropriate options.
In the Export Responses dialog box, after saving the formatting option specifications, the 
generated export file of the next scheduled occurrence adhere to the last customized specified 
format options.

 If you applied a filter in the Export Responses to Folder Scheduled dialog box for your 
scheduled response exports previously, you need to make sure that your newly set filter is 
enabled for the next scheduled export. To enable the currently applied filter to your report when 
scheduling export of your responses, on the Schedule Export Delivery page, click the Export 
Options link, in the Export Responses to Folder Scheduleddialog box, make sure 
that the Current Filter option is selected, and then click Save.

3 In the Delivery Schedule section, define when and how to deliver the responses:
• No Scheduling – Select to end your file later. You may need it if you have not yet decided when 

to export file. This option removes scheduling and stops sending of email notifications.
• Export Now – Export responses immediately.
• Export at a specific date and time – Specify a date and time when you want to export your 

file. Select a valid start date and time; otherwise, the file will not be saved.

 To schedule a regular export (daily, weekly, or monthly), click the Show Recurrence Options 
link. You can also set an end date or click No End Date.

4 Click Save.

 When the Export Now option is selected in the Delivery Schedule section, the Export Now 
button is displayed instead of the Save button.
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Schedule Export to SFTP
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > Schedule Export list > click  SFTP.

You can schedule export of responses to SFTP.

 If you close a survey, the scheduled responses export is performed one more time. If you reopen 
the survey, the export of responses is performed till the scheduled date expires.

Procedure 
1 On the Responses tab, in the Schedule Export list, click SFTP.
2 On the SFTP Delivery Page, in the Select Format list, click the needed file format: CSV, TSV, 

Microsoft Excel, or SPSS. The report in the selected format will be exported to the set location.

 If you want to specify the formatting options for your scheduled response exports, click the 
Export Options link next to the Select Format list, and then select the appropriate options.
In the Export Responses dialog box, after saving the formatting option specifications, the 
generated export file of the next scheduled occurrence adhere to the last customized specified 
format options.

 If you applied a filter in the Export Responses to SFTP Scheduled dialog box for your 
scheduled response exports previously, you need to make sure that your newly set filter is 
enabled for the next scheduled export. To enable the currently applied filter to your report when 
scheduling export of your responses, on the SFTP Delivery page, click the Export Options link, 
in the Export Responses to SFTP Scheduled dialog box, make sure that the Current 
Filter option is selected, and then click Save.

3 In the SFTP Settings sections, configure your SSH FTP connection:
• Server name – Name of the server where SFTP is located and where you want to export the file.
• Port – Port number for the specified server.
• Path – Location on a server to where you want to export the file.
• User Name – User name for the specified server.
• Password – Password for the specified server.

4 To validate connection, click Test Settings.
5 In the Delivery Schedule section, define the responses delivery schedule and the recurrence 

options. The following options are available:
• No Scheduling – Send your file later. You may want to select it if you have not yet decided when 

to export file. This option removes scheduling and stops sending of email notifications.
• Export Now – Export responses immediately.
• Export at a specific date and time – Specify a date and time when you want to export your 

file. You can either type the date and time manually into the available text field or select the date 
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and time from pop-up menus. Select a valid start date and time, otherwise the file will not be 
saved.

 Click the Show Recurrence Options link to set recurrence options for your file delivery. Use 
this functionality to export a file multiple times on a daily, weekly, or monthly basis. You can also 
set an end date or select No End Date.

6 Click Save.

 When the Export Now option is selected in the Delivery Schedule section, the Export Now 
button is displayed instead of the Save button.
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Displaying only valid question responses
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > click the response ID.

You can filter the respondent record to view only valid responses by selecting the Only show valid 
question responses check box. By default, the Only show valid question responses check box is 
not selected.
When you export the respondent record to the Adobe PDF format, the exported file data is displayed 
depending on the Only show valid question responses option. If the Only show valid question 
responses check box is selected, only valid responses are displayed in the exported file.

 You can also access the Only show valid question responses option in the View Responses 
dialog box of the Text Analytics report elements.

 



Manage Responses Validating records

EFM User Guide 998

Confidential and Proprietary Information of Verint Systems Inc.

Validating records
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > Actions menu  > Validate Record option.

This topic explains how data that is submitted by respondents can be cleaned to account for skip 
patterns in the survey. This is useful in four cases:
• Jump – A respondent uses the Jump button to answer a question that violates a skip pattern 

inside the survey.
• Branching – A respondent answers a question that has branching logic in it, uses the Back 

button to change their previous answer and proceeds down a different branching logic line.
• Conditional Choice/Question/Page – A respondent answers a question that has a Conditional 

Choice on a response option, uses the Back button to change the previous answer, and proceeds 
to a different page due to the Conditional Logic of the new response.

• Drilldown – A respondent answers the preliminary question and is taken to the Table question 
where only the table topics of their previous answered questions are displayed. Later, the 
respondents use the Jump or Back button to deselect their answers to the preliminary question, 
but never revisit the Table question to clear this data. Validate Records will remove the data 
from topic(s) in the Table question where the topic(s) in the preliminary question is now 
unanswered.

If a respondent does not see a question due to the designed survey logic, the choices of the skipped 
question are recorded as NULL* (not asked) in the Response Manager.
For Choose Many, Choose Many with Image, and Choose Many Matrix questions, a choice (column 
or row) that is not displayed to the respondent (due to using Hidden, Conditional Visibility, Number 
of Rows Visible options, or piping) is also recorded as NULL* (not asked) in the Response Manager.
All report elements that support Choose Many, Choose Many with Image, or Choose Many Matrix 
questions record choices as the following values: NULL (not asked), 0 (not selected), and 1 (selected). 
NULL is the database value that is displayed as blank space in the EFM application.
If you plan on using the Validate Records function in the EFM application, adhere to the following 
additional restrictions on branching; otherwise, unintended data deletion may occur.
• The advanced branch checkpoint question must be the last question on a page.
• A question that has basic branching in it must be the last question on a page.
• The target question of a branch must be the first question on a page.
Records in the database can be validated either one at a time or all at once. Steps for how to do both are 
included in the sections below.

Validate a single record

Procedure 
1 On the My Surveys page, open a saved survey to validate its data. 

The survey designer opens.
2 Click the Analyze tab. 
3 On the Reports page, click the Responses tab. 
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4 On the Response Manager page, select a response record to validate.
5 On the Actions menu, select Validate Record.

Validate all records

Procedure 
1 On the My Surveys page, open a saved survey to validate its data. 

The survey designer opens.
2 Click the Analyze tab. 
3 On the Reports page,  click the Responses tab. 
4 On the Actions menu, select Validate All Records. 
5 To validate all records page, type YES in all caps, and then click OK. 

To leave the database records as they were, click Cancel.

 While the records are being validated, a system busy message is displayed.

6 Click Close.
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Last Page Visited
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid  > add the Last Page column (if not available).

You can view the last page the respondent visited in your survey. So, you can track where most 
respondents are leaving the survey, and then edit the survey to improve the response rates. The page 
name is available in the Last Page column on the Response Manager page. This column displays the 
name you defined for this page during the survey creation. The page you see in the column is the last 
page where the respondent clicked Next or Submit in your survey.
By default, the Last Page column is not available. You can add this column to the Response Manager 
page by clicking the Columns button on the toolbar. Also, you can select the View Data Type > Raw 
Data on the Actions menu to view the page values that are stored in the database. The values are the 
survey page URLs.

 You can export the Last Page column, but cannot import it.

In the Modern survey rendering mode, the page name and page URL are not available, only page ID. You 
can view the page ID if you select the View Data Type > Raw Data on the Actions  menu.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

View the Last Page column

Procedure 
1 On the Response Manager page, click the Columns button. 
2 Click the red right arrow next to the Respondent Fields folder name to expand it.
3 Select the check box next to the Last Page field.
4 Click Apply. 

The column appears on the Response Manager page.
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Filtering by the Last Visited Page
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Response Manager grid > click Filter.

You can filter the report data by the Last Page column. The Last Page column displays the names of 
the last pages the respondents visited in your survey. The filter by the last pages is available on the 
Response Manager and Manage Participants pages. 
Survey pages may have custom names, for example, "Entertainment" instead of "Page 2", but it does not 
affect the work of the filter.
In the Modern survey rendering mode, the page name and page URL are not available, only page ID. You 
can view the page ID if you select the View Data Type > Raw Data on the Actions menu.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

Procedure 
1 On the Response Manager page, click the Filter button. 
2 In the Filter dialog box , click the Add button or the Add Filter Criteria link. 

The Add Filter Criteria dialog box opens.
3 In the Source list, select Participant Information.
4 In the Field  list, select Last Page.
5 In the Expression list, select the appropriate expression, for example, "<".
6 In the Value  list, select the survey page by which you want to filter the data, for example, "Page 4".
7 Click Add. 

The filter appears in the Filter dialog box.
8 Click the Apply Filter button. 

The responses from respondents who left the survey on pages 1-3 appear.
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Branched Out and Over Quota columns in reporting
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new survey or open an existing one > 
Collect tab > select the survey distribution method > Manage Participants or Responses page > 
Branched Out and Over Quota columns.

You can track the time when respondents were branched out of your survey or reached the over quota 
limit. The time is available in the Branched Out and Over Quota columns correspondingly. The 
Branched Out and Over Quota columns appear by default.
Also, you can view the Branched Out and Over Quota columns in the Participant Information dialog 
box.

 The Over Quota column appears only if the Quota Management functionality is available for 
your workgroup.

If a respondent goes back to a survey and changes the answer to the survey, the last survey status wins. 
For example, if the respondent is branched out, and then goes back and completes the survey, the 
respondent's status is Completed. If the respondent completes the survey, and then goes back, changes 
the answers, and is branched out, the respondent's status is Branched Out.
 



Manage Responses Filtering by Branched Out and Over Quota

EFM User Guide 1003

Confidential and Proprietary Information of Verint Systems Inc.

Filtering by Branched Out and Over Quota
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new survey or open an existing one > 
Analyze tab > Responses tab > Filter button.

You can filter a report by the Branched Out and Over Quota date. So, you can better manage your 
reporting data by either including the Branched Out and Over Quota responses into your report or 
removing such responses from it.
The filters are available in the various locations, including the Responses page, the Manage 
Participants page, and the report designer.

Set a Date over quota filter in the report designer

 The Date over quota option appears only if the Quota Management functionality is available 
for your workgroup.

Procedure 
1 In the report designer, click the Filter Report Data button. 
2 Click the Add Another Criteria link.
3 In the Question list, select the Date over quota option.
4 In the Expression  list, select <=>.
5 Set the date by which you want to filter the Over Quota responses in the Value text box. For 

example, 10/23/2011.
6 To save the filter criteria, click the Save link.
7 Click OK.

All responses that are over quota on 10/23/2011 appear.

 You can use the similar steps to create a Date Branched Out filter.

 

Set a Branched Out filter on the Manage Participants page

Procedure 
1 On the Manage Participants page, click the Filter button.
2 In the Filter dialog box, click the Add button or the Add Filter Criteria link. 
3 In the Add Filter Criteria dialog box, in the Source list, select Participant Information.
4 In the Field list, select the Branched Out option.
5 In the Expression  list, select <=>.
6 In the Value field, set the date by which you want to filter the Branched Out responses. For 

example, 1/6/2018.
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7 Click Add. 
The new filter appears in the Filter dialog box.

8 Click the Apply Filter button. 
On the Manage Participants page, you can view participants who are branched out on 1/6/2018.

 You can use the similar steps to create an  filter.

Set a Branched Out Date filter on the Response Manager page

Procedure 
1 On the Responses page, click the Date Filter button, and then select the period by which you want 

to filter the responses. 
2 Select the Branched Out Date option.
3 Click OK. 

All responses that are branched out during the specified time period appear in the Responses grid.

 You can use the similar steps to create an Over Quota Date filter.
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Export response data
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Quick Download option > download your responses to a variety of formats.

You can now download your responses in the .xlsx, .csv, .tsv, or .spss. The Quick Download feature is 
available for a survey in the Design, Open, or Closed status.
All response data from the current survey is exported with the question headings and choice labels.
By default, the report values for question choices start at 1 and can be overridden by entering a value 
starting at 0 (zero). The report values for Not Answered questions have a definition of 0 (zero).
When exporting response data using Export Values, unanswered questions are set to the Not Answered 
value of 0 (zero). So any export value set to 0 (zero) is indistinguishable from the Not Answered value.
When exporting response data using Report Values, the unanswered questions are left blank. So a 
report value set to 0 (zero) is distinguishable from the Not Answered value.

Procedure 
1 Click the Analyze tab. 

The Analyze landing page appears if you do not have any reports yet.
2 Click the appropriate button to download the responses to a file. 

The available options are Download to Excel, Download to CSV, Download to TSV, and Download 
to SPSS.

3 The export file is generated in the selected format.

 Time stamps are exported in your local time zone.

4 Click the link that appears to save or open the file.
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Export to CSV
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Export to CSV feature.

The Export to CSV feature enables you to save survey response data to your computer in the .csv 
format. You can access this feature on the Actions menu > Export > CSV option or directly on the 
toolbar.

Procedure 
1 On the Export menu, select CSV. 

The Export Responses dialog box opens.

 If your export includes options marked with an asterisk, you cannot import the data back into 
the application.

2 To display a dialog box with a download link to the export file, select the appropriate options, and 
then click Next.

3 Click the link that appears to save or open the file.
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Export to Excel
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Export to Excel feature.

The Export to Excel feature enables you to save survey response data to your computer in the 
Microsoft Excel format. You can access this feature on the Actions menu > Export > Microsoft Excel 
option  or directly on the toolbar.

Procedure 
1 On the Export menu, select Microsoft Excel. 

The Export Responses dialog box opens.

 If your export includes options marked with an asterisk, you cannot import the data back into 
the application.

2 To display a dialog box with a download link to the export file, select the appropriate options, and 
then click Next. 

3 To save or open the file, click the link that appears.
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Excel export restrictions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new one > 
Analyze tab > Responses tab > Export menu > Microsoft Excel option.

If you export a large amount of responses to Microsoft Excel, which may consume a lot of memory, the 
export is restricted. In such case, you are offered to export responses to the .csv file format. If you agree, 
the system automatically exports all data to the .csv file, which you try to export to Microsoft Excel. You 
can open the .csv file with Microsoft Excel.

Export large data sets to Microsoft Excel

Procedure 
1 On the Export menu, select Microsoft Excel. 
2 In the export restriction dialog box, click the Export to CSV button. 
3 In the Export Responses dialog box, select the appropriate options, and then click Next. 
4 Click the download link. 
5 In the File Download dialog box, click Save.

Export large panelist data to Microsoft Excel

Procedure 
1 Go to the Panel tab > Panelists tab.
2 On the Actions menu, point to Export, and then click Microsoft Excel. 

For the large datasets, the export is restricted.
3 Click the Export to CSV button. 
4 In the Export Panelists dialog box, click the download link, and then save the file.
5 Import the saved .csv file into Microsoft Excel.
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Export to SPSS
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Export to SPSS feature.

With the Export to SPSS feature, you can save the survey response data to your computer in the SPSS 
format. You can access this feature using the Export > SPSS option on the Actions menu or directly on 
the toolbar.

Procedure 
1 On the Export menu, select SPSS. 
 

2 In the Export Responses dialog box, in the Columns section, select data export options:
• Displayed Data – Only data available at the Responses side tab will appear in the exported file.
• All Response Data from the Current Survey – All response data from the current survey is 

exported with the question headings and choice labels.
3 In the Filter section, define if any filter is applied to the exported response data:

• No Filter – With this option, the exported file uses no filters.
• Current Filter – This option applies the current filter to the exported response data.

4 In the Content section, select the content type to export:
• Raw Values with Choice Labels – Export numeric database code values that you have defined 

in your survey as the response options and text associated with responses. For not selected 
responses the code value is set to 0. For each selected response the code value is set to 1.

• Report Values with Choice Labels – Export positive whole numbers that you have defined in 
your survey as the response options and text associated with responses. Report values should be 
set to unique values for SPSS Analysis.

• Export Values – Export alphanumeric values that you have defined in your survey as the 
response options.
If the question or at least one of the question choices has an export value defined only as 
numeric, after exporting the responses to SPSS, in the SPSS Data Dictionary, the value type for the 
corresponding question or choice is displayed as Numeric in the Type column.
If the question or at least one of the question choices has an export value defined as 
alphanumeric, after exporting the responses to SPSS, in the SPSS Data Dictionary, the value type 
for the corresponding question or choice is displayed as string in the Type column.
If the export values are not defined in the question or question choices, after exporting the 
responses to SPSS, in the SPSS Data Dictionary, the value type for the corresponding question or 
choice is displayed as Numeric in the Type column.

5 Define missing value for not asked Choose One and Choose Many questions by selecting the 
corresponding check box. By default, this option is not active. The system value appears in the export 
file when the option is not active.

6 Enter the whole number for missing value into the text box. 
The default value is set to 99999999.

7 Click Next.
8 In the opened dialog box, click the link that appears to save or open the file.
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Export the Unicode languages to SPSS
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Export to SPSS feature.

You can export survey responses to SPSS in any Unicode language such as Hebrew, Korean, or Japanese. 
Unicode is supported in SPSS versions 16 and higher. 
You need to have SPSS version 16 and higher on your computer to view the Unicode languages in 
exported file. The Unicode character encoding must be set in SPSS to view the data.

Procedure 
1 Open SPSS.
2 On the Edit menu, click Options. 

opens.
3 In the Options dialog box, on the General tab, select the Unicode option.
4 Click Apply.
5 Click OK.
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Export to TSV
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Responses tab > Export to TSV feature.

The Export to TSV feature enables you to save survey response data to your computer in the .tsv 
format. You can access on the Actions menu > Export > TSV feature  or directly on the toolbar.

Procedure 
1 On the Export menu, select TSV. 

The Export Responses dialog box opens.

 If your export includes options marked with an asterisk, you cannot import the data back into 
the application.

2 To display a dialog box with a download link to the export file, select the appropriate options, and 
then click Next.

3 Click the link that appears to save or open the file.
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Downloading reports
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Reports page > Download Report menu.

You can export your reports to the Microsoft Word, Microsoft PowerPoint, or Adobe PDF format and 
create a cluster report to view the report results outside of the product. You can export reports from the 
Reports page or from a report designer using the Download Report menu.

 The appearance of the exported report differs from the online report because the theme and 
table appearance changes are unavailable in the exported files. However, the Question Text 
Color and Question Description Color of custom report themes are rendered correctly in the 
exported reports.

You can use the Export Free-Form Text Questions option in the Report Export dialog box for 
PowerPoint to include all the Response List report elements in your report. The Response List report 
element is often used for comment-essay questions, which may contain a lot of text. If you want to 
include the survey comments into the exported reports, use the Microsoft PowerPoint output format 
because it extends the comments table into multiple slides, if required.
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Cluster Reports
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Reports page > Download Report menu > Cluster Report option.

With a cluster report, you can filter survey responses by a single question and view the exported results in 
the Adobe PDF, Microsoft Word, or Microsoft PowerPoint format outside of the product. 

 The appearance of the exported report differs from the online report because the theme and 
table appearance changes are not reflected in the exported files.

Create a Cluster Report

Procedure 
1 On the Reports page, create a new report or open a saved one. 
2 On the report designer page, on the Download Report menu on the toolbar, select Cluster Report.
3 In the export report dialog box, in the Question list, define the base question for the cluster report.
4 To add a brand logo to your report, select the Include Brand Logo check box.
5 Select the output format for your cluster report. 

The available options are PDF, Microsoft Word, and PowerPoint.
6 Enter the minimum number of responses required to generate a report into the corresponding text 

box.
7 Click OK. 

Your cluster report is generated as a ZIP archive.
8 To save or open the exported cluster report, click the link that appears.
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Completes Only notification in exported reports
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab >Reports page > create a new report or open a saved one > Filter Report Data button  > 
Filter Report Data dialog box > Other section > click Only show completed responses > click OK >  
Download Report menu  > export a report.

You can filter the report data so that only valid and full responses are included in the reports. When you 
export the report containing only completed responses to the Microsoft Word, Microsoft PowerPoint, 
and Adobe PDF formats or create a cluster report, the corresponding notification appears in the export 
file.

 For more information on the report filters, see Filters, page 723.

Procedure 
1 Open the report on the report designer page.
2 Click the Filter Report Data button on the toolbar. 
3 In the Filter Report Data dialog box, in the Other section, select the Only show completed 

responses check box.
4 Click OK.
5 On the Download Report menu, export the report data. 

In the exported report, you can see the notification that only completed responses are included in the 
report.
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Weighting overview
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab.
You can calculate a specific weight per survey respondent to ensure an accurate representation of a 
specific population, for example, Males vs. Females, within the data set. The main idea of weighting is to 
increase or decrease the importance of responses provided by one group of respondents as compared 
with another group in the demographic calculations, for example, to make sample response data set look 
more preferable.
When you click the Weighting tab, the Weighting page opens. On the toolbar, click the Add Criteria 
button to add new criteria for response weighting calculation.
On the Weighting grid, the following sections are available:
• Questions – Shows the survey question response choices selected for weighting.
• Actual – Shows the actual number and percentage of response choice selected by respondents.
• Desired – You can define the custom percentage of response choices, which you want to 

calculate by weighting. By default, the Desired (N) and Desired (%) fields are empty. When you 
change the Desired (%) value, the Desired (N), Weight, and Remaining Respondents fields 
are updated automatically.

• Weight – Shows the calculated weight for the corresponding response choice. The weight is 
calculated as follows:
Desired Percent / Actual Percent = Weight

• Remaining Respondents – Shows the number and percentage of respondents not covered by 
any weighting criteria.
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Define weighting for the Choose One questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > report landing page.
4 Click the Weighting tab. 
5 On the Weighting page, click the Add Criteria button or Add Criteria link.
6 In  the Add Criteria dialog box, select the Choose One survey question.

 Hover over the question to see the tool tip with the question and its response choices.

7 Click Next. 
8 In the response choices selection dialog box, select the response choices that you want to cover by 

weighting criteria.

 You can group responses if you want. For details on grouping responses, see Define weighting for 
Choose One questions grouping, page 1020.

9 Click Finish. The defined weighting criteria show on the Weighting page.
10 In the Desired (%) text box, enter the weighting percentage that you want to define for each 

response choice.
The weighting scheme is updated and saved automatically.
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Define weighting for the Choose Many questions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab.

Procedure 
1 Go to the Design & Collect tab > Surveys tab.
2 On the My Surveys page, create a new survey or open an existing one.
3 Go to the Analyze tab > report landing page.
4 Click the Weighting tab. 
5 On the Weighting page, click the Add Criteria button or Add Criteria link.
6 In  the Add Criteria dialog box, select the Choose One survey question, and then click Next.

 Hover over the question to see the tool tip with the question and its response choices.

7 To create a segment for weighting, click  the Add Segment button or Add Segment link. 
8 In the Add Segment dialog box, on the Required State menu, select  the state for each choice to 

determine which states should be covered by the segment.
The following options are available:

• Not Selected – The respondents do not select this choice in your survey.
• Selected – The respondents select this choice in your survey.
• Any State – The response choice selection does not matter.
9 Click Add. 

 The segments must be mutually exclusive.

10 To delete a segment, select the check box next to the segment you want to delete, and then click the 
Delete button.

11 Click Finish. 
12 In the Desired (%) text box, enter the weighting percentage that you want to define for each 

response choice.
The weighting scheme is updated and saved automatically.
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Define weighting for the Fill in the Blank question
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab.
You can define a weighting scheme for the Fill in the Blank questions with the Numbers input type only.

Procedure 
1 Click the Analyze tab. 
2 Click the Weighting tab in the left pane. 
3 On the Weighting page, click the Add Criteria button or Add Criteria link in the working area.
4 In the questions selection dialog box, select the Fill in the Blank survey question from the list to 

segment the data for it.

 Hover over the question to see the tool tip with the question and its response choices.

5 Click Next. 
6 In the range creation dialog box, click the Add Range button or the Add Range link in the working 

area to add a range of values for the segment.
7 Define the range of numeric values that should be covered by the segment. The ranges cannot 

overlap.

 You can either enter the value in the field or drag the slider.

• Enter the minimum value in the >= field.
• Enter the maximum value in the < field.
The minimum and maximum values are set to -2147483648 and 2147483647 correspondingly.

 To delete a range, click the  icon. To add more ranges, click the Add Range button.

8 Click Finish. The actual number and percentage show on the Weighting page.
9 Enter the custom weighting percentage you want to define for each response choice in the 

corresponding field under Desired (%). Your changes are saved automatically.
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Define weighting for Choose One questions 
grouping

Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab.
When adding criteria to a weighting scheme for the Choose One questions, report authors can select two 
or more response choices to group. All values in the group are calculated as a cumulative total. For details 
on weighting functionality, see Weighting overview, page 1016.

Procedure 
1 On the Weighting page, click the Add Criteria button or Add Criteria link in the working area.
2 In the questions selection dialog box, select the survey question from the list.

 Hover over the question to see the tool tip with the question and its response choices.

3 Click Next.
4 In the response choices selection dialog box, select the check boxes next to the response choices that 

you want to group, and then click the Group button.

 The Group button is only active if you select more than one response choice.

5 The response choices are shown as a group.

 To ungroup the response choices, select the check box next to the response choices group, and 
then click the Ungroup button.

6 Click Finish. The actual number and percentage are shown on the Weighting page.
7 Enter the custom weighting percentage you want to define for each response choice in the 

corresponding field under Desired (%). Your changes are saved automatically.
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Weighting – Role-Based Access
Navigation

Administration tab > Roles tab > Roles page.
Group administrator can control the workgroup members' access to the weighting functionality based on 
the user role set of permissions. You can enable weighting for a user by creating a new role or editing the 
existing ones on the Roles page. For details on weighting functionality, see Weighting overview, 
page 1016.
By default, weighting is available for all roles that have access to Manage Responses, except for the 
Translator role. The weighting permissions are only related to defining the weighting schemes. All users 
can view a report that has weighting applied as long as they have permissions to view the report. If the 
weighing criteria are defined for a survey, all users that have the right to edit the report can turn weighing 
on or off at the report level but they cannot define weighting criteria unless they have permissions to do 
it.
When copying the report that has weighting applied, the weighting scheme is copied too. However, the 
users copying the report cannot edit the weighting criteria but can turn the weighting on or off at the 
report level if they have permissions to edit the report.
So, if you do not have permission to define a weighting scheme, you can only view or use the weighting 
schemes defined by other users. In such case, the Weighting tab does not appear.

Procedure 
1 Administration tab > Roles tab.
2 On the Roles page, click the name of the role that you want to edit. 
3 On the Edit Role page,  in the Surveys section, select the Define Weighting Schemes check box.
4 Click Save.

 For more details about user roles, see Roles, page 1378.
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Weighting – View Count and Percent
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab > add weighting criteria.
Report authors can view the actual number and percentage for the respondents covered by the weighting 
criteria. In addition, they can view the number of remaining respondents. Report authors can also define 
the desired percentage for the respondents covered by the weighting criteria to change the response 
weight. For details on weighting functionality, see Weighting overview, page 1016.
When you add the weighting criteria, the actual Count and Percent of response choices are shown under 
Actual.
You can enter the custom weighting percentage that you want to define for each response choice in the 
corresponding Desired (%) text box. The calculated weight for the corresponding response choice is 
shown in the Weight column.

 The desired values cannot be negative or exceed 100%.
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Weighting by Completes Only
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab.
On the Weighting page,  you can toggle between the two response types — Completes Only and All 
Responses. The Completes Only option is selected by default.
• Completes Only – Click to view complete responses only. The weighting scheme is updated and 

shows the counts, weights, and percentages for complete responses only.
The response complete status is based on the response being set to complete status when the 
respondent takes the survey.

• All Responses – Click to view all responses. The weighting scheme is updated and shows the 
counts, weights, and percentages for all responses.

 When you toggle between the response types, the Desired (%) values do not change.

You can also see the updates in the saved report with the weighting scheme applied.
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Adding multiple questions to a weighting scheme
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab.
You can combine multiple questions into one weighting scheme. You can define multiple questions as 
separate criteria for the weighting scheme. Each defined question is shown in a separate column.

 For the steps on how to add weighting criteria, see Weighting overview, page 1016.

Delete questions from the weighting scheme

Procedure 

1 On the Weighting page, click the  icon next to the name of the question that you want to delete 
from the weighting scheme. 

 Deleting the question affects the entire weighting scheme. If you delete a question from the 
weighting scheme, all weighting data is removed from the Desired and Weight columns.

2 In the confirmation dialog box, click Delete. 
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Apply weighting to report
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab > Weighting page > add weighting criteria to a survey > 
Project Reports page > create a new report or open an existing one > Weighting button.
You can apply previously defined weighting scheme to a report when naming the report or designing it. 
When you name a report, you can apply weighting to it by selecting the Apply weighting scheme to 
report check box in the Name Your Report dialog box.

 For more details about weighting functionality, see Weighting overview, page 1016.

Additionally, you can either turn on or turn off weighting for a report during the report design process 
using the Weighting button on the toolbar in the report designer.
When you activate the weighting functionality, all report elements in the report except the Text Analytics 
report elements have weighting applied by default. Weighting is also applied to any new elements you 
add to the report. When weighting is applied, the corresponding notification shows for all report 
elements.

 You cannot apply weighting scheme to the Correlation and Response List report elements.

Procedure 
1 Create a new report or open a saved report in the report designer.
2 On the Weighting page, define a weighting scheme.

 For more details about how to define a weighting scheme,  see Weighting overview, page 1016.

3 On the toolbar, click the Weighting button.
4 To enable the weighting scheme for your report, in the Weighting dialog box, select the On option.
5 Click OK. 
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Apply weighting to report elements
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab > Weighting page > add weighting criteria to a survey > 
Project Reports page > create a new report or open an existing one.
Report authors can apply previously defined weighting scheme at the report element level. You can turn 
on weighting for a report element by selecting the Display Weighted Values check box in the Data 
properties menu.
When the weighting scheme is applied to the report element, additional check boxes appear in the 
Displayed Values properties menu. You can select the Show Total Responses and Show Total 
Responses Weighted check boxes to display additional values in the report element.
• Show Total Responses – Select this check box to display the total number of responses.
• Show Total Responses Weighted – Select this check box to display the total number of 

responses covered by weighting.

 If you export the report element that contains weighting scheme to the Adobe PDF, Microsoft 
Word, or Microsoft PowerPoint format, the exported report elements also contain the weighting 
scheme.

The selected values are shown in the report element along with the notification that the weighting 
scheme is applied.

 Applying weighting scheme to the report element also affects the shared reports and widgets. If 
you update the weighting scheme, the shared reports and widgets that contain weighting scheme 
are updated accordingly.

Procedure 
1 On the Project Reports page, create a new report or open an existing one.
2 Add any report element to the report.
3 In the Data section, select the Display Weighted Values check box.

 The Display Weighted Values check box is only available if you have a weighting scheme 
defined. For details on how to define a weighting scheme, see Weighting overview, page 1016.

4 Click the Displayed Values menu to expand it.
5 To display the total number of responses, select the Show Total Responses check box.
6 To display the total number of responses covered by weighting, select the Show Total Responses 

Weighted check box.
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Applying weighting manually to large datasets
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
> Design tab > Analyze tab > Weighting tab > Weighting page > add weighting criteria to a survey > 
Project Reports page > create a new report or open an existing one. 
A weighting scheme is applied automatically to the new survey responses since the weighting scheme was 
last applied or updated. The weighting scheme is not applied automatically to the survey responses if the 
number of responses exceeds 10,000 or the weighting scheme contains more than 100 rows. In these 
cases, the Apply link appears in the report designer. You can use the Apply link to apply the weighting 
scheme to the survey responses manually.
Also, weighting scheme is not automatically applied to the public reports and widgets. Public reports and 
widgets that contain weighting scheme are updated when you update the original report.

Procedure 
1 In the report designer, click the Apply link.

 The Apply link appears for large datasets only.
 

2 In the Weighting dialog box, click Apply. 
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Administration reports overview
Navigation

Report & Analyze tab > Administration Reports  tab.

You can quickly generate and view information on survey activity, added users, inactive users, and 
response rates by invitation and survey closed date. 
You can generate the following reports:
• Open Survey Activity, page 1029
• Users Added, page 1029
• Inactive Users, page 1029
• Response Rates by Invitation Sent Date, page 1029
• Response Rates by Survey Closed Date, page 1030
• Verbatim Counter report, page 1031

Open Survey Activity
The Open Survey Activity report shows you information about open survey events by workgroup for 
the last 12 months. Click the Open Survey Activity option to generate the report.

Users Added
The Users Added report shows you information about user levels by workgroup for the last 12 months. 
Click the Users Added option to generate the report.

Inactive Users
The Inactive Users report shows you a list of users who have not logged in to the application recently. 
Click the Inactive Users option to generate the report.
Select the date range by using the Start Date and End Date text boxes, and then click the Report 
button. The Inactive Users grid shows a number of columns, including:
• Workgroup – The name of the workgroup the user is assigned to.
• Display Name – The name of the user that displays in the application.
• Email – The user's email address.
• Login Date – The date when the user logged in for the last time.

Response Rates by Invitation Sent Date
The Response Rates by Invitation Sent Date report shows you the response rates for surveys that 
sent invitations within a specific date range. Click the Response Rates by Invitation Sent Date option 
to generate the report.
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Select the date range by using the Start Date and End Date text boxes, and then click the Report 
button. The surveys that sent invitations within the selected date range show in the grid and in the chart.
The Response Rates by Invitation Sent Date grid shows a number of columns, including:
• Survey – The name of the survey that sent invitations.
• Invitations – The number of invitations sent by survey.
• Responses – The number of respondents who replied to the survey.
• No Response – The number of participants who did not reply to the survey.
• Response Rate – The percentage of responses for the total number of invitations.

Response Rates by Survey Closed Date
The Response Rates by Survey Closed Date report shows you the response rates for surveys that 
closed within a specific date range. Click the Response Rates by Survey Closed Date option to 
generate the report.
Select the date range using the Start Date and End Date text boxes, and then click the Report button. 
The surveys that closed within the selected date range show in the grid and in the chart.
The Response Rates by Survey Closed Date grid shows a number of columns, including:
• Survey – The name of the survey.
• Invitations – The number of invitations sent by survey.
• Responses – The number of respondents who replied to the survey.
• No Response – The number of participants who did not reply to the survey.
• Response Rate – The percentage of responses for the total number of invitations.
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Verbatim Counter report
Navigation

Report & Analyze tab > Administration Reports  tab > Verbatim Counter option.

 The Verbatim Counter option is available only if you have a license for the embedded text 
analytics.

The Verbatim Counter report shows the number of verbatim credits used over the last 12 months. Click 
the Verbatim Counter option to generate the report. The report data is generated for a workgroup. The 
verbatim credits are counted for the embedded text analytics only.
In the Verbatim Counter report, the following columns are available:
• Survey Name – The name of the survey for which the verbatim credits were used.
• Date – The date when the verbatims were processed and credits were used.
• Credits Used – The number of used credits.
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Alert & Act tab overview
You can create and view triggers on the Alert & Act tab. You can add email, case, participant, webhook, 
and SMS message triggers and alerts to your survey, update profile fields, file imports, comments, Speech 
Analytics based on the specific responses and respondent location by using the Alert & Act tab. You can 
also send messages to any email address and create cases when a respondent submits a certain answer, a 
defined combination of several answers, or belongs to a specified location.

 To view the Alert & Act tab, you need to have the Unified VoC license activated for your 
workgroup and  Triggers view permission enabled for your user role. To receive the needed 
permissions, contact System Administrator and Group Administrator correspondingly. Your 
triggers will still be accessible in your survey list.

To take advantage of all features within Unified Data Model triggers, you need to have the following 
permissions enabled:
• Case Administration > Cases > Create and View permissions
• Survey Administration > Participants > Create, View, and Edit permissions
• Panel Administration > Profiles > View and Edit permissions
• Unified VOC Configuration > Unified Data Source > View permission
• Unified VOC Configuration > Unified Data Model > View permission
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Unified Data Model triggers
Navigation

Alert & Act tab > Triggers tab.

You can add triggers to your Unified Data Model based on the core measures, dimensions, and 
supplemental attributes, and delete values. 
On the Triggers page, you can add new triggers or delete the existing ones. You can also view the 
following information about a trigger:
• Name – Name of a trigger.
• Action – Action type that is performed when a respondent submits a certain answer, a defined 

combination of several answers, or meets the specified criteria defined in the trigger.
• Case Creation – Notification about whether a trigger has an action selected to create a case. 
• Active – State of a trigger. You can make it either active or inactive by switching the switch on or 

off.
• Data Source(s) - Name of a data source.
To update a trigger, click the name of the needed trigger, and the Trigger tab opens.
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Trigger tab
Navigation

Alert & Act tab > Triggers tab > click the needed trigger > Trigger tab. 

You can select the needed actions and set up criteria for a trigger.

 If a Unified Data Source is inactive, the trigger is not executed.

On the Trigger tab, you can select the following actions for a trigger:
• Actions – Select the trigger action that will be performed  when a respondent submits a certain 

answer, a defined combination of several answers, or meets the specified criteria defined in the 
trigger.
• Send Email – Create an alert message and specify a person who receives an email when 

respondents match the selected criteria.
• Create a Case –  Define the details of the case that will be created based on the specific 

respondent's answer or location.

 The action is available only if you have the Case Administration > Cases > Create and View 
permissions.

• Add as Participant to Survey – Create a trigger to add participants to a survey.

 The action is available only if you have the Survey Administration > Participants > Create, 
View, and Edit permissions.

• Update Profile Fields –  Create a trigger to update profile fields from the Unified Data Source.

 The action is available only if you have the Panel Administration > Profiles > View and Edit 
permissions.

• Webhook – Create a webhook trigger to send response information to a URL in the form of 
consumable JSON in a timely manner.

• SMS Message – Create a trigger to send a followup SMS message with the link to another survey, 
comment, or other project, when a certain criteria is met (for example, a customer fills in the 
comment with a negative NPS score).

 The action is available only if you have both the SMS license and the Unified VoC license enabled 
and configured.

• Criteria –  Specify the criteria for sending a trigger.
To add a criterion, click the Add Another Criteria link.

You can also specify the following expressions and values:
• Expression – Select the expression from the  list. 

- Equal To
- Not Equal To



Alert & Act Trigger tab

EFM User Guide 1036

Confidential and Proprietary Information of Verint Systems Inc.

- Contains
- Does Not Contain
- Begins With
- Ends With

• Value – Type the needed value.
• Save – Click the link or anywhere else in the dialog box to save your criterion.

If you add multiple criteria, you can combine them using the following Match options:
• All Criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The lists with parentheses and the And / Or operators appear next to each criterion.

In the dialog box, you can copy, move up or move down, and delete the criteria. To edit the criteria, click 
its name.
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Triggers criteria builder
Navigation

Alert & Act tab > Triggers tab > click the needed trigger > Trigger tab > Criteria section. 

The Criteria section allows you to set a number of criteria for your trigger.

• Source – Based on the source,  the criteria builder menu lists the corresponding measures. The 
Unified Data Set, provides the following measures:
• Core Measures 
• Dimensions 
• Supplemental 

The Expression and Value lists options depend on the measure you select. For example, if you select the 
Core Measures > Customer Satisfaction measure, the following options are available:
• Expression – Select the expression from the drop-down list. The available options are:

• Equal To (=)
• Not Equal To (≠)
• Less Than (<)
• Greater Than (>)
• Less Than Or Equal ()
• Greater Than Or Equal (≥)

• Value – Enter or select the value depending on the selected measure.  For Customer Satisfaction, 
the available options are numbers from 1 to 5.

To add a criterion, click the Add Another Criteria link.

If you add multiple criteria, you can combine them by using the following Match options:
• All Criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The drop-down lists with parentheses and the And/Or operators appear next to 

each criterion.
You can activate or deactivate your criteria by switching the Active toggle on or off.
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Send Email action
Navigation

Alert & Act tab > Triggers tab > select the existing trigger or create a new one > Send Email action.
For the email action, you need to define criteria for your trigger, create an alert message, and specify a 
person who receives an email when respondents select the specific answer or belong to a specified 
location.
You can edit the appearance of your message in the Design or HTML mode. The HTML option is available 
in the lower-left part of the dialog box.

Before you begin 
1 Go to the Unified Data Sources tab, and add a comment, file import, survey, or Speech Analytics 

project as a source to Unified Data Set.
2 Map a field as a criteria to the Unified Data Model and publish it to the Unified Data Set. For more 

information, see Map data from the Unified Data Model, page 1336.
3 Go to the Triggers tab, and then select the needed action.

Procedure 
1 On the Triggers  page, click the New button.
2 In the Create New Trigger dialog box, in the Trigger Name box, enter a name of the trigger, and 

then click Confirm.
3 In the Trigger Actions list, select the Send Email option.
4 Click the Email tab.
5 The From field can be configured on the Configuration > Case Setup > Address Preferences tab. 

If piping is enabled, you can provide your custom email address.
6 In the To field, type the email address of the person to be notified by the trigger.
7 In the Cc (carbon copy) and Bcc (blind carbon copy) fields, type the email addresses if required.

 Recipients in the Cc and Bcc fields also get the message. The names of the recipients in the Bcc 
field are not visible to other recipients.

8 In the Subject field, type the message short description.
9 In the message body, type the content of your email. You can customize the text by using the 

additional editing options from the toolbar.

 You can also pipe different fields in your message body by clicking the Insert Piped Value icon 

 on the toolbar.

10 Click Save. The created trigger appears on the Trigger tab.
11 To activate or deactivate your email trigger, on the Email tab, switch the toggle on or off.
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Create an email trigger
Navigation

Alert & Act tab > Triggers tab > Send Email check box > Email tab. 

For the email triggers, you need to define criteria for your triggers, create an alert message, and specify a 
person who receives an email when respondents select the specific answer or belong to a specified 
location.
You can  edit the HTML of your message in the email trigger to modify the appearance of your message. 
The HMTL option is available in the lower-left part of the dialog box.

Procedure 
1 Go to Alert & Act tab >  Triggers tab, and select the Send Email check box.
2 On the Email tab, in the From text box, select the email address of the person who will notify about 

the trigger. By default, the email address of the person who created the trigger is selected, but you 
can update your address preferences by doing to the Mail Setup page. For more information, see 
Mail Setup, page 1415.

3 In the To text box, type the email address of the person to be notified by the trigger.
4 In the Cc (carbon copy) and Bcc (blind carbon copy) text boxes, type the email addresses if required.

 Recipients in the Cc and Bcc text boxes also get the message. The names of the recipients in the 
Bcc text box are not visible to other recipients.

5 In the Subject text box, type the message short description.
6 In the message body, type the content of your email. You can customize the text by using the 

additional editing options from the toolbar. You can also pipe different text boxes in your message 
using the Insert Piped Value icon  on the toolbar.

7 Click OK. The created trigger appears on the Trigger tab.
8 To activate or deactivate a trigger, switch the toggle on or off correspondingly.
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Create a Case action
Navigation

Alert & Act tab > Triggers tab > select the existing trigger or create a new one > Create a Case action.

You can create case triggers based on Unified Data Model. For the case triggers, you need to define 
criteria for your triggers and specify a person who receives the details of the case that is created when 
respondents select the specific answer.

 The case triggers are available only if you have a license for the Case Management feature and 
the Case Administration > Cases permission enabled.

Before you begin 
1 Go to the Unified Data Sources tab, and add a comment, file import, survey, or Speech Analytics 

project as a  source to Unified Data Set.
2 Map a field as a criteria to Unified Data Model and publish it to the Unified Data Set. For more 

information, see Map data from the Unified Data Model, page 1336.
3 Go to the Triggers tab, and then select the needed action.

Procedure 
1 On the Triggers  page, click the New button.
2 In the Create New Trigger dialog box, in the Trigger Name text box, type a name for the trigger, 

and then click Confirm.
3 In the Actions list, select Create a Case.
4 On the Case Details tab, in the Assigned to text box, type the name of the workgroup member, to 

whom you want to assign the case. By default, the case is unassigned. The Assigned to text box is an 
auto-completing text box.

 You can also pipe different fields in the Assigned to, Title, Contact's Email, Contact's First 
Name, Contact's Last Name, Contact's Phone, and Contact's Business by clicking the 

Insert Piped Value   icon.

5 In the Priority  list, click the case priority. 

 You can configure the Priority list on the Configuration > Case Setup tab.

6 In the Title text field, type the case summary.
7 In the Notify Users text field, enter the names of the persons to receive a notification that a new 

case is created. When there are more than 50 members in a workgroup, the Notify Users option 
appears as an auto-completing text box.

8 In the Case Description text box, type the case description. You can customize the case description 
by using the additional editing options from the toolbar.
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 You can also pipe different fields in your case description by clicking the Insert Piped Value icon 

 on the toolbar.

9 In the Contact's Email text box, type the email address of the person, who can provide the detailed 
information about the case.

10 In the Contact's First Name text box, type the first name of the contact person.
11 In the Contact's Last Name text box, type the last name of the contact person.
12 In the Contact's Business text box, type the company name of the contact person.
13 In the Contact's Phone text box, type the phone number of the contact person.
14 In the Custom Properties section, select the custom case property. The available properties are: 

text, date, and Choose One.

 The case properties are available only if specified on the Case Setup tab by Case 
Administrator.

 

 You can pipe the available properties values based on Unified Data Model by clicking the Insert 

Piped Value icon  .

15 Click Save. The created trigger appears on the Trigger tab.
16 To activate or deactivate your case trigger, on the Case Details tab, switch the toggle on or off.
17 To view the case, go to the Cases tab. The case will be created if you receive a response that triggers 

the case.

Add as Participant to Survey action
Navigation

Alert & Act tab > Triggers tab > select the existing trigger or create a new one > Add as Participant to 
Survey action.

You can create an automatic trigger to add a participant to a survey to receive feedback from your users 
that fit certain criteria. You can add as many surveys as you need.

 The action is available only if you have the Survey Administration > Participants > Create, 
View, and Edit permissions enabled.

Before you begin 
1 Go to the Unified Data Sources tab, and add a comment, file import, survey, or Speech Analytics 

project as a source to Unified Data Set.
2 Map a field as a criteria to the Unified Data Model and publish it to the Unified Data Set. For more 

information, see Map data from the Unified Data Model, page 1336.
3 Go to the Triggers tab, and then select the needed action.
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Procedure 
1 On the Triggers  page, click the New button.
2 In the Create New Trigger dialog box, in the Trigger Name text box, type a name for the trigger, 

and then click Confirm.
3 In the Actions list, select Add as Participant to Survey action.
4 On the Add Participant tab, click the Add Survey button.
5 In the Add Survey dialog box, select the needed survey from the list, and then click Add.

 Survey that are in the Design mode and that do not have at lease one Contact List campaign 
are not available for selection. 

6 In the Field Containing Invitation Data column, select one of the following options:
• Select a Channel Data Field
• E-mail Address
For surveys, the following data types are available: Email, Phone Number, Text. For SMS surveys – 
Numeric, Phone Number, Text.

7 In the Select a Campaign column, select the needed Contact List campaign.

 The Select a Campaign list appears in the table if more than one Contact List campaign is 
added to a survey.

8 Click Apply.

 If you restart the page before applying changes, the sources that you defined previously will not 
be  saved.
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Update Profile Fields action
Navigation

Alert & Act tab > Triggers tab > select the existing trigger or create a new one > Update Profile Fields 
action.

You can automatically update profile fields from the Unified Data Source by using the Update Profile Fields 
action.

 The action is available only if you have the Panel Administration > Profiles > View and Edit 
permissions.

Before you begin 
1 Go to the Unified Data Sources tab, and add a comment, file import, survey, or Speech Analytics 

project as a source to Unified Data Set.
2 Map a field as a criteria to the Unified Data Model and publish it to the Unified Data Set. For more 

information, see Map data from the Unified Data Model, page 1336.
3 Go to the Triggers tab, and then select the needed action.

Procedure 
1 On the Triggers  page, click the New button.
2 In the Create New Trigger dialog box, in the Trigger Name text box, enter a name of the trigger, 

and then click Confirm.
3 In the Trigger Actions list, select the Update Profile Fields option.
4 On the Profile Fields tab, click the Update Profile link.
5 In the Update Profile dialog box, in the Current Profile menu, click the profile that you want to 

update. 

 You can update only published profiles.

6 In the grid below, match the fields with Unified Data Model to the corresponding profile fields that 
you want to update, and then click Add. You need to match each  field to a different profile field, or 
click Not Selected in the corresponding list. 

 You can add multiple profiles in scope of a single trigger. 

7 To save the trigger, click Apply. For the records that meet the defined criteria, the fields of the 
selected profile(s) are automatically updated with the corresponding information from the current 
Unified Data Set.

 If you restart the page before applying changes, the sources that you defined previously will not 
be  saved.

8 To activate or deactivate your trigger, on the Profile Fields tab, switch the Active toggle on or off.
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Send Webhook action
Navigation

Alert & Act tab > Triggers tab > select the existing trigger or create a new one > Webhook action.

You can create a webhook trigger to send response information to a URL in the form of consumable JSON 
in a timely manner.

Before you begin 
1 Go to the Unified Data Sources tab, and add a comment, file import, survey, or Speech Analytics 

project as a  source to Unified Data Set.
2 Map a field as a criteria to Unified Data Model and publish it to the Unified Data Set. For more 

information, see Map data from the Unified Data Model, page 1336.
3 Go to the Triggers tab, and then select the needed action.

Procedure 
1 On the Triggers  page, click the New button.
2 In the Create New Trigger dialog box, in the Trigger Name text box, type a name for the trigger, 

and then click Confirm.
3 In the Actions list, select Webhook.
4 On the Webhook tab, click Add Webhook.
5 In the Configure Webhook dilog box, in the Webhook Name text box, type the name of the 

webhook.
6 In the URL  text box, type the URL to which JSON will be sent. 
7 In the Content Type text box, the JSON format is set by default.
8 To add Header and Value pairs, click Add HttpHeader.
9 To generate a preview of  JSON,  click Generate Content Data.

In the Content Data text box, you can view and edit the generated JSON before sending it.
10 To  test a webhook, click Send Test Request.
11 Click Save. 

The created webhook trigger appears on the Trigger tab.
12 To view the webhook name, URL destination, or delete the webhook, go to the Webhook tab. 
13 To save the trigger settings, click Apply.
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Send SMS Message action
Navigation

Alert & Act tab > Triggers tab > select the existing trigger or create a new one > SMS Message action.

You can create a trigger to send a followup SMS message with the link to another survey, comment, or 
other project,  when a certain criteria is met (for example, a user fills in the comment card with a negative 
NPS score).

 The action is available only if you have both the SMS license and the Unified VoC license enabled 
and configured.

Before you begin 
1 Go to the Unified Data Sources tab, and add a comment, file import, survey, or Speech Analytics 

project as a  source to Unified Data Set.
2 Map a field as a criteria to Unified Data Model and publish it to the Unified Data Set. For more 

information, see Map data from the Unified Data Model, page 1336.
3 Go to the Triggers tab, and then select the needed action.

Procedure 
1 On the Triggers  page, click the New button.
2 In the Create New Trigger dialog box, in the Trigger Name text box, type a name for the trigger, 

and then click Confirm.
3 In the Actions list, select SMS Message.
4 On the SMS Message tab, in the To text box, type the phone number of the person to be notified by 

the trigger. 
To select the phone number from the list of phone type fields that are mapped in the Unified Data 
Source, click Select Mobile Field.

 You can add multiple phone numbers by clicking the Select Mobile Field button each time.

5 In the message body, type the content of your message. You can paste the full URL in the message 
body (if needed). You can customize the text by using the additional editing options on the toolbar.

6 In the Preview text box, you can preview the SMS text message.
7 To save the trigger settings, click Apply.

The created SMS trigger appears on the Trigger tab.
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Trigger History page
Navigation

Alert & Act tab > Trigger History tab. 

You can view a list of the most recently executed triggers in the workgroup and activity of automatic 
trigger actions.
On the Trigger History page, you can view the following values in the grid:
• Record ID – ID of the record for which the trigger is executed.
• Trigger Name – Name of a trigger.
• Action – Action type that is performed when the specified criteria is met in the trigger.

 For each performed trigger action, a new row in the Trigger History grid is created.

• Case – Link to a case trigger.
• Data Source –  Source of a trigger.
• Sent – Time when a  trigger is sent.

 Trigger history records stored in the workgroup are deleted after 90 days by default.

On the Trigger History page, you can export trigger history data  to the .csv, .tsv, or .xlsx file formats by 
clicking the Export button > CSV (Comma delimited), TSV (Tab delimited), or Microsoft Excel option.

 You can also define the needed export file format by clicking the Actions menu > Export option 
> CSV (Comma delimited), TSV (Tab delimited), or Microsoft Excel option.

In the Export Trigger History dialog box, you can click the download link to open or save the export file 
locally.
To search for any related trigger information in the Trigger History grid, type your search query in the 
search text box, and then click Search.
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Reports – Feedback Intelligence
Navigation

Project Reports tab > Feedback Intelligencetab. 

You can use the Feedback Intelligence product to create custom queries and reports to analyze your data 
for business insights and trends. For each Feedback Intelligence connection in the workgroup, a new side 
tab appears on the Administration tab. The side tab name is the display name of the Feedback 
Intelligence connection configured by your System Administrator. Click the side tab name to open the 
corresponding Business Objects InfoView web page.
You can view the Current survey, Respondent Fields, Panelists, Profiles, Surveys, Respondent 
System Information, and Respondent Location columns in Feedback Intelligence and create custom 
reports in Tableau or Business Objects based on this data.

 The Feedback Intelligence functionality is available if you have a license for the Feedback 
Intelligence feature.

System Administrator also needs to configure Feedback Intelligence, and then activate the Feedback 
Intelligence connection for your workgroup under FI Connections > Reporting Usage.
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Feedback Intelligence – Role-Based Access
Navigation

Administration tab > Rolestab. 

The survey administrator can control if the workgroup members can get access to the Feedback 
Intelligence functionality. Survey administrator can enable the Feedback Intelligence access for a user by 
creating a new role or editing the existing ones from the Roles tab on the Administration page.
By default, the Access Feedback Intelligence permission is enabled for Report Viewer, Report Author, 
Survey Administrator, Survey Author, and Group Administrator.

Activate the Access Feedback Intelligence functionality

Procedure 
1 On the Roles tab, click the name of the role you want to edit. 
2 On the Edit Role page, select the Access Feedback Intelligence check box in the Experience 

section at the bottom of the page.
3 Click Save.
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Feedback Migration Multiple
Navigation

Design & Collect tab > Surveys tab >  My Surveys page >  New menu > Import from Feedback.

You can quickly import multiple surveys at once from EFM Feedback into EFM using the "Import From 
Feedback" option. To easily identify the surveys you want to import, the survey details such as survey 
name, survey created date, most recent response date, and responses number are available for you 
during the import.
You can import a large number of surveys with the large response data sets from EFM Feedback into 
EFM. The task is running in the background without the process timeout. Additionally, you receive an 
email report when importing is completed.
The administrator of a workgroup can activate the functionality on importing data from EFM Feedback 
on the Administration > General tab by selecting the "Enable import from Feedback" check box and 
saving the settings. Then, the users within this workgroup can select the Import From Feedback option 
from the New  menu on the Surveys tab. See images below.
After importing a survey from EFM Feedback into EFM, you cannot import any updates to this survey. 
You can reimport the survey from EFM Feedback to have the most recent data, but it will import into EFM 
as a new survey. Some advanced settings may not port properly from EFM Feedback and need to be 
updated manually. The features include:
• IP Address Includes or Excludes
• Custom Validation Logic
• Templates
It is recommended to review the survey for accuracy before distributing it.

Error Messages
There are two known error messages you can face when trying to import the EFM Feedback survey into 
EFM.

Message 1
Feedback survey format is invalid to import {0}.
Meaning:
The Feedback survey is too old to import. Feedback surveys created before a certain point in time are not 
in a format that can be used by the current Feedback product and thus cannot be imported into EFM. 
Only XML-based surveys can be imported; these are surveys created with EFM Continuum or with 
WebSurvey or version 4 or higher.

Message 2
Multiple Feedback translations appeared to be the same, unable to import {0}.
Meaning:
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Feedback surveys have different rules for defining languages than EFM. To import a survey into EFM, you 
need to define a unique culture for each language. The "Languages And Messages" image below shows 
that English and German have the same culture (the "Description" column) and thus this survey cannot 
be imported.

Import surveys from EFM feedback
1 From the New menu, select Import from Feedback. The Login to your EFM Feedback account 

dialog box opens.
2 Enter your user name and password in the "User ID" and "Password" fields accordingly.
3 Click the Options button to expand the section.
4 Specify the link to EFM Feedback in the "URL" field.
5 Click Login. The following dialog box opens.
 

6 Select the check boxes next to the EFM Feedback surveys you want to import into EFM.

 Click the "Select all "n" entries in this grid" link to select all surveys.

7 Click Next.

 You can edit the survey name and description during the import process if you import a single 
survey.

8 Click Import. The survey import may take some time. When importing is completed, you can view the 
number of imported records and the number of records that failed to import.

9 Click Close. The imported surveys appear on the My Surveys page in EFM.
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EFM Feedback – Importing Multiple Surveys
Navigation

Design & Collect tab > Surveys tab >  My Surveys page >  New menu > Import from Feedback.

You can quickly import multiple surveys at once from EFM Feedback into EFM using the Import From 
Feedback option. To easily identify the surveys you want to import, the survey details such as survey 
name, survey created date, most recent response date, and responses number are available for you 
during the import.
You can import a large number of surveys with the large response data sets from EFM Feedback into 
EFM. The task is running in the background without the process timeout. Additionally, you receive an 
email report when importing is completed.
The administrator of a workgroup can activate the functionality on importing data from EFM Feedback 
on the Administration > General Setup tab by selecting the "Enable import from Feedback" check box 
and saving the settings. Then, the users within this workgroup can select the Import From Feedback 
option from the New menu on the Surveys tab. 
After importing a survey from EFM Feedback into EFM, you cannot import any updates to this survey. 
You can reimport the survey from EFM Feedback to have the most recent data, but it will import into EFM 
as a new survey. Some advanced settings may not port properly from EFM Feedback and need to be 
updated manually. The features include:
• IP Address Includes or Excludes
• Custom Validation Logic
• Templates
It is recommended to review the survey for accuracy before distributing it.

Error Messages
There are two known error messages you can face when trying to import the EFM Feedback survey into 
EFM.

Message 1
Feedback survey format is invalid to import {0}.
Meaning:
The Feedback survey is too old to import. Feedback surveys created before a certain point in time are not 
in a format that can be used by the current Feedback product and thus cannot be imported into EFM. 
Only XML-based surveys can be imported; these are surveys created with EFM Continuum or with 
WebSurveyor version 4 or higher.

Message 2
Multiple Feedback translations appeared to be the same, unable to import {0}.
Meaning:
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Feedback surveys have different rules for defining languages than EFM. To import a survey into EFM, you 
need to define a unique culture for each language. The "Languages And Messages" image below shows 
that English and German have the same culture (the "Description" column) and thus this survey cannot 
be imported.

Import surveys from EFM Feedback

Procedure 
1 From the New menu, select Import from Feedback. The Login to your EFM Feedback account 

dialog box opens.
2 Enter your user name and password in the "User ID" and "Password" fields accordingly.
3 Click the Options button to expand the section.
4 Specify the link to EFM Feedback in the "URL" field.
5 Click Login. The following dialog box opens.
6 Select the check boxes next to the EFM Feedback surveys you want to import into EFM.

 Click the "Select all "n" entries in this grid" link to select all surveys

7 Click Next.

 You can edit the survey name and description during the import process if you import a single 
survey.

8 Click Import. The survey import may take some time. When importing is completed, you can view the 
number of imported records and the number of records that failed to import.

9 Click Close. The imported surveys appear on the My Surveys page in EFM.
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EFM Feedback – Importing Surveys with Branching
Navigation

Design & Collect tab > Surveys tab >  My Surveys page >  New menu > Import from Feedback.

You can smoothly import surveys with branching logic from EFM Feedback into EFM. Both the simple and 
conditional branching set in EFM Feedback is supported in EFM.
In EFM Feedback, the following four actions are associated with branching:
• Jump to the next question
• Jump to a specific question (drop-down list to select a question)
• Jump to a web address (text box to specify the URL)
• Submit survey now
The following logic is applied to these actions in EFM:
• Jump to the next question works as a simple page break.
• Jump to a specific question redirects survey participants to the destination question.
• Jump to a web address creates a new custom end page and redirects survey participants to the 

specified URL.
• Submit survey now redirects survey participants to the survey end page.
All branches from EFM Feedback are ported into the branches of EFM. See image and explanation below.
• Description – Contains all criteria descriptions from EFM Feedback separated by the And/Or 

operator.
• Destination – Contains the question number or end page name defined by branching in EFM 

Feedback.
• Check Point – Contains the question number where the logic rule is applied.
• Criteria – Contains a list of all criteria from EFM Feedback.
Criteria for the following EFM Feedback question types are imported into EFM:
• All Choose One
• Choose All That Apply
• Fill In The Blank
• Essay
• Numeric Value
• Date Value
• Choose One Matrix
• Choose All That Apply Matrix
• Side-By-Side Matrix
• Rank Order
• Hidden Field
• Data Block (with the question types from the list)
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 For the steps on importing a survey from EFM Feedback into EFM, Feedback Migration Multiple, 
page 1051
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EFM Feedback – Importing Surveys with Translations
Navigation

Design & Collect tab > Surveys tab >  My Surveys page >  New menu > Import from Feedback.

You can import surveys with translations from EFM Feedback into EFM. When you import a survey, each 
translation is assigned the language and culture code in EFM, for example, English (India). The following 
logic is used to map the translation languages:
• If culture is defined in EFM Feedback, the corresponding culture is set in EFM.
• If encoding is defined in EFM Feedback, the corresponding culture is set in EFM.
• If there is no culture or encoding defined in EFM Feedback, the default culture is set in EFM.
The survey is not imported into EFM, if it has at least two translations with the same language and culture 
code. After importing, you can view a list of surveys that fail to import. If you import multiple surveys, 
you can view the import details in an email report.
To import such survey, you need to change the culture code in EFM Feedback so that you do not have 
two similar translations. Make the changes and import your survey again.

 For the steps on importing a survey from EFM Feedback into EFM,EFM Feedback – Importing 
Multiple Surveys, page 1053.
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EFM Feedback – Text Formatting Import
Navigation

Design & Collect tab > Surveys tab >  My Surveys page >  New menu > Import from Feedback.

When you import surveys from EFM Feedback into EFM, all text formatting is ported too. The formatting 
options include:
• Font Name
• Font Size
• Bold
• Italic
• Underline
• Foreground Color
• Background Color
You can preview your survey after import to check whether all text has the correct formatting applied.

 For the steps on importing a survey from EFM Feedback into EFM, Import surveys from EFM 
feedback, page 1052.
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EFM Feedback – "Choose One" Caption Import
Navigation

Design & Collect tab > Surveys tab >  My Surveys page >  New menu > Import from Feedback.

When you import surveys from EFM Feedback into EFM, the "Choose One (Pull Down Menu)" questions 
are ported with the "Choose One" caption. The "Choose One" caption is ported for the "Choose One 
Matrix" questions too.
When you select the "Insert "Choose One" into first item of pull down lists" check box in the EFM 
Feedback, the "Choose One" caption appears in the drop-down list by default. This caption is the default 
text that your survey participants see when they answer the survey.
Surveys imported from EFM Feedback with this check box selected have an additional value in the 
"Caption" drop-down list in EFM. You can change the caption at the following location:
• In the "Multiple Choice: Choose One" question, you can change the caption in the Appearance 

section.
• In the "Matrix" question with the "Multiple Choice: Choose One" side, you can change the caption 

in the Side # section under Advanced Options.

 Select the "Drop-down Box" layout to view the "Caption" feature.

The available options are "None," "Click here to choose," "Click here for choices," and "Choose One."

 For the steps on importing the surveys from EFM Feedback into EFM, Import surveys from EFM 
feedback, page 1052.
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EFM Feedback – Auto-Import Unique ID
Navigation

Design & Collect tab > Surveys tab >  My Surveys page >  New menu > Import from Feedback.

You can import the unique ID from an EFM Feedback survey into EFM automatically. When importing a 
survey from Feedback, the "Fill in the Blank" hidden system question is created storing the following 
participant data:
• Unique ID
• Response ID
• IP Address, and
• Language
This functionality is available for all the email-based surveys. The Generate Link surveys are not 
included.
If the unique participant ID is used in the EFM Feedback survey, it is automatically imported along with 
the other survey data into EFM. The unique ID is displayed in the "System (QSYSTEM_1)" column and in 
the Responses dialog box on the Response Manager page. See images below.
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Import WFO organizations and users
Navigation

Administration tab > Users tab > Actions menu > Import from WFO option.

You can import organizations and users from the WFO source into the EFM application without setting up 
the same organization structure across both products. You can import the whole WFO hierarchical 
structure of organizations and users or select particular users and organizations. During import, the 
organizations and users are identified by their emails.

 This functionality is available only for Group and Survey Administrator.

Before you begin 
• To verify if the Enable WFO Organization Synchronization check box is selected for your 

workgroup, contact your System Administrator.

Procedure 
1 On the Administration tab, click the Users tab.
2 In the Actions menu, click Import from WFO option.
3 On the Import Organizations and Users from WFO page, in the WFO section, expand the WFO 

Structure tree view.
4 Select the organizations and users that you want to import into the EFM application.
5 To move the organizations and users to your EFM organization, click the right arrow button, and then 

click Import.

 Users without email, first name, and last name, users that were previously imported, and 
organizations with the same name as in the EFM application are not imported. To view import 
details, click Administration tab > System Tasks tab > Import WFO Organizations link.

After import is completed, the WFO users imported into the EFM application receive the email message 
with the link to activate their accounts in the EFM application.

 To view your WFO hierarchical structure, go to Administration tab > Users tab > expand the 
WFO Structure tree view.

Besides, after import, the following external data source keys automatically appear on the External 
Sources side tab:
• WFO Organization
• WFO User
You cannot delete or set as default the WFO Organization or WFO User external data source key.

 To view the details about WFO Organization or WFO User external data source key, go to the 
Edit Organization or Edit User dialog box.

If you import the WFO user from some other file, you receive one of the following results:
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• A user who already exists in the EFM application cannot be imported.
• A user who does not exist in the EFM application becomes the EFM user.

 You can import the WFO organization only from the WFO source. If the organization with the 
same name already exists in the EFM application, it is not imported.
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Mapping WFO roles to EFM roles
Navigation

Administration tab > Users tab > Actions menu > Import from WFO option.

When importing WFO organizations and users, the WFO roles are automatically changed to the 
corresponding roles in the EFM application:
• Admin to Administrator
• Manager to Survey Administrator
• Supervisor to Survey Administrator
• Analyst to Report Author
• Agent to Report Viewer
• The user with custom role to Report Viewer
• The user with no role to Report Viewer
• The user with multiple roles to the highest of the role
If the user’s EFM role does not correspond to the user’s WFO role, you can change the role in the Edit 
User dialog box.
For more information about changing the user role, see Users, page 1349.

 If System Administrator changes the user role in the Edit User dialog box, this role is not mapped 
again to the WFO role automatically when updating.
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Update the WFO hierarchical structure
Navigation

Administration tab > Users tab > Actions menu > Import from WFO option.

After importing WFO organizations and users, you can update your WFO hierarchical structure by adding 
or deleting WFO organizations and users. During update, the users and organizations are identified by 
their IDs.

Procedure 
1 Log in to the EFM application as a Survey or Group Administrator.
2 On the Administration tab, click the Users tab.
3 In the Actions menu, click Import from WFO.
4 On the Import Organizations and Users from WFO page, in the WFO section, expand the WFO 

Structure tree view.
5 Select or clear the needed organizations and users, and then click the needed arrow button.
6 Click Update.

 To view the updated WFO hierarchical structure, go to Administration tab > Users  tab > WFO 
icon .
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Restrictions on WFO organizations and users
Navigation

Administration tab > Users tab > WFO icon > Users or Organizations button > click the needed user 
or organization.

You can manage WFO organizations and users according to the defined permissions. These permissions 
are almost the same as for EFM organizations and users, except for the following restrictions:
• Deleting WFO organizations and users
• Moving EFM organizations and users or new organizations and users to the WFO hierarchical 

structure
• Adding a child organization or user to the WFO organization
• Editing the name and external data source ID of the WFO organization
• Changing the user name, display name, email address, organization membership, status, and 

external data source IDs of the WFO user
• Assigning membership for the WFO user
For more information about permissions for managing EFM organizations and users, see Users, 
page 1349.

 To view or edit the details about a user, click the Administration tab > Users tab > WFO icon > 
Users button > click the needed user.To view the organization details, click the Administration 
tab > Users tab > WFO icon > Organizations button > click the needed organization.
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Recurrence of WFO and EFM synchronization
Navigation

Administration tab > Users tab > WFO icon > Users or Organizations button > click the needed user 
or organization.

After you import WFO organizations and users, you can update them according to the WFO source by 
setting a synchronization recurrence.

 To set the recurrence of the EFM application and the WFO source synchronization, contact your 
System Administrator.

If the recurrence is set, after synchronization, all changes in the WFO source are imported into the EFM 
application except for the following:
• If a user in the WFO source is moved to an organization that exists in the EFM application, such 

user is moved from the current organization in the EFM application to the new organization.
• If a user in the WFO source is moved to an organization that is not imported into the EFM 

application, such user is deleted from the EFM application.

 To disable synchronization, contact your System Administrator. For more information, see 
Disabling WFO and EFM synchronization, page 1072.
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Importing or activating existing users
Navigation

Administration tab > Users tab > Actions menu > Import from WFO option.

You can import the WFO users who already exist in the EFM application. Such users are imported 
according to the initial import or update procedure:
• To the WFO structure
• With editing restrictions applied to them
• With the WFO source indicated in the Source column
The following are special cases when importing users who already exist in the EFM application:
• Users with their first name, last name, or user name changed in the WFO source are imported and 

updated according to the changes in the WFO source.
• Deleted or suspended users are imported and become active.
• User roles assigned in the EFM application are not changed for existing users during import.
Existing users will not be imported or activated in the following cases:
• If users are assigned to multiple workgroups or to another workgroup.
• If user names are used by other users (except the user names which email addresses are the same 

in the WFO source and the EFM application).
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Export WFO users
 

Navigation

Administration tab > Users tab >  Organizations > Actions menu.

You can export the WFO users to the .csv, .tsv, or .xlsx file formats.

Procedure 
1 Log in to the EFM application as a Survey or Group Administrator.
2 On the Administration tab, click the Users tab.
3 Click Users, and then in the Actions menu, click Export.
4 Select the type of export, and then in the Export Users dialog box, click the link to download and 

view the exported file.
In the Source column of the exported file, you can view if the user is exported from the WFO or EFM 
source.
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Export WFO organizations
 

Navigation

Administration tab > Users tab >  Organizations > Actions menu.

You can export the WFO organizations to the .csv, .tsv, or .xlsx file formats.

Procedure 
1 Log in to the EFM application as a Survey or Group Administrator.
2 On the Administration tab, click the Users tab.
3 Click Organizations, and then in the Actions menu, click Export.
4 Select the type of export, and then in the Export Organizations dialog box, select the needed 

organizations.
5 In the Export Organizations dialog box, click the link to download and view the exported file.
In the Source column of the exported file, you can view if the organization is exported from the WFO or 
EFM source.
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Adding WFO users to Feedback Intelligence
Navigation

Administration tab > Users tab > Actions menu > Import from WFO option.

If you import users from the WFO source into the EFM application, they are automatically added to 
Feedback Intelligence and can use Business Objects and Tableau functionalities.
You can view the details of the Manage FI users for a workgroup task on the Tasks tab.

 The WFO users are added to Feedback Intelligence automatically if WFO synchronization and 
Feedback Intelligence are enabled and configured in the EFM application.

 

When WFO users are created in Feedback Intelligence, Groups link (EFM > Administration > Users) is 
enabled and these users can be added to Feedback Intelligence groups.
If the WFO user role is changed in the EFM application to a new one that does not have Access 
Feedback Intelligence or Access Tableau permission enabled, this user is removed from Tableau 
Server and disabled in Business Objects correspondingly.
If the existing WFO user role is changed in the EFM application to a new one that has Access Feedback 
Intelligence or Access Tableau permission enabled, this user is added to Tableau Server and Business 
Objects correspondingly. 

 If a WFO user is deleted during the synchronization, the user’s account is removed from the 
Business Objects and Tableau. If the WFO user’s email is changed during the synchronization, the 
user still has access to Tableau and Business Objects by using the existing user name and account 
name.
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Disabling WFO and EFM synchronization
The process of updating WFO organizations and users according to the WFO source can be stopped by 
disabling synchronization with the EFM application.

 To disable synchronization of the EFM application with the WFO source, contact your System 
Administrator.

 

Disabling the WFO and EFM synchronization causes the following:
• Updating of the WFO users and organizations stops.
• Users and organizations imported from the WFO source remain the WFO users and organizations.
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Deactivate the WFO source
 

Navigation

Administration tab > External Sources tab.

You can deactivate synchronization of WFO organizations and users with the EFM application.

 Deactivating the WFO and EFM synchronization causes the following:

1 Updating of the WFO organizations and users stops.
2 Organizations and users imported from the WFO source become EFM organizations and users.

 

Procedure 
1 Log in to the EFM application as a Survey or Group Administrator.
2 Click the Administration tab, and then click the External Sources side tab.
3 Select the WFO check box, and then click Deactivate.
4 In the confirmation message, click Disable.
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Managing comments
Navigation

Data Sources tab > Comments tab

On the Comments tab, you can perform the following actions:
• View and export comments

• Add comments to reports
• Create reports based on comments
• Enrich/Tire comments to data channels
• Add comments to data sets
• Add report elements with comments to dashboards

 For more information on adding comments to dashboards, see Adding report elements to 
dashboard, page 89 and Create advanced dashboard, page 66
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Export comments to the .csv, .tsv, or .xlsx file 
formats

Navigation

Data Sources tab > Comments tab > click the needed project link > click View Standard Report, 
Design from Scratch, or View Responses > Responses Manager page.

You can export comments to the .csv, .tsv, or .xlsx file formats to save them locally.

Procedure 
1 On the Response Manager page, in the Export menu, click the needed file format for export:

• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
The Export Responses dialog box appears.

2 In the Columns section, select the needed option:
• Displayed Data – Only data available on the Responses Manager page is exported.
• All Response Data from the Current Project – All response data from the current project is 

exported.
3 In the Filter section, define if any filter is applied to the exported data:

• No Filter – The exported file uses no filters.
• Current Filter – The current filter is applied to the exported response data.

4 Click Next, and in the Export Responses dialog box, click the link to download the exported file.
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Export comments to the .spss file format
Navigation

Data Sources tab > Comments  tab > click the needed project link > click View Standard Report, 
Design from Scratch, or View Responses > Responses Manager page.

You can export comments to the .spss file format to save them locally.

Procedure 
1 On the Response Manager page, in the Export menu, click the SPSS option.

The Export Responses dialog box appears.
2 In the Columns section, select the needed data export option:

• Displayed Data – Only data available on the Responses Manager page is exported.
• All Response Data from the Current Project – All response data from the current project is 

exported.
3 In the Filter section, define if any filter is applied to the exported data:

• No Filter – The exported file uses no filters.
• Current Filter – The current filter is applied to the exported response data.

4 To define the missing value for not asked questions, select the Define Missing Value for Not 
Asked Questions check box and enter the whole number for missing value into the text box.

 By default, this option is not active. The system value appears in the export file when the option 
is not active.

5 In the Export Responses dialog box, click the link to download and view the exported file.
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Schedule export of comments by email
Navigation

Data Sources tab > Comments tab > click the needed project link > click View Standard Report, 
Design from Scratch, or View Responses > Responses Manager page.

You can schedule export of comment in the .csv, .tsv, .xlsx, or.spss file formats by email.

 The file exported is zipped and attached to the email message.

Procedure 
1 On the Response Manager page, in the Schedule Export menu, click Email.
2 On the Schedule Export Delivery Page, in the Select Format menu, click the format of the 

exported file:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS

 To specify the formatting options for the scheduled export, click the Export Options link next to 
the Select Format menu, and then select the appropriate options.

3 In the To text box, type the email address of the needed recipients.

 If there are organizations in a workgroup, click the To button to select the recipients. In the 
Survey Responses Recipients dialog box, select a check box next to the user or organization, 
click the right arrow button to add them to the Recipients, and then click OK.

4 In the From text box, type the sender’s email address.
By default, your email address is selected.

5 In the Subject text box, type the title of the email message.
By default, the title of the email message is Responses for <survey name>.

6 In the email message body, type the needed text and customize it by using the editing toolbar.

 To preview the email message, click the Preview button. You can also test the email message by 
clicking the Send Test Email button and then entering the needed email address.

7 In the Delivery Schedule section, define the schedule of comment export:
• No Scheduling – Select to send your message later
• Send Now – Select to end your message immediately
• Send at a specific date and time – Specify a date and time when you want to deliver your 

email message
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 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set the end date or select No End Date.



Integration with OpinionLab Schedule export of comments to Folder

EFM User Guide 1080

Confidential and Proprietary Information of Verint Systems Inc.

Schedule export of comments to Folder
Navigation

Data Sources tab > Comments  tab > click the needed project link > click View Standard Report, 
Design from Scratch, or View Responses > Responses Manager page.

You can schedule export of comment  in the .csv, .tsv, .xlsx, or .spss file formats to the EFM local folder, 
which is located in {EFMInstall}\AppData\{groupID}\Responses\ {projectID}.

Procedure 
1 On the Response Manager page, in the Schedule Export menu, click Folder.
2 On the Schedule Export Delivery Page, in the Select Format menu, select the format of the 

exported file:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS

 To specify the formatting options for the scheduled export, click the Export Options link next to 
the Select Format menu, and then select the appropriate options.

3 In the Delivery Schedule section, define the schedule of comment  export:
• No Scheduling – Select to send a file later.
• Export Now – Select to export a file immediately.
• Send at a specific date and time – Specify a date and time when you want to export a file.

 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set the end date or select No End Date.
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Schedule export of comments to SFTP
Navigation

Data Sources tab > Comments  tab > click the needed project link > click View Standard Report, 
Design from Scratch, or View Responses > Responses Manager page.

You can schedule export of comment in the .csv, .tsv, .xlsx, or .spss file formats to the Secure File Transfer 
Protocol (SFTP) to access, transfer, and manage the comments.

Procedure 
1 On the Responses  tab, in the Schedule Export list, click SFTP.
2 On the Schedule Export Delivery Page, in the Select Format menu, select the format of the 

exported file:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS

 To specify the formatting options for the scheduled export, click the Export Options link next to 
the Select Format menu, and then select the appropriate options.

3 In the SFTP Settings section, enter the needed text into the following text boxes:
• Server name – Name of a server where SFTP is located and where you want to export the file to.
• Port – Number of a port for the specified server.
• Path – Location on a server to which you want to export the file.
• User Name – User name for the specified server.
• Password – Password for the specified server.

 To test connection, click the Test Settings button.

4 In the Delivery Schedule section, define the schedule of comment export:
• No Scheduling – Select to send a file later.
• Export Now – Export a file immediately.
• Export at a specific date and time – Specify a date and time when you want to export a file.

 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set the end date or select No End Date.
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Share a comment
Navigation

 Data Sources tab > Comments tab > Actions menu > Share button.

You can share your comment which provides other users or organizations access to your comments.
The following sharing options are available:
• View Access – You can only view the shared comment.
• Full Access – You can view and edit the shared comment.
You can also share multiple comments. When multiple comments are selected, you can only add Authors 
or Viewers. To view who has access to multiple comments, open an individual comment. You can remove 
Authors or Viewers (if needed).

 You can share comments only if the comments sharing permission is activated for your user role.

Procedure 
1 Go to the Data Sources tab, and then select the Comments tab.
2 On the OpinionLab Comments page, select the check boxes next to the comment that you want to 

share.
3 On the toolbar, on the Actions menu, click Share.
4 In the Share Access dialog box, select a check box next to the user or organization, and then click the 

right arrow button to move it to the View Access or Full Access box.
5 To send an email notification to the user or organization that have the view or full access to the 

comment, select the Notify Users by Email check box. 
The check box is selected by default.

6 Click OK.
7 In the Notify Users dialog box, edit the email notification, and then click OK.

 The Notify Users dialog box opens only when the Notify Users by Email check box is selected.
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Change a comment owner
Navigation

Data Sources tab > Comments tab > Actions menu > Change Owner button.

You as a group administrator can reassign the comments to a new owner.
When the comment owner is changed, the corresponding email notification is sent.

Procedure 
1 Go to the Data Sources tab, and then select the Comments tab.
2 On the OpinionLab Comments page, select the check boxes next to the comment that you want to 

reassign.
3 On the toolbar, on the Actions menu, click Change Owner.
4 In the Bulk Assign Comment Projects to New Owner dialog box, select the user who will be a new 

owner.

 The current comments owner is outlined in gray.

5 Click OK.
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Push a comment to Feedback Intelligence
Navigation

Data Sources tab > Comments tab > Actions menu > Push comments to FI button.

Before you begin 
• Publish the needed comment.

 Comment in the Design mode is not available for publishing.

• Contact a System Administrator to add the comment to Feedback Intelligence. A System 
Administrator can also enable and disable the Push to Feedback Intelligence option for a 
certain comment.

 When you update the existing comment in Feedback Intelligence, changes that you made to the 
comment may affect the previously generated Feedback Intelligence universe and Tableau data 
source, which may change or damage the existing reports. If you have reports based on this 
comment, it is recommended that you discuss your comment changes with a support manager 
before submitting this update.

Procedure 
1 On the Comments page, select the comment that you want to update in Feedback Intelligence.
2 On the Actions menu, click the Push to Feedback Intelligence option.
3 In the confirmation dialog box, click OK.

Your comment is marked to be updated in Feedback Intelligence.
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ForeSee page overview
Navigation

Data Sources tab > ForeSee tab > ForeSee page.

You can view information about the existing  ForeSee projects, open, rename, and delete them. 

 The ForeSee page is available if the System Administrator activates the ForeSee Integration     
license for your workgroup and only if you have the View permission.

Before you begin 
• To verify if the Enable ForeSee Iintegrationcheck box is selected for your workgroup, contact 

your System Administrator.
When you import a ForeSee project, the appropriate task is created on the System Task page. 
On the ForeSee page, the following columns are available:
• Project Title – Name of a ForeSee  project which is displayed as a link. 
• Type – Type of the ForeSee project.

 For now, only responses from the Model Surveys are supported for the further analysis. 

• Responses – Amount of responses for the ForeSee project. 
• Owner – The user to whom the ForeSee  project belongs.
• Last updated – The last time when the ForeSee project was changed.
• Analyze – Icon that redirects you to the Analyze tab of the ForeSee project when clicking it. 

The ForeSee page

Added [KH]
12/17/2019 4:41:47 PM
-----


Added [KH]
12/17/2019 4:41:47 PM
-----


Deleted [KH]
12/17/2019 4:42:37 PM
-----
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 When you click the project title link or Analyze  icon, you will be redirected to the Analyze 
tab of the ForeSee project. 

On the Actions menu, the following options are available:

• Rename – Click to rename the ForeSee  project. To make this option available, select the check 
box next to the ForeSee  project that you want to rename.

• Share – Click to share your  ForeSee  project with other users. You can select which users can view 
the   ForeSee  project, change the   ForeSee  project name, and notify users by email that the   ForeSee  
project is available to view. 

• Change Owner – Click to change the owner of  ForeSee  project.
In the ForeSee grid, you can sort your projects by the Project Title, Type, Responses, Owner, or Last 
updated.
By default, the ForeSee grid shows the first 10 projects. To view more saved projects, use the View per 
Page option. Select the 25, 50, or 100 link to display more projects. To navigate between the pages, click 
the navigation arrows in the lower right corner. The Displaying # of # option shows the number of 
current columns among the total number of them
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Share a ForeSee project
Navigation

Data Sources tab > ForeSee tab > Actions menu > Share option.

You can share your ForeSee project which provides other users or organizations access to your ForeSee 
projects.
The following sharing options are available:
• View Access – You can only view the shared ForeSee project.
• Full Access – You can view and edit the shared comment.
You can also share multiple ForeSee projects. When multiple ForeSee projects are selected, you can only 
add Authors or Viewers. To view who has access to multiple projects, open an individual project. You can 
remove Authors or Viewers (if needed).

 You can share ForeSee projects only if the ForeSee projects sharing permission is activated for 
your user role.

Procedure 
1 Go to the Data Sources tab, and then select the ForeSee tab.
2 On the ForeSee page, select the check boxes next to the project that you want to share.
3 On the toolbar, on the Actions menu, click Share.
4 In the Share Access dialog box, select a check box next to the user or organization, and then click the 

right arrow button to move it to the View Access or Full Access box.
5 To send an email notification to the user or organization that has the view or full access to the 

comment, select the Notify Users by Email check box. 
The check box is selected by default.

6 Click OK.
7 In the Notify Users dialog box, edit the email notification, and then click OK.

 The Notify Users dialog box opens only when the Notify Users by Email check box is selected.
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Change a ForeSee project owner
Navigation

Data Sources tab > ForeSee tab > Actions menu > Change Owner option.

You as a group administrator can reassign the ForeSee projects to a new owner.
When the project owner is changed, the corresponding email notification is sent.

Procedure 
1 Go to the Data Sources tab, and then select the ForeSee tab.
2 On the ForeSee page, select the check boxes next to the comment that you want to reassign.
3 On the toolbar, on the Actions menu, click Change Owner.
4 In the Bulk Assign ForeSee Projects to New Owner dialog box, select the user who will be a new 

owner.

 The current project owner appears dimmed. 

5 Click OK.
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Export ForeSee projects to the .csv .tsv, or .xlsx file 
formats

Navigation

Data Sources tab > ForeSee tab > ForeSee page > click the needed project link or Analyze icon next to 
the needed project >  View Standard Report, Design from Scratch, or View Responses > Responses 
Manager page.

You can export ForeSee projects to the .csv, .tsv, or .xlsx file formats to save them locally.

Procedure 
1 On the Response Manager page, in the Export menu, click the needed file format for export:

• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel

2 In the Export Responses dialog box, in the Columns section, select the needed option:
• Displayed Data – Only data available on the Responses Manager page is exported.
• All Response Data from the Current Project – All response data from the current project is 

exported.
3 In the Filter section, define if any filter is applied to the exported data:

• No Filter – The exported file uses no filters.
• Current Filter – The current filter is applied to the exported response data.

4 Click Next, and in the Export Responses dialog box, click the link to download the exported file.
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Export ForeSee project to the .spss file format
Navigation

Data Sources tab > ForeSee tab > ForeSee page > click the needed project link or Analyze icon next to 
the needed project >  View Standard Report, Design from Scratch, or View Responses > Responses 
Manager page.

You can export ForeSee projects to the .spss file format to save them locally.

Procedure 
1 On the Response Manager page, in the Export menu, click the SPSS option.
2 In the Export Responses dialog box, in the Columns section, select the needed data export option:

• Displayed Data – Only data available on the Responses Manager page is exported.
• All Response Data from the Current Project – All response data from the current project is 

exported.
3 In the Filter section, define if any filter is applied to the exported data:

• No Filter – The exported file uses no filters.
• Current Filter – The current filter is applied to the exported response data.

4 To define the missing value for not asked questions, select the Define Missing Value for Not 
Asked Questions check box and enter the whole number for missing value into the text box.

 By default, this option is not active. The system value appears in the export file when the option 
is not active.

5 In the Export Responses dialog box, click the link to download and view the exported file.



Integration with ForeSee Schedule export of ForeSee projects by email

EFM User Guide 1092

Confidential and Proprietary Information of Verint Systems Inc.

Schedule export of ForeSee projects by email
Navigation

Data Sources tab > ForeSee tab > ForeSee page > click the needed project link or Analyze icon next to 
the needed project > click View Standard Report, Design from Scratch, or View Responses > 
Responses Manager page.

You can schedule export of  ForeSee projectin the .csv, .tsv, .xlsx, or.spss file formats by email.

 The file exported is zipped and attached to the email message.

Procedure 
1 On the Response Manager page, in the Schedule Export menu, click Email.
2 On the Schedule Export Delivery Page, in the Select Format menu, click the format of the 

exported file:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS

 To specify the formatting options for the scheduled export, click the Export Options link next to 
the Select Format menu, and then select the appropriate options.

3 In the To text box, type the email address of the needed recipients.

 If there are organizations in a workgroup, click the To button to select the recipients. In the 
Survey Responses Recipients dialog box, select a check box next to the user or organization, 
click the right arrow button to add them to the Recipients, and then click OK.

4 In the From text box, type the sender’s email address.
By default, your email address is selected.

5 In the Subject text box, type the title of the email message.
By default, the title of the email message is Responses for <survey name>.

6 In the email message body, type the needed text and customize it by using the editing toolbar.

 To preview the email message, click the Preview button. You can also test the email message by 
clicking the Send Test Email button and then entering the needed email address.

7 In the Delivery Schedule section, define the schedule of comment export:
• No Scheduling – Select to send your message later
• Send Now – Select to end your message immediately
• Send at a specific date and time – Specify a date and time when you want to deliver your 

email message
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 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set the end date or select No End Date.
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Schedule export of ForeSee projects to SFTP
Navigation

Data Sources tab > ForeSee tab > ForeSee page > click the needed project link or Analyze icon next to 
the needed project > click View Standard Report, Design from Scratch, or View Responses > 
Responses Manager page.

You can schedule export of ForeSee project in the .csv, .tsv, .xlsx, or .spss file formats to the Secure File 
Transfer Protocol (SFTP) to access, transfer, and manage the ForeSee projects.

Procedure 
1 On the Responses  tab, in the Schedule Export list, click SFTP.
2 On the Schedule Export Delivery Page, in the Select Format menu, select the format of the 

exported file:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS

 To specify the formatting options for the scheduled export, click the Export Options link next to 
the Select Format menu, and then select the appropriate options.

3 In the SFTP Settings section, enter the needed text into the following text boxes:
• Server name – Name of a server where SFTP is located and where you want to export the file to.
• Port – Number of a port for the specified server.
• Path – Location on a server to which you want to export the file.
• User Name – User name for the specified server.
• Password – Password for the specified server.

 To test connection, click the Test Settings button.

4 In the Delivery Schedule section, define the schedule of comment export:
• No Scheduling – Select to send a file later.
• Export Now – Export a file immediately.
• Export at a specific date and time – Specify a date and time when you want to export a file.

 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set the end date or select No End Date.
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Schedule export of ForeSee projects to Folder
Navigation

Data Sources tab > ForeSee tab > ForeSee page > click the needed project link or Analyze icon next to 
the needed project > click View Standard Report, Design from Scratch, or View Responses > 
Responses Manager page.

You can schedule export of ForeSee project in the .csv, .tsv, .xlsx, or .spss file formats to the EFM local 
folder, which is located in {EFMInstall}\AppData\{groupID}\Responses\ {projectID}.

Procedure 
1 On the Response Manager page, in the Schedule Export menu, click Folder.
2 On the Schedule Export Delivery Page, in the Select Format menu, select the format of the 

exported file:
• CSV (Comma delimited)
• TSV (Tab delimited)
• Microsoft Excel
• SPSS

 To specify the formatting options for the scheduled export, click the Export Options link next to 
the Select Format menu, and then select the appropriate options.

3 In the Delivery Schedule section, define the schedule of comment  export:
• No Scheduling – Select to send a file later.
• Export Now – Select to export a file immediately.
• Send at a specific date and time – Specify a date and time when you want to export a file.

 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set the end date or select No End Date.



C h a p t e r  3 0  

Tableau

Topics 

Integration with Tableau 1097

Creating and managing reports in Tableau 1098

Import data from EFM into Tableau using Tableau WDC 1099



Tableau Integration with Tableau

EFM User Guide 1097

Confidential and Proprietary Information of Verint Systems Inc.

Integration with Tableau
Tableau is a third-party tool for creating and using advanced reports, data visualizations, dashboards, and 
data analysis. Depending on the Tableau product that you are using, you can track and manage your EFM 
data in two ways:
• If you have your own license for Tableau products, you can manage data via Tableau Web Data 

Connector (WDC) by importing the EFM survey responses into Tableau. It is not a one-time 
procedure, and you need to refresh the data each time it is updated in EFM. For more 
information, see Import data from EFM into Tableau using Tableau WDC, page 1099.

• If you have a Verint license for Tableau Server, the export, exchange, and analysis of the EFM data 
is performed by clicking the Tableau  tab on the Reports tab that redirects you to the Tableau web 
application. For more information, see Creating and managing reports in Tableau, page 1098

 The  tab name is the display name of the Tableau connection configured by your System 
Administrator.
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Creating and managing reports in Tableau
Navigation

Report & Analyze tab >  Tableau tab > Tableau web application.

You can access Tableau to view and manage projects (surveys, file imports, or profiles), data sources, and 
reports that are created based on EFM surveys, profiles, and file imports by using the Tableau tab.

 To enable the Tableau feature and configure the Tableau tab for your workgroup, contact System 
Administrator.

The process of using Tableau for reporting and adding surveys, file imports, Speech Analytics project, 
comments, Unified Data Sets, and profiles is the following (same as for Business Objects):
1 System Administrator configures Tableau settings, establishes Feedback Intelligence connection for 

your workgroup, and activates Tableau permissions.
2 Owner of a project shares access to a survey, file import, or profile in the Actions menu, on the 

corresponding projects list page.

 It is recommended to share Full Access for the user to view and edit the project.
 

3 System Administrator pushes a survey, file import, or profile to Feedback Intelligence, or you click the 
Push to Feedback Intelligence option on the Actions menu (this option is available if the project is 
already added to Feedback Intelligence).

 After you or System Administrator adds a survey, file import , or profile to Feedback Intelligence, 
it might take some time for the data to become available for reporting in Tableau. In this case, the 
newly added fields are marked with red in the workbook until the data is finally uploaded to the 
database.

When the Tableau feature is configured for the workgroup, the Access Tableau permission is 
automatically granted to the following roles:

• Group Administrator
• Report Author
• Report Viewer
• Survey Administrator
• Survey Author

After System Administrator activates the Tableau license, all users assigned to the workgroup receive the 
Tableau accounts.

 By default, all users within a workgroup receive the Viewer site role permissions in Tableau 
regardless of the assigned user role. For additional permissions, contact System Administrator.

You can log in to Tableau by using the EFM credentials. Your user name in Tableau is your email address in 
EFM. If you change an email address in EFM, your user name in Tableau will remain the same. To set or 
change the Tableau password, in the EFM application, click My Account > Change Tableau password.
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Import data from EFM into Tableau using Tableau 
WDC

Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > View Responses > Responses tab.

OR
Data Sources tab > Comments tab > click the needed comment card link > click the View Standard 
Report, Design from Scratch, or View Responses button > Responses Manager page.
You can import the survey, profile, or comment card response data from EFM into Tableau via Tableau 
Web Data Connector (WDC).

Procedure 
1 On the Actions menu, click Export > Tableau Link.

 The users with Report Viewer or Report Author roles, who do not have access to the 
Response Manager grid, can export the data from EFM into Tableau if the Tableau link is 
shared with them by other users.

2 In the Export to Tableau WDC dialog box, copy the URL.
3 In the Tableau Desktop application, under Connect > To a Server, click Web Data Connector. 
4 On the Web Data Connector page, paste the copied URL, and press Enter.
5 Log in with your EFM credentials.
6 On the Verint EFM Web Data Connector page, select the columns that you want to import. You 

can import all data related to profiles, surveys, and comment cards, such as data channels, participant 
information, location data, and other project-related data. For comment cards, columns represent all 
fields available in the Comments project.

 You can import the previously selected columns when exporting data for the second time by 
clicking the Use previously selected columns check box.

7 Click Import.
8 Click Update Now.

All response data that is available in EFM is now imported into Tableau WDC.

 To update the existing columns in Tableau, in a worksheet, right-click the data source, and then 
click Extract > Refresh. To add new columns to your data source in Tableau, right-click the data 
source > Edit Data Source.
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Cases tab
Navigation

Cases tab.

You can create, view, or edit cases assigned to you and assign cases to the workgroup members.

 The Cases tab is available if you have a license for the Case Management feature.

In the Cases grid, the following columns are available by default:

       Case – The case number.

       Title – The case name.

       Contact's Email – The email of the person who can provide the detailed information about the case.

       Assigned to – The workgroup member to whom the case is assigned.

       Status – The case status. The following options are available:
        Open

        On Hold

        Closed

       Priority – The case priority. The following options are available:
        1 – Critical

        2 – Very High

        3 – High

        4 – Medium

        5 – Low

        6 – Very Low

        7 – Negligible

       Last Modified – The last time when the case was changed.

On the Cases page, on the toolbar, the following options are available:

       Actions – Select the action that you want to perform on your case. The following options are available:
        New – Create a new case.

        Assign – Assign one or more cases to the workgroup member.

        Filter – Filter cases in the grid based on the specific criteria.

        Export – Export cases to the .CSV, .TSV, or Microsoft Excel file formats.

        Schedule Export - Schedule when case data is exported to Email, a local folder or an SFTP site.
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        Reopen – Reopen the previously closed case. You can reopen multiple cases.

        Close – Close the case. You can close multiple cases.

        Delete - Delete the case. You can delete multiple cases.

 The Assign, Export, and Close options are active only when one or more cases are selected.

       Columns – Select the columns to be displayed in the Cases grid. The following columns are available 
for selection:

        Opened by – The name of the person who opened the case.

        Created – The date and time when the case was created.

        Description – The case description.

        First Name – The first name of the contact person.

        Last Name – The last name of the contact person.

        Contact's Business – The company name of the contact person.

        Phone – The phone number of the contact person.

        Closed – The date and time when the case was closed.

        Duplicate Cases - The names of the cases closed as duplicates.

        Viewed – The number of  people who saw the case.

        Custom Properties – The additional values that can be set by a user to describe, categorize, and 
report on cases.

        Data Source Type – The type of the data source. The available types are Survey, Comments, Model 
Survey, Speech Analytics, and File Import.

        Project Name – The name of the project.

        Record ID – The link with a unique ID number of the record. When clicked, it displays the Responses 
dialog box.

        Organization Name – The name of the organization for the cases Org ID.

       Search – Search for the case by its title, contact information, or assignment. If you enter the number in 
the text field and it matches the case number, you are redirected to the case details page. The search 
filter is persisted while navigating through the Cases grid pages.

By default, all active cases assigned or unassigned to you  are sorted by Last Modified in a descending 
order. You can change the view of cases in the Cases grid by using the customized filters. For more 
information about filters, see Case Filters, page 1109 and Case Quick Filters, page 1113.
The total number of cases is displayed at the bottom of the grid. You can adjust the number of cases that 
appears on one page. The default number of cases per page is 10. However, you can select up to 100 
cases to appear on one page. You can also navigate through the pages by clicking the scroll arrows at the 
bottom of the grid.
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Case Management – Role-based access
Navigation

Administration tab > Roles tab.

The group and case administrators can control the workgroup members' access to create, view, edit, and 
assign cases based on the user role set of permissions. You can activate the Case Management 
functionality for a user by creating a new role or editing the existing ones. 
Two new predefined roles are added to the application:
• Case Administrator – User is able to create, view, and configure cases regardless of the user's 

assignment.
• Case User – User is able to create, edit, and view cases assigned for that specific user only.
By default, all Case Management permissions are active for the Group Administrator, Survey 
Administrator, Case Administrator, and Survey Author roles.

Activate Case Management for a user role

Procedure 
1 Go to the Administration tab > Roles tab.
2 On the Roles page, click the name of the role that you want to edit.
3 On the Edit Role page, define the actions the workgroup member can perform on cases by selecting 

the corresponding check boxes in the View, Create, and Edit columns in the Case Administration 
section. 
• View – View cases assigned to you or currently unassigned. 

 The selection of the View check box activates the Cases tab.

• Create – Add new cases.
• Edit – Modify cases assigned to you or currently unassigned.
• Delete – Remove cases assigned to you or currently unassigned. When you delete the case, the 

case records from all reports and dashboards are removed too.

 When you clear the View, Edit, or Delete check box for Cases, the View, Edit, or Delete check 
box for Organization Cases is cleared too.

4 Control the access of the workgroup member to customer emails by selecting the corresponding 
check boxes in the View and Edit columns in the Customer Email row in the Case Administration 
section.

 If the View check box is cleared, the following items are not visible to the workgroup member: 
the Email button when viewing a case, Contact’s Email column in the Cases grid, Contact’s 
Email filtering option, etc.
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5 To let the workgroup member view all cases in a workgroup regardless of their assignment and 
organization, in the Administration section, select the View All Cases check box.

 When you select the View All Cases check box, the View check boxes for Cases and 
Organization Cases in the Case Administration section are selected automatically.

6 To let the workgroup member to edit the priority labels and create custom properties,  in the 
Administration section, select the Configure Case Settings check box. 

 When you select the Configure Case Settings check box, the Configuration > Case Setup tab 
is activated.

7 Click Save.
 



Case Management Overview Organization Cases – Role-based access

EFM User Guide 1106

Confidential and Proprietary Information of Verint Systems Inc.

Organization Cases – Role-based access
Navigation

Administration tab > Roles tab.

The group and survey administrators can control the workgroup members' ability to view and edit 
organization cases based on the user role set of permissions. You can activate the Organization Cases 
functionality for a user by creating a new role or editing the existing ones. By default, all Organization 
Cases permissions are active for the group and survey administrators, case user and case administrator, 
and survey author.

Activate Organization Cases for a user role

Procedure 
1 Go to the Administration tab > Roles tab.
2 On the Roles page, click the name of the role that you want to edit. 
3 On the Edit Role page, in the Case Administration section, in the Organization Cases row, define 

the actions the workgroup member can perform on the organization cases by selecting the 
corresponding check boxes in the View and Edit columns.
• View – View all cases associated with the same organization the user is assigned to and its sub-

organizations.
• Edit – Modify all cases associated with the same organization the user is assigned to and its sub-

organizations.

 When you select the View or Edit check box for Organization Cases, the View or Edit check 
box for Cases is selected automatically.

4 Click Save.
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Creating new cases
Navigation

Cases tab > New button on the toolbar > Create New Case dialog box.

You can create new cases and define their details. 

 You can also open the Create New Case dialog box by clicking Actions menu > New.

In the dialog box, you can add the following information on the case:
• Assigned to
• Priority
• Title
• Notify Users
• Case Description
Optional fields:
• Contact's Email
• Contact's First Name
• Contact's Last Name
• Contact's Business
• Contact's Phone

Create a new case

Procedure 
1 On the Cases tab, click the New button on the toolbar. 
2 In the Create New Case dialog box, in  the Assigned to list, select the workgroup member to whom 

you want to assign the case. 
By default, the case author's name is displayed. When there are more than 50 members in a 
workgroup, the Assigned to option appears as an autocompleting text box.

 If the user is out of office the case is assigned to their chosen case proxy who works on all cases 
while the user is out of office. The case can be assigned to the original user on their return.

3 In the Priority list, select the case priority. 
4 – Medium is the default option.

4 In the Title text field, type the case summary. 
This field is required.

5 In the Notify Users text field, enter the names of the persons to receive a notification that a new 
comment is added to the case. 
When there are more than 50 members in a workgroup, the Notify Users option appears as an 
autocompletion text box.
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6 In the Case Description text field, enter the case description. You can customize the case description 
by using the additional editing options on the toolbar.

7 In the Contact's Email text field, enter the email address of the person, who can provide the detailed 
information about the case.

8 In the Contact's First Name text field, enter the first name of the contact person.
9 In the Contact's Last Name text field, enter the last name of the contact person.
10 In the Contact's Business text field, enter the company name of the contact person.
11 In the Contact's Phone text field, enter the phone number of the contact person.
12 Click Create. 

The new case is created and the case details page opens displaying all case data that you have defined.
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Case Filters
Navigation

Cases tab > Filter button on the toolbar > Filter dialog box.

You can apply the data and date filters to the cases to view the certain results only. The data filter is based 
on the specific criteria that you can define on a cases data basis. The age filter is based on the date when 
cases are last modified, created, or closed X days (hours) ago. The date filter is based on the date when 
cases are opened, closed, or last modified and on the specific time period. You can use a few filters at the 
same time. 
When you use a filter like Last Week, Last Month, Last Quarter, etc., the filter is a rolling filter. It means 
that the filter will continue to update relative to the current date and not the date when it is created.

Data Filter
In the Data Filter section, you can define the filter criteria based on your cases data. To add new criteria, 
click the Add Another Criteria link. The  lists appear where you can specify the filter parameter, 
expression, and value.
• Parameter – Select the parameter by which you want to filter your cases data from the  list. The 

following options are available:
• Assigned to
• Priority
• Status
• Contact's Email
• Contact's First Name
• Contact's Last Name
• Contact's Business
• Contact's Phone
• Date Opened
• Date Closed
• Last Modified
• Created By
• Source
• Title
• Description
• Data Source Type
• Project Name
• Record ID
• Organization Name

• Expression – Select the expression from the  list to make a comparison between Parameter and 
Value. The options for expression may vary depending on the selected parameter. 
The following options are available:
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• Equals
• Does Not Equal
• Less than
• Greater than
• Less than or equal
• Greater than or equal
• Contains
• Does Not Contain
• Begins With
• Ends With

• Value – Select the value for filtering criteria in the list. The options vary depending on the selected 
parameter. For example, for the Status parameter, you need to select the needed case status in 
the list, and for the Contact's Email parameter, you need to type the contact data in the text 
box. For the date-related parameters, you need to specify a date either by using the text box or 

the calendar icon .
• Save – Click the link or anywhere else in the dialog box to save your criteria.
If you add multiple criteria, you can combine them by using the following Match options:
• All Criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The lists with parentheses and the And / Or operators appear next to each criterion. 

The And operator defines that two or more filters linked together are true. The Or operator 
defines that one of the filters linked together is true.

• Remove – Click the Remove icon  to delete the filter criteria.

• Up/Down – Click the Up  or Down  arrow to move the selected filter criteria up or down 
one level in the list.  Filters are applied in a sequential manner, and their position in the list is 
important.

Age Filter
In the Age section, you can set the filter based on the date when cases are last modified, created, or 
closed X days (hours) ago. This filter is combined with the data filter. For example, you can set the 
following criteria:
Data Filter: Cases that are assigned to User 1
and
Age: Cases that are modified (created or closed) in X days.

Date Filter
In the Date Filter section, you can set the filter based on the date when cases are last modified and 
based on the selected time period.
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• Select Date Field – Select an option in the  list to filter the cases based on their modification date. 
The following options are available:
• None – Applies no date filter and is selected by default.
• Opened Date – Applies the filter based on the date the case was opened.
• Last Modified Date – Applies the filter based on the date the case was last changed.
• Closed Date – Applies the filter based on the date the case was closed.

• Time Period – Select an option in the  list  to filter the cases based on a certain time period. The 
following options are available:
• None – Applies no time period filter and is selected by default.
• Today – Shows the cases submitted today.
• Current Week – Shows the cases for the current week, no matter the current date.
• Current Month – Shows the cases for the current month, no matter the current date.
• Current Quarter – Shows the cases for the current three months, no matter the current date.
• Current Year – Shows the cases for the current calendar year, no matter the current date.
• Year to Date – Shows the cases for the period starting January 1st of the current year up until 

the current date.
• Last Week – Shows the cases for the past week.
• Last Month – Shows the cases for the past month.
• Last Quarter – Shows the cases for the past three months.
• Last Year – Shows the cases for the past year.
• Custom Dates – Shows the cases for the specific date range. When the Custom Dates option is 

selected, the Start Date and End Date text boxes appear. You can enter the date range in the 

corresponding text boxes manually or by using the calendar icon .
To set the default values for the date filters, click the Clear All Date Filters link.

Filter Cases by using the Data Filter

Procedure 
1 On the Cases page, on the toolbar, click the Filter button. 
2 In the Filter dialog box, in the Data Filter section, click the Add Another Criteria link. 

The drop-down lists appear where you can specify the filter parameter, expression, and value.
3 In the drop-down lists, select the parameter by which you want to filter your cases data, the 

expression to make a comparison between parameter and value, and the value for filtering criteria.
4 To save your criteria, click the Save link.
5 To add more criteria, click the Add Another Criteria link.
6 Specify if either all or any of the criteria need to be met by selecting the corresponding radio button to 

the right of the Match option.
7 To save your filter criteria, click Apply Filter. 

The Cases page is updated immediately.
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Filter Cases by using the Age Filter

Procedure 
1 On the Cases page, on the toolbar, click the Filter button.
2 In the Filter dialog box, click the Age section to expand it. 

You can filter by the cases, which were created 5 days ago, for example.
3 Select the check box next to the option that you want to use. 

The following options are available:
• Date Last Modified
• Date Created
• Date Closed

4 Select the expression next to the selected option.
5 Type the number in the text box, which is the number of days or hours.
6 Select Hour(s) or Day(s) in the list.
7 To save your filter criteria, click Apply Filter. 

The Cases page is updated immediately.

Filter Cases by using the Date Filter

Procedure 
1 On the Cases page, on the toolbar, click the Filter button.
2 In the Filter dialog box, in the Date Filter section, in the Select Date Field list, select an option to 

filter the cases based on their modification date.
3 In the Time Period list, select an option to filter the cases based on a certain time period.
4 To save your filter criteria, click Apply Filter. 

The Cases page is updated immediately.
When you apply filter to the cases, a notification describing the current filter appears above the Cases 
grid. You can change or cancel the custom filter by clicking the Edit or Clear link correspondingly.
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Case Quick Filters
Navigation

Cases tab > Cases grid > Quick Filters option.

You can filter the cases. Quick filters are predefined filters that you can use to quickly get to the cases you 
need.
The following options are available:
• All Cases – View all cases that you have access to.
• Assigned To Me – View all cases assigned to you.
• Unassigned Cases – View all currently unassigned cases.
• Custom Filter – Define your own filter based on the specific criteria. For more information about 

filtering, see Case Filters, page 1109.
When you apply a filter to the cases, a notification describing the current filter appears above the Cases 
grid. You can change or cancel the custom filter by using the Edit or Clear link correspondingly.

 The Edit link is available for the custom filter only.
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Add a column in the Cases grid
Navigation

Cases tab > Columns button on the toolbar.

You can specify which columns you want to display in the Cases grid.

Procedure 
1 On the Cases tab, click the Columns button.
2 In the Select Columns dialog box, select the check box next to the Case Fields or Custom 

Properties that you want to add.
3 Click Apply.

The added columns are now displayed in the Cases grid.
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Exporting Cases
Navigation

Cases tab > Actions menu.

You can export the case data to the .CSV, .TSV, or Microsoft Excel format.

Procedure 
1 Go to the Cases page > Actions menu.
2 On the Actions menu, point to Export, and then select the output format.
3 In the Export Cases dialog box, select the corresponding export options. 

There are the following options available:
• Columns – Select if all columns or only the displayed ones should be exported.
• Filter – Select if filter should be used to export the case data.
• Audit Log – Select what audit information should be exported.

4 Click Next. 
The export file is generated in the selected format.

5 To save or open the export file, click the link that appears.
6 Click Close.
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Schedule case data export
You can schedule case data exports regularly in a similar manner to how you schedule response data 
exports. The self-serve aspect of this feature means that there is no requirement to engage Verint services 
for the data broker service or use APIs. You can automatically pull the case data in with several options 
available.

To push case data into your chosen platform or file option, select the raw unformatted data, or choose to 
show the HTML formatting available when using a case trigger setup.

 You must have Export checked for Cases or Organization Cases under Case Administration 
to have access to scheduled exports for cases.

The following scheduling options are available to export case data:
• Schedule case export by Email, page 1117
• Schedule case export to folder, page 1119
• Schedule case export to SFTP, page 1120
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Schedule case export by Email
You can schedule the export and email delivery of case data to email recipients.

Procedure 
1 On the Cases tab, in the Schedule Export list, click Email.
2 On the Schedule Export Delivery Page, in the Select Format list, select the file format of the 

report (CSV, TSV or Microsoft Excel). To include a ZIP attachment, check  Zip attachments, and the 
report in the selected format is attached to the email message in a ZIP archive.

 To specify the formatting options for your scheduled case export, click the Export Options link 
next to the Select Format list, then select the appropriate options.
In the Export Cases Scheduled dialog box, after you save the formatting options, the next 
scheduled export file uses these options.

 If you applied a filter in the Export Cases Scheduled dialog box for your previously scheduled 
case exports, ensure that your newly set filter is enabled for the next scheduled export. To enable 
the currently applied filter on your report, on the Schedule Export Delivery page, click the 
Export Options link. In the Export Cases Scheduled dialog box, select the Current Filter 
option, then click Save.

3 To add recipients, do the following:
a. In the To text box, type the email address.

 You can add multiple addresses separating them by commas or semicolons.

b. If there are organizations in a workgroup, you can click the To button to select the recipients. In 
the Recipients dialog box, select a check box next to the user or organization, click the right 
arrow button to add them to the Recipients list, and then click OK.

4 In the From text box, specify the email address from which you want to send your message. By 
default, your email address is selected.

5 In the Subject text box, type the message subject. 
6 In the email body, type the message text and customize it by using the editing toolbar.
7 To preview your message, click the Preview button.
8 To test your message before delivering it to the recipient, do the following:

a. Click the Send Test Email button.
b. In the Send Test Email dialog box, in the Email Address field, type the test email address, and 

then click the Send button.
9 In the Delivery Schedule section, define when and how to deliver the case data:

• No Scheduling – Select to send your message later. This option removes scheduling and stops 
sending of email notifications.

• Send Now – Select to end your message immediately.

 A delay of several minutes can be expected before your email is delivered.
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• Send at a specific date and time – Specify a date and time when you want to deliver your 
email message. Select a valid start date and time; otherwise, the email message will not be saved.

 To schedule regular messages delivery (daily, weekly, or monthly), click the Show Recurrence 
Options link. You can also set an end date or select No End Date.

10 Click Save.

 When the Send Now option is selected in the Delivery Schedule section, the Send Report 
button is displayed instead of the Save button.
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Schedule case export to folder
You can schedule a case data export to your local folder, which is located in {EFM Install}\AppData\
{groupID}\Cases\

Procedure 
1 On the Cases tab, in the Schedule Export list, click Folder.
2 On the Schedule Export Delivery Page, in the Select Format list, select the format of the file (CSV, 

TSV or Microsoft Excel) to export to your local folder. To include a ZIP attachment, check  Zip 
attachments, and the report in the selected format is attached to the email message in a ZIP archive.

 To specify the formatting options for your scheduled case export, click the Export Options link 
next to the Select Format list, then select the appropriate options.
In the Export Cases to Folder Scheduled dialog box, after you save the formatting options, the 
next scheduled export file uses these options.

 If you applied a filter in the Export Cases to Folder Scheduled dialog box for your previously 
scheduled case exports, ensure that your newly set filter is enabled for the next scheduled 
export. To enable the currently applied filter to your report, on the Schedule Export Delivery 
page, click the Export Options link. In the Export Cases to Folder Scheduled dialog box, select 
the Current Filter option, then click Save.

3 In the Delivery Schedule section, define when and how to deliver the case export:
• No Scheduling – Select to send your file later. This cancels the export to folder but not email 

notifications.
• Export Now – Select this to export the file immediately.
• Export at a specific date and time – Specify a date and time when you want to export your 

file. Select a valid start date and time; otherwise, the file is not saved.

 To schedule a regular export (daily, weekly, or monthly), click the Show Recurrence Options 
link. You can also set an end date or click No End Date.

4 Click Save.

 When the Export Now option is selected in the Delivery Schedule section, the Export Now 
button is displayed instead of the Save button.
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Schedule case export to SFTP
You can schedule an export of case data to an SFTP server.

Procedure 
1 On the Cases tab, in the Schedule Export list, click SFTP.
2 On the SFTP Delivery Page, in the Select Format list, click the required file format: CSV, TSV, or 

Microsoft Excel. To include a ZIP attachment, check  Zip attachments, and the report in the selected 
format is attached to the email message in a ZIP archive.

 To specify the formatting options for your scheduled case export, click the Export Options link 
next to the Select Format list, then select the appropriate options.
In the Export Cases to SFTP Scheduled dialog box, after you save the formatting options, the 
next scheduled export file uses these options.

 If you applied a filter in the Export Cases to SFTP Scheduled dialog box for your previously 
scheduled case exports, ensure that your newly set filter is enabled for the next scheduled 
export. To enable the currently applied filter to your report, on the Schedule Export Delivery 
page, click the Export Options link. In the Export Cases to SFTP Scheduled dialog box, select 
the Current Filter option, then click Save.

3 In the SFTP Settings sections, configure your SSH FTP connection:
• Server name – Name of the server where SFTP is located and where you want to export the file.
• Port – Port number for the specified server.
• Path – Location on a server to where you want to export the file.
• User Name – User name for the specified server.
• Password – Password for the specified server.

4 To validate the connection, click Test Settings.
5 In the Delivery Schedule section, define the case export delivery schedule and the recurrence 

options. The following options are available:
• No Scheduling – Select to send your file later. This cancels the export to SFTP but not email 

notifications.
• Export Now – Export case data immediately.
• Export at a specific date and time – Specify a date and time when you want to export your 

file. You can either type the date and time manually into the available text field or select the date 
and time from pop-up menus. Select a valid start date and time, otherwise the file will not be 
saved.

 Click the Show Recurrence Options link to set recurrence options for your file delivery. Use 
this functionality to export a file multiple times on a daily, weekly, or monthly basis. You can also 
set an end date or select No End Date.

6 Click Save.
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 When the Export Now option is selected in the Delivery Schedule section, the Export Now 
button is displayed instead of the Save button.
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Case Management – Notify users
Navigation

Cases tab > click the case title or the case number > case details page.

You can receive email notifications when new cases are created or existing cases are updated. Also, you 
can define the users who will receive notifications.
You can notify users about the following actions performed on a case:
• Creating a new case on the Cases page or by the trigger
• Adding comment to a case
• Changing case description, status, or priority
• Assigning a new case
• Sending an email message to a contact person

 When the case is assigned to any user, you can select only users with the View All Cases 
permission to send notifications. For unassigned cases, you can select any user to send 
notifications.

The email notification contains the name of the user who performed an action on a case, case ID, case 
title, case priority, the URL to a case, and the action description.
You can notify multiple users at a time. The information about the notification appears on the case 
details page along with the related event.
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Case triggers
Navigation

Design & Collect tab > Triggers tab > Add Trigger button.

You can define case triggers to create cases based on the specific survey responses and respondent 
location. For the case triggers, you need to define criteria for your triggers and specify a person who 
receives the details of the case that is created when respondents select the specific answer or belong to a 
specified location.

 The case triggers are available only if you have a license for the Case Management feature and 
the Case Administration > Cases permission enabled.

 

On the Case Details tab, in the Add Trigger dialog box, you can add the following information for the 
case:
• Assigned to
• Priority
• Title
• Notify Users
• Case Description
Optional fields:
• Contact's Email
• Contact's First Name
• Contact's Last Name
• Contact's Business
• Contact's Phone

Create a case trigger

Procedure 
1 On the Triggers tab in the survey designer, click the Add Trigger button.
2 In the Add Trigger dialog box, in the Description text box, enter a short summary of the trigger.
3 In the Trigger Action drop-down list, click Create a Case.
4 On the Criteria tab, click the Add Another Criteria link.
5 Click the link next to Source, and then select one of the following sources:

• Current Survey (default) – Select the filter parameter, expression, and value from the drop-down 
lists:

a. In the first drop-down list, click one of the following options to apply the logic to:
• Survey question
• Response count criterion with the values from 0 to the specific number of choices or columns 

in Choose Many, Matrix with Choose One or Choose Many sides, or Scrolling Matrix questions
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• Device type criterion

 The device type and the response count criteria can be combined with other criteria for 
conditional visibility.

b. In the second drop-down list, click the expression.
c. In the third drop-down list, click one of the following:

• Question choice
• Number of responses provided by the respondent
• Detected type of device

 When the report or export value is set for a choice, it is displayed instead of the choice index and 
is used as an identifier for the choice.

• Participant Information – Select the filter parameter, expression, and value from the drop-
down lists:

a. In the first drop-down list, Campaign Name is selected.
b. In the second drop-down list, click the expression.
c. In the third drop-down list, click the needed campaign.

 The Campaign Name source is available only after you add at least one campaign on the Collect 
tab.

• Respondent Location – Select the filter parameter, expression, and value from the 
corresponding drop-down lists:

a. In the first drop-down list, click the needed parameter.
b. In the second drop-down list, click the expression, and then type the needed value in the adjacent 

box.
6 Click the Save link to save your criteria.
7 Click the Add Another Criteria link to add more criteria.
8 Specify if either all or any of the criteria need to be met by selecting the corresponding Match option.
9 Click the Case Details tab.
10 In the Assigned to text box, type the name of the workgroup member, to whom you want to assign 

the case. By default, the case is unassigned. The Assigned to text box is an autocompletion text box.

 You can also pipe values in the Assigned to text box from any question in the survey by typing 
the placeholder value in the text box, for example, %Q1_1%. You can pipe the user name or 
email. When the trigger is activated, the piped value is matched to a user name or email. If no 
match is found, the case is unassigned.

11 In the Priority drop-down list, click the case priority. 4 - Medium is the default option.
12 In the Title text box, type the case summary.
13 In the Notify Users text box, enter the names of the persons to receive a notification that a new case 

is created. When there are more than 50 members in a workgroup, the Notify Users option appears 
as an autocompletion text box.
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14 In the Case Description text box, type the case description. You can customize the case description 
by using the additional editing options from the toolbar.

 You can also pipe different fields in your case description using the Insert Piped Value icon  on 
the toolbar.

15 In the Contact's Email text box, enter the email address of the person, who can provide the detailed 
information about the case.

16 In the Contact's First Name text box, type the first name of the contact person.
17 In the Contact's Last Name text box, type the last name of the contact person.
18 In the Contact's Business text box, type the company name of the contact person.
19 In the Contact's Phone text box, type the phone number of the contact person.
20 In the Custom Properties section, select the custom case property. The case properties are available 

only if specified on the Case Setup tab by Case Administrator.
21 Click OK. The created trigger appears on the Triggers tab.
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Organizations and Cases
Navigation

Cases tab.

Cases are assigned to an organization based on the case owner. When new cases are created and 
assigned to the users, their organization is associated with these new cases. When a case is reassigned to 
another user, the organization of the case is updated accordingly.
Case users can view all cases that are assigned to their organization. This way case users can see other 
cases that are relevant to them even if they are not assigned to them. They can track the case creation, 
assignment, or reassignment in their organization.
If the organization is deleted, all cases assigned to the members of that organization are no longer 
associated with the organization.
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Case Details page
Navigation

Cases tab > click the case title or the case number > case details page.

You can view the details of the new and existing cases. The case details page opens when you create a 
new case or click the existing case in the Cases grid. You can navigate through the open cases, change 
case status and priority, assign case to the workgroup members, send email notifications to the contact 
person, and add comments to the case. In addition, you can see the history of all events on a case in an 
ordered list.
When the case details page opens, the case name and number are displayed at the top of the page, for 
example, Case 9. The Next Case and Previous Case arrows provide easy navigation to the next and 
previous cases within the case details page.

 The arrows become active when there are cases after or before the current case.

You can go back to the Cases page by clicking the Return to Cases link at the top of the page.
On the case details page toolbar, you can find the following options:
• Send an email message for cases, page 1132
• Close or reopen a case, page 1135
• Assign or reassign a case to a user , page 1130
• Put on hold or resume a case, page 1133
• Case Details – Case Properties, page 1138
• Case Details – Response Information, page 1137
• Add comments to a case, page 1139
• Case Details – History, page 1140
On the page, you can view and edit the following case details:
• Title – The case name.
• Description – The case's short summary.
• Status – The current case status (Open, On Hold, Closed).
• Priority – The current case priority that appears as a link, for example, 4 – Medium.
• Assigned to – The workgroup member to whom the case is currently assigned.
• Contact Information – The information about the contact person.

Contact Information
In the Contact Information section, the information about the contact person is displayed. The contact 
information is defined while creating the case. For more information, see Creating new cases, page 1107.

 If the contact information includes the email address, the address appears as a link in the 
Contact Information section. You can send an email message to a contact person by clicking 
the email link. For details, see Send an email message for cases, page 1132.
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The contact information appears as the links in the Contact Information section. You can edit the 
contact information by clicking the corresponding link. By default, each link is set to Not Set if it was not 
edited during the case creation. When you click the link, the text field appears instead of the link, where 
you can enter the contact information. When you click the Email link, the auto-completion text field 
appears.
You can also edit the contact information for the closed case.

 You cannot edit the contact information if the contact is a panelist.

Additionally, if multiple cases are assigned to a single user, they appear as the links under Other Open 
Cases in the Contact Information section. You can view the other cases by clicking the corresponding 
link. When you click the View All link, the Cases page opens displaying all cases assigned to the selected 
user. A notification describing the current filter appears above the Cases grid.

Edit the case details

Procedure 
1 On the Cases tab, click the case name or number in the grid. 
2 On the case details page, click the case title field. 

The case title field becomes editable.
3 Edit the case title.
4 Press Enter to save your changes.
5 Click the case description field. 
6 In the Case Description dialog box, enter the case description text. You can customize the text by 

using the editing toolbar, which provides additional editing options.
7 In the Notify Users text field, enter the names of the persons to receive a notification that the case is 

edited. When there are more than 50 members in a workgroup, the Notify Users option appears as 
an auto-completion text box.

8 To apply changes, click Save.
9 Click the current case priority that appears as a link, for example, 4 – Medium. 
10 In the Priority list, click the necessary option, and click Save. 

The following priority options are available:
• 1 – Critical
• 2 – Very High
• 3 – High
• 4 – Medium
• 5 – Low
• 6 – Very Low
• 7 – Negligible

11 In the Assigned to field, click the link, and in the Assign Case dialog box, select the assignee.
12 In the Contact Information section, fill out the following fields:

• Email
• First Name
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• Last Name
• Contact's Business
• Phone
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Assign or reassign a case to a user 
Navigation

Cases tab > click the case title or the case number > case details page > More Actions button.

You can assign cases to the workgroup members. Also you can change the case owner and add 
comments while changing the assignment. If needed, you can delete a user.

Procedure 
1 On the Cases tab, click the case name or number in the grid. 
2 On the case details page, click the More Actions button > Assign option. 
3 In the Assign dialog box, in the Assign Case to User list, select the workgroup member to whom 

you want to assign the case. When there are more than 50 members in a workgroup, the Assign 
Case to User option appears as an auto-completion text box.

 If the user is out of office the case is assigned to their chosen case proxy who works on all cases 
while the user is out of office. The case can be assigned to the original user on their return.

4 In the Notify Users text field, enter the names of the persons to receive a notification about the new 
case assignment. When there are more than 50 members in a workgroup, the  Notify Users option 
appears as an auto-completion text box.

5 Enter the comments while changing the assignment.
You can customize the comment text by using the editing toolbar, which provides additional editing 
options.

6 Click Assign. 
If the user you assigned the case to is out of office, a message is displayed to inform you that the case 
will be assigned to a proxy instead of the intended user.
Click OK.
The case is assigned to the selected user, and the Cases page opens. The added comment appears on 
the case details page under description.

 You can reassign a case to other users in the workgroup if it is a case trigger and you have the 
Reassign Cases permission enabled.
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Case Assignment notification
Navigation

Account menu  > My Account option > Case Management tab > Emails section.

You can receive email notifications when a new case is assigned to you either by another user or based on 
trigger criteria.
To activate this option, go to the Case Management tab > Emails section > select the Receive 
notification emails when Cases are assigned to you. check box.
This option is active by default. When a new case is created by the trigger that is not set for sending an 
email message, you will not receive the case assignment notification.
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Send an email message for cases
Navigation

Cases tab > click the case title or the case number > case details page > Email button.

You can send an email to the customer from within the application. You can customize the email text by 
using the editing toolbar.

Procedure 
1 Go to the Cases tab > click the case name or number.
2 On the case details page toolbar, click the Email button. 
3 In the Email dialog box, in the From list, select an email address from which you want to send your 

invitation. 
By default, your current email address appears in the From text box.

4 In the To field, enter the recipient's email address. 
By default, the contact person's email address appears in the To field. You can add multiple recipients 
by entering any valid email addresses separated by commas.

5 In the Notify Users text field, enter the names of the persons to receive a notification that a new 
email message is sent.
When there are more than 50 members in a workgroup, the Notify Users option appears as an auto-
completion text box.

6 In the Subject field, enter the subject of your email message. 
The default subject is the case name and number, for example, Case 16: Property Case.

7 Type your email text. 
You can customize the text by using the editing toolbar, which provides additional editing options.

8 Click Send. 
Your email is sent to the selected users.

9 Click Close.
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Put on hold or resume a case
Navigation

Cases tab > click the case title or the case number > case details page > Status list > On Hold  option.

You can put a case on hold or make a case active to reflect the interaction with the customer better. 
You can set the case status to On Hold when you are waiting for information from a customer, for 
example, and time calculations will be paused.  You can add comments while putting the case on hold and 
customize the comment text by using the editing toolbar.
When the case status is On Hold, the  Resume button appears. You can use the Resume button to 
reactivate the case and time calculations will be resumed.

 You can put cases on hold only if you have permissions to edit the cases.

Put the case on hold

Procedure 
1 Go to the Cases tab > click the case name or number.
2 On the case details page, in the Status list, click the On Hold option. 

 If the property is marked as required, you cannot put the case on hold until you provide a value 
for the property.

3 In the Put Case On Hold dialog box, in the Notify Users text field, enter the names of the persons 
to receive a notification that the case is put on hold. 
When there are more than 50 members in a workgroup, the Notify Users option appears as an 
autocompletion text box.

4 Enter the reason for putting the case on hold. 
You can customize the text by using the editing toolbar, which provides additional editing options.

5 Click Hold. 
The case status updates immediately.

Resume the Case

Procedure 
1 Go to the Cases tab > click the case name or number.
2 On the case details page toolbar, click the Resume button. 
3 In the Resume Case dialog box, in the Notify Users text field, enter the names of the persons to 

receive a notification that the case is resumed. 
When there are more than 50 members in a workgroup, the Notify Users option appears as an 
autocompletion text box.



Case Management Overview Put on hold or resume a case

EFM User Guide 1134

Confidential and Proprietary Information of Verint Systems Inc.

4 Enter your comments. 
You can customize the comment text by using the editing toolbar, which provides additional editing 
options.

5 Click Resume. 
The case status updates immediately.
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Close or reopen a case
Navigation

Cases tab > click the case title or the case number > case details page > Close/Reopen button.

You can close or reopen the case to reflect the interaction with the customer better.  You can add 
comments while closing the case and customize the comment text by using the editing toolbar.
When the case is closed, the Close button is displayed as Reopen. You can use the Reopen button to 
reopen the case and add comments if needed.

Close a case

Procedure 
1 Go to the Cases tab, click the case name or number.
2 On the case details page, click the Close button. 

 If the property is marked as required, you cannot close the case  until you provide a value for the 
property.

3 In the Close Case dialog box, in the Notify Users text field, enter the names of the persons to 
receive a notification that the case is closed. 
When there are more than 50 members in a workgroup, the Notify Users option appears as an 
autocompletion text box.

4 Enter the reason for closing the case. 
You can customize the text by using the editing toolbar, which provides additional editing options.

5 If the selected case is a duplicate, select the Is this a duplicate of a different case check box and 
provide the primary case number in the text field next to it. 
The text field is active only when the check box is selected.

6 Click Close. 
The case status updates immediately.

 When the case is closed as a duplicate, its status is Closed as Duplicate of # with a number of 
the primary case displayed as a hyperlink. The case name appears in the tooltip when you hover 
over the hyperlink. You can use the hyperlink to access the primary case.

Reopen a case

Procedure 
1 Go to the Cases tab, click the case name or number.
2 On the case details page, click the Reopen button. 
3 In the Notify Users text field, enter the names of the persons to receive a notification that the case is 

reopened. 
When there are more than 50 members in a workgroup, the Notify Users option appears as an 
autocompletion text box.
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4 Enter the reason for reopening the case. 
You can customize the text by using the editing toolbar, which provides additional editing options.

5 Click Reopen. 
The case becomes assigned to you.
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Case Details – Response Information
Navigation

Cases tab > click the case title or the case number > case details page > Response Information tab.

You can see the information about responses from your participants. If the case is created by a case 
trigger, the Response Information section appears on the case details page. In this section,  if the case is 
created by a survey or file import trigger, the source survey name or file import name and the record ID 
used for the case trigger are available. For comments and Text Analytics cases, the Campaign Name, 
Campaign Type, and Status information is not shown.

 The Response Information tab appears only if you create a case trigger. For more information 
about case triggers, see Case triggers, page 1123.

The following information is displayed on the page:
• Record ID – Displays the unique ID number of a response.
• Campaign Name – Displays  the name of a campaign.
• Campaign Type – Displays  the name of a distribution type.
• Show completed only – Select the check box to show only completed responses.
• Hide hidden questions – Select the check box to hide questions with visibility set to Hidden.
• Wrap text - Select the check box to resize and display the full contents of the Question Text and 

Response rows.
• Export Responses to PDF – Click the link to export responses in the PDF format.
• Question Text – Displays  the text of the question.
• Response – Displays  the response to the question.
• Status – Displays  the status of the question.  
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Case Details – Case Properties
Navigation

Cases tab > click the case title or the case number > case details page > Case Properties tab.

Case properties are additional values that can be set by a user to describe, categorize, and report on cases. 
The case properties appear in the set order on the Case Details page > Case Properties tab after you 
create them on the Case Setup page. To set a value for the property, click the drop-down list under the 
corresponding property, and then type the needed text in the box or select the required choice from the  
list. The Not Set value is available for all case properties that are not set as required.

If you make the property required on the Case Setup page, and select the Select an Option value for a 
property, you will not be able to open, put on hold, or close the case depending on the status that you 
selected in the Status For Required list.

 The case properties are available only if specified on the Configuration tab > Case Setup tab.
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Add comments to a case
Navigation

Cases tab > click the case title or the case number > case details page > Comments tab.

You can view  and add comments to the case which allows you to  better segment data associated with the 
case.

Procedure 
1 On the Cases tab, click the case name or the number in the grid.
2 On the case details page, on the Comments tab, click the Add Comment button.
3 In the Add Comment dialog box, in the Notify Users text field, enter the name of the person to 

receive a notification that a new comment is added to the case. When there are more than 50 
members in a workgroup, the Notify Users option appears as an auto-completion text box.

4 Enter the comment text.
You can customize the comment text by using the editing toolbar, which provides additional editing 
options.

5 Click Add.
The added comment appears on the case details page under description.
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Case Details – History
Navigation

Cases tab > click the case title or the case number > case details page > History tab.

You can view particular details about the case including the actions performed on it. It allows you to better 
segment the data associated with the case and you can  always find the historical information about the 
needed case.
All actions that were performed on the case appear in an ordered list with the most recent action at the 
top. Each action type has its own indicator. The indicators appear in different color to the left of each 
event for better identification. This way you can view the history of changes and current status of a case. 
For more information about the indicators, see List of Case Indicators, page 1141.
The following actions are displayed on the History tab:
• Opened by
• Closed by
• Closed as Duplicate
• Resumed by
• Placed on hold by
• Priority changed to
• Assigned to
• Description edited by
• Changed contact information
• Changed case property
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List of Case Indicators
The list of indicators used on the Cases tab.

List of Case Indicators

The Open icon notifies that the case is opened, reopened, or resumed.

The Edit icon notifies that comments are added or the case name, 
description, priority, or custom property is changed.

The Email Sent icon on the case details page.

The Assigned to icon on the case details page.

The Placed On Hold icon on the case details page.

The Closed icon on the case details page.

The Last Updated icon  appears next to the cases which have not been 
updated in over 7 days.

The Unassigned icon appears next to the currently unassigned cases.

The Newly Assigned icon appears next to the cases that have been 
recently assigned to you.
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Case Management reporting overview
Navigation

Report & Analyze tab > Case Reports tab.

You can  view the general and detailed information on case management within the workgroup, such as 
statuses, priorities, comments, reassigns, and emails. 
The following report types are available:
• Case Summaries, page 1143
• Case Averages, page 1149
• Case Priorities, page 1152
• Case Event Breakdown, page 1155

 The Case Reports page is available if the Case Management permissions are enabled for your 
user role.
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Case Summaries
Navigation

Report & Analyze tab > Case Reports tab > Case Summaries option.

You can view general information about your cases and filter the cases by status, user name, contact 
person data, and custom properties. In addition, you can export the existing cases data into the .CSV, 
.TSV, and Microsoft Excel file formats.
In the Case Summaries grid, the following columns are available:
• Contact's Business – The column content depends on the option selected from the 

Segmented by list above the grid. The Contact's Business is the default option.

 All cases without a contact's business or email are grouped in the Unknown row. When the User 
option is selected in the Segmented by list, the Unassigned row is displayed instead of 
Unknown, showing all unassigned cases.

• Cases Opened – The number of opened cases.
• Cases On Hold – The number of cases on hold.
• Cases Closed – The number of closed cases.
• Total Cases – The total number of cases.
At the bottom of the grid, the Totals row appears that totals all values in the corresponding columns.
You can click the column header in the table to sort the results based on the selected column. A sort icon 
indicates which column is used for sorting. At the bottom of the page, a toolbar enables you to adjust the 
number of items that displays on one page. You can adjust the number of items that appears on one 
page. The default number of items per page is 10. However, you can select up to 100 items to appear on 
one page. You can also navigate through the pages of items by clicking the scroll arrows at the bottom of 
the dialog box.
You can select the type of data that the case report is filtered by in the Segmented by list. The following 
options are available:
• Core Properties

• Contact's Business
• Contact's Email
• User

• Source
• Surveys

• Custom Properties
In this subsection, the available custom properties are displayed. For details on the cases custom 
properties, see Case Management – Notify users, page 1122.
You can also define which cases to display on the Case Summaries page by using the Displaying list. 
The following options are available:
• Cases Opened – Displaying all cases, regardless of their current status.
• Cases Closed – Displaying all cases with the Closed status.
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 When you select another option in the Segmented by or Displaying list, the case report is 
regenerated immediately.

The Case Summaries report settings are saved within one session.

Case Report Filtering
You can apply the data filters to the case summaries to view the data that represents a certain value in 
the report. When you click the value in the Case Summaries grid,  the results according to the applied 
custom filter are availbale on the Cases page. The custom filter criteria is based on the selected value. A 
notification describing the current filter appears above the Cases grid.
You can also filter the case summaries to view the information for a specific time period by using the date 
filter  menu. You can apply the following date filters:
• Date Range – Define a date range to filter the information in the Case Summaries grid. The 

following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself.  Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.

 For more information about filters, see Case Filters, page 1109 and Case Quick Filters, page 1113.
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Export the Case Report

Procedure 
1 On the Case Summaries page, click the Export menu on the toolbar.
2 On the Export menu, select the output format. 
3 In the Export Case Report dialog box, your file is generated in the selected format.
4 Click the link that appears to open or save the exported file. The file contains all data displayed in the 

grid at the moment of export regardless of the viewed page. If you apply the filter to the grid, only the 
filtered data is exported.

5 Click Close.
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Case Summary Pareto Chart
Navigation

Report & Analyze tab > Case Reports tab > Case Summary Pareto Chart option.

You can view the case counts by core or custom properties in a Pareto chart. The Pareto chart is a type of 
chart that contains both bars and a line graph, where individual values are represented in descending order 
by bars, and the cumulative total is represented by the line. By looking at the bars and line, you can quickly 
determine, which cases make up 80% of your activity.

Case Summary Pareto Chart 

The following charts are displayed in the Case Summary Pareto Chart:
• Total Cases – The number of cases according to the option selected in the Segmented by list 

above the chart against the total number of cases. The individual column appears for each option. 
The Contact's Business is the default option. The columns are arranged in a descending order 
from left to right. The chart may include up to 12 columns.

• Cumulative Percentage – The cumulative percentage of cases according to the option selected 
in the Segmented by list above the chart against the total percentage of valid cases. The 
cumulative percentage shows when you hover over the chart. 
The cumulative percentage is calculated in the following way:
cumulative percentage = (cumulative frequency/total number of valid cases) x 100
The example below describes the cumulative percentage calculation for the Pareto chart that 
includes three Total Cases columns:
A = number of cases in the first column
B = number of cases in the second column
C = number of cases in the third column
T = total number of cases
X = the first point on the cumulative percentage chart
Y = the second point of the cumulative percentage chart
Z = the third point of the cumulative percentage chart
The first point of the cumulative percentage chart is calculated as:
A / T * 100 = X
The second point of the cumulative percentage chart is calculated as:
(A + B) / T * 100 = Y



Case Management Overview Case Summary Pareto Chart

EFM User Guide 1147

Confidential and Proprietary Information of Verint Systems Inc.

The third point of the cumulative percentage chart is calculated as:
(A + B + C) / T * 100 = Z

You can click the label on the legend to show or hide the corresponding displayed value.
You can select the type of data that the case report is filtered by in the Segmented by list. The following 
options are available:
• Core Properties

• Contact's Business
• Contact's Email
• User

• Source
• Surveys

• Custom Properties
In this subsection, the available custom properties are displayed. For details on the cases custom 
properties, see Case Management – Notify users, page 1122.

You can also define which cases to display on the Case Summary Pareto Chart page by using the 
Displaying list. The following options are available:
• Cases Opened – Displaying all cases, regardless of their current status.
• Cases Closed – Displaying all cases with the Closed status.
The Case Summary Pareto Chart report settings are saved within one session.

Case Report Filtering
When you click the chart value, the Cases page opens displaying the results according to the applied 
custom filter. The custom filter criteria is based on the selected value. A notification describing the current 
filter appears above the Cases grid.
You can also filter the Case Summary Pareto Chart to view the information for a specific time period 
by using the date filter menu. You can apply the following date filters:
• Date Range – Define a date range to filter the information in the Case Summary Pareto Chart 

report. The following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Week – Shows the data for the current week, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
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• Last Week – Shows the data for the past week.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar  icon.
• Apply – Save the selected changes.
• Cancel – Remove the changes.

 For more information about filters, see Case Filters, page 1109 and Case Quick Filters, page 1113.

Export the Case Report

Procedure 
1 On the Case Summary Pareto Chart page, click the Export menu on the toolbar.
2 On the Export menu, select the output format. 
3 In the Export Case Report dialog box, your file is generated in the selected format.
4 Click the link that appears to open or save the exported file. 

The file contains all data displayed in the grid at the moment of export regardless of the viewed page.
5 If you apply the filter to the grid, only the filtered data is exported.
6 Click Close.
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Case Averages
Navigation

Report & Analyze tab > Case Reports tab > Case Averages option.

You can view how your workforce is handling the cases on  average. In addition, you can export the 
existing cases data into the .CSV, .TSV, and Microsoft Excel file formats.
In the Case Averages grid, the following  columns are available:
• Contact's Business – The column content depends on the option selected in the Segmented 

by list above the grid.
The Contact's Business is the default option.

 All cases without a contact's business or email are grouped in the Unknown row. When the User 
option is selected in the Segmented by  list, the Unassigned row is displayed instead of 
Unknown, showing all unassigned cases.

• Average Open Time – The average open time of the cases regardless of their current status.
• Average Hold Time – The average hold time of the cases regardless of their current status.
• Average Resolution Time – The average open time of the currently closed cases.
• Average Total Case Time – The average open plus hold time of the cases regardless of their 

current status.
At the bottom of the grid, the Workgroup Averages row appears that totals all values in the 
corresponding columns.
You can click the column header in the table to sort the results based on the selected column. A sort icon 
indicates which column is used for sorting. At the bottom of the page, on the toolbar, you can adjust the 
number of items that are displayed on one page. You can adjust the number of items that appears on 
one page. The default number of items per page is 10. However, you can select up to 100 items to appear 
on one page. You can also navigate through the pages of items by clicking the scroll arrows at the bottom 
of the dialog box.
You can select the type of data that the case averages report is filtered by in the Segmented by  list. The 
following options are available:
• Core Properties

• Contact's Business
• Contact's Email
• User

• Source
• Surveys

• Custom Properties
In this subsection, the available custom properties are displayed. For details on the cases custom 
properties, see Case Management – Notify users, page 1122.
You can also define which cases to display on the Case Averages page by using the Displaying list. The 
following options are available:
• Cases Opened – Displaying all cases, regardless of their current status.
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• Cases Closed – Displaying all cases with the Closed status.

 When you select another option in the Segmented by or Displaying list, the case report is 
regenerated immediately.

Case Report Filtering
You can apply the data filters to the case averages to view the data that represents a certain value in the 
report. When you click the value in the first column of the Case Averages grid, the Cases page opens 
displaying the results according to the applied custom filter. The custom filter criteria is based on the 
selected value. A notification describing the current filter appears above the Cases grid.
You can also filter the case averages to view the information for a specific time period by using the date 
filter menu. You can apply the following date filters:
• Date Range – Define a date range to filter the information in the Case Averages grid. The 

following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.

 For more information about filters, see Case Filters, page 1109 and Case Quick Filters, page 1113.
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Export the Case Report

Procedure 
1 On the Case Averages page, click the Export menu on the toolbar.
2 On the Export menu, select the output format. 
3 In the Export Case Report dialog box, your file is generated in the selected format.
4 Click the link that appears to open or save the exported file. The file contains all data displayed in the 

grid at the moment of export regardless of the viewed page. If you apply the filter to the grid, only the 
filtered data is exported.

5 Click Close.
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Case Priorities
Navigation

Report & Analyze tab > Case Reports tab > Case Priorities option.

You can view what kind of cases is being created. In addition, you can export the existing cases data into 
the .CSV, .TSV, and Microsoft Excel file formats.
In the Case Priorities grid, the following columns are available:
• Contact's Business – The column content depends on the option selected in the Segmented 

by list above the grid. 
The Contact's Business is the default option.

 All cases without a contact's business or email are grouped in the Unknown row.   When the User 
option is selected in the Segmented by list, the Unassigned row is displayed instead of 
Unknown, showing all unassigned cases.

• Critical – The cases with the Critical priority.
• Very High – The cases with the Very High priority.
• High – The cases with the High priority.
• Medium – The cases with the Medium priority.
• Low – The cases with the Low priority.
• Very Low – The cases with the Very Low priority.
• Negligible – The cases with the Negligible priority.
• Totals – The total number of cases according to the option selected in theSegmented by list.
At the bottom of the grid, the Totals row appears that totals all values in the corresponding columns.
You can click the column header in the table to sort the results based on the selected column. A sort icon 
indicates which column is used for sorting. At the bottom of the page, a toolbar enables you to adjust the 
number of items that displays on one page. You can adjust the number of items that appears on one 
page. The default number of items per page is 10. However, you can select up to 100 items to appear on 
one page. You can also navigate through the pages of items by clicking the scroll arrows at the bottom of 
the dialog box.
You can select the type of data that the case priorities report is filtered by in the Segmented by list. The 
following options are available:
• Core Properties

• Contact's Business
• Contact's Email
• User

• Source
• Surveys

• Custom Properties
In this subsection, the available custom properties are displayed. For details on the cases custom 
properties, see Case Management – Notify users, page 1122.
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You can also define which cases to display on the Case Priorities page by using the Displaying list. The 
following options are available:
• Cases Opened – Displaying all cases, regardless of their current status.
• Cases Closed – Displaying all cases with the Closed status.

 When you select another option in the Segmented by or Displaying list, the case report is 
regenerated immediately.

Case Report Filtering
You can apply the data filters to the case priorities to view the data that represents a certain value in the 
report. When you click the value in the Case Priorities grid, the Cases page opens displaying the results 
according to the applied custom filter. The custom filter criteria is based on the selected value. For 
example, if you click the specific segmented value, the filter will be All cases assigned the specific 
segmented value. A notification describing the current filter appears above the Cases grid.
You can also filter the case priorities to view the information for a specific time period by using the date 
filter menu. You can apply the following date filters:
• Date Range – Define a date range to filter the information in the Case Priorities grid. The 

following options are available:
• None – Applies no date filter.
• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 

end date of your custom filter in the corresponding text boxes.
• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.
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 For more information about filters, see Case Filters, page 1109 and Case Quick Filters, page 1113.

Export the Case Report

Procedure 
1 On the Case Priorities page, click the Export menu on the toolbar.
2 On the Export menu, select the output format. 
3 In the Export Case Report dialog box, your file is generated in the selected format.
4 Click the link that appears to open or save the exported file. The file contains all data displayed in the 

grid at the moment of export regardless of the viewed page. If you apply the filter to the grid, only the 
filtered data is exported.

5 Click Close.
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Case Event Breakdown
Navigation

Report & Analyze tab > Case Reports tab > Case Event Breakdown option.

You can view information about all events that have been performed on the cases, such as adding 
comments, sending email messages, reassigns, and changing statuses. In addition, you can export the 
existing cases data into the .CSV, .TSV, and Microsoft Excel file formats.
In the Case Event Breakdown grid, the following columnsare available:
• User – The user who has performed an event on the case. Only users who have performed any 

action on the cases appear in the grid.
• Cases Opened – The number of cases opened by the corresponding user.
• Cases On Hold – The number of cases put on hold by the corresponding user.
• Cases Closed – The number of cases closed by the corresponding user.
• Cases Reassigned – The number of cases reassigned by the corresponding user.
• Cases Edited – The number of cases edited by the corresponding user.
• Comments Added – The number of comments added by the corresponding user.
• Emails Sent – The number of email messages sent by the corresponding user.
At the bottom of the grid, the Totals row appears that totals all values in the corresponding columns.
You can click the column header in the table to sort the results based on the selected column. A sort icon 
indicates which column is used for sorting. At the bottom of the page, a toolbar enables you to adjust the 
number of items that displays on one page. You can adjust the number of items that appears on one 
page. The default number of items per page is 10. However, you can select up to 100 items to appear on 
one page. You can also navigate through the pages of items by clicking the scroll arrows at the bottom of 
the dialog box.
You can define which cases to display on the Case Event Breakdown page by using the Displaying list. 
The following options are available:
• Cases Opened – Displaying all cases, regardless of their current status.
• Cases Closed – Displaying all cases with the Closed status.

 When you select another option in the Segmented by or Displaying list, the case report is 
regenerated immediately.

Case Report Filtering

 You cannot filter the Case Event Breakdown report data by clicking the value in the grid.

You can filter the case event breakdown to view the information for a specific time period by using the 
date filter menu. You can apply the following date filters:
• Date Range – Define a date range to filter the informationin the Case Event Breakdown grid. 

The following options are available:
• None – Applies no date filter.
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• Custom – Shows the data for the date range that you create by yourself. Enter the start date and 
end date of your custom filter in the corresponding text boxes.

• Today – Shows the data for today.
• Current Month – Shows the data for the current month, no matter the current date.
• Current Quarter – Shows the data for the current three months, no matter the current date.
• Current Year – Shows the data for the current calendar year, no matter the current date.
• Year to Date – Shows the data for the period starting January 1st of the current year up until the 

current date.
• Last Week – Shows the data for the past week.
• Last Month – Shows the data for the past month.
• Last Quarter – Shows the data for the past three months.
• Last Year – Shows the data for the past year.
• Last 30 Days – Shows the data for the past 30 days.
• Last 90 Days – Shows the data for the past 90 days.
• Last 180 Days – Shows the data for the past 180 days and is selected by default.

• Start Date – Enter the start date in the text box manually or by using the calendar icon .

• End Date – Enter the end date in the text box manually or by using the calendar icon .
• Apply – Save the selected changes.
• Cancel – Remove the changes.

 For more information about filters, see Case Filters, page 1109 and Case Quick Filters, page 1113.

Export the Case Report

Procedure 
1 On the Case Event Breakdown page, click the Export menu on the toolbar.
2 On the Export menu, select the output format. 
3 In the Export Case Report dialog box, your file is generated in the selected format.
4 Click the link that appears to open or save the exported file. The file contains all data displayed in the 

grid at the moment of export regardless of the viewed page. If you apply the filter to the grid, only the 
filtered data is exported.

5 Click Close.
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Case Reports Scheduled Delivery
Navigation

Report & Analyze tab > Case Reports tab > select any report type > click the Scheduled Report 
Delivery button  on the selected report toolbar.

You can schedule reports to be delivered regularly to certain users so that they can track case metrics. On 
the Schedule Report Delivery page, you can create the email message, add recipients, select the file 
format, and schedule the delivery.
The report contains data available at the page at the moment when the email message is scheduled for 
delivery. If there is an organization hierarchy defined for a workgroup, the report data is scoped to the 
recipient’s organization access. For external emails, the data is scoped according to the task creator’s 
organization access.

Schedule the Case Report Delivery

Procedure 
1 Go to the Case Reports tab > select any report type. For example, Case Summaries.
2 On the Case Summaries page toolbar, click the Scheduled Report Delivery button. 
3 On the Schedule Report Delivery page , in the Select Format list, select the report format. For the 

Case Summaries, Case Averages, Case Priorities, and Case Event Breakdown reports, the 
following formats are available:
• .CSV
• .TSV
• .XLSX
For the Case Summary Pareto Chart report, the following formats are available:
• .PDF
• .DOCX
• .PPTX
If you want to zip the attachment, click the Zip attachments check box, and the report in the 
selected format is attached to the email message in a ZIP archive.

4 In the To text box, enter the email address of the recipient. 
You can add multiple addresses separating them by commas or semicolons. You can click the To 
button to select the recipients within the hierarchy if there is an organization hierarchy defined for a 
workgroup.

5 In the Case Report Recipients dialog box, select a check box next to the user or organization, click 
the right arrow button to add them to the Recipients list, and then click OK.

6 In the From text box, specify the email address from which you want to send your message. 
By default, your email address is selected.

7 In the Subject text box, type the message subject.
8 In the email body, type the message text and customize it by using the editing toolbar.
9 To preview your message, click the Preview button.
10 To test your message before delivering it to the recipient, click the Send Test Email button. 
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11 Type the test email address in the Email Address field, and then click the Send button.
In the Delivery Schedule section, define the report delivery schedule and the recurrence options. 
The following options are available:
• No Scheduling – Use this option to send your message later. You may want to select it if you 

have not finished adding recipients, writing your message, or have not yet decided when to send 
the message. This option removes scheduling.

• Send Now – Use this option to send your message immediately. There may be a delay of several 
minutes before your email is delivered to participants.

• Send at a specific date and time – Use this option to specify a date and time when you want 
to deliver your email. You can either type the date and time manually into the available text field 
or select the date and time from pop-up menus.

 To specify recurrence options for your message delivery, click the Show Recurrence Options 
link. Use this functionality to send a message multiple times on a daily, weekly, or monthly basis. 
You can also set an end date or select No End Date.

12 Click Save.

 When the Send Now option is selected in the Delivery Schedule section, the Send Report 
button is displayed instead of the Save button.
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File imports overview
Navigation

Data Sources tab > File Imports tab.

You can enrich your survey respondent data with additional information imported from external sources.
With file imports, you can synchronize data about your survey, comments, and profile respondents in the 
EFM application with the data from other systems. This way you get a wider range of information about 
your respondents without having to collect this data via survey, comments, and profile.

Data heading
If a file import has a Data Heading selected as Is Unique, then after the file import is published, an index 
is created for this field.

Data types
The following data types can be imported into file imports: 

• Text 
• Email Address 
• Date
• Numeric (Real Number)
• Set (Single Selection)
• Numeric (Whole Number)
• Essay
• Phone Number

 You cannot set the Essay and Set (Single Selection) data types as unique values.

The Set (Single Selection) data type represents the Choose One question and behaves as the Choose 
One question when used for reporting or filtering.
If you upload a file with the Phone Number data type, the system automatically detects the field type 
based on domestic or international phone patterns. You can set the Phone Number data type as unique 
value.

 You can use file imports with profiles.

Data channels
To use the imported data with your survey, comments, and profile you first need to map the file import 
to the survey, comments, and profile via data channel. This mapping is conducted with the help of the 
data field that contains unique information about the respondents. You should define the unique data 
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field for your file import before publishing. The type of the unique data field should match the type of 
the survey and comments Short Answer question.
When the respondent replies to your survey, comments, and profile with the response available in the file 
import unique field, all other information from the file import associated with this respondent becomes 
available in the Response Manager grid. This information can be used for reporting and filtering.
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File Imports page
Navigation

Data Sources tab > File Imports tab.

Use the File Imports page to create a new file import, view information about the existing file imports, 
open, rename, duplicate, and delete them. On the File Imports page, you can view the title, owner of 
your file import, dates when it was last published or modified, and whether the file import is used in the 
data channel.
You can also specify how many file imports to display per page by clicking the needed amount in the 
lower-left part of the File Imports page. By default, the file imports are sorted according to the date 
when they were last modified.

 You can change the column width on the File Imports page by dragging the needed column 
border.

On the Actions menu, the following options are available:
• New – Click to create a new file import.

 You can also create a new file import by clicking New on the toolbar.

• Rename – Click to rename the file import. To make this option available, select a check box next 
to the file import that you want to rename.

• Delete – Click to delete the existing file import. To make this option available, select a check box 
next to the file import that you want to delete.

• Push to Feedback Intelligence – Click to update the previously added file imports in Feedback 
Intelligence.

 Contact a System Administrator to add the file import to Feedback Intelligence. A System 
Administrator can also enable and disable the Push to Feedback Intelligence option for a 
certain file import.
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Create a file import
Navigation

Data Sources tab > File Imports tab > click New.

You can create a file import.

Procedure 
1 On the File Imports page, on the toolbar, click New.

 You can also click the Actions menu > New.

2 In the Name Your File Import dialog box, type the name of the file import, and then click OK.
The Connection page opens.

 If you want to return to the File Imports grid, click the Return to File Imports link.
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Managing a file import
Navigation

Data Sources tab > Speech Analytics tab > click an existing file import or create a new one by clicking 
New on the toolbar.

After creating a file import, use the following tabs to set up and manage your file import:
• Connection – Specify the file to import, select connection type, import method, and test all the 

settings. For more information, see Set scheduled file import , page 1167.
• Fields – Map the fields of the imported file to the correct data type and publish your file import. 

For more information, see Publish a file import, page 1169.
• Data – View, export, filter, and delete the data from your file import.

 To use the Data tab, you should first publish your file import.

• Values – Provide report labels, report values, and export values for the file import fields to use 
later for reporting, export, and view on the Response Manager page. Report labels specified for 
the Set (Single Selection) fields are displayed on the Data tab.

• Access – Control access of users and organizations to your file import. You can grant users full 
access or view access. For more information, see Check for new columns in a file import, 
page 1172.

• Data Channels – Map the imported data to survey or profile to add more attributes to the 
participant data and use the enriched data for reporting. For more information, see Map a file 
import to project or profile, page 1174.

• Triggers – Create triggers which occur upon the file scheduled import. For more information, see 
Create a file import trigger, page 1175.
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Add data to the file import
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Connection 
page.

You can add information to your survey by importing a file or several files. The data from the imported 
files are available for data channels.

 You can select the data update method in the file import. For more information, see Data update 
methods, page 1171.

Procedure 
1 On the Connection page, on the Connection type menu, select the File Upload Import option.
2 Click the Select button, and then choose the file to import.

 If you want to select another file, next to the file name, click Remove, and select the needed file.

3 Click the Upload button.

You can preview the data from the imported files on the Fields tab. You can also publish the file import 
with the data from the uploaded files. For more information about publishing a file import, see Publish a 
file import, page 1169.

When you import a file for the first time:
• If column value contains more than 255 characters, then the default data type is set to Essay.
• If column value contains all Numeric with a decimal place or a value that exceeds 2 billion, then 

the default data type is set to Numeric (Real Number).
• If column value contains all Numeric with no decimal place, then the default data type is set to 

Numeric (Whole Number).
• If column value contains valid date data type, then the default data type is set to Date.
• If column value contains valid email address data type, then the default data type is set to Email 

Address.
• If column value contains more than one different value repeated at least 2 times in the first 11 

items, then the default data type is set to Set (Single Selection).
• If column value contains valid phone number data type, then the default data type is set to 

Phone Number.
• If column value is empty or not specified, then the default data type is set to Text.
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Set file upload import 
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Connection 
page > File Upload Import connection type.

You can upload a file into the file import and define its import from the selected location. An uploaded file 
with its data are available for the data channels.
You can add only one file containing a single table into your file import. For the SQL database, the table 
can include 4,096 columns maximum and for the Oracle database –1,000 columns maximum.

 If you want to return to the File Imports grid, click the Return to File Imports link.

Procedure 
1 On the Connection page, on the Connection type menu, select the File Upload Import option.
2 To upload a file from a computer, click Select.
3 In the File Name text box, select a file that you want to import, and then click Open.

 The following file formats are valid: .csv, .tsv, .xlsx, .txt, .zip.

4 When file is processed, click Upload.
The file is uploaded immediately. You can view the number of records imported, number of records 
failed, and list any errors which occurred in the dialog box.

5 Go to the Fields tab, and then click Publish.
On the Data tab, data from the uploaded file import appears in the Data grid.

6 If you update a previously uploaded file import, go to the Connection tab, follow Steps 1-3 to upload 
the updated file again, and then click Upload.
The file is uploaded immediately. You can view the number of new records imported, number of 
records failed, and list of any errors that occurred in the dialog box.

If there is no new column added to the uploaded file import, you can view the current progress in 
percent, bytes processed, and total processed data in the dialog box.

 If task takes longer, then Email confirmation is required for processes exceeding setting, 
the task continues to run in the background. You can close this window to continue working. 
A status email is sent to you when the task completes. 

If there is a new column added to the uploaded file import, go to the Fields tab, and then click Publish.
You can use the File Upload Import method to upload multiple files and use append or upsert update 
methods to add more data to the file import (the procedure is similar to how data is appended or 
upserted for the scheduled file import).
You can use multiple connection types to upload data into a file import. For example, you can start with a 
scheduled upload for the initial data, and then change to file upload for subsequent data or vice versa.
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Set scheduled file import 
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Connection 
page > Schedule File Import connection type.

On the Connection page, you can specify the file to import, schedule its import from the selected location, 
and test all the settings.
You can add only one file containing a single table into your file import. For the SQL database, the table 
can include 4,096 columns maximum and for the Oracle database –1,000 columns maximum.

 If you want to return to the File Imports grid, click the Return to File Imports link.

Procedure 
1 On the Connection page, on the Connection type menu, select the Schedule File Import option.
2 On the Import Method menu, select the file location:

• EFM Folder - if your file is saved in the EFM folder. The path to the EFM folder is the following: 
{EFM install}AppData\{groupID}\import\{projectID}.

 You should be granted access to the EFM folder or ask your system administrator to place the 
needed file there.

If selected, type the name of the file you want to import in the File Name box.

 The following file formats are valid: .csv, .tsv, .xlsx, .txt, .zip.

• SFTP – SSH File Transfer Protocol – If your file is saved locally. If selected, specify:
- Server name – Name of the server where your file is located.
- Port – Port number for the specified server.
- Path – Path to your file.
- File name – Name of the file to import.
- User Name – Your user name for the specified server.
- Password – Your password for the specified server.

3 Click Recurrence to specify:
• Start date of automatic data import from the external file.
• Recurrence of automatic data import from the external file.
• End date of automatic data import from the external file.

 You can check the status of the data import on the Tasks tab of the Administration tab. You 
can also view the details of the data import task by clicking the corresponding event in the grid.

4 Click Save Setup.
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After saving connection setup, file import fields are automatically evaluated and mapped to the 
corresponding data types (text, email address, date, numeric (real/whole number), set (single 
selection), essay, or phone number) according to the following rules:
• If 100% of data in the field is composed of email addresses, the field type is marked as Email 

Address.
• If 100% of data in the field is composed of dates, the field type is marked as Date.
• If there are certain text data points that repeat in the field, the field type is marked as Set (Single 

Selection). In other words, if there is more than one text value repeating in less than 11 records, 
the field is Set (Single Selection).

• If 100% of data in the field is composed of numbers, the field type is marked as Numeric (Real 
Number).

• If a numeric field looks like numeric with no decimal place, the field type is still marked as 
Numeric (Whole Number).

• If 100% of data in the field is composed of telephone number, the field type is marked as Phone 
Number. 

• If a field is not specified, the field type is marked as Text. 

 The numeric data type is represented as a floating point number, and its precision is restricted to 
15 digits.

5 To test the connection settings, click Test Settings.
When the connection is set, you can publish your file import on the Publish tab (see Publish a file import, 
page 1169).
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Publish a file import
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Fields tab.

You can verify the mapping of the imported data fields to the corresponding data types is correct. Make 
the relevant updates and publish your file import. You can also preview the file import fields in the 
Sample Data grid.

 By default, the first row of the imported file is used for data headings. To use the first row as 
data, clear the Use First row for data headings check box in the Options section, and then 
provide your own data headings in the Columns grid.

Procedure 
1 In the Columns grid, in the Data Heading column, verify that your data headings are correct and 

change if needed. 
2 To edit the data heading, in the Columns grid, click the Data Heading column. 

If the Use first row of file for data headings check box is cleared, the default data headings are 
Field1, Field2, and so on. 
To save your edits, click outside the text box.

 You can edit data headings only before publishing your file import. After you publish a file 
import, the Data Heading text boxes become unavailable.

3 In the Columns grid, in the Data Type column, verify the data fields mapping and change it if 
needed.

4 To define the unique field for your file import, click the corresponding option button in the Is Unique 
column.
Unique field is used to map file import data to a survey and is required to be defined.

 The Mobile Number field is compatible with the Phone Number data type. You can set a field 
with the Phone Number data type as a unique value.

 Make sure that the mapping done in steps 1 and 2 is correct. After publishing the file import, you 
cannot change the mapping.

5 Click Publish.
After you click Publish, the file import is automatically validated for errors.

6 In the Publish Your File Import Now dialog box, view the details of the file import, and then click 
Publish if there are no errors or Cancel if errors are detected.
• If 500 or more errors are detected during file import, no rows from your file are imported. 
• If less than 500 errors are detected, only the rows with no errors are imported.

7 To check for new columns in your imported file, in the Options section, select the Check for new 
columns in the File Import check box. For more information, see Check for new columns in a file 
import, page 1172.
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8 In the Data Update Method list, select the way to update data in the file import. For more 
information, see Data update methods, page 1171.

 After you publish the file import, the uploaded file is deleted from the EFM folder within the next 
24 hours.

Now, you can use your file import to enrich the existing surveys or profiles with the help of data channels. 
For more information, see Map a file import to project or profile, page 1174.
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Data update methods
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Fields tab.

You can select the method to update data in the published file import.

 The file import update is performed automatically according to the file upload import or 
scheduled import settings specified on the Connection tab.

On the Data Update Method menu, you can click the following update methods:
• Append – Click to ignore data in the imported file when the unique identifier in the imported file 

matches the unique identifier in the file import. For example, in a file import with several imported 
columns, email is a unique identifier. When the file is imported according to the scheduled import, 
the data in columns for rows with matching unique identifiers is not updated. 

• Upsert – Click to update data in the file import when the unique identifier in the imported file 
matches the unique identifier in the file import. For example, in a file import with several imported 
columns, an email is a unique identifier. When the file is imported according to the scheduled 
import, data in columns for rows with matching unique identifiers is updated.

 If the unique identifier in the imported file does not match the unique identifier in the file import, 
a new row is added to the file import.
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Check for new columns in a file import
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Fields tab > 
Check for new columns in the file import check box.

With the Check for new columns in the file import check box selected, each time import is performed 
(according to the specified scheduled import settings), the application automatically checks if any new 
columns (fields) have been added to the imported file since last publish.
If there are no new columns added to the imported file, the file import is automatically published.
If there are one or more columns added to the imported file, you receive an email notification about this 
change asking you to publish the file import.
The new columns appear highlighted in the Columns grid on the Fields page and they are automatically 
mapped to the corresponding data types. You need to check the mapping, edit new data headings if 
needed, and then publish the file import.

 The updated file will not be imported until you click the Fields tab > Publish.

If the Check for new columns in the file import check box is cleared, all the new columns in the 
imported file are ignored.

 If there are new rows in the file, for the Append data update method, only the newly added 
columns are updated for new rows. For the Upsert data update method, all columns are 
updated for all rows in the file.
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Control access to a file import
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Access tab.

You can define the level of access that the users and organization units can have to your file import. 
The following options are available:
• Full Access – The users can edit the file import.
• View Access – The users can only view the file import and map it to their surveys or profiles for 

enrichment.

 If you want to return to the File Imports grid, click the Return to File Imports link.

Procedure 
1 On the File Imports page, click an existing file import or create a new one by clicking New.
2 On the Access tab, select the check boxes next to the users or organizations that you want to grant 

access to your file import.

 Only users that have at least View permission for file imports are shown on the Access page. For 
more information, see Roles, page 1378.

3 To move the selected user or organization to the Full Access or View Access box, click the 
corresponding right arrow button.

 All users assigned to the selected organization and all child organizations will be moved to the 
selected box on the right. You can move back the users or organizations that you do not want to 
share the file import access with by selecting the corresponding check boxes, and then clicking 
the left arrow button.

4 To send the email notification about the file import being published to the users granted access to the 
file import, select the Notify Users by Email check box.

 All users assigned to the selected organization will receive the email notification. Users can access 
the file import by clicking the link in the email message.
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Map a file import to project or profile
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Data Channels 
tab.

On the Data Channels tab, you can map the file import to a survey, comments, or profile via data channel 
to add more attributes to the participant data. After adding a file import to a survey or profile, you can use 
it to view its data in the Response Manager grid and to create report elements.
The survey, comments, or profile that you want to map to a file import needs to have at least one Short 
Answer question that matches the data type of the file import unique field.

Before you begin:
• Verify that your file import is published.
• Verify that your survey is open, data for comments is imported, and the profile is published.

Procedure 
1 On the Data Channels page:

• To map the file import to a project, click the Add Project link.
• To map the file import to a profile, click the Add Profile link.

2 In the Add Project or Add Profile dialog box correspondingly, select the needed project or profile, 
and then click Add.

3 On the Matching Project Question, Matching Profile Question, or Matching Comment Field 
menu, click the question that matches the specified data field. The selected question is used to 
identify the matching record in the file import and update the survey or profile data accordingly.

 If none of the survey or profile questions match the specified data field, the Matching Project 
Question, Matching Profile Question, and Matching Comment Field menus are 
unavailable.

4 To save the created data channel, click in the area out of the data channel. 
You cannot edit the data channel anymore.

 To delete the data channel, click the delete icon to the rightmost of the needed data channel. 
When deleting a data channel, any elements associated with this data channel (report elements, 
filters, Response Manager columns, and others) become unavailable.
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Create a file import trigger
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Triggers tab > 
Add Trigger button.

On the Triggers tab, you can create triggers, which occur upon the file scheduled import (see Set 
scheduled file import , page 1167). 
You can trigger the following actions:
• Create Case
• Add Participants to a Survey
• Update Profile Fields
The result of the trigger action depends on the selected data update method (see Data update methods, 
page 1171).

 To create triggers, first publish your file import.

Procedure 
1 On the Triggers tab, click the Add Trigger button.
2 In the Add Trigger dialog box, in the Description box, type the name for your trigger.
3 On the Trigger Action menu, click the action that you want to be triggered upon the defined criteria 

are met.
4 To define the trigger criteria, click the Criteria tab > Add Another Criteria link. 

You can define criteria based on the fields of the current file import only. You can define as many 
criteria as you need, and then combine them by using the criteria builder advanced options.

5 To proceed with the applied changes, go to the Fields tab, and click Publish.

 The file import records are checked against the defined criteria only after the next file upload 
import or scheduled file import.

6 Depending on the action selected in Step 3, follow the corresponding steps below.
• For the Create a Case action:
a. On the Case Details tab, define the details of the case: assign it to the user from your workgroup, 

specify case priority, title, and description, notify users of this case, and provide contact 
information of the person who receive the case details in the corresponding boxes.

b. To add piping support for the file import Case Triggers, in the Case Details section, on the Case 

Descriptions toolbar, click Insert Piped Value icon .
• In the Insert Piped Value dialog box, in the Fields section, in the list of published Data 

Headings, click a field that you want to pipe, and then click OK.
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 For Whole Number, Real Number, Text, Email, Phone Number, and Date, the placeholder for 
database value is inserted as %[Field1]Q1_1%.

For Essay, the placeholder for database value is inserted as %[Field1]Q1%.
For Set (Single Selection) the placeholder for choice label value is inserted as %[1]Q2LBL%.

• In the Custom Properties section > Insert Piped Value icon , in the list of question 
fields (where question type matches type of custom property), click a field that you want to 
pipe. 

 When the trigger is executed, the placeholders are replaced with the value or label for the file 
import record.

c. Click OK to save the trigger. 
For the records that meet the defined criteria, upon scheduled import, the case is created and its 
details are sent to the specified contact.

 Case triggers are available only if you have a license for the Case Management feature.

• For the Add Participants to a Survey action:
a. On the Survey Selection tab, click the Add Survey link.
b. In the Add Survey dialog box, select the survey that you want to add participants to, and then 

click Add. You can add multiple surveys.

 Only Contact List, Passcode campaign, and SMS surveys that are open are available for selection. 
Email and Mobile Number data fields are available in the published campaigns, and both data 
fields can be used for participant creation in triggers.

c. For multiple-campaign surveys, on the Campaign menu, select the needed campaign name.
d. On the Data Field menu, click the file import field that you want to import the participants from. 

For Contact List and Panelist surveys, you can import email addresses (Email Address, Mobile 
Number, or Text data fields); for SMS surveys, you can import telephone numbers (Numeric, 
Mobile Number, or Text data fields).

e. To save the trigger, click OK. 
For the records that meet the defined criteria, the email addresses or telephone numbers from 
the specified file import field are automatically added to the selected survey(s) as new 
participants.

 For the participants added from file import, you can pipe values from file import fields into 
question, choice, and topic labels and as preselected answers into Short Answer, Fill in the 
Blank, and Essay questions (see Pipe values from a file import, page 548).

• For the Update Profile Fields action:
a. On the Profile Fields tab, click the Update Profile link.
b. In the Update Profile dialog box, on the Current Profile menu, click the profile that you want to 

update. You can select to update only published profiles.



File Imports Create a file import trigger

EFM User Guide 1177

Confidential and Proprietary Information of Verint Systems Inc.

c. In the grid below, match the file import fields to the corresponding profile fields that you want to 
update, and then click Add. You need to match each file import field to a different profile field or 
click Not Selected on the corresponding menu. You can only update the fields with the 
responses to Fill in the Blank, Short Answer, Essay, and Choose One questions.

 If Set (Single Selection) values in the file import do not match Choose One question choices in 
the profile, the Choose One question responses show empty fields in the Response Manager 
grid.

If Set (Single Selection) includes additional values, which are not among the Choose One 
question choices, these values are ignored upon profile update.

d. On the Matching Profile Question menu, click the profile question that matches the data type 
of the file import unique field. The selected question is used to identify the matching record in the 
file important update the profile data accordingly. If file import and profile are matched by the 
Email Address data field, the new records are added from the file import to the profile as 
panelists.

 You can add multiple profiles in scope of a single trigger.

You can view the defined mapping by clicking the profile link on the Profile Fields tab.

e. Click OK to save the trigger. 
For the records that meet the defined criteria, the fields of the selected profile(s) are automatically 
updated with the corresponding information from the current file import. In addition, if file 
import unique field is Email Address data type, new records are added to the profile(s) as 
panelists. You can view the updated profile fields and newly added panelists in the Response 
Manager grid and in the Panelists grid accordingly.

7 To edit the trigger, click its link on the Triggers tab, and then make your changes in the Edit Trigger 
dialog box.

8 To apply the created trigger, on the Fields tab, click Publish.
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Delete a file import
Navigation

Data Sources tab > File Imports tab.

You can delete file imports in the File Imports grid.

 If you delete a file import that is used as a source for piping, then the values that are piped from 
this file import return no data.

Procedure 
1 In the File Imports grid, select one or more file imports, and then click Delete.

 You can also click the Actions menu > Delete.

2 In the Please, type in 'DELETE' and click Delete box, type DELETE, and then click Delete.
Your file import is permanently deleted.

 You cannot delete a file import if it is defined in a data channel. You should first remove all the 
associated data channels.
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Delete a record from a file import
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Data tab > select 
a record you want to delete > click the Delete Record(s) button.

You can delete a selected record or all selected records from the file import.

Procedure 
1 In the Data grid, select the check box next to one or more records that you want to delete, and then 

click the Delete Record(s) button on the toolbar.

 You can also click the Actions menu > Delete Record(s) option.

2 In the Delete Record(s) dialog box, click the Delete Record(s) button.
Your record is permanently deleted from the file import and any referenced data set.

 You should first delete the record(s) from the source file, otherwise, the record(s) will be added 
back in the EFM application after the next import recurrence.

 



File Imports Filter a file import

EFM User Guide 1180

Confidential and Proprietary Information of Verint Systems Inc.

Filter a file import
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Data tab > click 
the Filter button.

You can control what types of information to display in the Data grid by defining certain filtering criteria.

 To use the Data tab, you should first publish your file import.

Procedure 
1 On the Data page, on the toolbar, click the Filter button.

 The filter option is also available on the Actions menu.

2 In the Filter dialog box, click the Add button or the Add Filter Criteria link.
3 In the Add Filter Criteria dialog box, select the source file import for your filter.
4 In the corresponding lists, click the field, expression, and value by which you want to filter the data.
5 Click the Add button.

The new filter appears in the Filter dialog box.
6 In the Date Filter section, on the Select Date Field menu, set the filter based on the date when 

records were submitted or on the fields with Date data type.
7 On the Time Period menu, select the option from the list to filter the data based on a certain time 

period.
8 To set the default values for the date filters, click the Clear Filter link.
9 To save your changes, click the Apply Filter button.

 Export file import options meet all the filtering criteria you set.

When the filtering criteria are applied, a notification describing the current filter appears above the Data 
grid. You can change or cancel the custom filter by clicking the Edit or Clear link correspondingly.
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Export a file import
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Data tab > click 
Export.

On the Data page, you can export your file import to the .csv, .tsv, or .xlsx file formats by clicking the 
Export menu.

 To use the Data tab, you should first publish your file import.

Procedure 
1 On the Data page, on the Export menu, click the appropriate file format. 

The export file is generated in the selected format.

 Time stamps are exported in your local time zone.

2 In the Export file import dialog box, click the link to download the file.
3 Click Close.
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Push a file import to Feedback Intelligence
Navigation

Data Sources tab > File Imports tab > click an existing file import or create a new one > Actions menu > 
Push to Feedback Intelligence option.

You can update your file imports in Feedback Intelligence by clicking the Push to Feedback Intelligence 
option. This option is available if your file import is already added to Feedback Intelligence by a System 
Administrator of your workgroup. The System Administrator can also turn the Push to Feedback 
Intelligence option on or off for a certain file import.

 When you update the existing file import in Feedback Intelligence, changes that you made to the 
file import may affect the previously generated Feedback Intelligence universe, which may 
change or damage the existing reports. 

If you have reports based on this file import, it is recommended that you discuss your file 
import changes with a support manager before submitting this update.

Procedure 
1 On the File Imports tab, select the file import that you want to update in Feedback Intelligence.
2 On the Actions menu, click Push to Feedback Intelligence.
3 In the confirmation dialog box, click OK.

Your file import is marked to be updated in Feedback Intelligence.
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Speech Analytics

Speech Analytics integration provides the possibility to retrieve WFO Speech Analytics data into 
EFM for further analysis and reporting on interaction categories and data fields. Speech 
Analytics data can be used in data sets, UVoC Module, and Feedback Intelligence for reporting 
purposes.
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Speech Analytics grid
Navigation

Data Sources tab > Speech Analytics tab.

You can create a new Speech Analytics project, view information about the existing Speech Analytics 
projects, open, rename, and delete them. 
On the Speech Analytics page, you can view the title, owner of the Speech Analytics project, and dates 
when it was last published or modified.

 The Speech Analytics tab is only available for the workgroups with the Speech Analytics license 
enabled. To enable the license, contact your System Administrator.

If your Speech Analytics project is added to Feedback Intelligence, click the arrow next to the project 
name to expand Feedback Intelligence dialog box with details on project responses loading.
You can specify how many Speech Analytics projects to display per page by clicking the needed amount in 
the lower-left part of the Speech Analytics grid. By default, the Speech Analytics projects are sorted 
according to the date when they were last modified.

 You can change the column width on the Speech Analytics page by dragging the needed 
column border.

On the Actions menu, the following options are available:
• New – Click to create a new Speech Analytics project.

 You can also create a new Speech Analytics project by clicking New on the toolbar.

• Rename – Click to rename the Speech Analytics project. To make this option available, select the 
check box next to the Speech Analytics project that you want to rename.

• Delete – Click to delete the existing Speech Analytics project. To make this option available, select 
the check box next to the Speech Analytics project that you want to delete.

• Push to Feedback Intelligence – Click to update the previously added Speech Analytics projects 
in Feedback Intelligence.

 Contact a System Administrator to add the Speech Analytics project to Feedback Intelligence. A 
System Administrator can also enable and disable the Push to Feedback Intelligence option 
for a certain Speech Analytics project.
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Create Speech Analytics project
Navigation

Data Sources tab > Speech Analytics tab > New button.

You can create a Speech Analytics project.

Procedure 
1 On the Speech Analytics page, on the toolbar, click New.

 You can also click the Actions menu > New option.

2 In the Name Your Speech Analytics Project dialog box, type the name of the Speech Analytics 
project, and then click OK.
The Configure page opens.

 If you want to return to the Speech Analytics grid, click the Return to Speech Analytics link.
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Managing Speech Analytics
Navigation

Data Sources tab > Speech Analytics tab > click an existing Speech Analytics project or create a new one 
by clicking New on the toolbar.

After creating a Speech Analytics project, use the following tabs to set up and manage Speech Analytics:
• Configure – Select the Speech Analytics project with the configured SFTP settings. When you click 

Save Setup, a new Import Speech Analytics task is created with import recurrence every 15 
minutes, and project selection is saved to the task settings.

 When you select the Speech Analytics project, and then click Save Setup, the list is dimmed with 
the item selected.

• Data – View, export, and filter data, and delete the records from your Speech Analytics project. 
For more information how to export a Speech Analytics project, go to Export Speech Analytics 
project, page 1188.

 To use the Data tab, you need first to select the Speech Analytics project on the Configure tab.

 You need first to delete one or more records from the Speech Analytics source, otherwise, the 
records will be added back to EFM after the next import recurrence.

• Values – Provide the report labels, report values, and export values for the Speech Analytics fields 
to use later for reporting, export, and view them on the Response Manager page. Report labels 
specified for the Set (Single Selection) fields are displayed on the Data tab.

 To review and modify the values, you need first to select the Speech Analytics project on the 
Configure tab.

The Speech Analytics project is published with the following default fields:
• Transaction Id
• Agent Name
• Start Time
• ANI Code
• DNIS Code
• Direction
• Number of Holds
• Total Hold Time (secs)

On the Data tab, the Transaction Id for each record is a link. If you are not already logged in, by clicking 
the Transaction Id link, you are redirected to the Login page in the WFO app. If you are already logged 
in, you are redirected to the Interaction Review page related to the Transaction Id of the selected 
record.
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 The Transaction Id links are active, only if the WFO server settings are configured for the 
workgroup by your System Administrator.

When Speech Analytics data is imported, the data is analyzed for the categories. If the import file has new 
defined categories, a new category choice is created with the label set to the category name. Then this 
new choice is added to the Categories question, the questionnaire is republished, and the Speech 
Analytics grid is updated with the Categories column.

 By default all category choices are set to Not Asked (null).
If category has a Rank > 0 for a record, the categories choice is set to selected (1).
If category has Rank = 0 for a record, the categories choice is set to not selected (0).
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Export Speech Analytics project
Navigation

Data Sources tab > Speech Analytics tab > click an existing Speech Analytics project or create a new one 
> Data tab > Export button.

You can export your Speech Analytics project to the .csv, .tsv, or .xlsx file.

 To use the Data tab, you should first select the Speech Analytics project on the Configure tab.

Procedure 
1 On the Data page, on the Export menu, click the appropriate file format. 

The export file is generated in the selected format.

 You can also export a Speech Analytics project by clicking the Actions menu > Export option > 
the appropriate file format.

 Time stamps are exported in your local time zone.

2 In the Export file import dialog box, click the link to download the file.
3 Click Close.
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Delete Speech Analytics project
Navigation

Data Sources tab > Speech Analytics tab.

You can delete Speech Analytics projects in the Speech Analytics grid.

 If you delete a Speech Analytics project that is used as a source for piping, then the values that 
are piped from this project return no data.

Procedure 
1 In the Speech Analytics grid, select one or more Speech Analytics projects, and then click Delete.

 You can also click the Actions menu > Delete option.

2 In the Please, type in 'DELETE' and click Delete box, type DELETE, and then click Delete.
Your Speech Analytics project is permanently deleted.
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Push a Speech Analytics project to Feedback 
Intelligence

Navigation

Data Sources tab > Speech Analytics tab > click an existing Speech Analytics project or create a new one 
> Actions menu > Push to Feedback Intelligence option.

You can update your Speech Analytics project in Feedback Intelligence by clicking the Push to Feedback 
Intelligence option. This option is available if your Speech Analytics project is already added to Feedback 
Intelligence by a System Administrator of your workgroup. The System Administrator can also turn the 
Push to Feedback Intelligence option on or off for a certain Speech Analytics project.

 When you update the existing Speech Analytics project in Feedback Intelligence, changes that you 
made to the Speech Analytics project may affect the previously generated Feedback Intelligence 
universe, which may change or damage the existing reports. 

If you have reports based on this Speech Analytics project, it is recommended that you discuss 
your Speech Analytics project changes with Support before submitting this update.

Procedure 
1 On the Speech Analytics tab, select the Speech Analytics project that you want to update in 

Feedback Intelligence.
2 On the Actions menu, click Push to Feedback Intelligence.
3 In the confirmation dialog box, click OK.

Your Speech Analytics project is marked to be updated in Feedback Intelligence.
When your Speech Analytics project is added to Feedback Intelligence, in the Speech Analytics grid, click 
the arrow next to the project name to expand Feedback Intelligence dialog box with details on project 
responses loading.
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Data sets overview
With data sets, you can combine questions from multiple sources and tie-in contextual information after 
the data is collected into a single entity for analysis and reporting purposes.

Data points
Data points are fields collected from various sources that can be used for analysis needs. You can add 
questions from multiple internal and integrated projects such as surveys, profiles, comments, Speech 
Analytics projects, ForeSee projects, and file imports, and then combine them into a single data set.

 You can add different fields from various sources into one project by linking data points of the 
same type of questions. Otherwise, analysis will produce meaningless results. Make sure you 
map appropriate data together.

Linked fields
With linked fields, you can combine data points of the same type of questions that are available in 
different projects into one data set to create a custom report.
For example, if you know the email address of a respondent because that type of question was asked 
previously in the survey or it is in a panel profile, a linked field will allow you to copy that information to all 
of the responses from multiple sources. This can be used for further analysis. 
With linked fields you can uniquely identify the participants in the combined data. If you want to use 
results from the Generate Link surveys your data set must contain at least one data point that can be 
linked to a question in the Generate Link survey. For example, if you want to link the employee ID both 
your data set and link survey must have matching fields that can be used to link the data.
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Creating data sets process
Navigation

Data Sources tab > Data Sets tab.

Data Sets creating process contains the following three-step procedure: 
• Creating data sets process, page 1194
• Tie-in linked fields, page 1194
• Publish a data set for reporting, page 1195

Add a data point

Procedure 
1 Go to the Data Sources tab > Data Sets tab, on the toolbar, click the New button. 
2 In the Name Your Data Set dialog box,  in the Data Set Name text box, type the name of your data 

set.
3 Click OK. 
4 On the Data Points page, on the toolbar, click the Add Data Points button. 
5 In the Add Data Points dialog box, select the survey, comment, Speech Analytics project,  ForeSee 

projects, profile, or file import, from which you want to add data points.

 Surveys and profiles in the Design or Test mode are not shown. Only published file imports are 
available in the File Imports folder.

6 Select the check box next to the questions that you want to add as data points.
7 Click Add. 

The data points are added to the data set.
8 Add an identity question (Fill in the Blank or Short Answer) as a data point to your data set.

 You can combine and recode data points, change the primary question, and edit report options in 
the Edit Data Point dialog box.

Tie-in linked fields

Procedure 
1 Go to the Data Points page, on the toolbar, click the Add Linked Fields button. 
2 In the Add Linked Fields dialog box, select the survey, comment, Speech Analytics project, profile, or 

file import, from which you want to add linked fields.

 Surveys and profiles in the Design or Test mode are not shown. Only published file imports are 
available in the File Imports folder.

3 Select the check box next to the questions that you want to link, and then click Next.
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4 Select the question that uniquely identifies the respondent in the data source.
5 Select the question that has the matching information in your data set to the linked source identity 

question.
6 Click Add. 

The data points are linked.

Publish a data set for reporting

Procedure 
1 Go to the Data Points page, click the Publish button. 
2 In the Publish Your Data Set Now dialog box, click Publish. 

The data set is published, and the data points and linked fields are available for reporting.
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Data Sets tab
Navigation

Data Sources tab > Data Sets tab.

With data sets, you can easily gather and analyze specific information from multiple sources, merge it, 
and report on it. You can add, duplicate, share, and delete your data sets.
By default, your data sets are sorted by the Last Modified column in the Data Sets grid. If you want to 
change how your data sets display in the grid, click a column header (Title, Owner, Status, Last 
Populated, or Last Modified). An arrow displays up (ascending) or down (descending) to show the sort 
order. You can also change a column width by dragging the edge of the column header.
The default number of data sets per page is 10. However, you can select up to 100 data sets to be 
displayed on the Data Sets page. You can also navigate through the pages of data sets by clicking the 
scroll arrows at the bottom of the page.
To manage all data sets, select the check box in the upper-left corner of the Data Sets page.
On the Data Sets page, the following columns are available:
• Title – Name of a data set. To edit the data set, click the data set name.
• Owner – The user to whom the data set belongs.
• Status – The current data set status. 

The following data set status options are available:
• Design – Data set can be edited but is not available for reporting.
• Published – Data set is published for reporting.
• Processing – Data set information is in the update process after publishing.

• Last Populated – The last time when the data set was updated or published.
• Last Modified – The last time when the data set was changed.
On the toolbar, the following options are available:
• New – Create a new data set.
• Duplicate – Duplicate the selected data set.
• Rename – Change the name of the data set.
• Share – Share the selected data set with the other users.
• Publish – Publish the data set to make it available for reporting.
• Delete – Remove the selected data set.
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Data Sets–Role-based access
Navigation

Administration tab > Roles tab.

The group and survey administrators can control the workgroup members' ability to view, create, edit, 
and delete data sets based on the user role set of permissions. You can activate the Data Sets 
functionality for a user by creating a new role or editing the existing ones on the Administration tab > 
Roles tab. 
By default, all Data Sets permissions are active for the group and survey administrators. Additionally, a 
View access is active for the Lite Survey Author, Restricted Survey Author, and Report Author 
roles.

Activate Data Sets for a user role

Procedure 
1 Go to the Administration tab > Roles tab, and then click the name of the role that you want to edit. 
2 On the Edit Role page, define the actions the workgroup member can perform on data sets by 

selecting the corresponding check boxes in the View, Create, Edit, and Delete columns in the Data 
Sets row in the Survey Administration section. 
The selection of the View check box activates the Reports > Data Sets tab.
• View – View data sets shared with you by other users.
• Create – Create new data sets.
• Edit – Modify data sets that you have access to.
• Delete – Remove data sets that you have access to.

 When you select the Create, Edit, or Delete check boxes in the Survey Administration 
section, the View check box is selected automatically.

3 To let the workgroup member view all data sets in a workgroup regardless of their authorship and 
sharing status, in the Administration section, select the View All Data Sets check box.

4 Click Save.
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Organization scoped data sets
Navigation

Data Sources tab > Data Sets tab > New button.

You can create organization scoped data sets to share the scoped surveys with other users, allow them to 
use scoped report elements, and enforce scoping to protect data.
When you add a data point to the data set from an organization scoped survey, the data set becomes an 
organization scoped data set. Access to results is limited to the report viewers organization scope.
Adding a linked field from an organization scoped survey does not make a data set organization scoped. 
Access to results is not limited to the organization scope.
You can ensure that your scoped survey is not distributed in a non-scoped way in data sets. When a 
survey is scoped and you want it to remain scoped, clear the Allow survey to be linked into data sets 
check box. This way you mark the survey as excluded from linked fields. The survey will not be in the list 
when you add linked fields to the data set. The survey can still be used to add data points to the data set, 
which retains its scoping.
If you select the Allow survey to be linked into data sets check box, the survey can be used when 
you add linked fields to the data set. Adding a linked field to the data set makes a survey non-scoped.
The Allow survey to be linked into data sets check box is available only for the Organization 
External ID and Employee External ID library questions in the Question Options panel in the survey 
designer.
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Push a data set to Feedback Intelligence
Navigation

Data Sources tab > Data Sets tab > select the needed data set > Actions menu > Push to Feedback 
Intelligence option.

Before you begin 
• Publish the needed data set.

 Data set in the Design mode is not available for publishing.

• Contact a System Administrator to add the data set to Feedback Intelligence. A System 
Administrator can also enable and disable the Push to Feedback Intelligence option for a 
certain data set.

 When you update the existing data set in Feedback Intelligence, changes that you made to the 
data set may affect the previously generated Feedback Intelligence universe and Tableau data 
source, which may change or damage the existing reports. If you have reports based on this data 
set, it is recommended that you discuss your data set changes with a support manager before 
submitting this update.

You can add and update your data set in Feedback Intelligence for advanced reporting by using the Push 
to Feedback Intelligence option.

 When a data set is added to Feedback Intelligence, the columns on the Data Sets > Responses 
grid and the responses from multi-campaign surveys are available in Feedback Intelligence.

You can view and use the following columns for creating report elements in Business Objects and 
Tableau:
• Current Data Set
• Respondent Fields
• Panelists
• Profiles
• Respondent System Information
• Campaign Information
• Data Source Information
• Respondent Location

Procedure 
1 On the Data Sets tab, select the data set that you want to update in Feedback Intelligence.
2 On the Actions menu, click the Push to Feedback Intelligence option.
3 In the confirmation dialog box, click OK.

Your data set is marked to be updated in Feedback Intelligence.
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Create a data set
Navigation

Data Sources tab > Data Sets tab > New button.

You can name your data set right when you create it. The default name is Untitled Data Set followed by 
the next incremental number, for example, Untitled Data Set 3. Naming a data set makes it easier to 
organize and find your data set later.

Procedure 
1 Go to the Data Sets tab,  on the toolbar, click the New button. 
2 In the Name Your Data Set dialog box, in the Data Set Name text box, type the name of a data 

set.
3 Click OK. 

The data set is created  in the Design mode.

 Your next step is to add data points to your data set.
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Duplicate a data set
Navigation

Data Sources tab > Data Sets tab > Duplicate button.

You can manage the report data from different surveys. You can copy an existing data set to create a new 
one with your custom settings easier and faster.
You can copy shared with you data sets if the edit permission is active for your role.

 You can copy only one data set at a time.

Procedure 
1 In the Data Sets grid, select the check box next to the data set that you want to copy.
2 On the toolbar, click Duplicate. 
3 In the Duplicate a Data Set dialog box, in the Data Set Name field, type a name of the data set.
4 Click OK. 

The Data Points grid opens with the available data points. The duplicated data set contains the same 
data points and linked fields that were created in the original data set.
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Share a data set
Navigation

Data Sources tab > Data Sets tab > Share button.

You can manage the report data from different surveys. You can share your data sets with other users 
and organizations to give them the View or the View and edit access to your data sets. 
The following sharing options are available:
• View Access – The users can only view the data set shared with them. 
• Full Access – The users can view and edit the data set shared with them.

 You can share only one data set at a time and only your own data sets.

The list of users and organizations in the Share Access dialog box contains maximum 200 user names. 
To search for a specific user or organization, use the search box at the top of the list.
You can also view data sets shared with you by other users. The shared with you data set appears among 
your data sets. The name of the user who shared a data set with you is shown in the the Data Sets grid > 
Owner column. If you have the View access to the shared data set, all edit buttons will be disabled for 
the current data set.

Procedure 
1 In the Data Sets grid, select the check box next to the data set that you want to share.
2 On the toolbar, click Share. 
3 In the Share Access dialog box, with the list of users and organizations displayed, select a check box 

next to the user or an organization, and then click the right arrow to move them to the Full Access or 
View Access box.

 All users assigned to the selected organization as well as all child organizations will be moved to 
the selected right box too. You can move back the users or organizations you do not want to 
share the data set with, by selecting the corresponding check boxes and clicking the left arrows 
button.

4 To send the email notification to the users allowed to view or edit the data set, select the Notify 
Usersby Email check box. 
The check box is selected by default.

 All users assigned to the selected organization will receive the email notification of the data set 
being shared with them.

5 Click OK.
6 In the Notify Users dialog box, edit your email notification, and then click OK.

 The Notify Users dialog box opens only when the Notify Users by Email check box is selected.
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Stop sharing a data set

Procedure 
1 In the Data Sets grid, select the check box next to the previously shared data set.
2 On the toolbar, click Share. 
3 In the Share Access dialog box opens, in the Full Access or View Access box, select the user with 

whom you want to stop sharing the data set.
4 Click the left double arrows button  to move the selected user to the Users box.
5 Click OK. 

The data set is no longer available for the user.
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Publish a data set
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Publish button.

After creating a data set, you need to publish it to make it available for further reporting. When your data 
set is published, its editing is restricted. The data points and linked fields become available for reporting. 
The Publish button is renamed to Republish and becomes unavailable.
You can view the last time data was updated to track all changes in your report. The exact time of the 
update is displayed on the Data Points page > Data Last Populated status. If the data set is not 
updated yet, the Pending status is displayed. When the data set is in the update process, the Data Last 
Populated status is set to Processing.
If you want to edit your data set after publishing, for example, add a new data point or combine it with a 
published one, you need to republish the data set after making all the changes. The Unpublished icon 

 appears in front of the unpublished data point. Click Republish to make the updated data 
available for reporting.
Your data set is automatically validated for any errors before publishing. 
If there are no errors, the No problems were detected with your data set message appears.
You can also view a number of rows to be processed for this data set after publishing.

Procedure 
1 In the Data Sets grid, click the name of the data set that you want to publish. 
2 In the Data Points page, on the toolbar, click the Publish button. 
3 In the Publish Your Data Set Now dialog box, check your data set for the listed issues (if any).
4 Click Publish. 

The data set is published, and the data points and linked fields are available for reporting.
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Data set update frequency
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Update Frequency menu.

When your data set is published, it needs to be updated with the new responses or any changes in your 
surveys to provide accurate report information.
You can set the frequency of your data set updates with the following options:
• Daily
• Weekly
• Every 12 hours
• Never
By default, the frequency of the update is set to Daily. You can change it to Weekly, Every 12 hours, or 
to Never by clicking the needed option on the Update Frequency menu.
If you create a data set for one-time use only and do not need the updates for it, you can set the update 
frequency to Never. You can also change it any time you like.
You can view the last time the data was updated to track all changes in your report. The exact time of the 
update is displayed on the Data Points page > Data Last Populated status. If the data set is not 
updated yet, the Pending status is displayed. When the data set is in the update process, the Data Last 
Populated status is set to Processing.
Only data sets that have new or modified data will be processed.
If your data set is not updated or used by Feedback Intelligence for more than 30 days, the data set is not 
updated anymore.
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Report elements status messages
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or open an existing one 
that contains data set information.
You can view the data set updates information for the report elements that are based on the data sets.
Data is unavailable in a report element based on data set information in the following cases:
• Filters that filter out all the data are applied.
• The data is not processed yet.
When you publish or republish the data set, it takes some time for the report elements to be updated. In 
such case, the No Data Available message appears for the report element body. Additionally, the 
following message appears at the top of the report element:
The requested data is being recompiled from scratch. This may take some time. Thank you 
for your patience.
If the data set is in the Processing status, it takes some time for the report elements based on the data 
set to be updated. In such case, the message is the following:
Processing, please check back shortly.
If the data points that are used in your report elements have new answers, the report element shows the 
existing answers in the report element and the message  is the following:
Additional responses have been received but are pending processing. Chart will be updated 
shortly.
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Validate a data set
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Actions menu > Validate option.

You can check your data set for any errors and fix them before publishing the data set. The following 
information is available:
• Data points that should be recoded. 

These are data points where you need to map similar data together, fix reversed scales, or adapt 
slightly mismatched questions.

• Items that have sparse data. 
These are data points and linked fields where you need to provide the missing information. You 
can view the list of the missing items in the dialog box.

If there are no errors, the No problems were detected with your data set message appears.
You can also view a number of rows to be processed for this data set after publishing. Once your data set 
is published, its editing is restricted. The data points and linked fields become available for reporting.

Procedure 
1 On the Data Points page, on the Actions menu, click Validate. 
2 In the Validate Data Set dialog box, check your data set for the listed issues (if any).
3 Click Close.
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Delete a data set
Navigation

Data Sources tab > Data Sets tab > Delete button.

You can delete data sets that you do not need any more. If you delete a data set, the Data No Longer 
Available notification appears for the report elements using this data set. You can delete multiple data 
sets at a time.

Procedure 
1 On the Data Sets tab, select the check box next to the data set that you want to delete.
2 On the toolbar, click the Delete button. 
3 In the confirmation dialog box, click Delete. 

The data set is deleted.



Data Sets Data Points overview

EFM User Guide 1209

Confidential and Proprietary Information of Verint Systems Inc.

Data Points overview
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page.

After creating the data set, you need to add data points to it. 
Data points are fields collected from various sources, such as surveys, profiles, comments, Speech 
Analytics projects, and file imports, that can be used for reporting and analysis purposes. You can add, 
edit, combine, publish, and delete data points for the specific data set.
You also need to add an identity data point into your data set so that respondents can be tied to the 
linked fields. Identity data point is a question in your data set that holds unique identifying information 
about your respondents. Only the Fill in the Blank and Short Answer type of questions can be set as 
an identity data point.
The Data Points page provides you information on each data point and linked field that you created. 

You can identify the linked field by the Linked Field icon  before its title. The updated data point that 

should be republished for reporting is marked by the Warning icon  before its title. You can sort 
data points and linked fields by clicking the column heading. To change the width of a column, drag its 
edge.
To manage all items, select the check box in the upper-left corner on the Data Points page.
 
On the Data Points page, the following columns are available:
• Icon – The updated data point that should be republished for reporting and the linked fields are 

marked by icons in this column.
• Title – Question heading plus the question text, separated by a period. To edit the item, click the 

title.
• Data Format – Question type of the question.
• Data Source – Survey, profile, comment, Speech Analytics project,  ForeSee projects, or file import 

that the question is taken from. If data point consists of more than one column, it has the Source 
N name with all the sources listed. N is the number of columns that are combined together in the 
data point.

 
On the toolbar, you can see the following options:
• Actions – On the menu, the following options are available:

• Add Data Points – Add questions from multiple internal and integrated projects such as surveys, 
profiles, comments, Speech Analytics projects,  ForeSee projects, and file imports, and then 
combine them into a single data set.

• Add Linked Fields – Combine data points of the same type of questions that are available in 
different projects into one data set to create a custom report.

• Validate – Check your data set for any errors.
• Publish – Publish the data set to make it available for reporting.
• Delete – Delete the selected data point.



Data Sets Data Points overview

EFM User Guide 1210

Confidential and Proprietary Information of Verint Systems Inc.

 If you do not have permission to edit data sets, only the Validate option is active on the Actions 
menu.
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Add a data point to data set
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button.

You can add data points to the data set from a survey, comment, file import,  Speech Analytics project,  
ForeSee project, or profile. You can use all surveys, comments, file imports,  Speech Analytics projects,  
ForeSee projects, and profiles you have access to, including the My Surveys, Comments, File Imports, 
Shared Surveys, Other Users' Surveys, Speech Analytics, ForeSee, and Profiles folders. Surveys and 
profiles in the Design or Test mode are not shown. You can only add questions that are published in the 
open survey. 
You can add all question types as data points, but not such content as text,  code blocks, or sections. An 
identity data point can be a Fill in the Blank or Short Answer type of questions only.

Procedure 
1 On the Data Points tab, on the toolbar, click the Add Data Points button. 
2 In the Add Data Point dialog box, select the survey, comment, profile, Speech Analytics project, or file 

import, from which you want to add data points. The list of questions from the selected source 
appears in the Questions box. Hover over the question to preview it.

 Surveys and profiles in the Design or Test mode are not shown. Only published file imports are 
available in the File Imports folder.

3 To search for the specific survey, comment, profile,  Speech Analytics project, or file import, type a 
partial or whole project name in the search box, and then click the Search button. The list of surveys, 
profiles, comments,  Speech Analytics projects,  ForeSee projects, or file imports that match your input 
displays.

4 Select the check box next to the questions that you want to add as data points.
When you add data points from the multi-campaign survey, the system fields from all campaign types 
in the survey are available for the selection. The following campaign specific system fields are 
available:
• Panelist ID, Email, and Mobile Number (for Panelist campaign)
• Email and Mobile Number (for Contact List campaign)
• Email (for Passcode campaign and comments)

 The Mobile Number system field is available, only if SMS Surveys feature is enabled for the 
wokgroup.

 Questions that are already added to the data set are inactive in the dialog box.

5 Click Add. 
The data point is added to the data set.

6 Repeat the steps to add more data points. Add an identity data point, which is a Fill in the Blank or 
Short Answer types of question that holds unique identifying information about your respondents.
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 After that you can add linked fields and set the identity data point for your data set.
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Add and remove an identity data point
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button.

To combine projects for custom reporting you need to add an identity data point to your data set. An 
identity data point uniquely identifies the respondent in the data source. Only Fill in the Blank or Short 
Answer type of questions can be set as an identity data point.
You need to add an identity data point while adding other data points to your data set to tie respondents 
to the linked fields later. Only then you can link questions from a different survey. The Add Linked 
Fields button on the toolbar is only available if the identity data point is added to the data set.
For the Invite Panelists surveys, the identity information list contains Panelist ID, email, and mobile 
information. For the Create a List survey, list contains email and mobile information. For the Require a 
Passcode survey and comments, the list contains only email information.

 The mobile information is available, only if SMS Surveys feature is enabled for the workgroup.

If you delete an identity data point, the linked fields in your data set are also deleted. You can add them 
again after choosing a new identity data point.
When you delete an identity data point, all report elements and filters that included the deleted identity 
data point are deleted too.

Add an identity data point to a data set

Procedure 
1 On the Data Points tab, on the toolbar, click the Add Data Points button. 
2 In the Add Data Point dialog box, select the survey, comment, profile, Speech Analytics project, or file 

import, from which you want to add an identity data point.

 Surveys and profiles in the Design or Test mode are not shown. Only published file imports are 
available in the File Imports folder.

3 To search for the specific survey, comment, profile, Speech Analytics project, or file import, type a 
partial or whole project name in the search box, and then click the Search button. The list of surveys, 
profiles, comments, Speech Analytics project,  ForeSee project, or file imports that match your input 
displays.

4 Select the check box next to the Fill in the Blank or Short Answer type of questions that you want 
to add as an identity data point.

 Questions that are already added to the data set are inactive in the dialog box.

5 Click Add. 
The identity data point is added to the data set.
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Delete an identity data point

Procedure 
1 On the Data Points page, select the check box next to the identity data point that you want to 

delete. 
Identity data point is highlighted in gray in the grid.

2 On the toolbar, click Delete. 
3 In the confirmation dialog box opens, click Delete.
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Add linked fields
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Linked Fields button.

With linked fields, you can combine data points of the same type of questions that are available in 
different projects into one data set to create a custom report. The surveys, profiles, comments, Speech 
Analytics projects, and file imports that you want to combine need to have identity questions. These are 
the Fill in the Blank or Short Answer type of questions that uniquely identify the respondent in the 
data source. Only surveys that contain the Fill in the Blank or Short Answer type of questions are 
shown to the user in the Linked Questions box > Add Linked Fields dialog box. 
You can use all surveys, comments, file imports, and profiles you have access to, including the My 
Surveys, Comments, File Imports, Shared Surveys, Other Users' Surveys, Speech Analytics, and 
Profiles folders. Surveys and profiles in the Design or Test mode are not shown. You can only add 
questions that are published in an open survey.
You need to add an identity data point while adding other data points to your data set so that 
respondents can be tied to the linked fields. Only then you can link questions from a different data 
source. The Add Linked Fields button on the toolbar is only available if the identity data point is added 
to the data set.
For the Invite Panelists surveys, the identity information list contains Panelist ID, email, and mobile 
information. For the Create a List surevy, list contains  email and mobile information. For the Require a 
Passcode survey and comments, the list contains only email information. 

 The mobile information is available, only if SMS Surveys feature is enabled for the workgroup.

Connecting linked source
After selecting the data points that you want to link, you need to set the question that identifies the 
respondent in the survey that you want to link and the matching data point in your data set.
The Which question uniquely identifies a respondent in this data source list contains all Fill in 
the Blank or Short Answer questions from the survey or comment that you want to link. The identity 
question that you use more often is selected automatically. This question is called Linked Source Identity 
Question. If the published data set contains linked fields for a particular project, you cannot change the 
Linked Source Identity Question for that project.
The Which data point in your data set has matching information in it list contains all Fill in the 
Blank or Short Answer questions from your data set. This question is called Data Set Identity 
Question. If the published data set contains linked fields, you cannot change the Data Set Identity 
Question.
If your data set already contains linked fields and you want to add more linked fields from other sources, 
the Which data point in your data set has matching information in it list becomes unavailable for 
editing. You do not need to edit it to add all other linked fields.
You need to republish the data set after adding linked fields to update it for reporting.

Procedure 
1 On the Data Points page,  on the toolbar, click the Add Linked Fields button. 
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2 In the Add Linked Fields dialog box, select the survey, comment, profile, Speech Analytics project, or 
file import, from which you want to add linked fields.

 Surveys and profiles in the Design or Test mode are not shown. Only published file imports are 
available in the File Imports folder.

3 To search for the specific survey, comment card, profile, Speech Analytics project, or file import, type a 
partial or whole project name in the search box, and then click the Search button. The list of surveys, 
profiles, comments, Speech Analytics projects, or file imports that match your input displays.

4 Select the check box next to the question you want to link.
The system fields from all campaign types in the survey are available for the selection, if they match 
the linked source identity question.

 Questions that are already added to the data set are inactive in the dialog box.

5 Click Next.
6 Select the question that uniquely identifies the respondent in the data source.
7 Select the question that has the matching information in your data set to the linked source identity 

question.
8 Click Add. 

The data points are linked.
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Combine a data point
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page >  
Add Data Points button > click the data point name > Edit Data Point dialog box > Combine Data 
Point button.

You can combine data points from one source with data points from another source in one data set to 
create a custom report.
To combine similar questions from various sources, you need to select questions, which have the same 
question type. For example, if your primary question is a choice question (Choose One, Choose Many, 
Choose One with Image or Choose Many with Image), the combined question you can choose is 
the same choice question. If it is a Fill in the Blank question type, then the combined questions need to 
have the same number of topics and the same data type (text, number, date, etc.). For the matrix 
questions, the data points that you want to combine need to have the same number of rows, table sides, 
and the same data type for Fill in the Blank.
You can use all surveys, comment cards, file imports, and profiles that you have access to, including the 
My Surveys, Comments, File Imports, Shared Surveys, Other Users' Surveys, Speech Analytics, 
ForeSee, and Profiles folders. Surveys and profiles in the Design or Test mode are not shown. You can 
only add questions that are published in an open survey. You can add all question types as data points, 
but not such content as text,  code blocks, or sections.
You need to republish the data set after combining data points to update it for reporting.

Procedure 
1 On the Data Points page, click the data point that you want to combine with another data point.
2 In the Edit Data Point dialog box, on the toolbar, click the Combine Data Point button.
3 Select the survey, comment, profile, Speech Analytics project,  ForeSee project, or file import, from 

which you want to add a data point to the primary data point.

 Questions that are already added to the data set are inactive in the dialog box.

4 To search for the specific survey, comment, profile, Speech Analytics project, ForeSee project, or file 
import, type a partial or whole project name in the search box, and then click the Search button. The 
list of surveys, profiles, comments, Speech Analytics projects,  ForeSee projects, or file imports that 
match your input displays.

 Surveys and profiles in the Design or Test mode are not shown. Only published file imports are 
available in the File Imports folder.

5 Select the question that you want to combine with your previously added data point.
The system fields from all campaign types in the survey are available for the selection, if they match 
the data type of the selected data point. The following campaign specific system fields are available:
• Panelist ID, Email, and Mobile Number (for Panelist campaign)
• Email and Mobile Number (for Contact List campaign)
• Email (for Passcode campaign and comments)
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 The Mobile Number system field is available, only if SMS Surveys feature is enabled for the 
wokgroup.

 You can select only one question at a time.

6 Click Add. 
The data point is added to the primary data point.

7 Repeat the steps to combine more data points with the primary data point.

 You can also recode response options in your combined data points. 
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Change primary question in a data point
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button > click the data point name > Edit Data Point dialog box > Combine Data 
Point button.

The question with which you combine other questions in your data point is called a primary question. You 
need to set a primary question for your data point to map all other question responses in your data point 
to that question for recoding. You can change data point primary question once you combine different 
questions in the data point. The primary question is highlighted in gray and marked with the Star icon 

. You cannot delete a primary question.
By default, the first question in the data points is set as a primary question.
If you recode questions in your data point, and then want to change the primary question, you need to 
recode the questions again.
If you change the primary question after the data set is published, all other questions in the data point 

are indicated with the Warning icon . You need to republish the data set after changing the 
primary question to update it for reporting.

Procedure 
1 In the Edit Data Point dialog box, combine the questions in your data point with the primary 

question.
2 Select the check box next to the question that you want to set as primary.

 If you change the primary question, all the recoding you previously set is lost.

3 On the toolbar, click the Set as Primary button on the toolbar. The question becomes highlighted in 

gray and is marked with the Star icon .
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Delete a combined data point
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button > click the data point name > Edit Data Point dialog box > Delete button.

You can delete combined data points that you do not need anymore. You can also delete multiple 
combined data points at a time. You cannot delete the primary data point, to which you combine all the 

other data points. The primary data point is marked with the Star icon .
After deleting combined data points, you need to republish the data set to update it for reporting.

Procedure 
1 On the Data Points page, click the data point that you want to edit. 
2 In the Edit Data Points dialog box, select the check box next to the data point that you want to 

delete.
3 On the toolbar, click Delete. 
4 In the confirmation dialog box opens, click Delete.
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Delete a data point 
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button > click the data point name > Edit Data Point dialog box > Delete button.

You can delete data points and linked fields that you do not need anymore. You can also delete multiple 
data points and linked fields at a time. After deleting data points or linked fields, you need to republish 
the data set to update it for reporting. If you delete the identity data point, the linked fields in your data 
set are also deleted. You can add them again after choosing a new identity data point.
When you delete a data point, all report elements and filters that included the deleted data point are 
deleted too.

Procedure 
1 On the Data Points page, select the check box next to the data point or linked field that you want to 

delete.
2 On the toolbar, click Delete. 
3 In the confirmation dialog box, click Delete.
 



Data Sets Edit a data point

EFM User Guide 1222

Confidential and Proprietary Information of Verint Systems Inc.

Edit a data point
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button > click the data point name > Edit Data Point dialog box.

You can make the following changes to the data point:
• Add more questions to the data point or remove questions from it.
• Set a primary question for your data point to map all other questions' responses in your data 

point to that question for recoding.
• Set the report labels for a data point ahead of time to keep the labels consistent when you use the 

data in reporting.
• Recode questions combined together to fix reversed scales or adapt slightly mismatched 

questions.
 
You can view the following information on the data point for the reference:
• Data Type – Question type of the data point.

• Icons – The Star icon   indicates the primary question. The Warning icon   indicates 
the question thatis added to the data point but is not published yet.

• Title – Question heading plus the question text, separated by a period.
• Source – Survey or profile that the question is from.

Procedure 
1 On the Data Points page, click the data point name that you want to edit. 
2 In the Edit Data Point dialog box  with all questions that compose your data point, in the Title field, 

edit the data point name.
3 To add more questions to the data point, click  the Combine Data Point button.
4 To delete a question, select the check box next to the question that you want to remove, and then 

click the Delete button.
5 To change a primary question, select the check box next to the question that you want to set as 

primary, and then click the Set as Primary button. 

The Star icon  indicates the primary question.
6 To edit the settings used when reporting on the data point, click the Report Options button.
7 Fix the mismatched questions by using the Recode button.
8 Click Close. 

Your changes are saved.

 If you do not have permission to edit data sets, all functionality in the Edit Data Point dialog 
box is inactive.
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Edit linked fields
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button > click the data point name > Edit Data Point dialog box.

You can edit the title for your linked fields to identify them easier later.
You can view the Title, Data Type, Linked Source Identity Question, and the Data Set Identity 
Question boxes in the Edit Linked Field dialog box. The data type shows the question type of the 
linked field and is not editable.
The Linked Source Identity Question list contains all the Fill in the Blank or Short Answer type of 
questions from the survey that you want to link to your data set. The Data Set Identity Question list 
contains all the Fill in the Blank or Short Answer type of questions from your data set.
When the data set is published, you cannot edit the Linked Source Identity Question and the Data 
Set Identity Question information. Also if an unpublished data set contains linked fields from multiple 
projects, the Data Set Identity Question cannot be changed. To change it, you need to delete linked 
fields to have one linked source again.

Procedure 
1 In the Data Points grid, click the name of the linked field that you want to edit. 
2 In the Edit Linked Field dialog box, in the Title box, change the name of the linked field.
3 In the Linked Source Identity Question list, select the question that you want to set as an identity 

question in your data source.
4 In the Data Set Identity Question list, select the question that you want to set as an identity 

question in your data set.
5 To save the changes, click Save.
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Edit report labels and values
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
Add Data Points button > click the data point name > Edit Data Point dialog box > Report Options 
button.

You can set the report labels for a data point ahead of time to keep the labels consistent when you use 
the data in reporting. 
You can edit the report labels for the following question types:
• Choose One
• Choose One with Image
• Choose Many
• Choose Many with Image
• Fill in the Blank
• Short Answer
• Matrix with the Choose One and Choose Many sides
For the Choose One questions and the Choose One sides in the Matrix question, you can change the 
report and export values. For the Choose Many questions and the Choose Many sides in the Matrix 
question, you can change the export values.
When the export or report value is set for a choice, it is displayed instead of the choice index in the survey 
designer and is used as an identifier for the choice.
The following order of priority determines what value is displayed to the left of the choice:
• Export Value (if set)
• Report Value (if set)
• Choice Index
For example, if both export and report values are set to the choice, the export value will be displayed.
You can view a row for each response in a question. The ghost text shows the response labels and values 
that are used in the original question.
When you change the labels, labels that appear in the reporting are changed when this data point is used. 
It also changes the labels in the Recode Data dialog box accordingly. When you change the report 
values, it updates the calculations in report elements that use this data point. When you change the 
export values, it updates the exported values when you export the responses from this data point.

Procedure 
1 On the Data Points page, click the data point name that you want to edit. 
2 In the Edit Data Point dialog box, on the toolbar, click the Report Options button. 

The Edit Report Options dialog box opens.
3 In the Question Heading text box, edit the question heading.
4 In the Question Text text box, edit the question text.
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 For the Matrix question, you can switch between the topics and sides by clicking the Matrix 
Section list. When you switch between the sides, all changes are remembered.

5 In the Report Label section, edit the response text in the corresponding row.
6 In the Report Value section, edit the report value in the corresponding row.

 You can enter positive whole or decimal numbers for the report values. If you enter an invalid 

value, the warning icon  appears and an invalid value is reverted to an original one.

7 In the Export Value section, edit the export value in the corresponding row.

 You can use the Reset button to set all labels and values to the original labels and values. The 
Reset Side button in Matrix resets the currently selected side only.

8 Click Save.
9 Click Close.
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Recode a data point
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Data Points page > 
click a previously combined data point > Edit Data Point dialog box > Recode button.

You can recode questions that have been combined together in one data point to map similar data 
together, fix reversed scales, or adapt slightly mismatched questions. 
You can recode the following question types:
• Choose One
• Choose One with Image
• Choose Many
• Choose Many with Image
• Matrix with the Choose One and Choose Many sides
For Choose One and Choose Many questions, you can also recode the Please Specify text. The 
response with the Please Specify text is marked with an icon.
When you click the Recode button, the Recode Data dialog box opens, showing the following columns:
• Title – The title of the questions combined in one data point.
• Source – The data source that contains the corresponding question.
• Raw Label – The original label of the question choice.
• Report Label – The question choice label, which will be used for the data set. If you do not edit 

the report options, the original labels are used by default.
In the dialog box, the choices of the combined data points are displayed. The primary data point choices 
are in yellow and are not editable.
For the Matrix questions, you can select the side for data recoding in the Matrix Section list.
The  list of primary data point choices appears to the right of each choice of the secondary data point. By 
default, the choices of secondary data point are set to the matching options of primary data point. For 
the secondary data point choices that do not match the primary data point choices, the Not Set option is 
selected.
The data recoding does not impact the data present in the original source of the data point.

Procedure 
1 On the Data Points page, click the data point that you want to edit. 
2 In the Edit Data Point dialog box, on the toolbar, click Recode. 
3 In the Recode Data dialog box, in the Matrix Section list, select the Matrix question side that you 

want to recode. 
Your mapping is saved when you switch between the sides.

 This option is available only for the Matrix questions.

4 In the Report Label column, map the secondary data point choices to the primary data point choices 
by using the  list to the right of each secondary data point choice.
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 For the Choose Many questions, you can not select the same choice multiple times.

5 To set all your data mappings to the original values, click Reset. 
The Reset Side button in Matrix resets the currently selected side only.

6 After mapping all choices, click Save.
7 Click Close.
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Responses grid
Navigation

Data Sources tab > Data Sets tab > create a new data set or open an existing one > Responses tab.

You can view, export, and filter your data set responses. Responses are available after publishing or 
republishing the data set.
You can view the last time the data was updated to track all changes in your responses. The exact time of 
the update is displayed on the Responses page > Data Last Populated status. If the data set is not 
updated yet, the Pending status is displayed.
By default, the Responses grid displays the response data of 10 respondents, the dates they started and 
completed your survey, branched out and over quota dates, and the date you last modified their 
response data.
In addition, if your Responses grid is greater than one page in length, you can navigate between pages 
by clicking the page navigation arrows in the Responses grid.

In the Responses grid, click the Frequency Chart icon  to view the Frequency Chart that 
displays both the number and the percentage of respondents who answered the specified question.

Actions
The Actions menu provides you a number of options to customize your view of the Responses grid, 
filter responses, export responses, and more. 
The Actions menu includes the following options:
• View Data Type
• Columns
• Filter
• Clear All Filters
• Export
• Export Selected Responses to PDF

 Some options may appear dimmed on the Actions menu if no respondents are selected.

View Data Type
By clicking the Actions menu > View Data Type, you can specify what type of data you want to view in 
the Responses grid. 
The following options are available:
• Raw Data – Displays numeric values associated with responses.
• Choice Labels  – Displays text associated with responses.
• Export Values  – Displays values that you define in your survey. 

For example, if you want to display negative numbers in the Responses grid, specify this in the 
survey, and display it in the Responses grid.
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• Report Values  – Displays values that you define in your report. 

Columns
By clicking the Actions menu > Columns or the Columns button on the toolbar, you can specify which 
columns you want to display in the Responses grid. You can exclude the responses that you do not need 
in your report and include the respondent information that you want to use for reporting. For example, 
you can hide the Started survey date and display your respondents' Completed survey date.
You can add the following columns:
• Current Project – Lists the questions from the current project.
• Respondent Fields

• Record ID – Shows the unique ID number of the record.
• Preferred Contact Method – Shows the specified contact method information (Email or 

Mobile Number) for Contact List and Panelist campaigns.

 The mobile information is available only if SMS Surveys feature is enabled for the workgroup.

• Campaign Name – Shows the name of a campaign.
• Campaign Type – Shows the name of a distribution type.
• Started – Shows the date a respondent started the survey.
• Completed – Shows the date a respondent completed the survey.
• Branched Out – Shows the date a respondent was branched out of the survey.
• Over Quota – Shows the date a respondent reached the over quota limit.
• Last Modified – Shows the date when the survey was last modified.
• Campaign Status – Shows the campaign status, which is calculated only for the surveys that are 

in the Open or Closed status. There are the following campaign statuses: Sent, Confirmed 
Received, Started, Undeliverable, Completed, Bounced Back, Unsubscribed, Branched 
Out, and Over Quota.

• Culture – Shows the language culture that is used for the survey.
• Last Page – Shows the last page that the respondent visited.
• Response Source – Identifies where the survey response is coming from, for example, from 

intercept, mobile, or panel.
• Source Type – Shows the type of a source used to add participants, for example, manual entry, 

file, Web Service, active directory, survey, and so on.
• Task ID – Shows the unique ID number of the task.
• Occurrence – Shows the number of task occurrences.
• Referring URL – Tracks what triggered the intercept that the response is tied to.
• Web Browser’s User Agent – Shows the user agent of a web browser.
• Respondent’s IP Address – Shows the IP address of a respondent.
• Respondent’s Hostname – Shows the host name of a respondent.
• Data Source – Shows the name of the project that the response originated from and is 

consistent with the values shown in the Data Source column in the Data Points grid. When 
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applying a filter, the Data Source is available in the Participant Information section where the 
Value text box contains a list of project names for each data source used within the data set. If 
data point consists of more than one column, it has the Source N name with all the sources 
listed. N is the number of columns that are combined together in the data point.

• Key 1/ Key 2 / Key 3 – Shows the Require a Passcode data in the column.

 When the comment and survey fields exist in a single data set, the User Key 1 / OL 
ElasticSearch Id column is displayed in the Responses grid.

When only a comment  is available in the data set, the OL ElasticSearch Id column is displayed 
in the Responses grid.

• Panelists
• Panelist ID
• First Name
• Last Name
• Address 1
• Address 2
• City
• State/Province
• ZIP/Postal Code
• Country
• Phone Number
• Preferred Contact Method
• Panelist Culture
• External ID
• Health Score
• Is Subscribed
• Status

• Respondent System Information
• Record ID
• Browser Family
• Browser Version
• Operating System Family
• Operating System Name
• Device Type

• Respondent Location
• City
• State/Province
• ZIP/Postal Code
• Country
• Latitude
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• Longitude

Filter
By clicking the Actions menu > Filter or the Filter button on the toolbar, you can control what types of 
information to display in the Responses grid by defining custom filtering criteria. For example, you can 
exclude all responses that are larger than a certain value. 
In the Add Filter Criteria dialog box, in the Source list, data from the current project, columns, and 
profiles are available for defining the filtering criteria.
If data set contains at least one data point from a multi-campaign survey, you can add filtering criteria by 
Campaign Name and Campaign Type in the Participant Information source.

 If you select Campaign Name as a filtering field, text value field is available for input.

If you select Campaign Type as a filtering field, value list is available with all possible campaign 
types within all data set survey sources.
If you apply filtering by Campaign Name and/or Campaign Type, response data is available 
according to this filtering criteria.

Clear All Filters
By clicking the Actions menu > Clear All Filters option, you can remove any filter from the Responses 
grid. This means that responses will be displayed in the Responses grid based on the default view.

Export
By clicking the Actions menu > Export or the Export button on the toolbar, you can export data from 
the Responses grid into different file formats. Select the export file format from the list of file types, 
which includes CSV (Comma delimited), TSV (Tab delimited), Microsoft Excel, and SPSS. During the 
export process, you can customize how you want your data to be exported.

Export selected responses to PDF
You can export the responses to the Adobe PDF format. You can export single record or multiple records. 
For more information about exporting your responses to the Adobe PDF format, see Print Respondent 
Record, page 989.

Date Filter
By clicking the Date Filter button on the toolbar, you can display response data based on the time the 
respondents provided their answers. For example, you can set the date filter to include responses from 
surveys that respondents completed today or last year. You can also clear all date filters.
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Schedule Export
By clicking the Schedule Export button on the toolbar, you can schedule export and email delivery of 
the responses to the recipients to analyze answers externally. If there is an organization hierarchy defined 
for a workgroup, the responses export is scoped according to the task creator’s organization access. The 
report in the selected format will be attached to the email message in a ZIP archive.
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Panel tab
The Panel main tab enables you to add and filter panelists, create groups and profiles, access the link to 
your portal, and generate reports. Panelists may be a group of employees within a department or 
customers you want to solicit for information. 
There are five more tabs under the Panel tab: Panelists,  Profiles, and Filters. This topic provides a brief 
overview of all of them. 
• Panelists – Use this tab to add new panelists to your panel and manage their basic information. 

You can add panelists manually or import a panelists list into the panel. In addition, you can 
export a panelists list to the .csv, .tsv, and Microsoft Excel file formats. On the Panelists tab, you 
can also view the average panel health score, which shows the panelists' activity status. A number 
of factors determine the health score, for example, email opening rates, survey start and 
completion rates, and unsubscribe rates.

• Profiles – Use this tab to create new profiles. A profile is a collection of related questions that are 
often used to track information about a panelist. For example, a Contact Information profile 
may contain questions about a panelist's home or company address, phone number, and email. 
Information gathered about each panelist is then used to help you determine which panelists are 
the best candidates to complete your surveys.

• Filters – Use this tab to create filters based on panelist profiles, activity status, or advanced 
features, such as Original Source of Panelist and Portal Membership Status. Panel filters 
help you compile a list of participants that closely meet the survey criteria.

 The portal functionality is only available in EFM if you purchase the EFM Online Community 
Builder product.
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Panelists page overview
Navigation

Panel tab > Panelists tab.
On the Panelists tab, you can add new panelists to your panel and manage their basic information. You 
can add panelists manually or import a panelists list into the panel. In addition, you can export a panelists 
list to the .csv, .tsv, and Microsoft Excel file formats. The average panel health score on the Panelists tab 
shows the average activity rate of panelists.
The Panelists grid provides information about each panelist added to the panel.  In the Panelists grid, 
the following columns are available:
• Panelist ID – Unique record ID of the panelist in the EFM database.
• Email – Email address of the panelist.
• First Name and Last Name – First and last names of the panelist.
• Address 1 and Address 2 – Address at which the panelist resides. You can provide more than 

one address.
• City – City in which the panelist resides.
• State/Province – Sate or province in which the panelist resides.
• Country – Country in which the panelist resides .
• Health Score – Average activity rate of the panelist.
• Is Subscribed – Status that shows whether the panelist is subscribed to your surveys.
You can sort panelists in the grid by clicking the column heading. To change the width of a column, drag 
its edge. At the bottom of the Panelists grid, you can adjust the number of panelists that are displayed 
on one page. The default number of panelists per page is 10; however, you can select up to 100 panelists 
to be displayed in the grid.

Average panel health score
The Average Panel Health Score link is located in the upper-right corner of the Panelists grid; it is 
based on the average health score for the entire panel, and it is updated daily. The health score shows the 
average activity rate of the panelist. A number of factors determine the health score, for example, email 
opening rates, survey start and completion rates, and unsubscribe rates.
On the Report & Analyze tab > Panel Reports tab > Average Panel Health page, you can generate 
reports on the overall growth of the panel membership and on the Average Panel Health Score over 
certain periods. For more information, see Panel Reports tab, page 1262.

 For panelists who are not invited to surveys or campaigns, the health score is N/A and is not 
included in the overall Average Panel Health Score.

The health score is a value from 0 to 100%. A health score that equals to or is less than 25% is an 
unhealthy rating and is highlighted in red in the Panelists grid. A health score that equals to or is greater 
than 75% is a healthy rating and is highlighted green in the Panelists grid. Other health score ratings are 
not highlighted. An administrator can change the healthy panel threshold on the Administration tab. 
See General Setup, page 1406 for details.
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Actions  menu options
On the Panelists page, on the Actions menu, you can select the following options:
• Choice Labels – Turn the response text on or off.

• Select On to view the actual responses that you can see in the survey designer, for example, "Yes," 
"No," and "Somewhat."

• Select Off to view the raw numerical values for the question responses, for example, "1," "2," and 
"3."

• Health Score Highlighting (Rows) – Turn highlighting of the Health Score column values on 
or off.
• Select On to enable highlighting of panelist health scores shown in the Health Score column.
• Select Off to remove highlighting of panelist health scores shown in the Health Score column.

• Filter – Apply a custom filter to the Panelists grid to view the panelists who only meet certain 
criteria. You can create filters based on panelist profiles, activity status, or advanced features. For 
example, you can filter by panelists, whose first name is Richard. For more information about 
managing filters, see Filters tab, page 1256.

• Import – Upload a file with a list of panelists to the panel. You can import .csv, .tsv, .xlsx, .txt, and 
.zip file formats. The contents of the .zip file is scanned before extraction to check whether it 
contains the supported file formats. The first line in a file must contain only identifying headers 
going from left to right. Each panelist entry must start from a new line in the file.

A B C D E

External ID First Name Last Name Culture Email

12345 Lisa Mayer en-US lisa@hotmail.com

12346 Roger Black en-US rblack@gmail.com

12347 Bill White en-US Billie@yahoo.com

Import file example in Microsoft Excel

 You can save a Microsoft Excel document to the .csv or .tsv file format by using the Save As 
option.

During the import process, new panelists are added to the panel and existing panelists are updated. If 
a row contains an invalid email address, it is not imported. Panelists are identified by External ID. If no 
External ID is available during import, the system uses an email address as the External ID.

• Export – Export a list of panelists and their basic information into different file formats. Profile 
data is not exported. You can export into .csv, .tsv, or Microsoft Excel file formats.

 If you export data with the Choice Labels option enabled, you cannot import the data back into 
the panel.
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• View Panelist History – View the surveys and campaigns history of a selected panelist. You can 
print panelist history details.
• Surveys history includes survey name, last action, and date for each survey sent to the panelist.
• Campaigns history includes survey name, invitation status, date, and campaign status for each 

survey to which the panelist has been invited.

 The surveys list only includes Invite Panelists and profile surveys, which are surveys built from 
the profile questions.

• Delete Selected Panelists – Make the selected panelists inactive. In the Manage Participants 
window, you will not be able to select a deleted panelist to take your surveys until you activate the 
panelist on the Panelists tab. For the steps on activating a deleted panelist, see Activate deleted 
panelists, page 1239.

Add panelists
In addition to importing a panelists list into your panel, you can add panelists manually by using the Add 
Panelist button. To add a panelist, you should provide the following information about the panelist:
• Email
• Panelist’s Display Name (optional)
• First Name (optional)
• Last Name (optional)
• Address 1 (optional)
• Address 2 (optional)
• City (optional)
• State/Province (optional)
• ZIP/Postal Code (optional)
• Country (optional)
• Phone Number (optional)
• Mobile Number (optional)
• Preferred Contact Method (set automatically)

When a new panelist is added (or an existing panelist is updated by file import), and a Mobile 
Number exists for this panelist, Preferred Contact Method is automatically set to Mobile Number 
(if SMS feature is defined within the workgroup by System Administrator). Otherwise, it is set to Email.
For all existing panelists, Preferred Contact Method is set to Email by default. You can change it to 
Mobile Number manually if needed.
When sending a survey invitation to a panelist with both Email and Mobile Number specified, the 
Preferred Contact Method value is used to define whether to send invitation via email or via SMS.

• External ID (optional)

 If you do not provide any external ID, the system sets the panelist's email address as the external 
ID value.

• Culture (optional)
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You can also add a panelist to one or more portal groups.
You can view all the panelist information on the Manage Participants page when adding a specific 
panelist to the Invite Panelists campaign.
After you added a new panelist, click OK. The Add Panelist dialog box remains open for you to continue 
adding more panelists. Click the Close button to exit the dialog box.
 

Edit panelists
You can change the panelist's basic information by clicking the Panelist ID link of a particular panelist. 
The Edit Panelist dialog box opens where you can make changes and click the Apply button to save 
your edits.

Filter  menu options
On the Filter menu, the following options are available:
• Customize Filter – Create a filter and apply it to your Panelists grid to view only the panelists 

that meet your criteria. You can apply a previously created filter by selecting it on the Apply 
Saved Filter  menu.

 Click the Activity or Advanced section title to expand it.

• Show All Stars – View all panelists who have health score rating of 75% or greater.
• Show Unhealthy Panelists – View all panelists who have health score rating of 25% or less.
• Show Deleted Panelists – View all panelists who have a status of Deleted.
To remove the applied filter, click the Clear link above the Panelists grid.

Delete panelists
You can remove panelists from your panel by clicking the Delete button on the Panelists toolbar. A 
deleted panelist does not receive any invitations or reminders from your surveys. Additionally, in the 
Manage Participants window, you will not be able to select a deleted panelist to take your surveys until 
you activate the panelist on the Panelists tab. 

Search
Using the Search option, you can quickly find a panelist in the Panelists grid. Type a partial or whole 
panelist's first name, last name, or email address in the search field and click the Search button. The list 
of panelists that matches your input is displayed.

Import panelists list

Procedure 
1 On the Panelists page, on the Actions menu, click Import.
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2 In ther Import Panelists into the Panel dialog box:
a. Click Browse to navigate to the file that you want to upload. You can import .csv, .tsv, .xlsx, .txt, 

and .zip file formats. The contents of the .zip file is scanned before extraction to check whether it 
contains the supported file formats. For faster uploading, compress your files.

 All date and time values must be imported in Coordinated Universal Time (UTC) format.

b. Select the file, and then click Open.
c. Click Next.

3 In the Map Fields dialog box, match the imported file columns to the corresponding panelist field 
names, and then click Next.

4 Click Import.
The imported panelists list is displayed in your Panelists grid.

Activate deleted panelists

Procedure 
1 On the Panelists page, on the Filter menu, click Show Deleted Panelists.

The filter is applied, and all deleted panelists appear in your Panelists grid.
2 Click the Panelist ID link of a deleted panelist.
3 In the Edit Panelist dialog box, on the Status menu, click Active.
4 Click Apply.

The panelist is activated and appears in your Panelists grid again.

 To browse through the list of panelists, click the previous or next link in the Edit Panelist dialog 
box.

5 Click the Clear link above the Panelists grid to remove the applied filter and view the active panelists 
on your panel.

Manage columns
You can add more columns to the Panelists grid, including the columns from other surveys.

 Generate Link surveys do not have this option.

You can only add columns from other surveys if they are the same survey type.
1 On the Panelists toolbar, click Columns.
2 In the Columns dialog box, click the red arrow next to the folder that you want to add columns from 

(Panelists, Campaign History, Profiles, or Surveys).
3 Select the check box next to the column that you want to add to your Panelists grid or clear the 

check box next to the column that you want to remove from the Panelists grid.
4 To save your changes, click Apply.
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Excel export restrictions
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new one > 
Analyze tab > Responses tab > Export menu > Microsoft Excel option.

If you export a large amount of responses to Microsoft Excel, which may consume a lot of memory, the 
export is restricted. In such case, you are offered to export responses to the .csv file format. If you agree, 
the system automatically exports all data to the .csv file, which you try to export to Microsoft Excel. You 
can open the .csv file with Microsoft Excel.

Export large data sets to Microsoft Excel

Procedure 
1 On the Export menu, select Microsoft Excel. 
2 In the export restriction dialog box, click the Export to CSV button. 
3 In the Export Responses dialog box, select the appropriate options, and then click Next. 
4 Click the download link. 
5 In the File Download dialog box, click Save.

Export large panelist data to Microsoft Excel

Procedure 
1 Go to the Panel tab > Panelists tab.
2 On the Actions menu, point to Export, and then click Microsoft Excel. 

For the large datasets, the export is restricted.
3 Click the Export to CSV button. 
4 In the Export Panelists dialog box, click the download link, and then save the file.
5 Import the saved .csv file into Microsoft Excel.
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Panel Health Score
Navigation

Panel tab > Panelists tab > Panelists grid > Health Score column.
EFM's proprietary health scores provide administrators with an immediate overview of respondent history, 
both at the individual panelist and aggregate panel levels. Numerous factors go into determining the 
health score including email open rates, survey start and completion rates, and unsubscribe rates.
With the Health Score functionality, you have great flexibility in viewing "star panelists" with one click on 
the panelists Filter  menu (Show All-Stars). This is a great shortcut for quickly identifying panel stars for 
a focus group follow up, for example. Similarly, you can select the Show Unhealthy Panelists option 
for consideration of deletion or other actions with a single click.

Panelist Activity and the Panelist's Health Score
If the Panelist has not been invited to any surveys or campaigns, their health score will appear as "N/A" 
and will not be factored into the panel overall Average Health Score. 

View Panelist History
To view a particular Panelist's history, use the View Panelist History functionality.

Procedure 
1 On the Panelist grid, select a  check box next to the desired panelist.
2 On the Action menu, select View Panelist History. The Panelist History dialog box displays. The 

dialog box defaults to the Surveys tab and displays the Survey Name, Last Action, and Date for 
each survey the Panelist has been sent. 

3 In the Panelist History dialog box, select Send to Printer to print the current page. 

 Also available from this Surveys dialog box tab is the Panelist's name and current health score. 
Only Workgroup and Profile Surveys are included in the list.

Campaigns tab
The Campaigns tab is also available in the Panel History dialog box and provides the campaign history 
of each panelist.
To view a particular Panelist's campaign history, use the View Panelist History functionality, but select 
the Campaigns tab when the Panel History dialog box displays.

Procedure 
1 On the Panelist grid, select a  check box next to the desired panelist.
2 On the Action menu, select View Panelist History. The Panelist History dialog box displays. The 

dialog box defaults to the Surveys tab.
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3 In the Panelist History dialog box, select the Campaigns tab. This tab displays the Survey Name, 
Invitation Status, Date, and Campaign Status for each survey the Panelist has been sent.

4 Select Send to Printer to print the current page.

Campaign action status definition
• Undeliverable – An immediate notification from the server that can be caused by numerous 

reasons.
• Bounced Back – Email did not make it to the participant and bounced back from server or email 

address.
• Unsubscribe – Opened the email, but clicked the unsubscribe link. Will remove user from all 

future mailings.
• Opened Email – Opened the email but did not click the survey link.
• Survey Started – Opened the email and clicked the survey link.
• Completed Survey – Completed and submitted your survey.

Show All Stars and Show Unhealthy Panelists
Show All Stars and Show Unhealthy Panelists are available on the Filter menu. 

Show All-Stars
To show Panelists that have a high rating, use the Show All-Stars functionality.

Procedure 
1 On the Filter menu, select Show All-Stars.
2 A list is generated based on your Administrator's designated threshold for this status. Thresholds are 

set on the Administration main page. 

 Panelists above or at this percentage will have scores highlighted in green in the Panelists list. The 
threshold is based on a 1%-100% score scale, where 1 is very bad and 100 is excellent.

Show Unhealthy Panelists
To show Panelists that have a low rating, use the Show Unhealthy Panelists functionality.

Procedure 
1 On the Filter menu, select Show Unhealthy Panelists.
2 A list is generated based on your Administrator's designated threshold for this status. Thresholds are 

set on the Administration main page.

 Panelists below or at this percentage will have scores highlighted in red in the Panelist grid. The 
threshold is based on a 1%-100% score scale, where 1 is very bad and 100 is excellent.
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Health Score Highlighting
Health Score Highlighting – A health score for each panelist is available. The health score is a weighted 
value on a 0% to 100% scale, where anything 25% and under is unhealthy and 75% and above is healthy. 
This is the default setting.
Health Scores are presented with color-keying to quickly identify good/bad thresholds. By default, the 
healthy score for each panelist will present as:
• Green, bold if above 75% – healthy
• Red, bold if below 25% – unhealthy
• All other percentages display in black
Administrators have the ability to change the preset thresholds. This option is located on the 
Administration tab. 

Procedure 
1 Click the Configuration tab > General Setup tab.
2 Click inside the Healthy Panel Threshold text box and enter a number for the Healthy Threshold (1-

100).
3 Click inside the Unhealthy Panel Threshold text box and enter a number for the Unhealthy 

Threshold (1-100).
4 Click Save Setup.

Selecting Columns to Display
Administrators can select what data columns are visible on the Panelists tab. Create the report that you 
want by selecting the columns you want to display. 

Procedure 
1 On the Panelists page, click the Columns button.
2 In the Column dialog box, select the check box next to the column names that you want to display.
3 Click Apply.

 You can filter data based on selected columns, based on basic profiles, or custom profile data by 
using the Filter button. In addition, you can also sort by columns in the grid to get the most 
relevant Panelists' view. Once you acquire your desirable information in the grid, simply export to 
.csv (column delimited), .tsv (tab delimited) or Microsoft Excel format. Export is available on the 
Actions menu.

Average Panel Health Report
Available from the Report & Analyze tab > Panel Reports tab > Average Panel Health option. This 
report provides the health of your Panel over time.

Procedure 
1 Go to the Report & Analyze tab > Panel Reports tab > Average Panel Health option.
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2 The Average Panel Health page displays. 

 You have the ability to filter the report by date, email the report, or display for printing.
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Deactivating the Health Score Updates
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Collect tab > Overview dashboard.

For the Invite Panelists surveys, you can send emails that are not counted towards the panelist health 
score so that you can send emails without surveys. If panelist takes the survey with the Disable 
panelists health score updates for the survey check box selected, the panelist health score and 
average panel health score are not affected. By default, this check box is clear.
You can deactivate the panelist health score updates on the Overview dashboard.
If the unsubscribe link is included in the email and the user clicks the link, the user's health score becomes 
zero.

Procedure 

1 On the Overview dashboard, click the  icon, and then click the Advanced Properties option.

 The Advanced Properties option is available for the Invite Panelists surveys only.

2 To deactivate the health score updates, select the Disable panelists health score updates for the 
survey check box.

3 Click Save.
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Profiles tab
Navigation

Panel tab > Profiles tab > Profiles page.
A profile is a collection of related questions that are often used to track information about a panelist. For 
example, a profile labeled Contact Information might contain questions about a panelist's home 
address, work address, and phone number. A panelist might be included in one or more profiles. It is 
recommended, but not required that each profile contain related questions about the panelists. The 
Basic Information profile is the default profile that is included in all Workgroups. It contains exactly 
what the name infers basic information to include Email, First Name, Last Name, External ID, and 
Culture. 

 The Basic Information profile cannot be edited or deleted from the Profiles tab. Basic 
Information for each panelist is created when you select Add Panelist on the Panelist page. The 
Add Panelist dialog box displays.

Design Profile
Design your profiles similar to how you would design your survey. Notice how the User Interface is similar 
to the Survey Designer page. Create your profile questions as you would in the Survey Designer. See 
Choose One questions, page 247 and Choose Many questions, page 249.

 Profiles are always rendered in Classic survey rendering mode with no option to change it. For 
more information about survey rendering modes, see Survey rendering overview, page 414.

You can navigate to the Design Profile page by clicking the New button on the Profiles toolbar or if you 

have an existing profile you want to edit, click the  icon next to the profile you want to edit. 

Create a profile

Procedure 
1 On the Profiles toolbar, click the New button. 
2 In the Name Your Profile dialog box, in the Profile Name text box, enter a name for your profile.
3 Click OK.

Duplicate a profile

Procedure 
1 On the Profiles page, select a check box next to the profile that you want to duplicate.
2 On the toolbar, click the Duplicate button. 
3 In the Duplicate a Profile dialog box,  in the Profile Name text box, enter a name for your profile.
4 Click OK.
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 Select Include all reports associated with this survey check box if you want to include the 
reports that were associated with the original profile. In addition, note that this copy process will 
create a new, unpublished profile without any of the responses that were received in the original 
profile.
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Insert profile questions or data
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Analyze tab > Design tab >  Add a Question panel > Add from Library option > Insert Item dialog 
box > Profile Questions tab.

You can insert profile questions and data into your survey to pipe information from the Panel and 
Profiles into your survey. This functionality is available for the Invite Panelists surveys only.
Adding profile questions to the survey offers three key benefits:
• Profile questions function as library questions in that the design can be applied to multiple 

surveys.
• Profile question data is automatically preselected for each panel member added to the survey 

participant list. This means that pre-existing demographics for survey respondents is available for 
use in survey response analysis without having to ask repeatedly. Once inserted into the 
questionnaire, profile questions can be hidden from participant view.

• If profile questions remain visible to allow respondents to update existing demographics, the 
updates can be transferred to the participant panel data directly from the survey.

 You can use Step-by-step mode only to add, remove, and apply properties to your profile 
questions.

Profile questions added to the survey are locked from any updates but you can access the following 
properties for this question:
• Appearance (read and write access)

• Show Question Heading
• Show Question

• Validation & Logic (read access)
• Custom Properties

To edit the profile question, go to the profile designer.

 When you export a survey containing profile questions to another Workgroup, the profile 
questions are lost and need to be added to the survey again.

When you add multiple campaigns to your survey, profile questions for the Invite Panelists campaign 

are hidden from the respondents that belong to other campaign types, and the  icon appears next to 
the question heading in the survey designer.

Insert profile question into your survey

Procedure 
1 In the Add a Question panel, click the Add from Library option.
2 In the  Insert Item dialog box, click the Profile Questions tab.
3 In the Profiles menu, select the profile with the question that you want to insert. 
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4 In the Questions menu, select the check box next to the question that you want to add to your 
survey. You can select multiple questions to be added to your survey at a time in the order they 
appear in the Questions menu.

 You can preview the selected question in the right pane.

5 Click OK.

Insert profile data into your survey

Procedure 
1 Click any question, and then click in the question text field.  The editing toolbar for this question 

appears.
2 Click the  icon in the question edit box. 
3 In the Insert Piped Value dialog box, click the Profiles tab.
4 In the Panel Profile menu, select the profile with the question that you want to insert.
5 In the Field menu, select profile data that you want to pipe into your survey.
6 Click OK.

 You can update the profile information provided by panelists when responding the survey by 
using the Update Profiles option in the Actions menu on the Response Manager page. For 
more information, see Update profiles, page 1255.
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Create and edit profiles
Navigation

Panel tab > Profiles tab.
On the Profiles page, you can create and manage your profiles to gather information about each panelist 
and determine the best candidates to complete your surveys. You can create profiles manually in a profile 
designer or import an EFM profile file. 
The Profiles grid provides you information on each profile you created. You can sort profiles by clicking 
the column heading. To change the width of a column, drag its edge.
In addition, you can display more or fewer profiles in the Profiles grid. At the bottom of the page, a 
toolbar enables you to adjust the number of profiles that appears on one page. The default number of 
profiles per page is 10, but you can select up to 100 profiles to appear on the Profiles page.

The Profile page

 To manage all profiles, select the check box in the upper-left corner of the Profiles grid.

In the Profiles grid, the following columns are available:
• Posted to Portal – Shows whether the profile is active and posted to the portal. This column 

appears only if the Online Community Builder add-on product is installed.
• Profile Title – Shows the name of the profile.
• Unpublished Changes – Shows whether all changes are published and present in the live profile.
• Last Modified – Shows the last time when a user made changes to the profile.
• Modified By – Shows the name of a user who made changes to the profile.
• Design – Opens a profile designer where you can edit your profile.
• Analyze – Opens a report designer where you can create and edit reports on your profile.

 For information on creating a profile in a profile designer and duplicating a profile, see Create a 
profile, page 1246 and Duplicate a profile, page 1246.

Publish or apply changes to a profile
After editing a profile, you need to publish it to update your live profile.
• For an unpublished profile, select the profile in the list, and then, on the toolbar, click Publish.
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• For a published profile that has changes, select the profile in the list, and then, on the toolbar, click 
Apply Changes.

 You can view the publishing status of a profile  in the Profiles grid, in the Unpublished Changes 
column.

Activate or deactivate a profile
After designing a profile, you can activate it to make this profile visible in your portal. Note that the 
Activate button is available only if the Online Community Builder add-on product is installed.
• To activate a profile, select the inactive profile in the list, and then,  on the toolbar, click Activate.
• To deactivate a profile, select the active profile in the list, and then,  on the toolbar, click 

Deactivate.

 You can view the status of a profile in your portal  in the Profiles grid, in the Posted to Portal 
column.

Rename and delete a profile
• To rename a profile, select a check box next to the needed profile, and then, on the toolbar, click 

Rename.
• To delete a profile, select a check box next to the needed profile, and then, on the toolbar, click 

Delete.
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Add profile
Navigation

Panel tab > Profiles tab.
You can create a profile by importing it from a Microsoft Word (.doc and .docx) or EFM profile file (.que). It 
is possible to use the profile designer to create a prototype for the profile, and then download the profile 
to create the .que file. In addition, you can select a Microsoft Word document as the profile source. Be 
sure to include formatting for questions, text, and comments. You may use the Microsoft Word document 
example link in the Upload Profile dialog box as a reference for your profiles as well.

Before you begin 
• Verify that the file to be uploaded does not contain Modern survey rendering features. 

Otherwise it will not be uploaded.

Procedure 
1 On the Profiles page, click Upload.
2 To navigate to the file you want to upload, in the Upload Profile dialog box, click Select. 

The available file formats are Microsoft Word (.doc and .docx) and EFM survey file (.que).
3 Select the file, and then click Open.

 The OK button becomes available after you upload a file.

4 Click OK. The profile is created from the selected file.

 You can download a Microsoft Word example by clicking the Microsoft Word Survey link in the 
Upload Profile dialog box.
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Upload a profile
Navigation

Panel tab > Profiles tab.
You can create a profile by importing it from a Microsoft Word (.doc and .docx) or EFM profile file (.que). It 
is possible to use the profile designer to create a prototype for the profile, and then download the profile 
to create the .que file. In addition, you can select a Microsoft Word document as the profile source. Be 
sure to include formatting for questions, text, and comments. You may use the Microsoft Word document 
example link in the Upload Profile dialog box as a reference for your profiles as well.

Before you begin 
• Verify that the file to be uploaded does not contain Modern survey rendering features. Otherwise 

it will not be uploaded.

Procedure 
1 On the Profiles page, click Upload.
2 To navigate to the file that you want to upload, in the Upload Profile dialog box, click Select. The 

available file formats are Microsoft Word (.doc and .docx) and EFM survey file (.que).
3 Select the file, and then click Open.
4 Click OK. 

 The OK button becomes available after you upload a file.

The profile is created from the selected file.

 You can download a Microsoft Word example by clicking the Microsoft Word Survey link in the 
Upload Profile dialog box.

 



Panel page Edit a profile

EFM User Guide 1254

Confidential and Proprietary Information of Verint Systems Inc.

Edit a profile
Navigation

Panel tab > Profiles tab.
You can edit your profile by adding, deleting, or changing the questions as needed.

Procedure 
1 In the Profiles grid, click the name of the profile that you want to edit.
2 In the profile designer, change your profile questions.

The changes are saved automatically in the profile designer.

 To publish your profile, that is to apply changes to your live profile, in the profile designer, click 
the Apply link.
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Update profiles
Navigation

Design & Collect tab > Surveys tab > My Surveys page > open an existing survey or create a new one > 
Analyze tab > Design tab >  Add a Question panel > Add from Library option > Insert Item dialog box 
> Profile Questions tab > Profiles menu >  select the profile with a question you want to insert in your 
survey.

You can update the profile information provided by panelists when responding to the survey by clicking 
the Update Profiles option in the Actions menu, on the Response Manager page.

Before you begin 
• Verify that panelists answered the survey that was previously sent to them.

Procedure 
1 To access the Response Manager page, select the Analyze tab, and then click the Responses tab.
2 In the Actions menu, click Update Profiles.
3 To copy all of the answers to any borrowed questions back to the panelist’s profile, in the Update 

Profiles dialog box, click OK, and then click Close.
The panelist’s profile is updated.

 Updating profiles will overwrite the already-existing profile information.
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Filters tab
Navigation

Panel tab > Filters tab > Filters page.

Panel filters help you compile a list of participants who meet the survey criteria. On the Filters page, you 
can create filters based on panelist profiles, activity status, or advanced features. All your filters are saved 
in the Filters grid, so you can use previously created filters to quickly build a list of survey participants.
On the Filters toolbar, you can use the following options to manage panel filters:
• New – Open the Filter dialog box where you can create a new filter and use it to compile a list of 

participants that meet your survey criteria.
• Delete – Remove the selected filter from the Filters grid.
• Share – Allow other users to access your filter.
You can also apply a previously created filter by selecting it from the Apply Saved Filter  menu in the 
Filter dialog box.

 To view the filter options under the Activity or Advanced section, click its title.

 

Activity section
You can filter panelists based on their activity status in your survey. The following options are available 
under the Activity section:
• Last Sent Invitation (days) – Filter panelists who have been sent the invitation to a survey 

during a specified date range.
• Number of Invitations Received – Filter panelists who received a certain number of invitations 

in the last N days.
• Never Invited – Filter panelists who have never been invited to take your surveys.
• Never Participated – Filter panelists who have been invited to take your surveys, but have never 

started a survey.
• Number of Surveys Completed – Filter panelists who completed a certain number of surveys in 

the last N days.
• Last Survey Started (days) – Filter panelists who started the survey during a specified date 

range.
• Last Completed Survey (days) – Filter panelists who completed the survey during a specified 

date range.
• Last Survey Status – Filter panelists who have the Invited, Started, or Completed last survey 

status.
• Health Score – Filter panelists who have a specified health score. You can also filter the panelists 

who have the N/A heath score.
• Is Subscribed – Filter panelists who are subscribed to or unsubscribed from your surveys.
• Include deleted – Filter panelists who have the Deleted status on the Panelists tab.
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Activity section

Advanced section
You can filter panelists based on advanced features. The following options are available under the 
Advanced section:
• Original Source of Panelist – Filter panelists based on how they are added to the panel.
• Added to Panel (days) – Filter panelists based on when they are added to the panel.

 The Portal Membership Status and Portal Group Assignment options are available if you 
have the EFM Online Community Builder product.

• Portal Membership Status – Filter panelists based on their status in your portal. The available 
options are Not Yet Invited, Invited, But Not Registered, Registered, but Unconfirmed, 
and Registered Panelist.

• Portal Group Assignment – Filter panelists based on the portal group to which they belong.
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Advanced section

Create a new filter based on panelist profile

Procedure 
1 On the Filters page, click the New button.
2 In the Filter dialog box,   in the Filter Name text box, enter the title of your filter.
3 Click the Add button or Add Filter Criteria link.
4 In the Add Filter Criteria dialog box, in the Source list, select the source data for your filter.

Add Filter Criteria dialog box
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5 Select the field, expression, and value by which you want to filter panelists. For example, to filter 
panelists whose first name is Richard, select First Name = Richard.

6 Click the Add button.
The new filter appears in the Filter dialog box.

 You can use a toolbar to add, duplicate, move up, move down, or delete your filter criteria.

7 Click OK.
The filter appears in the Filters grid.

Edit Your Filter

Procedure 
1 On the Filters page, click the name of the filter that you want to edit.
2 In the Filter dialog box, edit the filter criteria.
3 Click OK.

Share Your Filter

Procedure 
1 On the Filters page, select the check box next to the filter taht you want to share with other users.
2 On the Filters toolbar, click the Share button.

The appropriate icon appears next to the shared filter.

 If you no longer want to share your filter, select the check box next to the filter, and then click the 
Share button. The icon next to that filter disappears.
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Panel filtering – additional options
Navigation

Panel tab > Filters tab > Filters page > New button > Filter dialog box > Activity section.

You can use additional filtering options based on the panelists activity.

The additional filtering options in the Filter dialog box

You can filter the panelists by number of completed surveys and received invitations to compile a list of 
participants who meet the survey criteria. You can also access the filtering while adding the panelists on 
the Manage Participants page.

Number of Invitations Received
You can filter panelists who received the invitation to take a survey in the last N days. Filtering is based on 
the number of surveys they have been invited to, not the number of emails they have received to take a 
survey. For example, if a participant received one initial invitation and three reminders for the same 
survey, they are counted as one "invite" for this filter, not four. For the transactional surveys scenario or 
the scenario where the same panelist can be asked to take the same survey more than once, invitations 
are counted as one. If you manually change the invitation status to Invitation Sent, it counts towards 
this filter.
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Number of Surveys Completed
You can define the date range for the survey completion by entering the number of days in the Time 
period (days) text box. If the time period is not defined, the filter includes no time limit.

 For more information about the panel filtering, see Filters tab, page 1256.

Filter panelists by the number of invitations received

Procedure 
1 On the Filters page, click the New button. 
2 In the Filter dialog box, click the Activity section to expand it.
3 Select the Number of Invitations Received check box.
4 Select the expression from the adjacent drop-down list. The following expressions are available:

• Equal To
• Not Equal To
• Less Than
• Greater Than
• Less Than Or Equal
• Greater Than Or Equal

5 Enter the number of invitations received during the specific date range in the text box to the right of 
the Expression  list.

6 Define the date range of the invitations received by entering the number of days in the Time period 
(days) text box. If the time period is not defined, the filter includes no time limit.

7 To save the filter, click Apply Filter.
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Panel Reports tab
Navigation

Report & Analyze tab > Panel Reports tab > Panel Size Report or Average Panel Health option.

The Report & Analyze tab > Panel Reports tab provides access to two Panel reports:
• Panel Size Report – Provides information on the growth of your Panel. This report provides you 

how many panelists were added or deleted, by month, as well as a chart view of the information.
• Average Panel Health – Provides information on your Panel's health over time. This report 

provides you the Average Panel Health, by month, as well as a chart view of the information.
You have options from the reporting pages to filter the data by date, email the report, or print the report.

Create a Panel Size Report

Procedure 
1 Go to the Report & Analyze tab > Panel Reports tab > Panel Size Report option.

The Panel Size Report

From this page, you have the option to filter the data by selecting the Date Filter button. Restrict the 
results to a specific time period or choose to include all data. See the Date Filter dialog box below.
In addition, you have the option to print the report or send a copy via email. Click the appropriate button 
to perform these functions.

Create an Average Panel Health Report

Procedure 
1 Go to the Report & Analyze tab > Panel Reports tab > Panel Size Report option.
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The Average Panel Health Report

From this page, you have the option to filter the data by selecting the Date Filter button. Restrict the 
results to a specific time period or choose to include all data.
In addition, you have the option to print the report or send a copy via email. Click the appropriate button 
to perform these functions.
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Library tab
Navigation

Library tab > Questions tab.

You can access a variety of information that can be created and stored for the later use.

 The Library tab is available if you have the Library Items permission. To assign permission to 
the needed user role, contact your Group Administrator.

On the Library page, the following tabs are available:
• Questions – Questions that are stored at this location can be used in multiple surveys without 

recreating the question each time. On this side tab, you can add new questions, and then add 
them to your Question Library.

• Hierarchical Questions – Hierarchical questions can be used  in your survey when your 
participants are presented with several choices. The choices with which participants are presented 
are based on their answers to previous steps in the question hierarchy.

• Choice Lists – Different lists of choices/responses that can be inserted as answer options for a 
question within your survey.

• AutoDropdowns – AutoDropdown list of choices from which you can choose, and then insert 
them into your surveys.

• Page Blocks - Page blocks allow you to add groups of questions from the library rather than 
individual questions, to build surveys.

• Code Blocks – Code blocks that you can add to your own JavaScript code in the survey. You can 
add code blocks to the library to reuse them in your surveys later.

• Text Blocks – Text blocks that you can create to add descriptive text about a section or 
instructions for your questions. You can add text blocks to the library to reuse them in your 
surveys later.

• Survey Templates – Survey that you (as well as other users) can use as a template by adding it 
to your Survey Template list at this location. This can make the process of creating surveys quicker 
and more efficient. In addition, users have access to several templates that come with the 
product.

• Survey Themes – Survey themes are used to quickly control the look and feel of questionnaires. 
Survey consists of the questionnaire itself and all steps needed to create, publish, receive, and 
analyze the results.  The application uses standard CSS and HTML header files to create themes. 
These files can be created and/or modified by users with the appropriate permissions or role.

• Report Themes – Similar to Survey Themes, a default theme can be assigned to your report or 
you can create a customized report theme that you can apply to your reports.

• Language Packs – Language pack contains the default validation messages, labels, and end 
pages of the survey in a certain language. You can store, export, import, and delete the language 
packs at this location. When you create a new survey or change the language of your survey, the 
language pack is applied to your survey in the closest matching language automatically.

• Image Manager – Your images can be uploaded, placed  in different folders, and you can edit 
them. Then you can insert the images into your survey questions, reports, themes, etc. You can 
also remove the images you do not need anymore.
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• Media Manager – Your media  can be uploaded and placed  in different folders. Then you can 
insert the media into your survey questions, reports, themes, etc. You can also remove the media 
you do not need anymore.

Add a question to the question library

Procedure 
1 On the Library tab > Questions tab, click New.
2 In the Add Library Question dialog box, enter a name for your question.
3 In the Questionnaire list, all of your available surveys are displayed. Select your survey from the list.
4 In the Questionnaire list, questions for the selected survey are displayed. When you select a survey 

question, it is previewed in the right display pane.

 There is the Add All link in the question drop-down, which enables you to add all questions from 
the selected survey into the library as a group or individually.

5 Specify a category for your library question. 
You can select a category from the  list or create a new category list name by entering a new name in 
the text box.

6 To add the question to the library, click OK.

 Select the Allow editing of this question check box  if you want to grant other users the ability 
to modify this question once they add it to their survey.

Delete a question

Procedure 
1 To delete a question from the library, select the question, and then click Delete.
2 To confirm, in the confirmation dialog box, click OK. 

To terminate the action, click Cancel.

Edit a question
You can only edit a question from the library if it is defined as Editable.  The Allow editing of this 
question check box that is available when you create a new library question, determines whether the 
question is editable. 
If there is a Yes status in the Editable column, the question will be editable once you insert it into your 
survey. If this column has a No status, then you must use the question in its current state. When you 
change the text in the editable question, it will be updated only in the survey where you make the 
changes.

 In this grid, all columns (Name, Question, Category, and Editable) can be sorted. Click the 
heading name once for ascending order or twice for a descending order sort.
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Adding library questions
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new survey or open an existing survey 
> Design tab > Content tab > Add menu or Add a Question section > click Library Question.

When you create a survey, you can use questions from the library to design your survey quickly and 
efficiently. Library questions are managed by the Library Manager for the later use by any survey 
designer in your environment. Questions in the library can be open or locked. The design of a locked 
library question cannot be modified and serves as a standard for your organization surveys.
If the library question is locked, you cannot edit the question but you can edit the following question 
properties:
• Show Question Heading
• Visibility
The locked library question is marked with the lock sign.

Procedure 
1 On the Design tab > Content tab > Add a Question section, click the Library Question button. 
2 In the Insert Item dialog box > Library Questions tab, questions are sorted by categories.

 If your survey contains at least one question or other content, you can add a library question by 
clicking the Add button or the Add  menu.

3 In the Categories list, select the category with the library question that you want to insert. 
4 In the Questions list, select the check box next to the question that you want to add to your survey. 

You can select multiple questions to be added at a time in the order they appear in the Questions 
list. 
Question preview is available in the right pane.

 You can add only one External ID question to your survey.

5 Click OK. 
The selected library question is added to your survey.
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Adding other content from library
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new survey or open an existing survey 
> Design tab > Content tab > Add menu or Add a Question section > click Add from Library.

When you create a survey, you can add text blocks and code blocks from the library to design your survey 
quickly. You can create code blocks and text blocks  for the later use, and then add them to your survey.

Procedure 
1 On the Design tab > Content tab > Add a Question section, click the Add from Library button. 

 If your survey contains at least one question or other content, you can add code blocks and text 
blocks by clicking the Add button or the Add menu.

2 In the Insert Item dialog box, click the Other Content tab.
3 In the Categories list, select the Code Blocks or Text Blocks option. The Text Blocks is a default 

option.
4 In the Elements box, the list of available code blocks appears. Select the check box next to the item 

that you want to add to the survey. You can select multiple items to be added to your survey in the 
order they appear in the Elements list.

 You can preview the selected element in the right pane.

5 Click OK. 
The selected element is added to your survey.
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Library Hierarchical Questions tab
Navigation

Library tab > Hierarchical Questions tab.

With hierarchical questions, you can create multiple-choice questions in your survey. The presented 
choices are based on the participant’s answer to a previous step in the question hierarchy. 
For example, in a survey that relates to car or truck manufacturers and models, you want to provide your 
participants with choice selections. Let us say that your question is “What type of automobile do you 
drive?” You create a hierarchical question that includes a “Manufacturer” list and add Honda, Ford, Chevy, 
etc. to the list. As a second step to this question, you also specify the model of the vehicle. So, you add 
“Model” as a sublist, and in that list you add all models for each manufacturer, such as Honda where you 
enter models like Accord, Civic, Pilot, etc.
With the help of hierarchical questions, participants can answer your survey quickly and easily. As they 
click manufacturer, for example, they are presented with choices of Honda, Ford, Chevy, and any other 
type of manufacturer you want to add as a choice. Based on their choice of manufacturer, they are 
presented with a group of model choices from which to choose. For instance, if the user selected Chevy, 
then they could be presented with Malibu, Corvette, Impala, etc.

Tips for hierarchical questions
• Your list in each step appears in alphabetical order.
• You can select the Preview tab at any time to see how your hierarchical question looks before 

inserting it into your survey.
• Question heading and question text are required when creating your hierarchical question.
• You can use the Delete button to remove the choices associated with a particular list item. This 

does not remove the whole step.
• Use the Remove Previous Step and Add Step options to delete or add steps within your 

hierarchical process, respectively.

 Hierarchical Questions are only available with the EFM Enterprise Edition.

 Feedback Intelligence Users, hierarchical questions are not available for export to Feedback 
Intelligence and should not be used if you require your data to be exported to the Feedback 
Intelligence product.

On the Library page, with Hierarchical Questions you can do the following:
• New – To create a new hierarchical question, select New.
• Duplicate – To duplicate a question, select the check box next to the question that you want to 

duplicate, and then click Duplicate.
• Delete – To delete a question, select the check box next to the question that you want to delete, 

and then click Delete.
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Create a new hierarchical question

Procedure 
1 Go to the Library page > Library tab > Hierarchical Question tab > click New.
2 On the Questions tab of the hierarchical question editing page, enter a name for your question, your 

Question Heading text, and add your question to the Question Text area. You can also provide 
additional instructions to the question in the Instructions text box.

 In the Classic survey rendering mode, instructions text is not displayed in the survey. Starting 
with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. In the 
future EFM releases, the Classic survey rendering will not be supported.

3 Create a List Caption (optional), and then click OK.
4 On the Text tab, create your first Step Label by typing the name.

 You will actually see the words Step Label in the text box. Replace the text with your own label 
name.

In the example below, Step Label is replaced with Genre, and three choices are added to the choice 
text box.

5 To activate the New, Edit, and Delete buttons, click the Add Step link.

 When you click Add Step, a new step text box is added to the right of the current step label text 
box, so that you can continue your hierarchical steps.

You can specify the sort order of your choices on the Sort menu. With the User Defined sort order, 
you can change the choices order by clicking the arrows next to each choice.

6 To add a sublist to any choice (that you have just added), select one of your choices in the first step 
list, and then click Add Step.
For example, select the genre of your choice, and it displays with a green highlight. Click the New 
button (under the second Step Label), and the Add Multiple Choices dialog box opens. Enter each 
choice in a separate line in the text box, and then click OK. Your choices are added into the next step 
label text box.

 You can specify Choice Values for your Choice Names by entering [Choice Label]=[Choice Value], 
for example, English=EN. A Choice Value is stored as the response and is displayed in the 
response manager and reporting. If no Choice Value is entered, the Choice Name is used as the 
Choice Value.

7 Type in a Step Label for your sublist. 
Continue this process until you have completed all hierarchical choices and added all your steps and 
sublists. 

8 To save, click OK.
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 For the Modern survey rendering, you can choose not to display the steps with 1 or 0 items in a 
survey by selecting the Hide steps with 1 or 0 items in the list from rendering in Survey 
check box at the bottom of the Text tab.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

Preview a hierarchical question
You can preview your hierarchical question by clicking the Preview tab. You can access the Preview tab 
when creating a new hierarchical question or editing an existing one. 

Create a hierarchical question with  the Web Service option

Procedure 
1 Go to the Library page > Library tab > Hierarchical Question tab > click New.
2 On the hierarchical question editing page, enter a name for your question, your Question Heading 

text, and add your question to the Question Text area.
3 Create a List Caption (optional).
4 Select the Web Service tab.
5 Type in the URL of your Web Service Database.
6 Type in the Step Labels (one per line, for example, Make, Model, Year).
7 To confirm, click OK.

To terminate the action, click Cancel.

 The Web Service option is used to integrate with your Web Service client. If you need more 
information about Web Services, contact the EFM Services Department.

Example of using a Web Service
For example, you create a Web Service call that gets a list of choices from an external database. When 
your survey participant selects a choice from step one, the Web Service is called with that choice as an 
argument, it then goes to the external database, takes the choices associated with that list, and populates 
the next step’s drop-down.
The same process occurs when your participant selects a choice from second step’s list. Again the Web 
Service is called with that choice as an argument, goes to the external database, takes the choices 
associated with that list, and populates the next step. This process will continue based on how many 
steps are in your hierarchical question. Each time a step needs to be populated with choices, your Web 
Service is called.
See Also Reference: The W3C defines a Web Service as a software system designed to support 
interoperable machine-to-machine interaction over a network. Web Services are frequently just Web APIs 
that can be accessed over a network, such as the Internet, and executed on a remote system hosting the 
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requested services. Web Service definition can be found on the following Wikipedia Web site: 
http://en.wikipedia.org/wiki/Web_service

Add a hierarchical question to a survey

Procedure 
1 On the My Surveys page, create a new survey or open a saved survey.
2 On the Design tab, in the Add a Question panel, click Add from Library.
3 In the Insert Item dialog box, click the Hierarchical Questions tab.
4 Select the check box next to the hierarchical question that you want to add to the survey. 

You can select multiple questions to be added at a time in the order they appear in the Questions 
list.

 You can preview the selected question in the right pane.

5 Click OK.

Edit a hierarchical question

Procedure 
1 Go to the Library page > Library tab > Hierarchical Question tab.
2 On the Hierarchical Questions page, click the name of the hierarchical question that you want to 

edit.
3 On the hierarchical question editing page, make your changes, and then go back to the Library page.

 If the hierarchical question has been published in a survey, you can no longer add or remove 
steps in it. Changes to step lists are reflected immediately in the published survey.

http://en.wikipedia.org/wiki/Web_service
http://en.wikipedia.org/wiki/Web_service


Library page Previewing a Hierarchical Question

EFM User Guide 1274

Confidential and Proprietary Information of Verint Systems Inc.

Previewing a Hierarchical Question
Navigation

Library tab > Hierarchical Questions tab > Hierarchical Questions page > create a new question or 
open an existing one > Preview tab.

You can preview your hierarchical question by clicking the Preview tab.  You can also view a translation for 
your hierarchical question by selecting the corresponding language in the Language list.

 On the Preview tab, a hierarchical question is displayed as in the Modern survey rendering.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

The Preview feature is only available with the Enterprise edition of EFM. If you want to upgrade from 
Professional to Enterprise, see Contact us, page 50 for company contact information.

 To see how the HierarchicalQuestion works within your survey, you must first insert it, and 
then publish your survey.
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Translate Hierarchical Question
Navigation

Library tab > Hierarchical Questions tab > Hierarchical Questions page > create a new question or 
open an existing one.

You can add translations to your hierarchical questions to ensure better survey experience for 
respondents with different language backgrounds.

Procedure 
1 On the Library page, select the Hierarchical Questions tab.
2 Click the name of the hierarchical question that you want to translate. 

OR 
To create a new question, click New.

3 On the hierarchical question editing page, click the Translations tab.
4 To add the translation language for your hierarchical question, click the Add Language button.
5 To export your hierarchical question to the .csv, .xlsx, .xliff, or .zip file formats, click the Export 

button.

 To export and import the hierarchical question translation, follow the same procedures as for the 
survey translation export and import. For more information, see  Translations import and export , 
page 429.

6 In the exported file, translate all the strings of the hierarchical question to the added language, and 
then save the file.

 You can add multiple languages to your hierarchical question and provide multiple translations in 
a single file.

7 To import the question translation back into the EFM product, click the Import button.
When translating a survey containing the hierarchical question into the corresponding language, the 
translated question appears in the survey translation editor.
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Hierarchical Question "Required" option
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > create a new survey or open an existing one > 
Design tab > Content tab > Add menu or Add a Question section > click the Validation & Logic 
section > Options section >  Answer Required check box.

You can make the hierarchical questions required. The Answer Required check box is available for you 
to require survey participants to answer the hierarchical questions. This option applies to the whole 
hierarchical question, which means that survey participants need to answer the full question before 
moving to the next page or submitting the survey.

 You can view how your hierarchical question works within your survey in the Test or Preview 
mode.

Make all Hierarchical Questions required

Procedure 
1 On the Design tab, click the Bulk Edit link. 
2 In the dialog box, select the Answer Required check box.
3 Click the Apply All link. 

All questions in your survey become required.
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Library Choice Lists tab
Navigation

Library tab > Choice Lists tab.

You can create a library of choice lists and use them later during your create-a-survey process. When you 
create a question in your survey and want to add response choices quickly, you can insert a choice list 
that you have previously created and saved in your library.

Add a choice list to your library

Procedure 
1 On the Library tab, click the Choice Lists tab.
2 On the toolbar, click New.
3 In the Add Library Responses dialog box, enter a name for your choice list, and then type each 

choice on a separate line.
4 To save your changes, click OK.

Edit a choice list

Procedure 
1 On the Choice Lists page, click the name of the choice list that you want to edit.
2 In the Edit Library Responses dialog box, make your changes, and click OK.

Delete a choice list

Procedure 
1 On the Choice Lists page, select a check box next to the choice list that you want to remove, and click 

Delete.
2 In the confirmation dialog box, click Delete.

Duplicate a choice list

Procedure 
1 On the Choice Lists page, select a check box next to the choice list that you want to duplicate.
2 Click Duplicate.

 To manage all choice lists, select the check box next to the Name title in the grid.

You can sort your choice lists in ascending or descending alphabetical order by clicking the 
Name title on the toolbar.
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Library AutoDropdowns
Navigation

Library tab > AutoDropdowns tab.

With the AutoDropdowns feature, you can create choice responses on a  menu format. When you create a 
question in your survey you can insert the AutoDropdown list that you have previously created and filed 
in your library.
To manage the AutoDropdown lists, click the following buttons on the toolbar:
• New – Create a new AutoDropdown list.
• Duplicate – Duplicate the selected AutoDropdown list.
• Delete – Remove the selected AutoDropdown list.

 AutoDropdowns can only be used with the Fill in the Blank and Short Answer questions.

Create an AutoDropdown

Procedure 
1 Go to the Library tab > AutoDropdowns tab.
2 On the Autodropdowns page, click New.
3 In the Add AutoDropdown dialog box, enter the name for your AutoDropdown, and then type your 

options on separate lines.

 You can specify Choice Values for your Choice Labels by entering [Choice Label]=[Choice Value], 
for example, English=EN. A Choice Value is stored as the response and is displayed in the 
response manager and reporting. If no Choice Value is entered, the Choice Label is used as the 
Choice Value.

4 To confirm, click OK.

Edit an AutoDropdown

Procedure 
1 Select the AutoDropdown that you want to modify.
2 In the Edit AutoDropdown dialog box, make your changes, and then click OK.

Delete an AutoDropdown

Procedure 
1 Select a check box next to the AutoDropdown that you want to remove, and then on the toolbar, click 

Delete.
2 In the confirmation dialog box, click Delete.
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Duplicate an AutoDropdown

Procedure 
1 Select a check box next to the AutoDropdown that you want to duplicate.
2 Click Duplicate. 

In the AutoDropdown grid, the duplicated AutoDropdown with "(2)" at the end of its name appears.
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Library Page Blocks
Navigation

Library tab > Page Blocks tab.

You can define groups of multiple questions based on  the type of survey being conducted. EFM can store 
these questions individually, but you can also group questions together as a page block that can be 
added to a survey to save time and ensure accuracy.
To manage the page blocks,  on the toolbar click the following buttons:
• New – Create a new page block.
• Delete – Remove the selected page block.

 The Delete button is active only when at least one page block in the grid is selected.

Create a new Page Block

Procedure 
1 Go to the Library tab > Page Blocks tab.
2 On the toolbar, click New. 
3 In the Add Page Block dialog box enter the title of a new page block in the Name text box. It is 

limited to 64 characters.
4 In the Description text box, enter how and when this page block should be used  (optional).
5 Specify a Category for your page block.

You can select a category from the list or create a new category list name by entering a new name in 
the text box.

6 In the Questionnaire list, select the questionnaire from your available surveys.
7 In the Page Block list, select the page block you want to insert.

A portion of the page block is displayed in the preview.
8 Click Add. 

The page block appears in the grid.

Delete a Page Block

Procedure 
1 Go to the Library tab > Page Blocks tab.
2 Select the check box next to the page block that you want to delete, and click Delete. 
3 In the confirmation dialog box, click Delete. 

The selected page block is removed from the library.
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Library Code Blocks
Navigation

Library tab > Code Blocks tab.

You can use code blocks to add your own JavaScript code to the survey. You can add code blocks to the 
library to reuse them in your surveys later. 
To manage the code blocks,  on the toolbar click the following buttons:
• New – Create a new code block.
• Duplicate – Duplicate the selected code block.
• Delete – Remove the selected code block.

 The Duplicate and Delete buttons are active only when at least one code block in the grid is 
selected.

Create a new code block

Procedure 
1 Go to the Library tab > Code Blocks tab.
2 On the toolbar, click New. 
3 In the Add Code Block dialog box, in the Name text box, enter the title of a new code block. It is 

limited to 64 characters.
4 Type your code, and then click Add. 

The code block appears in the grid.

Duplicate a code block

Procedure 
1 Go to the Library tab > Code Blocks tab.
2 Select the check box next to the  code block that you want to duplicate.
3 On the toolbar, click Duplicate. 

The duplicate of the code block appears in the grid below the original code block. The name of the 
duplicate is the original code block name followed by the next incremental number, for example, Code 
Block (2).

Edit a code block

Procedure 
1 Go to the Library tab > Code Blocks tab.
2 In the grid, click the name of the code block that you want to edit. 

The Edit Code Block dialog box opens.
3 Edit your code.
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4 To save your changes, click OK.

Delete a code block

Procedure 
1 Go to the Library tab > Code Blocks tab.
2 Select the check box next to the code block that you want to delete, and click Delete.
3 In the confirmation dialog box, click Delete. 

The selected code block is removed from the library.
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Code Blocks – Role-based access
Navigation

Administration tab > Roles tab.

The survey administrator can control if the workgroup members can get access to adding and editing 
their custom code blocks.
By default, code blocks editing is enabled for the predefined roles and disabled for the custom roles.
When code editing is disabled for a user role, the Code Block functionality becomes hidden for the user 
in the following places:
• Survey designer page > Design tab > Content tab > Add menu
• Survey designer page > Design tab > Content tab > Add panel
• Library tab > list of tabs
If you do not have the permission to add and edit your custom code blocks, you can still add the 
predefined code blocks from library. The predefined code blocks cannot be edited. For more information 
on library questions, see the Adding other content from library, page 1269.

Procedure 
1 On the Roles tab, click the name of the role that you want to edit. 
2 On the Edit Role page, in the Experience section, select the Edit Code Blocks check box.
3 Click Save.
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Library Text Blocks
Navigation

Library tab > Text Blocks tab.

Text block is a non-question content. You can add text blocks to the library to reuse them in your surveys 
later. 
To manage the text blocks,  on the toolbar click the following buttons:
• New – Create a new text block.
• Duplicate – Duplicate the selected text block.
• Delete – Remove the selected text block.

 The Duplicate and Delete buttons are active only when at least one code block in the grid is 
selected.

Create a new Text Block

Procedure 
1 Go to the Library tab > Text Blocks tab.
2 On the toolbar, click New. 
3 In the Add Text Block dialog box, in the Name text box, enter the title of a new text block. It is 

limited to 64 characters.
4 Type your text. 

You can customize the text and add images or media by using the editing toolbar.
5 Click Add. 

The text block appears in the grid.

Duplicate a Text Block

Procedure 
1 Go to the Library tab > Text Blocks tab.
2 Select the check box next to the text block that you want to duplicate.
3 On the toolbar, click Duplicate. 

The duplicate of the text block appears in the grid below the original text block. The name of the 
duplicate is the original text block name followed by the next incremental number, for example, Text 
Block (2).

Edit a Text Block

Procedure 
1 Go to the Library tab > Text Blocks tab.
2 In the grid, click the name of the text block that you want to edit. 
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3 In the Edit Text Block dialog box, edit your text. 
You can customize the text and add images or media by using the editing toolbar.

4 To save your changes, click OK.

Delete a Text Block

Procedure 
1 Go to the Library tab > Text Blocks tab.
2 Select the check box next to the text block that you want to delete, and click Delete. 
3 In the confirmation dialog box, click Delete. 

The selected text block is removed from the library.
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Library Survey Templates  tab
Navigation

Library tab > Survey Templates tab.

The Survey Templates tab displays templates that accompany the product and provides you the ability 
to add new templates. You can use a survey that you or other users have created as a template by adding 
it to your library. This feature makes creating surveys quicker and more efficient.
On the actions toolbar, the following options are available:
• New – Create a new survey template.
• Delete – Delete the selected survey template.

 Click the Template button to sort your survey templates in ascending or descending order.

Add a new template

Procedure 
1 On the toolbar, click New.
2 In the Add Library Template dialog box, type a name for the template.
3 In the Select a survey section, select a survey to add as a template.
4 Click OK. 

Template is added to your library.

Use the template you added to your library

Procedure 
1 Go to the Surveys tab, on the New menu, click Use a Template. 
2 In the Survey Templates list, all survey templates from your library appear.
3 In the Use a Template dialog box, select the needed template, and then click Create Survey.

 An example of what the template looks like is provided in the Preview pane.

Delete a template

Procedure 
1 Go to the Survey Templates tab.
2 Click the check box next to the template that you want to delete, and click Delete.

 You can only delete templates that do not have the lock icon .

3 Click Delete. 
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4 In the confirmation dialog box, click Delete.
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Survey themes
Navigation

Library tab > Survey Themes tab.

Themes are used to quickly control the look and feel of your surveys using a CSS view or HTML format. 
You can create new themes, copy, edit, or delete your themes, and set your default theme for new 
surveys.
In the Survey Themes grid, the following columns are available:
• Name – Name of the survey theme. 
• Group – Name of the survey theme group (User Defined, Featured, Standard, or Legacy).
• Last Modified by – Name of a user who last edited a survey theme.
• Last Modified – The last time when the survey theme was edited.
• Default – Denotes a survey theme set as default for all surveys.

 If a survey theme is marked with the locked icon, you cannot edit or remove it.

To manage tasks, use the following options on the toolbar:
• New – Create a new theme.
• Duplicate – Make a copy of a theme by selecting the check box next to the theme that you want 

to copy.
• Set as Default Theme – Set your default theme by selecting the check box next to the theme 

that you want as your default.
• Delete – Delete a survey theme by selecting the check box next to the theme that you want to 

delete.
• Search – Search for a survey theme by its name.

 You cannot edit original survey themes included in the EFM application. You must first duplicate 
an original theme and give the duplicated theme a new name before modifying it.
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Create a survey theme
Navigation

Library tab > Survey Themes tab > click the New button.

You can create a new survey theme and control the look and feel of your surveys using a CSS view or 
HTML format. Your customized theme will work for all device types.

Procedure 
1 On the Survey Themes page, click the New button.
2 To edit the default theme name, click Untitled.
3 In the Survey Rendering list, select the Classic or Modern survey rendering modes to support your 

ongoing or customized survey.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

4 In the Select a Base Theme list, select the theme on which you want to create your custom theme.
5 On the Fonts, Survey Colors, Button Colors, Images, and Miscellaneous tabs, set options to 

customize the look and feel of your survey.
6 To view the survey appearance, click the Preview in New Window button.

 On the top of the page, you can click the Return to Library link to go back to the Library > 
Survey Themes page.

Create a survey theme in a CSS view

Procedure 
1 On the Survey Themes page, click the New button.
2 On the Create a Survey Theme page, click the CSS button, and then click the Upload button.
3 In the Upload dialog box, click the Choose file button to select your CSS file.
4 To upload the CSS file for your survey theme, click OK.

 Go to the CSS Tutorial, page 1297 for tips on creating your own theme.

Create a survey theme in an HTML view

Procedure 
1 On the Survey Themes page, click New.
2 On the Create a Survey Theme page, click the HTML button, and then click the Upload button.
3 In the Upload dialog box, click the Choose file button to locate your HTML file.
4 To upload the HTML file for your survey theme, click OK.
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 To save the current content as a file, and then use an alternate editor to make changes, click the 
Download button.

To replace the current tab content with the changes made with the alternate editor, click the 
Upload button.
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Manage a survey theme
Navigation

Library tab > Survey Themes tab.

You can copy, delete, edit, and set your default survey theme.

Duplicate a survey theme

Procedure 
1 On the Survey Themes page, select the check box next to the theme that you want to duplicate.
2 Click Duplicate. 

 The name of the duplicated survey theme is the original survey theme name followed by the next 
incremental number, for example, “Cotton (2)." To edit the default theme name, click the name 
that you want to change.

Delete a survey theme

Procedure 
1 On the Survey Themes page, select the check box next to the theme that you want to delete.
2 On the toolbar, click Delete.
3 In the confirmation dialog box, click Delete.

Edit a survey theme

Procedure 
1 On the Survey Themes page, click the name of the theme that you want to edit.
2 To edit the CSS or HTML of a survey theme template, click the CSS or HTML buttons respectively.

 If you rename a theme, any surveys using that theme will revert to the default theme when the 
survey is republished.

Set your default theme

Procedure 
1 On the Survey Themes page, select the check box next to the theme that you want to set as default.
2 Click Set as Default Theme.
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 After you make a theme your designated to be default, a green check mark appears in the default 
column for that particular theme.
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Survey themes quick filters
Navigation

Library tab > Survey Themes tab > Survey Themes page > Quick Filters option.

You can filter the survey themes by using the Quick Filters option. Quick filters are predefined filters you 
can use to quickly get to the survey themes you need.

The Quick Filters links

The following options are available:
• All Themes – View all the survey themes you have access to.
•  My Themes – View all themes that you created.
• User Defined Themes – View only all the customized survey themes.
• Featured Themes – View only all the precreated featured survey themes.
• Standard Themes – View only all the precreated standard survey themes.
• Legacy Themes – View only all the precreated legacy survey themes.

 Use the Search option to quickly find the required survey theme in the Survey Themes grid.

When you apply a filter to the survey themes, a notification describing the current filter appears above 
the Survey Themes grid. You can cancel the quick filter by using the clear link.

The Current Filter notification
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Survey theme designer
Navigation

Library tab > Survey Themes tab  > Survey Themes page  > New button on the toolbar.

You can customize the appearance of your survey theme by setting particular options on the Fonts, 
Survey Colors, Button Colors, Images, and Miscellaneous tabs.

 You cannot use the Look and Feel view of a survey theme designer to set styles for the custom 
themes, created before the 8.0 release.

On the Fonts tab, select among a number of editing options for section heading, question heading, 
question text, response text, column headers, validation messages, and button labels. Standard options 
include:
• Font Name
• Bold
• Italic
• Underline
• Font Color
On the Survey Colors tab, select the necessary color in the RGB sliders (Red, Green, and Blue) and HSB 
(Hue, Saturation, and Brightness). The color of the following elements can be modified:
• Response (On Hover)
• Response (Selected)
• Check Box (Background)
• Radio Button (Background)
• Table Header
• Table Row (Odd)
• Table Row (Even)
• Table Border
• Accent Colors

 You cannot change the color of Response(On Hover) and Response (Selected) in the Classic 
survey rendering mode.

• Slider (Handle)
• Sloder (Selection)
On the Button Colors tab, change the color of text, background, border, background (on hover), and 
border (on hover) for the following buttons:
• Next Button
• Back Button
• Reset Button
• Save Button
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• Jump Button
On the Images tab, change images for radio button (clear), radio button (selected), check box (clear), 
check box (selected), page background, logo, and star rating. You can also change the style of a page 
background. The following options are available:
• Fit Horizontal
• Fit Vertical
• Stretch
• Tile
• Center

 Images for radio button (clear), radio button (selected), check box (clear), and check box 
(selected) should be 16x16 pixels for both Classic and Modern survey rendering modes. Larger 
images should be additionally customized.

 Starting with the EFM 15.1 FP3, the Classic survey rendering is unavailable for new workgroups. 
In the future EFM releases, the Classic survey rendering will not be supported.

On the Miscellaneous tab, select the color in the RGB sliders (Red, Green, and Blue) and HSB (Hue, 
Saturation, and Brightness) for the following elements:
• Page Background
• Progress Bar (Incomplete)
• Progress Bar (Complete)
• Validation Message (Background)
• Validation Message (Border)
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Survey themes – HTML template keywords
Navigation

Library tab > Survey Themes tab  > Survey Themes page  > New button on the toolbar > HTML view.

You can use the predefined HTML keywords to edit the HTML template of your survey theme.

HTML template 
keywords

Description

%PROGRESS_BAR% Places the progress bar HTML at the given location.

%BUTTONS% Places all survey buttons at the given location.

%TAG_LINE% Places the tag line HTML at the given location.

%CONTENT% Places the survey content at the given location.

%LOGO% Places the logo HTML at the given location.

%FORM% Is supported to enable the functioning of previously created 
themes.

%SURVEY_TITLE% Is supported to make title shown in the survey by default.

 If the %FORM% keyword is present in the template, all new keywords are ignored. 
If the %FORM% keyword is missing in the template, the new keywords are used.

If the %SURVEY_TITLE% keyword is present, the survey title is rendered in its own <h1> outside 
the %CONTENT% placeholder.
If the %SURVEY_TITLE% keyword is missing, the survey title is rendered in a forced section 
heading inside the %CONTENT% placeholder.
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CSS Tutorial
You can use CSS to customize the look and feel of your survey theme. For example, use CSS to adjust the 
position of elements on the screen or to change the background color of your survey theme. EFM 
enables you to upload your own CSS files. You can use the following elements in the CSS file you upload 
to EFM.

 If you are creating your own CSS file, you will need these CSS elements in your CSS file for the 
Survey Themes to work. It is recommended that you use the EFM provided theme titled Default 
as the basis for new themes, as the essential structure for both CSS and HTML pages are 
provided. First, make a copy of the Default theme, rename the copy, and make the desired 
changes.

Global

CSS Element What it modifies

.body The entire document

.hr The <hr /> horizontal lines

.h1 Heading format text

 

Questions

CSS Element What it modifies

.section-heading Section headings

.question-heading Question headings

.question-text Question text

.choice-text Text labels of choices

.text-block Non-question text blocks

 

Tables

CSS Element What it modifies

.category-row Table category rows



Library page CSS Tutorial

EFM User Guide 1298

Confidential and Proprietary Information of Verint Systems Inc.

CSS Element What it modifies

.anchor-row Table category rows

.choice-row Table choice rows

.total-row Non-topic rows

.odd-row Odd topic rows (3,5,7)

.even-row Even topic rows (2,4,6)

.topic-text Topic column

 

Progress Indicator (every progress indicator is made up of table cells)

CSS Element What it modifies

.progress-table Do not modify this unless you are very familiar with CSS

.completed-cell Change the color of completed cells

.uncompleted-cell Change the color of uncompleted cells

 

Properties
Click inside the { } braces on the line with the property you want to edit.
In the upper-right area of the screen, look for the property you want, for example:

CSS Property What it modifies

background-color Background color

font-family Font name or font family name

font-size Font size

font-style Font style (bold, italic, etc.)

To learn more about CSS elements, visit the W3C's Web site below.
http://www.w3schools.com/default.asp

http://www.w3schools.com/cssref/default.asp
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Report Themes
Navigation

Library tab > Report Themes tab > Report Themes page.

You can create new report themes, copy, edit, and delete the existing themes, and set the selected theme 
as your default theme for all your reports. Report themes help you to control the appearance of your 
report. 
To manage the report themes, you can select the following options:
• New – Create a new theme in a report theme designer.
• Duplicate – Duplicate the selected report theme.
• Set as Default Theme – Set the selected theme as your default theme for all your reports.
• Delete – Remove a report theme from the library.
• Search – Search for a report theme by its name.

 You cannot edit or delete the locked   themes.

By default, the Report Themes grid shows the first 10 report themes. To view more saved report 
themes per page, click the View per Page option at the bottom of the Report Themes grid. Select the 
25, 50, or 100 link to display more report themes. In addition, if the Report Themes grid is longer than 
one page, you can navigate between the pages clicking the navigation arrows in the lower-right corner.

 For the steps on how to create and edit the report themes, see Report Theme Builder, page 1301.

Duplicate a Report Theme

Procedure 
1 In the Report Themes grid, select the report theme that you want to copy. 

Once selected, the report theme is highlighted in brown.
2 On the toolbar, click Duplicate. 

A duplicate of the report theme appears in the right pane. The name of the duplicate is the original 
report theme name followed by the next incremental number, for example, Khaki (2).

Delete a Report Theme

Procedure 
1 In the Report Themes grid, select  a theme.
2 On the toolbar, click Delete. 
3 In the confirmation dialog box, click Delete.
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Edit a Report Theme

Procedure 
1 In the Report Themes grid, click the name of the report theme that you want to edit. The report 

theme designer opens.
2 Make your changes. Your changes are saved automatically.

Set a Default Report Theme

Procedure 
1 In the Report Themes grid, select a report theme.
2 On the toolbar, click the Set as Default Theme button. 

The selected report theme is set as your default theme for all your future reports.

 The check mark   appears in the Default column next to your default report theme.
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Report Theme Builder
Navigation

Library tab > Report Themes tab > Report Themes page  > click the New button > create a new theme 
or select an existing one > click the Edit button > report theme designer.

With the report theme designer, you can create and edit themes that specify default appearance and 
formatting properties for the report elements. 
You can define properties for the various report elements and the overall theme using the following tabs:
• General Appearance, page 1301
• Chart Appearance, page 1302
• Table Appearance, page 1302
• Text Appearance, page 1303

General Appearance
On the General Appearance tab, you can select the template and background color for your report, add 
a logo, and specify the logo position in your report.
• Template – Use the list to select a template for your report. 

The default templates are as follows:
• Cotton
• Khaki
• Worldwide Blue
• Plain Color
• Default

• Background Color – Select from a palette, the background color for your report. Select from a 
range of colors in the Web Palette, RGB Sliders, HSB (Hue, Saturation, and Brightness), and HSV 
(Hue, Saturation, and Value). If you know the hexadecimal value of a color, you can enter it 
manually or click Custom Color to adjust red, green, blue, hue, saturation, and black level values.

 The Background Color option is only active if the Plain Color option in the Template  list is 
selected.

• Choose Logo – Click the button to add an image or a brand logo to your report. Click the Clear 
button to delete the logo image from the report

• Logo position – Use the  list to select the logo position on the report page. 
The available options are as follows:
• Right
• Center
• Left
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Chart Appearance
The Charts Appearance tab includes the Series Labels, Size, Border Style, Background Color, and 
Sentiment sections, providing a number of customization properties. 
• Series Labels – Section contains options to customize the labels font and appearance.

• Font – Select the web-compatible fonts for your charts.
• Font Size – Select the web-compatible font sizes for your charts.
• Font Color – Select  the font color for the chart report elements. Select from a range of colors in 

the Web Palette, RGB Sliders, HSB (Hue, Saturation, and Brightness), and HSV (Hue, Saturation, 
and Value).

• Label Rotation – Define the label rotation angle in degrees.
• Max Characters – Define the maximum number of characters for your charts.

• Size – Section contains options to customize the chart size.
• Width – Define the width of your charts. Values you input into this field are measured in pixels.
• Height –Define the height of your charts. Values you input into this field are measured in pixels.

• Border Style – Section contains options to customize the border of your charts.
• Border Color – Select  the border color of your charts.
• Border Width – Adjust the border width of your charts. The available options are Default, Light, 

Medium, and Heavy.
• Border Radius – Define the border radius of your charts. The available options are Default, Small, 

Medium, and Large.
• Background Color – Section contains options to customize the background color of your charts.

• Background Color – Select  the background color of your charts.
• Background gradient end – Select  the gradient color for the uppermost area of your charts.
• Series Palette – Select a theme for the series in your chart by clicking the Series Colors button 

in the Series Palette dialog box, and then select color for each data point from a palette.
• Sentiment – Section contains options to customize the sentiment color in the text analytics 

elements. 
• Positive – Select  the color of a positive sentiment.
• Neutral – Select  the color of a neutral sentiment.
• Negative – Select  the color of a negative sentiment.
• Category – Select  the color of the category in a heat map, for example.

Table Appearance
The Table Appearance tab includes the Bar Colors, Table Headers, and Table Rows sections, both 
providing a number of customization properties.
• Use Series Colors from Frequency Charts – Select the web-compatible fonts for the table 

headers and rows.
• Series Palette – Select a theme for the series in your table by clicking the Series Colors button 

in the Series Palette dialog box, and then select color for each data point from a palette. This 
option is active only when the Use Series Colors from Frequency Charts check box is clear.
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• Font – Select the web-compatible fonts for the table headers and rows.
• Font Size – Select the web-compatible font sizes for data and header text.
• Font Color – Select the font color for the table headers and rows.
• Header Background Color – Select  the background color for the table headers.
• Row Background Color – Select  the background color for the table rows.

Text Appearance
The Text Appearance tab includes the Question Text, Question Description, Caption and Text 
Element sections, providing a number of customization properties. 
• Question Text – Section contains options for your question text appearance.

• Show Question Heading – Show the question heading.
• Show Question Text – Show the question text.
• Question Text Font – Select the web-compatible fonts for the question text in your report.
• Question Text Size – Select the web-compatible font sizes for the question text in your report.
• Question Text Color – Select  the text color for the questions in your report.

• Question Description – Section contains options for your question description appearance.
• Show Question Description – Show the question description text.
• Question Description Font – Select the web-compatible fonts for the question description in 

your report.
• Question Description Size – Select the web-compatible font sizes for the question description 

text.
• Question Description Color – Select  the text color for the question description in your report.

• Caption – Section contains options for the caption appearance.
• Caption Font – Select the web-compatible fonts for the caption text.
• Caption Size – Select the web-compatible font sizes for the caption text.
• Caption Color – Select  the text color for the caption.

• Text Element – Section contains options for the Text report element appearance.
• Text Font – Select the web-compatible fonts for the Text report element.
• Text Size – Select the web-compatible font sizes for the Text report element.
• Text Color – Select  the color for the Text report element.

 Rename a Report theme

Procedure 
1 Click the Edit link next to the report theme name. 

The theme name appears as a text field for editing.
2 Edit the report theme name.
3 To apply change, press Enter.
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Add a logo to a Report heme 

Procedure 
1 Click the Choose Logo button. 
2 In the Picture dialog box, select the image that you want to insert. 
3 To edit the image, use the Image Editor.

 To select another image, click the Upload button.

4 Click Insert.
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Locked library questions
Navigation

Design & Collect tab > Surveys tab > My Surveys grid > open an existing survey or create a new one > 
Design tab > add a locked library question to the survey > Translation tab > add the language into which 
you want to translate your survey or open any existing translation > translation editor.

You cannot edit the locked library questions in the translation module. This also applies to the locked 
hierarchical and profile questions. Locked questions are system questions that are secured and cannot be 

edited or deleted. Each locked question has the lock icon   and the corresponding message next to it.

 You can add translations to the hierarchical questions by clicking the Translations tab on the 
hierarchical question editing page. For more information, see Translate Hierarchical Question, 
page 1275.

Locked library, hierarchical, and profile questions are included in the calculation of the completion 
percentage in the translation module.
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Image Manager
Navigation

Library  tab > Image Manager tab > Image Manager page.

You can upload your images, place them in different folders, and edit them. You can insert the images 
into your survey questions, reports, themes, and so on. You can also remove the images you do not need 
anymore.

 The Image Manager page is available only if the Allow User Media permission is activated for 
the user role.

On the Image Manager page, you can find the following folders:
• User Media – The images and media added by a specific user. This folder is only available if the 

Allow User Media permission is activated for the user role.
• Group Media – The images and media for a workgroup. You can upload images and media to this 

folder if the Upload Group Media permission is activated for the user role.
You can also view the following information on the image:
• Filename – The name of the file.
• Size – The size of the file measured in bytes.
• Last Modified – Last time the file was changed.
You can click the image name in the grid to preview it in the right pane.

Add a new folder

Procedure 
1 On the Library > Image Manager page, select the folder, for which you want to create a folder.

2 On the Image Manager toolbar, click the New Folder icon . 

 You can also right-click the folder, and then click New Folder to create a new folder.

3 In the Enter the new folder name dialog box, edit your folder name.
4 Click OK. 

A new folder appears.

 You can create subfolders under Group Media if you have the Upload Group Media 
permissions.

Rename a folder or file

Procedure 
1 On the Library > Image Manager page, right-click the folder or file that you want to rename.
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2 Click Rename.
3 Edit the your folder name, and then click Enter. 

Your folder is renamed.

 You can rename the Group Media folders if you have the Delete Group Media permissions.

Delete a folder or file

Procedure 
1 On the Library > Image Manager page, select the folder or file that you want to delete. 

2 On the Image Manager toolbar, click the Delete icon . 
3 In the confirmation dialog box, click OK. 

The folder is deleted.

 You can delete the Group Media folders if you have the Delete Group Media permissions.

Upload an image to the Image Manager

Procedure 
1 On the Library > Image Manager page, select the folder to which you want to upload the image.

2 On the Image Manager toolbar, click the Upload icon . The Upload dialog box opens, 
where you can find the information on the maximum file size and extensions allowed.

3 Click the Select button to locate your image.
4 Select the image, and then click Open.

 To add many images at once, click the Add button. You can also choose to overwrite the images 
with the same file name by selecting the Overwrite if the file exists check box.

5 Click the Upload button. 
The image appears in the folder.

Edit the image

Procedure 
1 On the Library > Image Manager page, select the image that you want to edit.
2 Click the Edit link below the image preview. 
3 In the Edit Image dialog box, customize your image by using various editing options on the toolbar.
4 To apply your changes, click Save.
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Media Manager
Navigation

Library  tab > Text Blocks tab > Media Manager tab > Image Manager page. 

You can upload your media and place them in different folders. You can insert the media into your survey 
questions, reports, themes, and so on. You can also remove the media you do not need anymore.

 The Media Manager page is available only if the Allow User Media permission is activated for 
the user role.

On the Media Manager page, you can find the following functionalities:
• User Media – The media added by a specific user. This folder is only available if the Allow User 

Media permission is activated for the user role.
• Group Media – The media for a workgroup. You can upload media to this folder if the Upload 

Group Media permission is activated for the user role.
You can also view the following information on the media:
• Filename – The name of the file.
• Size – The size of the file measured in bytes.
• Last Modified – Last time the file was changed.

Add a new folder

Procedure 
1 On the Library > Media Manager page, select the folder, for which you want to create a folder.

2 On the Media Manager toolbar, click the New Folder icon . 

 You can also right-click the folder, and then click New Folder to create a new folder.

3 In the Enter the new folder name dialog box, edit your folder name.
4 Click OK. 

A new folder appears.

 You can create folders under Group Media if you have the Upload Group Media permissions.

Rename a folder or file

Procedure 
1 On the Library > Media Manager page, right-click the folder or file that you want to rename.
2 Click Rename.
3 Edit the your folder name, and then click Enter. 

Your folder is renamed.
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 You can rename the Group Media folders if you have the Delete Group Media permissions.

Delete a folder or file

Procedure 
1 On the Library > Media Manager page, select the folder or file that you want to delete. 

2 On the Media Manager toolbar, click the Delete icon . 
3 In the confirmation dialog box opens, click OK. 

The folder is deleted.

 You can delete the Group Media folders if you have the Delete Group Media permissions.

Upload a media to the Media Manager

Procedure 
1 On the Library > Media Manager page, select the folder to which you want to upload the media.

2 On the Media Manager toolbar, click the Upload icon . 
3 In the Upload dialog box, you can find the information on the maximum file size and extensions 

allowed.
4 To locate your media, click the Select button.
5 Select the media, and then click Open.

 To add many media at once, use the Add button. You can also choose to overwrite the media 
with the same file name by selecting the Overwrite if the file exists check box.

6 Click the Upload button. 
The media appears in the folder.
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Search for library items
Navigation

Library tab > Questions, Hierarchical Questions, Choice Lists, AutoDropdowns, Survey Themes, 
or Report Themes pages > Search field > search for the library items.

You can quickly find the required library items by their names.

 The Search option is only available for the following tabs: Questions, Hierarchical Questions, 
Choice Lists, AutoDropdowns, Survey Themes, and Report Themes.

Procedure 
1 In the Name search field in the upper-right corner of the Questions grid, type the name of the 

library question that you want to find.
2 Click the Search button.

Entries with a similar name appear in the Questions grid.

 To remove the current filter conditions, in the Quick Search notification message, click the Clear 
link.
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Unified Data Set overview
You can combine multiple sources in the Unified Data Set and tie-in contextual information after the data 
is collected into a single entity for analysis and reporting purposes. You can combine these sources by 
mapping them to the Unified Data Model.

 To combine data from the multiple sources into the Unified Data Set, and then analyze it, you 
must have Unified VoC license enabled for your workgroup.

Unified Data Model
With the Unified Data Model, you can define a set of values or fields to combine data from different 
sources by using the mapping capabilities. You can add questions from different internal and integrated 
projects such as surveys, file imports, comments, and ForeSee and Speech Analytics projects, and then 
combine them into a single data set.
Within the Unified Data Model, you can create the following values: 
• Core measures – Numeric values that have the specific range of attributes that help to identify 

the positive, neutral, and negative feedback.
• Dimensions – Various forms of data that can be used in reporting to gain the critical insight on 

how they impact core measures.
• Supplemental attributes – Data entries that can help in qualitative analysis of the feedback and 

connection with a concerned individual.

Unified Data Source
Unified Data Sources are connections to other repositories where the mapped data is monitored for alerts, 
triggers, and some modest analysis.  With the Unified Data Sources, you are able to build dashboards and 
reports based on their feedback, and take automatic action through Unified Data Model triggers.
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Configure Unified Data Set
You can combine multiple sources in the Unified Data Set to use them for further analysis and reporting 
purposes. The main feature of the Unified Data Set is that you can define sources and areas that interest 
you the most, or where you want additional feedback or improvements. You can define these areas by 
creating the core measures, dimensions, or supplemental attributes on the Unified Data Mode page.

Workflow 
1 Ensure that you have the Unified VoC module.

Make a request for the Unified VoC module to perform actions on the Unified VoC features.
The Unified Data Set functionality is only available for the workgroups with the Unified VoC license 
enabled. To enable the license, contact your System Administrator.

2 Ensure that you have the needed role permissions.
To verify that you have all necessary user role permissions, contact your System Administrator. 
Administrator can activate the Unified Data Set functionality for a user by creating a new role or 
editing the existing ones on the Administration tab > Roles tab.

3 Configure Unified Data Model.
Define the Unified Data Model by creating the core measures, dimensions, or supplemental 
attributes. You create these values according to your needs. 

4 Publish your changes to use the data types from the Unified Data Model in the Unified Data Sources.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.

5  Connect Unified Data Sources.
Unified Data Set supports the survey, file Import, comments, ForeSee and Speech Analytic project 
types.
a. Map data sources fields to the data types of the configured Unified Data Model.
b. Specify value mapping for the data fields with the Choose One or Choose Many questions.
c. Publish your changes to make them available for further reporting and analysis.

After you define the Unified Data Model values according to your needs, map them to the Unified Data 
Sources, and then publish them, the Unified Data Set project is created automatically. It is a virtual project 
where the mapped data is stored. This data becomes available in reporting, dashboards, and other 
features. You can also make it available for advanced analysis by using the Feedback Intelligence solution 
and create reports and dashboards from all sources that are joined together.

 If you apply any changes to the data that is already published, the Unified Data Set is updated 
automatically.
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Overview page
Navigation

Unified VoC tab > Overview tab >  Sources view.
The Overview page is a summary page to view and manage all connected sources to the Unified Data Set. 

 The Overview page appears only if you have the Unified VoC license enabled and the View 
permission selected for Unified Data Sources.

The following sources are displayed in widgets if you have integration configured and enabled:
• Surveys
• Comments
• File Imports
• Speech Analytics
• ForeSee
If you do not have permissions for a particular source project, you will still see information about it in 
widgets having the View permission for Unified Data Sources.
Each widget displays a total number of sources connected to Unified Data Set of that type and the 
number of active sources of the particular type. Clicking the widget name redirects you to the Unified 
Data Sources page.



Unified VoC Unified data view page

EFM User Guide 1316

Confidential and Proprietary Information of Verint Systems Inc.

Unified data view page
Navigation

Unified VoC tab > Overview tab >  Data view.

The Unified data view page allows viewing feedback data available in Unified Data Set, filter the data, and 
perform export of it.

On the Responses tab, you can show or hide particular columns, filter the data, export or schedule 
export of responses, and push them to FI. 
The following columns are available for selection:
• Unified Data Set
• Respondent Fields
• Respondent System Information
• Respondent Location
You can export responses to CSV, TSV, Microsoft Excel, SPSS file formats, or schedule export by email, to 
folder, or to SFTP.
By clicking the Actions menu > Filter option, you can control what feedback data to display on the 
Unified data view page by defining custom filtering criteria. For example, you can exclude all responses 
that are larger than a certain value. Also, the Date Filter with the following options in the list is available: 
Clear All Date Filters, Today, Current Week, Current Month, Current Quarter, Current Year, Year to Date, 
Last Week, Last Month, Last Quarter, Last Year.
In the Add Filter Criteria dialog box, in the Source list, data from the current project, columns, and 
profiles are available for defining the filtering criteria.
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Unified Data Model page
Navigation

Unified VoC tab > Unified Data Model tab > Unified Data Model page.
You can view, create, edit, and delete the needed data types in a schema that can be mapped on the 
Unified Data Model page.

 The Unified Data Model page is available if the System Administrator activates the Unified VoC 
license for your workgroup and only if you have the View permission.

The Unified Data Model page

On the Unified Data Model page, the following options are available:
• Core Measures – Displays the list of the Core Measures values that you can view, create, edit, 

and delete according to your role permissions. This allows you to use them in the Unified Data 
Set. 

• Dimensions – Displays the list of the Dimensions values that you can view, create, edit, and 
delete according to your role permissions. This allows you to use them in the Unified Data Set. 

• Supplemental – Displays the list of the Supplemental values that you can view, create, edit, 
and delete according to your role permissions. This allows you to use them in the Unified Data 
Set. 

When the Core Measures tab is selected, the following columns are available:
• Core Measure – Name of the core measure.
• Abbr – Shortened form for the core measure's name.
• Min – Maximum selected value for the core measure.
• Max – Minimum selected value for the core measure.
• Range – Highchart that displays the positive, neutral, and negative ranges according to the 

numeric values (red color for the negative, yellow for neutral, and green for positive). When you 
point to the appropriate range section, it becomes highlighted and the numeric values that define 
the negative, neutral, or positive range are displayed.

When the Dimensions tab is selected, the following columns are available:
• Dimension – Name of the Dimension value.
• Data Type – Type of the Dimension value to match the target question or field for mapping it 

on the Unified Data Model page.
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• Description – Name or short explanation of the Dimension value.
When the Supplemental tab is selected, the following columns are available:
• Supplemental Data – Name of the Supplemental attribute.
• Data Type – Type of the Supplemental attribute to match the target question or field for 

mapping it on the Unified Data Model page.
• Description – Name or short explanation of the Supplemental attribute.

By default, the Unified Data Model grid shows the first 10 items. To view more saved items, use the 
View per Page option. Select the 25, 50, or 100 link to display more items. To navigate between the 
pages, click the navigation arrows in the lower right corner. The Displaying # of # option shows the 
number of current columns among the total number of columns.
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Create new core measure
Navigation

Unified VoC tab > Unified Data Model tab > Core Measures tab > New button.
You can create the core measures if you have the appropriate permissions.
Core measures are numeric values that have the specific range of attributes with a help of which you can 
easily identify the positive, neutral, and negative feedback.

Procedure 
1 Go to the Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page, select the Core Measures tab.
3 To add a new core measure, click the New button.

 The New button is available only if you have the View and Create permissions.

4 In the Add Core Measure dialog box, enter the appropriate information.
The following options are available:
• Name  – Enter the name of the core measure.
• Abbreviation  – Enter the  shortened form  of the core measure's name.

 The maximum number of characters that you can enter in the Abbreviation text box is five.

• Minimum – Define the minimum value for the core measure.
• Maximum – Define the maximum  value for the core measure.

 The maximum value should be at least two values greater than the minimum value.

• Reversed Scale – Select the check box so the range of values from the positive to negative is 
measured in the reverse order.

• Passive Range – Enter the range of values to define the neutral feedback for your core measure.
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The Add Core Measure dialog box

5 Click Save.
The new item is added to the Core Measures grid.

 When you click the title of a core measure, the Edit Core Measure dialog box opens where you 
can edit the core measure information.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Delete core measure
Navigation

Unified VoC tab > Unified Data Model tab > Core Measures tab > Delete button.
You can delete the previously created core measures.

Procedure 
1 Go to the Unified VoC tab > Unified Data Model tab.
2 On theUnified Data Model page, select the Core Measures tab.
3 In the Core Measures grid, select the check box next to the item that you want to delete.
4 Click the Delete button.

 The Delete button is available only if you have the View and Delete permissions.

5 In the confirmation dialog box, click Delete.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Duplicate core measure
Navigation

Unified VoC tab > Unified Data Model tab > Core Measures tab > Duplicate button.
You can duplicate the previously created core measures. 

Procedure 
1 Go to the  Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page, select the Core Measures tab.
3 In the Core Measures grid, select the check box next to the item that you want to duplicate.
4 Click the Duplicate button.

 The Duplicate button is available only if you have the View, Create, and Delete permissions.

5 In the Duplicate Core Measure dialog box, enter the name of the core measure or leave the default 
one.

The Duplicate Core Measure dialog box

6 Click OK.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Create new dimension
Navigation

Unified VoC tab > Unified Data Model tab > Dimensions tab > New button.
You can create the dimensions  if you have the appropriate permissions.
Dimensions are various forms of data and you can use them in reporting to get the information on how 
they impact the core measures.

Procedure 
1 Go to the Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page, select the Dimensions tab.
3 To add a new dimension, click the New button.

 The New button is available only if you have the View and Create permissions.

4 In the Add Dimension dialog box, enter the appropriate information.
The following fields are available:
• Name  – Enter the name of the dimension.
• Data Type  – Select the type of the dimension to match the target question or field for mapping it 

on the Unified Data Model page.
You can select among the Text, Number (Whole Number), Number (Real Number), Set 
(Single Selection), Set (Multiple Selection), and Date data types.

• Choices  – Specify the choice label for your dimension. 
Multiple choice labels should be separated by pressing Enter. The specified labels will be displayed 
in the Description column with a comma.

 The Choices text box is available only if  the Set (Single Selection) or Set (Multiple Selection) 
data type is selected.

• Description  – Enter the name or short explanation of the dimension.
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The Add Dimension dialog box

5 Click Save.
The new dimension is added to the Dimensions grid.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Delete dimension
Navigation

Unified VoC tab > Unified Data Model tab > Dimensions tab > Delete button.
You can delete the previously created dimensions.

Procedure 
1 Go to the  Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page, select the Dimensions tab.
3 In the Dimensions grid, select the check box next to the item that you want to delete.
4 Click the Delete button.

 The Delete button is available only if you have the View and Delete permissions.

5 In the confirmation dialog box, click Delete.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Duplicate dimension
Navigation

Unified VoC tab > Unified Data Model tab > Dimensions tab > Duplicate button.
You can duplicate the previously created dimensions.

Procedure 
1 Go to the Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page, select the Dimensions tab.
3 In the Dimensions grid, select the check box next to the item that you want to duplicate.
4 Click the Duplicate button.

 The Duplicate button is available only if you have the View, Create, and Delete permissions.

5 In the Duplicate Dimension dialog box, enter the name of the dimension or leave the default one.
6 Click OK.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Create new Supplemental attribute
Navigation

Unified VoC tab > Unified Data Model tab > Supplemental tab > New button.
You can create the supplemental attributes if you have the appropriate permissions.
Attributes are supplemental data entries that can help you in qualitative analysis of the feedback and 
connection with a concerned individual. 

Procedure 
1 Go to the  Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Modelpage, select the Supplemental tab.
3 To add a new supplemental attribute, click the New button.

 The New button is available only if you have the View and Create permissions.

4 In the Add Supplemental Attribute dialog box, enter the appropriate information.
The following fields are available:
• Name  – Enter the name of the attribute.
• Data Type  – Select the type of the attribute to match the target question or field for mapping it 

on the Unified Data Model page.
You can select among the Text, Email Address, Number (Whole Number), Number (Real 
Number), Phone Number, Date, and Essay data types.

• Description  – Enter the name or short explanation of the attribute.

The Add Supplemental Attribute dialog box
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 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Delete Supplemental attribute
Navigation

Unified VoC tab > Unified Data Model tab > Supplemental tab > Delete button.
You can delete the  previously created supplemental attributes.

Procedure 
1 Go to the  Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page, select the Supplemental tab.
3 In the Supplemental grid, select the check box next to the item that you want to delete.
4 Click the Delete button.

 The Delete button is available only if you have the View and Delete permissions.

5 In the confirmation dialog box, click Delete.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Duplicate Supplemental attribute
Navigation

Unified VoC tab > Unified Data Model tab > Supplemental tab > Duplicate button.
You can duplicate the previously created  supplemental attributes.

Procedure 
1 Go to the Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page, select the Supplemental tab.
3 In the Supplemental grid, select the check box next to the item that you want to duplicate.
4 Click the Duplicate button.

 The Duplicate button is available only if you have the View, Create, and Delete permissions.

5 In the Duplicate Supplemental dialog box, enter the name of the dimension or leave the default 
one.

The Duplicate Supplemental dialog box

6 Click OK.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Yes. To cancel your changes, click Revert.
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Unified Data Source page
Navigation

Unified VoC tab > Unified Data Sources tab > Unified Data Sources page.
You can view, add, and edit the projects and map their data types from the configured Unified Data Model 
to add them to the Unified Data Set.

 The Unified Data Sources page is available if the System Administrator activates the Unified 
VoC license for your workgroup and only if you have the View permission.

The Unified Data Source page

On the Unified Data Sources page, the following columns are available:
• Title – Type of a project. It can be a survey, comment, Speech Analytics project, or file import. 
• Last Modified – Date and time when the project was last modified. 
• Latest Activity – Date and time when the latest activity to a project was performed.
• Active – Toggle with a help of which you can determine whether the source is active.

 You can sort your sources by the title and the date when they were last modified. 

To search for the specific source, type a partial or whole source name in the search box, and then click the 
Search button. The list of sources that match your input are displayed. 
By default, the Unified Data Sources grid shows the first 10 sources. To view more saved sources, use 
the View per Page option. Select the 25, 50, or 100 link to display more sources. To navigate between 
the pages, click the navigation arrows in the lower right corner. The Displaying # of # option shows the 
number of current columns among the total number of them.
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Add a new source
Navigation

 Unified VoC tab > Unified Data Sources tab > Add button.
You can add new sources to the  Unified Data Set and map their data types to the configured   Unified Data 
Model.

Procedure 
1 Go to the  Unified VoC tab > Unified Data Sources tab.
2 On the Unified Data Sources page, click the Add button.
3 In the Add New   Unified Data Source dialog box, in the Type menu, select the type of a project to 

be added as a source.
4 Select the needed project from the list of all available projects. 

You can select from the following project types:  survey, comment, ForeSee and Speech Analytics 
project, or file import.

The Add New Unified Data Source dialog box
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 If the project is already added as a source, it is dimmed and you cannot select it again. 

5 Click Add.

 When you click the Add button, you will be redirected to the Data Mapping page. For more 
information, see Map data from the Unified Data Model, page 1336.
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Deactivate a source
Navigation

Unified VoC tab > Unified Data Sources tab > Unified Data Sources page.
You can deactivate a source to control the updates that will be included in the Unified Data Set.
When you publish the data for the particular source, the toggle next to this source on the Unified Data 
Sources page becomes active by default. You can deactivate the source to control the updates to  the 
Unified Data Set as well as exclude the response or feedback data from the reports and dashboards 
without reimporting them to the  Unified Data Set. 

Procedure 
1 Go to the Unified VoC tab > Unified Data Sources tab.
2 On the Unified Data Sources page, turn off the toggle next to the source that you want to 

deactivate.
3 In the confirmation dialog box, click Deactivate.

Now, the source is deactivated and the Unified Data Set will not be updated with new records.
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Delete a source from the Unified Data Set
Navigation

Unified VoC tab > Unified Data Sources tab > Unified Data Sources page > select a channel > Delete 
button.
You can delete sources that you do not need to use anymore. When a source is deleted, its records are 
removed from the  Unified Data Set.

Procedure 
1 Go to the Unified VoC tab > Unified Data Sources tab.
2 In the Unified Data Sources grid, select the check box next to the source that you want to delete  

from the  Unified Data Set. 
3 Click the Delete button.

 The Delete button is available only if you have the View and Delete permissions.

4 In the confirmation dialog box, click Delete.
Now, all records from the source are removed from the  Unified Data Set, reporting, dashboards, and 
other features, but you can add them later. For more information, see Add a new source, page 1332.
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Map data from the Unified Data Model
Navigation

Unified VoC tab > Unified Data Sources tab > Unified Data Sources page > create a new source or 
open an existing one > Data Mapping tab.
You can map data from the Unified Data Model to specify which question or field corresponds to the 
Unified Data Set.
You can map data while you are creating a source, or click the title of existing source, and then you are 
redirected to the Data Mapping tab.
For more information, see Add a new source, page 1332. 
In the Data Mapping grid, the following columns are available: 
• Data Field – Contains the list of each field that is present in the data source that will be mapped. 
• Contains Data Type – Contains the list of Unified Data Model fields. It can be a core measure, 

dimension, or supplemental attribute.

• Value Map – Click the calculator icon  to specify value mapping for the data fields with the 
Choose One or Choose Many questions.

The Data Mapping tab

Procedure 
1 Go to the Unified VoC tab > Unified Data Sources tab.
2 In the Unified Data Sources grid, click the source to which you want to map the data.
3 On the Data Mapping tab, in the Contains Data Type column, select the core measure, dimension, 

or supplemental that contains the required data type.
4 Specify value mapping for the data fields with the Choose One or Choose Many questions by 

clicking the  icon. For more information, see Specify value mapping, page 1339.
5 Click the Publish button.

 The Publish button is active when at least one value is mapped.

6 In the Publish Unified Data Source dialog box, click Publish.



Unified VoC Map data from the Unified Data Model

EFM User Guide 1337

Confidential and Proprietary Information of Verint Systems Inc.

Now, the mapped data is available in the Unified Data Set. 

 When you publish the data for a particular source, the toggle next to this source on the Unified 
Data Source page becomes active by default. 

The Publish Unified Data Source dialog box

 When you click the Publish button, you are redirected to the Data View tab. For more 
information, see Data View tab, page 1341.

When you make any changes to the Unified Data Model values that are already mapped to the Unified 
Data Set, you receive the warning message. It says that your changes may affect the mapping for the 
Unified Data Sources. If you confirm your changes, the Unified Data Set is updated accordingly. 

To map comments to Unified Data Set by using Unified Data Sources, you must have the OpinionLab 
and Unified VoC licenses enabled. If the OpinionLab license expired, you will still see comments as 
Unified Data Sources and mappings will be the  same, but publishing and importing will be unavailable. To 
import and publish data in a comment, activate the OpininoLab license.
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Predefined  values of the Unified Data Model
Navigation

Unified VoC tab > Unified Data Model tab > Unified Data Model  page. 
The EFM application contains a number of predefined values for the Unified Data Model. It allows you to 
save time on the creation of most commonly used data fields that are needed for reports. Each predefined 
value includes a defined set of parameters. 
The following predefined core measures are available:
• Net Promoter Score
• Customer Satisfaction 
The following predefined dimension is available: 
• Feedback Date
The following predefined Supplemental values are available: 
• E-mail Address
• Phone Number

Predefined core measures
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Specify value mapping
Navigation

Unified VoC tab > Unified Data Sources tab > Unified Data Sources page > open a source > Data 

Mapping view >  icon.
You can specify value mapping for the data fields with the Choose One or Choose Many questions by 

clicking the  icon.

 The Calculator icon is available only when the Contains Data Type list is filled and  Choose 
One or Choose Many question type is selected.

If not all question choices are mapped to the Unified Data Set, you will see the  icon next to the 
appropriate data field. You need to specify choice values to receive the complete results.

Procedure 
1 Go to the  Unified VoC tab > Unified Data Sources tab.
2 In the Unified Data Sources grid, open the needed source.

3 If the data is already mapped, in the Data Mapping view, click the  icon next to the field that 
includes the Choose One or Choose Many question type. 

4 If the data is not mapped yet, in the Contains Data Type column, select the core measure or 

dimension that contains the required data type, and then click the  icon.

 For more information, see Map data from the Unified Data Model, page 1336.

5 In the Value Map dialog box, specify the choices values. 
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The Value Map dialog box

6 Click Publish.

 If you specify the value mapping for the Choose One question, you can select one value for the 
data source value multiple times. For the Choose Many question, you can select one value for 
the data source value only once.

 When you update the mapping, the data source becomes unpublished. To apply changes, you 
should click the Publish button.

When the source is published, all the value mappings are processed and the Unified Data Set is updated 
automatically.
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Data View tab
Navigation

Unified VoC tab > Unified Data Sources tab > add a new source or open an existing one > Data 
Mapping tab > Data View tab.
You can view all records of the appropriate source after the data from the Unified Data Model was 
mapped and this source was published. 
After you click the Publish button on the Data Mapping tab, you are redirected to the Data View tab. 
For more information on data mapping, see Map data from the Unified Data Model, page 1336.

 The Data View tab is available only if you have the View permissions and the source is 
published.

The Data View grid

The Data View grid shows all columns that were mapped to the fields on the Data Mapping tab. The 
Record ID column on the Data View grid represents the unique record identifier of the field from the 
Unified Data Model that was mapped.
By default, on the Data View grid, the first 10 items are shown. To view more saved items, use the View 
per Page option. Select the 25, 50, or 100 link to display more items. To navigate between the pages, 
click the navigation arrows in the lower right corner. The Displaying # of # option shows the number of 
current items among their total number.
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Update the mapping
Navigation

Unified VoC tab > Unified Data Sources tab > Unified Data Sources page > select a source with 
mapped data > Data Mapping tab.
You can update the mapping for the source after it is published. 

Procedure 
1 Go to the Unified VoC tab > Unified Data Sources tab.
2 In the Unified Data Sources grid, select the source that already has the mapped data.
3 On the Data Mapping tab,  in the Contains Data Type column, click the name of the value that you 

want to remap, and then, in the drop-down menu, select the new core measure, dimension, or 
supplemental.
Name of the value is displayed as a link.

4 If you want to map the data field that was not mapped before, click the Unselected link, and then,  in 
the drop-down menu, select the core measure, dimension, or supplemental that contains the required 
data type.

5 Click Publish.

 When you click the Publish button, the Unified Data Set is automatically updated.

Updating the mapping
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Push a Unified Data Set project to Feedback 
Intelligence

Navigation

 Unified VoC tab > Unified Data Sources tab > Unified Data Sources page > select a source > Push 
to Feedback Intelligence button.

You can add and update your Unified Data Set project in Feedback Intelligence for advanced reporting by 
using the Push to Feedback Intelligence option.

Before you begin 
• Publish the needed Unified Data Set project.
• Contact a System Administrator to add the Unified Data Set project to Feedback Intelligence. A 

System Administrator can also enable and disable the Push to Feedback Intelligence option 
for a certain project.

 When you update the existing Unified Data Set project in Feedback Intelligence, changes that you 
made to the Unified Data Set project may affect the previously generated Feedback Intelligence 
universe, which may change or damage the existing reports. 

Procedure 
1 Go to the Unified VoC tab > Unified Data Sources tab.
2 On the Unified Data Sources page, select the check box next to the source that you want to push to 

FI, and then click the Push to Feedback Intelligence button.
3 In the confirmation dialog box, click OK.

Your Unified Data Set project is marked to be updated in Feedback Intelligence.

 When you update the Unified Data Set project, the warning message appears telling that the 
structure of the project is changed. The Push to Feedback Intelligence button becomes 
available on Unified Data Sources page and you should push the Unified Data Set project to FI 
again.
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Configure Unified VoC to view feedback in Mobile 
Comment Stream

The mobile comment stream feature in the Experience Mobile application allows you to monitor customer 
feedback and identify potential customer experience issues. For more information on using the 
application see the Experience Mobile User Guide.

 To use this feature you must configure the Unified Data Model so that specific core measures 
are displayed along with comments (Essays) in the mobile comment stream feed.

Workflow

1 Ensure that you have the Unified VoC module.
Make a request for the Unified VoC module to perform actions on the Unified VoC features.
The Unified Data Set functionality is only available for the workgroups with the Unified VoC license 
enabled. To enable the license, contact your System Administrator.

2 Ensure that you have the needed role permissions.
To verify that you have all necessary user role permissions, contact your System Administrator. 
Administrator can activate the Unified Data Set functionality for a user by creating a new role or 
editing the existing ones on the Administration tab > Roles tab.

3 Configure Unified Data Model.
Define the Unified Data Model by creating the core measures (feedback) you want to display in the 
comment stream. 

4 Publish your changes to use the data types from the Unified Data Model in the Unified Data Sources.
5  Connect Unified Data Sources.

Create the data source (survey) and map the core measures you created, then publish your data 
source so the comment stream displays data.

 

Configure Unified Data Model for Mobile Comment Stream
The Unified Data Model must be configured with the core measures and attributes which are used to 
display customer feedback in the comment stream.
You must create a new Essay supplemental attribute. The attribute must be mapped to a core measure 
so that the comments appear with a score.

Procedure 
1 Go to the  Unified VoC tab > Unified Data Model tab.
2 On the Unified Data Model page select the Supplemental tab.
3 To add a new supplemental attribute, click the New button.

 The New button is available only if you have the View and Create permissions.

https://verintconnect.com/Authoring/EIS/Technical/Assets/EFM/EFM15.3FP2/Verint_Experience_Mobile_User_Guide.pdf
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4 In the Add Supplemental Attribute dialog box, enter the Name and select Essay as the Data 
Type.

5 Click Save and check that your new attribute is displayed in the list.
6 Select the Core Measures tab.
7 Create a new core measure or edit an existing measure.
8 Select the Mobile Comment Stream check-box then in the Essay Question drop-down menu select 

your newly created supplemental attribute  (of data type Essay).
9 Click Save.

You must now configure the Unified Data Source.

 When you make any changes to the Unified Data Model page, the Publish Changes message 
appears. To apply your changes, click Commit, and then, in the confirmation dialog box, click 
Continue. To cancel your changes, click Cancel.

Configure Unified Data Source for Mobile Comment Stream
To create data for the comment stream you must add a survey as a new source to the Unified Data Set 
and map the data types to the configured Unified Data Model. The survey must contain at least one of 
the following:

       Choose One Question

       Essay Question

Procedure 
1 Go to the  Unified VoC tab > Unified Data Sources tab.
2 On the Unified Data Sources page, click the Add button.
3 In the Add New   Unified Data Source dialog box, in the Type menu, select Survey as the type of 

project to be added as a source.
4 Select your survey from the list and click Add.
5 In the Data Mapping screen pick the first Choose One question and select your Core Measure in the 

Contains Data Type column.
6 Click the icon in the Value Map column and accept the default values displayed.
7 Click Update.
8 In the Data Mapping screen pick the first Essay question and select your Supplemental Attribute in 

the Contains Data Type column then click Publish.
9 In the Publish Unified Data Source dialog click Publish. 

The mapped data is available in the Unified Data Set and can be viewed in the mobile comment 
stream. 
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Administration tab overview
The Administration tab provides access to the following administrative tasks:
• Users, page 1349 – Add, import, delete users, and send email messages to a workgroup. You can 

also add or delete organizations in your workgroup and assign users to organizations.
• Roles, page 1378 – Add, modify, and delete roles that define permissions of users.
• Devices, page 1388 – Register your device for use with the EFM Mobile Offline App. Devices that 

can be used are the iPhone, iPad, and iPod Touch.
• Feedback Intelligence, page 1394 – View the contents of the Feedback Intelligence  Folders table 

for the current workgroup. You can also view the list of users of your workgroup with the access 
to Feedback Intelligence.

• User Logs, page 1399 – View the transaction events specific to your workgroup.
• Unsubscribe List, page 1396 – Add panelists (and non-panelists) to this list that will be excluded 

from survey-based emails.
• Tasks–History view, page 1450 – Track tasks that have been performed by all users within a 

workgroup.
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Users
Navigation

Administration tab > Users tab.
You can use the Users tab to add new users to a workgroup, import users from a .csv, .tsv, .xlsx, or .txt 
file, export users to a .csv, .tsv, or Microsoft Excel file format, edit, and remove existing users from a 
workgroup. On the Users page, you can find different information about the users. 
The Users page shows a number of columns including:
• User Name – The name with which the user logs into the product.
• Display Name – The name of the user to display in the application.
• Email – The user's email address. This is usually used as the From address on invitations created 

by the user.
• Organization – The organization to which the user is assigned.
• Role – The user's security role.
• Groups - The groups to which the user is assigned.
On the toolbar, you can find the following functionality:
• Actions – On this menu, the following options are available:

• Add User – Add a new user to a workgroup. You must have authority under the Roles tab to add 
users.

• Assign Membership – Add selected individual users or groups of users to organizations assigned 
to your workgroup. One user can be a member of only one organization at a time. You can move 
users from one organization to another.

• Import – Import users from a .csv, .tsv, .xlsx, .txt, or .zip file. The contents of the .zip file is 
scanned before extraction to check whether it contains the supported file formats.

• Export – Export selected users to the .csv, .tsv, or Microsoft Excel file format.
• View User’s History – View the login and logout dates and times for a particular user in the 

current workgroup.
• Notify User(s) – Send an email notification to the selected users in the current workgroup.
• Reassign All Cases – Assign the cases of the selected user to another user. You can reassign 

cases between users that belong to one organization.
• Delete – Remove selected users from the workgroup.

• New  – Add a new user to a workgroup. You must have authority under the Roles tab to add 
users.

• Users/Organizations/Groups – Toggle between the Users, Organizations, and Groups views.
• Search – Enter the name of the user you want to find in the text box and click the Search button 

next to the text box.
By default, the Users page shows the first 10 users. To view more items per page, use the View per 
Page option at the bottom of the Users page. Select the 25, 50, or 100 link to display more users. In 
addition, if the Users page is longer than one page, you can navigate between the pages by clicking the 
navigation arrows.
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Adding a new user
Navigation

Administration tab > Users tab > Users page.

To add a new user to a workgroup,  on the toolbar, click the New button. The Add User dialog box opens 
with the following tabs:

Basic Information
Define the basic information for a new user.
• User Name – Enter the name for the user to log into the application.
• Display Name – Enter the name for the user you want to display to other users.
• Email – Type the user's email address.
• Language – Select the language for the user from the list.
• Default Workgroup – Select the default workgroup for the user. If you are working with only 

one workgroup, that workgroup name displays. If you have multiple workgroups, select it from 
the list.

• Status – Select a user status from the list. The default is Active.
• Time Zone – Select a time zone from the  list.

Extended Information
Define the additional information for a new user. On the Extended Information tab, you can find the 
following fields:
• Organization
• Department
• Country
• Province
• Fax
• Employee Count
• Registration Date
• Industry
• Job Title
• State
• Telephone
• Interests
• Registration Portal
• Referred By
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Preferences and Settings
Define the settings for the preference mode, questionnaire designer, and the default report charts for a 
user. On the Preferences and Settings tab, you can customize the following functionality:
• Predefined Settings – Set the levels for the users based on their experience with the product on 

the Preferences Mode menu:
• Beginner – Applies the recommended settings for a beginning user.
• Standard – Applies the recommended settings for a user who is more comfortable with the 

application but who is not an expert.
• Expert – Applies the recommended settings for an expert user, such as Free Form Word Processor 

and more rows displayed per page in any page with a grid view such as the Response Manager 
page.

After you select the preference mode from the list, click the Load button to apply the settings.
• Questionnaire Designer

• Designer View 
• Display XML Tab
• Display HTML Tab
• Display DB Headings in Tree View

• Default Report Charts
• Choose One
• Choose Many
• Matrix Question

• Experience
• Email confirmation is required for processes exceeding: "n" (minutes)

 For more details on the preferences and settings, see My Account page, page 1444.

Workgroup
Select the role and reviewer status for a user on the corresponding menus. 
• Workgroup – The name of the workgroup to which the user is assigned.
• Role – Select the workgroup role for the user.
• Organization Membership – Select the organization you want the user to be the member of. If 

you change the user's workgroup, the user becomes the member of the root organization in the 
new workgroup.

• Organization Access – Select the organization to which you want the user to have access. If the 
user is a member of a child organization, you can give him/her access to the parent organization. 
By default, the user has access to the organization he or she is the member of. If you change the 
organization membership, the user then has access only to the assigned organization.

• Reviewer Status – Select the status that defines the review permission for the user.
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External IDs
Assign an external identifier for a user to associate external data to users efficiently. On the External IDs 
tab, you can find the following columns:
• External Data Source – View the list of the external data sources defined for your workgroup.
• External Data Source ID – Type any text that helps you identify the external source better. The 

external source ID should be unique for all users.
Click OK to add a new user. The user is added to the workgroup and a message with the login information 
is sent to this user's email.
You can change the information of any user in the workgroup by using the Edit User dialog box that 
opens when you click the user's name in the grid.
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Manage users
Navigation

Administration tab > Users tab > Users page.

View user's login history

Procedure 
1 On the Users page, select the user whose login history you want to view.
2 On the Actions menu, click the View User's History option. 
 

3 In the Login History dialog box, navigate through the pages by clicking the navigation arrows.
4 Click Close.

Assign users to organization

Procedure 
1 On the Users page, select the users to whom you want to assign an organization.
2 On the Actions menu, click Assign Membership.
3 In the Assign Membership dialog box, select the organization from the organization tree.
4 Click Assign.

Reassign all user's cases to another user

Procedure 
1 On the Users page, select the user whose cases you want to reassign.
2 On the Actions menu, click Reassign All Cases.  opens.
3 In the Bulk Assign Cases to New Owner dialog box, select the user to whom you want to assign 

the cases.
4 Click OK.



Administration Import users from a file

EFM User Guide 1354

Confidential and Proprietary Information of Verint Systems Inc.

Import users from a file
Navigation

Administration tab > Users tab > Users page.
Multiple users can now be assigned the same role as they are imported into EFM.
You can also import users with their organization information. The organization name in the imported 
document should be exactly the same as the organization name in the application.
Additionally, you can import the following user fields: Employee External Data Source, Employee External 
ID, Organization External Data Source, and Organization External ID. These fields are optional. If you 
want to import employee fields, you need to specify both employee user fields (Employee External Data 
Source and Employee External ID). Similarly, if you want to import organization fields, you need to specify 
both organization user fields (Organization External Data Source and Organization External ID).
If the Employee External Data Source field is valid, and the Employee External ID field is unique for 
the data source, the employee is added with the specific external ID on the data source. If you do not 
specify the Employee External Data Source field and the Employee External ID field, the employee is 
added without External ID.
If the Organization External Data Source and the Organization External ID fields are valid, the 
employee is added with the assignment to the specific organization. If you do not specify the 
Organization External Data Source and the Organization External ID fields, the employee is added 
to the root organization.

Procedure 
1 Go to the Administration tab > Users tab.
2 On the Actions menu, click Import. 
3 In the Import Users dialog box, click Select to locate the file to import on your system. 

File type must be .csv, .tsv, .xlsx, .txt, or .zip. The contents of the .zip file is scanned before extraction 
to check whether it contains the supported file formats.

4 Click Next.  
5 In the Map Fields dialog box, map the fields from the import file to the User Fields.

 Certain fields will map automatically such as User Name, Display Name, Email, Culture, 
Organization, Employee External Data Source, and Employee External ID.

6 Click Next. 
7 In the list with the user roles, select the role that will be assigned to all of these users.
8 Click Next. The Ready To Import Users message shows.
9 Click Import. The Task Completed message shows.
10 Click Close.
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Export users
Navigation

Administration tab > Users tab > Users page.
The system and group administrators can export the workgroup users data to the .csv, .tsv, or Microsoft 
Excel format.
The exported file contains the following data about all users registered under the current workgroup, 
regardless of the selected user or page:
• User Name 
• Display Name 
• Email 
• Organization Membership 
• Organization Access 
• Role 
• Culture 

Procedure 
1 Go to the Administration >  Users tab.
2 On the Actions menu, click Export, and then select the output format.
3 In the Export Users dialog box, click the link that appears to save or open the export file.
4 Click Close.
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Notify users
Navigation

Administration tab > Users tab > Users page.
You can view the list of all user accounts in the current workgroup and send emails to the needed users. 

Procedure 
1 Go to the Administration >  Users tab.
2 Select the check box next to the user to whom you want to send an email, and then  on the Actions 

menu, click Notify Selected Users.
3 Complete the following fields to compose your message:

• From – An email address of the email sender. By default, it is your user account.
• Reply To – An email address the recipients reply to if they select to answer the email. By default, it 

is your user account.
• To – Select the check boxes next to the people names you want to send your email to.
• Subject – Add the subject line to your email.
• Email Body – Add content to the body of your message and customize it by using the editing 

toolbar. You can change the format of your message text, add images, input HTML, check spelling, 
print your email, and so on.

4 Click the Send button.
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Organizations
Navigation

Administration tab > Users tab > Users page > Organizations button.
On the Organizations page, you can add, delete, disable, and edit organizations in your workgroup. In the 
left corner of the Organizations page, you can view the list of organization titles that belong to your 
workgroup.
Click the organization name in the grid to edit the organization title and the External Data Source ID 
information.
You can disable an organization without users or child organizations if you do not need to use it for data 
collection any longer but want to include it in reporting. Disabled organizations appear dimmed in the 
grid.
You can add child organizations to the existing organizations. Click the organization title in the tree and 
the list of child organizations appears in the Organizations grid.
By default, your organizations are sorted by the Title column in the Organizations grid. If you want to 
change how your organizations display in the grid, click a column header (Title or Organization). An 
arrow appears up (ascending) or down (descending) to show the sort order. You can also change a 
column width by dragging the edge of the column header.
The default number of organizations per page is 10; however, you can select up to 100 organizations to 
display on the Organizations page. You can also navigate between the pages of organizations by clicking 
the navigation arrows at the bottom of the page.
To manage all organizations, select the check box in the upper-left corner of the Organizations page.
The following columns are available on the Organizations page:
• Title – Name of a child organization. Click the child organization name to edit the child 

organization.
• Organization – Name of the organization to which the child organization belongs.
• External Data Source ID – Unique identifier of an organization.



Administration Add an organization

EFM User Guide 1358

Confidential and Proprietary Information of Verint Systems Inc.

Add an organization
Navigation

Administration tab > Users tab > Users page > Organizations button > New button.
You can add organizations and child organizations to arrange a hierarchy of users and organizations in 
your workgroup. You can also export your organization hierarchy into a file to easily modify it, and then 
import your updates back to EFM. For more details, see Export  organizations, page 1360.
The name of each new organization and of all child organizations should be unique.

Procedure 
1 On the Users page, click the Organizations button. 
2 On the Organizations page, click the workgroup name.
3 On the toolbar of the Organizations grid, click the New button. 
4 In the Add Organization dialog box, in the Title text box, enter the name of the organization.
5 Click Add. 
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Add a child organization
Navigation

Administration tab > Users tab > Users page > Organizations button > New button.
You can add new organizations to the Organizations grid to arrange a hierarchy of organizations in your 
workgroup.

Procedure 
1 On the Userspage, click the Organizations button. 
2 In the Organizations grid, from the list of workgroup organizations, select the organization name to 

which you want to add a new child organization.

 You can find the organization name by using the search box at the top of the list. To search for 
the specific organization name, type a partial or whole organization name in the search box. The 
list of organization names that match your input displays.

3 On the toolbar of the Organizations grid, click the New button. 
4 In the Add Organization dialog box, in the Title text box, enter the name of the organization.
5 Click Add. 
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Export  organizations
Navigation

Administration tab > Users tab > Users page > Organizations button > Actions menu > Export 
option.
You can maintain your organizations’ hierarchy by exporting it to the needed file format (.csv, .tsv, or 
.xlsx). In the exported file, you can modify the organizations’ hierarchy, and then upload your updates 
back to the EFM application.
The exported file contains the following columns:
• Workgroup – Workgroup of the exported organization hierarchy. Ensure that workgroups match 

before importing a file.
• Organization Name – Title of the organization. This column is empty for top-level organizations 

in the hierarchy.
• Parent Organization Name – Title of the parent organization.
• External Data Sources – IDs of external data sources separated by semicolons.

 The file for import should contain the same columns.

Procedure 
1 In the Organizations grid, in the Actions menu, click Export, and then select the needed file format.
2 In the Export Organizations dialog box, download your file, and then close the dialog box.
3 Modify the organizations’ hierarchy as needed.
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Import organizations
Navigation

Administration tab > Users tab > Users page > Organizations button > Actions menu > 
Importoption.
You can import organizations in the following formats:  .csv, .tsv, or .xlsx 

Procedure 
1 In the Organizations grid, in the Actions menu, click Import.
2 In the Import Organizations dialog box, choose one of the following options:

• Update current organization structure – The existing organizations will be updated, and new 
ones will be added from the file (if any). No organizations will be disabled in EFM.

• Import new organization structure – Besides updating the existing organizations and adding 
the new ones, the organizations from the previous structure will be disabled according to the 
updates in the imported file.

 The organizations containing child organizations or users will not be disabled, and the import task 
will be completed with errors.

3 Click Select and locate the needed file on your computer. You can import .csv, .tsv, or .xlsx files.

 You can also download a file template by clicking the Download Template link.

a. Click Next.
b. In the Import Organizations dialog box, map the columns from the imported file to the 

corresponding data fields by using the drop-down lists, and then click Next. Certain fields are 
mapped automatically.

c. Click Import, and then click Close.

 If the file structure is broken, the import process fails. Reasons of the broken structure can be the 
following: organizations with non-existing organization set as a parent, some columns are missing 
or extra columns are present in a file, non-existing External Data Sources are used, and so on.
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Disable organizations
Navigation

Administration tab > Users tab > Users page > Organizations button > select an organization > 
Actions menu > Disable Organizations option.
You can disable organizations that you do not need to collect information from any longer. The disabled 
organizations remain available for reporting.
Once you disable an organization, it is impossible to enable it again. You cannot perform the following 
actions on the disabled organizations:
• Assign users and child organizations
• Use as default
• Edit
• Share reports or surveys with
It is possible to disable only the organizations that do not include any child organizations or users. If you 
want to disable an organization that contains users or child organizations, you need to reassign all users it 
contains and delete all child organizations in it.
You can also disable child organizations.

Procedure 
1 In the Organizations grid, select the check box next to the organization that you want to disable.
2 On the Actions menu, click the Disable Organizations option.  
3 In the confirmation dialog box, click Disable Organizations.

The organization is disabled and appears dimmed in the grid.
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Delete organizations
Navigation

Administration tab > Users tab > Users page > Organizations button > select an organization > 
Actions menu > Delete option.
You can delete the organizations and child organizations that you do not need to use anymore. When an 
organization is deleted, it is no longer available in the application. Any data associated with the shared 
surveys or shared reports scoped to the deleted organization is removed from the application as well.
If an organization has survey results or cases associated to it, they are reassigned to the parent 
organization. You can disable an organization instead of deleting it to leave it available for reporting of 
the existing survey results. For more information, see the Disable organizations, page 1362. You can also 
delete the disabled organizations that you do not need to use for reporting any longer. 
It is possible to delete only the organizations that do not include any child organizations or users. If you 
want to delete an organization that contains users or child organizations, you need to reassign all users 
that it contains and delete all child organizations in it.
It is possible to delete multiple organizations at a time.

Procedure 
1 In the Organizations grid, select the organization that you want to delete.
2 On the Actions menu, click Delete.
3 In the confirmation dialog box , click OK. 
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Assign External Data Source ID to organization
Navigation

Administration tab > Users tab > Users page > Organizations button > click the needed organization 
> Edit Organization dialog box.
You can assign External Data Source ID to an organization to associate external data with that organization 
efficiently.

 Organizations imported from the WFO source have their External Data Source IDs already 
assigned. You cannot edit the External Data Source IDs of the organizations imported from the 
WFO source.

 

Procedure 
1 In the Edit Organization dialog box, in the External Data Source column, find the data source that 

you want to assign to the organization.
2 In the External Data Source ID text box, next to the needed data source, type the unique name for 

the data source that identifies the external data in the particular organization.
3 Click Save.
For information about adding external data source, see External Data Sources, page 1437.
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Assign External Data Source ID to a user
Navigation

Administration tab > Users tab > Users page >  click the needed user > Edit User dialog box > 
External IDs tab.
You can assign External Data Source ID to a user to associate external data with that user efficiently.

 Users imported from the WFO source have their External Data Source IDs already assigned. You 
cannot edit the External Data Source IDs of the users imported from the WFO source.

 

Procedure 
1 On the External IDs tab, in the External Data Source column, find the data source that you want 

to assign to the user.
2 In the External Data Source ID column, next to the needed data source, type the unique name for 

the data source that identifies the external data.
3 Click Save.
For more information about adding external data source, see External Data Sources, page 1437.
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Organization scoped surveys
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one > Design tab > 
Content tab > Add menu or Add a Question section > click Add from Library.
You can add the Organization External ID or Employee External ID question to your survey to 
associate survey results with employees or organizations. The collected data can be used for statistics and 
reports. Only one of these questions can be added to the survey. The questions are added as hidden.

 You can only add the Organization External ID and Employee External ID questions to a 
survey in Design mode before it is published or reopened.

The Organization External ID question includes the following topics:
• External Data Source
• Organization External ID
• Organization Display Name (always hidden)
The Employee External ID question includes the following topics:
• External Data Source
• Employee External ID
• Employee Display Name (always hidden)
• Organization Display Name (always hidden)
• Employee Username (always hidden)
• Employee Email Address (always hidden)
You can ensure that your scoped survey is not distributed in a non-scoped way in data sets. When a 
survey is scoped and you want it to remain scoped, clear the Allow survey to be linked into data sets 
check box. The Allow survey to be linked into data sets check box is available only for the 
Organization External ID and Employee External ID library questions on the Question Options panel in 
the survey designer. For more information, see Organization scoped data sets, page 1198.

Collecting Survey Responses
You can collect responses to the External ID questions via any means available for the Fill in the Blank 
question (pre-load data, API calls, user input, piping from another question, etc.). The submitted data is 
compared to the Organization or Employee External ID for the specified external data source. If a match 
is found, the Organization or Employee is associated to the survey. If a match is not found, the default 
organization is used. You can define the default organization under Question Options.

 The comparison of IDs is case-insensitive.

If your survey includes the Organization External ID question, the following fields are available on the 
Responses side tab and for any report element supporting the Fill in the Blank question:
• Organization External ID
• External Data Source
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• Organization Display Name
If your survey includes the Employee External ID question, the following fields are available on the 
Responses tab and for any report element supporting the Fill in the Blank question:
• Employee External ID
• External Data Source
• Employee Display Name
• Employee Username
• Employee Email Address
So you can add report elements based on these External ID fields. The report data will include only the 
responses associated with a specific organization. This ensures secure access to response data limited to 
authorized users only. If a report author is not associated to the root organization, the public report and 
public widget features are unavailable.
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Organization performance analysis report
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one > Design tab > 
Analyze tab > Reportspage > New  menu > click Organization Performance Analysis Report.
OR
Report & Analyze tab > Project Reports tab > Reports page > New  menu > click Organization 
Performance Analysis Report.
You can create an Organization Performance Analysis report to associate the survey results with 
definite organizations or users. The report is created based on the user's current organization.
For that purpose your survey should include the External ID System Question, which can be shown or 
hidden for the users. If the question is hidden, the responses are automatically assigned to the user's 
current organization. For more information on the External ID System Questions, see Organization 
scoped surveys, page 1366.
When you create a new Organization Performance Analysis report, you can use the Question and 
Properties tabs.

The Organization Performance Analysis Wizard dialog box
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Question
On the Question tab, you can select the question you want to analyze in your Organization 
Performance Analysis report.
• Survey Question – Select the question responses to which you want to analyze in your report. It 

is possible to analyze only one question at a time.

 For the Choose Many questions, only the Each Response option is available.

• Values and Display – Select the data format that you want to use in your report.
• Question Count – Select this check box to view the total number of responses for the selected 

question in your report.
• Response Mean – This option shows the sum of values divided by the number of values 

(average value).
• Values – This option shows the percentage of the response choices selected by respondents.
• Bars – This option shows the bar with the percentage of the response choices selected by 

respondents.
• Top Box Response Groups – This option shows either percentage or number of the response 

choice groups selected by respondents. You can specify the number of choices to be used for 
defining the top and the bottom groups on the Properties tab.
• Count – This option shows the number of the response choice groups selected by respondents.

- Percent of Row Total – This option shows the percentage in addition to the number of the 
response choice groups selected by respondents.

• Stacked Bars – This option shows the bar with the percentage of the response choice groups 
selected by respondents.

• Each Response – This option shows either percentage or number of each response choice 
selected by respondents.
• Count – This option shows the number of responses for each response choice.

- Percent of Row Total – This option shows the percentage in addition to the number of 
responses for each response choice.

• Bars – This option shows the bar with the count of responses for each response choice.

Properties
The Properties tab contains the Labels and Data sections, both providing a number of customization 
options.
In  the Labels section, the following options are avaliable: 
• Question Labels – Select the question label for your report. The available options are Question 

Heading and Report Heading.
• Caption – Enter your text in this text box to show a brief description below your report.
• Base Total (label) – Use this text box to edit the label for total amount of response choices 

selected by respondents. Base is a default label. If you do not provide any value, the default value 
is applied to the report.

In  the Data section, the following options are avaliable: 
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• Displayed Values – Select the response data appearance in your report. The following opations 
are available:
• Numbers and Percentages – This option shows both percentage and the number of the 

response choices selected by respondents. The response choices number appears above the 
percentage.

• Percentages only – This option shows only the percentage of the response choices selected by 
respondents.

• Numbers only – This option shows only the number of the response choices selected by 
respondents.

• Decimal Places – Define the decimal places for the values in the report. The available options are 
0, 1, 2, and 3.
• Reverse Order – Select this check box to view the values and means in an opposite order.

• Range of Top Group – Use this text box to specify the number of choices to be used for defining 
the top group. For example, if the top group range is set to 2, all responses of 9 and 10 on a 0-10 
scale are included in the top group. 

• Range of Bottom Group – Use this text box to specify the number of choices to be used for 
defining the bottom group. For example, if the bottom group range is set to 7, all responses of 0, 
1, 2, 3, 4, 5, 6, and 7 on a 0-10 scale are included in the bottom group.

To apply changes that you made to the report properties, click OK.

Viewing the Organization Performance Analysis Report
Your Organization Performance Analysis report consists of the three main sections:
• Organization – The name of the main organization that you are assigned to.
• Organizations in [the name of the main organization] – The name of the child organizations that 

belong to the main organization.
• Employees in [the name of the main organization] – The users that belong to both main and 

child organizations.
Your Organization Performance Analysis report might contain responses gathered from users that 
belong to different child organizations. You can view the results received from each organization by 
clicking the child organization's name in the second section of the report.

 The public report generation does not currently support the Cross-tab Analysis report types. The 
Cross-tab Analysis report types are now disabled for the public reports.

It is also possible to filter your report by organizations.

 You can create an Organization Performance Analysis report by using the survey that contains 
the External ID System Question.
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Add organization performance analysis report
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one > Design tab > 
Analyze tab > Reportspage > New  menu > click Organization Performance Analysis Report.
OR
Report & Analyze tab > Project Reports tab > Reports page > New  menu > click Organization 
Performance Analysis Report.
You can add an Organization Performance Analysis report to associate the survey results with definite 
organizations or users. The report is created based on the user's current organization.

Procedure 
1 Open the Reports page.
2 On the New menu, click Organization Performance Analysis Report.
3 In the Name Your Report dialog box, in the Report Name text box, enter the name of a report .
4 Click OK. 
5 In the Organization Performance Analysis Wizard dialog box, on the Question and Properties 

tabs, select the properties for your report.
6 Click OK.
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Filter responses by organizations
Navigation

Design & Collect tab > Surveys tab > create a new survey or open an existing one > Analyze tab > 
Responses tab > Actions menu  > click Filter.
You can filter responses by the organizations with which they are associated.

Procedure 
1 On the Responses tab, on the Actions menu, select the Filter option. 
2 In the Filter dialog box, click the Add button. 
3 In the Add Filter Criteria dialog box, in the Source menu, select the Participant Information 

option.
4 In the Field menu, select the Organization option.
5 Use the Expression and Value menus to specify the organization you want to use for or exclude 

from filtering.
6 To save the filter criteria, click the Add button. 

The created filter displays in the Filter dialog box.
7 To filter responses according to the created criteria, click the Apply Filter button.
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Groups
Navigation

Administration tab > Users tab > Users page > Groups button.
Use the Groups view to manage the groups assigned to your workgroup.

 The Groups view is available only if the system administrator configured Feedback Intelligence 
under Feedback Intelligence > Business Objects > Enable FI User Security Automation 
Features.

Use the following options  to manage groups:
• Actions – Select whether you want to add or remove a group from the workgroup.

The following options are available:
• Add Group – Add a new group to the workgroup.
• Delete – Delete the selected group from the workgroup.
• Import – Import groups from a .csv file.
• Export – Export selected groups to the .csv file format. For more details, see Export and import 

the user group assignments, page 1377.
• Add Group – Add a new group to the workgroup.
• Users/Organizations/Groups – Toggle between the Users, Organizations, and Groups 

views.
• Search – Enter the name of the group in the text box and click the Search button.
By default, the Groups view shows the first 10 groups on the page. To view more items per page, use the 
View per Page option at the bottom of the Groups view. Click 25, 50, or 100 to display more groups.
You can sort survey participants in the view by clicking the column heading. To change the width of a 
column, drag its edge.
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Assign users to group
Navigation

Administration tab > Users tab > Users page > Groups button > Groups column > click the count link 
> Assigned Groups dialog box.
You can manage the list of groups assigned to the user by using the Assigned Groups dialog box.

 Only users with Feedback Intelligence enabled roles can be assigned to the group.
 

Before you begin 
• Verify that the system administrator configured Feedback Intelligence under Feedback 

Intelligence > Business Objects > Enable FI User Security Automation Features to 
activate the Groups view.

Procedure 
1 Go to the Administration tab > Users tab.
2 On the Users page, in the Groups column, click the group’s link.
3 In the Assigned Groups dialog box, select the check box next to the group that you want to add.
4 In the Actions menu, click Add Group.
5 In the Assign Groups dialog box, select the check box next to the group that you want to assign to 

the user, and then click Add Group.
6 In the Assigned Groups dialog box, click Close.

The group is assigned to the specified user.

 To delete the assigned group, select the group in the Assigned Groups dialog box, and then on 
the Actions menu, click Remove Group.
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Add group
Navigation

Administration tab > Users tab > Users page > Groups button > New button.
You can add a new group and assign users to this group.

Before you begin 
• Verify that the system administrator has configured Feedback Intelligence under Feedback 

Intelligence > Business Objects > Enable FI User Security Automation Features to 
activate the Groups view.

Procedure 
1 Go to the Administration tab > Users tab.
2 On the Users page, click the Groups button.
3 On the toolbar, click New.
4 In the Add Group dialog box, click Group, and then enter the name and description of the group in 

the corresponding text boxes.
5 On the Surveys tab, in the Actions menu, click Add.
6 In the Add Surveys todialog box, select the surveys to add to the group, and then click Add.

 Select the All Surveys check box to map the group to all existing and future surveys submitted 
to Feedback Intelligence.

7 On the Users tab, in the Actions menu, click Add.
8 In the Add Users to dialog box, select the surveys to add to the group, and then click Add.

 Only users with Feedback Intelligence enabled roles can be assigned to the group.

9 Click Close.
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Edit group
Navigation

Administration tab > Users tab > Users page > Groups button > click a group name > Edit Group 
dialog box.
You can edit the group with the assigned users.

Before you begin 
• Verify that the system administrator has configured Feedback Intelligence under Feedback 

Intelligence > Business Objects > Enable FI User Security Automation Features to 
activate the Groups view.

Procedure 
1 Go to the Administration tab > Users tab.
2 On the Users page, click the Groups button.
3 In the Groups view, click the group’s name.
4 In the Edit Group dialog box, click the Group tab, and then edit the description of the group in the 

Description text box. The name of the group is not editable.
5 On the Surveys tab, in the Actions menu, click Add.
6 In the Add Surveys to dialog box, select the surveys to add to the group, and then click Add.

 Select the All Surveys check box to map the group to all existing and future surveys submitted 
to Feedback Intelligence.

 

7 To delete the assigned survey, select the survey in the Surveys grid. 
8 In the Actions menu, click Delete, and then click OK.

 Only users with Feedback Intelligence enabled roles can be assigned to the group.
 

9 To delete the assigned user, select the user in the Users grid.
10 In the Actions menu, click Delete.
11 Click Close.
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Export and import the user group assignments
Navigation

Administration tab > Users tab > Users page > Groups button > Actions menu.
You can maintain your user to group assignments in a workgroup by exporting them to the .csv file 
format. In the exported file, you can modify the assignments, and then upload your updates back to the 
EFM application.
The exported file contains two columns: User Name and FI Group Name.

 The file for import should contain the same columns.

Before you begin 
• Verify that the system administrator has configured Feedback Intelligence under Feedback 

Intelligence > Business Objects > Enable FI User Security Automation Features to 
activate the Groups view.

Procedure 
1 Export assignments:

a. In the Groups grid, on the Actions menu, click Export, and then select the .csv file format.
b. In the Export User-Group Assignments dialog box, download your file, and then close the 

dialog box. 
Modify the exported assignment as needed.

 The imported user-group mappings replace all the existing mappings.   Any user-group mappings 
not contained in the imported file are   removed.

2 Import assignments back to EFM:
a. In the Groups grid, on the Actions menu, click Import.
b. In the Import User-Group Assignments dialog box, click Select and choose the needed file.
c. Click Next.
d. Click Import.

 If the file is not valid, contains user name or group name that is   incorrect, does not have an FI 
account, or does not exist in a     workgroup, then the import process is canceled.

e. Click Close.
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Roles
Navigation

Administration tab > Roles tab.
You can create, edit, copy, and delete user roles and corresponding permissions within the application and 
set the selected role as a default role for all new users.
Having a custom role, you can set the selected role as default one only for users with the same or less 
permissions than your custom role has.
EFM is a role defined application. By using either standard or custom roles, administrators can control the 
use of each aspect of the application. 
The Roles page shows a number of columns, including:
• Name – The name of the role.
• Description – The role's short description.

• Default – The default role, which is marked by the check mark  .
On the toolbar, you can find the following functionality:
• Duplicate – Duplicate the selected role.
• Delete – Remove the selected role.
• Default Role – Make the selected role as default role for all new users. If you do not assign any 

role to the users, the default role is assigned to them automatically with the permissions that 
accompany that role.

• Create Role – Create a new role.

 You can click any selected role to change it, except the locked   roles.

By default, the Roles page shows the first 10 roles. To view more items per page, use the View per Page 
option at the bottom of the Roles page. Select the 25, 50, or 100 link to display more roles. In addition, if 
the Roles page is longer than one page, you can navigate between the pages by clicking the navigation 
arrows.
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Predefined roles
Navigation

Administration tab > Roles tab.
The EFM application contains a number of predefined roles, each including a defined set of permissions. 

The predefined roles are marked as the locked   roles. Administrator assigns a role to each user within 
the workgroup. 
The following predefined roles are available:
• Default – Default unassigned role.
• Case Administrator – Users can create, view, and configure cases regardless of their assignment.
• Case User – Users can create and edit cases that are assigned to them only. Also, users can view 

any cases in their organization; users that are not assigned to any organization can view all cases 
in the workgroup.

• Group Administrator – Administrator of a workgroup.
• Lite Survey Author – Survey author that does not have access to advanced features.
• Report Author – Users can create and edit reports.
• Report Viewer – Users can view saved reports they have been granted access to.
• Restricted Survey Author – Users can create surveys and have limited reporting access.
• Survey Administrator – Survey author that has access to some administration functions.
• Survey Author – Users can create and design surveys.
• Translator – Users can translate surveys, invitations, and responses.
• Web Administrator – Users can design and generate code for Web Intercepts. 

 To view the permissions assigned to a role, select the check box next to the role name, and then 
click the Edit button on the toolbar.
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Create a new role
Navigation

Administration tab > Roles  tab > New button.

To create a new role, click the New button on the toolbar. 
The Create Role page opens.
On the Create Role page, complete the following text boxes:
• Name – Enter the title of a new role.
• Description – Enter a short description of a new role.
The Create Role page provides a set of permissions, which determine the actions the user can perform 
within the product, including:
• View – The user can see the specified item.
• Create – The user can add a new item.
• Edit – The user can modify the item.
• Delete – The user can remove the item.
• Translate – The user can perform a translation of the item.
• Import – The user can import data into the item.
• Export – The user can save the specified item to use it outside the product.

 Some actions cannot be performed on certain features. These items do not have a check box.

The permissions are divided into ten categories, each including a number of items. You can assign 
permissions to the role by selecting the corresponding check boxes. The categories are divided as follows:
• Survey Administration – Permissions to work with the Surveys tab.

• Questionnaire
• Campaigns

 By default, the Campaigns permissions are enabled for the Group Administrator, Survey 
Administrator, Survey Author, Lite Survey Author, and Restricted Survey Author roles. For other 
default and custom roles, the permissions are cleared, and the Campaigns feature is unavailable. 
To enable the Campaigns permissions, contact your Group Administrator.

• Participants
• Invitations
• Tasks
• Responses
• Reports
• Data Sets

• Reporting - Permissions that allow building reports.
• Reports 

• Unified VoC Configuration – Permissions to work with the Unified VoC Module.
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 The Unified VoC Configuration permissions are available only if the System Administrator 
activates the Unified VoC license for your workgroup.

• Unified Data Set – Select the needed check boxes to view, add, import, export, and edit the 
Unified Data Sets.

• Unified Data Source – Select the needed check boxes to view, add, and edit the projects and map 
their data types to the configured unified data mode to add them to the VoC main features.

• Unified Data Model – Select the needed check boxes to view, create, edit, and delete the needed 
data types in a schema that can be mapped the unified data source.

• Global Triggers – Select the needed check boxes to create, edit, and delete triggers.
• Data Connectors – Permissions to work with the Data Sources tab.

• File Imports

 By default, all permissions (View, Edit, and Delete) are selected only for the Group 
Administrator and Survey Administrator roles.

• OpinionLab Comments 
• Speech Analytics
• ForeSee

 The OpinionLab Comments, Speech Analytics, and ForeSee categories are available only if 
the System Administrator activated the OpinionLab license, Speech Analytics license, and ForeSee 
Integration license for the workgroup correspondingly.

• Poll Administration – Permissions to work with the Polls tab.
• Polls

• Web Intercept Administration – Permissions to work with the Web Intercepts tab.
• Web Intercepts

• Panel Administration – These items relate to the Panel tab.
• Panelists
• Profiles
• Filters

• Group Administration – Permissions to work with the administration of the workgroup.
• Library Items
• Survey Themes
• Users and Organizations
• Roles
• Email
• Unsubscribe List
• Devices
• External IDs
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 The following categories do not have the standard set of actions (for example, View, Create, or 
Edit) listed. Items are enabled by selecting the appropriate check boxes.

 

• Case Administration – Permissions to work with the Cases tab.
• Cases
• Organization Cases
• Customer Email Address

• Anomaly Detection – Permissions to control users who have access to Anomaly Detection 
features.
• Access Anomaly Detection – Allows accessing and viewing the Anomaly Detection projects and 

provides access to the Anomaly Detection page under Report & Analyze.
• Add to Anomaly Detection – Allows adding new projects to Anomaly Detection and provides 

access to the Anomaly Detection page under View Responses.
• Reassign Cases – Allows reassigning cases to other users in the workgroup. By default, it is enabled 

for Group Administrator, Case Administrator, Case User, Survey Administrator, and Survey 
Author.

• Administration – Permissions to configure different features.
• Configure Group Settings
• View All Surveys
• View All Tasks
• View All Intercepts
• Configure Portal Settings
• Manage Panelist Status
• Configure Workgroup Options
• View Transaction Events
• Configure Case Settings
• View All Cases
• View All Data Sets
• Workgroup Reports Activity
• View FI Security
• Track As Admin
• Data Retention Notifications – Allows receiving scheduled notifications about surveys and 

responses. By default, the permission is enabled for Group and Survey Administrators.
• Manage Data Policies – Displays the Data Policies page under the Configuration tab and allows 

specifying settings for data retention and deletion. By default, the permission is enabled for 
Group and Survey Administrators.

• Images and Media – Permissions to work with images and media.
• Upload Group Media
• Delete Group Media
• Allow User Media

• Users – Permissions to work with the users.

Added [KH]
12/17/2019 11:18:47 AM
-----
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• Notify Group Users
• Audit Users

• Surveys – Permissions to work with the Surveys tab.
• Open Surveys
• Close Surveys
• Edit Survey HTML
• Send Invitations
• Share Surveys
• View Campaign Reports
• Permanently Delete Surveys
• Define Weighting Schemes
• Send to Offline Device
• SMS Surveys

• Campaign Creation - Permissions to work with campaigns.
• Survey Link
• Contact List
• Panelist
• Social Media
• Offline Device
• Passcode
• QR Code

 By default, the Campaign Creation permissions are enabled for the Group Administrator, 
Survey Administrator, Survey Author, Lite Survey Author, and Restricted Survey Author roles. 
Group Administrator and Survey Administrator can select and clear certain permissions for the 
duplicated default and custom roles. Depending on this, a user can either view, add, or edit the 
selected campaigns.

• Profiles - Permissions to work with the Profiles tab.
• Open Profiles
• Close Profiles

• Experience - Permissions to work with different features.
• Advanced Branching
• Email Triggers
• Free Form Word Processor
• Scoring
• Custom Properties
• Page Rotation
• Public Report
• View Dashboards
• Share Dashboards
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• Public Dashboard

 If the View Dashboards check box is cleared, the Share Dashboards and Public Dashboard 
check boxes are cleared automatically. 

If the Share Dashboards check box is selected, the View Dashboards check box is selected 
automatically.
If the Public Dashboard check box  is selected, the View Dashboards check box is selected 
automatically. 

 

• Add Text Analytics Elements
• Access Feedback Intelligence – Allows requesting the project to be pushed to FI.
• Add to Feedback Intelligence – Allows pushing new projects to FI.

 If you have the Access Feedback Intelligence permission, but do not have the Add to Feedback 
Intelligence permission, you can update the existing FI projects, but cannot push a new project to 
FI.

• Edit Code Blocks
• Export to Tableau WDC
• Mobile Comment Stream - Allows access to the comment stream feature on the Experience Mobile 

application.

 By default, the Mobile Comment Stream permission is enabled for the Group Administrator, 
Survey Administrator and Report Viewer.

To apply settings to a new role, click the Save button.
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Manage user roles
Navigation

Administration tab > Roles  tab > Roles page.

You can create, delete, duplicate, and edit user roles.
The Create Role page provides a set of permissions, which determine the actions a user can perform 
within the product, including:
• View – The user can see the specified item.
• Create – The user can add a new item.
• Edit – The user can modify the item.
• Delete – The user can remove the item.
• Translate – The user can perform a translation of the item.
• Import – The user can import data into the item.
• Export – The user can save the specified item to use it outside the product.

 Some actions cannot be performed on certain features. These items do not have a check box.

Duplicate a role

Procedure 
1 On the Roles page, select the role that you want to copy. 
2 On the toolbar, click the Duplicate button.

The name of the duplicate is the original role name followed by the next incremental number, for 
example, "Group Administrator (2)."

 

Delete a role

Procedure 
1 On the Roles page, select the role that you want to delete.
2 On the toolbar, click Delete.
3 In the confirmation dialog box, click Delete.

Edit a role

Procedure 
1 On the Roles page, click the name of the role that you want to edit. 
2 On the Edit Role page, make your changes.
3 Click Save.
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Default role

Procedure 
1 On the Roles page, select the role that you want to make a default one.
2 On the toolbar, click the Default Role button. 

The selected role is set as a default role for all new users.

 The check mark   appears in the Default column next to the default role.
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Activate workgroup reports activity for user role
Navigation

Administration tab > Roles  tab > Roles page > New button > Create Role page > Administration 
section.

You can control the user's ability to access workgroup reports based on the user role set of permissions. 
You can activate the  Workgroup Reports Activity functionality for a user by creating a new role or editing 
the existing ones from the Roles side tab on the Administration page. When the Workgroup Reports 
Activity option is not active, you can only access your own reports and reports shared with you by other 
users. By default, this option is active for group and survey administrators.

Procedure 
1 Go to the Administration tab > Roles  tab.
2 On the Roles page, on the toolbar, click the New button.
3 On the Create Role page, scroll down to the Administration section, and then select the 

Workgroup Reports Activity check box.
4 Click Save. 
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Devices
Navigation

Administration tab > Devices tab > Devices page.

 You must be a Survey Administrator to view this functionality.

The Devices page is used to register your device for use with the EFM Mobile Offline App. Devices that 
can be used are the iPhone, iPad, and iPod Touch. To send your survey to devices, you first need to add 
the Offline Device campaign to the survey (see Adding multiple campaigns to survey, page 586), and then 
open your survey.
Alerts are provided for text and email notifications. In the ID section, blue arrow appears if the device has 
either email or text messaging available. Selecting the blue arrow will launch either a new email message 
or a new text message to allow users to send the device’s ID to the EFM system administrator in order to 
simplify the process of adding a device to the EFM server.
If both email and text messaging are available, the email takes priority over the text message. A standard 
email or text will appear (with the device information) and the user will add the appropriate contact 
information (email address or text message phone number). 

 The Mobile Offline Survey Taking feature is available only if you have a license for it.

You can use the Devices page to register your device.
You can use the following options on the toolbar to manage devices:
• Actions – Activate, deactivate, import, and export your devices.
• Register Device – Register a device in the product to establish connection between the device 

and the application.
• Delete – Delete the previously added device. 
• Search – Search for the device by its ID, description, or tags.
You can find the following information about each registered device in the Devices grid:
• Device ID – The ID of the registered device.
• Description – A brief description of the registered device.
• Status – The status of the registered device. The available options are active and inactive.
• Tags – The custom user information (for example, a group name). It is limited to 255 characters.
When you delete a device, all surveys and respondent data are deleted from the device. 

 The responses that have already been synchronized with the Web application are not deleted.
 

Register a Device

Procedure 
1 Go to the Administration tab > Devices tab.
2 On the Devices page, click the Register Device button.
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3 In the Add Device dialog box, fill in the requested information.

Add Device dialog box

4 Click OK.
5 To send surveys to your iPhone or iPad, navigate to the Collect tab, add the Offline Device campaign 

(see Adding multiple campaigns to survey, page 586), and then use the created widget to add or 
import devices from another survey (see Manage Offline Access, page 1468).

Remove a Device

Procedure 
1 Go to the Administration tab > Devices tab.
2 On the Devices page, select the check box next to the device that you want to remove from the 

application.
3 Click the Delete button. 
  

4 In the warning dialog box, type DELETE in all caps.
5 Click the Delete button.

Edit the Device Data

Procedure 
1 On the Devices page, click the device ID.
2 In the Edit Device dialog box, edit the device data.
3 Click OK.
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Self-register a device
Navigation

Administration tab > Devices tab > Devices page.
Administrators can send the registration emails to the device users so that users can automatically register 
their devices. Administrators can share the registration URL by using email, text message, or a web page. 
When users click the registration URL on their device, their device is automatically registered to the 
appropriate workgroup in an active state. After activation, any available surveys are accessible.
The registration URL is unique for each workgroup. If device is already registered to a workgroup, and 
users click another registration URL, the device is deactivated from the previous workgroup and activated 
in a new workgroup.

Procedure 
1 Go to the Administration tab > Devices tab.
2 On the Devices page, copy the URL above. 
3 Send the URL to the user's device by email or text message or share the URL by using a web page.
4 Notify the URL recipients that they need to click the registration link to register the device. After 

clicking the link, the device is registered to the appropriate workgroup in an active state.
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Tag devices for self-registration
Navigation

Administration tab > Devices tab > Devices page.
When you register a device by using the URL, you can specify a tag for the device. You can specify the tag 
in the Option Tag text box on the Devices page. After specifying the tag, the registration URL is updated 
to include the specified tag value. The tag value in the URL is encoded and is assigned to the device on 
registration. When the device is registered, the tag appears on the Devices page in the Tag column next to 
the device.

Procedure 
1 On the Devices page, in the Option Tag text box, enter a tag for the device. 
2 Copy the updated URL from the text box.
3 Send the URL to the user's device by email or text message or share the URL by using a web page.
4 Notify the URL recipients that they need to click the registration link to register the device. After 

clicking the link, the device is registered with the tag to the appropriate workgroup.



Administration Activate and deactivate multiple devices

EFM User Guide 1392

Confidential and Proprietary Information of Verint Systems Inc.

Activate and deactivate multiple devices
Navigation

Administration tab > Devices tab > Devices page.
Administrators can activate and deactivate multiple devices to manage them more efficiently. You can 
make multiple devices active or inactive by clicking the Activate or Deactivate option correspondingly. 
You can also activate the inactive devices any time you need.

Deactivate Devices

Procedure 
1 Go to the Administration tab > Devices tab.
2 On the Devices page, select the check boxes next to the devices that you want to make inactive.
3 On the Actions menu, click Deactivate.

The deactivated devices appear as Inactive in the Status column.

Activate Devices

Procedure 
1 On the Devices page,  select the check boxes next to the devices that you want to make active.
2 On the Actions menu, click Activate.

The activated devices appear as Active in the Status column.
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Import and export devices
Navigation

Administration tab > Devices tab > Devices page > Actions menu.
You can upload multiple devices on the Devices page, on the Actions menu. Additionally, you can export 
a list of devices and their basic information into the different file formats to view the devices data outside 
of the application.

Import Devices

Procedure 
1 Go to the Administration tab > Devices tab.
2 On the Devices page, on the Actions menu, click Import. 
3 In the Import Devices dialog box, click Select to navigate to the file that you want to upload. 

 You can import .csv, .tsv, .xlsx, .txt, and .zip file formats. The contents of the .zip file is scanned 
before extraction to check whether it contains the supported file formats. You need to specify 
the device ID and description in the file for the device to be uploaded successfully.

4 Select the file, and then click Open.
5 Click Next.
6 In the Map Fields dialog box, match up the fields from the import file with the corresponding fields in 

the right pane if needed.
7 Click Next.

 If the imported file contains the devices which have been already added to the Administration 
> Devices page, they will be updated.

8 In the Ready to Import Devices List dialog box, click Import to begin importing data.
9 In the Task Completed dialog box, click Close. 

Export Devices

Procedure 
1 On the Devices page, select one or more devices that you want to export.
2 On the Actions menu, click Export, and then select the output format. 
3 In the Export Devices dialog box, click Export.
4 Your file is generated in the selected format. 
5 To open or save the exported file, click the link that appears.
6 Click Close.
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Feedback Intelligence
Navigation

Administration tab > Feedback Intelligence  tab.

You can view the contents of the Feedback Intelligence Folders table for the current workgroup. You can 
also view the list of users of your workgroup with the access to Feedback Intelligence.

Before you begin 
• The system administrator needs to configure Feedback Intelligence, and then activate the 

Feedback Intelligence tab for your workgroup under Feedback Intelligence > Business 
Objects > Enable FI User Security Automation Features.

The users with access to Feedback Intelligence grid
To view the list of users who have access to Feedback Intelligence, click the counter link next to the Users 
with Access to Feedback Intelligence. The Users with Access to Feedback Intelligence grid 
opens with the following columns:
• User Name – The name with which the user logs into the product.
• Display Name – The name of the user that displays in the application.

 To sort the results based on the selected column, you can click the column header in the table.

The Folders grid
The following columns are available on the Folders grid:
• Folder – Provides a single folder name located under the Public Folders in the associated 

Business Object system.
• Description – Describes the current Business Object environment.
• Path – Provides the path to the current Business Object environment.
• Groups – Contains a count of groups assigned to the user.

 You can click the column header in the table to sort the results based on the selected column.

To ensure you are viewing the most recent data, click the Refresh button above the Folder column.
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Assign groups to Feedback Intelligence folder
Navigation

Administration tab > Feedback Intelligence  tab > Groups column > click the count link > Assign 
Groups dialog box.

You can assign Business Object groups to reporting folders in your Feedback Intelligence system from the 
application.

Before you begin 
• The system administrator needs to configure Feedback Intelligence, and then activate the 

Feedback Intelligence tab for your workgroup under Feedback Intelligence > Business 
Objects > Enable FI User Security Automation Features.

Procedure 
1 In the Groups column, click the count link.
2 In the Assign Groups dialog box, click Add Group to add a group to the folder.
3 In the Authorize Group for Folder dialog box, select the check box next to group that you want to 

authorize.
4 Specify the access level of the group by clicking the necessary option in the Access Level menu, and 

then click Add Group.
The following options are available:
• No Access
• View
• Schedule
• View on Demand
• Full Control

5 To change the access level of the assigned group, select the check box next to the group, and then 
click Change Access Level in the Actions menu.

6 To delete the assigned group, select the check box next to the group, and then click Delete Group in 
the Actions menu.

7 Click Close.
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Unsubscribe List
Navigation

Administration tab > Unsubscribe List  tab >  Unsubscribe List page.

On the Unsubscribe List page, you can manage all survey participants in your workgroup that select to 
unsubscribe from your surveys. Each participant that clicks the Unsubscribe link in your survey is 
automatically added to the Unsubscribe List page and will not receive any emails with survey invitations 
or reminders. You can also import and export the unsubscribe list.
The Unsubscribe List functionality applies to panelists and non-panelists.

 Only group and survey administrators can add, import, export, and delete email addresses from 
the unsubscribe list.

The Unsubscribe List page shows the following columns:
• Email – Shows email addresses you add to the unsubscribe list.
• Is Panelist? – Shows whether the email address in the unsubscribe list belongs to a panelist or 

non-panelist.
On the toolbar, you can find the following functionality:
• Add Email Address – Add email addresses to the unsubscribe list.
• Import – Import a list of email addresses that you want to add to the unsubscribe list.
• Export – Export the unsubscribe list to the .csv file format to view the unsubscribe list outside the 

application.
• Delete – Remove the email addresses from the unsubscribe list.
• Search – Enter the email address you want to find in the text box and click the Search button 

next to the text box.
By default, the Unsubscribe List page shows the first 10 email addresses. To view more items per page, 
use the View per Page option at the bottom of the Unsubscribe List page. Select the 25, 50, or 100 
link to display more email addresses. In addition, if the Unsubscribe List page is longer than one page, 
you can navigate between the pages by clicking the navigation arrows.

Unsubscribe Tips
• The unsubscribe list is synchronized with the panel Is Subscribed field. All panelists who 

unsubscribe are added to the workgroup unsubscribe list.
• If a panelist is unsubscribed and becomes subscribed, then the panelist email address is removed 

from the workgroup unsubscribe list automatically.
• When participants receive the invitation or reminder emails and select to unsubscribe, those 

participants remain in the participant list and are marked as unsubscribed.
• Participants who previously unsubscribed are distinguished from participants who unsubscribed 

from your current survey project. The difference is in the status: previously unsubscribed versus 
unsubscribed.
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Add an email address to the unsubscribe list
1 On the Unsubscribe List page, click the Add Email Address button.
2 In the Unsubscribe Emails dialog box, enter the email address of any survey participant you want to 

exclude from all survey-based email messages in a text box.

 Enter each email address on a new line or separate them with a semicolon.

3 Click the Unsubscribe button. 

Import the unsubscribe list
1 On the Unsubscribe List page, click the Import button.
2 In the Iimport Unsubscribe List dialog box, click the Select button and select the file of the .csv, 

.tsv, .txt, .xlsx or .zip file format. 

 The contents of the .zip file is scanned before extraction to check whether it contains the 
supported file formats. The file should include the Email column with the list of email 
addressesthat you want to import.

3 Click Next.
4 In the Map Fields dialog box, match up the fields from the import file with the corresponding fields in 

the right pane by using the Unsubscribe Fields menu.

 Select the Display fields that are mapped by this wizard check box to view the fields 
mapped automatically.

5 Click Next. 
The Ready to Import Unsubscribe List message shows.

6 Click Import. 
The Task Completed message shows.

7 Click Close. 

Export the unsubscribe list
1 On the Unsubscribe List page, click the Export button. 

The export file is generated in the .csvformat.
2 Click the link that appears to open or save the exported data.
3 Click Close.

Remove an email address from the unsubscribe list
1 On the Unsubscribe List page, select the check box next to the email address that you want to 

remove from the Unsubscribe List.
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2 Click the Delete button.
3 In the confirmation dialog box, click Delete.
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User Logs
Navigation

Administration tab > User Logs  tab >  Transaction Events page.

The group and survey administrators can view all transaction events performed in the application, for 
example, adding a user to a workgroup or login history. The transaction events are displayed for the 
current workgroup. 
You can filter events by using the following options on the Transaction Events page:
• Options – Select the type of transaction events that you want to view by using the Action Type 

menu. All events are displayed by default.
• Date – Define the date range over which you want to track the transaction events by using the 

start date and end date filters.
You can additionally track and filter the following transaction events:
• Export Organizations
• Import Organizations
• Data Store Triggers
The filtered data appears at the bottom of the Transaction Events page. You can view the following 
information:
• Action Type – The transaction events based on your filter.
• Successes – The number of the corresponding successful transaction events.
• Errors – The number of the corresponding unsuccessful transaction events.

 You can use the Success and Errors columns to export data about the transaction events. For 
more information about exporting transaction events data, see Export data about transaction 
events, page 1401.

 

By default, the Transaction Events grid displays the first 10 events. To view more events per page, click 
25, 50, or 100 to the right of the View per Page option.
In addition, if the Transaction Events grid is greater than one page in length, you can navigate between 
the pages by clicking the navigation arrows.
You can click the item in the Successes or Errors columns to view more details about the transactional 
event.
The following columns appear in the Transaction Events dialog box:
• Date – The date of the transaction event.
• User – The workgroup member who performed the transaction event.
• Project – The survey or file import related to the transaction event.
• Information – The additional information about the transaction event, for example, an IP 

address.

 The information in the Transaction Events dialog box may vary according to the selected 
action type.
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Filter the transaction events

Procedure 
1 Go to the Administration > User Logs  tab.
2 On the Transaction Events page, on the Action Type menu, select the transaction event type that 

you want to view, for example, Login.

3 In the Start Date text box, enter the start date manually or by clicking the  icon .
By default, the current date is selected. 

4 To apply the no start date filter, click the No Start Date button.

5 In the End Date text box, enter the end date manually or by clicking the  icon.
By default, the current date is selected. 

6 To apply the no enddate filter, click the No Start Date button.

 You can click the  icon  to open the time picker.

7 Click the Applying Filter button.

Activate transaction events for a user role

Procedure 
1 Go to the Administration tab > Roles tab.
2 On the Roles page, click the name of the role you that want to edit.
3 On the Edit Role page, in the Administration section, select the View Transaction Events check 

box.
4 Click Save. 
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Export data about transaction events
Navigation

Administration tab > User Logs  tab >  Transaction Events page.

You can export the data about transaction events to the following file formats: CSV, TSV, and Excel.

 This functionality is available for users with permission to view transaction events.

Procedure 
1 Go to the Administration tab > User Logs  tab.
2 In the Transaction Events grid, in the Success or Errors column (depending on what you want to 

export), click the needed number.
3 In the Transaction Events - Login dialog box, click the Export menu, and then click the needed 

format.
4 In the dialog box, click the link to download and view the exported file.
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System Tasks – History view
Navigation

Administration tab > System Tasks  tab >  Tasks  page.

With the History task view, you can send invitations, track the progress of long operations, and track all 
tasks performed in the application, for example, testing surveys, exporting responses, or importing 
participants.
On the Tasks page, the following columns are available:
• Event – Short description of the task.
• Event Details – Name of the project to which the task refers.
• User – Owner of the project to whom the task refers.
• Start Date – Date and time when the task starts.
• Elapsed Time – Time during which the task is performed.
• Status – Task status, for example, in progress, completed, completed with errors, removed, 

canceled, or failed.
• Execution Location – Location where a task or request was executed, for example, the web 

application or scheduler.
By default, the Tasks grid displays the first 10 tasks. To view more tasks per page, click 25, 50, or 100 
links. To change the width of a column, drag its edge.
In addition, if the Tasks grid is greater than one page in length, you can navigate between the pages by 
clicking the page navigation arrows 
On the toolbar, the following options are available: 
• Cancel – Stop the task execution.

 The Cancel button is only active for the tasks with the In Progress status.

• Filter – Filter the tasks that are displayed on the Tasks page by specific features, for example, by 
task type, status, or task execution date.

View task details

Procedure 
1 On the Tasks page, select the task for which you want to view details.
2 In the Task Details dialog box, view the current information for the selected task.

For the Send Initial Invitation, Send First Reminder, Send Second Reminder, Send Third 
Reminder, Send Fourth Reminder, and Send Thank You task types, you can view the following 
information:
• Campaign – Campaign name that is associated with the invitation.
• Campaign ID – Campaign ID that is associated with the invitation (only for tasks associated with 

multiple-campaign surveys).
• Email Invitations – Number of email messages that are associated with the invitation.
• SMS Invitation – Number of SMS messages that are associated with the invitation.
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3 Click Close.

Cancel a task

Procedure 
1 On the Tasks page, select the task with the In progress status that you want to cancel.
2 On the toolbar, click Cancel.

Set a filter

Procedure 
1 On the Tasks page, click the Filter button. 
2 In the Filter Tasks dialog box, on the Project menu, select the project for filtering. 

You can select a survey, profile, file import, or data set.
3 On the Event Type menu, select the task type for filtering.

You can filter by group of events, such as all distribution actions, all import actions, all export actions, 
or all miscellaneous.

4 On the Status menu, select the task status for filtering.

5 In the Start Date text box, enter date when the task starts manually or by using the  icon. By 
default, the current date is selected.

6 In the End Date text box, enter the end date manually or using the  icon.  By default, the current 
date is selected.

 You can click the  icon  to open the time picker.

7 To apply the filter, click OK. 
The notification appears on the Tasks page.
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System Tasks – Scheduled view
Navigation

Account menu  > My Account option > Tasks tab > Scheduled view.

You can track all future tasks that you have scheduled in the application, such as test survey, export 
responses, import participants, or send invitations with the Scheduled task view.
In the Tasks grid, the following columns are available:
• Event – The event type.
• Event Details – The name of the survey the task refers to.
• Start Date – The date and time when the task starts.
• Recurrence – The scheduled recurrence of the task, for example, weekly or monthly.
• Next Occurrence – The date and time when the task will be performed next time.
The Tasks grid displays the first 10 tasks by default. To view more tasks per page, select 25, 50, or 100 
next to View per Page option at the bottom of the Tasks grid. To change the width of a column, drag its 
edge.
If the Tasks grid has more than one page, you can navigate through pages by using the page navigation 
arrows in the lower-right corner of the Tasks grid.
To manage tasks, use the following options on the toolbar:
• Filter – Filter the tasks by survey or event type.
• Cancel – Stop recurrence of the scheduled reports and scheduled export of responses by a task 

type. The canceled recurrence will be added to the Transaction Events page with the Task 
Cancel action type and the Delivery Schedule will be updated to No Schedule, but the 
message body, subject, and recipients will not change. 
You can cancel recurrence only for the following task types:
• Export Responses Schedule 
• Export Responses to Folder Scheduled 
• Export Responses to SFTP Scheduled 
• Export Scheduled Survey Report 
For other task types, the Cancel button is unavailable.
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General Setup
Navigation

Configuration tab > General tab > General Setup page.
You can define settings for your workgroup, portal, panel, and library. 
To save your changes, click the Save Setup button at the bottom of the General Setup page.

Workgroup Setup
In the Workgroup Setup section, you can define the following options:
• Workgroup Name – Enter the workgroup name, which appears in the application banner when 

you log in.
• Workgroup Description – Enter a short description of the workgroup.
• Theme – View the theme for the workgroup.
• ID – The workgroup ID number.
• Survey Publish Warning – Provide a custom warning that will appear in the Open Your Survey 

Now? dialog box for all survey authors in the workgroup. You can type up to 255 characters in 
the text box. If you do not specify any custom warning, the default message opens.

 This option is only available for users with the Group Administrator role.

• Enable automatic survey permanent deletion –  Allow the permanent deletion of the surveys 
from the recycle bin after a specified number of days.

 Enable automatic survey permanent deletion is available only for users with the Group 
Administrator role.

• Enable publishing to social media sites – Allow survey authors to publish Generate Link 
survey links to social media sites (for example, Facebook, Twitter, and LinkedIn) within the 
workgroup. This option is useful if corporate policy prohibits sharing the company branding on 
personal social networks.

• Enable significance testing in Cross-tab Analysis – Disable significance testing using the 
Cross-tab Analysis report for the users in the workgroup.

• Enable Public Report – Allow the workgroup members to share reports with the users that do 
not have access to the application.

• Enable Public Dashboard – Allow the workgroup members to share dashboards with the users 
that do not have access to the application.

• Automatically remove insecure code from survey designer – Removes the insecure code 
that is entered outside of the Code Blocks for the users who do not have the Edit Code Blocks 
permission selected. This option is available for Group Administrator, Survey Administrator, and 
custom roles with the Configure Workgroup Options permission selected.
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Portal Setup
In the Portal Setup section, you can define the following options:
• Enable Portal – Select the option to enable the portal.
• Portal URL – This field is completed automatically if you purchase the EFM Community Builder 

Module (VCBM) portal product.
• Portal Registration Profile – If you want your portal members to complete after they register, 

select the profile.
• Require Approval – If you want administrator to approve each portal registration before the 

user gains access to the portal, select this check box.

Panel Setup
In the Panel Setup section, you can change the default health score for the panel. The health score 
shows the average activity rate of the panelist. A number of factors determine the health score, for 
example, email opening rates, survey start and completion rates, and unsubscribe rates. The health score 
is a value from 0 to 100%.
• Healthy Panel Threshold – Enter a value for the healthy score in the provided text box.
• Unhealthy Panel Threshold – Enter a value for the unhealthy score in the provided text box.

Library Setup
In the Library Setup section, you can define the following options:
• Enable  Featured Survey Themes – Select this check box to allow users in the workgroup to use 

precreated featured survey themes. It applies to the themes on the Library > Survey Themes 
tab and on the Formatting tab in the survey designer.

• Enable Standard Survey Themes – Select this check box to allow users in the workgroup to use 
precreated standard survey themes. It applies to the themes on the Library > Survey Themes 
tab and on the Formatting tab in the survey designer.

• Enable Legacy Survey Themes – Select this check box to allow users in the workgroup to use 
precreated legacy survey themes. It applies to the themes on the Library > Survey Themes tab 
and on the Formatting tab in the survey designer.

• Enable  use of System Report Themes – Select this check box to allow users in the workgroup 
to use precreated system report themes. It applies to the themes on the Library > Report 
Themes tab and on the Formatting tab in the report designer.

• Enable use of System Survey Templates – Select this check box to allow users in the 
workgroup to use precreated system survey templates. It applies to the templates on the Library 
> Survey Templates tab and on the New menu on the My Surveys page.

If a featured (standard or legacy) theme is applied to a survey, and you clear the Enable Featured 
(Standard or Legacy) Survey Themes check box, the selected theme still appears in the Survey 
Theme menu on the Survey Formatting tab, but no other featured (standard or legacy) themes are 
available.
If a system theme is applied to a report, and you clear the Enable use of System Report Themes 
check box, the selected theme still appears in the Report Theme menu on the Report Formatting tab, 
but no other system report themes are available.
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Advanced Text Analytics
In the Advanced Text Analytics section, you can disable users in the workgroup to export the survey 
response data for the advanced text analysis by selecting the Disable Export for Text Analysis check 
box.

 The Advanced Text Analytics section is available only for the workgroups with the granted 
Advanced Text Analytics license. To enable the license, contact your system administrator.

Embedded Text Analytics
In the Embedded Text Analytics section, you can configure connection to one of the Text Analytics 
providers: Verint Text Analytics or Verint Text Analytics Services.
For Verint Text Analytics provider, type the URL to connect to the Text Analytics instance and enter 
the User Name and Password into the designated text boxes.
For Verint Text Analytics Services provider, type the corresponding URLs into the following text 
boxes:
• Text Engine – URL to the system that conducts the data analysis.
• Configuration Service – URL to the system that contains all configuration settings.
• Search – URL to the search engine.

 To disable Text Analytics connection, select Disabled.

You can test the configured connection by clicking Test below the Embedded Text Analytics section.

 The Embedded Text Analytics section is available only for the workgroups with the granted 
Embedded Text Analytics license. To enable the license, contact your system administrator.
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SMS Gateway Settings
Navigation

Configuration tab > SMS Gateway Settings tab > SMS Gateway Settings page.

You can define the SMS gateway settings for your workgroup. By default, the SMS gateway settings are 
read only. To edit the SMS gateway settings, select the Enable SMS Gateway check box.

 The SMS Gateway Settings tab is only available for the workgroups with the SMS license 
enabled. To enable the license, contact your System Administrator.

In the SMS Gateway Type list, you can select the type of the SMS gateway to be used: OPG, SMPP, 
MacroKiosk,  Telefonica SDF, or Twilio. The default value is OPG.

OPG SMS gateway type
The following settings are available for the OPG SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
Incoming Message Settings
• Incoming Message URL – URL to which the SMS gateway sends messages.
• Incoming Message Username – User name used by the SMS gateway when sending messages 

to the EFM system.
• Incoming Message Password – Password used by the SMS gateway when sending messages to 

the EFM system.
Originating Number Settings
• Originating Number – Number from which the participants receive messages and to which they 

can reply.
Invitation Originating Identity Settings
• Invitation Originating Identity - Originating number or branded text that the invitation 

message comes from. This setting is optional.
• Request Reply for Contact List Invitations - Option that indicates if the message can be 

replied to the sender. When the check box is selected, then originating number is used for sending 
the invitation messages. By default, the check box is cleared, in this case the participants receive a 
message from the company.
This value applies only to SMS invitations and does not apply to two-way SMS surveys.

Extended parameters
• Send Message Encoding – Gateway specific coding that is used for SMS messages. The default 

value is windows-1252.
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
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• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

SMPP SMS gateway type
The following settings are available for the SMPP SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
• Second Outgoing Message Server – Backup server or address for sending messages via the 

SMPP-Type 1 SMS gateway.
• Port – Port for sending messages via the SMS gateway.
• SMPP Version – Indication of the SMPP protocol version. The default value is v3.3.
Originating Number Settings
• Originating Number – Number from which the participants receive messages and to 

which they can reply.
• Source TON – Type of number (TON) value of a sender for sending messages via the SMS 

gateway.
• Source NPI – Numbering plan identification (NPI) value of a sender for sending messages via the 

SMS gateway.
• Destination TON – Type of number (TON) value of a recipient for sending messages via the SMS 

gateway. The default value is 0.
• Destination NPI – Numbering plan identification (NPI) value of a recipient for sending messages 

via the SMS gateway.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from. This setting is optional.
• Invitation Source TON – TON value of a sender for sending the first messages via the SMS 

gateway.
• Invitation Source NPI – NPI value of a sender for sending the first messages via the SMS 

gateway.
• Invitation Destination TON – TON value of a recipient for receiving the first messages via the 

SMS gateway. The default value is 0.
• Invitation Destination NPI – NPI value for receiving the first messages via the SMS 

gateway.
Extended Parameters
• Receiver Parameters – Parameters of a recipient.
• Transmitter Parameters – Parameters of a sender.
• Send Message Encoding – Gateway specific coding that is used for SMS messages. The default 

value is utf-8.
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
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• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

MacroKiosk SMS gateway type
The following settings are available for the MakroKiosk SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
Incoming Message Settings
• Incoming Message URL – URL to which the SMS gateway sends messages.
Originating Number Settings 
• Originating Number – Number from which the participants receive messages and to which they 

can reply. 
• Originating Routing Token – Value used for sending messages via the SMS gateway. This 

setting is optional.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from.  This setting is optional.
• Service ID – Value used for sending messages via the SMS gateway.
Extended Parameters
• Send Message Encoding – Gateway specific coding that is used for SMS messages. The default 

value is utf-8.
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

Telefonica SDF SMS gateway type
The following settings are available for the Telefonica SDF SMS gateway type:
Outgoing Message Settings
• Outgoing Message Server – Server or address for sending messages via the SMS gateway.
• Outgoing Message Username – User name used to authenticate with the SMS gateway.
• Outgoing Message Password – Password used to authenticate with the SMS gateway.
• Outgoing Header Username – User name value used to communicate with the SMS gateway.
• Outgoing Header Password – Password value used to communicate with the SMS gateway.
Incoming Message Settings
• Incoming Message URL – URL to which the SMS gateway sends messages.
• Incoming Message Username – User name used by the SMS gateway when sending messages 

to the EFM system.



Configuration SMS Gateway Settings

EFM User Guide 1412

Confidential and Proprietary Information of Verint Systems Inc.

• Incoming Message Password – Password used by the SMS gateway when sending messages to 
the EFM system.

Originating Number Settings
• Originating Number – Number from which the participants receive messages and to which they 

can reply.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from.  This setting is optional.
Extended Parameters
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

Twilio SMS gateway type
The following settings are available for the Twilio SMS gateway type:
Twilio Settings
• Account SID and Authentication Token – Credentials that are received while configuring Twilio 

account. 
• Webhook URL – The URL to the machine where ESI service is running.
Originating Number Settings
• Originating Number – Number from which the participants receive messages and to which they 

can reply.
Invitation Originating Identity Settings
• Invitation Originating Identity – Originating number or branded text that the invitation 

message comes from.  This setting is optional.
Extended Parameters
• HTTP Accept Language – Language used when the SMS Gateway opens a survey in the EFM 

system. The default value is cy;q=0.8,en;q=0.4.
• Filtered Out Error Codes – List of unreported errors. The default value is 1105,1220.

General settings
The following settings are available for all SMS gateway types:
• Start Sending Time – Specifies the time of the day when sending of outgoing SMS invitation 

messages starts.
• Stop Sending Time – Specifies the time of the day when sending of outgoing SMS invitation 

messages stops.
• Sending Time Zone – Specifies the time zone used to interpret the Start Sending Time and 

Stop Sending Time.
• Sending Days – Specifies the days of the week when sending of outgoing SMS invitation 

messages occurs.
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• Opt Out Terms – Specifies the terms that, if included in a participant's response SMS, denote 
that a participant opts out of taking a survey. The default opt out term is stop. You can add more 
terms in a pipe (|) delimited list.

 If no sending days are selected, the error message notifying that no SMS invitation is sent 
appears after clicking the Save Setup button.

• Error Survey URL – Specifies the address of a survey that is used to collect error messages.
• Maximum Outgoing Messages per Second – Specifies the maximum number of outgoing 

messages per second. The default value is 0. This setting is optional.

SMS staging directories
For each valid SMS gateway, the defined SMS gateway settings are stored in the staging directories located 
in the AppData directory. You can find the staging directories in the following locations:
• {EFM install} AppData/{Groupld}/sms/incoming
• {EFM install} AppData/{Groupld}/sms/realtime
• {EFM install} AppData/{Groupld}/sms/archive
• {EFM install} AppData/{Groupld}/sms/error
• {EFM install} AppData/{Groupld}/sms/process
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Publishing Setup
Navigation

Configuration tab > Publishing tab > Publishing Setup page.

You can define the Web locations and options for publishing surveys within the workgroup and test your 
settings.

 To save your changes, click the Save Setup.

You can configure the following settings:
• Survey Engine Path – Path to the CGI script used to process the surveys.
• Web Survey Location – Directory on the Web server where the published surveys for the 

current workgroup are located.
The Publish To section contains three options:
• Local Web Server – Surveys are published to the local file system. The path to the local Web 

server where the surveys are posted is specified in the Local Publish Path text box. It is the 
default setting. You can update it by clicking the Refresh Local Publish Path icon next to the 
text box.

• Network Share – Surveys are published to the shared network directory. The path to the shared 
network directory where your surveys are posted is specified in the UNC File Path field. This 
setting is useful if the application is hosted on a Web server farm.

• Remote FTP Server – Surveys are published to the remote FTP server. You need to provide the 
following information if you use this option:
• FTP Server Name
• FTP Port Number
• Subfolder to publish to
• User Name
• Password
• File Transfer Protocol (FTP or SFTP)

On the Publishing Setup page, you can also do the following:
• Test – Test the survey publishing options. The passing or failing message appears.
• Clear Cache – Clear the cache content.
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Mail Setup
Navigation

Configuration tab > Mail Settings tab > Mail Setup page.

You can select what type of mail server to use and customize the address preferences for the invitations 
and reminders emails. 

 

The Mail Setup page

 To apply your changes, click Save Setup.

All outgoing system messages have a unique mailing ID and message ID. So you can track all the emails in 
the email system logs, such as Hurricane. Examples of emails include: user name/password emails, 
triggers, case emails, schedule emails, participant emails, share report/dashboard/survey/data set, portal 
messages, test messages, export, messages sent by Web Services (errors), long running tasks, notify users, 
review actions, panel reports, survey invitations, etc.

Mail Server
In the Mail Server section, you can select between the SMTP and Hurricane mail server types. 
Depending on the server type that you select, the Mail Server section shows different properties.

SMTP Mail Server
• SMTP Server – Define the email server that is used by the EFM application.
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• SMTP Port – Specify the SMTP port for the SMTP server defined. The default value is 25.
• SMTP Time Out (Seconds) – Specify the time in seconds that EFM waits for a response from the 

SMTP server.  The default value is 60.
• Secure Options – Select the secure option of SSL and/or TLS encryption that is used for a 

connection for the SMTP mail server.
The following options are available:
• Auto – Select the secure option to decide automatically which SSL or TLS options to use. If the 

server does not support SSL or TLS, then the connection continues without any encryption.
• SSL On Connect – Select the secure option if the connection should use SSL or TLS encryption 

immediately.
• Start TLS – Select the secure option that elevates the connection to use TLS encryption 

immediately after reading greeting and the capabilities of the server. If the server does not 
support the Start TLS extension, then the connection fails and a NotSupportedException will be 
thrown.

• Start TLS When Available – Select the secure option that elevates the connection to use TLS 
encryption immediately after reading the greeting and capabilities of the server, but only if the 
server supports the Start TLS extension.

• None – No SSL or TLS encryption is used.

Authentication
• Type – Select the authentication type from the following options:

• None – Select if no authentication is required.
• Auth Login – A method of email authentication that passes the user name and password 

encrypted via base-64 encryption.
• CRAM-MD5 – A method of email authentication used by LDAP servers. The password is 

encrypted using the MD5 algorithm.
• DIGEST-MD5 – A method of SASL email authentication that performs authentication to the 

directory server with a user name and password in a way that does not expose the clear-text 
password.

• NTLM – A method of email authentication that performs authentication to a server by using an IP 
Address.

• PLAIN – A method of SASL email authentication that performs authentication to the directory 
server with a user name and password. The client can identify itself with a user name rather than a 
DN (Distinguished Name).

• SCRAM-SHA-1 – A method of email authentication that performs authentication by verifying the 
name of a user, password, and authentication database.

• SCRAM-SHA-256 – A method of email authentication that performs authentication by requiring 
the server-side password hashing.

• Account – Enter the account to use when authenticating.
• Password – Enter the account password when authenticating.
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Hurricane Mail Server
• Hurricane Server – Define the email server that is used by the EFM application.
• Hurricane Account – Enter the account data.
To test your settings functionality, click Test.

Mail Preferences
In the Mail Preferences section, you can turn on tracking of the Confirmed Received invitation status by 
selecting the Enable "Confirmed Received" tracking check box (selected by default).

 The Enable "Confirmed Received" tracking check box is available for both SMTP and the 
Hurricane mail servers.

With this functionality, survey authors can track the Confirmed Received status on a user level by 
including the tracking pixel in the emails. Note that the tracking pixel can increase the chances that emails 
are viewed as spam. To maximize response rates, survey authors can turn off this feature if tracking of 
the Confirmed Received status is not critical.

 To turn on this functionality on a survey level, see Advanced Features of invitation, page 625. To 
turn on this functionality on a workgroup level, contact your Group Administrator.

If the Enable "Confirmed Received" tracking check box is selected, the Confirmed Received status is 
displayed in the following places of the EFM application:
• Collect tab > Invitations page and invitation mail details dialog box (see Invitations page, 

page 631).
• Collect tab > Manage Participants page > Campaign Status, Initial Invitation Status, First 

Reminder Status, Second Reminder Status, Third Reminder Status, Fourth Reminder 
Status, and Thank You Status columns.

Address Preferences
The Address Preferences section contains the From Address, Reply To Address, To Address, and 
System Address subsections. You can use them to define your email address preferences.
• From Address – The email address that the recipients of the email invitation see as the sender.

• Enable address piping in From field of Invitation – Turn on the address piping in the From 
text box of invitation email.

• Enable Survey Author's email address to be used as "From" address on invitations and 
reminders – Make a survey author's email address visible in the From text box. 

• Enable all emails in the list below to be used as "From" addresses on invitations and 
reminders – Make all email addresses from a defined list visible in the From text box and provide 
the ability to manage that list.
- To add an email address to the list, click the New button.
- To delete an email address from the list, select it in the list, and then click the Delete button.
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• Reply To Address – The email address that the recipients reply to if they select to reply to the 
survey invitation.
• Enable address piping in Reply To field of Invitation – Turn on the address piping in the 

Reply To text box of invitation email.
• Enable Survey Author's email address to be used as "Reply To" address on invitations 

and reminders – Make a survey author's email address visible in the Reply To text box. 
• Enable all emails in the list below to be used as "Reply To" addresses on invitations 

and reminders – Make all email addresses from a defined list visible in the Reply To text box 
and provide the ability to manage that list.
- To add an email address to the list, click the New button.
- To delete an email address from the list, select it in the list, and then click the Delete button.

• To Address
• Enable address piping in To field of Invitation – Turn on the address piping in the To text box 

of invitation email.
• System Address

• System From Address – Define an alternative system address.

Related topics 
Add an email address to list, page 1419
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Add an email address to list
Navigation

Configuration tab > Mail Settings tab > Mail Setup page > Address Preferences section.

You can add new email address to the list.

Procedure 
1 Go to the Configuration tab > Mail Settings tab > Mail Setup page.
2 In the From Address section, click the New button. 
3 In the Add Email dialog box, in the Email Address box, type the email address that you want to add.
4 In the Display Name box, type the name of the email sender.
5 Click OK.
6 Click the Save Setup button.
7 To delete an email address from a list, select the email address, and then click the Delete button.
8 Click the Save Setup button. 
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Case Setup
Navigation

Configuration tab > Case Setup tab > Case Setup page.
 

The Case Administrators can customize the case priority options and create case properties as additional 
values that can be set by a user to describe, categorize, and report on cases. Also, they can configure the 
case escalation emails.

The Case Setup page
   

 The Case Setup tab is available only if the Configure Case Settings permission check box is 
enabled for the user role.

  

In the Priorities section, the following columns are available:
• Value – Set the numeric value of each priority option. The range of values is from 1 to 7, where 1 

refers to the highest priority.
• Label – Enter the label text for the priorities into the text boxes. When you change the priority 

label, it is updated throughout the application. The character limit for the text labels is 64 
characters. By default, the following priority labels are available:
• Critical
• Very High
• High
• Medium
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• Low
• Very Low
• Negligible

• Default – Set the default priority option for all new cases and case triggers by selecting the 
corresponding option.
In the Case Properties section, the Add New Property link appears. Click the Add New Property 
link to add the following custom properties: Choose One, Date, or Text.

 You can add multiple properties of the same type.
   

The added case property appears in the Case Properties section as a hyperlink followed by the property 
choices.

You can move the rows with properties by using the  icon in the Order column. The Case Properties 
appears in the set order on the Case Details page, in the Case Properties section.
You can edit the case properties by using the Edit Case Property dialog box, which opens when you click 
the property name.

 Editing choice labels affects all cases that currently use that choice.

In addition, you can define the visibility criteria for the case properties. 

 By default, the new custom property is visible to all case users and appears on a Case Details 
page, in the Case Properties section. The Not Set check box is the default choice option.

You can hide the case properties for the case users by clearing the check box in front of the property that 
you want to hide.
You can also make the property required and select the status in which to enforce the requirement by 
clicking the Required check box and selecting the needed option from the Status for Required list next 
to the needed property. The required properties can have the following statuses: Open, On Hold, 
Closed.

 The hidden properties become unavailable for all cases.

In the Case Tabs Configuration section, you can choose the order in which to display the tabs on the 
Case Details page.
In the Case Escalation section, you can define when the icon appears in the Cases grid next to the cases 
that have not been updated for a certain time period. Enter the number of days in the text box in the 
Case Escalation section. By default, the time period is set to seven calendar days.

 You can enter only whole numbers in the text box.
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Add Case Property
Navigation

Configuration tab > Case Setup tab > Case Setup page.

The Case Administrators can customize the case priority options and create custom properties as 
additional values that can be set by a user to describe, categorize, and report on cases. Also, they can add 
the case property.

Procedure 
1 Go to the Configuration tab > Case Setup tab.
2 In the Case Properties section, click the Add New Property link.
3 In the Add Case Property dialog box, in the Type menu, select the case property type.

The following options are available:
• Choose One – Filter the cases by using the property followed by choices. 

 You can select only one choice for the filtering.

• Date – Filter the cases by using the following options for date-based properties:
- Equal To
- Not Equal To
- Less Than
- Greater Than
- Less Than Or Equal
- Greater Than Or Equal

• Text– Filter the cases by using the following options for text-based properties:
- Equal To
- Not Equal To
- Contains
- Does Not Contain
- Begins With
- Ends With

4 In the Label text box, type the name for the case property.
5 In the Choice column, enter the text for the property choices into the corresponding text boxes.
6 In the Enabled column, select the check box next to the choice to make it available on the Case 

Details page for the user.

 By default, all choices are selected.

7 To add more choices, click the Add Choice link.
8 Click Add. 

A new case property appears on the Case Setup page and on the Case Details page.
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 The Value, Choice, and Enabled columns are available only for the Choose One case property 
type.
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Case Escalation
Navigation

Configuration tab > Case Setup tab > Case Setup page > Case Escalation section.

You can define which cases need to be reported in the emails by adding rules. You need to specify criteria 
for the case escalation emails and add the email contacts. When the criteria are met for a case, a 
notification email is sent to the specified emails. The email contains a list of cases matching the rules with 
their URL. The list is ordered from the newest to the oldest cases.
You can apply the data, age, and date filters to the cases.

Data Filter
In the Data Filter section, you can define the filter criteria based on your cases data. To add new criteria, 
click the Add Another Criteria link. The menus appear where you can specify the filter parameter, 
expression, and value.
• Parameter – Select the parameter by which you want to filter your cases data in the menu. 

The following options are available:
• Assigned to
• Priority
• Status
• Contact's Email
• Contact's First Name
• Contact's Last Name
• Contact's Business
• Contact's Phone
• Date Opened
• Date Closed
• Last Modified
• Created by
• Source
• Title
• Description

• Expression – Select the expression in the menu to make a comparison between Parameter and 
Value. The options for expression may vary depending on the selected parameter. The following 
options are available:
• Equals
• Does Not Equal
• Less than
• Greater than
• Less than or equal
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• Greater than or equal
• Contains
• Does Not Contain
• Begins With
• Ends With

• Value – Select the value for filtering criteria in the menu.  The options vary depending on the 
selected parameter.  For example, for the Status parameter, you need to select the needed case 
status from menu, and for the Contact's Email parameter, you need to type the contact data in 
the text box. For the date-related parameters, you need to specify a date either by using the text 
box or the calendar icon.

• Save – Click the link or anywhere else in the dialog box to save your criteria.
If you add multiple criteria, you can combine them by using the following Match options:
• All Criteria – All the criteria must be met.
• At Least One Criterion – At least one of the criteria must be met.
• Advanced – The menus with parentheses and the And / Or operators appear next to each 

criterion. The And operator defines that two or more filters linked together are true. The Or 
operator defines that one of the filters linked together is true.

• Remove – Click the  icon  to delete the filter criteria.

• Up/Down – Click  or  arrow to move the selected filter criteria up or down one level in the 
list. Filters are applied in a sequential manner, and their position in the list is important.

Age Filter
In the Age section, you can set the filter based on the date when cases are last modified, created, or 
closed X days (hours) ago. This filter is combined with the data filter. For example, you can set the 
following criteria:
Data Filter: Cases that are assigned to User1
and
Age: Cases that are modified (created or closed) in X days.

Date Filter
In the Date Filter section, you can set the filter based on the date when cases are opened, closed, or last 
modified and based on the selected time period.
• Select Date Field – Ffilter the cases based on their modification date.

The following options are available:
• None – Applies no date filter and is selected by default.
• Opened Date – Applies the filter based on the date when the case was opened.
• Last Modified Date – Applies the filter based on the date when the case was last changed.
• Closed Date – Applies the filter based on the date when  the case was closed.

• Time Period – Ffilter the cases based on a certain time period.
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The following options are available:
• None – Applies no time period filter and is selected by default.
• Today – Shows the cases submitted today.
• Current Week – Shows the cases for the current week, no matter the current date.
• Current Month – Shows the cases for the current month, no matter the current date.
• Current Quarter – Shows the cases for the current three months, no matter the current date.
• Current Year – Shows the cases for the current calendar year, no matter the current date.
• Year to Date – Shows the cases for the period starting January 1st of the current year up until 

the current date.
• Last Week – Shows the cases for the past week.
• Last Month – Shows the cases for the past month.
• Last Quarter – Shows the cases for the past three months.
• Last Year – Shows the cases for the past year.
• Custom Dates – Shows the cases for the specific date range. When the Custom Dates option is 

selected, the Start Date and End Date text boxes appear. You can enter the date range in the 

corresponding text boxes manually or by clicking the  icon. 
To set the default values for the date filters, click the Clear All Date Filters link.

Delivery Options
You can schedule sending your case escalation emails by using two different methods:
• No Scheduling – Send your email later.
• Send at a specific date and time – Specify a date and time when you want to deliver your 

email. You can either type the date and time manually into the available text field or select the 
date and time from pop-up menus. Select a valid start date and time, otherwise the case 
escalation email will not be saved.

By clicking the Show Recurrence Options link, you can specify the recurrence options for your case 
escalation email delivery. Use this functionality to send an email multiple times on a daily, weekly, or 
monthly basis. In addition, you can set an end date or select No End Date.
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Add rules for case escalation emails
Navigation

Configuration tab > Case Setup tab > Case Setup page > Case Escalation section  > Add Rules link > 
Add Condition dialog box.

Procedure 
1 Go to the Configuration tab > Case Setup tab.
1 In the Case Escalation section, click the Add Rules link. 
2 In the Add Condition dialog box, in the Description text box, enter a short summary of the rule.
3 On the Criteria tab, click the Add Another Criteria link. 
4 In the parameter list, select the parameter by which you want to filter your case data.
5 In the expression list, select the expression.
6 In the value list, select the value for filtering criteria.
7 Click the Save link.
8 To add more criteria, click the Add Another Criteria link.
9 Specify if either all or any of the criteria need to be met by selecting the corresponding option to the 

right of the Match section.
10 Click the Age section to expand it.
11 Select the check box next to the option you want to use, select the expression, type the number in the 

text box, and then select Days or Hours from the menu. For example, Date Last Modified < 5 
Days.

12 Click the Date Filter section to expand it.
13 Select an option in the Select Date Field menu, and then select an option in the Time Period menu.
14 Click the Email tab.
15 In the To text box, type the email address of the person to receive the email.
16 In the Cc and Bcc text boxes, type the email addresses if required.
17 In the Subject text box, type the case escalation short description.
18 Set the delivery options for your email.
19 Click OK. 

The escalation email will be sent according to the settings configured on the Criteria and Email tabs 
and the delivery options.
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Edit rules for case escalation
Navigation

Configuration tab > Case Setup tab > Case Setup page > Case Escalation section  > click a link of a rule 
> Edit Condition dialog box.

You can edit the case escalation criteria on the Case Setup page by using the Edit Condition dialog box. 
You can access the Edit Condition dialog box by clicking the rule description link on the Case Setup page.
You can move the rules up and down, copy, or delete the rules by using the corresponding icons.
When you click the rule description link, the Edit Condition dialog box opens. You can edit the existing 
rules and add new criteria by following the same steps as in the Add Condition dialog box.
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Data policies 
Navigation

Configuration tab > Data Policies page.
Use Data Policies to manage surveys, responses, notifications, and exclusions by selecting options to 
enforce survey and response behavior.

 To view the Data Policies page, ensure that you have the    Manage Data Policies permission. 
By default, it is enabled for Group Administrators and Survey Administrators.

Data Policies supports the four tabs, Surveys, Responses, Notifications, and Exclusions,  that describe how 
to configure parameters to permanently delete surveys and responses. 
• Surveys tab: Add a configuration option to enforce how long your surveys will remain open. In 

addition, you can automatically move closed surveys to the Recycle Bin, and permanently delete 
surveys after a fixed period of time.

• Responses tab: Configure your system to automatically delete any responses after a fixed period 
of time, permanently delete responses for closed surveys after a fixed period of time, or  select to 
keep responses.
If the workgroup is FI-enabled, response data present in  Feedback Intelligence must be deleted 
manually and is not covered by these settings.

• Notifications tab: Configure your system to notify  survey owners and other email recipients 
about upcoming deletions. 

• Exclusions tab: If your surveys are configured to be deleted automatically, you can configure 
your system to exclude surveys that you want to keep from the automatic deletion process.

Related topics 
Set a scheduled automatic response deletion, page 1432
Set a scheduled automatic survey closure, page 1429
 Set a scheduled automatic survey deletion, page 1430
Set a scheduled permanent response deletion, page 1432
Set a scheduled permanent survey deletion, page 1431
Set notifications for survey owners about  scheduled actions, page 1433
Set periodical reminders about scheduled deletions, page 1434
Exclude surveys from automatic deletion, page 1434
 

Set a scheduled automatic survey closure
Navigation

Configuration tab > Data Policies tab > Data Policies page > Surveys tab.
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Configure the time you want your surveys to remain open.  Setting up this option will help you to manage 
your survey process more efficiently.
You can also allow users to   delete surveys manually from the Recycle Bin by selecting the Allow users to 
permanently delete surveys from the Recycle Bin check box. 

Before you begin 
• To view the Data Policies page, ensure that you have the    Manage Data Policies permission. By 

default, it is enabled for Group Administrators and Survey Administrators.

Procedure 
1 Go to the Configuration  tab > Data Policies tab > Surveys tab. 
2 In the Option section, select the Enforce a maximum amount of time for a survey to remain 

open check box, and specify a value greater than 0. By default, it is set to 90 days.

 When you  set the value, it affects  other settings in the following way:
Any open surveys that do not have a scheduled close date set, are updated with a close date 
according to the value you defined in this option, for example, surveys will close after 90 days 
from the day the option was set.
Any open surveys that have a scheduled close date set, their scheduled close date remains the 
same as before, and are not impacted by this option.
Any new surveys created in the workgroup, have a close date according to the value defined, for 
example, will close 90 days after the survey opens.

All settings that you define are saved automatically.
When configured, settings are saved, and the User Logs > Transaction Events page is updated with 
information about who made the changes and when.

 Set a scheduled automatic survey deletion
Navigation

Configuration tab > Data Policies tab > Data Policies page > Surveys tab.
You can configure your system to  automatically move closed surveys to the Recycle Bin after a fixed 
period of time, or you can select to keep surveys. 

 If the workgroup is FI-enabled, response data present in  Feedback Intelligence must be deleted 
manually and is not covered by these settings.

Before you begin 
• To view the Data Policies page, ensure that you have the    Manage Data Policies permission. By 

default, it is enabled for Group Administrators and Survey Administrators.

Procedure 
1 Go to the Configuration  tab > Data Policies tab > Surveys tab. 
2 In the Automation section, select the Automatically move surveys to the Recycle Bin when 

closed after fixed period of time option, and specify a value greater than 0. 
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By default,  the None option is selected and surveys are not moved to the Recycle Bin .

 When selected, the first scheduled task is executed in seven days to allow users to receive a prior 
notification.

All settings that you define are saved automatically.
Following the setting configuration, task executions that take place are logged in the Task Logs  with 
information about what surveys were deleted and when.
When configured, settings are saved, and the User Logs > Transaction Events page is updated with 
information about what surveys were deleted and when.

Set a scheduled permanent survey deletion
Navigation

Configuration tab > Data Policies tab > Surveys page.

You can configure your system to permanently delete surveys that are located in the Recycle Bin after a 
fixed period of time, or you can select to keep surveys.

 For surveys moved to the Recycle Bin before the option was activated, the automatic permanent 
deletion date is scheduled based on the date the option was activated (that is in 90 days from the 
day when auto-deletion was scheduled, not from when the surveys were moved to Recycle Bin).

Before you begin 
• To view the Data Policies page and delete the surveys permanently, ensure that you have the    

Manage Data Policies and the Permanently Delete Surveys permissions. By default, it is 
enabled for Group Administrators and Survey Administrators.

Procedure 
1 Go to the Configuration  tab > Data Policies tab > Surveys tab. 
2 In the Data Retention section, select the Permanently delete surveys located in the Recycle 

Bin after a fixed period of time option, and specify a value greater than 0.
By default, the surveys are not deleted and the None option is selected.

 When selected, the first scheduled task is executed in seven days to allow users to receive a prior 
notification.

 When you  set the value, it affects  other settings in the following way:
Any surveys that are used in data sets and Unified Data Sets, are not deleted and this information 
is tracked in Task Details.
Any surveys added to Advanced Dashboard will be deleted according to the value you set even 
though you cannot delete them manually.

All settings that you define are saved automatically.
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Following setting configuration, task executions that take place are logged in the Task Logs  with 
information about what surveys were deleted and when.

When configured, settings are saved and the User Logs > Transaction Events page is updated with 
information  about what surveys were deleted and when.

Set a scheduled automatic response deletion
Navigation

Configuration tab > Data Policies tab > Data Policies page > Responses tab.
You can configure your system to delete responses automatically after a fixed period, or  select to keep 
responses.  You can change the default values of time-based settings to any value greater than 0.

 If the workgroup is FI-enabled, response data present in  Feedback Intelligence must be deleted 
manually and is not covered by these settings.

Before you begin 
• To view the Data Policies page, ensure that you have the    Manage Data Policies permission. By 

default, it is enabled for Group Administrators and Survey Administrators.

Procedure 
1 Go to the Configuration  tab > Data Policies tab > Responses tab. 
2 In the Automation section, select the Automatically delete any response after a fixed period 

of time option, and specify a value greater than 0. The default value is 180 days and applies to all 
surveys, including the ones in a Design mode.
By default, the None option is selected.

 When selected, the first scheduled task is executed in seven days to allow users to receive a prior 
notification.

All settings that you define are saved automatically.
When configured, settings are saved and the User Logs > Transaction Events page is updated with 
information about who made the changes and when.

Set a scheduled permanent response deletion
Navigation

Configuration tab > Data Policies tab > Data Policies page > Responses tab.
You can configure your system to permanently delete responses for closed surveys after a fixed period, 
or select to keep responses.

Before you begin 
• To view the Data Policies page and delete the responses permanently, ensure that you have the    

Manage Data Policies permission. By default, it is enabled for Group Administrators and Survey 
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Administrators.

Procedure 
1 Go to the Configuration  tab > Data Policies tab > Responses tab. 
2 In the Data Retention section, select the Permanently delete responses for closed surveys 

after a fixed period of time option, and specify a value greater than 0. The default value is 90 days.

 When selected, the first scheduled task is executed in seven days to allow users to receive a prior 
notification.

The None option is selected by default.
All settings that you define are saved automatically.
When selected, an automated nightly process checks the time that has passed after a survey is closed. If 
this is more than the specified number of days, the responses are permanently deleted.
Following the setting configuration, task executions that take place are logged in the Task Logs
(permanent delete) with information about which responses were deleted and when.
When configured, settings are saved and the User Logs > Transaction Events page is updated with 
information about who made the changes and when.

Set notifications for survey owners about  scheduled actions
Navigation

Configuration tab > Data Policies tab > Data Policies page > Notifications tab.
You can set one-time or periodical  notifications about scheduled survey or response deletions for survey 
owners and users with whom the survey is shared.
You receive a separate email message for each survey.

Before you begin 
• To view the Data Policies page, ensure that you have the    Manage Data Policies permission. By 

default, it is enabled for Group Administrators and Survey Administrators.
• To receive notifications, you must  be a Group or Survey Administrator, a user with the Data 

Retention Notifications permission, a survey owner, or a user with whom the survey is shared.

Procedure 
1 Go to the Configuration  tab > Data Policies tab > Notifications tab.
2 In the Survey Specific Notifications section, select the Notify survey owners and shared users 

starting a fixed period of time before the deletion option, and the value greater than 0. By 
default, it is set to 90 days.

3 To schedule notifications recurrence, in the Recurrence Options list, select the needed options.
All settings that you define are saved automatically.
When configured, settings are saved, and the System Tasks > Tasks page is updated with the list of 
users and email addresses who received the notification.
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Set periodical reminders about scheduled deletions
Navigation

Configuration tab > Data Policies tab > Data Policies page > Notifications tab.
You can set a reminder about all scheduled survey and response deletions in your workgroup to all users 
of the workgroup and to any additional recipients who have the Data Retention Notifications 
permission. 

Before you begin 
• To view the Data Policies page, ensure that you have the    Manage Data Policies permission. By 

default, it is enabled for Group Administrators and Survey Administrators.
• To receive notifications, you must be a Group or Survey Administrator, a user with the Data 

Retention Notifications permission or a user added to the Additional Email Recipients list, a 
survey owner, or a user with whom the survey is shared.

Procedure 
1 Go to the Configuration tab > Data Policies tab > Notifications tab.
2 In the Survey Summary Notifications section, select the Notify users periodically via email 

about upcoming deletions check box. By default, it is set to 14 days.
3 To add additional recipients, in the Additional Email Recipients list, click the New button and type 

email address and display name.
All settings that you define are saved automatically.
When configured, settings are saved, and the System Tasks > Tasks page is updated with the list of users 
and email addresses who received the notification.

Exclude surveys from automatic deletion
Navigation

Configuration tab > Data Policies tab > Data Policies page > Exclusions tab.
If your surveys are configured to be deleted automatically, you can configure your system to exclude 
surveys that you want to keep from the automatic deletion process. Only surveys are currently 
supported for exclusions and data policies.
All surveys added to the Exclusions list, are  excluded from  all automated retention policies. If you want to 
delete the surveys that are excluded from the automatic deletion, you must do it manually.

Before you begin 
• To view the Data Policies page and delete the surveys permanently, ensure that you have the    

Manage Data Policies and the Permanently Delete Surveys permissions. By default, it is 
enabled for Group Administrators and Survey Administrators.

• To exclude other user's surveys, ensure that you have the Group Administrator role with the 
View All Surveys permission. 

Procedure 
1 Go to the Configuration tab > Data Policies tab > Exclusions tab.
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2 Click the Add Project button.
3 In the Add Project to Exclusions List dialog box, select a survey to exclude, and click Add.

 You can select your own surveys to exclude, as well as  surveys shared with you. Surveys in the 
Design mode are also available and can be added to the Exclusions list.

4 (Optional) If you select a survey to exclude from automatic deletion, which is currently in the recycle 
bin, you have the option to restore the survey from the recycle bin, or leave it in the recycle bin by 
clicking the Yes or No button correspondingly. In both cases, the surveys remain excluded and will 
not be deleted.

5 (Optional) To remove a survey from the Exclusions list, select the survey in the grid, and click the 
Remove from List button. 

After you remove surveys from the Exclusions list,  the  automatic survey deletion will apply to these 
surveys, during the next task run.

When configured, settings are saved, and the User Logs > Transaction Events page is updated with 
information about who made the changes and when.
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Workflow
Navigation

Configuration tab > Workflow tab > Workflow page.

You can assign the users in your workgroup a role of the survey reviewer or assisted survey author. These 
roles are used in the survey approval process.
In some companies, the survey and invitation content must be reviewed and approved by someone 
other than the survey author (for example, marketing or legal department) before the survey becomes 
available externally.
Users who require approval to open a survey are called assisted survey authors. Users who approve a 
survey are called survey reviewers. An assisted survey author cannot open a survey or republish a live 
survey without the prior reviewer's approval of the content. A survey reviewer can accept or decline a 
survey submitted for review.

Assign user a survey reviewer role

Procedure 
1 Go to the Configuration tab > Workflow tab.
2 On the Workflow page, in the Users text box, enter a partial or whole user name.
3 Select the user name to whom you want to assign a survey reviewer role.
4 To add the user name to the Survey Reviewers list, click the right double arrows button.

 To cancel the assignment and move the user name back to the Users list, click the  arrow.

Assign user an assisted survey author role

Procedure 
1 Go to the Configuration tab > Workflow tab.
2 On the Workflow page, in the Users text box, enter a partial or whole user name.
3 Select the user name to whom you want to assign an assisted survey author role.
4 To add the user name to the Assisted Survey Authors list, click the   left double arrows button.

 To cancel the assignment and move the user name back to the Users list, click the  arrow.
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External Data Sources
Navigation

Configuration tab > External IDs tab > External Data Sources section.

In the External Data Sources grid, you can add and delete external data sources and set one of them as 
default.
The name of the new data source should be unique.
The following columns are available in the External Data Sources grid:
• External Data Source Key – Name of the data source that is used as an ID of the external 

source when importing data. To edit the data source description, lick a data source name.
• Description – Name or short explanation of the data source key.
• Default – Data source that is used by default. The default external source is used when an 

external ID is provided without a specific reference to an external source name.
By default, your external data sources are sorted by the External Data Source Key column in the 
External Data Sources grid. If you want to change how your data sources display in the grid, click a 
column header (External Data Source Key or Description). An arrow appears up (ascending) or down 
(descending) to show the sort order. You can also change a column width by dragging the edge of the 
column header.
The default number of data sources per page is 10; however, you can select up to 100 data sources to 
display in the External Data Sources grid. You can also navigate through the pages of data sources by 
using the scroll arrows at the bottom of the page.
To manage all data sources, select the check box in the upper-left corner of the External Data Sources 
grid.
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Manage external data sources
Navigation

Configuration tab > External IDs tab > External Data Sources section.

In the External Data Sources grid, you can add and delete external data sources and set one of them as 
default. The name of the new data source should be unique.

Add an External Data Source

Procedure 
1 Go to the Configuration tab > External IDs tab.
1 In the External Data Sources grid, click the New button.
2 In the Add External Data Source dialog box, in the External Data Source Key text box, enter the 

name of the data source.
3 In the Description text box, enter the data source description.
4 Click OK. 

Delete an External Data Source

Procedure 
1 In the External Data Sources grid, select the check box next to the data source that you want to 

delete.
2 Click the Delete button.

 Removing a data source will affect any new imports or responses configured to use this data 
source. All user and organization external IDs associated with this data source will also be 
removed.

3 In the confirmation dialog box, click Delete. 

Edit an External Data Source

Procedure 
1 In the External Data Sources grid, click the data source key. 
2 In the Edit External Data Source dialog box, in the Description text box, edit the data source 

description.
3 Click OK. 

 You can edit only the data source description. The data source key cannot be edited because it is 
used as an ID of the external source while importing data.
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Set an External Data Source as Default

Procedure 
1 In the External Data Sources grid, select the check box next to the data source that you want to set 

as default.
2 Click the Set as Default button. 

The data source is set as default and is marked with a green check mark in the Default column.

 The Set as Default button is available only if one external data source is selected.
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External Sources Administration Control
Navigation

Configuration tab > External IDs tab > External Connections  section.

Group and survey administrator can control the workgroup members' access to the external connections 
based on the user role set of permissions.  You can use the External Connections functionality to turn 
the external connections on or off for a workgroup. The External Connections grid displays a number 
of columns, including:
• Name – Shows the external connection name.
• Description – Shows the external connection description.
• Status – Shows whether the external connection is active or not.

 The External Connection functionality is available if you have a license to use the External Source 
feature.

You can also enable the external connections for a single user by creating a new role or editing the 
existing ones on the Administration tab,  on the Roles tab.
When the external connection is enabled for a workgroup by administrator, the External IDs side tab 
appears on the My Account page, where you can configure the external connections. When survey 
administrator turns off the external connection, which is currently in use, the dashboard items no longer 
display the data from the disabled connection.
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Single Sign On integration
Single Sign On (SSO) occurs when a user logs in to one application and remains logged in to another third-
party service automatically, regardless of the platform or domain the user is using.
A System Administrator enables SSO between EFM and other third-party service so that end users do not 
have to enter their user names and passwords every time they switch the applications.
A System Administrator creates and manages application credentials, and assigns those credentials to 
workgroups that need access to the application. In that way, users created within the specific workgroup 
gain single sign-on access to the third-party application simply by clicking the provided link in the EFM 
application.
A user can access the EFM application by entering the user name (or the email address) and the password 
provided by a System Administrator. To log in to the application, each user needs to have a unique email 
address. If the email address is assigned to two or more accounts, then access is possible by providing a 
user name.

 For details on Service Provider and Identity Provider support in EFM, refer to the EFM SSO 
Integration Guide.

If you use SSO with a certificate file (either for encryption or signing), you can see a warning message with 
the expiration period details.

SSO certificate expiration warning message
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My Account page
Navigation

Account menu  > My Account option.

You can edit your profile information, change your EFM password, define settings for your login 
experience, decide what charts are selected by default for reports, enable advanced designer options, and 
adjust email settings.

Profile Information
In the Profile Information section, you can define the following options:
• Display Name - Enter the name that you want to be displayed in the application.
• User Name - The name that you use to log in to the application. Only System Administrator can 

define and update a user name.
• Change Password - Change your password by clicking the link.
• Role - The user role determines the access level and defines permissions for users to perform a 

group of tasks in the application. System Administrator assigns a role to each user within the 
workgroup.

• Email - The email address that you use to log in to the application.
• Change Email - Change your email address by clicking the link.

 If your new email address is not unique, an error message appears saying that this email is 
already used by another user.
To confirm email address change, you need to enter the confirmation code that you receive to 
your new requested email address.

• Default Workgroup - Select your default workgroup.
• Organization - The organization that you are assigned to. System Administrator assigns users to 

the organization.
• Display the application in this language - Select the language of the application user 

interface.
• Create projects in this language by default - Select the language for your projects.

The survey languages are divided into two groups:
• Language Pack Support – This group includes the survey languages that are supported by the 

system language packs. A language pack contains the default validation messages, labels, and end 
pages of the survey in a certain language and is applied to your survey automatically.

• Additional Translation Required – This group includes all languages, except the languages 
supported by the system language packs. You need to translate the validation messages, labels, 
and end pages of your survey into the selected language.
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 If you select the blank option in the Display the application in this language list, the 
application will be displayed in the language of your web browser. 
If you select the blank option in the Create projects in this language by default list, the 
project will be created in the language selected for the application.

• Preferred Time Zone (all times in the product will refer to this time zone) - Select the 
time zone for the EFM application. All your projects will refer to this time zone.

• Reset Hidden Help Messages - Click the link to display features that were previously hidden by 
clicking Hide This or Don’t show this message again links within the application.

The Profile Information section

 After login, if the application language or time zone is not configured, the Preferences page 
opens. You can set your preferences for time, dates, and numbers to be displayed correctly in the 
EFM application. To proceed to the application, click Continue.

Define Log-on Experience
• Remember the last selected survey project on login - Select the check box to remember the 

last survey project you worked on.
• Display dashboard after login - Select the check box to display the Dashboard page after 

logging in to the application.

Reports
• Default chart type for a Choose One question
• Default chart type for a Choose Many question
• Default chart type for a Matrix question
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Survey Properties
• Enable Advanced Designer Options – Select the check box to view the following items:

• Outline and Flow, HTML, and XML tabs on the My Surveys page.
• Custom End Pages on the Pages tab.
• Group and project IDs in Survey Designer > Properties > API Access.
• Campaign ID next to the campaign name, for example, (1) Passcode.
• Culture code next to Translation > Languages.

Email
• Email confirmation is required for processes exceeding - Type the number of minutes you 

want the system to wait before sending an email confirmation message.

About
The About section displays a copyright statement and information about the Open Source Attribution, 
End User License, and Intellectual Property Notice.
To save all your changes and preferences, click Save either at the top or at the bottom of the My 
Account page.
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External Sources
Navigation

Account menu  > My Account option > External IDs tab.

You can add, configure, and delete the connection to the external sources in EFM that you have access to. 
You can add as many connections to the same external source as you want.
The External IDs grid displays the following columns:
• Name – The name of the connection.
• External Source – The source of the connection.
• Configuration – The URL of the external source.

 The External IDs tab is available only if you have a license to use the External IDs feature. 
Currently, you can configure only the Impact 360 Text Analytics source.
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Manage External Sources
Navigation

Account menu  > My Account option > External IDs tab.

You can add, edit, and delete the connection to the external sources that you have access to.

 The External IDs tab is available only if you have a license to use the External Source feature. 
Currently, you can configure only the Impact 360 Text Analytics source.

Add the Impact 360 Text Analytics source

Procedure 
1 On the External IDs page, on the toolbar, click the New button.
2 In the Configure Source dialog box define the following:

• Connection Name - Enter the name of the connection to the external source.
• External Source - The Impact 360 Text Analytics external source is selected by default.
• URL - Enter the Embedded Text Analytics URL.
• User Name - Enter the name that you use to log in to the application.
• Password - Enter the password you use to log in to the application.

3 To add a new source to the External IDs grid, click Save.

 When you save the external source configuration, your credentials are saved in the database for 
future sessions.

Edit the Impact 360 Text Analytics source

Procedure 
1 On the External IDs page, click the name of the external source that you want to edit. 
2 In the Configure Source dialog box, edit the Impact 360 Text Analytics source settings.
3 To update the external source, click Save.

Delete the Impact 360 Text Analytics source

Procedure 
1 On the External IDs page, select the check box next to the external source that you want to delete.
2 On the toolbar, click the Delete button.
3 In the confirmation dialog box, click the Remove Selected Sources button.
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 When you delete the external source that is currently in use, the dashboard items no longer 
display the data from the deleted source.
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Tasks–History view
Navigation

Account menu  > My Account option > Tasks tab > History view.

You can view the history of the tasks performed in the application, such as test survey, export responses, 
import participants, or send invitations with the History task view. You can also track the progress of the 
tasks that potentially require a longer period of time to be completed.
In the Tasks grid, the following columns are available:
• Event – The event type.
• Event Details – The name of the survey that the task refers to.
• Start Date – The date and time when the task starts.
• Elapsed Time – The time during which the task is performed.
• Status – The task statuses are in progress, completed, removed, cancelled, deferred, completed 

with errors,  or failed.
• Execution Location – The location where the task or request was executed, for example, the 

web application or scheduler service.

 The Execution Location column is available only for the group and system administrators.

The Tasks grid displays the first 10 tasks by default. To view more tasks per page, click 25, 50, or 100 
next to the View per Page option at the bottom of the Tasks grid. To change the width of a column, 
drag its edge. If the Tasks grid has more than one page, you can navigate through pages by using the 
page navigation arrows in the lower-right corner of the Tasks grid.
To manage tasks, use the following options on the toolbar:
• Cancel – Stop the task execution.

 The Cancel button is only available for the tasks with the In Progress status.

• Filter – Filter the tasks by the survey, event type, status, or task execution start and end dates.
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System Tasks – Scheduled view
Navigation

Account menu  > My Account option > Tasks tab > Scheduled view.

You can track all future tasks that you have scheduled in the application, such as test survey, export 
responses, import participants, or send invitations with the Scheduled task view.
In the Tasks grid, the following columns are available:
• Event – The event type.
• Event Details – The name of the survey the task refers to.
• Start Date – The date and time when the task starts.
• Recurrence – The scheduled recurrence of the task, for example, weekly or monthly.
• Next Occurrence – The date and time when the task will be performed next time.
The Tasks grid displays the first 10 tasks by default. To view more tasks per page, select 25, 50, or 100 
next to View per Page option at the bottom of the Tasks grid. To change the width of a column, drag its 
edge.
If the Tasks grid has more than one page, you can navigate through pages by using the page navigation 
arrows in the lower-right corner of the Tasks grid.
To manage tasks, use the following options on the toolbar:
• Filter – Filter the tasks by survey or event type.
• Cancel – Stop recurrence of the scheduled reports and scheduled export of responses by a task 

type. The canceled recurrence will be added to the Transaction Events page with the Task 
Cancel action type and the Delivery Schedule will be updated to No Schedule, but the 
message body, subject, and recipients will not change. 
You can cancel recurrence only for the following task types:
• Export Responses Schedule 
• Export Responses to Folder Scheduled 
• Export Responses to SFTP Scheduled 
• Export Scheduled Survey Report 
For other task types, the Cancel button is unavailable.
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Set a filter for a task in History view
Navigation

Account menu  > My Account option > Tasks tab > Scheduled view.

You can filter the tasks performed in the application with the History task view by applying different filter 
settings.

Procedure 
1 On the Tasks page,  click the Filter button.
2 In the Filter Tasks dialog box, from the Survey list, select the survey name for filtering.
3 In the Event Type list, select the task type for filtering.

You can filter by group of events, such as all distribution actions, all import actions, all export actions, 
or all miscellaneous.

4 In the Status list, select the task status for filtering.

5 In the Start Date text box, type the start date manually or use the Calendar icon .
The current date is selected by default.

6 In the End Date text box, type the end date manually or use the Calendar icon . 
The current date is selected by default.

 You can click the Time View icon  to open the Time Picker.

7 To apply the filter changes, click OK.
On the Tasks page, the notification appears about current filter settings.

 To change or delete the applied filter, click the Edit or Clear links correspondingly.
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Change a workgroup
Navigation

Log in to the application > Workgroup menu.

A workgroup is a set of users who can collaborate within the EFM application. You can create workgroups, 
such as R&D workgroup, HR workgroup, Marketing workgroup, and others to work in the protected 
environments. Each workgroup has access to only their environment while Group Administrator can 
manage all workgroups.
You can quickly and easily share questionnaires and other data in your workgroup, allowing other users in 
the same workgroup to view, edit, and analyze the same data.

Procedure 
1 Select the workgroup on the Workgroup menu. 
2 If you belong to more than 10 workgroups, the Change Workgroup dialog box appears.
3 Type the needed workgroup name or ID, and click Search.
4 Select the needed workgroup name, and click OK.
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Mobile apps overview
A mobile version of EFM is available on the mobile devices including the Apple iPhone, iPad, and the 
Android smart phone. 
The EFM mobile apps  provide access to:
• My Surveys folders and list of surveys
• Shared Surveys folder and list of surveys
• Ability to view Survey Status
• Option to send a Survey Link from the device
• Ability to view campaign information
• Ability to view response history
• Option to review a mobile report
For more details, click your device name:
• EFM Mobile apps–iPhone, page 1456
• EFM Mobile apps–iPad, page 1459
• EFM Mobile apps–Android, page 1461

 EFM Mobile does not currently support customer accounts that require SSO for authentication in 
the EFM platform. Currently, the EFM Mobile login page has not been designed with the custom 
header values, and therefore cannot successfully authenticate using the SSO server.
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EFM Mobile apps–iPhone

Install the EFM Mobile iPhone app 
1 Go to your iPhone App store, and then search for EFM Mobile.
2 Click Free, and then click Install. 

Log in to EFM Mobile (iPhone)
1 On the iPhone touch screen, tap the EFM Mobile App icon. 

The Welcome to EFM Mobile screen appears.

iPhone EFM Mobile Login screen

2 Enter the following required information:
• User Name – The name that you use to log in to the EFM application.
• Password – The password that you use to log in to the EFM application.
• EFM application URL – The URL where EFM is located.
• Tap Login. 

The My Surveys page appears.

My Surveys page
The My Surveys page provides access to your surveys (including SMS surveys), folders, and settings. 
Select a survey in the  list of surveys. You can also view the surveys that are shared with you. Go to the  
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Folders > Shared Surveys folder.

iPhone Mobile > My Surveys page

Procedure 
1 In the My Surveys list, select a survey. 

The survey information screen appears.
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Survey information screen

2 On the survey information screen, you have access to:
• Participant Status – View the number of participants who started and completed your survey 

and the total number of participants. The Over Quota and Branched Out statuses appear only 
if there are any data for over quota and branched out.

• Response History – Display the chart view of the response history. 
• Send Survey Link – Email your survey link and invitation to one of your contacts. 
• Mobile Report – View the mobile report for each of your survey questions. You have the ability 

to page through each question using the arrows, or tap the button in the middle to display the list 
of all  questions. In the list of questions you can tap and display responses for that question.

To display the Settings screen, change your workgroup, or log out of the EFM  Mobile Application, tap the 

Settings icon .
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EFM Mobile apps–iPad

Install the EFM Mobile iPad app 
1 Go to your iPad App store, and then search for EFM Mobile.
2 Click Free, and then click Install. 

Log in to EFM Mobile (iPad)
1 On the iPad touch screen, tap the EFM Mobile App icon. 

The Welcome to EFM Mobile screen appears.

iPad EFM Mobile Login screen

2 Enter the following required information:
• User Name – The name that you use to log in to the EFM application.
• Password – The password that you use to log in to the EFM application.
• EFM application URL – The URL where EFM is located.
• Tap Login. 

The My Surveys page appears.

My Surveys page
The My Surveys page provides access to your surveys (including SMS surveys), folders, and settings. 
Select a survey in the  list of surveys. You can also view the surveys that are shared with you. Go to the  
Folders > Shared Surveys folder.
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iPad Mobile > My Surveys page

Procedure 
1 In the My Surveys list, select a survey. 

The survey information screen appears.
2 On the survey information screen, you have access to:

• Participant Status – View the number of participants who started and completed your survey 
and the total number of participants. The Over Quota and Branched Out statuses appear only 
if there are any data for over quota and branched out.

• Response History – Display the chart view of the response history. 
• Send Survey Link – Email your survey link and invitation to one of your contacts. 
• Mobile Report – View the mobile report for each of your survey questions. You have the ability 

to page through each question using the arrows, or tap the button in the middle to display the list 
of all  questions. In the list of questions you can tap and display responses for that question.

To display the Settings screen, change your workgroup, or log out of the EFM  Mobile Application, tap the 

Settings icon .
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EFM Mobile apps–Android

Install the EFM Mobile Android app
1 Go to the EFM Mobile app for the Android.
2 Download the application. 

You can also download from the Android Marketplace.

Log in to EFM Mobile (Android)
1 On the Android touch screen, tap the EFM Mobile App icon. 

The Welcome to EFM Mobile screen appears.

Android EFM Mobile Login screen

2 Enter the following required information:
• User Name – The name that you use to log in to the EFM application.
• Password – The password that you use to log in to the EFM application.
• EFM application URL – The URL where EFM is located.
• Tap Login. 

The My Surveys page appears.

My Surveys page
The My Surveys page provides access to your surveys, folders, and settings. Select a survey from your 
list of surveys. You can also  tap the menu button, and then on the My Surveys page, click Search > 
enter the survey name.

 The SMS survey support will be added in the future release.

http://www.amazon.com/s/ref%253dnb_sb_noss?url=search-alias=aps&field-keywords=vovici&x=0&y=0
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You can also view the surveys that are shared with you. Tap the menu button, and then go to the Folders 
> Shared Surveys folder.

Android Mobile > My Surveys page

Procedure 
1 In the My Surveys list, select a survey. 

The survey information screen appears.
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Survey information screen

2 On the survey information screen, you have access to:
• Participant Status – View the number of participants who started and completed your survey 

and the total number of participants. 
• Response History – Display the chart view of the response history. 
• Send Survey Link – Email your survey link and invitation to one of your contacts. 
• Mobile Report – View the mobile report for each of your survey questions. You have the ability 

to page through each question using the arrows, or tap the button in the middle to display the list 
of all  questions. In the list of questions you can tap and display responses for that question.

To display the Settings screen, change your workgroup, or log out of the EFM  Mobile Application, tap the 

Settings icon .
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Offline Mobile–Guided Access mode
Navigation

Start EFM Offline Mobile on your mobile device.

You can deploy surveys using the Offline Mobile app in the Guided Access mode to survey in a retail 
environment like a bank and lock down access to the rest of iOS and management aspects of Offline 
Mobile app. Guided Access keeps the device in a single application and allows you to control which 
features are available. In Guided Access mode, the close button and the survey details button are not 
visible.

Enable Guided Access mode

Procedure 
1 Go to Settings > General > Accessibility > Guided Access.
2 Turn Guided Access mode on.
3 Set the passcode that is used when Guided Access is enabled.
4 To display the accessibility shortcut settings in the Guided Access mode, turn Accessibility 

Shortcut on.

Set Kiosk Time-Out

Procedure 
1 Click About.
2 Press the plus or minus sign to increase or decrease the time-out.

Conduct survey in Guided Access mode

Procedure 
1 Triple-click the Home button to start Guided Access.
2 Click the Launch Survey button.
3 Collect responses.

 Click the Need More Time button if respondents need more time to answer the questions. 
Otherwise, the survey starts again when the countdown reaches zero.

4 Click the Start Over button to start a new survey.

Exit Guided Access

Procedure 
1 Triple-click the Home button.
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2 Enter the passcode.
3 Click End in the upper-left corner.
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Offline Device–Role-based access
Navigation

Administration tab > Roles tab.

The group and survey administrators can control the workgroup members' access to authorize surveys 
for distribution to the offline mobile devices based on the user role set of permissions. You can enable 
the Send to Offline Device functionality for a user by creating a new role or editing the existing ones.

 This option is available only if you have a license for the Mobile Offline Survey Taking feature.

By default, the Send to Offline Device functionality is active for all users that have access to open a 
survey. 
When the offline mobile survey taking is disabled, you can see neither the Devices tab on the 
Administration tab nor the Send to Device button in the Collect view.

Activate Offline Mobile for a user role

Procedure 
1 Go to Administration tab > Roles tab.
2 Click the name of the role that you want to edit.

The Edit Role page opens.
3 On the Edit Role page, in the Surveys section, select the Send to Offline Device check box.
4 Click Save.

 For details on the user roles, see Roles, page 1378.
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Manage Offline Access
Navigation

Design & Collect tab > Surveys tab > create a new survey or select an existing one > Collect view > 
select any distribution type except for Require a Passcode > Overview dashboard > add the Offline 
Device campaign for your survey > Offline Devices tab > Manage Offline Access page.
You can add, remove, import, and search for the devices of the EFM Offline Mobile users by using the 
Manage Offline Access page functionality. 
After registering a mobile device on the Administration page, you can send a survey to it, and then 
respond to it in the offline mode from your device.

 This topic refers to EFM Offline Mobile App that can be installed on iPhone, iPad, and iPod Touch. 
Do not confuse it with EFM Offline Mobile (PC edition), for details, see Export a survey to EFM 
Offline Mobile (PC edition), page 187.

The Manage Offline Access page is only available after you add the Offline Device campaign to your 
survey on the Overview dashboard by clicking the Add Campaign menu.

 If your survey is already distributed via Require a Passcode method, you cannot add any other 
campaigns to it including Offline Device campaign.

After this, the Offline Devices tab appears on the Collect tab. Click the Collect tab to open the 
Manage Offline Access page.
After adding the Offline Device campaign, you can add devices to your survey in one of the following 
ways:
• By clicking options on the    menu: 

• Add Device – Select the device to which send your survey. You can select any device that is 
registered on the Administration tab (see Register a Device, page 1388 and Send a survey to the 
device, page 1471).

• Import Devices from Survey – Select the survey from which to import devices.
• By clicking the toolbar options on Offline Devices > Manage Offline Access:

• Actions – Import devices from another survey into the current survey (see Import a device from 
another survey, page 1470).

• Add – Select the device to which to send your survey. You can select any device that is registered 
on the Administration tab (see Send a survey to the device, page 1471).

All the added devices are displayed in the Manage Offline Access grid.
To manage the added devices, you can also use the following options on the toolbar:
• Remove – Stop survey sharing with the previously added device (see Stop sharing survey with the 

device, page 1472).
• Search – Search for the device by typing its ID, description, or tags in the Search box.
In the Manage Offline Access grid, you can find the following information about each device that is 
added to your survey:
• Device ID – The ID of the registered device.
• Description – A brief description of the registered device.
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• Tags – Custom user information (for example, a group name). It is limited to 255 characters.
By default, the Manage Offline Access grid displays the first 10 devices. To view more devices per page, 
click 25, 50, or 100 to the right of the View per Page option at the bottom of the Manage Offline 
Access grid. You can also sort devices by clicking the column heading. To change the width of a column, 
drag its edge.
In addition, if the Manage Offline Access grid is longer than one page in length, you can navigate 
through pages by clicking the page navigation arrows.
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Import a device from another survey
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or select an existing one > 
Collect view > select any distribution type except for Reguire a Passcode > Overview dashboard > Add 
Campaign menu > add the Offline Device campaign to the survey.

You can import devices from another survey, and then send your survey to the imported devices to 
respond to it in offline mode.

Procedure 
1 Go to the Collect tab of the survey that you want to send to a mobile device.

 Make sure that your survey is not distributed via Require a Passcode method.

2 On the Overview dashboard, on the Add Campaign menu, add the Offline Device campaign.

3 On the created Offline Devices widget, on the    menu, click Import Devices from Survey.
Or
Go to the Offline Devices > Manage Offline Access, and then on the Actions menu, click Import 
Devices from another survey.

4 In the Import from Survey dialog box, select a survey that you want to import devices from, and 
then click OK.

 You can select only one survey at a time.

5 Click Import.
When importing is completed, you can view the number of imported devices and the number of 
devices that failed to import.

6 Click Close. 
The imported devices appear on the Manage Offline Access page.
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Send a survey to the device
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or select an existing one > 
Collect view > select any distribution type except for Reguire a Passcode > Overview dashboard > Add 
Campaign menu > add the Offline Device campaign to the survey.

You can send a survey to a mobile device, and then respond to it in the offline mode from your device. You 
can select any device that is registered on the Administration tab (see Register a Device, page 1388).

 If a survey contains Hierarchical questions, Image Upload questions, or has the Web Service 
Event Handler functionality configured, you cannot send it to mobile devices and respond to it 
in offline mode.

Procedure 
1 Go to the Collect tab of the survey that you want to send to a mobile device.
2 On the Overview dashboard, on the Add Campaign menu, add the Offline Device campaign.
3 On the created Offline Devices widget, on the   menu, click Add Device.

Or
Go to the Offline Devices > Manage Offline Access, and then click Add on the toolbar.

4 In the Add Device dialog box, to the right of the Find Using option, specify how you want to search 
for the devices by selecting the corresponding option:
• Description or Device ID
• Tags

5 In the text box, type the device information.
6 Click Search. 

The results of the search appear in the Devices Found grid.

 You can navigate through the pages in the dialog box by clicking the page navigation arrows.

7 Select the check box next to the device that you want to use for the survey distribution.
8 Click Add Device.

The survey is sent to the selected device, and the device appears in the Manage Offline Access grid.

 If your survey is shared with any offline device, a corresponding notification appears on the 
Collect tab under the survey status.
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Stop sharing survey with the device
Navigation

Design & Collect tab > Surveys tab > My Surveys page > create a new survey or select an existing one > 
Collect view > select any distribution type except for Reguire a Passcode > Overview dashboard > Add 
Campaign menu > add the Offline Device campaign to the survey.

You can stop sharing your survey with the mobile device to which you sent it.

Procedure 
1 On the Collect tab, click the Offline Devices tab.
2 On the Manage Offline Access page, select the check box next to the device that you want to stop 

sharing the survey with.
3 On the toolbar, click the Remove button.
4 In the confirmation dialog box, click Remove.
The device is removed from the survey distribution.
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